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1.6

Notices
Proprietary notice

The product information and design disclosed herein were originated by and are the property
of Bosch Security Systems, LLC. Bosch reserves all patent, proprietary design, manufacturing,
reproduction, use and sales rights thereto, and to any article disclosed therein, except to the

extent rights are expressly granted to others.

Copyright notice

Copyright 2021 by Bosch Security Systems, LLC. All rights reserved. Reproduction, in whole or
in part, without prior written permission from Bosch is prohibited.

*All other trademarks are property of their respective owners.

*MOTOROLA, MOTOTRBO, and the Stylized M logo are registered in the U.S. Patent and
Trademark Office.

Warranty notice (limited)

For warranty and service information, see http://www.telex.com/warranty.

Factory service center

Factory Service Center

Bosch Security Systems, LLC
Radio Dispatch Products

8601 East Cornhusker Highway
Lincoln, Nebraska, 68507

Contact information

Sales

E-mail: TelexDispatch@us.bosch.com
Phone: (800) 752-7560

Fax: (402) 467-3279

Customer service repair
E-mail: repair@us.bosch.com
Phone: (800) 553-5992

Technical support

E-mail: TelexDispatchtechsupport@us.bosch.com
Knowledge database: http://knowledge.boschsecurity.com/
Web: www.telex.com

Claims

No liability will be accepted for damages directly or indirectly arising from the use of our
materials or from any other causes. Our liability shall be expressly limited to replacement or
repair of defective materials.
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Mototrbo claim

Motorola Solutions, Inc and its subsidiaries make no express or implied representation or
warranty with respect to: (i) any of the Products references herein; (ii) the information
provided herein (including without limitation the key findings and test results regarding the
Products and the functionality or interoperability thereof) (“Information”) or any solution,
combination or system that may be created with the use thereof. The information is offered
“as is” with all faults and does not constitute professional, technical, legal or other advice to
the user.

1.7 Warning

Notice!
This is a class A product. In a domestic environment this product may cause radio
interference, in which case the user may be required to take adequate measures.

Warning!
Do not open the unit. No user serviceable parts are contained within. Bosch cannot be
responsible for damage. If the unit is opened, the warranty can be voided.

1.8 OpenSSL project

—  This product includes software developed by the OpenSSL Project for use in the
OpenSSL Toolkit (https://www.openssl.org/).

—  This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).

—  This product includes cryptographic software written by Tim Hudson
(tih@cryptsoft.com).
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2 Overview

The Telex C-Soft Console Software is a Microsoft Windows application (refer to Copyright
notice, page 11) that enables a PC with a network connection to monitor and control 2-way
radios connected to the network. Utilized in conjunction with an infrastructure of Telex VolP
(Voice Over Internet Protocol) products, the C-Soft application offers a powerful and
convenient method for controlling a radio network using standard computer equipment.
The software console can support up to 200 lines and is fully compatible with popular touch
screen monitors. In addition, standard desk microphones, headsets, and foot-switches are
supported through the use of the ADHB-4 headset adapter panel.

Notice!
Application Notes containing instructions for specific product installation are available for
download at www.telex.com.

Computer system requirements

Operating system Microsoft Windows 8.1 and Windows 10
(supports both 32-bit and 64-bit)

Sound system Full-duplex Microsoft Windows compatible
sound system

Network connection 10Mbps or 100Mbps, full-duplex TCP/IP
connection. Static IP address preferred to
DHCP

Processor speed Intel Core i3 2.80GHz processor

Random access memory Minimum of 8GB recommended
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License and optional features

Part number

Description

Model number

F.01U.307.023 | C-Soft 2-line SOFTWARE v7 C-Soft7 2L
F.01U.307.024 | C-Soft 6-line SOFTWARE v7 C-Soft7 6L
F.01U.307.025 |C-Soft 12-line SOFTWARE v7 C-Soft7 12L
F.01U.307.026 | C-Soft 24-line SOFTWARE v7 C-Soft7 24L
F.01U.307.027 | C-Soft 50-line SOFTWARE v7 C-Soft7 50L

F.01U.307.028

C-Soft 100-line SOFTWARE v7

C-Soft7 100L

F.01U.307.029

C-Soft 150-line SOFTWARE v7

C-Soft7 150L

F.01U.307.030

C-Soft 200-line SOFTWARE v7

C-Soft7 200L

F.01U.307.031

Upgrade Previous C-Soft to C-Soft
v7

C-Soft7 Upgrade

***Each C-Soft license includes 2 lines of SIP and 1 line of Per Line Playback

F.01U.307.047 | SIP Enhanced 6-line SIP 6L
F.01U.307.048 |SIP Enhanced 12-line SIP 12L
F.01U.307.032 Line Call Playback 2-line Playback 2L
F.01U.307.033 Line Call Playback 6-line Playback 6L

F.01U.307.034

Line Call Playback 12-line

Playback 12L

F.01U.307.035

Line Call Playback 24-line

Playback 24L

F.01U.307.036

Line Call Playback 50-line

Playback 50L

F.01U.307.037

Line Call Playback 100-line

Playback 100L

F.01U.307.038

NEXEDGE Direct IP 2-line

NEXEDGE IP 2L

F.01U.307.039

NEXEDGE Direct IP 6-line

NEXEDGE IP 6L

F.01U.307.040

NEXEDGE Direct IP 12-line

NEXEDGE IP 12L

F.01U.307.041

NEXEDGE Direct IP 24-line

NEXEDGE IP 24L

F.01U.307.042 DFSI Direct IP 2-line P25 DFSI 2L
F.01U.307.043 | DFSI Direct IP 6-line P25 DFSI 6L
F.01U.307.044 |DFSI Direct IP 12-line P25 DFSI 12L
F.01U.307.045 | DFSI Direct IP 24-line P25 DFSI 24L
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F.01U.343.866

AES Encryption Option, per seat

Encryption Seat

F.01U.343.860 |Direct IP Interface, DMR AIS, 2-line  |DMR AIS IP 2L
F.01U.343.861 |Direct IP Interface, DMR AIS, 6-line |DMR AIS IP 6L
F.01U.343.862 Direct IP Interface, DMR AIS, 12-line |DMR AIS IP 12L
F.01U.343.863 |Direct IP Interface, DMR AIS, 24-line | DMR AIS IP 24L
F.01U.343.864 |Application Programming Interface |API SDK

SDK
F.01U.343.865 Application Programming Interface, |API Seat

per seat
F.01U.343.856 P25 CSSI Direct IP 2-line License P25 CSSI 2L
F.01U.343.857 | P25 CSSI Direct IP 6-line License P25 CSSI 6L
F.01U.343.858 | P25 CSSI Direct IP 12-line License P25 CSSI 12L
F.01U.343.859 | P25 CSSI Direct IP 24-line License P25 CSSI 24L
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C-Soft Application Software

C-Soft Designer program

The C-Soft Designer program provides the ability to create custom dispatch screen designs.
Console operators with differing requirements can be given different screen designs. Once the
screen layout is created, the C-Soft Designer program generates a file read by the C-Soft
Runtime program.

Notice!
A software-based license key is not required to operate C-Soft Designer.

C-Soft Runtime program

The C-Soft Runtime program does the actual network communications with the other radio
elements available on the network. This single screen design file makes it easy for the
designer to send updates to users wherever they may be located.
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5 Installation and setup

This chapter includes information on the installation of and the initial system setup
requirements for the C-Soft program.

Sections include:

— Install the C-Soft Runtime Software

— Install the C-Soft Designer Software

- Install the ADHB-4 Driver

— Install the Telex License Server

—  Configure the initial Volume Control settings

5.1 Install the C-Soft Runtime software

Important: The C-Soft Installation package is downloadable from www.telex.com. Contact the
technical support team to get access.

To install the C-Soft software, do the following:
1. Download the C-Soft installation package and copy it to your computer.
2. Navigate to and double-click the C-Soft Setup_vXXXX.exe file.

The C-Soft Runtime Setup wizard appears.

iS5 Setup - Telex C-Soft Runtime — et

Welcome to the Telex C-Soft
Runtime Setup Wizard

This will install Telex C-Soft Runtime 7.7.0.0 on your
computer.

It is recommended that you close all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup,

3. Click Next.
The License Agreement window appears.
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ﬁEﬂ Setup - Telex C-5oft Runtime —

License Agreement
Please read the following important information before continuing.

Pleasze read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

End User Software License Agreement

Important Information

PLEASE READ THIS END USER LICEMSE AGREEMENT (THE "LICEMNSE")
CAREFULLY BEFORE OPENING THE PACKAGE AND/OR USING THE CONTENTS
THEREOF AND/OR BEFORE DOWMNLOADING OR INSTALLING THE SOFTWARE
PROGRAM. IF YOU DO NOT AGREE TO THISLICEMSE DO NOT OPEN THE
PACKAGE AND/OR DOWNLOAD AND/OR INSTALL THE SOFTWARE AND

@ I accept the agreement
()1 do not accept the agreement

< Back

W

Cancel

4.
5.

To agree with the agreement, select the “l accept the agreement” radio button.

Click the Next button.
The Information window appears.

ﬁ_,'-’:,! Setup - Telex C-5Soft Runtime —

Information
Please read the following important information before continuing.

YWhen you are ready to continue with Setup, didk Mext,

Al C-5oft executables must be shut down first before installing.

< Back

Cancel

6.

Follow the instructions in the window and click Next.
The Select Destination Location window appears.
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E_,'-’;J Setup - Telex C-5oft Runtime —

Select Destination Location
Where should Telex C-Soft Runtime be installed?

Setup will install Telex C-Soft Runtime inte the following folder.

To continue, dick Mext. If yvou would like to select a different folder, dick Browse.,

": rogram Files (x86)Telex Communications\C-5oft Browse...

At least 71.5 MBE of free disk space is required.

7. Click Next to accept the default folder location for C-Soft (recommended).
The Select Additional Tasks window appears.
OR
Click Browse to select a different folder location for C-Soft.

The Browse window appears.

ﬁ! Setup - Telex C-5oft Runtime —

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while instaling Telex C-5oft
Runtime, then dick Mext.

Additional shortouts:
|:| Create Runtime Desktop Icon
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8. From the Additional shortcuts list, select check boxes for the shortcuts you want to
create.

9. Click Next.
The C-Soft Settings window appears.

ﬁ%‘ Setup - Telex C-Soft Runtime —

C-5oft Settings
Position Settings

Please enter the following C-Soft Directory settings, and then dick Mext.

Audio Recording Directory

|C:\ProgramDa1ﬁ‘n,Telex Communications\C-Soft\Audio Archive | Browse...
Images Directory

|C:\PrngramDa1ﬁ‘|,Telex CommunicationsiC-Soft\Media\Images | Browse...
Sounds Directory

|C:\ProgramDa1ﬁ‘n,Telex Communications\C-Soft\Media\Sounds | Browse. ..
GPS Directory

|C:\PrngramDa1ﬁ‘|,Telex Communications\C-Soft\DesignData | Browse...

10. Click Next to accept the default C-Soft Directory settings (recommended).
The C-Soft Settings TSM Setup window appears.
OR
Click the Browse button to navigate to the folder as desired for each Directory setting.
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E_,'-’;J Setup - Telex C-5oft Runtime —

C-Soft Settings
Position Settings

Please enter the following TSM settings, and then dick Next.

TSM Username:

|a|:|min

TSM Password:

[ ]Reset Password
TSM Ping TTL:

E

11. Enter the TSM Username desired.

12. Select the Reset Password check box to reset the password that logs into the device
with TSM.

13. Enter the TSM Ping TTL to set the TTL (Time to Live) value, which is TSM device
detection feature.

14. Click Next.
The C-Soft Settings Position Name window appears.
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ﬁEﬂ Setup - Telex C-5oft Runtime —

C-Soft Settings
Position Settings

Please enter the following C-Soft settings, then dick Mext.

Position Name:
Telex Radio Dispatch Position 1

15. Enter the Position Name.
16. Click Next.
The C-Soft Settings Summary window appears.

ﬁ_%' Setup - Telex C-Soft Runtime — >

C-Soft Settings
Summary

Directory Settings:
Audio Recording: C:\ProgramDataiTelex Communications\C-Soft\Audio Archive
Images: C:'\ProgramDataiTelex Communications\C-SoftiMedialImages
Sounds: C:'\ProgramData’iTelex Communications\C-SoftiMedia'Sounds
GP5; C:\ProgramDataiTelex Communications\C-Soft\DesignData

TSM Settings:
sername: admin
Reset TSM Password: false
TTL: &

Fosition Mame: Telex Radio Dispatch Position 1

|:| Confirm Position settings to continue

< Back Mext = Cancel

17. Select the Confirm Position settings to continue check box.
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18. Click Next.
The Ready to Install window appears.
NOTE: The destination location and start menu folder paths appear in this window.

ﬁ! Setup - Telex C-5oft Runtime -

Ready to Install
Setup is now ready to begin installing Telex C-Soft Runtime on your computer,

Click Install to continue with the installation, or didk Back if you want to review or
change any settings.

Destination location:
C:\Program Files (x36)\Telex CommunicationsiC-Soft

< Back Install Cancel

19. Click Install.
C-Soft installs. The C-Soft Runtime Setup Wizard finish window appears.

ﬁ! Setup - Telex C-5oft Runtime —

Completing the Telex C-Soft
Runtime Setup Wizard

Setup has finished installing Telex C-Soft Runtime on your
computer. The application may be launched by selecting the
installed shortouts.

Click Finish to exit Setup,

20. Click Finish, when complete.
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5.2 Install the C-Soft Designer software

Important: The C-Soft Installation package is downloadable from www.telex.com. Contact the
technical support team to get access.
To install the C-Soft Designer software, do the following:

Notice!

The C-Soft Designer installer launches during the C-Soft Runtime installer. It has already
downloaded to your machine.

1. Navigate to and double-click the C-SoftDesigner_Setup_vXXXX.exe file.
The C-Soft Designer Setup wizard appears.

5 Setup - Telex C-Soft Designer — >

Welcome to the Telex C-Soft
Designer Setup Wizard

This will install Telex C-Soft Designer 7.7.0.0 on your
computer.

It is recommended that you dose all other applications befare
continuing.

Click Mext to continue, or Cancel to exit Setup.,

2. Click Next.
The License Agreement window appears.
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E_,'-’;J Setup - Telex C-5oft Designer

License Agreement
Flease read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

|End User Software License Agreement

Important Information

PLEASE READ THIS END USER LICEMSE AGREEMENT [THE "LICEMSE")
CAREFULLY BEFORE OPEMING THE PACKAGE AND/OR USING THE CONTENTS
THEREOF AND/OR BEFORE DOWNLOADING OR INSTALLING THE SOFTWARE
PROGRAM. IF YOU DO NOT AGREE TO THISLICENSE DO NMOT OPEN THE
PACKAGE AND/OR DOWNLOAD AND/OR INSTALL THE SOFTWARE AND

W

@I accept the agreement
("1 do not accept the agreement

To agree with the agreement, select the “l accept the agreement” radio button.
4. Click the Next button.

The Upgrade Design window appears.

5. (Optional) Select the Upgrade default design check box to have C-Soft Designer
automatically upgrade the current design to a version compatible with the C-Soft
Designer version being installed.

Notice!

If selected, a backup of the default design is saved prior to upgrade. It exists in the same
folder, but a version suffix is added to the file's name. For example, if the designs name is
MyDesign.veg, MyDesign.veg is the first backed up to MyDesign_X.XXX.veg. and then
MyDesign.veg is upgraded to the new C-Soft version.
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ﬁEﬂ Setup - Telex C-5oft Designer —

Upgrade design file

Default Design: C:\ProgramDataiTelex
Communications C-Soft\Configurations\05252021113740\Mikes_18_line_7.692-fi:

Upgrade default design file

1. Click Next.
The Information window appears.

ﬁ_,'-?—,.! Setup - Telex C-5oft Designer —

Information
Please read the following important information before continuing.

When you are ready to continue with Setup, dick Mext,

All C-Soft executables must be shut down first before installing.

2. Follow the instructions in the window and click Next.
The Select Destination Location window appears.
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E_,'-’;J Setup - Telex C-5oft Designer —

Select Destination Location
Where should Telex C-Soft Designer be installed?

Setup will install Telex C-Soft Designer into the following folder.

To continue, dick Mext. If yvou would like to select a different folder, dick Browse.,

C:\Program Files (x86)Telex Communications\C-Soft Designer Browse...

At least 8.1 MB of free disk space is reguired.

Figure 5.1:

1. Click Next to accept the default folder (recommended).
The Select Additional Tasks window appears.
OR
Click Browse to select a different folder location for the program’s files.
The Browse window appears
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ﬁEﬂ Setup - Telex C-5oft Designer —

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing Telex C-Soft
Designer, then didk Mext,

Additional shortouts:
|:| Create Designer Desktop Icon
[] Create Sample Veg Folder Shortcut

2. From the Additional icons list, select check boxes for shortcuts you want to create.
3. Click Next.

The Ready to Install window appears.

NOTE: The destination location and start menu folder paths appear in this window.

ﬁ_,'-’:,! Setup - Telex C-5oft Designer —

Ready to Install
Setup is now ready to beqin instaling Telex C-Soft Designer on your computer,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:\Program Files (x86)Telex Communications\C-5oft Designer

< Back Install Cancel

4. Click Install.
C-Soft Designer installs.
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EE;! Setup - Telex C-5oft Designer —

Completing the Telex C-Soft
Designer Setup Wizard

Setup has finished installing Telex C-Soft Designer on your
computer, The application may be launched by selecting the
installed shortouts,

Click Finish to exit Setup.

5. Click Finish, when complete.

5.3 ADHB-4 driver installation
The ADHB-4 Device Installer wizard appears automatically at the end of the C-Soft installation
process.

To install the ADHB-4 driver, do the following:
1. From the Welcome to the ADHB-4 Installer wizard, click the Next button.
The Windows Security message appears.
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ADHB-4 Device Installer

Welcome to the ADHB-4 Installer!

This wizard will wallk you through updating the drivers for
your ADHB-4.

To continue, click MNext.

ach Mext = Cancel

2. Click Next.
The Windows Security window appears.

ﬁ'f;! Setup - Telex C-5oft Runtime -

Ready to Install
Setup is now ready to beqin instaling Telex C-Soft Runtime on your computer,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:\Program Files (x3&)Telex Communications\C-5oft

< Back Install Cancel

3. Click Install.
The Congratulations! You are finished Installing the ADHB-4 window appears.
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ADHB-4 Device Installer

Congratulations! You are finished
installing the ADHB-4.

The drivers were successfully installed on this computer.

You can now connect your device to this computer. f your device
came with instructions, please read them first.

Driver Mame Status

" Bosch Security Systems,... Ready to use

4. Click Finish.
The ADHB-4 driver installation is complete.

Note:

—  When the installation is finished, the C-Soft executable files are located at: C:\Program
Files\Telex Communications\C-Soft.

— The cposi.txt, keyset.dat, and DefaultVeg.txt files are located at: C:\Programdata\Telex
Communications\design_folder.

5.4 Telex License Server setup

The Telex License Server Installer wizard appears automatically at the end of the ADHB-4
installation process.

For more information about the Telex License process, refer to “Appendix | - Telex License
Activation tool, page 585”.

To install the Telex License Server, do the following:
1. From the Welcome to the Telex License Server Setup Wizard, click the Next button.
The License Agreement window appears.
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e Setup - Telex License Server — *

Welcome to the Telex License
Server Setup Wizard
This will install Telex License Server 1.6.0.0 on your computer,

Itis recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup,

2. To accept the agreement, select the “l accept the agreement” radio button.
The Select Destination window appears.

EE Setup - Telex License Server 1.6.0.0

License Agreement
Flease read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

IMPORTANT INFORMATION

PLEASE READ THIS EMD USER LICEMSE AGREEMENT (THE "LICEMSE”) CAREFULLY
BEFORE OPEMING THE PACKAGE AMD/OR. USING THE CONTENTS THEREOF
AMDOR. BEFORE DOWMNLOADING OR INSTALLING THE SOFTWARE PROGRAM,

IF YOU DO NOT AGREE TO THIS LICENSE DD NOT OPEM THE PACKAGE AMD/OR
DOWMNLOAD AMD/OR. INSTALL THE SOFTWARE AMD PROMPTLY (AND IN AMY
EVENT, WITHIM 7 DAYS FROM THE DATE YOU RECEIVED THIS PACKAGE )
RETURM THE SOFTWARE WITH THE ORIGIMAL PACKAGE TO BOSCH, ERLASE THE
SOFTWARE, AND ANY PART THEREOF, FROM YOUR COMPUTER. AMD DO NOT
IISE IT IM AMY MAMMER. WHATSOEVER.,

@I accept the agreement
()1 do not accept the agreement
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EE Setup - Telex License Server —

Information
Flease read the following important information before continuing.

When you are ready to continue with Setup, didk Mext.

Please ensure that Telex License Activation Tool is not running before installing Telex
License Server.

3. Follow the instructions in the window and click Next.
The Select Destination Location window appears.

4. Click the Next button to accept the default folder location for C-Soft (recommended).
The Select Start Menu Folder window appears.

OR
Click the Browse button to select a different folder location for C-Soft.

The Browse window appears.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



34 en| Installation and setup C-Soft 7.700

EE Setup - Telex License Server —

Select Destination Location
Where should Telex License Server be installed?

Setup will install Telex License Server into the following folder.

To continue, didk Mext, If yvou would like to select a different folder, dick Browse,

C:\Program Files (x86)Telex CommunicationsiLicense Server Browse...

Atleast 31.1 MB of free disk space is reguired.

EE Setup - Telex License Server —

Select Start Menu Folder
Where should Setup place the program's shortouts?

o
Setup will create the program's shortouts in the following Start Menu folder,
[

To continue, didk Mext, If yvou would like to select a different folder, dick Browse,

|'I'Elex Communications Browse. ..

1. Click the Next button to accept the default folder (recommended).
The Select Additional Tasks window appears.
OR
Click the Browse button to select a different folder location for the program’s shortcut
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files.
The Browse window appears.

EE Setup - Telex License Server

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing Telex
License Server, then dick Next,

Firewall:

Add an exception to Windows Firewall for Telex License Server

Additional icons:

Create Telex Activation Toaol Desktop Icon

From the Additional icons list, select check boxes for the shortcuts you want to create.
Click the Next button.

The Ready to Install window appears.

EE Setup - Telex License Server

Ready to Install
Setup is now ready to begin installing Telex License Server on your computer,

Click Install to continue with the installation, or didk Back if you want to review or
change any settings.

Destination location:
C:\Program Files (x86)\Telex CommunicationsiLicense Server

Start Menu folder:
Telex Communications

Additional tasks:
Fireveall:

Add an exception to Windows Firewall for Telex License Server
Additional icons:

Create Telex Activation Tool Desktop Icon

< Back Install Cancel
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4. Click the Install button.
The Microsoft Visual C++ 2012 window appears.

#F Microsoft Visual C++ 2012 Redistributable (x26) - 11.061030Setup | = || @ |[ 2= |

Microsoft Visual C++ 2012
Redistributable (x86) - 11.0.61030

MICROSOFT SOFTWARE LICENSE TERMS i

»

MICROSOFT VISUAL C++ 2012 RUNTIME LIBRARIES

These license terms are an agreement between Microsoft Corporation {or
based on where you live, one of its affiliates) and you. Please read them.  _

o ol S o, = SRSt G S N R o L e e R e N S e Ny e e

[C]1agree to the license terms and conditions

5. Select the | agree to the license terms and conditions check box.
6. Click the Install button.
Once installed, the Setup Successful window appears.

%) Microsoft Visual C++ 2012 Redistributable (x86) - 11.0.61030 Setup | — | = [s&am

Microsoft Visual C++ 2012
Redistributable (x86) - 11.0.61030

Setup Successful
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7. Click the Close button.
The Completing the Telex License Server Setup Wizard appears.

EE Setup - Telex License Server —

Completing the Telex License
Server Setup Wizard

Setup has finished installing Telex License Server on your
computer. The application may be launched by selecting the
installed icons.

Click Finish to exit Setup.

8. Click the Finish button.

5.5 Initial volume control settings

There are two sets of volume control settings on the computer crucial to the operation of the
C-Soft programs. The first set controls playback volumes, and the second set controls
recording volumes. Before using the C-Soft applications, these settings need to be checked
and adjusted, if necessary.

These steps are only necessary when not using the ADHB-4.

5.5.1 Playback volumes
To set the playback volume, do the following:

o
1. Click the speaker icon

The Mixer window appears.

in the system tray.
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2. Click Mixer.
The Volume Mixer window appears.

)

Mixer

i, Volume Mixer - Speakers (Realtek AC'97

Device Applications
n. TELEX
) ﬂ | C-Soft
Speakers ¥ System Sounds C-Soft Console -

SIP-Theresa.veg

- > =

®

Set the Device Volume to the maximum level.
The C-Soft Console volume slider moves to maximum.

4. Click the Device Speaker’s icon.
The Speaker Properties window appears.
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5. Click Levels.
The Levels page appears.

\ General | Custom | Levels | Enhancements 1 Advanced |

Realtek AC97 Audio Output

0

PC Speaker ‘ 7 ! UNIVERSAL
| NO
Phone Line SYMBOL

Microphone

Balance
Balance
—

6. If a universal no symbol does not appear on the Microphone’s speaker icon, click the
microphone icon.
The universal no symbol appears on the icon.
OR
If the universal no symbol appears on the microphone icon, go to the next step.
7. Click OK.
The window closes.

5.5.2 Recording volumes
To set the recording volumes, do the following:

<P

1. Right-click the speaker icon in the system tray.
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2.

From the shortcut menu, select Recording Devices.
The Recording page appears.

Playbadc] Recording | Sounds | Communications |

Select a recording device below to modify its settings:

'{- Microphone
N\ Realtek AC'97 Audio
Default Device

Line In
Realtek AC'97 Audio
Currently unavailable

SPDIF
Realtek AC'97 Audio
Currently unavailable

Phone Line
Realtek AC'97 Audio
@ Currently unavailable

| Set Default |v| | Properties |

Apply

e

Click Microphone.
The Configure Button is Enabled.
Click the Configure Button.

The Configure Speech Recognition screen appears.

— . ey

Yy : e - i . :
Ou - Mﬁ » Control Panel » Easeof Access » Speech Recognition -l

i Control Panel Home

Advanced speech options
Text to Speech

=

Configure your Speech Recognition experience

g‘ Start Speech Recognition
Start using your voice to contrel your computer.

9 Set up microphone

Set up your computer to work properly with Speech Recognition.

Take Speech Tutorial
= Learn to use your computer with speech. Learn basic commands and dictation.

& Train your computer to better understand you

Read text to your computer to improve your computer's ability to understand your veice. Doing this

isn't necessary, but can help improve dictation accuracy.

Open the Speech Reference Card

View and print 2 list of cornmon commands to keep with you so you always know what te say.
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5. Click Set up microphone.

The Microphone Setup Wizard appears.

&, b Microphone Setup Wizard
What type of microphone is Microphone (Realtek AC'97 Audio)?
@ Headset Microphone
g Best suited for speech recognition, you wear this on your head.
]
= Desktop Microphone
. 3 These microphones sit on the desk.
Other
' Such as array microphones and microphones built inte other devices.
l MNext I I Cancel

i = e —,
6. Select the type of microphone you want to configure.
7. Click Next.

The Set up your microphone window appears.
8. Follow the instructions in the window.
9. Click Next.

The Adjust Volume window appears.
10. Follow the instructions in the window.
11. Click OK.

The Sound window closes.
12. Close the Volume Mixer window.

5.6 Position settings

These position settings are stored in the devices ProgramData and are used on any design file
ran on the device. These settings are configurable when running the C-Soft Installer (7.700 or
greater). They can also be configured using TSM for both C-Soft Desktop installations and
IP-30XX devices.

Audio Recording Directory: Location of recorded audio

Images Directory: Global location for images

Sounds Directory: Global location for sounds

GPS Directory: Global location for GPS kml files

TSM Username: Username for accessing device from TSM

TSM Password: Password for accessing device from TSM

TSM Ping TTL: TTL for TSM network connection

Position Name: Name of the dispatch position
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6

6.1
6.1.1

6.1.2

Communications system design

Designing a C-Soft console requires an understanding of the radio network and how the
various radios and other communication equipment are connected.

Before you begin to design the C-Soft console, create a road map of the radio, console, and
any other communication equipment locations.

This road map must include the following:

—  Multicast Addresses for each channel of TX (Transmit) and RX (Receive) communication.

—  Port numbers for each channel of TX and RX communication.

— Base IP Addresses assigned to each console or radio on the network and the number of
frequencies each radio operates on.

—  The number of channels each radio may operate on.

Communication control

Tone remote control

Telex Radio Dispatch sells a full line of tone control consoles and radio adaptors. This
technology requires an analog connection between console and radio. Each console needing
to control an individual radio is wired in parallel to allow multiple operator positions to
monitor and control the same radio. For a large system with multiple console positions and
multiple radio channels, an entire rack might be devoted to bridging audio to all interested
parties. In addition, due to loading of multiple consoles on a particular circuit, additional
bridging hardware might be required, increasing wiring and tuning of the system for
acceptable performance. The Ethernet-based IP network solves many of these issues and
provides for a number of other services not previously possible.

VolIP radio control

VolP is referred to generically throughout this document to mean RolP (Radio Over Internet
Protocol). RolP terminology is a subset of VolP and referred to as VolP generically throughout
this document. VolIP is a method of breaking analog audio up into packets to be transferred
over a computer data network. Because Ethernet delivers information packets, audio is
generally broken into 10-40ms chunks of audio, compressed, and placed on the Ethernet. The
nodes of the network are then free to utilize or ignore any combination of packets. If a
particular audio stream is of interest, the stream of audio packets are captured,
decompressed, converted back to analog, and played on available speakers.

Given the popularity of the Ethernet-based networks, many companies and agencies already
have an existing network or LAN (Local Area Network). Beyond that, a large number of
companies exist to provide WAN (Wide Area Network) connections between sites with
significant distances between them. The WAN connections can be used to connect offices
across the street from one another, around the world, or anywhere in between. Possibly the
best thing about these connections is they may already exist. In many cases, WAN links are
less expensive than a comparable leased analog line and they can carry more conversations
simultaneously.
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6.2

The most compelling reason to consider basing the next radio control system upgrade on VolP
technology is the simplification in wiring requirements. Instead of needing to bring a pair or
more of wires, per channel, to each console, only a single connection to the Ethernet is
required. Since Ethernet can easily handle dozens of simultaneous connections, it becomes
the only pipeline required for all communications.

PC & Network Security Considerations

No system can be 100% protected against security threats. However, there are measures both
manufacturers and users can do to help reduce the likelihood of a malicious attack resulting in
either the loss of data or system takeover. We evaluate and improve our products continuously
to protect against such attacks. This is only one safeguard used to reduce the likelihood of
such an event. There are many more considerations needed to implement measures to
strengthen your network security.

We strongly recommend the following considerations:

—  Deploy Dispatch products and software on isolated networks that do not connect to
other networks, when possible.

—  Apply the latest Windows updates and install up-to-date IT security software.

—  User rights should be properly administered using group policies to prevent unauthorized
use of USB connected devices.

— If the Dispatch network must connect to other networks, install and properly maintain
firewalls and intrusion detection systems.

— If Dispatch devices or computers use the Internet to connect, a VPN or tunnel connection
should be utilized. Examples of such products are those made by DCB (Data
Communications for Business), Cisco, and others.

Notice!

Bosch recommends utilizing the services of IT professionals knowledgeable about network
design and security when designing, installing, and configuring dispatch networks and
deploying PCs. By default, the Telex Dispatch products using the Windows operating system
has Windows Update enabled along with Windows Defender (firewall and anti-virus).
Disabling these features is not recommended unless it is part of an internal IT security
program that uses customized security policies along with appropriate anti-virus and firewall
software.

6.3
6.3.1

Network requirements

IP operation overview

The network options today have essentially converged on Ethernet. A local electronics store
may sell many of the components for both a wired or wireless network solution. For more
advanced network applications, an in-house or external network hardware source may be
required. These sources of information can also help with the design of the network, as well
as provide sources for advanced networking equipment, such as routers and hubs from Cisco
and other network vendors. This section is an overview of the protocols operating on the top
of the Ethernet network.
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6.3.2

6.3.3

6.3.4

6.3.5

Ethernet as physical layer

Ethernet is a network and has a low level method for transferring data from one location to
another. Source and destinations are based on the MAC (Media Access Control) which is
embedded in the Ethernet interface. The MAC Address is unique for all devices in the world
and cannot be changed. The IEEE (Institute of Electrical and Electronics Engineers) controls
the allocation of the MAC Addresses. The definition for Ethernet includes requirements for
inter-operation at speeds of 10 and 100 Mbps. Higher speeds are available, but generally have
not filtered down into end-user equipment.

Bandwidth
Each VolP channel requires 50kBit of bandwidth while active. Full-duplex conversation
requires 100kBit of bandwidth.

Some radio systems transmit go-ahead beeps when it is clear to talk. In order for the console
operator to hear the beeps, the system must support full-duplex communication. Full-duplex

bandwidth may only be required for the first few seconds of a conversation, due to the brief

nature of the go-ahead beeps at the beginning of the transmission.

When using Telex’s IP-223 with a PIB (Phone Interface Box) or TDI (Telephone Dispatch
Interface) adapter, C-6200, or a NI-223 for a telephone connection, a full 100kBit is required
since it is a full-time, full-duplex conversation.

Additional vocoders available: Telex 32K (50 kbits/sec simplex), G.726 16K (34 kbits/sec
simplex), G.726 32K (50 kbits/sec simplex), G.711 (82 kbits/sec simplex).

Multicast
In general, Telex Dispatch Systems require Multicast to function. The network must be able to
create a static Multicast Address, accessible at all times.

Once an IGMP (Internet Group Management Protocol) join message is sent out, networks
typically enable Multicast and then prune branches after a period of time. Due to intermittent
usage patterns of 2-way radios, such a system can appear to work flawlessly for a period of
time and then no longer work.

When using Cisco technology, IP PIM dense mode is recommended. Generally speaking,
sparse-dense-mode can also be implemented effectively. We recommend explicitly joining the
Multicast group with an IP IGMP static-join X.X.X.X command. For more information on Cisco
and IGMP, visit www.cisco.com.

If running Sparse mode, by design Telex equipment only sends a IGMP join message when
powered up or queried by routers. The routers need to be configured with a PIM Interval
Timer to keep the Multicast group active. (See example below.)

IP PIM query-interval

To configure the frequency of PIM (Protocol Independent Multicast) router query messages,
use the ip pim query-interval command in interface configuration mode.
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6.3.6

6.3.7

To return the default interval, use the no form of this command:

ip pim query-interval seconds

no ip pim query-interval [seconds]

Internet group management protocol

IGMP can be used to control where Multicast is allowed to propagate. This should be limited
to subnets utilizing the C-Soft program as the dispatch console and only when used on an
intermittent basis (when the C-Soft program is used for a period of time and then shut down).
When a console on the subnet is expected to be continually operational, Multicast must be
active for the subnet at all times.

Network performance

Networks should perform well under any loading conditions. The default audio delay is 120ms,
plus any delay added by the network. While delay alone does not cause issues, variable delay
(also known as jitter) does. Jitter, in a network, cannot exceed the maximum packet buffer of
any individual product buffer. Refer to the individual product manuals for these specifications.
For example, the IP-223 or IP-224 can handle approximately 600ms of network jitter.

Notice!
Losing more than 5% of the total packets transmitted compromises audio quality and system
performance. Optimally, packet loss should be less than 1%.

6.3.8

TCP/IP and UDP/IP

TCP/IP (Transmission Control Protocol/Internet Protocol) is the best-known protocol for use
in computer communications. It is the basis for communications on the Internet and World
Wide Web. It is a guaranteed method of transferring data between two computers. Being
guaranteed means for every packet of information transferred from one computer to another
an acknowledgement packet is returned. Additional handshaking is utilized from the outset of
the data communications to ensure both ends of the connection. Because of this guaranteed
communications and its implementation utilizing handshaking (no other method is available),
TCP/IP adds a great deal of overhead to data communications is not desirable for audio traffic
over a network. This is where UDP/IP finds its acceptance.

UDP/IP (Universal Datagram Protocol/Internet Protocol) has existed as long as TCP/IP as an
unreliable method of data communications. The term unreliable should not be thought of as a
problem for audio communications over a network connection. UDP allows for a computer to
send a packet of data to another computer without the handshaking sequence required within
TCP/IP. Because of this, the computer sending the packet has no confirmation the packet
arrived at its destination. While the loss of packets can be a problem, it generally is accounted
for when the UDP application is developed. In the case of VolP, the loss of a packet, which
only contains 10-40ms of audio, is not a problem, as the human ear generally ignores the small
chunk of lost audio. The largest single factor in the loss of UDP/IP packets is network design
and loading. UDP applications use algorithms which makes the loss of information the largest
single factor in UDP/IP network design and loading. As long as a network is well designed with
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capacity for all of its chartered requirements, packet loss can be a non-issue. Because of its
lower overhead and its ability to Multicast, UDP/IP is the protocol of choice for VolP
development.

6.3.9 Multicast UDP/IP

Multicast is an extension to UDP/IP. It enables one computer to broadcast data packets to
multiple recipients. This is an ideal model for radio communications when multiple people
need to monitor the audio. A single VolP connected radio is set up to broadcast Multicast VolP
packets when receiving audio. Since the Multicast packets can be received by any interested
party, all consoles monitoring the audio can receive and decode the packets for playback. In
addition to simplifying monitoring of audio traffic by multiple listeners, Multicast also greatly
reduces the bandwidth requirement on the network. Instead of having to regenerate the
received audio into a UDP/IP data stream to each individual monitor, which uses the
bandwidth times the number of monitoring consoles, a single data stream is generated and
monitored by all.

Implementation of a Multicast protocol requires a few things for seamless use on a network.
First, clients must all support the protocol. This is accepted as given since all Telex Radio
Dispatch products utilize Multicast for audio communications. Second, consider if the network
infrastructure supports Multicast.

Multicast packets are defined to be all packets with a destination address between 224.0.0.0
and 239.255.255.255. Some of these addresses are commonly used for broadcast audio and
are not necessarily available. When a computer opens a UDP/IP port within this address range,
it also joins the group. By joining the group, a packet is sent out to all addresses saying it is
interested in seeing the traffic on this Multicast address. Routers that receive this broadcast
message to join a particular Multicast Address then pass packets through because the router
is now aware a listener is interested in this traffic. The routers utilized in the network must
support this. The protocol used to alert routers to parties who are interested in certain
Multicast Address traffic is IGMP (Internet Group Management Protocol). Telex radio Dispatch
products support IGMPv1, as defined in RFC 1112.

In addition to the joining of Multicast broadcast groups, clients on the network can also
specify a packet TTL (Time To Live). The TTL is the number of routers the packet goes through
before being stopped. As an example, the TTL for a particular broadcasting node on the
network is set to 3. This means when a packet is transmitted, it arrives at the first router in
the network. This router examines the TTL value in the packet and determines if it should pass
it through since it is not zero. When it passes the packet, the router decrements the TTL value
by 1 to a value of 2. The next router encountered by packets does the same, reducing the
value of TTL to 1. The next router does the same and the TTL is reduced to 0. The next router
the packet reaches examines the TTL value, sees it is zero, and the packet is not to be
retransmitted. Setting a large TTL value may allow for packets to get from one host to another
on a large network, but also adds additional bandwidth requirements due to the larger
number of packets being transferred.
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6.3.10 Telex Radio Dispatch port-centric method
As mentioned earlier, Telex utilizes Multicast for all audio communications. Typically only one
Multicast is used for all traffic. In addition to a valid Multicast Address, a port number is
required. The port is an additional two bytes of information ranging between 1054 and 65535
that further specifies how the data traffic should be handled. For example, assume the base
Multicast Address chosen is 225.8.11.81. Port 1054 is used to distinguish channel 1's RX
traffic. Port 1072 is used to specify channel 1's TX traffic. Channel 2 might use 1055 for RX
and 1073 for TX traffic. By making each channel’s TX and RX ports different and unique, full-
duplex audio can be supported and many channels of traffic can be supported using only one
Multicast Address (full-duplex data transmission means data can be transmitted in both
directions on a signal carrier at the same time). It is through this method a single console can
pick and choose the particular radio resources available on the network without concern for
what the console right next to it is utilizing.
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7 C-Soft Designer program

The C-Soft Designer program is a console designer application used by system specialists to
design and configure custom dispatch windows. Various combinations of buttons, sliders,
text, and popup windows can be included in a window design. These elements are then
configured to operate on specific lines.

The designer can place elements in any desired location, and can include or omit functions
based on the requirements of the system and the console operator.

When you are finished designing your VolP system, the C-Soft console can be created. Before
you begin, determine the TX and RX port of each radio, the multicast group(s) used, the
number of radios to control, and the frequencies used by each radio.

7.1 Starting the C-Soft Designer program

To start the C-Soft Designer program, do the following:
—  Double-click the C-Soft Designer desktop shortcut created during program installation.
The C-Soft Designer program appears.
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8

C-Soft Designer window

When the C-Soft Designer program is started, the console window, shown in the Figure
below, appears. This window is the workspace. It contains the commands and tools needed to
design and configure a customized software console.

The C-Soft Designer workspace includes the following components:
- Title Bar

- Menu Bar

- Toolbar

- Console window

—  Status Bar

EES Default.veg - C-Soft Designer
Title Bar —

File Edit Insert Yiew Configure Run Help

Menu Bar 2 || % | ? | + -

/'
Tool Bar /'

onhsole Window /'

Status Bar /'

Figure 8.1: C-Soft Designer workspace

Title Bar
The Title Bar is located across the top of each window. When a file is opened, the path
sequence and file name appear on the title bar.

Menu Bar

The Menu Bar is located directly below the title bar and displays menus that contain
commands for accessing the C-Soft Designer functions. For example, the Insert menu contains
commands to add Ul Element Buttons, Volume Sliders, Text, Popup Windows, and more.

Toolbar

The Toolbar is located directly below the menu bar and provides quick, easy access to

commonly used tasks. Refer to the Table below for a brief description of each button on the

toolbar and the action taken when the button is selected.

To move the toolbar, do the following:

—  Click, hold, and drag the move handle on the toolbar or the title bar (blue bar on a
floating toolbar) to a new location.

The toolbar can be docked on any side of the window or as a floating toolbar, inside or

outside the workspace.

Icon Tool name Description
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Bﬁ' Open Open an existing console design. You can also use File |
Open.

n Save Save the current console design. You can also use File |
Save.

& Cut Delete the selected item(s). You can also use Edit | Cut
or the Delete key on the keyboard.

This does not place the cut item on the clipboard.
After information is cut, you can not retrieve it.

Copy

Copy the selected item(s). You can also use Edit | Copy
or CTRL+C.
This places the copied item on the clipboard.

Paste

Insert the item(s) on the clipboard into the console
design. You can also use Edit | Paste CTRL+V

l.'ﬁ:i About

Display the software version, company contact
information, and various statistics about the console
design. You can also use Help | About C-Soft Designer.

Increase Width

Increase the width of the selected element.
Proportionally increase the size of the selected text.

I I+

Decrease Width

Decrease the width of the selected element.
Proportionally decrease the size of the selected text.

Increase Height

+
+—

Increase the height of the selected element.
Proportionally increase the size of the selected text.

Decrease Height

I
+—

Decrease the height of the selected element.
Proportionally decrease the size of the selected text.

Rotate Window

Rotate the selected popup window 90° counter-
clockwise around the selected popup button. Rotate
the selected text 90° counter-clockwise.

Move Right Move the selected item(s) to the right.
Move Left Move the selected item(s) to the left.
Move Up Move the selected item(s) up.

Move Down Move the selected item(s) down.

Start C-Soft Runtime

ve==11 O

Run C-Soft Runtime with the current .veg file loaded in
C-Soft Designer.

Tab. 8.1: C-Soft Designer toolbar

Console window

The Console window displays the open console design. The console window contains a grid
for easy alignment of elements on the window. The grid is a window alignment tool and is not
displayed on the console position window.

Status Bar

The Status Bar is located at the bottom of the workspace window.
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To display or hide the status bar, do the following:

—  From the View menu, select Status Bar.

The status bar view toggles on and off. If there is a check mark next to Status bar in the view
menu, the Status bar is visible.
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9

User interface element configuration

The C-Soft Designer program is heavily dependent on the mouse for interacting with the
elements that comprise the console window design. The mouse is used for selecting and
moving objects, to access a form or window, and to perform actions on the displayed element
or text.

Several standard Windows shortcuts are supported and are listed next to the command on the
menu. This section describes C-Soft Designer features available to assist in component
manipulation on the console window.

To select a single item, do the following:

—  Click the desired item.

A red target is displayed on the selected element or in the case of text, there is a bounding
outline around the selected text.

To select a group of items, do the following:

1. Position the mouse pointer at the top and to the side of the objects to be selected.

2. Press and hold the left mouse button while dragging the mouse over the objects to be
selected.
This draws a box around the items selected.

3.  When all items are included within the box, release the mouse button.

A red target appears on the selected element(s), and, in the case of text, there is a box around

the selected text.

You can select all items by pressing Ctrl+A.

A group of items cannot be moved using the mouse. When selected, use either the positioning

tools

+ = -
e on the toolbar or the arrow keys on your keyboard to move the items.

To move an individual item, do the following:
1. Select the item to be moved.

2. Drag the item to its new location on the window.

To copy and move an individual item at the same time, do the following:
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1. Select the item while holding down the Ctrl key.
2. Drag the item to its new location on the window.

This moves the copied item into the new location with all the parameters of the copied item
intact. When a popup button is copied using the Ctrl key, the popup window is also copied.

The Ctrl key copies items to allow for large sections of the console window to be designed,
copied, and then modified slightly to quickly design the console window.

: Narrow Bold
Arial monospacec || |narow BoldIt

" Arne Pro Bold -
Ul Group Properties == BodMtaic  |=

Arno Pro Caption Black
Armno Pro Display Black Oblique ™

Line to Associate Function \with:
&ne 1

[ Ok I ’ Cancel }

Sample

AaBbYyZz

To change the line number associated with a group of items, do the following:

1. Select a group of items.

2. Right-click an element within the selected group.
A shortcut menu appears.

3.  From the shortcut menu, select Group Line Number.
The Ul Group Properties window appears.

4. From the Line to Associate Function With drop down menu, select the line to associate
with the selected group.

5. Click OK.

The line number for the group is changed.

To change the border color of a group of items, do the following:
1. Select a group of items.
2. Right-click an element within the selected group.
A shortcut menu appears.
3.  From the shortcut menu, select Group Border Color.
The Ul Group Border Color window appears.
4. From the Border Color drop down menu, select the color to associate to the group.
5. Click OK.
The border color for the group of items is changed.

To change the font used on the elements in the group, do the following:
1. Select a group of items.
2. Right-click an element within the selected group.
A shortcut menu appears.
3. From the shortcut menu, select Group Font Change.
The Font window appears.
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Select the Font, Font style, and Size you want to display on the elements.

A sample of the selected style displays in the Sample field at the bottom of the Font
window.

Click OK.

The position of the popup window in relation to the popup button can be changed. The border
color of a group can also be changed.

To change the position of a popup window, do the following:

1.

Right-click a Ul element popup button.

A shortcut menu appears.

From the shortcut menu, select Open popup.
A popup window appears.

From the toolbar, select the rotate icon. D

Each click on the tool rotates the window 90° counter-clockwise around the selected
popup button.

OR

Use the arrow keys or directional buttons to move the popup window.

To change a text string, do the following:

1.

Select the text you want to change.

A bounding outline appears around the text.
Right-click on the text.

The Font window appears.

In the Enter Text field, make the changes to the text.

Font style:
Regular

-
: —_| [Marrow Bold
Arial MDHDEPECEC|_| Marrow Bold It —
Arno Pro Bold L
Bold Italic 3
Black —
Arno Pro Display Black Oblique ~

Arno Pro Caption

Colaor: Sample

[ Ivellow

Horizontal

EnterText: Mobile Radio

Click OK to accept the changes.
The text is changed.

OR

Click Cancel.

To change the size of a button, volume control or text string, do the following:
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Select an item or group of items.
From the menu bar, select the increase or decrease width and height icons.

Ha+1-1
OR
Press the Ctrl key while pressing the arrow keys on your keyboard.

To change the size of a popup window, do the following:

1.

Right-click a Ul element popup button.

A shortcut menu appears.

From the shortcut menu, select Open popup.
A popup window appears.

Select the popup button.

+ =
Use the increase or decrease width and height icons < +1 -1 to size the popup
window.

OR
Press the Ctrl key while pressing the arrow keys on your keyboard to size the popup
window.

For more information, refer to the table on “Toolbar”.
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10

10.1

File menu

The File menu contains commands for working with files.

Open

Only files in the C-Soft Designer file format (*.veg) or Telex Design Archive (.tda) can be
opened by the C-Soft Designer program.

NAVIGATION: Select File | Open from the menu bar.

Save

C-Soft Designer saves the active design to the C-Soft Designer file format (*.veg), or the Telex
Design Archive (*.tda) file format. If the active design has not yet been saved to a file, the Save
menu opens the Save As dialog to select a destination file name and type.

NAVIGATION: Select File | Save from the menu bar.

Save As
The Save As... menu option opens the Save As dialog to select a destination file name, file
type, and sets the active design to the specified file.
To save a file by a different name, do the following:
1.  From the File menu, select Save As... .
The Save dialog opens.
2. Navigate to the desired folder.
3. In the File Name field, enter the new file name.

Import SIP Contacts

To include SIP Phone contacts in your TDA file use the Import SIP Contacts menu to open a
file chooser to select a SIP Contacts (*.csv or .veg) file. After selecting the file, the file is
copied and named to the expected Design Data location corresponding to the current design.
As a result, when saving the current Design as a Telex Design Archive, the SIP contacts file is
included in the Design Archive and can be deployed to an IP-30XX device.

File Information
The File Information menu opens the File Information window. For more information, see File
Information window, page 58.

Design Errors window

The Design Errors window appears when a file is saved and C-Soft Designer detects potential
errors in the design.

When the file is saved, the C-Soft Designer program performs a validation on the console
design. The results of the validation are displayed in the Design Errors window.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



58 en | File menu

C-Soft 7.700

Checking for Hidden Buttons in Popup:
Checking for Repeating Port Use:
Checking far Overlapping Button:
Searching Button Functiong----—---

Searching for Backup Line Button Emrorg-—
Searching for Per-Line Configuration Error:
Searching for Call Windows Button Emors-
Searching for Crosspatch Button Errors:
Searching for Dial Button Errors:
Searching for Emergency Button Errors:
Searching for Encryption Button Errars-
Searching for Freq Button Errors
Searching for Group Select Button Erorg---
Searching for GPS Button Errors-
Searching for Input Button Errars-
Searching for Intercom Button Erors
Searching for Marker Tone Button Ermors--
Searching for Monitor Button Errors--
Searching for Mute Button Errars-
Searching for ADHE-4 Button Errors:
Searching for Page Button Erors:
Searching for Phone Button Error.
Searching for PTT Button Erors--
Searching for Radio Button Errors:
Searching for Relay Button Ermors:
Searching for Ry All Button Ermors:
Searching for Scan Button Erors
Searching for Select Button Emors---
Searching for SIP Call Control Button Error:
Searching for Supervisor Button Ermars-
Searching for Talk Around Button Error:
Searching for Tx All Button Emorg--------
Searching for Popup Errors:
Searching for Yolume Contral Emmorg--—-----

Mo Errars Found------

When not all the results can be displayed within the window, scroll bars are provided to
navigate through all of the test results.

Close button

The Close button is used to close the Design Errors window.

10.2 File Information window

The File Information menu is used to open the File Information window. This window
displays:

The file path for the currently open file.

The version of C-Soft Designer used to last save the .veg file, total number of buttons,

popups, and sliders used in the current design.

The Licensing Requirements group box lists the number of lines configured for each

feature and lists the minimum C-Soft License Feature that meets the specification.
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“File Infa t
File Parameters
Path of current file:
C:\ProgramDataTelex Communications\design_folder\Config
Property Value
Last Saved in Version 7.300
Total Buttons 56
Total Popups 2
Total Sliders 9
Licensing Requirements
Feature Lines License Required
Lines 9 TRD-CSOFT-LIMES-12
SIP 2 No license required
P25-DFSI 1} No license required
NEXEDGE 1] No license required
Per Line Call Playback 5 TRD-CSOFT-PLCP-6
DMR-AIS 4 TRD-CSOFT-DAIS-G
P25-Encryption 0 Na license required
APT - TRD-CSOFT-API
Figure 10.1: File Information window
Refer to
—  File Information window, page 58
. . .
10.3 Telex Design Archive (TDA) files

C-Soft Designer allows the export of a container file called the TDA (Telex Design Archive),
which contains all the resource files referenced in a given design. The media contents of a
design file are not stored in the design and use static addressing to display them in C-Soft
Runtime. The TDA container allows creating a design on a separate device that then deploying
it to an IP-30XX, which unpacks and copies the resources to the designated storage locations.

TDA File

Figure 10.2: TDA Contents
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11 Edit menu

The Edit menu, shown in the Figure below, contains commands for the setup and revision of

per line and global parameters for your VolP network. This menu also contains commands to

create and modify individual elements of the console position design.

EE Defaultveg - C-Soft Designer
File Edit | Insert View Configure Run Help

=

Setup Per Line Parameters
Setup Global Parameters
Setup Language Customization
Setup Pagers

Setup Tone Levels

Setup SIP Phone

Setup P23

Setup GPS Mapping
Setup NEXEDGE

Setup Exteral Systems
Setup AIS

Edit Filters

Edit User D List

Edit Group ID List

Edit Status Message D List
Edit Text Message ID List
Edit System

Cut

Copy

Paste

Increase Width
Decrease Width
Increase Height
Decrease Height

Rotate Window

Move Right

Mave Left

Mave Up

Maove Down

Open Popup

Properties

CtrleX.
CtrleC
Crl+V

Figure 11.1: Edit Menu
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12 Per Line Parameters window

The Per Line Parameters window, shown in the Figure below, is used to configure line types,
addresses, port information, and line frequencies for the VolP network. This window allows
configuration of up to 200 separate entries.

The frequency, vocoder, backup IP, and signaling parameters for all lines included in the
console design must be set up on this window. If the line is not set up on this window, the

line is not available as an option when setting up the user interface elements.

Additions and changes can be made to the Per Line Parameters window at any time. However,
make sure all Ul Elements, assigned to the line, are updated.

NAVIGATION: Select Edit | Setup Per Line Parameters from the menu bar.

Per Line Para: rs
Line Packet

Mumber  Line Type Line Mame R Multicast Address Rx Port Tx Multicast Address  Tw Port Baze Radio IP: TTL Delay @,

1 Fire Department 225 8 .11.81 1054 225 8 11.81 1254 0.0.0.0 o I‘
Echo Packets Enable: [7] 0.0.0.0 |1054 0.0.0.0 |[1254

2 [Telw | Sidney Pol 2265 8 .11.81 1055 225 8 11.81 12885 0. .0.0. 10
Echo Packets Enable: [7] 0.0.0.0 [1088 0D.0.0.0 [125%

3 [Tekx  ~] NewporPol 268 .11.81 1056 25 8 11.8 1285 0.0.0. 0
Echo Packets Enable: [7] 0.0.0.0 108 0.0.0.0 |[1256

4 [Tl iDen Line 225.8 11.8 1057 2258 11.8 1257 0.0.0.0
Echo Packets Enable: [ 0.o0.0.0 05 0D.0.0.0 |[1257

5 [Telw =] 16kbVocoder 2265 8 .11.81 1058 225 8 11.81 1258 0.0.0.0

[Teles -] "

Echo Packets Enable: [7] 0.0.0.0 |[i058 0.0.0.0 |1258

= + | Supenvisor Line 2658 1181 1059 225 8 11.8 1259  0.0.0.0 -
Echo Packets Enable: [] 0.0 0.0 [1058 0.0.0.0 [1259 5

7 [Disabled +|[Line7 225.8 .11.81 1080 | 225. 8 .11.8 1260 | 0.0.0.0 [6] [10 " Sianal

Figure 12.1: Per Line Parameters window

Line Number Field
The Line Number field displays the number of the line. This number is used for identification
purposes in the design of the console position.

Line Type Drop Down Menu

The Line Type drop down menu identifies the type of line being configured. When a selection
is made in the line type field, the fields necessary to enter the setup information for that line
type are enabled.

Available selections for this field are:

- Disabled - Line is not enabled. When the line is configured, it can be disabled without
losing configuration settings. Note that Line 1 cannot be disabled.

—  Telex - Compatible with Telex VolP radio dispatch products, such as the C-6200, IP-223 or
IP-224. Select Telex for FleetSync, Sprint Direct Connect, MDC-1200, or MOTOTRBO
(refer to “Copyright notice, page 11”) Professional Digital Two-Way Radio System.

—  Phone - Allows the console to access a telephone line from across the network. Phone
configurations require the use of Telex’s PIB or TDI adapter. For more information, see
the IP-223 Phone Interface Box Technical Manual (F.01U.188.265) or the Telephone
Dispatch Interface Technical Manual (F.01U.196.107) available for download at
www.telexradiodispatch.com.
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—  SIP Phone - Each C-Soft 7.000 License comes with two SIP lines. Additional lines can be
purchased as an additional feature, and are available in 6, and 12 line increments. For
more information refer to SIP (Session Initiation Protocol) configuration, and to “S/P
Phone line configuration, page 111”.

—  P25-DFSI - For more information, refer to “Setting up a P25-DFSI Line”.

—  NEXEDGE - For more information, refer to “NEXEDGE Trunking System Setup”.

— AIS - For more information, refer to “DMR-AIS”.

—  P25-CSSI - For more information, refer to “CSSl Interface”.

Line Name Field
The Line Name field is used to enter a descriptive name for the line. This name is used for
identification purposes in the console position design.

This field can contain up to 30 characters.

RX Multicast Address Fields

The RX Multicast Address fields identify the broadcast address for all audio traffic. This
dotted quad number must be between 224.0.0.2 and 239.255.255.255. Devices can have the
same or different Multicast Address for RX channels. Telex VolP enabled equipment can use
one Multicast Address for all lines with the port number defining the RX channels.

Note:

—  Unicast addressing (point-to-point communications) is also supported. Enter a static IP
address of the receiving gateway device.

—  The RX Multicast Address must match the RX Multicast Address setup on the IP-223,
IP-224, or a C-6200 if it is the gateway.

RX Port Fields
The RX Port fields identify the RX port numbers. These numbers must be unique per channel
and must be between 1054 and 65535.

The RX port number must match the port number set up on the IP-223, IP-224, or a C-6200 if
it is the gateway.

TX Multicast Address Fields

The TX Multicast Address fields identify the broadcast address for all audio traffic. This
dotted quad number must be between 224.0.0.2 and 239.255.255.255. Devices can have the
same or different Multicast Address for TX channels. Telex VolP enabled equipment can use
one Multicast Address for all lines with the port number defining the TX channels.

Note:

—  Unicast addressing (point-to-point communications) is also supported. Enter a static IP
address of the receiving gateway device.

—  The TX Multicast Address must match the TX Multicast Address setup on the IP-223,
IP-224, or a C-6200 if it is the gateway.
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TX Port Fields
The TX Port fields identify the TX port numbers. These numbers must be unique per channel
and must be between 1054 and 65535.

The TX port number must match the port number set up on the IP-223, IP-224, or a C-6200 if it
is the gateway.

EXAMPLE: In the Figure below, the RX Port is 1054 and the TX Port is 1254 for Line 1. All
consoles monitoring receive audio for channel 1 must share the same Multicast Address, as
well as the same RX port number. Any console transmitting on the network must set its port
number to 1254 to cause the radio to key up.

Line Options Setup: Line

Line Setup Options
Yocoder Type | TELE= 32K

T2 Monitor Enable [] Scannable
[T] Packet Delay for Satelite Maode

Backup IP Setup
Multicast Address Part
R o.o0.0.0 1054
T o.o.0.0 1254

BaseRadiolP: 0 .0 .0 .0

Base Radio IP Field

The Base Radio IP field identifies the IP Address of the IP-223 or IP-224 used by the C-Soft
program to create a TCP connection to the specified address. This address is required for the
C-Soft program to create an internal ping command. It is also required for full-duplex mode
(i.e., telephone mode) and to generate encoded message strings (i.e., 5/6 Tone). We
recommend you include a base radio IP Address for all lines within your system design.

The base radio IP Address can be configured to periodically ping the IP gateway to determine
if a network connection still exists for a particular radio. If there is no response received from
the ping, the backup IP radio address is used.

A backup button is available for the console design. This button is used to force a switch, or to
monitor whether the primary or backup channel is used. Additional information on this feature
is provided in “Backup Line, page 232”.

TTL Field

The TTL field identifies the number of routers the Multicast audio packets go through before
being stopped. The network design dictates this value. If audio is not reaching a particular
node on the network, increasing this value may correct the problem.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



64 en | Per Line Parameters window C-Soft 7.700

The range for this field is 1 to 99.

Packet Delay Field

The Packet Delay field identifies the length of delay before playback, in 20ms packets. Some
buffering of these packets must occur before playback to help absorb network delays, jitters,
and lost packets. The typical entry for this field is 6, which translates to a delay of 120ms
before playback (each packet is 20ms of audio). Larger values may be required for
complicated networks, smaller values for simpler networks.

The range for this field is 4 to 64.

Echo Packets Enable Check Box

The Echo Packets Enable check box indicates the system operates on networks that do not
support multicast. The C-Soft program must be running at all times to translate and transfer
packets from one IP subnet to another.

A typical application has a number of radios spread throughout a network without multicast.
In this case, the radio adapters (IP-223s, IP-224s or C-6200s) are programmed to send packets
to the IP Address of the PC running the C-Soft program with Echo Packets enabled.

An example of an Echo Packet system, where three different radios are connected through a
WAN, is shown in Appendix D - Echo Packets Diagram, page 478. In each of the subnets, a
single copy of the C-Soft program is used to communicate to the radio in its subnet. A second
console is used to echo the audio traffic to other copies of the C-Soft program. The C-Soft
program also echoes all traffic to a Multicast Address within its subnet so additional consoles
can be added to the system by specifying the Multicast Address.

Options Button
The Options button opens the Line Options Setup window, shown in the Figure below, for the
selected line.

Freqs Button
The Freqgs button opens the Frequency Parameters window for the selected line. For more
information, refer to “Frequency Parameters window, page 67”.

Signal Setup Button
The Signal Setup button opens the Signaling Parameters window. For more information, refer
to “Signaling Parameters window, page 72”.

SIP Button
The SIP button opens the Configuration SIP Settings window. For more information, refer to
“Configure SIP Settings window, page 108”.

12.1 Line Options Setup window

The Line Options Setup window is used to configure the monitoring capabilities, digital
format in the line setup options and the backup IP to use if network resources of the primary
radio interface identified for the line fail.
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Line Options Setup: Line

Line Setup Options
Wocoder Type | TELEX 32K -|

T2 Monitor Enable [] Scannable
[T] Packet Delay for Satelite Maode

Backup IP Setup
Multicast Address Part
R o.o0.0.0 1054
T o.o.0.0 1254

BaseRadiolP: 0 .0 .0 .0

Figure 12.2: Line Options Setup window

Notice!
Vocoder configurations must be the same across devices.

To open the Line Options Setup window, do the following:
1. Select Edit | Per Line Parameter.
The Per Line Setup window appears.
2. Click Options.
The Line Options window appears.

Line Setup Options group box
Vocoder Type drop down menu
The Vocoder Type drop down menu indicates the bit rate at which audio is converted into

digital format. This feature is used to configure communication between C-Soft and an IP-223
or IP-224.

Available selections for this field are:
TELEX 32K, G.726 16K, G726 32K (IP224 Only), and G.711 64K (IP224 Only).

The G.726 32K (IP224 Only) and G.711 64K (IP224 Only) vocoders are only supported on C-
Soft version 6.000 or higher, Network Recorder version 4.500 or higher, and the IP-224.
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Line Cptions Setup: Line

Line Setup Optiahs
Woooder T_','DE TELEH 32K T
m Cancel

G.726 32K [IP224 Ornily)
[] Packet Del: G.711 B4K [IP224 Only]

Figure 12.3: Vocoder Type drop down menu - Line Options Setup

| T Moritor G.72E 1EK. |

Notice!
The TELEX 32K is the same as the previous ADPCM 32K, and the G.726 16K is the same as
the previous ADPCM 16K.

TX Monitor Enable check box
The TX Monitor Enable check box indicates the console operator can monitor TX traffic from
other console operators.

Scannable check box

The Scannable check box indicates the console operator is allowed to control the scan list of
a particular radio. The frequency button is used in C-Soft Runtime to add or delete radio
channels from the scan list.

Notice!
This feature is not supported on all radios, only Kenwood TK-x80, TK-x150/180, TX-5x10, and
NEXEDGE support.

Packet Delay for Satellite Mode check box

The Packet Delay for Satellite Mode check box enables Satellite Mode which means if there
is an issue with play out audio within the correct timing (burst of packets instead of
consistent 20ms packets) no packets are dropped, but there is an audio delay based on how
inconsistently the packets are received.

If not selected, Normal mode is enabled meaning if there is an issue with playing audio within
the correct timing, packets are dropped so the audio delay is no longer than the Packet Delay
plus 80ms.

Backup IP Setup group box

RX Multicast Address and Port fields
The RX Multicast Address and Port fields identify the receive Multicast Address and port to
use if the primary receive path fails.
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12.2

TX Multicast Address and Port fields
The TX Multicast Address and Port fields identify the transmit Multicast Address and port to
use if the primary transmit path fails.

Base Radio IP field
The Base Radio IP field identifies the backup IP Address of the base radio, should the primary
address fail.

Buttons
The OK button saves the entries and closes the window.

The Cancel button discards any changes made and closes the window.

Frequency Parameters window

The Frequency Parameters window, shown in the Figure below, is used to enter the
parameters for the individual function tones available for the selected line.

Additions and changes can be made to the Frequency Parameters window at any time.
However, if any user interface elements have been placed on the console window, the changes
made to a line must also be changed on the individual elements, if needed.

0K

Fire Gnd 2

2
3

4 [Fread
5 [Fieas
6
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8

Freq
Enable Number Frequency Name
1 FieGnd1

e

EEE

Fieq6

Freq?

OoOoO

Fiea8
9 Freq 9
Fieq 10
1 [Fregll
12 [Fregi2
13 [Freq13
14 [Fregl4
15 [Freq15
16 [Freq16 <

o
3
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] [

Pai Made Setup
345678 910111213141516

Pairl: [[]

Paii2:

Pair3:

Paird: (7]

RX Block Lines:
1:Line 1 -
2-Not Enabled- 7
3:-Not Enabled- -
4:-Not Enabled-
5:-Not Enabled-
6:-Not Enabled- i

Figure 12.4: Frequency Parameters window

Enable Check Box
The Enable check box indicates the corresponding frequency numbers are available to the
console operator for selection on the line.

Frequency Name Field

The Frequency Name field is used to enter a descriptive name for the frequency. This name is
used to identify the frequency for the elements used in the design of the console position and
is made available for selection in a list of variables.

When a frequency name is changed, a Frequency Change button’s text does not automatically
update. This is done separately.
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This field can contain up to 20 characters.
OK Button
The OK button saves the entries and closes the window.

Load File Button
The Load File button is used to load a .csv file into the current frequency window.

Notice!
When the .csv file is loaded, all items in the current list are overwritten.

To load a saved frequency .csv file, do the following:
1. Click Load File.
The Open window appears.
2. In the Open window, select the file you want to load.
3. Click Open.
The file is loaded, the Frequency Name field is populated and the Enable check box is
selected.

Save File Button
The Save File button is used to save the current frequency names to a .csv file.

To save the currently enabled frequency names to a .csv file, do the following:
1. Click Save File.
The Save As window appears.
2. In the Filename field, enter a name.
3. Click Save.
The .csv file is saved in the current folder.

Pair Mode Setup Check Boxes

The Pair Mode Setup check boxes allow function tones to have control functions not used for
actual control of the radio. There are four wildcard groups available per line. Function tones 1
and 2 are not allowed in a wildcard group and a function tone may not be selected in more
than one group. One function tone from each group can be active at a time, plus either F1 or
F2.

RX Block Lines Display Box

The RX Block Lines display box contains a list of all the lines in the system. Each line selected
in the list has its received audio blocked from the speaker when the line you are currently
configuring is selected. This allows the console operator to transmit on a radio that has
overlapping coverage with other radios without getting feedback from the radios receiving the
transmitted signal. This function also operates when a parallel console is transmitting on the
line.

To mute a line during transmission, do the following:
1. Select the line(s) in the display box.
The line is highlighted.
2. Click the line(s) a second time to clear the selection.
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The line is no longer highlighted.
Notice!
Individual lines must have Mute Per-Line buttons associated with them for this feature to
work.

12.3 Frequency Parameters windows - MOTOTRBO

Channel Setup Page

When the Freq button for a Telex line configured for a system type of MOTOTRBO line is
clicked, the Frequency Parameters window opens to the Channel Setup page. The Channel
Setup page, shown in the Figure below, is used to enter the MOTOTRBO line’s channel, zone,
channel name, pair mode setup and RX block.

Notice!
The General Signal Setup window must be configured for MOTOTRBO system type before
MOTOTRBO parameters are available on this page. Refer to “Signaling Parameters Window”.
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RX Block Lines:
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Figure 12.5: Frequency Parameters - Channel Setup Page

Enable check box
The Enable check box indicates the corresponding frequency numbers are available to the
console operator for selection on the line.

Zone field
The Zone field is used to enter a MOTOTRBO zone number. The same zone number must also
be configured in the radio.
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Chan field
The Chan (Channel) field is used to enter a MOTOTRBO channel number. The same channel
number must also be configured in the radio.

Channel Name field

The Channel Name field is used to enter a user-recognizable name for the frequency. This
name identifies the frequency for elements used in the console design and is available for
selection in C-Soft Runtime.

This field can contain up to 20 characters.

Notice!

If the Channel Name field is changed, the Channel Name button’s text does not automatically
update. This is done separately.

All Call Check box
The Al Call check box indicates the All Call function is enabled in C-Soft for the associated
channel. The MOTOTRBO radio must be configured for All Call.

Zone Setup Page

When the Zone Setup tab is clicked from the Frequency Parameters window, the Zone Setup
page appears. The Zone Setup page, shown in the Figure below, is used to set up zone names.
The Zone Setup window supports up to 250 different zone names.

[ Channel Setup | Zone Setup 0K
e Load File
Number Zone Name -
2 Channel Pool|
3 Zone 3
4 Zone 4
5 Zone 5
6 Zone 6
7 Zone 7
8 Zone 8
9 Zone 9
0 Zone1d
1 Zone 11
2 zonen2
1B Zone13
14 Zone 14
15 Zone 15
16 Zone 16 -
2 Channel Pool Zone
Pair Mode Setup
3456789 1011121314151
rr: D000
rar2 DO E O
[CElEllele]
rar DO E O
RX Block Lines:
1:Fire Department A
2:Sidney Police a
3:Newport Police
4:iDen Line
5:16kb Vocoder
| 6:Supervisor Line S

Figure 12.6: Frequency Parameters window - Zone Setup Page

Zone Name field

The Zone Name field is used to enter a user-recognizable name for the zone. The name should
match the zone name configured in the radio.
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This field can contain up to 20 characters.

Notice!
A Zone is a place channels are stored in a radio.

Channel Pool Zone field
The Channel Pool Zone field indicates the zone number used for a channel pool.

REFERENCE: If there is a fixed zone for channel pool programmed in the MOTOTRBO radio,
the zone must be entered in this field. For more information, refer to Motorola’s technical
documentation.

OK button
The OK button saves the entries and closes the window.

Load File button
The Load File button is used to load a .csv file into the current frequency window.

Notice!
When the .csv file is loaded, all items in the current list are overwritten.

To download a saved frequency .csv file, do the following:
1. Click Load File.
The Open window appears.
2. Inthe Open window, select the desired file.
3. Click Open.
The file is loaded, the Frequency Name field is populated and the Enable check box is
selected.

Save File button
The Save File button is used to save the current frequency names to a .csv file.

To save the currently enabled frequency names to a .csv file, do the following:
1. Click Save File.
The Save As window appears.
2. In the Filename field, enter a name.
3. Click Save.
The .csv file is saved in the current folder.
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Pair Mode Setup check boxes

The Pair Mode Setup check boxes allow function tones to have control functions not used for
actual control of the radio. There are four wildcard groups available per line. Function tones 1
and 2 are not allowed in a wildcard group and a function tone may not be selected in more
than one group. One function tone from each group can be active at a time, plus either F1 or
F2.

RX Block Lines display box

The RX Block Lines display box contains a list of all the lines in the system. Each line selected
in the list has its received audio blocked from the speaker when the line you are currently
configuring is selected. This allows the console operator to transmit on a radio that has
overlapping coverage with other radios without getting feedback from the radios receiving the
transmitted signal. This function also operates when a parallel console is transmitting on the
line.

To mute a line during transmission, do the following:
1. Select the line(s) in the display box.
The line is highlighted.
2. Click the line(s) a second time to clear the selection.
The line is no longer highlighted.

Notice!
Individual lines must have Mute Per-Line buttons associated with them for this feature to
work.

124 Signaling Parameters window

When Telex is selected in the Line Type drop down menu, and the Signal Setup button on the
Per Line Parameters window is clicked, the General Signal Setup page, shown in the Figure
below, appears.
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-
Signaling Parameters: Line

|| | General Signal Setup |

System Settings

System Type: [Generic v]

Systemn Name: MNane

Signaling AutoFill Setup
[] Enable Signaling AutoFil

Starting Line Number: 1

Ending Line Mumber: 1

Call Logging
Display Al Calls

System Settings Group Box

System Type drop down menu
The System Type drop down menu is used to configure the signaling type for the individual
line.

Available selections for Telex Line Type are:

—  Generic - For more information, refer to “Generic system type, page 75”.

— 5/6 Tone/DTMF ANI - For more information, refer to “5-6 Tone/DTMF AN/ system type,
page 75”.

—  FleetSync - For more information, refer to “FleetSync system type, page 83”.

— iDEN - For more information, refer to “iDEN System Type”.

—  Telex-Serial - For more information, refer to “Telex-Serial system type, page 86”.

— MDC-1200 - For more information, refer to “MDC-1200 system type, page 88.

-  MOTOTRBO - For more information, refer to “MOTOTRBO system type, page 92”.

—  Sprint Direct Connect - For more information, refer to “Sprint Direct Connect system
type, page 96”.

—  Telex-Enhanced-ANI - For more information, refer to “Telex-Enhanced-ANI system type,
page 98”.

Available selections for Phone Line Type are:
—  Generic - For more information, refer to “Generic system type, page 75”.
—  Phone - For more information, refer to “Phone system type, page 100”.

Available selections for P25-DFSI Line Type are:
—  P25-DFSI - For more information, refer to Appendix E, “Setting up a P25-DFSI Line”.
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Available selections for NEXEDGE Line Type are:
—  NEXEDGE - For more information, refer to Appendix F, “NEXEDGE Trunking System
Setup”.

Available selections for P25-CSSI Line Type are:
—  P25-CSSI For more information, refer to Appendix G, “CSSI Interface”.

Notice!
The Signaling Setup button is disabled for lines types of Disabled and SIP.

System Name drop down menu

The System Name drop down menu is used to select a system for the selected line. If the
System Type field is set to FleetSync, MDC-1200, MOTOTRBO or Telex-Serial, this field
becomes active.

Notice!
Systems are configured by the user. Refer to “Edit System List Window”.

Edit System button

The Edit System button is used to open the Edit System window. From this window, you can
modify the systems included in the Per Line Parameter configuration. For more information,
refer to “Edit System List Window”.

Signaling Autofill Setup group box

Enable Signaling Autofill check box
The Enable Signaling Autofill check box indicates the signaling parameters configured on the
current line are copied and then pasted into the corresponding line numbers.

Starting Line Number field
The Starting Line Number field is used to indicate the first line to which signaling parameters
are copied.

Notice!
The Enable Signaling Autofill check box must be selected to enable autofill.

Ending Line Number field
The Ending Line Number field is used to indicate the last line to which signaling parameters
are copied.
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Notice!
The Enable Signaling Autofill check box must be selected to enable autofill.
Call Logging group box
Display All Calls check box
The Display All Calls check box allows you to choose to display all calls in the Per-Line Call
History window, regardless of the call’s destination ID. If cleared, only calls sent to the
console or a group containing the console’s ID are displayed in the Per-Line Call History
Window.
Notice!
The Display All Calls check box is only enabled when the following System Types are selected:
Generic, 5/6 Tone/DTMF ANI, FleetSync, and MDC-1200. For other system types, the Display
All Calls check box is not applicable.
OK button
The OK button saves the entries and closes the window.
Cancel button
The Cancel button discards any settings made and closes the window.
12,5 Signal system types
12.5.1 Generic system type
The Generic system type option is used to configure the line for a system type other than
those listed.
To configure the line for a Generic system, do the following:
1. Select Edit | Per Line Parameters from the menu bar.
The Per Line Parameters window appears.
2. From the Line Type drop down menu, select Telex.
3. Click Signal Setup.
The Signaling Parameters window appears.
4. From the System Type drop down menu, select Generic.
5. Select Display All Calls, to display all calls in the Per-Line Call History window.
12.5.2 5-6 Tone/DTMF ANI system type

The 5/6 Tone/DTMF ANI (Automatic Number Identification) system type option is used to set
the line type signal to 5/6 tone or DTMF signaling.

Notice!
The IP-224 does not support 5/6 Tone or DTMF encoding or decoding functions.
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To configure the line for a 5/6 DTMF ANI type, do the following:
1. Select Edit | Per Line Parameters from the menu bar.
The Per Line Parameters window appears.
2.  From the Line Type drop down menu, select Telex.
3. Click Signal Setup.
The Signaling Parameters window appears.
4. From the System Type drop down menu, select 5-6 Tone/DTMF ANI.
The 5/6 Tone DTMF ANI Setup tab and Call Setup tab appear.

5/6 Tone DTMF ANI Setup page
When 5/6 Tone DTMF ANI is selected from the System Type drop down menu, the 5/6 Tone/
DTMF ANI Setup page appears, as shown in the Figure below.

Signaling Parameters: Sidney Poli E
General Signal Setup | 56 Tone/DTMF ANI Setup | Call Setup |

Per Line Consale 1D
Unit 1D: 123 Defaults
Auto Ack Setup
Signaling Setup Auto Ack Type: — ,]
Signaling Type: CCIR1 - Auto Ack Delay: 2000 | ms
Digit Duration: 25 ms
Imterdigit Duration: 0 ms Single Tone Auto Ack Setup
Pause Duration: 25 ms Frequency: 000 |Hz
Duration: 25
Preamble Durgtion: 25 g uratian ms
Lewel: -3 |dB
Level: 3 dB
Signaling Del
Twist Level: 0 dB gnaling Delays
Group Digit: A Initial Delay: 750 ms
End Delay: 0 ms
Repeat Digit: E

Figure 12.7: 5/6 Tone/DTMF ANI Setup Page - Signaling Parameters
Per Line Console ID group box

Unit ID field
The Unit ID field is used to assign a numeric identifier to the console’s line. The unit ID
appears when a radio is called from the specified console line.

This field can contain up to 8 digits.
Signaling Setup group box

Signaling Type drop down menu
The Signaling Type drop down menu identifies the signaling type used when generating a call.

Available selections for this field are:
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- CCIR1
- CCIR2
- DTMF
- DZVEI
- EEA

- EIA

- EURO
- KENWOOD 5-TONE
- MODAT
- NATEL
- PCCIR
- PDZVEI
- PZVEI
- ZVEIl

- ZVEI2

Digit Duration field
The Digit Duration field represents the length of time, in ms, the digit tone plays when it is
active.

The range for this field is 25 to 9999ms.

Interdigit Duration field
The Interdigit Duration field represents the length of time, in ms, between the digit tones
within a group.

The range for this field is 25 to 9999ms.

Pause Duration field
The Pause Duration field represents the length of time, in ms, allowed between transmitted
groups.

The range for this field is 25 to 9999ms.

Notice!
The pause duration must be at least the sum of the Digit and Interdigit Duration fields.

Preamble Duration field

The Preamble Duration field represents the length of time, in ms, the first tone digit plays.
With some radio systems, the first tone needs to be longer than subsequent tones. For
example, the first tone may be used to activate a dormant (battery saving) state.

The range for this field is 25 to 9999ms.
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Notice!
The preamble duration must be at least the amount of the Digit Duration field.

Level field
The Level field represents the relative level, in dB, the encoded message sends.

The range for this field is -20dB to +12dB.

Twist Level field

The Twist Level field represents the relative level difference, in dB, of high and low tones
generated when using DTMF tone types. This field is only active when DTMF is the selected
tone type.

The range for this field is -10dB to +10dB.

Group Digit field
The Group Digit field represents the group identification defined by the radio system.
Typically this digit is not used anywhere else in the system.

This range for this field is 0-9 or A-D, # and *.

Repeat Digit field

The Repeat Digit field identifies a repeat digit. Repeat digits are used to signal a digit has
been repeated. Repeat digits are used to maintain tone transitions at appropriate intervals,
which simplifies the decode function.

EXAMPLE: The repeat digit is E and the subscriber ID is 23335. The encoder string would
actually send a tone string of 23E35.

Defaults button
The Defaults button resets all the signal parameters back to the default values.

Auto Ack Setup group box

Auto Ack Type drop down menu
The Auto Ack Type drop down menu allows you to choose the signaling type desired to
acknowledge receipt of a call.

Available selections for this field are:

— Disabled - Indicates no acknowledgement is sent after receiving a call.
— Single-Tone - Indicates a single tone is sent after receiving a call.

—  Signaling - Indicates the Auto Ack field is available for formatting.

For more information, refer to “Auto Ack Field” in “Auto Ack Field”.

Auto Ack Delay field
The Auto Ack Delay field allows you to configure the lead-in delay, in ms, for receiving
messages configured to transmit acknowledgements back to the calling radio.
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The range for this field is 0 to 9999ms.
Single Tone Auto Ack Setup group box

Frequency field
The Frequency field represents the frequency, in Hz, generated during a single tone
acknowledgement.

The range for this field is O to 4000Hz.

Duration field
The Duration field represents the duration, in ms, of the single tone acknowledgement.

The range for this field is 25 to 9999ms.

Level field

The Level field represents the relative level, in dB, the encoded message sends.
The range for this field is -20dB to +12dB.

Signaling Delays group box

Initial Delay field
The Initial Delay field represents the lead-in delay, in ms, for console-generated messages
transmitted to the field radios.

The range for this field is O to 9999ms.

End Delay field
The End Delay field identifies the delay, in ms, at the end of transmitted messages to the field.
It delimits the tone string.

The range for this field is 0 to 9999ms.

Notice!
A value is required for this field. Do not leave blank.

Call Setup page
When 5/6 Tone/DTMF Tone ANI is selected from the System Type drop down menu the Call
Setup page appears, shown in the Figure below.
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Signaling Parameters: Sidne:

General Signal Setup | 5-6 Tone/DTMF ANI Setup | Call Setup |

Call Setup
Format

Auto Ack:

Emerg. Resolved:

PTT BOT:

PTTEOT:
Call 1
Call 2:
Call 3:
Call 4:
Call &:
Call &:
Call 7:
Call 8:
Call 5:

Call 10:

Figure 12.8: Call Setup Page - Signaling Parameters
Call Setup group box

Auto Ack field

The Auto Ack field represents an automatically generated acknowledgement message that is
sent to the field after receiving a select call. First, configure the “Auto Ack Type drop down
menu”, then configure this field using the proper format.

This field can contain up to 32 characters.

Field values can be: Low or High.

- DTMF Format - Allows for 0-9, *, #, A-D, G, |, K, P, R, and S.

—  5-Tone Format - Allows for 0-9, A-F, G, I, K, P, R, and S.

For more information, refer to the table “Call setup group format descriptions” below.

Emerg Resolved field

The Emerg Resolved (Emergency Resolved) field represents the message sent each time an
emergency is acknowledged (for example, when the Emergency Ack button is pressed in the
Active Emergency window).

This field can contain up to 32 characters.

Notice!
A message is sent only if the emergency is active.
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Field values can be: Low or High.

—  DTMF Format - Allows for 0-9, *, #, A-D, G, |, K, P, R, and S.

—  5-Tone Format - Allows for 0-9, A-F, G, |, K, P, R, and S.

For more information, refer to the table “Call setup group format descriptions” below.

PTT BOT field
The PTT BOT (Push-To-Talk Beginning Of Transmit) field represents the message sent each
time the PTT button is pressed on the console at the beginning of transmit.

This field can contain up to 32 characters.

Field values can be: Low or High.

—  DTMF Format - Allows for 0-9, *, #, A-D, G, |, K, P, R, and S.

—  5-Tone Format - Allows for 0-9, A-F, G, |, K, P, R, and S.

For more information, refer to the table “Call setup group format descriptions” below.

PTT EOT field
The PTT EOT (Push-To-Talk End Of Transmit) field represents the message sent each time the
PTT button is pressed on the console at the end of transmit.

This field can contain up to 32 characters.

Field values can be: Low or High.

-  DTMF Format - Allows for 0-9, *, #, A-D, G, |, K, P, R, and S.

- 5-Tone Format - Allows for 0-9, A-F, G, I, K, P, R, and S.

For more information, refer to the table “Call setup group format descriptions” below.

Call (1-10) Format field

The Call (1-10) Format fields represent the message sent when selected by the console
operator on the Per Line Call History, Call List Window, or the Manual Call List window. Refer
to the Figure below.

This field can contain up to 32 characters.

Field values can be: Low or High.

- DTMF Format - Allows for 0-9, *, #, A-D, G, |, K, P, R, and S.

—  b5-Tone Format - Allows for 0-9, A-F, G, |, K, P, R, and S.

For more information, refer to the table “Call setup group format descriptions” below.

Call (1-10) Label field

The Call (1-10) Label fields represent the label applied to the button on the Per Line Call
History, the Manual Call Window, and the Call List Window popup button, shown in the Figure
below.

This field can contain up to 31 alphanumeric characters.
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Defaults button
The Defaults button resets the fields to their default values.

Value

Description

Stands for Console ID. Use the “Unit ID Field” on page 75 or “User ID Field” on
page 83 to configure the Console ID. This value must match the number of digits
in the Console ID.

For example, the Console ID is 123, the value entered in the format field would
be IIl.

Stands for Group. This is used to make a Group Call. The Group ID is configured
on the “Edit System List Window - System Menu” on page 180 to configure
Group IDs. This value must match the number of digits in the Group ID.

For example, the Group ID is 5000A, the value entered in the format field would
be GGGGG.

NOTE: Not applicable for iDEN setup.

Stands for Status. Use the “Status Message ID List Window” on page 172 to
configure Status IDs.

Stands for Pause. When you want to format a pause into the string being sent
out, use a P. Pause Duration is set up in Signaling Setup.

Stands for Radio ID. You must enter the exact number of digits in the radio ID.
For example, if you pick User ID 12356, you must enter RRRRR.

Takes all the digits in the User ID of the type of call being made. In this format,
you can enter a K, which enters all numbers associated with the User ID column.

formats.

NOTE: You can use any combination of these values with the numerical digits to create

Tab. 12.2: Call setup group format descriptions
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Per Line Call History: 5/6 Tene Li

Date Time Freq Status Uszer ID Calling IDv
|
Sevs RS ((Setsets
| Private Call | | Group Call | | Status | |Di.rect:Norﬂ'1 | Direct:East |
|Di.rect:Sout|'1 | | Direct:West | Calla | | Calla | Call10 |

Save ta File Dane

Figure 12.9: Per Line Call History Window for 5/6 Tone or iDEN Line

12.5.3 FleetSync system type
The FleetSync system type option is used to configure the line used to encode/decode
FleetSync IDs and status codes.
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Signaling Parameters: Line 1

General Signal Setup

System Settings
System Type: Generic w
Generic
System Name: 56 Tone/DTMF ANI Edit System
iDEM
Telex-Senal
MDC-1200

Signaling AutoFill Setul poToTRBO

o [ Sprint Direct Connect
[1Enable Signaiing {2577 =2 2l

Starting Line Mumber:
Ending Line Number:

Call Logging

Digplay All Calls

Figure 12.10: FleetSync System Type

To set the system type to FleetSync, do the following:
1. Select Edit | Per Line Parameters from the menu bar.
The Per Line Parameters window appears.
2.  From the Line Type drop down menu, select Telex.
3. Click Signal Setup.
The Signaling Parameters window appears.
4. From the System Type drop down menu, select FleetSync.
The FleetSync Setup tab appears.
5.  From the System Name drop down menu, select a system for the line.

FleetSync Setup page
When FleetSync is selected from the System Type drop down menu, the FleetSync Setup
page appears, shown in the Figure below.
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Signaling Parameters: Fire Departﬁ

| General Signal Setup | FleetSync Setup

| Per Line Consale [D
Fleet 1D 100

User 1D: 1000

Call Permission Setup
Allow Broadcast Calls on thig Line
AMlow InterFleet Calls on this Line

Iser Display Options
[] Ony Display Fitters

Figure 12.11: FleetSync Setup Page—Signaling Parameters

Per Line Console ID group box

The Per Line Console ID group box is used to define the Fleet ID and User ID. The Fleet ID is
added to the front of the User ID to create the Per Line Console ID. This ID appears on radio
when receiving data/audio from that console line.

EXAMPLE: To create console ID 1234567, enter 123 as the Fleet ID and 4567 as the User ID.
Whenever the operator presses the PTT button or send a FleetSync data message, the
receiving radios display the console ID configured for the line.

Fleet ID field
The Fleet ID field is used to enter the 3-digit Fleet ID number of a group of FleetSync radios
and is assigned per line.

The range for this field is 100 to 349.

Unit ID field
The User ID field is used to identify the console’s 4-digit User ID to FleetSync radios
programmed for Over-The-Air-Protocol.

The range for this field is 1000 to 4999.

Note:

— The IP-223 or IP-224 must be configured for FleetSync Encode.

— The Console ID does not appear if the mobile radio connected to the IP-224 is configured
for FleetSync Signaling.
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Call Permission Setup group box

Allow Broadcast Calls on this Line check box
The Allow Broadcast Calls on this Line check box is used to grant the line permission to place
FleetSync broadcast calls.

Allow InterFleet Calls on this Line check box
The Allow InterFleet Calls on this Line check box is used to grant the line permission to place
calls to fleets or units outside the console’s fleet.

User Display Options group box

Only Display Filters check box

The Only Display Filters check box indicates, in addition to the system name, that only filters
containing fleets and units display in the C-Soft Runtime FleetSync Dispatching window’s
system list, refer to the Figure below. All components in the system are visible including
groups and individuals, otherwise only filters and their components are visible.

Notice!
The Only Display Filters check box controls the system list appearance only. Component
permissions are controlled per line, refer to “FleetSync system type, page 83".

FleetSyne Dispatehing FlestSyne Dispatching

Only Display Fllters K Only Display Filters b 3] S
option selected Fokes El 4 option unselected . L
- o E =
- os;am: + @ Saud C
Cae 100 = P Souad B
& Ca 10 & Car 105
& Cu 102 & Car 107
@103 & Ca 1l
g Cae 104 ©Cuil
Cuw 105 Souad A
& Ca 107 # @ Sidney Police
& Cu 108 & Mewport Polce
& Cx 109 = Dupatchers
=40 Squad B @ Sidewey Dispatch
& Culls & Hewport Dupach
& Ca 107 / = # Sidney Police
& Cx 08 Filters a0
& Cx 109 e & a0l =
‘.’os;wpum Fles gE::g
/ % Newport Police @ Cartld
/ € Dispaichens — & Sidney Dispatch
” D Sidney Dispatch Shabus | = ¢ Newport Polce Stalus
i & Newpost Dispatch - & Car 108
Filters
[ & Ca 107
@ Coa 1082
Ertet Te & Car 1088 Ert
— & Mewport Dinpatch
Hieu's Console
Groups
Individual I
I [

Figure 12.12: FleetSync System List Filters Display in C-Soft Runtime

1254 Telex-Serial system type
The Telex-Serial system type option is used to configure the line for serial radio control. The
System Type is used for a variety of radio brands. Consult the IP-224 user manual for a full list
of radios utilizing the Telex-Serial Type option.
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signaling Pararneters: Line 1

General Signal Setup

System Settings
System Type: Generic e
Generic
System Name: 56 Tone/DTMF ANI Edit System
Fleet Sync
iDEM

Telex-5eral
Signaling AutoFill Setupg ﬂg%%o

e | Sprint Direct Connect
[JEnable Signaiing | 7210, Erhanced-AN

Starting Line Mumber:
Ending Line Mumber:

Call Logging

Display Al Calls

Figure 12.13: Telex-Serial System Type

To set the system type to Telex-Serial, do the following:
1. Select Edit | Per Line Parameters from the menu bar.
The Per Line Parameters window appears.
2.  From the Line Type drop down menu, select Telex.
3. Click Signal Setup.
The Signaling Parameters window appears.
4. From the System Type drop down menu, select Telex-Serial.
The Telex-Serial Setup tab appears.
5. From the System Name drop down menu, select a system for the line.
6. Click the Telex-Serial Setup Tab.
The Telex-Serial Setup page appears.
7. Inthe Console ID field, enter the console ID.

Telex-Serial Setup page
The Telex-Serial Setup page, shown in the Figure below, is used to define the Per Line
Console ID.
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125.5

General Signal Setup | Telex Serial Setup

Per Line Consale D

Console ID: (I

Figure 12.14: Telex-Serial Setup Page

Per Line Console ID group box
The Per Line Console ID group box is used to define the Console ID. This ID appears on the

radio when receiving data/audio from that console line.

Console ID field

The Console ID field is used to enter the console ID for the Telex-Serial Line.

MDC-1200 system type
The MDC-1200 system type option is used to configure the line for MDC-1200 use.

Signaling Pararneters: Line 1

General Signal Setup

] Enable Signaling

Ending Line Mumber

Call Logging
Display Al Calls

System Settings
System Type: Generc
Generic
System Name: 576 Tone/DTMF ANI
FleetSync
iDEM
Telex-Seral
| -1
Signaling AutoFill Setu O

Sprint Direct Connect
Telex-Enhanced-ANI

Starting Line Mumber:
:

Figure 12.15: MDC-1200 System Type

Edit System

To configure the line for a MDC-1200 type, do the following
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1. Select Edit | Per Line Parameters from the menu bar.
The Per Line Parameters window appears.
2. From the Line Type drop down menu, select Telex.
3. Click Signal Setup.
The Signaling Parameters window appears.
4. Select MDC-1200 from the System Type drop down menu.
The MDC-1200 Setup tab appears.
5.  From the System Name drop down menu, select a system for the line.

MDC-1200 Setup page
When MDC-1200 is selected from the System Type drop down menu, the MDC-1200 Setup
page appears, shown in the Figure below.

Per Line Consale [D

Group 10 {In Hex) 001

Unit 10: (In Hex) 0001

PTT ID Options
| Fre Only -

Call Pemission Setup
Allow Broadcast Calls on this Line

|User Display Options
[] Cnby Display Filters

Figure 12.16: MDC-1200 Page - Signaling Parameters
Per Line Console ID group box

Group ID: (In Hex) field
The Group ID: (In Hex) field is used to identify the group ID for the console.

This field requires a 3-digit hexadecimal number (0-EEE).

Notice!
Do not use the letter F in this field. It is reserved as a wild card digit used to create
MDC-1200 custom call groups.
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Unit ID (In Hex) field
The Unit ID (In Hex) field is used to identify the MDC-1200 unit for the line.

This field requires a 4-digit hexadecimal number (1-DEEE).

Call type ID range
Unit call 0001-DEEE
Group call EOOO-EEEE
System call FFFF

Tab. 12.3: MDC-1200 unit ID ranges

Note:

- Apply the ID numbers as given in the Table above.

— The letter F is reserved as a wild card digit used to create MDC-1200 custom call groups.

— Acall sent to an ID containing the letter F is received by all units that match all the non-F
characters.

EXAMPLE: A call sent to D1FF is received by all units with an ID between D100 and D1EE.

PTT ID Options

PTT ID Options drop down menu
The PTT ID Options drop down menu is used to indicate when an ID is sent while
transmitting.

Available selections for this field are:

- None-No PTT ID is sent when transmitting from the console.

—  Pre Only - The console’s PTT ID is sent before the voice stream begins.

— Post Only - The console’s PTT ID is sent after the voice stream ends.

—  Pre and Post - The console’s PTT ID is sent both before and after the voice stream begins
and ends.
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Signaling Parameters: NE& P-ol_

| General Signal Setup | MDC-1200 Setup

Per Line Consale |D
Group 1D {In Hex) 0m

Unit 10 {In Hex) 0001

PTT ID Options

Pre hd

Mone

Ca Post Only
Pre and Post
¥

v

User Display Options
[] Onhy Digplay Filters

Figure 12.17: PTT ID Options Drop Down Menu
Call Permission Setup group box

Allow Broadcast Calls on the Line check box
The Allow Broadcast Calls on the Line check box indicates the console operator is allowed to
place call alerts, and place select calls to the entire system.

The system user ID is FFFF.
User Display Options group box

Only Display Filters check box

The Only Display Filters check box indicates, in addition to the system name, only groups and
units contained in the filter display in the system list in C-Soft Runtime’s MDC-1200 Dispatch
window, shown in Figure 329. When selected, only filters and their components are visible.
Otherwise, all components in the system appear in the system list.

Notice!

The Only Display Filters check box controls the system list appearance. Component
permissions are controlled per line. For more information, refer to “Call Permission Setup
Group Box”.
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MDC-1200 Dispatching MDC-1200 Dispatching

Only Display Filters

Only Display Filters
options selected

option unselected

Filters/

Units/

Filters

Gmupns»Z

Figure 12.18: MDC-1200 System List Filters Display in C-Soft Runtime

12.5.6 MOTOTRBO system type
The MOTOTRBO system type option is used to configure the line for MOTOTRBO use.

Notice!
There is a 10 console limit to each SOIP line.
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Figure 12.19: MOTOTRBO System Type

Edit System

To configure the line for MOTOTRBO type, do the following:
1. Select Edit | Per Line Parameters from the menu bar.
The Per Line Parameters window appears.

2.  From the Line Type drop down menu, select Telex.

3. Click Signal Setup.

The Signaling Parameters window appears.
4. From the System Type drop down menu, select MOTOTRBO.
The MOTOTRBO Setup tab appears.
5. From the System Name drop down menu, select a system for the line.

MOTOTRBO Setup page

When MOTOTRBO is selected from the System Type drop down menu, the MOTOTRBO Setup
page appears, shown in the Figure below.

Bosch Security Systems, LLC
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Signaling Parameters: Line 1

General Signal Setup | MOTOTREO Setup

Interface Type

) MOTOTREQ Interface

S0OIP Setup
¥ Multicast Address  RX Port
2258 11 .81 2000

TX Multicast Address TX Port
22508 11 .81 2200

Control Line Setup
Multicast Address Cortrol Port
Z225. 8 .11 .81 | |2254

Default

Metworlc Setup
CAl Metwork: 12

CAl Group Metwors: 225

Feset to I_]_efauh

Figure 12.20: MOTOTRBO Setup Page

Interface Type group box

MTRBI radio button

The MTRBI radio button is used to select signaling using the MTRBI interface option to IP-224
or IP-223.

MOTOTRBO radio button
The MOTOTRBO radio button is used to select signaling using the MOTOTRBO interface

option to IP-224.

SOIP Setup group box
The SOIP Setup group box is used to set up communication between the IP-223 or IP-224 and

C-Soft to send and receive serial data. The fields in this section must match the same fields
for the specified line on the IP-223 or IP-224.

For more information, refer to the MTRBI Installation Manual (F.01U.247.183). For MOTOTRBO
support, refer to the MOTOTRBO Application Guide (F.01U.298.170).

2021-06 | 14 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC



C-Soft 7.700 Per Line Parameters window | en 95

RX Multicast Address field

The RX Multicast Address field indicates the Multicast Address used to receive serial data
over the network. This is the same Serial Over IP RX Multicast Address set up in the IP-223’s
or IP-224’s Multicast Address Setup window for the associated MOTOTRBO line.

RX Port field

The RX Port field indicates the RX port number used to receive serial data. This is the same
Serial Over IP RX port number set up on the IP-223 or IP-224 for the associated MOTOTRBO
line.

TX Multicast Address field

The TX Multicast Address field indicates the Multicast Address used to send serial data. This
is the same Serial Over IP TX Multicast Address set up in the IP-223’s or IP-224’s Multicast
Address Setup window for the associated MOTOTRBO line.

TX Port field

The TX Port field indicates the TX port number used to send serial data. This is the same
Serial Over IP TX port number set up on the IP- 223 or IP-224 for the associated MOTOTRBO
line.

Control Line Setup group box
The Control Line Setup group box section is used to set up multiple C-Soft consoles to
communicate with the same MOTOTRBO radio.

Multicast Address field

The Multicast Address field indicates the Multicast Address used by the console to
communicate with MOTOTRBO radio. The Multicast Address is configured for the line in the
Per Line Parameters window.

This field is not editable.

Control Port feld
The Control Port field indicates the port used to communicate with the MOTOTRBO radio.

The default value for this field is 1000 more than the TX Port value configured for the line on
the Per Line Parameters window.

To change the TX Port value, do the following:
1. Clear the Default check box.
The Control Port field becomes editable.
2. Inthe Control Port field, enter a port number.

Default check box

The Default check box is used to accept the control port’s default value. The default value is
calculated by adding 1000 to the TX Port number for the line. When the check box is selected,
this value is automatically entered in the field. Clear the check box to enter a different value.
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Network Setup group box
The Network Setup group box section is used to set up the MOTOTRBO radio to send text
messages and allow GPS (Global Positioning System) to work in C-Soft.

Notice!

The CAl (Common Air Interface) Network and CAl Group Network fields in C-Soft Designer
must match the CAl network and CAl Network Group configured in the MOTOTRBO CPS
software.

For more information, refer to the Motorola’s technical documentation.

CAI Network field
The CAI Network field is used to enter the value for the CAl network configured on the radio.

The range for this field is 1 to 126.

CAIl Group Network field
The CAI Group Network field is used to enter the value for the CAl Group Network configured
on the radio.

The range for this field is 225 to 239.

12.5.7 Sprint Direct Connect system type

Sprint Direct Connect Setup page
When Sprint Direct Connect is selected from the System Type drop down menu, the Sprint
Direct Connect Setup page appears.

To configure the line for Sprint Direct Connect type, do the following:
1. Select Edit | Per Line Parameters from the menu bar.
The Per Line Parameters window appears.
2.  From the Line Type drop down menu, select Telex.
3. Click Signal Setup.
The Signaling Parameters window appears.
4. From the System Type drop down menu, select Sprint Direct Connect.
The Sprint Direct Connect Setup tab appears.

2021-06 | 14 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC



C-Soft 7.700

Per Line Parameters window | en 97

-

I| | General Signal Setup | Sprint Direct Connect Setup [
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R Multicast Address FX Port
B 8 .11 . 81 2000

T¥ Multicast Address TX Port
2258 11 .81 2200

Emergency Setup
[ Enable Emergency on Call et

Call Mert Message Index: |0

Figure 12.21: Signaling Parameters - Sprint Direct Connect Setup
SOIP Setup group box

RX Multicast Address field

The RX Multicast Address field indicates the Multicast Address used to receive serial data
over the network. This is the same Serial Over IP RX Multicast Address set up in the IP-223’s
or IP-224’s Multicast Address Setup window for the associated Sprint Direct Connect line.

RX Port field

The RX Port field indicates the RX port number used to receive serial data. This is the same
Serial Over IP RX port number set up on the IP-223 or IP-224 for the associated Sprint Direct
Connect line.

TX Multicast Address field

The TX Multicast Address field indicates the Multicast Address used to send serial data. This
is the same Serial Over IP TX Multicast Address set up in the IP-223’s or IP-224’s Multicast
Address Setup window for the associated Sprint Direct Connect line.

TX Port field

The TX Port field indicates the TX port number used to send serial data. This is the same
Serial Over IP TX port number set up on the IP-223 or IP-224 for the associated Sprint Direct
Connect line.

Emergency Setup group box

Enable Emergency on Call Alert check box

The Enable Emergency on Call Alert check box enables C-Soft to treat incoming SDC call
alerts containing the message index specified in the Call Alert Message Index field as an
Emergency. C-Soft plays emergency alert tones, performs the Emergency button flash actions
on the receiving line’s Select button, and creates an entry in the Active Emergency window.
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Call Alert Message Index drop down menu
The Call Alert Message Index drop down menu is used to select the Call Alert message
triggered by an Emergency in C-Soft. The Sprint Direct Connect handsets contain 21 preset

Call Alert messages.

Index Message Index Message
0 <no message> 11 I'll be there shortly
1 Can't talk right now 12 | love you
2 Will call you back 13 Meeting still on?
3 I'm in a meeting 14 Are you free?
4 Call me 15 Please stop by
5 Direct Connect me 16 Can | call you?
6 Yes 17 In the office?
7 No 18 On my way
8 Where are you? 19 Need help
9 Let's get lunch 20 Where you at?
10 The meeting has been
cancelled
12.5.8 Telex-Enhanced-ANI system type

The Telex-Enhanced-ANI system type option is used to configure the line for serial radio
control. Consult the IP-224 user manual for full list of radios utilizing the Telex-Enhanced-ANI

Type option.
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Figure 12.22: Telex-Enhanced-ANI System Type

To set the system type to Telex-Enhanced-ANI, do the following:

1.

Select Edit | Per Line Parameters from the menu bar.

The Per Line Parameters window appears.

From the Line Type drop down menu, select Telex.

Click Signal Setup.

The Signaling Parameters window appears.

From the System Type drop down menu, select Telex-Enhanced-ANI.
The Telex-Enhanced-ANI Setup tab appears.

From the System Name drop down menu, select a system for the line.
Click the Telex-Enhanced-ANI Setup Tab.

The Telex-Enhanced-ANI Setup page appears.

Select the Enable Callback check box, if applicable.

Telex-Enhanced-ANI Setup page
The Telex-Enhanced-ANI Setup page is shown in the Figure below.
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Signaling Parameters: Sonim

General Signal Setup  Telex Enhanced ANI Setup

Per Line Settings

Figure 12.23: Telex-Enhanced-ANI Setup Page

Per Line Settings group box

The Callback feature allows Line PTT and Main PTT buttons to send group/private call
commands depending on the last call made. This is needed on protocols that need to
differentiate between the two call types.

Enable Callback check box
The Enable Callback check box is used to enables or disables the Callback feature.

12.5.9 Phone system type
The Phone system type option is used to configure the line for standard phone use, as shown
in the Figure below.

Available selections for this field are:

—  Generic - If Generic is selected no additional signaling is being used. For more
information, refer to “Generic system type, page 75”.

— Phone - Phone enables the ability to send additional DTMF signaling to IP-223. For more
information, refer to “Phone Setup Page” below.
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Signaling Parameters: Fire De

General Signal Setup |

System Settings

System Type: M
(Genernc
System Neme: [

Signaling AutoFill Setup
[ Enable Signaling AutaFil

Starting Line Mumber: 1

Ending Line Number: 1

Call Logging

Display All Calls

Figure 12.24: Phone System Type

To configure the line for a Phone type, do the following:
1. Select Edit | Per Line Parameters from the menu bar.
The Per Line Parameters window appears.
2.  From the Line Type drop down menu, select Phone.
3. Click Signal Setup.
The Signaling Parameters window appears.
4. From the System Type drop down menu, select Phone.
The Phone Setup tab and the Call Setup tab appear.

Phone Setup page
When Phone is selected from the System Type drop down menu, the Phone Setup page
appears, shown in the Figure below.
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C-Soft 7.700

I |Geneml Signal Saup| Phone Setup |CE|II Se‘tup|

Signaling Setup
Signaling Type:
Diigit Duration:
Imterdigit Duration:

Pause Duration:

Preamble Duration:

Level:

Twist Level:

Signaling Delays

Initial Delay:

End Delay:

|DTMF -|
150 me
100 ms
250 ms
150 me
-3 dB
0 dB
750 ms
0 ms

Figure 12.25: Phone Setup Page - Signaling Parameters

Signaling Setup group box

Signaling Type drop down menu
The Signaling Type drop down menu, shown in the Figure above, identifies the signaling type
used when generating a phone call. DTMF is the default field value and can not be changed.

Digit Duration field
The Digit Duration field represents the length of time, in ms, the digit tone plays when it is

active.

Interdigit Duration field

The Interdigit Duration field represents the length of time, in ms, between the digit tones
within a group.

Pause Duration field
The Pause Duration field represents the length of time, in ms, allowed between transmitted

groups.
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Notice!
The pause duration must be at least the sum of the Digit and Interdigit Duration fields.

Preamble Duration field

The Preamble Duration field represents the length of time, in ms, the first tone digit plays.
With some radio systems, the first tone needs to be longer than subsequent tones. For
example, the first tone may be used to activate a dormant (battery saving) state.

Notice!
The preamble duration must be at least the amount of the Digit Duration field.

Level field
The Level field represents the relative level, in dB, the encoded message sends.

The range for this field is -20dB to +12dB.

Twist Level field

The Twist Level field represents the relative level difference, in dB, of high and low tones
generated when using DTMF tone types. This field is only active when DTMF is the selected
tone type.

The range for this field is -10dB to +10dB.

Signaling Delays group box

Initial Delay field
The Initial Delay field represents the lead-in delay, in ms, for console-generated messages
transmitted to the field radios.

The range for this field is 0 to 9999ms.

End Delay field

The End Delay field identifies the delay, in ms, at the end of transmitted messages to the field.
It delimits the tone string.

The range for this field is 0 to 9999ms.

When Phone is selected from the System Type drop down menu, the Call Setup page appears,
shown in the Figure below.
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Signaling Parameters: Fire

General Signal Setup | Phone Setup | Call Setup

Call Setup

Auto Ack:
Emerg. Resolved:
PTT BOT:

PTTEOT:
call 1: |
Call 2:
Call 3:
Call 4:

Call &
Call &
Call 7:
Call &
Call 5:

Call 10:

Figure 12.26: Call Setup Page - Signaling Parameters Phone

Call Setup group box

Auto Ack field
The Auto Ack field for phone setup is disabled.

Emerg Resolved field
The Emerg Resolved field for Phone Setup is disabled.

PTT BOT field
The PTT BOT field for Phone Setup is disabled.

PTT EOT field
The PTT EOT field for Phone Setup is disabled.

Call (1-10) Format field

The Call (1-10) Format fields represent the message sent when selected by the console
operator on the Per Line Call History, Call List Window, or the Manual Call List window. Refer
to the Figure below.

This field can contain up to 32 characters.

Field values can be: Low or High.
—  DTMF Format - Allows for 0-9, *, #, A-D, G, |, K, P, R, and S.
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For more information, refer to the table “Call setup group format descriptions” below.
Call (1-10) Label field
The Call (1-10) Label fields represent the label applied to the button on the Per Line Call
History, the Manual Call Window, and the Call List Window popup button, shown in the Figure
below.
This field can contain up to 31 alphanumeric characters.
—
Date Time Freq Status Uszer ID Calling IDv
sets RS
| Private Call | | Group Call | | Status | |Direct:h|orﬂ'1 | Direct:East
|Direct:50ut|'1 | | Direct:West | Calla | | Calla | Call10 |
Figure 12.27: Per Line Call History Window
Refer to
—  Generic system type, page 75
12.6 AutoFill Line Parameters window

The AutoFill Line Parameters window, shown in the Figure below, is used to eliminate
repetitious data entry by automatically populating the corresponding fields on the Per Line
Parameters window with the entries shown in the AutoFill Line Properties window. The RX
and TX entry automatically increment by one for each filled line.

AutoFill button
The AutoFill button, shown in the Figure below, opens the AutoFill Line Parameters window.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



106 en | Per Line Parameters window C-Soft 7.700

LU e codL UL LUl [ reue u andria

e LiEduiey LA NS -RN Lol uoL . .
o T = = Options | |Freqs| | getyp [ | SIP
Echo Packets Enable: 0.0.0.0 |[1062 D.0.0.0 |1262
i ine 1( 225.8 .11, 3 225. 2 0o igna
10 |Disabled | Line 10 5.8 .11.81 |1083 225. 8 11,81 1263 0D.0.0.0 |6 10 Opiions | [Frcs EE,‘E\ P
Echo Packets Enable: 0.0.0.0 |1063 0.0.0.0 [1263 . 2

AutoFill

Figure 12.28: Per Line Parameters AutoFill Button

i — N

(VIR IP Address:
TH P Address:

Line Type:

R Port Start:
T Port Stark:

TTL: B
Packet Delay. 10

Wocoder Type: | TELEX 32K

Starting Line Murnber: 1 Ending Line Mumber; 1

k. I [ Caricel

Figure 12.29: AutoFill Line Parameters Window

RX IP Address check box
The RX IP Address check box indicates the IP Address is selected for the Autofill feature.

RX IP Address field
The RX IP Address field indicates the IP Address used to receive data over the network.

TX IP Address check box
The TX IP Address check box indicates the IP Address is selected for the Autofill feature.

TX IP Address field
The TX IP Address field indicates the IP Address used to send data over the network.

Line Type check box
The Line Type check box indicates the Line Type is selected for the Autofill feature.

Line Type drop down menu
The Line Type drop down menu is used to select the type of line for the Autofill feature.

Available selections for this field are Disabled, Telex, Phone, SIP Phone, P25-DFSI, NEXEDGE,
and AlS.
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RX Port Start check box
The RX Port Start check box indicates the RX Port Number is selected for the Autofill feature.

TX Port Start check box
The TX Port Start check box indicates the TX Port Number is selected for the Autofill feature.

TTL check box
The TTL check box indicates the TTL number is selected for the Autofill feature.

TTL field
The TTL field is used to enter the number of routers the Multicast audio packets go through
before being discarded. Network design dictates this value.

The range for this field is 1 to 100.

Packet Delay check box
The Packet Delay check box indicates the Packet Delay number is selected for the Autofill
feature

Packet Delay field
The Packet Delay field is sued to enter a packet delay number.

The range for this field is 4 to 27.

Vocoder Type check box
The Vocoder Type check box indicates the Vocoder Type is selected for the Autofill feature.

Vocoder Type drop down menu
The Vocoder Type drop down menu is used to select the vocoder to use for the Autofill
feature.

Available selections for this field are: TELEX 32K, G.726 16K, G.726 32K (IP224 Only), and
G.711 64K (IP224 Only).

Starting Line Number field
The Starting Line Number field is used to enter a starting line number.

The range for this field is 1 to 200.

Ending Line Number field
In the Ending Line Number field is used to enter an ending line number.

The range for this field is 1 to 200.

To fill line parameters with the autofill feature, do the following:
1. From the menu bar, select File | Setup Per Line Parameters.
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N

Click Autofill.

The AutoFill Line Parameters window appears.

3 In the RX IP Address field, enter an RX IP Address.

4. Inthe TX IP Address, enter a TX IP Address.

5. In the Line Type drop down menu, select a Line Type.

6. Inthe RX Port Start field, enter an RX Port start number.

7. Inthe TX Port Start field, enter a TX Port start number.

8. Inthe TTL field, enter a TTL.

9. In the Packet Delay field, enter a Packet Delay number.

10. In the Starting Line Number filed, enter a starting line number.
11. In the Ending Line Number field, enter an ending line number.
12. Click OK.

The IP Addresses, port numbers and TTL automatically fill in the appropriate fields starting
and ending with line numbers entered in the AutoFill Line Parameters window.

OK button
The OK button applies the selected settings and closes the window.

Cancel button
The Cancel button closes the window.

12.7 Configure SIP Settings window

The Configure SIP Settings window, shown in the Figure below, is used to register the SIP
Address.

Global SIP settings are available in the SIP Global Configuration window. To open this
window, select Edit | Global SIP Phone. For more information, refer to “Global SIP
Configuration window, page 163”.
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Configure SIP Settings for Line #18 - GrandStream 2004 >

SIP Account Credentialz
Extenzion: | 2004

DomainServer IF: |1 721951 51

Authorization Mame: |2EIEI¢1

EERETTEEY

Pazzword:

Reqistrar Settings

Registrar Compatibility: | Fully Compliant ~
Ring Settingz

Ring Sound: | Default il
Fromy Server

[ ] Uze Dutbound SIP Proxy Serer

Semver Address:
Backup Address:
[dzer Mame:

Paszword:

Yaicemail 5 ettings

E nable % oicemail Motification

Cancel

Figure 12.30: Configure SIP Settings Window

SIP Account Credentials group box

Extension field
The Extension field is used to enter the SIP extension number (for example, 211).

Domain/Server IP field
The Domain/Server IP field is used to enter the Domain or Server IP address (for example,
172.19.50.20).

Authorization Name field
The Authorization Name field is used to specify the user name used to register the SIP
account on the SIP Server.

Password field
The Password field is used to specify the password used to register to the SIP server. This is
typically known as secret on the SIP server.
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Registrar group box

Registrar Compatibility drop down menu
The Registrar Compatibility field is used to specify the compatibility level of the specified
registrar server with RFC 3581 (SIP Symmetric Response Routing).

The default selection is Fully Compliant.

Available selections for this field are:

—  Fully Compliant - Registrar is fully compliant with RFC 3581 and will register any number
and all types of listeners in the SIP packet header’s Contact field.

—  Cannot Use Multiple Contacts - Registrar is able to register only one contact in the SIP
packet header’s Contact field.

— Cannot Use Private Contacts - Registrar is unable to register any contacts in the SIP
packet header’s Contact field.

—  Has Application Layer Gateway - Network address translations will be handled externally
by a router with an Application Layer Gateway. Network address translations should not
be performed by C-Soft.

For more information refer to “SIP Phone line configuration, page 111”.

To configure the line for a SIP phone, do the following:
1. From the menu bar, select Edit | Setup Per Line Parameters.
The Per Line Parameters window appears.
2. From the Line Type drop down menu, select SIP phone.
The SIP button is active.
3. In the Line Name field, enter a name for the line.
4. Select the Echo Packets check box (optional).
NOTE: this can be used to stream audio to a recorder.
- In the RX Multicast Address field, enter the desired echo destination.
— Inthe RX port field, enter the desired Port number.
5. Inthe TTL field, enter a value between 1 and 99.
6. Click SIP.
The Configure SIP Setting For Line X - (where X is the line number) window appears.

Ring Settings group box

Ring Sound drop down menu
The Ring Sound drop down menu is used to select different ring tones for individual SIP
Extensions. One of four ring tones can be assigned to a SIP Extension.

Available selections for this field are: Ring 1, Ring 2, Ring 3, and Ring 4.

Notice!
If the Default option is selected, C-Soft uses the Ring Sound set in Global Settings (Edit |
Setup Global Parameters | Peripherals tab | Ring Sound).
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Proxy Server group box

Use Outbound SIP Proxy check box

The Use Outbound SIP Proxy check box indicates traffic is initially sent through the proxy
server entered in the Use Outbound SIP Proxy field. If the Use Outbound SIP Proxy check box
is selected, the specified proxy settings override the Global SIP Proxy settings found in the
Global SIP Configuration window for the specific line.

Notice!
The Server Address field must also be configured.

Server Address field
The Server Address field is used to enter the proxy server’s address.

Notice!
The Use Outbound SIP Proxy check box must also be selected.

12.8

Backup Address field

The Backup Address field is used to specify a backup proxy server address. If the parameter is
set and C-Soft fails to register using the primary Proxy Server address, C-Soft switches to the
backup proxy address and attempts to re-register.

User Name field
The User Name field is used to enter the proxy server User Name.

Password field
The Password field is used to enter the proxy server password.

Voicemail Settings group box

Enable Voicemail Notification check box
The Enable Voicemail Notification check box enables C-Soft to subscribe to voicemail
notification messages from the SIP server.

SIP Phone line configuration

C-Soft supports SIP Phone lines. SIP (Session Initiation Protocol) provides an alternative
method of telephone line installation into your dispatch system. With SIP you can easily adapt
and configure many telephone lines into a C-Soft console position without having to connect
external hardware.

Each C-Soft 7.000 License comes with two SIP lines. Additional lines can be purchased as an
additional feature and are available in 6, and 12 line increments.
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12.8.1 SIP features
The SIP option is used to access the following features:
—  Crosspatch
- Outbound DTMF
—  Per line call history
—  Call directory editing on-the-fly
—  Auto-answer incoming calls
—  Stun and proxy server
—  Auto adjustments
- Silence detection
—  Network recording or monitoring
- Call hold
— Do not disturb
- 3-way-calls
- Microphone mute
- Line conference
—  Consultant transfer
-  Blind transfer
- Missed call history
- Call waiting
—  Conditional forwarding

To configure your system for SIP calls, do the following:

1. Obtain a SIP account through your IT system administrator or internet service provider.

2. Configure a SIP phone line in C-Soft Designer, refer to S/P Phone line configuration, page
111.

3. If using a network recorder or monitor, configure echo packets in C-Soft Designer, refer
to Configure SIP for recording or monitoring, page 112.

4. Set up global SIP configurations in C-Soft Designer, refer to “Global SIP Configuration
window, page 163".

5. Create a SIP Call Control button in C-Soft Designer, refer to S/P Call Control, page 368.

6. Test the registration parameters in C-Soft Runtime, refer to “Test the SIP Registration”.

12.8.2 Configure SIP for recording or monitoring
The SIP Phone line can be recorded or monitored. This is configured in the Per Line
Parameters window.

For more information, refer to “Per Line Parameters window, page 61”.

[ Per Line Parameters l 25 I
Line Packet
Mumber  Line Type Line Mame Fix Multicast Address R Port Tx Multicast Address T Port EBase Radio IP: TTL Delay
225. 8 g 05 2258 g 25 0.0.0.0 0 Signa -
1 SIP Phone v | SIP Diamondhead 2 11. 81 1054 At 11 .81 [1254 2 1 Options | [Freqs ‘5‘5:?‘ P | —
EchoPackets Enable: 7] 255. 8 . 11.91 1059 0.0.0.0 [1254 Setup

Figure 12.31: SIP Line Type - Per Line Parameters

To configure the SIP line for network recording or monitoring, do the following:
1. From the Per Line Parameters window, select the Echo Packets Enable check box.
2. In the RX Multicast Address field, enter an IP Address.
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3. Inthe RX Port field, enter an RX port number.
4. Click OK.
The Per Line Parameters window closes.
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13 Global Parameter Setup window

The Global Parameter window, shown in the Figure below, is used to navigate to the
Appearance, Audio, Control Settings, Local Consoles, Peripherals, and Recording pages to
configure global settings.

NAVIGATION: Select Edit | Setup Global Parameters from the menu bar.

13.1 Appearance page

The Appearance page, shown in the Figure below, is used to configure various C-Soft
appearance settings. This includes Unit/ID Display behavior, background display options, and
button style.

Global Parameter Setup >

Pppearance  Audio  Control Settings  |RR Recording  Local Consoles  Peripherals  Recording

AMI Setup Alias Setup Group AN Setup

: [ Mways Display Unit & [ Hide Group ANI

[ ] Enable Resid

[ ]Clear AMlon PTT

Logo

Image Filename: | Browse ..

Position: Upper Left  ~

Button Style Button Border
Styvle: | Glossy Rectangle w Thickness: E :
Button Flash Colors Background Colar

Call Alert: |:||v| Group Cal: [ |-
Emergency: -|*| Select Call: [ |-

Window Options
[ ] keep information windows as top layer

Popup Options
Close Using: | Done Button i

Cocs

Figure 13.1: Appearance Page - Global Parameters Setup
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ANI Setup group box

Enable Sticky ANI check box
The Enable Sticky ANI check box indicates the ANI displayed on the select button remains
visible until the next call is received.

Enable Residual ANI check box

The Enable Residual ANI check box indicates the previous caller’s ANI continues to display
after receiving a call from a user without ANI capabilities; otherwise, the caller’s ANI
disappears when the call is ended.

Clear ANI on PTT check box
The Clear ANI on PTT check box indicates the ANI, normally displayed on the select button, is
cleared when a PTT operation is selected.

Alias Setup group box

Always Display Unit # check box

The Always Display Unit # check box indicates the Unit ID # (ANI) is displayed on the
receiving line’s Select button in addition to the unit’s Alias. Selecting this check box causes
both the user’s alias and number to appear on the button.

Group ANI Setup group box

Hide Group ANI check box

The Hide Group ANI check box indicates the Group ANI information is not displayed on the
receiving line’s Select button when receiving a Group call on a line configured for either Sprint
Direct Connect, P25-DFSI, NEXEDGE, or iDEN operation.

Logo group box
Image Filename field

The Image Filename field identifies the file path of a image to be displayed in the background
of the Console window.

C-Soft supports 1-bit, 4-bit, 8-bit and 24-bit bitmaps, .png, .jpg, and .gif file formats.

This field can contain up to 255 characters.

Browse button
The Browse button opens the Open window, which is used to navigate to the logo image file.

To change the image file, do the following:
1. Click Browse.
The Open window appears.
2. Select the file you want to use for the image.
3. Click Open.
The path to the image file appears in the field.

Position drop down menu
The Position drop down menu is used to select the location of the image logo on the console
window.
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Available selections for this field are: Upper-Left, Upper-Right, Lower-Left, Lower-Right, Center
and Stretch.

Button Style group box
The Button Style group box is used to select a button style.

Style drop down menu
The Style drop down menu is used to select the button style.

Available options are: Classic, Glossy Circle, Glossy Rectangle, Modern, and Vista.

Classic Option
The Classic option, if selected, indicates the buttons are displayed in a classic style.

Telex Radio Dispatch MDC-1200 Demo

MDC-1200 Line 1 Line 2 Line 3

Per Line Call History Per Line Call History Per Line Call History
MDC Line 1 Line 2 Line 3

Figure 13.2: Classic Option Style

Glossy Circle Option

The Glossy Circle Option, if selected, indicates the buttons are displayed in a glossy circle
style.
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Telex Radio Dispatch MDC-1200 Demo

MDC-1200 Line 1 Line 2 Line 3
Per Line Call History Per Line Call History Per Line Call History
MDC Line 1 Line 2 Line 3

Figure 13.3: Glossy Circle Option Style

Glossy Rectangle Option
The Glossy Rectangle option, if selected, indicates the buttons are displayed in a glossy
rectangle style.

Telex Radio Dispatch MDC-1200 Demo

MDC-1200 Line 1 MDC-1200 Line 2 Line 3

o R e
NDL Line 1 MDC Line 2 Line 3

Figure 13.4: Glossy Rectangle Option Style

Modern Style Option
The Modern Style option, if selected, indicates the buttons are displayed in a glossy rectangle

style.
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Telex Radio Dispatch MDC-1200 Demo

MDC-1200 Line 1 Line 2 Line 3

Per Line Call History
MDC Line 1

Select

Per Line Call History
Line 2

Select

Per Line Call History
Line 3

Select

Figure 13.5: Modern Style Option

Vista Style Option
The Vista Style option, if selected, indicates the buttons are displayed in a vista style.

Telex Radio Dispatch MDC-1200 Demo

MDC-1200 Line 1 Line 2 Line 3

Per Line Call History Per Line Call History Per Line Call History
MDC Line 1 Line 2 Line 3

Select

Selected Select

Figure 13.6: Vista Button Style

Button Border group box
The Button Border group box is used to select the thickness of the border of various Ul
Controls. This setting applies to all buttons, popup buttons, and frequency controls.

Thickness spin box
The Thickness spin box is used to set the thickness of the border around the Ul button. The
higher the value, the thicker the border.

The range for this field is 0 to 10.
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The default is 5.

Button Flash Color group box
The Button Flash Color group box is used to set the blink color for Select buttons when
receiving one of the following call types.

Call Alert drop down palette
The Call Alert drop down palette is used to set the button color when a Call Alert is being
received. The button blinks when an alert is received.

Group Call drop down palette
The Group Call drop down palette is used to set the button color when a Group Call is being
received. The button blinks when a Group Call is received.

Emergency drop down palette
The Emergency drop down palette is used to set the button color when an Emergency call is
being received. The button blinks when an Emergency call is received.

Select Call drop down palette
The Select Call drop down palette is used to set the button color when a Select call is being
received. The button blinks when a Select call is received.

Background Color group box

Background Color drop down palette
The Background Color drop down palette displays the background color for the console and
popup windows. Use the drop down button to open a palette to select the desired color.

The default color is black.
Window Options group box

Keep Information Windows As Top Layer check box

The Keep Information Windows As Top Layer check box indicates all C-Soft information
windows are always displayed above C-Soft popup windows or any other application running
on the PC.

The C-Soft information windows include:
—  Active Emergency Window

- Call List Window

- Call Queue Window

—  Emergency History Window

- Event Logger Window

- FleetSync Window

—  Global Call History

—  HB4 Global Parameters Setup Window
- HB4 Volume Window

-  HB4 Speaker Select Window

— HB4 IRR Speaker Select Window

—  License Dialog

—  Manual Call List Window

- Manual Page Entry
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- MDC-1200 Window

-  MOTOTRBO Window

- P25-DFSI Window

—  Per Line Call History Window
- SIP Call Window

—  Status List Window

- Supervisor

- Web Page Popup

Popup Options group box
Close Using drop down menu

The Close Using drop down menu is used to select the closure method used by all popup
windows.

Available options are:

—  Use the “X” in the top right

—  Use the “Done” in the bottom right corner

—  Use the button toggle to close. The button toggle closes the window even when using “X”
or “Done”

13.2 Audio page

The Audio page, shown in the Figure below, is used to configure audio routing and blocking.
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Global Parameter Setup =4

fppearance  Audic  Control Settings  |RR Recording  Local Consoles  Peripherals  Recording

Audio Muting and Routing MIC AGC

] Sum Unselect to Headset when On Enable [ ]
(] Mute Select Audio During PTT )

[ Mute Unselect Audio During PTT Target Level: | |dB
[] Mute Lines When Unselected Min Active: |15 | dB

[ ] Mllow Muting Selected Lines
[] Mute Selected Channels with R Block

[] Disable Local Talk Pemit Tanes Audio Filtering
[] Lines Remain Muted for Emergencies [] Disable Audio Bandpass Fiters
Audio Blocking Direct IP Line Gain

R Block Delay: EI ms ] Enable Line Gain 1dB
DTMF Setup

Fiywheel: ms Level: dE

SOIP Audio Setup

PTT Hang Timer: EI ms

Carcs

Figure 13.7: Audio Page - Global Parameters Setup
Audio Muting and Routing group box

Sum Unselect to Headset when On check box
The Sum Unselect to Headset when On check box indicates when an ADHB-4 is active, select
and unselect audio is combined and routed to the headset.

Mute Select Audio During PTT check box
The Mute Select Audio During PTT check box indicates select audio is muted when PTT is
used.

Mute Unselect Audio During PTT check box
The Mute Unselect Audio During PTT check box indicates unselect audio is muted when PTT
is used.

Mute Lines When Unselected check box
The Mute Lines When Unselected check box indicates unselected lines are automatically
muted (only selected line is heard).
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Allow Muting Selected Lines check box
The Allow Muting Selected Lines check box indicates the console operator is able to mute
selected lines on the console.

Mute Selected Channels with RX Block check box
The Mute Selected Channels with RX Block check box indicates the console operator is able
to mute channels on which RX Block is enabled.

Disable Local Talk Permit Tones check box

The Disable Local Talk Permit Tones check box indicates the console does not generate talk
permit tones. Instead, the talk permit tones are generated by a communication device
attached to the system.

Lines Remain Muted for Emergencies check box

The Lines Remain Muted for Emergencies check box indicates the console will not transmit
emergency call audio when the console is muted. When the check box is not selected, a muted
console will transmit emergency call audio.

Audio Blocking group box

RX Block Delay field

The RX Block Delay field identifies the amount of time, in ms, the release of the RX blocked
line is delayed. The RX blocked lines are selected on the Per Line Frequency Setup window,
refer to “RX Block Lines Display Box”. This delay allows any IP- and/or system-delayed audio
to end before releasing the muted lines.

The range for this field is 300 to 5000ms.
The default is 0.

To disable this feature, do the following:
- In the RX Block Delay field, enter 0 ms.

DTMF Setup group box

Flywheel field
The Flywheel field identifies the amount of time, in ms, allowed to pass between clicks of
different DTMF keypad keys before the radio is keyed down by the console.

The range for this field is 300 to 5000ms.
The default is 2000.

Level field

The Level field identifies, in dB, the relative audio level to be transmitted. The actual level
transmitted by the radio varies depending on the system. This field allows the console
designer to adjust the relative level up or down after the remainder of the system is aligned
and operational.

The range for this field is -30 to 10dB.
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SOIP Audio Setup group box

PTT Hang Timer field

The PTT Hang Timer field is used to enter the amount of time to delay the PTT off command
for SOIP protocols. This delay allows the IP-223/4 to complete processing any transmit audio
before C-Soft sends a command to the serial device to stop transmitting. To calculate the
Hang Timer Delay, use the following equation:

Hang Timer Delay = IP-224 Packet Delay * 20ms + IP-224 TX Delay (EQ 1)

Currently, only Sprint Direct Connect lines are affected by this feature.

MIC AGC group box
The MIC AGC (Automatic Gain Control) group box indicates the C-Soft program supports a
software based microphone AGC.

Enable check box

The Enable check box is used to help equalize speech level variations caused by the use of
different microphones, different speaking distances to the microphone, and different volumes
of speech.

Target Level field

The Target Level field identifies the audio level, in dB, the MIC AGC packets are adjusted to.
- If the measured audio level is above the target level, the audio is reduced in gain.

— If the incoming level is below the target, up to 6dB of gain is applied to bring the level up.

The range for this field is -30dB to 6dB.

Min Active field

The Min Active field identifies the audio level, in dB, at which the AGC software stops trying
to adjust the audio level. If audio below this level is detected, the AGC software does not
attempt to adjust the audio. This prevents open mics from amplifying background noise onto
the transmit channel.

The range for this field is -60 to 0 dB.
Audio Filtering

Disable Audio Bandpass Filter check box

The Disable Audio Bandpass Filter check box indicates the audio bandpass filter is disabled.
When selected, audio transmitted from C-Soft is not passed through the vocoder specific
bandpass filter before being encoded. Disabling the bandpass filter results in the transmit
audio sounding warmer (more bass) than filtered audio.

Direct IP Line Gain group box

Enable Line Gain check box

The Enable Line Gain is used to help balance receive audio levels between IP-224s and the
Direct IP system. When enabled, the selected amount of gain is applied to all receive audio of
every Direct IP Lines (AIS, NEXEDGE, P25-DFSI, and P25-CSSI).

Available gain levels are 3 dB, 6 dB, 9 dB, and 12 dB.
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13.3

Control Settings page

The Control Settings page, shown in the Figure below, is used to enable various console
controls, a supervisor password and points to FleetSync, MDC1200 and MOTOTRBO system

files.

Global Pararmeter Setup

Appearance  Audio

User Contral Options Supervisor Password

! IRR Recording Local Consoles

Perpherals Recording

[ Allow Freq Update Anytime 1234

[]lgnore Freq Updates
[ ] Dizable Spacebar PTT
[] Kill Lines on Crosspatch

Window Controls
Allow Minimize

Allow Mazimize
Allow Resize
Allow Move
Allow Close

Cortral Timeouts

Supervisor: EI sec
Crosspatch: EI SEC

Save Runtime Setting

Keyboard Dual-Tone Fomat

Save Runtime State on Close ® DTMF () Ko
System List

Filename: | | Browse ...
Logging Setup
[] Enable Logging Log Level: Emor

Cancel

Figure 13.8: Control Settings Page - Global Parameters Setup
User Control options

Allow Freq Update Anytime check box

The Allow Freq Update Anytime check box indicates frequency updates are accepted at any
point in the RX stream. Otherwise, frequency updates are accepted at the beginning of a call,

before audio playback begins.

Ignore Freq Updates check box

The Ignore Freq Updates check box is used to ignore frequency change updates from remote
sources, such as parallel consoles or IP-224s. A line’s transmit frequency can only be changed
on the local console using either Frequency Change button or the Frequency Control.
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Disable Spacebar PTT check box
The Disable Spacebar PTT check box indicates the spacebar is not used for PTT.

Kill Lines on Crosspatch check box

The Kill Lines on Crosspatch check box indicates the console operator cannot transmit on a
line included in crosspatch by a parallel console operator. Otherwise, the console operator is
allowed to transmit on the lines even if another console operator has included the lines in a
crosspatch.

Control Timeouts group box

Supervisor field
The Supervisor field controls the parallel console crosspatch timeout. The timeout is
controlled by the Supervisor console initiating the action.

The range for this field is 0 to 3600 seconds.

EXAMPLE: Console 1 has supervisor timeout set to 10 seconds.

Console 2 has supervisor timeout set to 2 seconds.

— Case 1: If console 1 initiated the action, then both consoles timeout after 2 seconds.

—  Case 2: If console 2 initiated the action, then console 2 times out in 2 seconds and
console 1 times out in 10 seconds.

To disable supervisor timeout, do the following:
- In the Supervisor field, enter 0.

Crosspatch field
The Crosspatch field indicates the amount of time, in seconds, a crosspatch is allowed to
remain inactive before it is dropped.

The range for this field is 0 to 3600 seconds.

To disable crosspatch inactivity, do the following:
— In the Crosspatch field, enter 0.

Save Runtime Setting group box

Save Runtime Status on Close check box

The Save Runtime Status on Close check box indicates the console size, position, settings,
and selections are saved to the cposi.txt when the program is closed. Otherwise, the size
position, and selections are not saved when C-Soft Runtime is closed.

For more information, refer to “Window Sizing” on “C-Soft Console, page 466”.

Notice!
C-Soft opens only the current version of the cposi.txt file.
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System List group box

Filename field

The Filename field identifies the system file used by C-Soft Runtime when it opens the.veg
file. If left blank, the Edit System window opens to a blank system. The filename identifies the
path to the saved FleetSync, MDC-1200, MOTOTRBO, Telex-Serial and P25-DFSI systems.

For more information, refer to “Edit System List window, page 192”.

Browse button
The Browse button is used to select the system list file to use. When clicked, a file chooser
menu opens and allows the user to browse to the desired System List file.

Logging Setup group box
Enable Logging check box

The Enable Logging check box indicates logging is active and the console creates an event log
file when C-Soft Runtime is started.
By default the Enable Logging check box is not selected.

If the Enable Logging check box is selected, then a log file is created.

The location of the log file is C:\ProgramData\Telex Communications\C-Soft\Logs.

Notice!

The log file is named SystemlLog_[Date][Time] _[.veg file name].txt. For example, a system log
started on June 3rd at 1:05 PM from the Denton Fire.veg file is named, SystemLog_06-03
13:05:13 Denton Fire.txt. A new file is created anytime C-Soft Runtime is started or when the
current log file reaches a file size of 3 Mb.

Event log files are kept for at least seven days. C-Soft deletes any files older than seven days
at boot-up, or when creating a new event log file because the existing file has reached its
maximum size.

Log Level drop down menu
The Log Level drop down menu is used to select type of messages to be saved in the event log
file and the event log window, if available.

Available options are:

—  Error - Used for events that could cause or indicate a service failure.

—  Warning - Used for minor user-level exceptions not expected during normal operation.

— Information - Used for normal user-level events (for example, incoming calls, starting a
call, etc.)

— Debug - Used for debugging purposes.
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Notice!

Error, Warning, and Debug are used by Sprint Direct Connect only. All other types use

Information only.

Supervisor Password

Supervisor Password field

The Supervisor Password field is used to assign a password for the supervisor function and

any other password protected functions.

This field can contain up to 16 alphanumeric characters.

Window Controls group box

Window Controls check boxes

The Window Controls check boxes indicate the standard window controls are included on the

dispatch console window.

Available selections for this field are:

—  Allow Minimize - allows the console operator to minimize the dispatch window to a
button on the toolbar.

-  Allow Maximize - allows the console operator to maximize the dispatch window.

—  Allow Resize - allows the console operator to resize the dispatch window.

- Allow Move - allows the console operator to move a dispatch window that has been
resized.

— Allow Close - allows the console operator to close a dispatch window. If this selection is
not enabled, the only way to shut down the dispatch console position is to use the
Windows Task Manager (press Ctrl+Alt+Delete to open Windows Task Manager).

Keyboard Dual-Tone Format group box

DTMF radio button

The DTMF radio button indicates DTMF tones are used when keyboard number keys are

pressed.

Knox radio button

The Knox radio button indicates Knox tones are used when keyboard number keys are

pressed. Knox tones are specific tones used to unlock Knox boxes. These boxes are used

primarily by fire departments.
134 IRR Recording page

The IRR Recording page, shown in the Figure below, is used to assign the lines to be recorded
by Per Line Recording and Per Line Recording options.
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Global Parameter Setup .

Pppearance Audio  Control Settings  |RR Recording | ocal Consoles  Peripherals  Recording

Line Recording Setup Recording Settings

Output Speaker: Speaker 2 o

J:Line 3
4:Line 4 Minimum Record Duration: 05sec ~
G:Line &
7:Line 7 Display Options
_
S:Lline 9 [] Log Qutgaing Calls
10:Line 10 )
11-Not Enabled- [ Populate Keypad on selection
12:-Maot Enabled-
13:-Mot Enabled-
14:-Mot Enabled-
15:-Mot Enabled-
16:-Maot Enabled-
17:-Mot Enabled-
18:-Mot Enabled- W

Mumber of recorded lines: 4

Concs

Figure 13.9: IRR Recording Page - Global Parameters Setup

Line Recording Setup group box

When checked the last 60 minutes of received audio will be recorded and available for
playback from the both the Per Line History or Global Call History Window. Up to 100 lines
can be selected for IRR recording.

The recorded audio storage directory is specified in C:\ProgramData\Telex Communications C-
Soft\Settings\ClientSettings.xml and by default is C:\ProgramData\Telex Communications C-
Soft\Audio Archive. Change the recorded audio storage directory by using Telex System
Manager.

Recording Settings group box
Output Speaker drop down menu

The Output Speaker drop down menu is used to designate the speaker used to playback per
line call recording audio.

Minimum Record Duration drop down menu
The Minimum Record Duration drop down menu is used to set the minimum length of time a
call must last for the audio to be recorded.
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Calls lasting less than the minimum duration are not recorded and will not be available for
playback.
Default is 0.5 sec.

Options are:
- 0.5sec
- 1.0sec
- 1.5sec
- 2.0sec

Log Outgoing Calls check box
The Log Outgoing Calls check box sets C-Soft’s logging behavior in both the Per Line History
and Global Call History windows.

By default, C-Soft only logs incoming calls. If the Log Outgoing Calls check box is selected,
outgoing calls are also logged in these windows. Note, the line must be configured in the Line
Recording Setup Box to record outgoing traffic.

Additionally, if Per Line Recording is enabled for a given line and the Log Outgoing Calls check
box is checked, outgoing transmissions made on that line are recorded and available for
playback.

Populate Keypad on Selection check box

The Populate Keypad on Selection check box indicates the user can select an entry in the per
line call history window and have the keypad automatically populate with the ID of the call. By
default, this option is disabled.

13.5 Local Consoles page

The Local Consoles page, shown in the Figure below, is used to configure the IP Addresses of
local consoles.
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Global Parameter Setup .

Pppearance Audio  Control Settings  |RR Recording  Local Consoles  Peripherals  Recording

Local Console IP Addresses

[0.0.0.0|] [0.0.0.0|
[0.0.0.0] [0.0.0.0|
[0.0.0.0] [0.0.0.0|
[0.0.0.0] [0.0.0.0|
[0.0.0.0] [0.0.0.0|

Direct IP Console Subscrber 1Ds

O o I O N O B o
P JF JF Jp _JpF
FJF JF JF JF JpF
I JF JF JF _JpF
FJF JF JF JF JpF

Crossmute direct P console subscriber [Ds (Only for NEXEDGE, AlS and C5511

Concs

Figure 13.10: Local Consoles Page - Global Parameters Setup
Local Console IP Addresses group box

Local Console IP Address fields

The Local Console IP Address fields identify up to 10 base IP Addresses of the Hardware IP
Console (IP-2002, IP-1616, IP-3000 series and C-6200) and C-Soft consoles that reside in the
same room.

The C-Soft program examines the source of the audio, and, if the source is from a console in
this list, the audio is muted. An exception to the muting rule is, if an ADHB-4 is connected and
the headset is turned on. In this case, the received audio is routed to the headset earpiece
and is played, ignoring the crossmute condition.

Notice!
Individual lines must have Mute Per-Line buttons associated with them for this feature to
work.
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Direct IP Console Subscriber IDs field

The Direct Console Subscriber IDs field is only used for the NEXEDGE IP, AIS, and P25 CSSI

interfaces. If an ID is entered into this field, the console treats all audio received from the

entered ID as a parallel console transmission.

Crossmute File

The Crossmute File is used to allow each position to have its own crossmute settings without

requiring a different design file by populating the Local Console IP Address fields with a .txt

file.

To create a crossmute file, do the following:

1. Ina .txt file, enter up to 200 IP Addresses (one per line).

2. Select File | Save from the menu bar.
The Save window opens.

3. Inthe File Name field, enter csoft_crossmutes.txt.

4. From the Look in drop down menu, select C:\ProgramData\Telex Communications\C-
Soft\DesignData.

5. Click Save.

The IP Addresses are loaded from this file and replace the entries in the Global Properties

Setup window.

Notice!

The Crossmute File feature does not apply to either the AIS, CSSI, or NEXEDGE IP interfaces.

Crossmute Direct IP Console Subscriber IDs check box (for NEXEDGE, AlS, and CSSI Lines

Only)

The Crossmute Direct IP Console Subscriber IDs check box is used to allow crossmute for

the NEXEDGE IP, AIS, CSSl interfaces in a parallel console. This means when C-Soft detects a

parallel console transmit with a console ID on the list, it mutes the transmit audio.

To enable Crossmute Direct IP Console Subscribers, do the following:

1. Inthe Direct IP Console Subscribers ID field, enter the IDs for all NEXEDGE, AlS, and
CSSI consoles present in the system.

2. Select the Crossmute direct IP console subscribers IDs check box.

13.6 Peripherals page

The Peripherals page, shown in the Figure below, is used to configure network settings,
phone, and peripheral devices.
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Global Parameter Setup .

Appearance Audic  Control Settings  |RR Recording  Local Consoles  Peripherals | Recording

Metwork Settings License Server(s)

IP Interface: EI = IP Address/MName:
Radio Fing Interval: EI SEC 1: | |

TCP/IP Timeout: ms 2 | |
[]Enable R¥ Multicast Loopback

Phone ADHB-4 Speaker Vaolume
Ring Multicast: | 225. 8 . 11. 81 | Mirs Vokume

Ring Port Speaker1: 0 | (0%.99%)

Ring Sound: | Ring 1 e Speaker Z: EI (0°-99%)
Ring Speaker: | Speaker1 = Speaker 3: EI (0%-59%)
Speaker4: [0 | (0%95%)
[] Auto Hold Phone Line on PTT
Speaker5: [0 | (0%99%)
MNED-10
Multicast: |225 3 1181 Speaker & EI (07-99%)

Update Port:

Concs

Figure 13.11: Peripherals Page - Global Parameters Setup
Network Settings group box

IP Interface spin box

The IP Interface spin box is used to select the network interface. The C-Soft program can be
configured to use any of the first four interfaces.

If no traffic is detected on the selected interface, do the following:
1. From the IP Interface spin box, select a different interface (0-3).
2. Save the C-Soft Designer.exe file.

3. Restart the C-Soft Runtime console.

Notice!

If at least one Ethernet connection is present, the value always defaults to zero, often
resulting in no traffic detected. If your computer has an Ethernet connection not being used
to run C-Soft Runtime, we recommend turning off that connection or setting the value in the
field to 1, 2, or 3.
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Caution!
If you choose to run an Ethernet connection and C-Soft at the same time, you might lose your
C-Soft Ethernet connection.

EXAMPLE: The wireless connection is located at interface 0 and the C-Soft Ethernet
connection is located at interface 1. If the computer becomes disconnected from the wireless
connection, Windows automatically moves the C-Soft Ethernet connection from interface 1 to
interface 0. In this case, C-Soft is disconnected from the Ethernet.

Radio Ping Interval field

The Radio Ping Interval field identifies the time, in seconds, between ping attempts on the
base radio IP Address. The typical amount of time is 300 seconds or five minutes. A value of
zero disables the function.

The range for this field is 0 to 9999 seconds.

TCP/IP Time Out field
The TCP/IP Time Out field indicates the amount of time, in ms, before the TCP/IP connection
times out.

The range for this field is 1000 to 20000ms.

Enable RX Multicast Loopback check box
The Enable RX Multicast Loopback check box is used to enable the current console
configuration to receive Multicast audio sent from the same PC currently running C-Soft.

Phone group box

Ring Multicast field

The Ring Multicast field identifies the IP Address to which the ring signal is broadcast. The
entry in this field should correspond to the values set in a C-6200 console with an actual
phone card interface, or to an IP-223 with Telex’s PIB or attached TDI Adapter.

Ring Port field

The Ring Port field is used to identify the port number to which the ring signal is broadcast.
The entry in this field should correspond to the values set in a C-6200 console with an actual
phone card interface, or to an IP-223 with Telex’s PIB or attached TDI Adapter.

Ring Sound drop down menu
The Ring Sound drop down menu is used to select the ring sound heard when a call is
received.

Available selections for this field are: Ring 1, Ring 2, Ring 3, and Ring 4.

Ring Speaker drop down menu
The Ring Speaker drop down menu is used to select which speaker plays incoming phone ring
tones.
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Available selections for this field are Speaker 1, Speaker 2, Speaker 3, Speaker 4, Speaker 5,
or Speaker 6.

Auto Hold Phone Line on PTT check box
The Auto Hold Line on PTT check box is used to indicate any phone currently offhook is put
on hold when any PTT button is pressed.

Notice!
Feature supported in both Line Types: Phone and SIP Phone.

NEO-10 group box

The NEO-10 device sends out a UDP packet anytime one of its inputs or outputs changes
state. The C-Soft program monitors this traffic and allows all users of the equipment to see
input and output status changes.

Multicast field
The Multicast field identifies the Multicast Address of the NEO-10 device.

The entry in this field should correspond to the entry on the NEO-10 Multicast Setup window.

Update Port field
The Update Port field identifies the port number of the NEO-10 device.

The entry in this field should correspond to the entry on the NEO-10 Multicast Setup window.
License Server group box

IP Address/Name fields

The IP Address/Name fields are used to specify the IP address or name of one or two Telex
Licensing Servers. Address specifications are expected in the following formats:

- <port>@<host IP>

- <port>@<servername>

- <host IP>

The default port is 27000.

Notice!

In C-Soft Runtime, the token “@localhost” will automatically be added to the license server
specification to instruct the license libraries to additionally connect to a locally-running
license server. As a result, for configurations using a local license server, no additional
parameters need to be set in C-Soft Designer.

ADHB-4 Speaker Volume group box

Speaker 1-6 Min Volume field

The Speaker 1-6 Min Volume field indicates the minimum selectable volume level for speakers
connected to jacks 2-6. During C-Soft operation, the volume for the specified speaker cannot
be set lower than the percentage configured for the speaker in this field.
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13.7

This field ranges from 0% to 100%.

Speaker 1’s volume is controlled with the Volume Master Select button. Refer to “Ul Element
Function Drop Down Menu”.

Recording page
The Recording page, shown in the Figure below, is used to configure a recording with Telex’s

Network Recorder.

For more information, refer to the Telex Network Recorder Technical Manual and Archive
Database Reviewer (F.01U.188.143).

Global Parameter Setup >

Appearance  Audic  Control Settings  |RR Recording  Local Consoles  Peripherals  Recording

Enable Vocoder Type Multicast Port TTL
Select: [ | TELEX 32K 225.8 .11.81| |[2055 1
Unselect: [ | TELEX 32K 225.8 .11.81| 2056 1
Speaker3: [ | TELEX 32K 225.8 .11.81| |2057 1
Speakerd: [] | TELEX 32K 225.8 .11.81| 2058 1
Speaker5. [ |TELEX 32K 225.8 .11.81 | 2059 1
Speakers: [ |TELEX 32K 225.8 .11.81 | 2060 1
Mic: []  TELEX32K |225. 8 .11.81| |20%4 1
NENA: [0 | TELEX 32K [225. 8 .11.81] |2061 1
Aux Track Left:  [] | TELEX 32K [225. 8 . 11.81] |2062 1
Aux Track Right:  [] | TELEX 32K [225. 8 11 .81] |2083 1

Carcs

Figure 13.12: Recording Page - Global Parameters Setup
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Notice!
The microphone only records during activity, such as a telephone call or PTT.

Enable check box

The Enable check box is used to enable the Select speaker, Unselect speaker, speakers 3-6,
microphone, NENA, Aux Track Left, and Aux Track Right for recording from the indicated IP
Address and port.

Notice!

Speakers 3-6 and NENA are used when an ADHB-4 is connected to the PC. Aux Track Left is
the left channel audio received by the Aux In port on the ADBH-4 Gen 2. Aux Track Right is the
right channel audio received by the Aux In port on the ADBH-4 Gen 2.

Vocoder Type drop down menu

The Vocoder Type drop down menu indicates the bit rate at which audio is converted into
digital format. This feature is used to configure communication between C-Soft and an IP-223
or IP-224.

Available selections for this field are: TELEX 32K, G.726 16K, G.726 32K (IP224 Only), and
G.711 64K (IP224 Only).

Multicast field
The Multicast field indicates the console’s Multicast Address for the selected speaker,
microphone, or NENA.

Notice!
If multiple consoles are in use, this option requires a separate configuration for each console.

Port field
The Port field indicates the port used for the selected speaker, microphone or NENA audio.

The port number must be unique from all other ports configured on the console.

TTL field
The TTL field indicates the lifespan of data in a computer or network.
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14 Language Customization

The Language Customization window, shown in the Figure below, is used to configure call
window names, buttons, button labels, button color codes, column labels, fonts, and the

number of lines to display in the window.

Notice!

The Language Customization window was formerly known as “Global Call Parameters.”

NAVIGATION: Select Edit | Language Customization from the menu bar.

Language Custornization

List Entry Font Size
Active Ememgency: IEI

Call List:
Emergency History:
Per Line Call History:
Status List:

Default Settings

To restore all Language settings to a default state,
click Restore Defaults.

General  Button Labels Button Images  Column Headings  Text Labels

Maximum Ertry Limit

Emergency Histaory:

Per Line Call History:

Formatting

Call4oConsale Calor:

Date Fomat:

Window Titles

Restore Defaults

Cancel

Figure 14.1: Language Customization Window - General Page

14.1 General page

The General page is used to set the list entry font size, maximum entry limit, formatting, and

to restore default settings.
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List Entry Font Size group box

Active Emergency Font Size field
The Active Emergency Font Size field is used to specify text size for the Active Emergency
Call History window.

The range for this field is 1 to 72.

Call List Font Size field
The Call List Font Size field is used to specify the text size for the Call List window.

The range for this field is 1 to 72.

Emergency Call History Font Size field
The Emergency Call History Font Size field is used to specify the text size for the Emergency
Call History window.

The range for this field is 1 to 72.

Per Line Call History Font Size field
The Per Line Call History Font Size field is used to specify the text size for the Per Line Call
History window.

The range for this field is 1 to 72.

Status List Font Size field
The Status List Font Size field is used to specify the text size for the Status List window.

The range for this field is 1 to 72.
Maximum Entry Limit group box

Emergency Call History Window Lines field

The Emergency Call History Window Lines field is used to set the number of lines displayed
in the Emergency Call History window. When the Call History window is full, the oldest call is
removed.

The range for this field is 1 to 500 lines.

Per Line Call History Window Lines field

The Per Line Call History Window Lines field is used to set the number of lines displayed in
the Per Line Call History window. When the Call History window is full, the oldest call is
removed.

The range for this field is 1 to 500 lines.
Formatting group box

Call-to-Console Color drop down menu
The Call-to-Console Color drop down menu is used to set the Call-To-Console background
color. The background color can be changed by selecting options from the drop down menu.
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Notice!
The Call-to-Console color is used as the background color for calls directed to C-Soft
consoles in the FleetSync, MDC-1200, Call List and Per Line Call History windows.

Date Format drop down menu
The Date Format drop down menu is used to select the date format displayed in the call logs.

Available selections for this menu are:
- MM/DD/YYYY
-  DD/MM/YYYY

Default Setting group box

Restore Default button
The Restore Default button is used to reset all parameter settings to their default values.

The Restore Default button will reset all parameters in the Language Customization setup.

14.2 Button Labels window

The Button Labels group box contains fields to enter custom labels appearing on buttons in
the Call List, Per Line, Manual Call List, Set Status and Active Emergency windows.
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Language Customization *

General Button Labels  Button Images  Column Headings  Text Labels  Window Titles

General Buttons DTMF Buttons

ACK: Digit A:
Backspace: Digit B:
Cancel: Diigit C:
Clear: Digit D: ICI
Done: Digit E:
Emergency Clear: Diatt F:
Set Status:

Cancs

Figure 14.2: Language Customization Window - Button Labels Page

General Button group box

ACK field

The ACK field creates a button label that displays in the Active Emergency window. When the
button is clicked in C-Soft Runtime, the emergency is acknowledged by sending a message to
the radio that initially declared the emergency.

This field can contain up to 10 characters.

Backspace field
The Backspace field creates a button label that displays in the Manual Call window. When the
button is clicked in C-Soft Runtime, the last character entered in the User ID field is cleared.

This field can contain up to 10 characters.

Cancel field
The Cancel field creates a button label that displays in the Set Status window. When the
button is clicked in C-Soft Runtime, changes are discarded and the window closes.

This field can contain up to 10 characters.
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Clear field
The Clear field creates a button label that displays in the Manual Call List window. When the
button is clicked in C-Soft Runtime, the User ID field is cleared.

This field can contain up to 10 characters.

Done field
The Done field creates a button label that displays in all call windows. When the button is
clicked in C-Soft Runtime, the window closes.

This field can contain up to 10 characters.

Emergency Clear field
The Emergency Clear field creates a button label that displays in the Active Emergency
window. When the button is clicked in C-Soft Runtime, the Emergency is cleared from the list.

This field can contain up to 10 characters.

Set Status field

The Set Status field creates a button label that displays in the Per Line Call History, Manual
Call List and Call List windows. When the button is clicked in C-Soft Runtime, the Status List
window appears and a status ID can be selected and sent.

This field can contain up to 10 characters.

DTMF Buttons group box

Digit A-F fields

The Digit A-F fields create a button label that displays in the Manual Call window. When the
button is clicked in C-Soft Runtime, the digit it is assigned to is entered in the User ID field.

This field can contain up to 10 alphanumeric characters.

14.3 Button Images window

The Button Images group box contains fields to enter the file path of an image file
(.bmp, .jpg, .gif, and .png) to display custom images on the specified buttons.

Each button image contains the following two buttons:

Browse button

The Browse button opens the Open window, which is used to navigate to the image file.

Clear button
The Clear button resets the current file path to the default file path.

Notice!

To create a transparent background when using a 24-bit bitmap image, use RGB color 192,
192, 192.
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Language Custemization >

General Button Labels Button Images  Column Headings Text Labels  Window Titles

Button Images

Activity: foctivity bmp | =] [%
IC LED: @ cedbmp | [=][X
Link Fail [fied bmp | [=] [X
Mute: @  [muteonbmp | =] [%
Pagng:  {EELTEY |pagingbmp | [=][X
Page Done [pagedone bmp | [=] [X
RX LED: @  |dedbmp | [=] [X
TX LED: T |bded bmp | [=] [X
XTX LED: |dtrded bmp | =] [%

Cancs

Figure 14.3: Button Images window

Activity

The Activity icon is displayed on a Popup button when audio traffic is detected on a line
contained in the popup window and the popup window is closed (see Ul Element Setup
window - Add Popup Button, page 439). The default image is activity.omp.

IC LED

The IC LED icon is displayed on a Select button when intercom traffic is detected on the
Select button’s line (see Select, page 364). The default image is icled.bmp.

Link Fail

The Link Fail icon is displayed on Select buttons when C-Soft fails to detect a device at the
Select button’s base radio IP (see Select, page 364). The default image is Ifled.bmp.

Mute LED

The Mute LED icon is displayed on Select buttons when the Select button’s line is muted (see
Select, page 364). The default image is muton.bmp.

Paging

The Paging icon is displayed on Page and Manual Pages buttons while the page is being sent.
The default image is paging.bmp.
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144

Page Done

The Page Done icon is displayed on Page and Manual Pages buttons when the page has been
completed and the “Manually confirm pages are done sending” option has been enabled in
Paging Setup see Paging Settings window, page 149The default image is pagedone.bmp.

RX LED

The RX LED icon is displayed on Select buttons when receive traffic is detected on the Select
button’s line (see Select, page 364). The default image is rxled.bmp.

TX LED

The TX LED is displayed on Select buttons when parallel console transmit traffic is detected
on the Select button’s line (see Select, page 364). The default image is txled.bmp.

XTX LED

The XTX LED icon is displayed on Select buttons when parallel console transmit traffic, which
has been crossmuted, is detected on the Select button’s line (see Local Consoles page, page
129 and Select, page 364). The default image is xtxled.bmp.

Column Headings page

The Heading Labels group box contains fields to enter custom labels appearing on column
headings in the Call List, Per Line, Manual Call List, Set Status and Active Emergency
windows.
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Language Customization *

General Button Labels  Button Images Column Headings  Tewt Labels  Window Titles

Heading Labels

Date: |
Time: |T|me
Channel: |Channe|
Freq: | Freq
Status: |St.atus

Talkgroup: |TG ID

User ID: |User D

Caliing 1D |Calling ID

Status ID: | Status ID
Duration: | Duration
Comments: |Cummerrts
Direction: | Pt/ T

Cancs

Figure 14.4: Language Customization Window - Column Heading Page

Heading Labels group box

Date field
The Date field is used to create the column label applied to the date column in call windows.

This field can contain up to 31 characters.

Time field
The Time field is used to create the column label applied to the time column in call windows.

This field can contain up to 31 characters.

Channel field
The Channel field is used to create the column label applied to the channel column in call
windows.

This field can contain up to 31 characters.
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Freq field
The Freq field is used to create the column label applied to the frequency column in call
windows.

This field can contain up to 31 characters.

Status field
The Status field is used to create the column label applied to the status column in call
windows.

This field can contain up to 31 characters.

Talkgroup field
The Talkgroup field is used to create the column label applied to the talkgroup column in call
windows.

This field can contain up to 31 characters.

User ID field
The User ID field is used to create the column label applied to the user ID column in call
windows.

This field can contain up to 31 characters.

Calling ID field
The Calling ID field is used to create the column label applied to the calling ID column in call
windows.

This field can contain up to 31 characters.

Status ID field
The Status ID field is used to create the column label applied to the status ID column in call
windows.

This field can contain up to 31 characters.

Duration field
The Duration field is used to create the column label applied to the duration column in call
windows.

This field can contain up to 31 characters.

Comments field
The Comments field is used to create the column label applied to the comments column in
call windows.

This field can contain up to 31 characters.
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14.5 Text Labels window

The Text Labels group box contains fields to enter custom labels appearing in text fields in
the Call List, Per Line, Manual Call List, Set Status and Active Emergency windows.

Language Customization *

General Button Labele  Button Images  Column Headings Text Labels  Window Titles

Text Labels

Alias: | |
D Type: |ID Type

Filters: |F|fters

|
|
Ma Filters: | Mo Filter |
|

Mo Status: | Mo Status

Cancel

Figure 14.5: Language Customization Window - Text Labels Page

Text Labels group box

Alias field
The Alias field is used to create the column label applied to the alias column in call windows.

This field can contain up to 31 characters.

ID Type field
The ID Type field is used to create the column label applied to the ID type column in call
windows.

This field can contain up to 31 characters.

Filters field
The Filters field is used to create the filters label applied to the Call List window.
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This field can contain up to 31 characters.

No Filters field
The No Filters field is used to create the label applied when no filters are selected in the
filters display in the Call List window.

This field can contain up to 31 characters.

No Status field
The No Status field is used to create the label applied when no statuses are selected in the
status display in call windows.

This field can contain up to 31 characters.

14.6 Window Titles window

The Window Titles group box contains fields to enter custom titles appearing on windows in
the Call List, Per Line, Manual Call List, Set Status and Active Emergency windows.

Language Custornization X

General Button Labels Button Images Column Headings Text Labels  Window Titles

Window Titles
Active Emergency: |
Call List: |Cal| List

Emergency Histary: |Ernergenc'_.' Histony

Global Call History: |Glnbal Call Histony

Manual Call List: |I'l-'1anual Call List

Per Line Call History: |P'er Line Call History

Status List: |Status List

Carcs

Figure 14.6: Language Customization Window - Window Titles Page
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Window Titles group box

Active Emergency field
The Active Emergency field allows you to name the window that appears when the Active
Emergency button is clicked in the C-Soft Runtime program.

This field can contain up to 10 characters.

Call List field
The Call List field allows you to name the window that appears when the Call List button is
clicked in the C-Soft Runtime program.

This field can contain up to 10 characters.

Emergency History field
The Emergency History field allows you to name the window that appears when the
Emergency History button is clicked in the C-Soft Runtime program.

This field can contain up to 10 characters.

Global Call History field
The Global Call History field allows you to name the window that appears when the Global
Call History button is clicked in the C-Soft Runtime program.

This field can contain up to 10 characters.

Per Line Call History field
The Per Line Call History field allows you to name the window that appears when the Per Line
Call History button is clicked in the C-Soft Runtime program.

This field can contain up to 10 characters.

Manual Call List field
The Manual Call List field allows you to name the window that appears when the Manual Call
List button is clicked in the C-Soft Runtime program.

This field can contain up to 10 characters.

Status List field
The Status List field allows you to name the window that appears when the Status List button
is clicked in the C-Soft Runtime program.

This field can contain up to 10 characters.
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15 Paging Settings window

The Paging Settings window, shown in the Figure below, is used to configure pager settings
for both individual and group pages. Up to 10 predefined pages can be configured.

NAVIGATION: Select Edit | Setup Pagers from the menu bar.

Pager Setup
Fage Type:
Mone Setuni

Haone Setun?

Haone Setund

MHaone Setund

Haone Setunh
Haone Setunb

Mane Setun?

MHone Setund
Setund

Setunld

MHone

MHone

Page Send Topalogy
@ Sequential (1 Parallel

Tone Optians
[] Corect low frequency tone levels [Flatten Levels]

Delay between stacked pages: 0 mz

IJzer Control Optionz

[ &llows Programmed Page Stack buttons to be stacked
[ &hways stack page buttons
[] M anually confirm pages are done zending

[] Rievert bo initial frequency after sending page

Figure 15.1: Pagers Window
Page Setup

Page Type drop down menu
The Page Type drop down menu, to the right of the pager number, is used to select a pre-
defined pager from a list.

Available selections for this field are:
— 2 Tone 100 (Quickcall 11 100)
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— 2 Tone 1000 (Quickcall Il 1000)
- DTMF
- Knox

In addition to the pager selections provided on this window, a Ul element is provided.

Setup button
The Setup button is used to open the appropriate window for the type of pager selected in
the drop down menu.

For more information, refer to:

- “2Tone 100 Page Setup window, page 151”.
- “2Tone 1000 Setup window, page 153”.

- “DTMF Paging Setup window, page 157 .

- “Knox Paging Setup window, page 158”.

Page Send Topology

Sequential radio button
The Sequential radio button indicates the paging codes are sent on a line by line basis. The
pages for one line are completely sent before the pages on the next line are started.

Parallel radio button
The Parallel radio button indicates the paging codes are sent on different lines at the same
time.

Tone Options

Correct Low Frequency Tone Levels (Flatten Levels)

The Correct Low Freq Tone Levels (Flatten Levels) check box indicates tones across 300kHz
to 3kHz spectrum are flattened for better level adjustment. Depending on the load being
driven, it is possible additional roll-off of the lower frequency tone (sub 1kHz) levels can
occur.

Delay Between Stacked Pages field

The Delay Between Stacked Pages field is used to set the amount of time, in ms, C-Soft waits
between stacked pages. This feature enables page decoders to distinguish between different
pages.

The range for this field is 0 to 9999ms.

Notice!
This field is global and affects all stacked pages regardless of page type or format. This field
is added to the Inter-Page Delay configured for the individual Page Formats.

User Control Options Group Box

Allow Programmed Page Stack Buttons to be Stacked check box
The Allowed Programmed Page Stack Buttons to be Stacked check box indicates
programmed page stack buttons can be stacked.
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Always Stack Page Buttons check box
The Always Stack Page Buttons check box indicates that Page buttons are always stacked.

Manual Confirm Pages Are Done Sending check box

The Manual Confirm Pages Are Done Sending check box indicates the Page, Manual Page,
and Programmed Page Stack buttons display the Done icon once all pages generated by a
page button have been sent by the console. The Done icon remains visible on the page
buttons until the Page Cancel button is clicked.

Revert to Initial Frequency After Sending Page check box
The Revert to Initial Frequency After Sending Page check box indicates the console returns
to the original frequency configured before sending the page.

OK button
The OK button saves the entries and closes the window.

15.1 2 Tone 100 Page Setup window

The 2 Tone 100 Page Setup window, shown the Figure below, is used to configure a 2-digit
code paging sequence for this format. To open this window, select 2 Tone 100 from the Page
Type drop down menu.

2 Tone 100 Page E

T—

Page Mame:

Page Level:

|nitial Page Delay:

Inter-Page Delay:
Tone 1 Group:
Tone 2 Group:

Tone 1 Time:

Gap Duration:

Tone 2 Time: 0
Group Tone Time: 0

Enable Diagonal: [~
[hag Tone Freg: |0 Hz

Diag Locatian: [checked=1zt Tone)

Q. I[ Cancel ]

Figure 15.2: 2 Tone 100 Page Setup Window
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Page Name field

The Page Name field is used to enter a descriptive name to associate with the paging
sequence for this encoder. The name, when assigned, is displayed in the Pager Setup window
next to the Pager Number field, and is included for selection in a list of variables for the user
interface element page function.

Page Level field
The Page Level field identifies the output, in dB, of the relative paging tone.

The range for this field is -60 to 10dB.

Initial Page Delay field
The Initial Page Delay field identifies the amount of time, in ms, allowed from PTT until the
first tone is played.

The range for this field is 0 to 9999ms.

Inter-Page Delay field
The Inter-Page Delay field is used to set the amount of time, in ms, C-Soft waits between
stacked pages using the paging format.

The range for this field is 0 to 9999ms.

Notice!
This field only affects stacked pages using this page format. The field is added to Delay
Between Stacked Pages field on the Paging Setting window.

Tone 1 Group and Tone 2 Group fields
The Tone 1 Group and Tone 2 Group fields identify which two frequencies are played in
succession.

The range for this field is 1 to 15.

To determine the entry for each field, do the following:
—  Using the table on “Telex Tone Group Numbers, page 473", find the desired Telex Tone
Group number for the first and second tones.

Tone 1 Time field

The Tone 1 Time field identifies the duration, in ms, of tone 1. The tone and gap durations for
standard paging plans are shown in “Tone and Gap Durations for Standard Paging Plans, page
474",

The range for this field is 0 to 10000ms.

Gap Duration field

The Gap Duration field identifies the duration, in ms, of the gap duration. The tone and gap
durations for standard paging plans are shown in “Tone and Gap Durations for Standard
Paging Plans, page 474”.

The range for this field is 0 to 15000ms.
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Tone 2 Time field
The Tone 2 Time field identifies the duration, in ms, of tone 2. The tone and gap durations for

standard paging plans are shown in “Tone and Gap Durations for Standard Paging Plans, page
474",

The range for this field is 0 to 10000ms.

Group Tone Time field

The Group Tone Time field identifies the duration, in ms, of the group tone. The tone and gap
durations for standard paging plans are shown in “Tone and Gap Durations for Standard
Paging Plans, page 474”.

The range for this field is 0 to 10000ms.

Enable Diagonal check box

The Enable Diagonal check box indicates the tone specified in the Diag Tone Freq field is used
in place of either the first or second tone depending on the selection in the Diag Location
check box. Otherwise, the group tone is played for the diagonal tone duration period.

Diag Tone Freq field
The Diag Tone Freq field identifies the frequency, in Hz, of the diagonal tone when the Enable
Diagonal check box is selected.

The range for this field is 0 to 3000Hz.

Diag Location check box
The Diag Location check box indicates the diagonal tone is used in place of the first tone;
otherwise, the group tone is used.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.

15.2 2 Tone 1000 Setup window

The 2 Tone 1000 Setup window, shown in the Figure below, is used to configure a 3-digit
paging code. To open this window, select 2 Tone 1000 from the Page Type drop down menu.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



154 en | Paging Settings window C-Soft 7.700

2 Tone 1000 Page [ ———

Fage Mame:

Fage Lewvel:

Imitial Page Drelaw:

Inter-Page Delay:

Tone Plan Mumnber:

Tore 1 Tirne:

ap Duration:
Tore 2 Time: 0

Group Tane Time: 0O

Enable Diagonal: [
Diag Tone Freq: |0 Hz

Diag Locatian: [checked=1st Tone]

I OF. I[ Cancel ]

Figure 15.3: 2 Tone 1000 Setup Window

Page Name field

The Page Name field is used to enter a descriptive name to associate with the setup for this
encoder. The name, once assigned, is displayed on the Pager Setup window next to the Pager
Number field, and is included for selection in a list of variables for the user interface element
page function.

Page Level field
The Page Level field identifies the output of the relative paging tone.

The range for this field is -60 to 10dB.

Initial Page Delay field
The Initial Page Delay field identifies the amount of time allowed from PTT until the first tone
is played.

The range for this field is 0 to 9999ms.

Inter-Page Delay field
The Inter-Page Delay field is used to set the amount of time, in ms, C-Soft waits between
stacked pages using the paging format.

Notice!
This field only affects stacked pages using this page format. The field is added to Delay
Between Stacked Pages field on the Paging Setting window.

The range for this field is 0 to 9999ms.
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Tone Plan Number field

The Tone Plan Number field is used to configure the first and second page tones. Refer to
“Telex Tone Group Numbers, page 473".

The range for this field is 1 to 25.

EXAMPLE: If the pager to be reached is N349, the Telex Code Plan Number would be set to 12
which corresponds to group Mot N. The Pager Capcode 3 corresponds to the line (3+3), in
Group N (Tone Plan Number 12), from which the 2 Tone Group Frequencies are selected.

From using Telex Code Plan #12, Tone Group #3, and Tone Group #3 for N349, the first tone
(Telex Tone Group Number 3 and Tone Group 4) sent would be 313.0, followed by the second

tone (Telex Tone Group Number 3 and Tone Group 9) 1063.2.

Table “Example tone plan number locator” shows the break down of each digit in the pager
number N349 and a description of the encoder parameters identified by the digit.

Digit Identifies Description

N Pager Locate the Mot N Where the Telex code
group pagers in “2 plan # (12) and the
Tone 1000 Plan Pager Capcode (3xx)
Numbers” on page intersect in the table
427. to identify the Telex

Group No. (3+3). This

Enter the Telex identifies the
Codeplan # from the |frequencies for tone 1
top row in the Tone and Tone 2.
Plan Number (12)
(this digit can also
identify the entries
for the Tone 1 Time,
Gap Duration, Tone 2
Time and Group Tone
Time fields, refer to
“Tone and Gap
Durations for
Standard Paging
Plans” on page 426).

3 Pager Capcode Locate the Pager In the table’s left
Capcode (3xx) in “2 column.
Tone 1000 Plan
Numbers” on page
427.

Bosch Security Systems, LLC
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4 Tone 1 Frequency Using the first Where these two
number identified items intersect in the
above (3), locate the |table identifies the
Telex Group No. 3 frequency of tone 1
and Tone Group 4 (313.0).

(second digit in pager
number), from “Telex
Tone Group
Numbers” on page

425,

9 Tone 2 Frequency Using the second Where these two
number in the Telex items intersect in the
Group number (3), table identifies the
locate the Telex frequency of tone 2

Group No. 3 and Tone | (1063.2).
Group 9 (third digit in
pager number) from
“Telex Tone Group
Numbers” on page
425,

Tab. 15.4: Example tone plan number locator

Tone 1 Time field

The Tone 1 Time field identifies the amount of time of the duration for tone 1. The tone and
gap durations for standard paging plans are shown in “Tone and Gap Durations for Standard
Paging Plans, page 474”.

The range for this field is 1 to 10000ms.

Gap Duration field

The Gap Duration field identifies the amount of time of the gap duration. The tone and gap
durations for standard paging plans are shown in “Tone and Gap Durations for Standard
Paging Plans, page 474”.

The range for this field is 1 to 15000ms.

Tone 2 Time field

The Tone 2 Time field identifies the amount of time of the duration for tone 2. The tone and
gap durations for standard paging plans are shown in “Tone and Gap Durations for Standard
Paging Plans, page 474”.

The range for this field is 1 to 10000ms.

Group Tone Time field

The Group Tone Time field identifies the amount of time of the tone duration for the group
tone. The tone and gap durations for standard paging plans are shown in “Tone and Gap
Durations for Standard Paging Plans, page 474”.

The range for this field is 1 to 10000ms.
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Enable Diagonal check box
The Enable Diagonal check box indicates the frequency entered in the Diag Tone Freq field is
used in place of either the first or second tone depending on the selection made in the Diag
Location check box. Otherwise, the second tone is played for the diagonal tone duration
period.
Diag Tone Freq field
The Diag Tone Freq field identifies the frequency of the diagonal tone when the Enable
Diagonal check box is selected.
The range for this field is 0 to 3000Hz.
Diag Location check box
The Diag Location check box indicates the diagonal tone is used in place of the first or second
tone. If selected, the diagonal tone overrides either the first or second group tone. Otherwise,
group tone is used.
OK button
The OK button saves the entries and closes the window.
Cancel button
The Cancel button discards any changes made and closes the window.

15.3 DTMF Paging Setup window

The DTMF Paging Setup window, shown in the Figure below, is used to configure standard
paging tones level, delay, time length and string length.
To open this window, select DTMF from the Page Type drop down menu.

Fage Mame:

Fage Level

Initial Page Dielay:

Inter-Page Delay:
DTHF On Tirne:
DTHF OFf Tirne:

DTHF Drigiks:

]S

Figure 15.4: DTMF Paging Setup Window

Page Name field

The Page Name field is used to enter a descriptive name to associate with the setup for this
encoder. The name, once assigned, is displayed on the Pager Setup window next to the Pager
Number field, and is included for selection in a list of variables for the user interface element
page function.

Page Level field
The Page Level field identifies the output of the relative paging tone.
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The range for this field is -60 to 10dB.

Initial Page Delay field
The Initial Page Delay field identifies the amount of time allowed from PTT until the first tone
is played.

The range for this field is 0 to 9999ms.

Inter-Page Delay field
The Inter-Page Delay field is used to set the amount of time, in ms, C-Soft waits between
stacked pages using the paging format.

The range for this field is 0 to 9999ms.

Notice!
This field only affects stacked pages using this page format. The field is added to Delay
Between Stacked Pages field on the Paging Setting window.

DTMF On Time field
The DTMF On Time field identifies the amount of time the DTMF digit is played.

The range for this field is 20 to 2000ms.

DTMF Off Time field
The DTMF Off Time field identifies the amount of time in between the time each DTMF digit is
played.

The range for this field is 20 to 2000ms.

DTMF Digits field
The DTMF Digits field identifies the number of digits in a standard page. The number of digits
specified are expected by all pages using this option.

The range for this field is 1 to 16.

OK button
The OK button saves the entries and closes the window.

Cancel button

The Cancel button discards any changes made and closes the window.

154 Knox Paging Setup window

The Knox Paging Setup window, shown in the Figure below, is used to configure the pager
name, output level, digit duration, pause times, and digits required in the page.
To open this window, select Knox from the Page Type drop down menu.
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Page Mamme:

Page Level:

Iritial Page Delay:

Inter-Page Delay:

Fonow On Time:
Koo OFF Tirne:

Ko Didits:
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Figure 15.5: Knox Paging Setup Window

Page Name field

The Page Name field is used to enter a descriptive name to associate with the paging
sequence for this encoder. The name, when assigned, is displayed in the Pager Setup window
next to the Pager Number field, and is included for selection in a list of variables for the user
interface element page function.

Page Level field

The Page Level field identifies the output of the relative paging tone.

The range for this field is -60 to 10dB.

Initial Page Delay field
The Initial Page Delay field identifies the amount of time allowed from PTT until the first tone
is played.

The range for this field is 0 to 9999ms.

Inter-Page Delay field
The Inter-Page Delay field is used to set the amount of time, in ms, C-Soft waits between

stacked pages using the paging format.

Notice!
This field only affects stacked pages using this page format. The field is added to Delay
Between Stacked Pages field on the Paging Setting window.

The range for this field is 0 to 9999ms.

Knox On Time field
The Knox On Time field identifies the amount of time the knox digit is played.

The range for this field is 20 to 2000ms.
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Knox Off Time field
The Knox Off Time field identifies the amount of time in between the time each Knox Digit is
played.

The range for this field is 20 to 2000ms.

Knox Digits field
The Knox Digits field identifies the number of digits in a standard page. The number of digits
specified are expected by all pages using this option.

The range for this field is 1 to 16.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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16 Tone Levels window

The Tone Levels window, shown the Figure below, is used to configure the tone level, in dB,
of individual tones heard by the operator.

NAVIGATION: Select Edit | Setup Tone Level from the menu bar.

Tones level

Emergency Tones

Group Call Tornes

T alk. Permit Tones
|nput Beeps

Page Beepz

Phione Rings
Select Call Tones

Sidetones

)4

Figure 16.1: Tone Levels Window

Emergency Tone field
The Emergency Tones field indicates the tone level at which the emergency tone is heard.

The range for this field is -60 to 0 dB.

Group Call Tones field
The Group Call Tones field indicates the tone level at which the group call tones are heard.

The range for this field is -60 to 0 dB.

Talk Permit Tones field
The Talk Permit Tones field indicates the beep level at which the iDEN beeps are heard.

The range for this field is -60 to 0 dB.

Input Beeps field
The Input Beeps field indicates the beep level at which the input beeps are heard.

The range for this field is -60 to 0 dB.

Page Beeps field
The Page Beeps field indicates the beep level at which the page beeps are heard.

The range for this field is -60 to 0 dB.

Phone Rings field
The Phone Rings field indicates the ring level at which the phone rings are heard.
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The range for this field is -60 to 0 dB.

Select Call Tones field
The Select Call Tones field indicates the tone level at which select call tones are heard.

The range for this field is -60 to 0 dB.

Sidetones field
The Sidetones field indicates the level at which sidetones are heard.

The range for this field is -60 to 0 dB.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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17 Global SIP Configuration window

The Global SIP Configuration window, shown in the Figure below, provides access to SIP
Network settings and SIP Audio settings.

SIP extension settings are configured on a Per Line basis. For more information, see Configure
SIP Settings window, page 108.

NAVIGATION: Select Edit | Setup SIP Phone from the menu bar.

17.1 SIP Network page

The SIP Network page, shown in the Figure below, is used to enter Default Identity, STUN
Settings, Proxy Server Settings, and various other advanced settings.

Global SIP Configuration -

SIP MNetwork  Audio  Behavior
Default dentity

Display Name: ||

STUMN Server
[]Use STUN Server

Server Address:

Prowy Server
[] Use Qutbound SIP Proxy Server

Server Address:

|Iser Mame:
Password:

Advanced

[] Listen on Specific IP' Address J55 355 255 25§

[ Use Mon-Standard Port E0GD
] Enable Logging

Cancel

Figure 17.1: Network Page - Global SIP Configuration
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Default Identity group box

Display Name field

The Display Name field is used to enter an alias name for the console for easy identification.
The display name appears on the SIP phone if the SIP phone or SIP/PSTN gateway is capable
and configured to display the alias.

STUN Server group box

Use STUN Server check box

The Use STUN Server check box indicates the STUN (Session Traversal Utilities for NAT
[Network Address Translation]) server entered in the field is used to negotiate packet routing
through NAT firewalls or NAT routers.

Server Address field
The Server Address field is used to enter a server address for packet routing.

Notice!
The Use Stun Server check box must also be selected.

Typically, if C-Soft is running on a computer running on a private IP network, then it is
necessary to enable the use of STUN server option. The STUN protocol allows C-Soft to use a
STUN server on the internet to determine how the NAT gateway translates the UDP addressing
between the private network and the public internet.

Proxy Server group box

Use Outbound SIP Proxy check box
The Use Outbound SIP Proxy check box indicates traffic is initially sent through the proxy
server entered in the Server Address field.

Notice!
The Server Address field must also be configured.

Server Address field
The Server Address field is used to enter the proxy server’s address.

Notice!
The Use Outbound SIP Proxy check box must also be selected.

User Name field
The User Name field is used to enter the proxy server User Name.
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Password field
The Password field is used to enter the proxy server password.

Advanced group box

Listen on Specific IP Address check box
The Listen on Specific IP Address check box indicates the IP Address you enter in the Listen
on Specific IP Address field is active.

Notice!
The Listen on Specific IP Address field must also be configured.

Listen on Specific IP Address field

The Listen on Specific IP Address field is used to enter the specific IP Address to use for
sending and receiving phone calls. This feature is useful when the computer has multiple NICs
(Network Interface Cards).

Notice!
The Listen on Specific IP Address check box must also be selected.

Use Non-Standard Port check box
The Use Non-Standard Port check box indicates the port number entered in the field is used
for SIP communication. Otherwise, the default port number 5060 is used.

Notice!
The Use Non-Standard Port field must also be configured.

Use Non-Standard Port field
The Use Non-Standard Port field is used to enter a port number for SIP communications.~

Notice!
The Use Non-Standard Port check box must also be selected.

Enable Logging check box
The Enable Logging check box enables logging for the SIP library in C-Soft. This check box is
used for Debugging Purposes Only.
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17.2 Audio page

The Audio page, shown in the
buffering configuration.

Figure below, contains LAM, silence detection, and jitter

Global 5IP Configuration

SIP MWetwork Audic | Behavior

LAM Setup
LAM Level {dRB)

LAM Time (s)

Silence Detection

() None

() Fixed Threshold
(®) Adaptive Threshold
Voice Deadband (ms)
Silence Deadband (ms)
Jitter Buffering
Min Duration {ms)

Max Duration {ms)

Thresheld o=

Period {ms) IE
=

LS

-
-

4|k

1k

[
50

250
Restore Defaults

Cancel

Figure 17.2: Audio Page - Global SIP Configuration

LAM Setup group box

The LAM Setup group box is used to control LAM (Line Activity Monitor) during SIP phone to

radio crosspatch activity.

LAM Level (dB) spin box

The LAM Level (dB) spin box is used to set the audio threshold at which the crosspatched
line or echo packets begin to send audio packets over the network.

The range for this field is -60 to 0 dB.

LAM Time (s) spin box

The LAM Time spin box is used to set the amount of time for radio crosspatch activity. The
LAM time determines how long the SIP line is active after the audio level is below the LAM

level threshold.
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The range for this field is 0 to 60 sec.
Silence Detection group box

None radio button
The None radio button indicates there is no silence detection for any SIP phone line in the
system. Audio continues to transmit, even if silent.

Fixed Threshold radio button and Threshold spin box

The Fixed Threshold radio button is used to activate the minimum audio detection mode.
When the audio level reaches the specified threshold configured in the spin box, it is no longer
considered silent. Audio levels below the specified raw digital value in the spin box are
ignored and considered silent.

This setting is used with the Voice Deadband and Silence Deadband spin boxes.

The range for this field is 0 to 8000.

Adaptive Threshold radio button and Period spin box

The Adaptive Threshold radio button is used to activate the dynamic audio detection mode
and is the recommended configuration for silence detection. The minimum audio is
automatically adjusted after the software determines the average audio received over the
amount of time specified in the Period spin box.

This setting is used with the Voice Deadband and Silence Deadband spin boxes.

The range for this field is 10 to 10000ms.

Voice Deadband (ms) spin box
The Voice Deadband (ms) spin box is used to configure the minimum duration of audio above
the threshold needed to start sending audio.

The range for this field is 10 to 10000ms.

Notice!
If audio is choppy after setting the value, try setting to a shorter amount of time.

Silence Deadband (ms) spin box

The Silence Deadband (ms) spin box is used to configure the minimum duration of audio
below the threshold before the audio is considered silent. The time should be long enough so
that gaps between spoken words are not detected as silence, otherwise the audio may sound

choppy.

The range for this field is 10 to 10000ms.
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Jitter Buffering group box

The Jitter Buffering group box contains settings for buffering incoming audio packet delivery
to reduce jitter. When the minimum and maximum are set, the duration of jitter buffer is
dynamically adjusted between the two values. A longer duration can improve the audio quality
if network latency is variable, but when the duration is set for too long, audio delay can
interfere with conversation. Experimentation is the best way to optimize your settings.

Min Duration (ms) spin box
The Min Duration (ms) spin box is used to configure minimum buffer duration for incoming
audio.

The range for this field is 10 to 10000ms.

Max Duration (ms) spin box
The Max Duration (ms) spin box is used to configure maximum buffer duration for incoming
audio.

The range for this field is 10 to 10000ms.

Restore Default button
The Restore Defaults button is used to restore factory defaults. The default values appear in
the Figure above.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.

Operation Test

Test the SIP registration to confirm successful connectivity and authentication to the SIP
server. SIP Server status is recorded in the Global Call History page in C-Soft Runtime and a
success or failure registration message appears in the status bar.

Notice!

A SIP Call Control Ul element is required for each SIP line. Before testing the SIP connection,
you must create a SIP Call Control Ul element button. Refer to “SIP Call Control” on page
342.

To test the SIP connection in C-Soft Runtime, do the following:

—  Open the C-Soft console.

A message appears in the console status bar:
— If the connection is successful, a success message appears.
— If the connection fails a failure message appears.
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C-Soft Console
jSIF' Line: Diamond Card - Registered as 52420@usgw.ast.diamondcard.us

: C-Soft Console
SIP Line: SIPDiamondcard - Unable to Register as 52420@usgw.ast.diamondcard.us

17.3 Behavior page

The Behavior page, shown in the figure below, contains settings for defining how C-Soft SIP
operates. These settings are needed for interoperability with different SIP servers, which may
have differing procedures for common SIP operations.

Global SIP Configuration >

SIP Metwork Audio  Behavior

Hold Initigtion

®Allow independent stream states:

() Stop all streams

Cancel

Figure 17.3: Global SIP Configuration - Behavior page

Hold Initiation Group Box

The Hold Initiation group box is used to set how C-Soft initiates putting a call on hold. The
default value is Allow independent stream states, and is only recommended to set Stop all
streams in the case that C-Soft audio is leaking while on hold.
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Allow independent stream states Radio Button

The Allow independent stream states radio button indicates that C-Soft, upon putting a call
on hold, sends an invite message with the parameter a=sendonly, which the SIP server and
remote endpoint negotiate media streams, ultimately putting the call on hold.

Stop all streams Radio Button
The Stop all streams radio button indicates that C-Soft, upon putting a call on hole, sends an

invite message with the parameter a=inactive, immediately ending the streams without
negotiation.
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18 Setup P25

NAVIGATION: Select Edit | Setup P25 from the menu bar.

For more information about setting up P25:

— P25 DFSI Global Setup is discussed in P25 DFSI Global Setup window, page 480
—  Global P25 CSSI Parameters is discussed Global P25 CSSI Parameters, page 540
—  Encryption Setup is discussed in Encryption Setup window, page 516

Refer to
- P25-DFSI window, page 322
-  Appendix E - P25-DFSI (Digital Fixed Station Interface), page 479
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GPS Mapping Setup window

The GPS Mapping Setup window is used to enable GPS data to be received and stored by C-
Soft, and to configure GPS settings, such as file name.

The .kml file is located in a directory specified in C:\ProgramData\Telex Communications C-
Soft\Settings\ClientSettings.xml and by default is C:\ProgramData\Telex Communications C-
Soft\DesignData. Change the GPS Mapping storage directory by using Telex System Manager.
NAVIGATION: Select Edit | Setup GPS Mapping from the menu bar.

GPS Mapping Setup x

KML File Setup
Store received GPS data in KML file

File Name: |C|UC-|‘~|TI|

Network Setup
[] Enable GPS Output (NEXEDGE Only)

GPS IP Address GFS Port

|1?2.1e.1::.?:

&
—
()
()

Figure 19.1: GPS Mapping Setup Window

Notice!
GPS mapping is currently only available for the Kenwood NEXEDGE, MOTORBO, and Tait DMR
Trunking systems.

KML File Setup group box

Store received GPS data in KML File check box
The Store received GPS data in KML File check box is used to create and store GPS file.

Notice!
Google Earth functionality will only work if the Store received GPS data in KML File check box
is selected.

File Name field
The File Name field is used to define the file name.

Network Setup group box

Enable GPS Output (NEXEDGE Only) check box

The Enable GPS Output check box is used to enable GPS output. If selected, the GPS IP
Address and GPS ports become active and can be modified. If the radios have GPS enabled,
the console outputs the GPS information on the console’s user selectable address and port.
The format is in Degrees, Decimal Minutes.
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The remote radio must be configured in the radio programming software to send the GPS
coordinates to the console ID.

Notice!
The Network GPS feature is only available for the NEXEDGE IP interface.

GPS IP Address field
The GPS IP Address field indicates the console’s GPS IP Address for transmitting GPS data.

GPS Port field
The GPS Port field indicates the port used for GPS data.

The port number must be unique from all other ports configured on the console.
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20 NEXEDGE

NAVIGATION: Select Edit | Setup NEXEDGE from the menu bar.

— NEXEDGE is discussed in Appendix H - Kenwood NEXEDGE Direct IP interface, page 544

—  Global NEXEDGE Conventional Parameters window is discussed in Global NEXEDGE
Conventional Parameters window, page 561

—  Global NEXEDGE Trunking Parameters is discussed in NEXEDGE Trunking System setup,
page 551

—  NEXEDGE Encryption is discussed in NEXEDGE Encryption window, page 581
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21 Setup External Systems

Use Setup External Systems to configure and manage connections to external systems that C-
Soft uses for various specialized operations.

21.1 API Setup

For more information on the API Setup window, see
- Appendix K - C-Soft API Installation notes, page 604
- Setup External Systems window, page 605
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22 AIS

For more information, see A/S Global Setup window, page 596.
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23 Filter List Setup window

The Filter List Setup window, shown in the Figure below, is used to create a list of filters for
the console operator to use during FleetSync, MDC-1200, MOTOTRBO, P25-DFSI, and Telex-
Serial system creation to sort and organize units and groups or fleets of user IDs in the
system. The filters are also used by the console operator to filter units and groups while in the
Call List window, the FleetSync Dispatching window, the MOTOTRBO Dispatching window,
the P25-DFSI Dispatching window and Keypad Control.

This list can contain up to 60 filters.

NAVIGATION: Select Edit | Edit Filters from the menu bar.

Filter List Setup

&dd Filter

Delete Filker

Clear List

Figure 23.1: Filter List Setup Window

Filter List Setup group box

Filter Entry field
The Filter Entry field is used to enter a label for a new filter.

This field can contain up to 16 alphanumeric characters.

List field
The List field displays the list of all filters created in the system.

This list can contain up to 60 filters.

Add Filter button
The Add Filter button is used to add the filter entry in the Filter Entry field to the list of filters.

To add a filter, do the following:
1. Inthe Filter Entry field, enter a name for the filter.
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2. Click Add Filter.
The new filter appears in the Filter Entry field.

Delete Filter button
The Delete Filter button is used to delete an unwanted entry from the list of filters.

To delete a filter, do the following:

1. In the Filter List field, select the filter name.
2. Click Delete Filter.

The filter is deleted from the list.

Clear List button
The Clear List button is used to clear the entire list of filters from the Filter List.

To clear all entries, do the following:
—  Click Clear List.
The list is cleared from the window.

Notice!
If you accidentally click the clear list button and did not want to delete the entire list then
click Cancel and reopen the window.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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24

User ID List window

The User ID List window, shown in the following Figures, is used to create a list of individual
users in the system for recall later. It is used in conjunction with the ANI features of certain
radios. When the window is closed and reopened, the user IDs are sorted by Name in
ascending order. Refer to the Figure below.

NAVIGATION: Select Edit | Edit User ID List from the menu bar.

Name: UserID: | Sart By ID P T Inhibit:

35

]

Filters lcon 1

Filters lzon 1

Filters lzon 1

34 Telex-Serial
MOTOTRED
FleetSync
MDC-1200 Filters lzan 1

P25-DFSI Filters lean 1

Phane Filters loan 1

Sprint DC Filters loan 1

Generic Filters lzon 1
Generic Filters lcon 1

Generic Filters lcon 1

T e Y Y e Y e i

Generic Filters lcon 1

) Coes

Figure 24.1: User ID List Window

Notice!
When the User ID List is closed and opened again, the blank rows are deleted and the list is
sorted in ascending order by Name.

Name field
The Name field is used to enter a descriptive name to associate with the User ID.

When the ANI is received, this name appears on the select button for the line and in the User
ID column of the Per Line Call History window, Call List window, and the Manual Call List
window. If no name is associated with a User ID, the User ID appears on the line’s button and
in the history and call list windows.

This field can contain up to 16 characters.

For more information about ANI display configuration, refer to “ANI Setup Group Box”.

Sort By Name button
The Sort By Name button is used to sort the User ID List by Name in ascending order.

User ID field
The User ID field is used to configure the user ID number transmitted by the radio.
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User ID Types:

Generic: Up to 31 hexadecimal digits, *, and #
FleetSync: Up to 31 decimal digits.

iDen: Up to 31 decimal digits, *, and #
Telex-Serial: Up to 31 decimal digits
MDC-1200: Up to 31 hexadecimal digits
MOTOTRBO: Up to 31 decimal digits
NEXEDGE: Up to 5 decimal digits

NEXEDGE All Call: The ID is 65535

P25-DFSI: Up to 31 decimal digits

P25-CSSI: Up to 31 decimal digits

Phone: Up to 31 decimal digits, *, and #
Sprint DC: Up to 31 decimal digits

AlS: Up to 8 decimal digits
Telex-Enhanced-ANI: Up to 32 alphanumeric characters

Some of these system types do expect certain User ID formats or ranges, which are as follows:

Generic: This applies to many different systems, so there is no additional specification
FleetSync: 7 decimal digits: in range of 1001000-3494999

iDen: “<number>*<number>*<number>”

Telex-Serial: applies to many different systems, so no additional specification
MDC-1200: 4 hexadecimal digits O - FFFF

MOTOTRBO: decimal number 0-16776125

NEXEDGE: decimal number 0-65519

P25-DFSI: decimal number 0-65535

P25-CSSI: decimal number 0-65535

Phone: decimal number of up to 15 digits

Sprint DC: decimal number of 10 digits for an individual phone number and 15 digits for a
TeamDC group ID

AIS: Decimal number 1 - 16777215

Telex-Enhanced-ANI:A-Z, a-z, and 0-9

This field can contain up to 32 characters.

Notice!
Up to 6000 user IDs can be created.

Sort By ID button
The Sort By ID button is used to sort the User ID List by User ID in ascending order.

Type drop down menu
The Type drop down menu is used to select the system type the user ID is associated with.

Available selections for this field are: Generic, FleetSync, iDEN, Telex-Serial, MDC-1200,
MOTOTRBO, P25-DFSI, Phone, Sprint DC, NEXEDGE-TRUNK, NEXEDGE-CONV, CSSI and AlS.
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Mame: ’Smt By Narne] User |D: [ Sort By D ] Type: T Inhibit: lcon:
i B EE |-
z a i)
3 i'Pj;—Serial . feon 1
: s | o
5 P25DFSI &l lcon 1
B EEEQFDE = lcon 1
’ NEEDGELow | O on 1
8 ?leex-Enhanced-ANl (& lcon 1
g P25-C551 & P
| Ok H Cancel

Figure 24.2: User ID List - Type Drop Down Menu

TX Inhibit check box

The TX Inhibit check box indicates the caller’s alias displays when received, but does not
display as an available destination in the Call List, FleetSync Dispatch window, MDC-1200
Dispatch window, MOTOTRBO Dispatch window, P25-DFSI Dispatch window, or Keypad.

Filters button

The Filters button is used to assign one or more filters to the ID. When the filter button is
clicked, the Select Filters window appears and displays all filters you created earlier. Refer to
“Filter List Setup window, page 177.

To assign filters to the user ID, do the following:
1. Click the Filter Button.
The Select Filter window appears.
2. Select the filters you want to add the User ID to.
All the filters you want to include the User ID in are selected.
3. Click OK.
The User IDs are added to the selected filters.

To deselect a filter, do the following:
—  Click the filter.

Select Filters window
The Select Filters window is used to select filters to associate the user with. You can assign
multiple filters to a single User ID.

Load File button
The Load File button is used to load a .csv file containing User ID information into the User ID
List window.

Notice!
When the .csv file is loaded, all items in the current list are overwritten.
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To load a saved User ID .csv file, do the following:
1. Click Load File.
The Open window appears.
2. In the Open window, select the file you want to load.
3. Click Open.
The file is loaded, the Username, ID, and Type field are populated. If configured in the file, TX
inhibit and filters are also populated.

Save File button
The Save File button is used to save the current User IDs to a .csv file.

To save the User ID List to a .csv file, do the following:
1. Click Save File.
The Save As window appears.
2. In the Filename field, enter a name.
3. Click Save.
The .csv file is saved in the current folder.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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25

Group ID List window

The Group ID List window, shown in the Figure below, is used to configure both the decode
and encode group IDs for group ANIs. By default, the Group ID List is sorted by Group Name in
ascending order (refer to the Figure below).

Up to 5000 Group IDs can be created.

NAVIGATION: Select Edit | Edit Group ID List from the menu bar.

Notice!
When the Group ID List is closed and opened again, the blank rows are deleted and the list is
sorted by Group Name in ascending order.

Group: Group ID:| Sort By D Type: T Inhibit: - Set Colar:
Newpait Faliee ] [JOTT [Flestsyne Fiters

Ridgetop Police 102 [iDEN Filters =

O

Sidney Police 103 [ TelexSerial Filters

EECRINNN SN (voc120

Station 2 302 [MOTOTRBO
Station 3 303 [P25DFs

Filters

Filters

Filters

[ Generic Filters

[ Generic Filters

2
3
4
5
G
7
a
9

[ Generic Filters

—_
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[ Generic Filters

—
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[ Generic Filters

OoOooOoOoOooooo
T T T Y

12 | Generic Filters

| LoadFile || SaveFie |

lUncheckAII]E Set Color i lHeset Colors [ Cancel ]

Figure 25.1: Group ID List Window

Group field

The Group field is used to enter a descriptive name to associate with the Group ID. This name
is displayed on the Select button of the line when the ANI is received and in the Per Line Call
History Window, Call List Window, Manual Call List Window, System-specific Dispatch
Windows, and the Keypad Module. If no name is associated with a Group ID, the Group ID
appears.

This field can contain up to 16 characters.

Sort By Name button
The Sort By Name button is used to sort the Group ID List by Group Name in ascending order.
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Group ID Field
The Group ID field is used to enter the particular resource group’s identification number
which is used for aliasing incoming and addressing outgoing group-related operations.

This field can contain up to 8 characters.

ID number format:

- Generic - Up to 8 hexadecimal digits, *, and #.
—  FleetSync - Up to 8 decimal digits.

— iDEN - Up to 8 decimal digits, *, and #.

—  Telex-Serial - Up to 8 decimal digits.

- MDC-1200 - Up to 8 hexadecimal digits.

-  MOTOTRBO - Up to 8 decimal digits.

- NEXEDGE - Up to 5 decimal digits.

—  P25-DFSI - Up to 8 decimal digits.

—  P25-CSSI - Up to 8 decimal digits.

- AIS - Up to 8 decimal digits., 1-16777215

—  Telex-Enhanced-ANI: Up to 32 alphanumeric characters

Sort By ID button
The Sort By ID button is used to sort the Group ID List by Group ID in ascending order.

Type drop down menu
The Type drop down menu is used to select the system type for the assigned group.

Available selections for this field are Generic, FleetSync, iDEN, Telex-Serial, MDC-1200,
MOTOTRBO, P25-DFSI, NEXEDGE-TRUNK, NEXEDGE-CONV, P25-CSSI| and AIS

To assign the system type to the group, do the following:
—  From the Type drop down menu, select the type of system associated to the group.

FleetSunc

iDEM

Telex-Serial
MDC-1200
MOTOTREO
F25-0FsI
MEXEDGE-TRUME
MEAEDGE-COMY
al5
Telex-Enhanced-4r|
P25-C551

Figure 25.2: Group ID List Window - Type Drop Down Menu

TX Inhibit check box

The TX Inhibit check box indicates the caller’s alias displays when received, but does not
display as an available destination in the FleetSync Dispatch Window, MDC-1200 Dispatch
Window, or Keypad module.

Set Color check box

The Set Color check box is used to set a color for the group ID. When the set color check box
is selected, the Set Color button can be used to assign a color to the selected items. For more
information, refer to “Set Color Button”.
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The Filters button is used to assign a filter(s) to the group. When a filter is assigned, the

group is included any time the selected filter(s) is chosen.

Load File button

The Load File button is used to load a .csv file into the current Group ID List window.

Notice!

When the .csv file is loaded, all items in the current list are overwritten.

To load a saved group ID .csv file, do the following:

1. Click Load File.

The Open window appears.

2. In the Open window, select the file you want to load.

3. Click Open.

The file loads, the Group name and Group ID fields populate. If included in the saved file, the
group color, filters and TX Inhibit also populate.

Save File button

The Save File button is used to save the current Group ID List to a .csv file.

To save the Group ID List to a .csv file, do the following:

1. Click Save File.

The Save As window appears.
2. In the Filename field, enter a name.

3. Click Save.

The .csv file is saved in the current folder.

Bosch Security Systems, LLC
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Uncheck All button
The Uncheck All button clears all Set Color check boxes.

Set Color button

The Set Color button opens the color palette. With this palette you can assign a color to
display as the background for the group and group ID in C-Soft Runtime’s system-specific
dispatch windows, and the Per Line Call History window. The colors allow for customization
and quick visual recognition of configured groups.

To set a color for the group ID, do the following:

1. Select the Set Color check box for each group you want to assign a color.
Each group ID you want to color is selected.

2. Click Set Color.
The Color window appears.

3. Select a color.
The color appears in preview box.

4. Click OK, to apply the color in the preview box.

The color is applied to the selected group(s).

Click Cancel to close the window and discard changes.

Reset Colors button
The Reset Colors button sets all Group ID background colors to white.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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26

Status Message ID List window

The Status Message ID List window, shown in the Figure below, is used to configure status
messages and status IDs that are either sent of received by the console.

This list can contain up to 5000 status messages.

Note:

-  When the window is closed and reopened, the list is sorted in descending Status ID
order.

— Any row left unfilled is deleted and the list is sorted by descending group ID number
when the Status Message ID List is closed and opened again.

NAVIGATION: Select Edit | Edit Status Message ID List from the menu bar.
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Figure 26.1: Status Message ID List Window

Status Message field

The Status Message field creates an alias or descriptive message to associate with the Status
ID. This message appears in the Per Line Call History window, Global Call History window,
System-specific Dispatch windows, Status window, Send Status button, and on the Select
button upon receiving a Status Message.

This field can contain up to 32 characters.
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Status ID field
The Status ID field identifies the message transmitted by the radio. For example, using the
Figure above, if status 98 is sent to the console, the console displays “Mandown”.

This field can contain up to 8 characters.

Password Protected check box
The Password Protected check box is used to indicate the supervisor password is required
before the status ID can be sent. Refer to “Supervisor Password Field”.

Set Color check box
The Set Color check box is used to select specific Status Message entries to which the Set
Color button applies.

Load File button
The Load File button is used to load a .csv file into the current Status ID window.

Notice!
When the .csv file is loaded, all items in the current list are overwritten.

To load a saved status message .csv file, do the following:
1. On the Status Message ID List window, click Load File.
The Open window appears.
2. Inthe Open window, select the file you want to download.
3. Click Open.
The file is loaded, the Status Message and ID fields are populated. If configured in the saved
file, status color and password protection is also populated.

Save File button
The Save File button is used to save the current Status Message ID List to a .csv file.

To save the Status Message ID List to a .csv file, do the following:
1. On the Status Message ID List window, click Save File.
The Save As window appears.
2. In the Filename field, enter a name.
3. Click Save.
The .csv file is saved in the current folder.

Uncheck All button
The Uncheck All button clears all Set Color check boxes.

Set Color button
The Set Color button is used to set a color for any entries for which the Set Color check box is
selected.

To set the Status ID color, do the following:
1. Select the Set Color check box for all messages you want to assign a color.
2. On the Status Message ID List window, click Set Color.
The Color window appears.
3. From the Basic colors group box or the palette, select a color.
4. Click OK.
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The selected Status IDs are colored.
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Reset Colors button
The Reset Colors button sets all Status ID background colors to white.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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27

Text Message ID List window

The Text Message ID List window, shown in the Figure below, is used to configure static text
messages (aliases) and an associated ID. The Text Message ID List is used to associate sent or
received TextID codes to a readable Text Message.

This list can contain up to 500 text messages.

NAVIGATION: Select Edit | Edit Text Message ID List from the menu bar.

Text Message:

Code Pink
Code Yellow

Return to Desk

Load File ] ’ Save File

Figure 27.1: Text Message ID Window

Text Message field

The Text Message field is used to create a descriptive message for the Text ID. This message
can be selected by the console operator from the Per Line Call History window, MDC-1200
Dispatching window, MOTOTRBO Dispatching window and P25-DFSI Dispatching window
while in C-Soft Runtime.

This field can contain up to 48 characters.

Text ID field

The Text ID field indicates the ID number entered on the radio to send the text message. This
ID number also appears in the Quick Text drop down menu on the MOTOTRBO Dispatching
window in C-Soft Runtime for selecting a text message to send to the radio.

This field can contain 1 to 3 digits.
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Load File button
The Load File button is used to load a .csv file in to the current Text Message ID List window.

Notice!
When the .csv file is loaded, all items in the current list are overwritten.

To load a saved text message .csv file, do the following:
1. Inthe Text Message ID List window, click Load File.
The Open window appears.
2. In the Open window, select the file you want to load.
3. Click Open.
The file is loaded, the Text Message and ID fields are populated.

Save File button
The Save File button is used to save the Text Message ID List to a .csv file.

To save the Text Message ID List to a .csv file, do the following:
1. Click Save File.
The Save As window appears.
2. In the Filename field, enter a name.
3. Click Save.
The .csv file is saved in the current folder.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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28 Edit System List window

The Edit System List window, shown in the Figure below, is used to create and manage units,
groups, and fleets included in your FleetSync, MDC-1200, MOTOTRBO, P25-DFSI, NEXEDGE
IP, or Telex-Serial system. This list can contain up to 200 systems.

Reference

For more information about creating a Ul Element button for a FleetSync, NEXEDGE IP,
MDC-1200, MOTOTRBO, Telex Serial, or P25 DFSI system:

—  Refer to “FleetSync, page 255”.

—  Refer to “MDC-1200, page 291”.

- Refer to “MOTOTRBO Radio Setup page, page 303”.

—  Refer to “P25-DFSI window, page 322”.

—  Refer to “CSS/ System setup, page 538.

—  Refer to “Telex-Serial Setup page” on “Telex-Serial system type, page 86”.

- Refer to “Appendix H - Kenwood NEXEDGE Direct IP interface, page 544”.

For more information about using the dispatching window that appears when the console
operator selects a FleetSync, MDC-1200, MOTOTRBO, or P25 DFSI dispatching window
button in C-Soft Runtime:

-  Refer to “FleetSync Dispatching window, page 256”.

—  Refer to “MDC-1200 Dispatching window, page 294”.

—  Refer to “MOTOTRBO Dispatching window, page 312”.

—  Refer to “P25-DFSI window, page 322”.

—  Refer to “CSS/ System setup, page 538.

NAVIGATION: Select Edit | Edit System from the menu bar.
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Figure 28.1: Edit System List Window - Blank

To create a new system, do the following:
1. From the File menu, select New.
2.  From the Edit System List window, select System | New System.
The New System window appears.
3. Inthe New System Name field enter a name.
A new system with empty filters and empty statuses appears in the System List field.

System names cannot contain the characters shown in the following table:

“ ‘ ; & < > ( ) ,

Tab. 28.5: Characters not permitted in system names

28.1 File menu - Edit System List

The File menu, in the Edit System List window, shown in the Figure below, is used to create
new, open existing, save the current system list, or close the current window.

Available selections for this field are New, Open, Save, and Close.
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Figure 28.2: File Menu - Edit System List Window

New menu
The New menu clears the current System List field display so you can create a new system list
in the window.

To create a new system list from the Edit System List window, do the following:
1. From the File menu, select New.
A prompt to save the current system appears, if one already exists.
2.  From the System menu, select New System.
The New System window appears.
3. In the name field, enter a name for your new system.
4. From the System Type drop down menu, select a system type.

Note:

— If asystem(s) is currently displayed in the System List field, then you are prompted to
save changes to the current system before the window refreshes.

— If no system is currently displayed, selecting File | New has no affect. Click System | New
System, to begin to create a new system

Open menu
The Open menu opens a window to select a file from.

To open an existing system list, do the following:

1. From the File menu, select Open.
NOTE: If a system is currently displayed in the System List field, then you are prompted
to save changes to the current system before the window refreshes.

2.  From the Open window, select the system file you want to add to the System List field.
The system file is highlighted.

3. Click Open.
The system is loaded in the System List field and system components are available for
selection.
OR
Click Cancel to exit without selecting a system list file.
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Save menu

The Save menu saves the currently displayed system to a file.

To save a system list file, do the following:
1. From the File menu, click Save.
The Save As window appears.
2. In the name field, enter a name for the system list.

OR

Verify the filename is the name you want to use.
3. Click Save.
Notice!

If this is the first time you are saving the system list, click the Save button, the Save As
window appears. Choose a filename and path to save the file or click the cancel button.

Save as Default XML File check box
The Save as Default xml File check box indicates the selected system list file is designated as
the default system list for the console position.

To save the current system list as the default .xml file, do the following:
1. From the File menu, click Save.
The Save As window appears.
2. In the name field, enter a name for the system list.
OR
Verify the filename is the name you want to use.
3. Select the Save as Default xml File check box.
4. Click Save.
The system list is saved as default and appears the next time the Edit System window opens.
Also, this system list is used by Runtime the next time the .veg file is run.

This feature works in conjunction with the Filename field on “Filename Field”.

Close menu
The Close menu closes the Edit System List window.
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28.2

28.2.1

To close the Edit System window, do the following:
1. From the File Menu, select Close.
A C-Soft Designer window appears.
2. Click Save to save changes.
OR
Click No to discard changes and close the window.
OR
Click Cancel to discard changes.

Edit System List window - System Menu

The System Menu, shown in the Figure below, is used to select a new system, copy from an
existing system, or automatically build a system with filters, groups, statuses, and units you
defined earlier.

Available selections for this field are: New System, Copy System, and Auto Build System.

Sy Mew System...

Copy System...

Auto Build System

Figure 28.3: System Drop Down Menu - System List

New System window
The New System window, shown in the Figure below, is used configure the system type and
name the new system.

New System Setup group box
The New System Setup group box is used to enter a System Name and select a System Type.

System Name field
The System Name field is used to enter a name for your new system.

This field can contain up to 23 characters.

System Type drop down menu
The System Type drop down menu is used to select the type of system you want to configure.

Available selections for this field are: FleetSync, Telex-Serial, MDC-1200, MOTOTRBO,
NEXEDGE-CONV, NEXEDGE-TRUNK, and P25-DFSI.
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Figure 28.4: System Type Drop Down Menu - New System

To create a new system, do the following:

1. From the Edit menu, select Edit System List.

The Edit System List Window appears.
2.  From the System menu, select New System.
The New System window appears.

3. Inthe System Name field, enter a name for the new system.

4. From the System Type drop down menu, select the system type (for example, FleetSync).

5. Click OK.
The system is added to the System List field.

Notice!

If the system already appears in the System List field, the copied system is added to the
current system list and placed at the bottom of the list. If you are creating a new system, it is
placed in the System List field with empty filters and status containers.

OK button

The OK button creates the new system and closes the window.

Cancel button

The Cancel button closes the window without creating a new systems.

Notice!

The new system is not saved until the system file is saved.

28.2.2 Copy System window

The Copy System window, shown in the Figure below, is used to specify one system (source
system) to copy to another system (destination system).

Bosch Security Systems, LLC Technical Manual
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28.2.3

NAVIGATION: Select File | Copy System from the System List menu bar.

Figure 28.5: Copy System Window

Source System drop down menu

The Source System drop down menu is used to select an existing system to copy. The list is
populated with systems defined and saved earlier. For more information, refer to “Edit System
List window, page 192”.

Destination System field
The Destination System field is used to enter a name for the new system being created.

OK button
The OK button copies the selected source system to the newly created destination system and
closes the window.

Cancel button
The Cancel button closes the window without copying any systems.

To copy a system, do the following:

1. From the Source System drop down menu, select a system to copy.
2. In the Destination System field, enter a name for the new system.
3. Click OK.

The system is added to the System List field.

If systems already appear in the System List field, the copied system is added to the current
system list and placed at the bottom of the list.

If you are creating a new system, it is placed in the System List field with empty filters and
status containers.

System configuration

C-Soft supports Telex-Serial, FleetSync, MDC-1200, MOTOTRBO, and P25-DFSI signaling
protocols. In C-Soft Designer, systems are created to help manage permissions, organize units
and groups, and set up status message. In C-Soft Runtime the system is accessible through
the FleetSync, MDC-1200, MOTOTRBO or P25-DFSI Dispatching windows.

For more information, refer to “FleetSync Dispatching window, page 256”.
For more information, refer to “MDC-1200 Dispatching window, page 294”.
For more information, refer to “MOTOTRBO Dispatching window, page 312”.
For more information, refer to “P25-DFS/ window, page 322”.
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28.2.4

28.24.1

To configure a system, follow these steps:

1. Plan your system.

2. Create the system filters, refer to “Filter List Setup window, page 177”.

3. Setup auser ID List, refer to “User ID List window, page 179”.

4. Set up a group ID list, refer to “Group ID List window, page 183”.

5. Set up a status ID list, refer to “Status Message ID List window, page 187".

6. Create the system, refer to “Edit System List window, page 192", use filters and lists
created in steps 2-5.

7. Set up Per Line Parameters, refer to “Per Line Parameters window, page 61”.

8. Add the required Ul elements for the selected signaling protocol, refer to “U/ Element
Setup window - Add button, page 404“.

9. Manage default system file, refer to “Filename Field on “Filename Field”.

If you create more than one system file you can manage which system appears, by default, in

the Edit System List window.

Auto Build System command
The Auto Build System from the File menu is used to automatically create a new system
based on the current console configuration.

To build a system with the Auto Build command, do the following:
1. From the System menu, click New System.
A New System window appears.
2. In the New System Name field, enter a name for the new system.
From the System Type drop down menu, select the system type.
4. Click OK.
The new system is added to the system list field with empty filters and status containers.
5. In the system list field, select the check box for the new system.
6. From the System window, select Auto Build System.
The new system is populated with all Filters, User IDs, Status IDs, Group IDs, and Units

w

IDs saved while completing steps 2-5 in “System configuration, page 198”. Only users and
groups of the same system type are added to the new system.

Delete unwanted filters, IDs, and statuses, as needed.

System List group box
The System List group box is used to display the current system and its components.

To change the system list view, do one of the following:
—  Click the expand button to view components. oF
—  Click the collapse button to hide components. ™

System List group box

System List check boxes

The System List check boxes indicate the component is selected for removal. For more
information, refer to “Remove From List Button” on “System Components group box, page
200",
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System Components check boxes

The System Components check boxes indicate the component is selected to add to the
system list. For more information, refer to “Add to List Button” on “System Components group

box, page 200”.

System Components group box

yztem Components

_omponent Type:

Groups = E dit |
roup Type
OTOTREO

Group Alia Groups
3 Statuzes
Test Meszages
[Irits

i Group

Figure 28.6: Component Type Drop Down Menu - System List

28.2.4.2 System Components group box
Component Type drop down menu
The Component Type drop down menu, shown in the Figure above, is used to select a
category to pull data from.
Available selections for this field are Filters, Groups, Statuses, Text Messages and Units.
Filters component
The Filters component is used to select a filter. You must create filters, refer to “Filter List
Setup window, page 177, before a list is available for selection.
When the filter component is selected, the filter aliases you created appear in the list.
System Companents
Component Tope: [Filters *] [ Edit ]
Filter Aliaz
[ Squad
[] SquadE
[ Squad &
[ Dispatchers
Figure 28.7: Filter Alias List Example
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Groups components

The Groups component is used to select groups to include in your system. You must create
groups, refer to “Group ID List window, page 183, before a list of groups is available for
selection.

When the Groups component is selected, the group aliases you created appear in the list. See
the Figure below.

—  Group Alias Column
The Group Alias column displays the alias for available groups.

—  Group ID Column
The Group ID column displays the ID number used to connect to the group.

—  Group Type Column
The Group Type column displays the signaling type configured for the group.

Syztemn Components

Component Type: | Groups T] [ E dit ]
Group Aliaz Group (D Group Type
[ Group 300 300 MOTOTREO

Figure 28.8: Groups Alias List

Statuses components

The Statuses components is used to select statuses to include in your system. You must
create statuses, refer to “Status Message ID List window, page 187, before a list is available
for selection.

When the Status component is selected, the status aliases you create appear in the list. See
the Figure below.

—  Status Alias Column
The Status Alias column displays the alias configured for the status message.

—  Status ID Column
The Status ID column displays the ID used to send the status message.
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System Components

Component Type:  |iStatuses T] [ E dit ]
Status Aliaz Statuz D
[l In Service 10
[l Cut of Service ih
[]  Emergency Tun O aa
[ Harm Honk, 29
[l Inkibit T a0
[l Stun k=]
[l Fevive 92
[ Ack Stun On 93
[l Ack Stun OFff 94
[l M andawn 2t
[l Emergency 93

Figure 28.9: Status Alias List Example

Text Messages

The Text Messages component is used to select text messages to include in your system. You
must create text messages, refer to “Text Message ID List window, page 190", before a list is
available for selection.

When the Text message component is selected, the text messages you create appear in the
list. Refer to the the Figure below.

—  Text Message Column
The Text Message column displays the text message.

—  Text Message ID Column
The Text Message ID column displays the ID used to send the message.
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Syztem Components

Component Type: T ext Meszages P ] [ Edit ]
Test Meszage Test Meszage D
[l Teut Mezzage 16 15
[l Teut Meszage 2 p
[ Return to Desk, 20
[ Code ellow 21
[ Code Pink, 22
[ Text Meszage 3 3
& Tedt Meszage 4 4
& Test Meszage 5 4]
& Tedt Meszage 6 G
[l Test Meszage 7 7
[l Test Mezzage 8 a
[l Test Meszage 9 g

Figure 28.10: Text Messages List Example

Units components

The Units component is used to select units (individual users) to add to either a system or an
MDC-1200 group. The unit becomes a child when added to an MDC-1200 group. This helps
organize users in the system list. You must create units, refer to “User ID List window, page
1797, before a list of units is available for selection.

To add units to a group, do the following:
1. From the Component Type drop down menu, select Units.
The list of units you created appears.
2. Select units to add to the system list.
3. Select the group’s check box to which you want to add the unit.
4. Click Add to List.
The selected units are added to the group.

Unit Alias column
The Unit Alias column displays the alias for each configured unit.

Unit ID column
The Unit ID column displays the individual ID to which the message is sent.

Unit Type column
The Unit Type column displays the unit’s signaling system type.
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System Componenets
Component Type: | (ISR, -
Unit Alias Unit ID Unit Type
E Console 1000 MDC-1200
[ Remote 1 1001 FleetSync
| Remote 2 1002 FleetSync
i Remote 3 1003 Fleets

Figure 28.11: Units List Example

Add to List button

The Add to List button is used to add components selected in the System Component field, to
the currently selected system.

To add a component to the current system, do the following:

1. From the System List, select the system you want to add the component to.

2. In the System Component field, select the items you want to add to the system.
The selected items are highlighted in the System Component field.

3. Click Add to List.

The highlighted components are added to the selected system in the System List field.

Remove From List button
The Remove From List button is used to remove components from the System List.

To remove a component from a system list, do the following:

1. From the System List, select the system component you want to remove from the
system.

2. Click Remove From List.

The highlighted components are removed from the selected system in the System List field.

Select All button
The Select All button is used to select each component currently listed in the System
Components list. When clicked, all component’s check boxes are selected.

Deselect All button
The Deselect All button is used to deselect all components currently listed in the System
Components list. When clicked, all component’s check boxes are cleared.

Window Design Edit commands

The Window Design Edit commands include several standard Windows commands. The
shortcut key for the command is listed next to the command on the menu. Most of the Edit
menu commands can be accessed by the toolbar buttons described in the table C-Soft
Designer Toolbar on “C-Soft designer window”. A shortcut menu with a list of commands
relevant to the selected item can also be displayed by right-clicking a user interface element.
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Additional details for these commands are provided in “User interface element configuration,
page 53”.

To select all elements on the window, do the following:
—  Click Ctrl+A.
All elements are selected.

To deselect all, do the following:
—  Click the console window background.
All elements are deselected.

Command Description

Cut Select Cut from the Edit menu to delete the selected item.

NOTE that the Cut command does not place the selected item(s) into the
clipboard. Also, the Delete key on the keyboard can be used to delete
design elements from the window.

Copy Selecting Copy from the Edit menu copies the selected item(s) to the
clipboard.
Paste Select Paste from the Edit menu to insert the item(s) in the clipboard onto

the console window. The clipboard is specific to the C-Soft Designer
program and cannot be used to exchange data with other applications. Any
item(s) in the clipboard can be pasted multiple times. Each succeeding
paste appears as a cascading item off the original item pasted to allow for
easy selection and placement of the object(s).

Increase Width | Select Increase Width from the Edit menu to increase the width of the
selected element. When text is selected, the size of the selected text is
proportionally increased.

Decrease Select Decrease Width from the Edit menu to decrease the width of the
Width selected element. When text is selected, the size of the selected text is
proportionally decreased.

Increase Select Increase Height from the Edit menu to increase the height of the
Height selected element. When text is selected, the size of the selected text is
proportionally increased.

Decrease Select Decrease Height from the Edit menu to decrease the height of the
Height selected element. When text is selected, the size of the selected text is
proportionally decreased.

Rotate Select Rotate Window form the Edit menu to rotate the popup window

Window counter-clockwise around the selected popup button.

Move Right Select Move Right from the Edit menu to move the selected item(s) to the
right.

Move Left Select Move Left from the Edit menu to move the selected item(s) to the
left.

Move Up Select Move Up from the Edit menu to move the selected item(s) up.
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Move Down

Select Move Down from the Edit menu to move the selected item(s) down.

Open popup

Select Open popup from the Edit menu to open the popup window for the
selected popup button.

Properties

Select Properties from the Edit menu to open the Ul Element Setup window
for the selected item, or in the case of text, a window to enter a new text
string.

Refer to

—  Filter List Setup window, page 177

—  Group ID List window, page 183

—  Status Message ID List window, page 187
- Text Message ID List window, page 190

—  User ID List window, page 179

—  User interface element configuration, page 53
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29 Insert menu

The Insert menu contains commands to add controls and descriptive text to the console
window.

Notice!
This menu also appears by right-clicking in the C-Soft Designer Workspace.

Available selections for this field are:
- Add Button

-  Add Clock

- Add Frame

— Add Frequency Control

- Add Keypad

-  Add Popup Button

- Add Text

—  Add Text Message Control
- Add Volume Control

- Add VU Meter

When a command is selected, a button or control appears in the upper-left corner of the
console window.

Notice!
All available Ul Elements can also be placed inside popup windows.

Learn how to position items on the console window, refer to “User interface element
configuration, page 53”.

EXAMPLE: The Figure below, shows the console workspace after Add Button is selected from
the Insert menu and the newly created button is right-clicked.

To insert a Ul Element button, do the following:
- From the Insert menu, click Add Ul Button.
The Ul button appears in the upper left corner of the console window.
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,

File Edit Inset Wiew Run Help
=2 = I R PENP=R

!

Properties

Increase Height
Decrease Height
Increase Width
Decrease Width

Figure 29.1: Button Properties Flyout Menu
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30
30.1

Ul Element Setup window
Type page

The Type page, shown in the Figure below, is used to select the button’s filter, function and
line.

Type |Co|ors |Clptions

Ul Element: Button

Filter: ’AII

Il Element Function:
| GPS Read

Line to Associate Function With:

| Sidney Police 7] Global Radio Button

Figure 30.1: Ul Element Setup for Radio Command Button - Type Page

Filter drop down menu
The Filter drop down menu is used to refine the list of all available Ul Element functions to a
smaller subset of options available in the Ul Element Function drop down menu.

Ul Element Function drop down menu
The Ul Element Function drop down menu is used to select a function type. If a Radio
Command Button function type is selected, the Global Radio Button check box appears.

Line to Associate Function With drop down menu
The Line to Associate Function With drop down menu is used to select a desired line.

Global Radio Button check box
The Global Radio Button check box, if enabled, indicates that a Radio Command Button
function type is selected in the Ul Element function drop down menu.

—  Select the Global Radio Button check box to send the configured radio command on any
selected line.

— If the Global Radio Button check box is not selected, the configured radio command is
sent on the specified line only.
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30.2

30.3

Colors page

The Colors page, shown in the Figure below, is used to setup the colors and text of the Radio

Command Button.

Colors | Dptions

Button Up

eutor: [T
Text
Color: - |T

GPS Read
Texd:

Button Down

Button: :| |-|
Text
Colar - |..

GPS Read
Texd:

Drop Down Button Settings

Button Size: 17 == Piels

Amow Color: -|v|
Border Color: -|v|

Drop Down Direction
() Above
@ Below
O Left
(™) Right

Figure 30.2: Ul Element Setup for Radio Command Button - Colors Page

For information on the Button Up and Button Down color and text options, refer to the
“Global Parameter Setup window, page 114”.

Drop Down Direction group box
The Drop Down Direction group box specifies the direction the drop down list containing the
list of the available users or groups is displayed relative to the button.

Above radio button
The Above radio button indicates the drop down list displays above the button.

Below radio button
The Below radio button indicates the drop down list displays below the button.

Left radio button
The Left radio button indicates the drop down list displays to the left of the button.

Right radio button
The Right radio button indicates the drop down list displays to the right of the button.

OK button
The OK button saves the entries and closes the window.

Options page

The Options page, shown in the Figure below, is used to select the settings for list and scroll
settings.
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|T}rpe ICnInrs Options

List Settings Scrolling Settings
Background Color: [::::]I- Scrollbar Width: 17 Pixels

Teot Color- I:H"l Minimum Slider Size: Piels

Ertry Spacing: 8  Piels Password Protection

s is SSW
Visible Ertries: 10 Iz Supervisor Password

Figure 30.3: Options Page - Ul Element Setup

List Settings group box

Background Color drop down menu

The Background Color drop down menu displays the background color of the drop down list.

The background color can be changed by selecting the drop down menu to open a color
palette.

Text Color drop down menu
The Text Color drop down menu displays the color of the text in the drop down list. The text
color can be changed by selecting the drop down menu to open a color palette.

Entry Spacing field

The Entry Spacing field determines the amount of space in pixels between individual entries
in the drop down list. The value entered for Entry Spacing and the font type determine the
height of the individual entries in the drop down list. The entry spacing value can be increased
to allow individual entries to be selected from a touch screen.

The range for this field is 0 to 99.
The default value for this field is 8.

Visible Entries field
The Visible Entries field determines the number of users visible in the drop down list without
scrolling.

The default value for this field is 10.
Scrolling Settings group box

Scrollbar Width field
The Scrollbar Width field determines the width in pixels of the scrollbar in the drop down list.
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The default value for this field is 17.

Minimum Slider Size field

The Minimum Slider Size field determines the minimum height of the scrollbar’s thumbtack
slider in the drop down list. The thumbtack slider is sized proportionally based on the total
number of entries in the list and the number of entries which are displayed. The minimum
slider size ensures the scrollbar is always as least as large as the entered value.

The default value for this field is 17.
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31

Ul Element Functions configuration

The Ul Element Functions drop down menu, on the Type page, contains Ul Element functions
for selection. Configuration for each function is described in the following section and listed
alphabetically, as it appears in the drop down menu.

Ul ELEMENT

FUNCTION

CROSS REFERENCE

Add button

Active Emergency Window

Opens the Active Emergency
window to display emergency
calls.

Refer to “Active Emergency
Window, page 219”.

ADHB-4 Auxiliary Audio
Control

Allows the console operator
to toggle the playing of audio
received from the ADHB-4
Gen 2’s Aux In port

Refer to “ADHB-4 Auxiliary
Audio Control button, page
220",

ADHB-4 Mic Control

Allows the user to switch
between two mic control
inputs when the ADHB-4 is
connected to C-Soft.

Refer to “ADHB-4 Mic
Control, page 222”.

ADHB-4 NENA-Hold

Places a hold on the NENA
line.

Refer to “ADHB-4 NENA-Hold,
page 223”.

ADHB-4 NENA-Hook Control

Indicates if the NENA line is
off or on-hook.

Refer to “ADHB-4 NENA-Hook
Control function, page 224”.

ADHB-4 NENA-Indication

Indicates the current on or
offhook state of a NENA line.

Refer to “ADHB-4 NENA-
Indication, page 224”.

ADHB-4 NENA-Mute

Mutes the NENA line.

Refer to “ADHB-4 NENA-Mute,
page 225”.

ADHB-4 Select speaker
Control

Allows the user to turn the
selected speaker on and off
when the ADHB-4 when the
headset is connected.

Refer to “ADHB-4 Select
Speaker Control, page 225”.

Alert

Configures tones and
duration for alerts.

Refer to “Alert, page 225”.

Annunciation

Allows the user to send a pre-
recorded .wav file.

Refer to “Annunciation, page
228",

Address.

Auto-Dial Assign a string to send when | Refer to “Auto-Dial, page
the button is clicked. 2317,
Backup Line Switches to backup IP Refer to “Backup Line, page

232",

Call List Window

Opens the Call List window
to display a list of user IDs.

Refer to “Call List Window,
page 233”.
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Call Priority

Sets an outgoing call’s
priority for AIS/DMR calls.

Refer to “Call Priority button,
page 238”.

Call Queue Window

Allows users to view calls
added to call queue.

Refer to “Call Queue window,
page 239”.

Crosspatch

Crosspatches two or more
lines.

Refer to “Crosspatch, page
246",

Crosspatch Block

Blocks a crosspatch line from
transmitting.

Refer to “Crosspatch Block,
page 247”.

Crosspatch Clear

Clears a specific group from a
crosspatch.

Refer to “Crosspatch Clear,
page 248”.

Crosspatch Programmed

Crosspatches a pre-defined
group.

Refer to “Crosspatch
Programmed, page 248".

Crosspatch PTT

Transmits from the console to
crosspatched lines.

Refer to “Crosspatch PTT,
page 250”.

Dial Dials the number specified in |Refer to “Dial, page 251”.
the Keypad Module.
DTMF Digit Creates a DTMF digit button. |Refer to “DTMF Digit, page
251",
Emergency ACK Acknowledges an active Refer to “Emergency ACK,

emergency.

page 252”.

Emergency Clear

Stops emergency tones from
playing on the console.

Refer to “Emergency Clear,
page 253”.

Emergency History Window

Opens the Emergency History
window to view received
calls.

Refer to “Emergency History
Window, page 253”.

Encryption

Toggles encryption on/off.

Refer to “Encryption, page
254",

Encryption Key Select

Select transmit P25-DFSI
encryption option and display
incoming call’s encryption
information.

Refer to “P25 Encryption” on
page 469.

Event Logger

Displays system log events.

Refer to “Event Logger, page
254",

FleetSync

Opens a FleetSync
Dispatching window.

Refer to “FleetSync, page
2557,

Frequency Change

Changes to a pre-defined
frequency.

Refer to “Frequency Change,
page 265”.

GPS Read

Reads the GPS coordinates of
a radio.

Refer to “GPS Read button,
page 266”.
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GPS Trigger Off

Turns off the trigger reading
of the GPS coordinates of a
radio.

Refer to “GPS Trigger Off
button, page 267”.

GPS Trigger On

Reads the GPS coordinates of
a radio at a set periodic time.

Refer to “GPS Trigger On
button, page 267" .

Group Programmed

Broadcasts to a pre-defined
group.

Refer to “Group Programmed,
page 269”.

Group Select

Creates a pre-defined group.

Refer to “Group Select, page
273",

Group Select Limited

Limits the number of lines
which can be selected
simultaneously.

Refer to “Group Select
Limited, page 273".

Input Indication

Monitors NEO-10, or ADHB-4
activity.

Refer to “/nput Indication,
page 274”.

Instant Recall

Plays back audio.

Refer to “/Instant Recall, page
278",

Intercom

Allows console to console
communication.

Refer to “Intercom, page
281”.

Intercom-Per Line

Allows pre-defined console to
console communication.

Refer to “Intercom-Per Line,
page 281”.

Knox Digit

Creates a Knox digit button.

Refer to “Knox Digit, page
282",

Instant Recall - Last Call
Button

Allows console operator to
play back audio from last
received call.

Refer to “/nstant Recall - Last
Call button, page 280”.

Launch Application

Opens specified application.

Refer to “Launch Application,
page 282”.

Manual Call List Window

Opens the Manual Call List
window.

Refer to “Manual Call List,
page 285”.

Marker Tone

Keys and sends a tone burst
to a pre-defined radio
channel.

Refer to “Marker Tone, page
287",

MDC-1200 Window

Opens the MDC-1200
Dispatching window.

Refer to “MDC-1200, page
291”.

Monitor

Sends packets to open
squelch or ignore CTCSS
tones.

Refer to “Monitor, page 303".

MOTOTRBO Window

Opens the MOTOTRBO
Dispatching window.

Refer to “MOTOTRBO
Window”.

Mute Group

Mutes audio on a pre-defined
group.

Refer to “Mute Group, page
319°.
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Mute Main

Mutes all currently selected
lines.

Refer to “Mute Main, page
320”.

Mute-Per line

Toggles mute on a pre-
defined line.

Refer to “Mute-Per Line, page
321”.

P25-DFSI Window

Opens the P25-DFSI
Dispatching Window.

Refer to “P25-DFS/ window,
page 322”.

Page Pages a specific line and Refer to “Page, page 324”.
frequency.
Page Cancel Cancels an active page. Refer to “Page Cancel, page

328.

Page Manual Entry

Sends a page to a pager
number entered by the
console operator.

Refer to “Page Manual Entry,
page 328”.

Page Send Sends a group of pages, when | Refer to “Page Send, page
stacked. 331”.
Page Stack Stacks pages. Refer to “Page Stack, page

332.

Page Stack Programmed

Stacks a pre-defined group of
pages.

Refer to “Page Stack
Programmed, page 333".

Per Line Call History

Opens the Per line Call
History window.

Refer to “Per Line Call
History, page 335”.

Phone Flashhook

Flashhooks a phone line.

Refer to “Phone-Flashhook,
page 343”.

PTT Group Call

Transmits audio to a group of
radios.

Refer to “PTT-Group Call,
page 345”.

PTT -Main Transmits audio to all Refer to “PTT-Main, page
selected lines. 346”.
PTT Per Line Keys a pre-defined line. Refer to “PTT-Per Line, page

346”.

PTT Private Call

Transmits audio to a single
radio.

Refer to “PTT-Private Call,
page 347”.

PTT - Talk Back

Transmits to the last line that
received audio.

Refer to “PTT-Talk Back, page
348”.

Radio Call Alert

Sends a Call alert to a Radio.

Refer to “Radio Call Alert,
page 348”.

Radio Call Type

Selects between Broadcast
and Conference Call Types.
(NEXEDGE IP Only).

Refer to “Radio Call Type,
page 349”.

Radio Check

Checks if a Radio is on/off.

Refer to “Radio Check, page
349,
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Radio Disable Disables a Radio. Refer to “Radio Disable, page
349°.
Radio Enable Enables a Radio. Refer to “Radio Enable, page

350”.

Radio Regroup

Temporarily reassigns
Talkgroup.

Refer to “Radio Regroup,
page 350”.

Radio Remote Monitor

Activates PTT on remote radio
to monitor.

Refer to “Radio Remote
Monitor, page 351”.

Radio Ungroup

Resets Radio Talkgroup.

Refer to “Radio Ungroup,
page 351”.

Radio Select Call

Sends a Select Call to a radio.

Refer to “Radio Select Call,
page 353”.

Radio Status

Sends a Status Message to a
radio.

Refer to “Radio Status, page
3527,

Radio Status Request

Requests the Status of a
Radio.

Refer to “Radio Status
Request, page 352”.

Radio On/Offhook

Toggles radio on/off
periodically to keep the radio
active.

Refer to “Radio-On/Offhook,
page 353”.

Relay Control Button

Controls an ADHB-4 or

Refer to “Relay Control

NEO-10 relay. Button, page 354”.

RX All Disengages mute on selected | Refer to “RX All, page 363".
lines.

Scan Scans the selected line. Refer to “Scan, page 364”.

Scrambler/Encrypt Key Select

Selects active NEXEDGE
encryption key

Refer to “Kenwood NEXEDGE
Direct IP Interface” on page
503.

Select

Selects a line.

Refer to “Select, page 364”.

SIP Call Control

Opens the SIP Calls window.

Refer to “S/IP Call Control,
page 368”.

Stack Status Programmed

Opens the Status
Programmed window.

Refer to “Status Stack
Programmed, page 396”.

Stack Status Window

Opens the Stack Status
window.

Refer to “Status Stack
window, page 398".

Supervisor Seizes control of a line or Refer to “Supervisor, page
group of lines. 401”.
Talk Around Toggles the serial controlled | Refer to “Talk Around button,

radio that supports talk
around feature on/off.

page 402”.
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Text Button

Displays text on the console.

Refer to “Text button, page
402°.

TX All Selects all lines for TX. Refer to “TX All, page 403”.
Add Clock
Clock Displays the current time on | Refer to “Ul Element Setup
the console. window - Add Clock, page
4127,
Add Frame
Frame Displays a configurable frame |Refer to “U/ Element Setup

on the console.

window - Add Frame, page
416”.

Add Frequency Control

Frequency Control

Displays a customized
frequency control on the
console.

Refer to “Ul Element Setup
window - Add Frequency
Control, page 418”.

Add Keypad

Keypad

Provides access to an on-
screen keypad, allowing easy
access to contacts, DTMF
keypad, and operation
history.

Refer to “Ul Element Setup
window - Add Keypad, page
425",

Add Popup Button

Add Popup Button

Displays a Popup button.

Refer to “Ul Element Setup
window - Add Popup Button,
page 439”.

Popup Global Call History

Opens the Global Call History
display.

Refer to “Popup Global Call
History, page 444”.

Popup Webpage

Opens a window that displays
a pre-defined webpage.

Refer to “Popup Webpage,
page 442”.

Popup Window Control

Configures popup window
controls

Refer to “Popup Window
Setup page, page 440”.

Add Text

Font Window

Displays customizable text
lines to console design.

Refer to “The Done button is
used to close the window”.

Add Text Message Control

Text Message

Provides an interface for
sending and receiving text

messages.

Refer to “Ul Element Setup
window - Add Text Message
Control, page 450”.

Add Volume Control
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Volume-ADHB-4 NENA Controls the NENA volume on | Refer to “Volume-NENA” on
an ADHB-4. Type page, page 453.
Volume-Auxiliary Track Left Controls the left channel Refer to “Volume-Auxiliary
volume of the auxiliary audio | Track Left” on Type page,
when operating with an page 453.
ADHB-4 Gen 2.
Volume-Auxiliary Track Right | Controls the right channel Refer to “Volume-Auxiliary
volume of the auxiliary audio | Track Right” on Type page,
when operating with an page 453.
ADHB-4 Gen 2.
Volume-Master Select Controls the volume on all Refer to “Volume-Master
select lines. Select” on Type page, page
453.
Volume-Master Unselect Controls the volume on all Refer to “Volume-Master
unselected lines. Unselect” on Type page, page
453.
Volume-Per Line Controls volume per line. Refer to “Volume-Per Line” on
Type page, page 453.
Add VU Meter
VU Meter Control Displays the volume | Refer to “Ul Element Setup
level of a particular line. window - Add VU Meter, page
4577,
Tab. 31.6: Ul elements
Refer to
— Ul Element Setup window - Add Text, page 449
31.1 Active Emergency Window

The Active Emergency Window, shown in the Figure below, function displays a list of current

active emergencies.

When clicked in the C-Soft Runtime program, the Active Emergency window automatically

appears, and the Select button on the line receiving the emergency blinks. The Active
Emergency window is also accessible by clicking the Active Emergency button. For more
information, refer to “Emergency Button” on page 282 and to “Emergency Type” on page 284.

When an emergency call is received, the Active Emergency window automatically appears, and
the Select button on the line receiving the emergency blinks. The Active Emergency window is

also accessible by clicking the Active Emergency button. One of two actions can be taken on

an emergency call listed in the window:

—  Clear the emergency - By clearing the emergency, the emergency entry turns orange and
the tones stop. Pressing the Clear button clears all Active Emergencies in the list.
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- Acknowledge the emergency - By acknowledging the emergency, the selected emergency
entry is removed from the Active Emergency window. The user can acknowledge only one
emergency at a time. This can be accomplished without first clearing the emergency. For
supported radio protocol the emergency acknowledge message is sent to the individual
radio that declared the emergency.

Ul Elernent Setup
Type Colore Active Emergency Window Setup

Behavior

Automatically populate keypad on acknowledgement

Figure 31.1: Active Emergency Window Setup
Behavior group box

Automatically Populate Keypad On Acknowledgement check box

The Automatically Populate Keypad On Acknowledgement check box indicates when the
Active Emergency Window’s ACK button is pressed, the keypad’s destination is set to a
selected Emergency entry. Since the keypad’s contents are context specific to the currently
selected line, the keypad only updates if the currently selected line’s Signaling/System type
match those of the selected Emergency entry.

To add an Active Emergency button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Active Emergency Window.
The Active Emergency Window Setup tab appears.
5. Click the Active Emergency Window Setup tab.
The Active Emergency Window Setup page appears.
6. Select the Automatically populate keypad on acknowledgement check box, if desired.
7. Click OK.
The button color changes and Active Emergency appears on the button.

31.2 ADHB-4 Auxiliary Audio Control button

Notice!
Unless specified, the ADHB-4 and the ADHB-4 Gen 2 function the same.
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The ADHB-4 Auxiliary Audio Control button allows the console operator to toggle the playing
of audio received from the ADHB-4 Gen 2’s Aux In port. When the button is in the up state, the
auxiliary audio is muted. When the button is in the down state, the selected auxiliary audio
channel is played in the designated speaker. The button can be configured by the user to
either the left or right track audio.

The ADHB-4 Auxiliary Audio Control buttons are muted when a Main Mute button is pressed
and un-muted when an RX All button is pressed. The ADHB-4 Auxiliary Audio Control buttons
can be added to a crosspatch, with the limitation of one ADHB-4 Auxiliary Audio Control
button per crosspatch.

ADHB-4 Auxiliary Audio Setup page
The ADHB-4 Auxiliary Audio Setup page is used to setup which auxiliary track to use.

To open the ADHB-4 Auxiliary Audio Setup page, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4.  From the Ul Element drop down menu, select ADHB-4 Auxiliary Audio Control.
The Auxiliary Audio Setup tab appears.
5. Click the ADHB-4 Auxiliary Audio Setup tab.
The ADHB-4 Auxiliary Audio Setup page appears.

Ul Element Setup
Type Colors  Auxiliary Audio Setup

Auxiliary Track Selection

Auxiliary Track selection

Left radio button
The Left radio button indicates the ADHB-4 Auxiliary Audio Control button is controlling the
Auxiliary Audio Left track.

Right radio button
The Right radio button indicates the ADHB-4 Auxiliary Audio Control button is controlling the
Auxiliary Audio Right track.
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313

ADHB-4 Mic Control

The ADHB-4 Mic Control allows the user to switch between two microphone control inputs
when the ADHB-4 is connected to C-Soft.

Notice!

The microphone source selected for the up state of the button is active when the button is in
the up position; conversely, the microphone source selected for the down state is active
when the button is depressed.

ADHB-4 Mic Control Button Setup page
When the ADHB-4 Mic Control is selected from the Ul Element Function drop down menu, the
ADHB-4 Mic Control Button Setup page appears.

The ADHB-4 Control button can operate in one of two behaviors: Toggle or Selectable.

When configured as a toggle button, C-soft uses the ADHB-4 Control button’s up or down
state to determine the active ADHB-4 input source. Upon pressing the button, C-Soft toggles
between sources configured for the Up and Down states. Each state may select one of the
following:

—  Controller - the headset/mic input on the main ADHB-4 unit.

- RHB1 - remote headset box 1.

—  RHB2 - remote headset box 2.

- Desk Mic.

When configured as a selectable button, the ADHB-4 Mic Control Button is displayed as a Split
Button. Pressing the button displays a drop down list of options, allowing the user to select
which mic source to use.

The list is configurable by selecting the check box next to each option in the list of Available
Options.
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Ul Elernent Setup
Type Colors Options ADHB-2 Mic Cortrol Button Setup

Behavior

(®) Togale
Select ADHE-4 Mic Toggle States

Up State: |Controller o

Down State: | RHE1 e

() Selectable
Awailable Options

Controller
RHE1
RHB2
Desk Mic

Figure 31.2: ADHB-4 Mic Control Button Setup

To add an ADHB-4 Mic Control button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element Function drop down menu, select ADHB-4 Mic Control.
The ADHB-4 Mic Control Button Setup tab appears.
5. Click on the ADHB-4 Mic Control Button Setup tab.
6. From the ADHB-Mic Toggle States drop down menu, select one of the following for either
or the up and/or down state:
—  Controller - the headset/mic input on the main ADHB-4 Unit.
-  RHB1 - remote headset box 1
—  RHB2 - remote headset box 2
- Desk Mic
7. Click OK.
The button color changes and ADHB-4 Mic Control appears on the button.

314 ADHB-4 NENA-Hold

The ADHB-4 NENA-Hold function allows the console operator to place a NENA (National
Emergency Number Association) audio line connected to an ADHB-4, on hold. If the NENA is
on hold, the TX audio is not sent to the NENA and RX audio is routed to a specified speaker.
Otherwise the TX and RX are sent from the NENA line.

To add a ADHB-4 NENA-Hold button, do the following:
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31.5

31.6

1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select ADHB-4 NENA-Hold.
5. Click OK.
The button changes color and NENA Hold appears on the button.

ADHB-4 NENA-Hook Control function

The ADHB-4 NENA-Hook Control function allows the console operator to change the NENA
phone line logic that is connected to an ADHB-4, on or off hook.

To add ADHB-4 NENA-Hook Control button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select ADHB-4 NENA-Hook Control.
5. Click OK.
The button changes color and NENA On Hook Control appears on the button

ADHB-4 NENA-Indication

The ADHB-4 NENA-Indication function indicates the current on- or offhook state of a NENA
phone line connected to an ADHB-4. A speaker icon appears on the button to indicate audio
routing for the NENA line.

Notice!
If the NENA Mute button is clicked (for example, line is muted) the mute icon appears on the
NENA Indication button.

To add NENA-Indication button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select ADHB-4 NENA-Indication.
5. Click OK.
The button changes color and NENA Indication appears on the button.
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31.7 ADHB-4 NENA-Mute

The ADHB-4 NENA-Mute function allows the console operator to mute the RX audio of a NENA
phone line.

To add a NENA-Mute button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select ADHB-4 NENA-Mute.
5. Click OK.
The button changes color and NENA Mute appears on the button.

31.8 ADHB-4 Select Speaker Control

The ADHB-4 Select Speaker Control allows the user to turn the selected speaker on and off
when the headset is connected.

To add an ADHB-4 Select Speaker Control button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select ADHB-4 Select Speaker Control.
5. Click OK.
The button color changes and Speaker Off appears on the button.

31.9 Alert

The Alert function allows the console operator to send a tone to all selected lines.

In C-Soft Runtime, if PTT is not active when an Alert button is pressed, the PTT button is
automatically activated to key the remote radios before the tones are generated.

Alert Setup page
When the Alert function is selected from the Ul Element Function drop down menu, the Alert
Setup page appears. Refer to the Figure below.
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Aot St

Tone Type:
3 Tone: () Pulsed Tone () Hi-Lo

Low Frequency: 1000 Hz  Low/On Durgtion: 1000 | ms
Hi Frequency: |0 Hz Hi/Off Duration: |0 ms
Tore Level: -10 dB

Figure 31.3: Alert Setup Page - Ul Element Setup

Tone Type group box
The Tone Type group box identifies the type of tone to play. When a selection is made, the
fields necessary to enter the setup information for the tone type are enabled on the page.

Tone radio button
The Tone radio button indicates a single steady tone is used as an alert tone.

To add a tone alert button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Alert.
The Alert Setup tab appears.
5. Click the Alert Setup tab.
The Alert Setup page appears.
In the Tone Type group box, select the Tone radio button.
In the Low Frequency field, enter the frequency (in Hz).
In the Tone Level field, enter the tone level (in dB).
. Click OK.
The button changes color and Alert appears on the button.

© N

Pulsed Tone radio button
The Pulsed Tone radio button indicates a pulsed tone is used as an alert tone.

To add a Pulsed Tone alert button, do the following:
1. From the Insert menu, select Add Ul Button.

A None button appears on the console window.
2. Right-click the None button.

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The Ul Element Setup window appears.
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4. From the Ul Element drop down menu, select Alert.
The Alert Setup tab appears.
5. Click the Alert Setup tab.
The Alert Setup page appears.
6. From the Tone Type group box, select the Pulsed Tone radio button.
7. Inthe Low Frequency field, enter the frequency (in Hz).
8. Inthe Low/On Duration field enter the duration (in ms).
9. In the Hi/Off Duration field, enter the duration in ms.
10. From the Tone Level field, enter the tone level (in dB).
11. Click OK.
The button changes color and Alert appears on the button.

Hi-Lo radio button
The Hi-Lo radio button indicates a Hi-Lo warble is used as an alert tone.

To add a Hi-Lo alert button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Alert.
The Alert Setup tab appears.
5. Click the Alert Setup tab.
The Alert Setup page appears.
6. From the Tone Type group box, select the Hi-Lo radio button.
7. Inthe Low Frequency field, enter the frequency (in Hz).
8. Inthe Low/On Duration field, enter a duration (in ms).
9. In the Hi Frequency field, enter a frequency (in Hz).
10. In the Hi/Off Duration field, enter the duration (in ms).
11. From the Tone Level field, enter the tone level (in dB).
12. Click OK.
The button changes color and Alert appears on the button.

Low Frequency field
The Low Frequency field identifies the frequency of the low tones sent when the button is
pressed.

The range for this field is 0 to 3000Hz.

Low/On Duration field
The Low/On Duration field identifies the duration at which the frequency is played.

The range for this field is 0 to 2000ms.
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31.10

Hi Frequency field
The Hi Frequency field identifies the frequency of the high tones sent when the button is
pressed.

The range for this field is 0 to 3000Hz.

Hi/Off Duration field
The Hi/Off Duration field identifies the duration at which the frequency is stopped.

The range for this field is 0 to 2000ms.

Tone Level field
The Tone Level field identifies the relative change allowable in the level of the tone generated.

The range for this field is -30 to 0dB.

Annunciation

The Annunciation function allows the console operator to send a pre-recorded .wav file to
radio users. When clicked the .wav file waits for all console TX and RX traffic to clear before
sending the recording. If multiple annunciation buttons are clicked, the .wav files are sent in
the order they were clicked.

Annunciation Setup page
When the Annunciation function is selected from the Ul Element drop down menu the
Annunciation Setup page appears.
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Ul Element Setup x

Type Colors Annuncigtion Setup

Annunciation Setup Relay Setup
File Path: | Browse... [ ] Activate Relay With Annunciation
Relay Destination
: -10
Level: |10 B ADHB4  (® NEO
[] 5end on Selected Lines ADHE-4 Settings
Mone Relay1 Relay?

Frequency: | O:Use Default

[] Stay Selected After Annunciation NEO Settings
P 0.0.0.0 Relay:  Mone

Active Duration: 3000 | ms

Figure 31.4: Annunciation Setup Page - Ul Element Setup
Annunciation Setup group box

File Path field
The File Path field is used to specify the path for the .wav file recording. When preparing
the .wav file, ensure the file is saved with a 16-bit, 8.000kHz sample rate.

Notice!
We recommend using Audacity, an open source software application (http://
audacity.sourceforge.net/), to make changes to your .wav files.

Browse button
The Browse button is used to browse for and select the .wav file to be used.

Level field
The Level field indicates the relative level change, in dB, for the .wauv file.

The range for this field is -30dB to 10dB.

Send on Selected Lines check box
The Send on Selected check box indicates the console operator can select which line(s)
the .wav file can be sent on.

If unselected, the .wav file is sent only on the line associated to the Ul Element button
currently being configured. Otherwise, the .wav file is sent to all selected lines.
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Frequency drop down menu
The Frequency drop down menu is used to select the frequency for the Annunciation. This
field contains all the frequencies defined for “Frequency Parameters window, page 67 .

Stay Selected After Annunciation check box
The Stay Selected After Annunciation check box indicates the line used for the annunciation
is selected after the annunciation ends and unselect all other lines.

Notice!
This setting does not change the Select state of the line when the line is in a crosspatch.

Relay Setup group box

Active Relay With Annunciation check box
The Active Relay With Annunciation check box indicates a configured relay activates when an
annunciation is sent.

Relay Destination group box
The Relay Destination radio buttons identify the relay to be controlled. When a selection is
made, the fields necessary to enter the setup information for the relay are enabled.

ADHB-4 Settings group box

The ADHB-4 Settings radio buttons identify which ADHB-4 relay is activated when the
Annunciation is sent.

None radio button
The None radio button indicates none of the ADHB-4 relays is activated.

Relay 1 radio button
The Relay1 radio button indicates the first relay in the ADHB-4 is being controlled.

Relay 2 radio button
The Relay 2 radio button indicates the second relay in the ADHB-4 is being controlled.

NEO Settings group box
The NEO Settings field identifies the IP Address and the relay, if any, for the NEO-10.

IP field
The IP field identifies the IP Address of the NEO-10.

Relay drop down menu
The Relay drop down menu is used to select the desired relay.

Available selections for this field are None, Port 1, Port 2, Port 3, Port 4, Port 5, Port 6, Port 7,
Port 8, Port 9 and Port 10.

Active Duration field
The Active Duration field is used to enter the length of time, in ms, the relay remains active
from the start of the Annunciation.
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The range for this field is 300-3000ms.

31.11 Auto-Dial

The Auto-Dial function allows the console operator to quickly dial a pre-defined number.

Auto-Dial String Entry page
When the Auto-Dial String Entry function is selected from the Ul Element drop down menu
the Auto-Dial String Entry page appears. Refer to the Figure below.

Type |Cu|nrs Auto-Dial String Entry

Enter Dial String: |

Tone Standard
@ DTMF
) Knoe

Figure 31.5: Auto-Dial String Entry Page - Ul Element Setup

To add an Auto-Dial button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Auto-Dial.
The Auto-Dial String Entry tab appears.
5. Click the Auto-Dial String Entry tab.
The Auto-Dial String Entry page appears.
6. In the Enter Dial String field, enter the Auto-Dial number for the button.
NOTE: Commas entered in this field add a 2 second delay.
7. Click OK.
The color of the button changes and Dial appears on the button.

Enter Dial String field
The Enter Dial String field indicates the number to dial when the button is clicked in C-Soft
Runtime.

This field can contain up to 16 characters.
Tone Standard group box

DTMF radio button
The DTMF radio button indicates DTMF tones are transmitted to place the call.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



232 en | Ul Element Functions configuration C-Soft 7.700

31.12

Knox radio button
The Knox radio button indicates Knox tones are transmitted to place the call.

Backup Line

The Backup Line function forces the line to route packets to and from either the primary or
secondary radio interface. If the ping routine fails to receive a reply from the Base Radio IP, it
automatically switches to the Backup IP settings specified in the Per Line Parameters window.

In C-Soft Runtime, the button changes to show the current condition. If there is a failure on
both the primary and secondary radio interfaces, LINK FAIL is displayed on the Select button.

Notice!
When the Backup Line function is selected, a line must be selected from the Line to Associate
Function With drop down menu.

Backup Control Line Setup page
When the Backup Line function is selected from the Ul Element drop down menu, the Backup
Control Line Setup page appears. Refer to the Figure below.

[[ifllow User to Switch Primany/Backup:

Figure 31.6: Backup Control Line Setup Page - Ul Element Setup

Allow User to Switch Primary/Backup check box

The Allow User to Switch Primary/Backup check box indicates the console operator is
allowed to manually switch between the primary and secondary radios. Otherwise, the button
functions as an indicator only, and the console operator cannot control the radio in use.

Notice!
The C-Soft program needs to be restarted to reset from the backup radio to the primary
radio.

To add a Backup Line button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
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4. From the Ul Element drop down menu, select Backup Line.
The Backup Control Line Setup tab appears.
5. From the Line to Associate Function With drop down menu, select the line to setup the
backup control.
6. Click the Backup Control Line Setup tab.
The Backup Control Line Setup page appears.
7. Select the Allow User To Switch Primary/Backup check box, if desired.
8. Click OK.
The button changes color and Primary appears on the button.
31.13 Call List Window
The Call List Window function creates a button used to view a list of User IDs.
In C-Soft Runtime, if the console operator clicks the Call List button, the Call List window for
the selected line, shown in the Figure below, appears. From this window, the user can make
outgoing calls and send status messages based upon programming setup. The Call List
displays generic, iDEN, and phone type users and groups.
To add a call list button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Call List.
5. Click OK.
The color of the button changes and Call List appears on the button.
31.13.1 Call List window

The Call List window, shown in the Figure below, is used to view and select from a list of IDs.
Default messages are configured by the console administrator and assigned to the buttons on
the bottom of the window.
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Call List: No Line Selected

ID Type [lias >,
User ID IFrank L'
| Alias | User ID |
T R
Med 385
Cal 94
Bob 93
Sid 92
Matt AN
Nick 30
Filters INo Filters LI

Status | Mo Status Set Status I

Figure 31.7: Call List Window - C-Soft Runtime

ID Type drop down menu

The ID Type drop down menu is used to select a sort type for the list.

Available selections for this field are:

—  Alias - Select Alias from the menu to sort the User IDs by alias in ascending alphabetical

order.

— ID - Select ID from the menu to sort the User IDs by ID number in ascending numerical
order. The selected ID type determines the User ID drop down menu entries.

User ID drop down menu

The User ID drop down menu is used to select a user ID for placing a call. Either the alias or
the ID number appears in the menu depending on the ID Type drop down menu selection.
Alternatively, the status can be selected from the list at the bottom of the window.

Filters drop down menu

The Filters drop down menu is used to select a filter from the list. When selected, the list

populates with users assigned to the filter by the console administrator.

Available selections for this field are:
—  No Filter - Displays a complete list of user IDs.

—  User-defined System Filter - Displays only user IDs belonging to the filter.
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Status field
The Status field indicates the currently selected status. If no status is selected, No Status
appears in the field.

Set Status button
The Set Status button is used to select a status to send. When clicked, the Status List window
appears. Refer to the Figure below.

To view the Call List, do the following:

1. Click Call List.

2. From the Filter drop down menu, select a filter to sort the list.
OR
Select No Filter.

To select a user ID to place a call to, do the following:
1. Select the line you want to place the call from.
2. Click call List.
The Call List window appears.
3. From the Filter drop down menu, select a filter to sort the list.
OR
Select No Filter.
4. From the User ID drop down menu, select an alias or user ID.
The selected user ID in the call list is highlighted.
5. Click Done.
If a password is required to send the status ID, the Password Entry window appears.
6. Using the monitor keypad or your keyboard, enter the password.
For each character you enter, asterisks fill the empty field at the top of the window.
OR
If the password is unknown, click Cancel.
The Password Window closes.
7. Click Done.
The Password Entry and Status List windows close and the selected status’s alias appears in
the Status Message field or, if the password is incorrectly entered, an error message appears.

To send a status ID from the Call List window in C-Soft Runtime, do the following:
1. While in C-Soft Runtime, select the line you want to place the call from.
2. Select a Call List button.
The Call List window appears.
3. From the ID Type drop down menu, select an alias or an ID number.
The selected User ID in the User List is highlighted.
4. Select Set Status.
The Status List window appears.
5. From the ID type drop down menu, sort the list by alias or status ID number.
The list is sorted depending on the selected type.
6. From the Status drop down menu, select a status ID to send.
The selected status ID is highlighted.
OR
From the status ID list, select a status ID to send.
The selected status ID is highlighted.
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10.

11.

Click Done.

If a password is required to send the status ID, the Password Entry window appears.
Using the monitor keypad or your keyboard, enter the password.

For each character you enter, asterisks fill the empty field at the top of the window.
Click Enter.

The Password Entry window closes and the selected status’s alias appears in the Status
Message field. If the password is incorrectly entered, an error message appears.

OR

Click Cancel.

Click a Call button to place the call.

The message is sent and a confirmation or error message appears in the dispatching
status bar.

Click Done to close the window.

Call (1-10) buttons

The Call (1-10) buttons are used to place user-defined calls configured in the 5-6 Tone/DTMF
ANI system type, page 75. The labels configured on the 5/6 Tone/DTMF ANI Setup page appear
on these buttons in the Call List window.

Notice!
The Call1-Call10 buttons may have different labels assigned by the console administrator.

31.13.2

To place a call from the Call List window, do the following:

1.

2.

Select an ID from the list.
Available call buttons on the bottom of the window become active.
Select a call button.

The call is placed.

Done button
The Done button is used to close the Call List window.

Status List window

The Status List window, shown in the Figure below, is used to select from a list of
preprogrammed status IDs. When a status ID is selected and the window is closed, the
selected status appears in the Status field located on the Status List window.
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1D Type |Aﬁas j

Status |Emergencv ;I

Emergency

S Out of Service
Revive |Revive
Stun  [Stun
Inhibit TX 30
Out of Service 11
Cancel Done

Figure 31.8: Status List Window

ID Type drop down menu
The ID Type drop down menu is used to select a sort type for the list.

Available selections for this field are:

—  Alias - Selecting Alias from the menu, sorts the status IDs by alias in alphabetical order.

—  Status ID - Selecting ID from the menu, sorts the status IDs by ID number in ascending
numerical order.

Status drop down menu

The Status drop down menu is used to select the status to send. Either the alias or the ID
number appear in the list and is determined by the selection in the ID Type drop down menu.
Alternatively, the status can be selected from the list at the bottom of the window.

Refer to Call 1-10 Buttons on the “Call List window, page 233” or to “Per Line Call History
Setup Page” on “Per Line Call History, page 335” to continue with sending a message to the
selected ID.
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31.14

Password Entry
Enter Pazsword: I

1 2 3
4 5 B
7 g 3
0
Cancel | Enter

Cancel button
The Cancel button discards any changes made and closes the window.

Enter button
The Enter button is used to close the Status List window.

Refer to
- Call List window, page 233

Call Priority button

The Call Priority button is used to set the transmit call priority for calls on AIS lines sent from
the consoles.

There are five levels of priority:

- Off (0)

-  Low (1)

- Normal (2)

- High (3)

- Emergency - generates an emergency response on the radios

By default, all calls are set to a priority of Off (0).
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31.15 Call Queue window

The Call Queue window contains a list of calls that require a response from the dispatcher.
The status of individual calls is updated across all consoles as dispatchers answer and
complete calls.

Signalling/ Call Alert Group Call Private Call Select Call Group Status
Call Type

5/6 Tone, N/A Yes N/A Yes N/A
DTMF

Fleet Sync N/A Yes Yes Yes N/A
Telex-Serial®> |Yes? Yes? Yes? Yes? N/A
MDC-1200 Yes Yes Yes N/A N/A
MOTOTRBO |Yes Yes Yes N/A N/A
NEXEDGE Yes Yes Yes Yes Yes
Direct IP

AlS Yes Yes Yes N/A N/A
Telex- Yes Yes Yes Yes N/A
Enhanced ANI

a.

support varies based on attached mobile

The Call Queue Window Setup page is used to configure the Call Queue Window.

Ul Element Setup Pt

Type Colors  Call Queue Window Setup | Call Queus Columns  Group Statuses

Event Selection Event Priorty

Call Alert Sort entries by:

[ Group Call (®) Time event received:

Private and Selective Call i) Event Status D - Ascending
Group Statuses () Event Status ID - Descending
Behavior Window Appearance

[] Automatically populate keypad on answer Maximum Mumber of Visible Entries: @

[] Play audible alert for waiting entries

Set Font
[]Remove completed entries from window Sample Text

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



240 en | Ul Element Functions configuration C-Soft 7.700

31.15.1

31.15.1.1

31.15.1.2

31.15.1.3

Call Queue Setup page

Event Selection group box

The Event Selection group box allows users to select call types to be added to the call queue
window. When the C-Soft console receives one of the selected radio call events, an entry is
created in the call queue window.

Call Alert check box
The Call Alert check box indicates call alerts can be added to the call queue window.

Group Call check box
The Group Call check box indicates group calls can be added to the call queue window.

Private and Selective Call check box
The Private Call check box indicates private and selective calls can be added to the call queue
window.

Group Statuses check box
The Group Statuses check box indicates group statuses can be added to the call queue
window.

Behavior group box

Automatically Populate Keypad on Answer check box

The Automatically Populate Keypad on Answer check box indicates the user ID information
for a call entry is automatically added to the User Entry field in the Keypad control when the
call is answered. A call is answered when the Answer button is clicked.

Play Audible Alert for Waiting Entries

The Play Audible Alert for Waiting Entries check box indicates an audible alert is played on
Speaker 1 when receiving a new call queue event. The audible alert serves as a notification,
and is played each time a call event is added to the Call Queue Window.

Remove Completed Entries from Window

The Remove Completed Entries from Window check box indicates call entries with a call
state of Completed are removed from the Call Queue window. A Call entry is removed from
the window once the Clear button is clicked.

Event Priority group box
The Event Priority group box is used to configure how call queue events are ordered in the
Call Queue Window.

Time Event Received radio button

The Time Event Received radio button indicates the incoming call events are sorted by the
time the event was received, with the most recently received events being displayed at the top
of the window.
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31.15.1.4

31.15.2

Event Status ID - Ascending

The Event Status ID - Ascending radio button indicates incoming call events are sorted by the
value of the event’s Status ID. An event with a lower numbered status ID will be displayed
above an event with a higher status ID (i.e. Status #1 will be shown above Status #2).

Event Status ID - Descending

The Event Status ID - Descending radio button indicates incoming call events are sorted by
the value of the event’s Status ID. An event with a higher numbered status ID will be displayed
above an event with a higher status ID (i.e. Status #2 will be shown above Status #1).

Window Appearance group box

Maximum Number of Visible Entries field

The Maximum Number of Visible Entries field is used to enter and identify the number of call
entries saved in the call queue window. Once the maximum number has been reached the last
call entry is removed from the end of the list.

The range for this field is 1 to 50.

Set Font button

The Set Font button, when selected, opens the Font window. The Font window is used to
select a font type and font size to use for the call queue window. When the format is changed,
a preview of the text appears in the Sample field.

Font
Font: Font style:
Arial Regular
-

e | |Marrow Bold 12
Arial MONOSPAcer || |Narrow Bold It | |14 |:|
Baskerville Old Face Bold Al s | E

Bold Itali 3 18
Bavhaus 95 e =
Bell MT -~ | |Black Obligue = | |22 =

Sample

AaBbYyZz

Figure 31.9: Font Window

Call Queue Columns page
The Call Queue Window Setup page is used to configure which columns are visible in the Call
Queue Window.
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Ul Element Setup >

Type Colors  Call Queus Window Setup  Call Queue Columns  Group Statuses

Column Setup
Select the columns to be displayed:

Call State

[ Frequency
[] status
Line Mame
Time

User ID

Column Setup group box
The Column Setup group box allows users to determine which columns are visible in the Call
Queue window. The respective column will be displayed in the Call Queue window if checked
and hidden if unchecked.

Call State check box
The Call State check box is used to add a call state column to the Call Queue window.

The possible call states are:
- Waiting

- Processing

- Complete

Console ID check box
The Console ID check box is used to add a console ID column to the Call Queue window.

Date check box
The Date check box is used to add a date column to the Call Queue window.

Frequency check box
The Frequency check box is used to add a frequency column to the Call Queue window.

Line Name check box
The Line Name check box is used to add a line name column to the Call Queue window.
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Status check box
The Status check box is used to add a status column to the Call Queue window.

Time check box
The Time check box is used to add a time column to the Call Queue window.

User ID check box
The User ID check box is used to add a user ID column to the Call Queue window.

31.15.3 Group Statuses page
The Group Statuses page is used to configure which statuses trigger an entry in the Call
Queue Window. The Group Statuses page is visible when the Group Statuses check box is
checked in the Event Selection group box in the Call Queue Window Setup page.

Notice!

A maximum of 20 statuses can be configured for the Call Queue Window.

Ul Elernent Setup >

Type Colors  Call Queue Window Setup  Call Queue Columns  Group Statuses

Available: Enabled:
Backup needed Call Requast
Loud and clear Priorty PTT
Fire
Status 207

3

S

Available field

The Available field displays all statuses in the system. This list is used to select a status to add
to the Enabled field.
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31.154

Enabled field
The Enabled field displays statuses which will trigger an entry in the Call Queue Window.

Move Right button
The Arrow Right button is used to move statuses from the Available field to the Enabled field.

Move Left button
The Arrow Left button is used to move statuses from the Enabled field to the Available field.

Call Queue window

The Call Queue window is used to view calls added to the call queue. In C-Soft Runtime, click
the Call Queue Window button to open the Call Queue window. This window contains a Call
Queue list. You can resize and move this window, as needed.

Call Queue
Date Time Channel Console ID User D Call State
Answer Clear Done

Figure 31.10: Call Queue Window

Answer button
The Answer button is used to change the call entry status from Waiting to Processing.

Clear button
The Clear button is used to change the call entry status from Processing to Complete.

Done button
The Done button is used to close the Call Queue window.

To use the Call Queue Window in C-Soft Runtime, do the following:

2021-06 | 14 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC



C-Soft 7.700

Ul Element Functions configuration | en 245

1. Select the call entry in the list.
Call Queue
Date Time Channel Console 1D User D Call State
Answer Clear Done
2. Click the Answer button.
Note:

Incoming calls are added to the Call Queue window. Call entries have a status of Waiting
until answered by a dispatcher.

Selecting the call entry causes the background color of the call entry to change to the
selected color configured in Microsoft Windows.

After the call has been answered, the call status updates to Processing. After a call has
been answered, any dispatcher on a parallel console position can clear the call entry.
Dispatchers on parallel console positions can determine the dispatcher who answers and
clears a particular call by viewing the Console ID field for the call entry.

To clear a call, do the following:

Bosch Security Systems, LLC
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1. Select the call entry in the list.
Call Queue

Date Channel Console ID User ID Call State

Answer Clear Done

2. Click the Clear button.
NOTE: Selecting the call entry causes the background color of the call entry to change to
the selected color configured in Microsoft Windows.

Call Queue

Date Channel Console ID User ID Call State

Answer Clear Done

The call event is complete. If the Remove Completed Entries from Window check box is
unchecked, the call entry remains on the screen until the maximum number of viewable
entries (configured in C-Soft Designer) is reached.

31.16 Crosspatch

The Crosspatch function allows the console operator to connect two or more radios/phone
lines, enabling different lines to talk to other lines configured as full-duplex become simplex in
operation when placed into a crosspatch.
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Notice!
Only the console creating the crosspatch is able to clear the crosspatch. All other consoles
display X-PATCH on lines in a patch group.

Patch Group page
When the Crosspatch function is selected from the Ul Element drop down menu, the Patch
Group page appears. Refer to the Figure below.

Select Patch Group:

Figure 31.11: Patch Group Page - Ul Element Setup

To add a Crosspatch button, do the following:

1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4. From the Ul Element drop down menu, select Crosspatch.
The Patch Group tab appears.

5. Click the Patch Group tab.
The Patch Group page appears.

6. From the Select Patch Group drop down menu, select the number of the crosspatch
group (1-30).

7. Click OK.

The color of the button changes and Patch appears on the button.

31.17 Crosspatch Block

The Crosspatch Block function allows a particular crosspatch line to be blocked from
transmitting.

EXAMPLE: If the line is stuck in receive mode due to noise, that line can be blocked, releasing
its control of the crosspatch. After the line completes a transmit cycle, then it is eligible to
transmit/receive as part of the patch.

Patch Group page
When the Crosspatch function is selected from the Ul Element drop down menu, the Patch
Group page appears. Refer to the Figure below.
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31.18

31.19

To add a Patch Block button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Crosspatch Block.
The Patch Group tab appears.
5. Click the Patch Group tab.
The Patch Group page appears.
6. From the Select Patch Group drop down menu, select the crosspatch group number.
7. Click OK.
The color of the button changes and a Patch Block button appears in the console window.

Crosspatch Clear

The Crosspatch Clear function allows the console operator to drop the patch for the
crosspatch group.

Patch Group page
When the Crosspatch function is selected from the Ul Element drop down menu, the Patch
Group page appears. Refer to the Figure below.

To add a Patch Clear button, do the following:

1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4. From the Ul Element drop down menu, select Crosspatch Clear.
The Patch Group tab appears.

5. Click the Patch Group tab.
The Patch Group page appears.

6. From the Select Patch Group drop down menu, select the number of the crosspatch
group.

7. Click OK.

The color of the button changes and Patch Clear appears on the button.

Crosspatch Programmed

The Crosspatch Programmed function allows the console operator to create a crosspatch on
a pre-defined group of lines.
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Notice!
Telex recommends you assign a unique color to this button because it is applied to all lines in

the crosspatch.

Line Group page
When the Crosspatch Programmed function is selected from the Ul Element drop down menu,

the Line Group page appears. Refer to the Figure below.

Lne Group

Select Lines for Group:

1:5IP Diamandhead - Options
2:5idney Police T
J:Newport Police — [] Autostart Crosspatch
4iDen Line

5:16kb Vocoder

6:Supervisor Line

7-Mot Enabled-

8:-Mot Enabled-

G:-Mot Enabled-

10:-Mot Enabled-

11:-Mot Enabled- -

Group Patch Mumber

Figure 31.12: Line Group Page - Ul Element Setup

Select Lines for Group field
The Select Lines for Group field contains a list of all the lines configured on “Per Line
Parameters window, page 61”. Selecting a line from this list assigns the line to the group.

Group Patch Number drop down menu
The Group Patch Number drop down menu is used to assign a unique crosspatch group

number to the selected line.

Autostart Crosspatch check box
The Autostart Crosspatch check box indicates the crosspatch is automatically created when

the C-Soft program is started.

To add a Crosspatch Programmed button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
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9.

From the Ul Element drop down menu, select Crosspatch Programmed.

The Line Group tab appears.

Click the Line Group tab.

The Line Group page appears.

On the Line Group page, select the line(s) from the Select Lines for Group field.

From the Group Patch Number drop down menu, select the group patch number.

From the Options field, select the Autostart Crosspatch check box to automatically start
the crosspatch, if desired.

Click OK.

The color of the button changes and Preset Patch appears on the button.

Notice!
Autostart Crosspatch does not work for Phone or SIP lines.

Refer to

Per Line Parameters window, page 61

31.20 Crosspatch PTT

The Crosspatch PTT function allows the console operator to transmit audio to all lines
included in the crosspatch.

Patch Group page
When the Crosspatch PTT function is selected from the Ul Element drop down menu, the
Patch Group page appears. Refer to the Figure on “Crosspatch, page 246”.

To add a Crosspatch PTT button, do the following:

1.

7.

From the Insert menu, select Add Ul Button.

A None button appears on the console window.

Right-click the None button.

A shortcut menu appears.

From the shortcut menu, select Properties.

The Ul Element Setup window appears.

From the Ul Element drop down menu, select Crosspatch PTT.
The Patch Group tab appears.

Click the Patch Group tab.

The Patch Group page appears.

From the Select Patch Group drop down menu, select the number of the crosspatch
group.

Click OK.

The color of the button changes and Crosspatch PTT appears on the button.

Refer to

Crosspatch, page 246
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31.21

31.22

Dial

The Dial function dials the user selected in the keypad. For more information on the Keypad
Module, refer to “Dial” on page 234.

To add a Dial button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Dial.
5. Click OK.
The color of the button changes and Dial appears on the button.

DTMF Digit

The DTMF Digit function adds one digit of a DTMF keypad. Multiple buttons can be added to
the console to form a DTMF keypad. All 16 digits are supported.

DTMF Digit page
When the DTMF Digit function is selected from the Ul Element drop down menu, the DTMF
Digit page appears. Refer to the Figure below.

DTMF Digt

DTMF Digt:

Figure 31.13: DTMF Digit Page - Ul Element Setup

DTMF Digit drop down menu
The DTMF Digit drop down menu provides a list of numbers and letters for the DTMF keypad.

This range for this field is 0-9 or A-D, # and *.

Note:

—  Each digit must be assigned to its own button.

-  When creating a telephone keypad, the corresponding letters for the keypad are
automatically inserted.

In C-Soft Runtime, if a DTMF digit button is clicked, the digit is sent to all selected lines during
a PTT operation, or it generates its own PTT if clicked outside of a PTT operation.
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To assign a digit to a button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select DTMF Digit.
The DTMF Digit tab appears.
5. Click the DTMF Digit tab.
The DTMF Digit page appears.
6. From the DTMF Digit drop down menu, select the digit you want to appear on the button.
7. Click OK.
The color of the button changes and the selected number (or letter) appears on the button.

C:\Program Files\Telex Communications\Tele)

File Edt Insert View Help
F H & & LA =

Ready

31.23 Emergency ACK

The Emergency ACK function creates a button to indicate the emergency is acknowledged
and stops the Select buttons blinking.

Notice!
When the Emergency ACK function is selected, a line must be selected from the Line to
Associate Function With drop down menu.

In C-Soft Runtime, if an emergency signal is received, the C-Soft program sends an emergency
Hi-Lo tone to the selected speaker to notify the console operator. In addition, the Select
button for the line that received the emergency call blinks.

To add an Emergency ACK button, do the following:
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1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4.  From the Ul Element drop down menu, select the Emergency ACK button.
5.  From the Line to Associate Function With drop down menu, select the desired line to
associate with this function.
6. Click OK.
The color of the button changes and Emergency ACK appears on the button.

31.24 Emergency Clear

The Emergency Clear function stops the Hi-Lo tone from playing on the selected speaker.

To add an Emergency Clear button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4.  From the Ul Element drop down menu, select Emergency Clear.
5. Click OK.
The color of the button changes and Emergency Clear appears on the button.

31.25 Emergency History Window

The Emergency History Window function creates a button to access the emergency call
history list.

In C-Soft Runtime, if the Emergency History window button is clicked, the Emergency History
window appears. From this window, you can view all emergencies, cleared emergencies, and
acknowledged emergencies.

To add an Emergency History Window button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4.  From the Ul Element drop down menu, select Emergency History Window.
5. Click OK.
The color of the button changes and Emergency History appears on the button.
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31.26 Encryption
The Encryption function allows the console operator to selectively turn on and off encryption
message sent to an IP-223 or IP-224.
Notice!
When the Encryption function is selected, a line must be selected from the Line to Associate
Function With drop down menu.
Encryption Setup page
When the Encryption function is selected, the Encryption Setup page appears, shown in the
Figure below.
Figure 31.14: Encryption Setup Page - Ul Element Setup
Default Secure check box
The Default Secure check box indicates encryption is enabled when C-Soft boots up.
To configure encryption on a line, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Encryption.
1. From the Line to Associate Function With drop down menu, select the desired line to
associate with this function.
2. Click OK.
The color of the button changes and Clear appears on the button.
31.27 Event Logger

The Event Logger function opens a window that displays all the messages written to the Event
Log file viewable by the dispatcher.

Note:
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— The Event Logger window only displays log messages if logging is enabled.
— To set the log level and which level of logging messages to record, see “Logging Setup
Group Box”.

To add an Event Logger button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Event Logger.
5. Click OK.
A button with Event Logger on it appears.

31.28 FleetSync

The FleetSync function creates a button to open the FleetSync Dispatching window, shown in
the Figure in “FleetSync Dispatching window, page 256”.

In C-Soft Runtime, when the window is open the user can view the system list, call history and
status history, send status IDs, voice messages and data messages, select groups and
individuals to place calls.

FleetSync Setup page
When the FleetSync function is selected from the Ul element drop down menu, the FleetSync
Setup page appears, shown in the Figure below.

Console Requests

I Timeout: & S8

Figure 31.15: FleetSync Setup Page - Ul Element Setup
Console Requests group box

Timeout field
The Timeout field is used to configure the amount of time, in seconds, the console waits after
sending a status request command before indicating a response was never received.

The range for this field is 1 to 10 seconds.
To add a FleetSync button, do the following:

1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
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2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select FleetSync.
5. Click OK.
A button with FleetSync on it appears.

Refer to
—  FleetSync Dispatching window, page 256

31.28.1 FleetSync Dispatching window
The FleetSync Dispatching window is used by the console operator in C-Soft Runtime to
place calls, view call history, and send status and text messages. Console action feedback is
provided in the Dispatching Status bar.

FleetSync Dispatching

System Drop Down Menu —»Poe =] Setadhons |ty |
- BX] 5 T
System List Field =% = ogauc m E:'T'm m,'f.m e
]
D
L]
D
& Car 105
& Ca107
& Ca 108
o & Car 03
Filter icon ———* Sausxe |
G Calls |
& Car107 |
: @Ca108 |
Allow icon ————"& ca 109 Al Sat |
= @ Squsdh
. O Fleatld  [107 Userld [0 Add 1o Selected
@ Hewport Pobice
= € Dispatchers
Deny icon 3 Status Message Select Type
[ Ho Status St Slatus  Status Message
" Test Message
Enter Test Message: ™ Select Cal
" Request Status
Data messaging Send
Group Box /’i
| Done
Dispatching Status Bar —p

Figure 31.16: FleetSync Dispatching Window

System Type drop down menu
The System Type drop down menu is used to change from the currently selected system to
another system in the console position.

The default systems included in the drop down menu depend on the currently selected line’s
configuration.

Up to 200 systems can be created.

2021-06 | 14 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC



C-Soft 7.700

Ul Element Functions configuration | en 257

System List field

The System List field populates with components that belong to the system currently selected
from the System drop down menu. Filters components are listed next in the hierarchy. When a
filter component is expanded, individual unit and fleet components are visible.

Systems can be configured, by the console admin, to display filters only. In that case, only
components affiliated with a filter, shown in the Figure below, appear in the filter list.
Otherwise, all components, including components with deny icons (permission to place calls

is denied), shown

FleetSync Dispatching

Only Display Fliters
option selected

A

Filters

in the Figure above, appear in the list.

FleetSyne Dispatching

Only Display Filters
= Selacted _ = Lel
folon option unselected fole
B Foboe — [
= € SquadC |
& Ca 100
& Ca 10
& Cae 102
& Cx 103
& Ca 104
S Cx105
& Ca07
G0
&Cx108
- @ SquadB
@ Cx105 @ Newpoit Dispatch
& Ca 107 . Sidney Police
@ Cxl08 Filters & Cx 100 |
@ Ca108 Marws GLxl M
OSwa_dA E Gk & Cs 02 Z
+ 5 Sidney chce @ Ca03
@ Newport Polce g[u 104
& Dizpatchers — Sidrey Dispaich
/ & Sidney Dispalch Status Me Mot Pobot Eiat,
@ Newport Dispaich & Ca 105 -
" & Ca 107
e 08
Entes Tex & Ca 109 Ent
@ Newport Dispatch
& Hizu's Corole
Groups,
Individual
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Figure 31.17: System Displays Only Filters Example

Icon Type

Description

° Filter

The Filter icon indicates the component is a filter. Filters are used to
group, sort, and label the components contained in the filter, refer to
the Figure above.

To view or hide filters, do one of the following:
—  Click the expand button to view components. e
—  Click the collapse button to hide components. ™

o Allow

The Allow icon indicates the component is available for selection.

The console operator can place calls and send status and text messages
to these components, refer to the Figure above.

e Deny

The Deny icon indicates the component does not allow broadcast calls,
when a system is tagged, or, does not allow interfleet calls when Fleets
or Units are tagged, refer to the Figure above.
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System List flyout menu
The System List flyout menu, shown in the Figure below, is a quick method of accessing the
Select Type commands also available in the Data Messaging Group Box.

Available selections for this field are Status, Text Messages, Select Calls and Request Status.

FleetSync Dispatching

IPulice ﬂ Selected Iterr
+ & SquadC SFj
+ & Squad B o
- &P Squad A

€3 Sidney -

DR
- &€ Dispatchers Status

S ke Dig Text Message
=@ ) ; Select Call

) Status Request

>

L

o

Figure 31.18: System List Flyout Menu

To access the System List flyout menu, do the following:
1. Inthe System List, right-click the unit or group to send the call or message to.
The System List flyout menu appears.
OR
In the System List, right-click the system to send the call or message to.
The System List flyout menu appears.
2. Click Status.
OR
Click Text Message.
OR
Click Select Call.
OR
Click Status Request.

Reference
—  For more information, refer to “Status Message Radio Button” on “Select Type Group

”

Box”.

—  For more information, refer to “Text Message Radio Button” on “Select Type Group Box”.
—  For more information, refer to “Select Call Radio Button” on “Select Type Group Box”.
—  For more information, refer to “Request Status Radio Button” on “Select Type Group

”

Box”.
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Selected Items page
The Selected Items page is used to view the currently selected component’s ID information.
The selected item list is used to determine where the call or status message is sent.

Selection of only one component per system is allowed. Grayed out items with deny icon tags
are not available for selection.

For more information, refer to “Manual Select Group Box”.

To add a component’s ID to the Selected Items page, do the following:
1. Inthe System list field, select the component.
The component is highlighted.
2. Click Add to Selected.
The item appears in the list.

To remove an ID from the Selected Items page, do the following:
1. Right-click the unwanted component.

2. Click Remove Item.

The item disappears from the list.

Manual Select group box
The Manual Select group box is used to manually enter Fleet and User ID numbers for placing
calls, sending status messages and text messages.

Fleet ID field

The Fleet ID field is used to enter the Fleet ID portion of the ID number for placing and

sending interfleet calls and messages. The Fleet ID field is populated, by default, with the

Fleet ID when the system is selected and broadcast calls are allowed on the line.

— If interfleet calls are not allowed on the selected line, the Fleet ID field is not editable for
any component. It is possible, however, to place an individual intrafleet call manually. The
selected line’s Fleet ID-grayed out-is added on to the unit ID number you enter manually.

— If aFleet ID and User ID are both 0, then the console displays the following message:
Cannot add a system! Allow Broadcast Call option is disabled, appears.

User ID field
The User ID field is used to manually enter the unit ID portion of the ID number. It is used to
place a call or send a message when the ID is not available for selection from the system list.

The User ID field is also used to place broadcast calls using zeros, indicating it is a broadcast
call, and is sent to all members of the fleet.

History page

The History page is used to view past FleetSync calls and messages received by the console.
Additionally, calls or messages can be sent by selecting the ID in the history log. When
selected, the ID is added to the Selected Items page.

This list is configured by the console administrator. It can contain up to 500 IDs. For more
information, refer to “Per Line Call History Window Lines Field” on “Per Line Call History
Window Lines Field”.
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Note:
—  Calls are not saved to the history list if C-Soft Runtime is closed.
—  The FleetSync Call History list includes calls received from parallel console positions.

FleetSync Dispatching
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Figure 31.19: History Page - FleetSync Dispatching Window

Call History View group box
The Call History View group box is used to control the log display.

All Lines radio button
The All Lines radio button is used to display all calls and messages received by the console.

Selected Line radio button
The Selected Line radio button is used to display all calls and messages received on the
selected line.

Call Details group box
The Call Details group box is used to display additional call information for the currently
selected ID type.

Add to Selected button

The Add to Selected button is used to add the manually entered Fleet and Unit ID to the
selected items page. When the ID number displays in the Selected Items page, the call can be
placed or message sent.

To manually place an individual call inside the current system, do the following:
1. In C-Soft Runtime, select a line.
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3.
4.

Click the FleetSync button.

The FleetSync Dispatching window appears.The Fleet ID field is, by default, populated
with the current system’s fleet ID.

In the User ID field, enter the individual’s unit ID number.

Click Add to Selected.

The system name you are currently working with appears in the Selected Items page.

Notice!

The name on the FleetSync button is configured by your console administrator. FleetSync is
used generically to refer to any button configured for FleetSync functions.

To manually place an interfleet call, do the following:

1.
2.

1.

Select a line with interfleet calls allowed.

Click FleetSync.

The FleetSync Dispatching window appears.

In the Fleet ID field, enter the individual’s fleet ID number.
In the User ID field, enter the individual’s unit ID number.

Click Add to Selected.

The system name you are currently working with appears in the Selected Items page.

To manually place a broadcast call, do the following:

1.
2.

4.
5.

Select a line with broadcast calls allowed.

Click FleetSync.

The FleetSync Dispatching window appears. The Fleet ID field contains the system Fleet
ID number, and is not editable.

In the System List field, select the system name.

The system name is highlighted.

In the Unit ID field, enter 0000.

Click Add to Selected.

The system name you are currently working with appears in the Selected Items page.

Note:

Lines can be configured to allow or deny both broadcast calls or interfleet calls.
Permission to place calls can be determined by the window’s appearance. Refer to the
two Figures below.

Icon Type Description

9 Deny Broadcast calls are not allowed as indicated by the deny icon. When the
system name is selected, the Selected Items page is empty and the
Fleet ID field is grayed out, refer to the Figure below.

o Allow Broadcast calls are allowed as indicated by the allow icon. When the
system name is selected the ID number appears in the Selected Items
page and the Fleet ID field is active, refer to the Figure below.
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FleetSync Dispatching
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Figure 31.20: Broadcast Call Permissions

Icon Type Description
9 Deny Interfleet calls are not allowed as indicated by the deny icon. When the
Fleet name is selected, the Selected Items page is empty and the Fleet
ID field is grayed out, refer to the Figure below.
o Allow Interfleet calls are allowed as indicated by the allow icon. When the
Fleet name is selected, the ID appears in the Selected Items page and
the Fleet ID field is active, see to the Figure below.
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FleetSync Dispatching
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Figure 31.21: Interfleet Call Permission

Status Message field

The Status Message field indicates the currently selected status message. If no status is
selected, No Status appears in the field. The Set Status button is used to change the status
ID.

Set Status button

The Set Status button is used to select a status to send. When the Set Status button is
clicked, the Status List window appears. Refer to the Figure on “Status List window, page
236,

To set the status ID, do the following:
1. Select Set Status.
The Status List window appears.
2. Select a Status ID from the list.
The ID is highlighted.
OR
From the Status drop down menu, select a Status ID.
The ID is highlighted.
3. Click Done.
The selected Status ID appears in the Status Message field.

Select Type group box
The Select Type group box is used to select the type of message or call sent when the Send
button is clicked.
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Status Message radio button
The Status Message radio button indicates the currently selected status message is sent to
the ID number listed in the Selected Item page.

To send the current status message, do the following:

1. Select the Status Message radio button.

2.  Click Send.

The message is sent and a confirmation appears in the status bar.

Notice!
Status ID codes must be between 10 and 99. See manufacturer’s technical data for specific
Status ID codes.

Text Message radio button
The Text Message radio button indicates the current entry in the Enter Text Message text box
is sent to the ID number listed in the Selected Item page.

To send the current text message, do the following:

1. Select the Text Message radio button.

2. Click Send.

The message is sent and a confirmation appears in the status bar.

Text messages can contain up to 48 characters.

Select Call radio button
The Select Call radio button indicates a select call is placed to the current ID in the Selected
Iltems page.

To place a select call to the ID, do the following:

1. Select the Select Call radio button.

2.  Click Send.

The message is sent and a confirmation appears in the status bar.

Request Status radio button
The Request Status radio button is used to send a request for status from the ID currently
listed in the Selected Items page.

To request a status from the ID, do the following:

1. Select the Request Status radio button.

2. Click Send.

The message is sent and a confirmation appears in the status bar.

Send button

The Send button is used to send the currently selected call, status, or message to the ID listed
on the Selected Items page. When selected, a confirmation or error message appears in the
status bar at the bottom of the window.
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Done button
The Done button is used to close the FleetSync Dispatching window.
FleetSync Dispatching window status bar
The FleetSync Dispatching window status bar, shown in Figure on “FleetSync Dispatching
window, page 2567, indicates console activity. Confirmation and error messages appear when
calls, statuses, or messages are sent.

31.29 Frequency Change

The Frequency Change function sends a burst of packets onto the Ethernet network
requesting the remote radio change to the new frequency of the selected line. Additionally, all
other consoles on the network change to display the new frequency of the radio on that
particular line.

Notice!
When the Frequency Change function is selected, a line must be selected from the Line to
Associate Function with drop down menu.

Freq Set page
When the Frequency Change function is selected from the Ul Element drop down menu, the
Freq Set page appears. Refer to the Figure below.

Select PTT Frequency:

‘ 1:Group 100 T'

1:Group 100
Z:Group 200
J:Analog 410
4:Analog 415
5:Group 300
&:Group 400
TAl Call

Figure 31.22: Freq. Set Page - Ul Element Setup

Given that frequencies change, it is common to place frequency selection buttons in a popup
window. The console operator opens the popup window to change frequencies and closes the
window when they are done.
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31.30

However, with the popup window closed, it becomes impossible to see exactly what
frequency is currently selected for the line. By placing the variable $FREQX$, where X
represents the line number, into the Button Up Text and Button Down Text field on the Colors
page, the frequency for that line is automatically updated on the button when it changes.

When Scannable is selected for the line, refer to “Scannable Check Box” on “Line setup
options group box”, right-click the button to display a shortcut menu that provides the
console operator the ability to add or remove this channel from the scan list.

When a frequency is in the scan list, a scan icon appears on the frequency change button.
Parallel consoles are also alerted to update their display if a frequency is added or removed
from the scan list.

Select PTT Frequency drop down menu
The Select PTT Frequency drop down menu is used to select the frequency for the line. This
field contains all the frequencies configured on “Freqs Button”.

To add or change a Frequency button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the Ul button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Frequency Change.
The Freq Set tab appears.
5.  From the Line to Associate Function With drop down menu, select the desired line to
associate with this function.
6. Click the Freq Set tab.
The Freq Set page appears.
7. From the Select PTT Frequency drop down menu, select the desired frequency for the
line selected.
8. Click OK.
The color of the button changes and FregX (X representing the line of the frequency) appears
on the button. Also, the frequency is changed for the line.

Additions and changes can be made to the Per Line Frequency Setup window at any time.
However, if any user interface elements have been placed on the console window, the changes
made to a line must also be changed on the individual elements, if needed.

GPS Read button

The GPS Read button is used to query the current GPS coordinates of the selected radio. This
functionality is currently supported on lines using NEXEDGE or MOTOTRBO signaling only.

To query a radio of its GPS coordinates, do the following:

1. From the GPS Read drop down list, select the unit you want to send this command.
OR
If using the a Keypad, select the unit you want to send the GPS Read Request.
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31.31

31.32

2. Click GPS Read.
The command is sent.

To add a GPS Read button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select GPS Read.
5. Click OK.
The color of the button changes and GPS Read appears on the button.

GPS Trigger Setup page
The GPS Trigger Setup page is used to select the settings for the GPS Trigger.

GPS Trigger Off button

The GPS Trigger Off button is used to stop periodic GPS coordinate updates from the
selected radio. The functionality is currently supported on lines using NEXEDGE or
MOTOTRBO signaling only.

To stop receiving periodic GPS coordinates from a radio, do the following:
1. From the GPS Trigger Time drop down menu, select the unit you want to send the GPS
Trigger Off command.
OR
If using a Keypad, select the unit you wish to send the GPS Trigger Off command.
2. Click GPS Trigger Off.
The command is sent.

To add a GPS Trigger Off button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4.  From the Ul Element drop down menu, select GPS Trigger Off.
5. Click OK.
The color of the button changes and GPS Trigger Off appears on the button.

GPS Trigger On button

The GPS Trigger On button is used to start periodic GPS coordinate updates from the
selected radio. The functionality is currently supported on lines using NEXEDGE or
MOTOTRBO signaling only.

To start receiving periodic GPS coordinates from a radio, do the following:
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From the GPS Trigger Time drop down menu, select the unit you want to send the GPS

Trigger On command.
OR

If using a Keypad, select the unit you wish to send the GPS Trigger On command.

Click GPS Trigger On.
The command is sent.

GPS Trigger Setup page
When the GPS Trigger On Button function is selected from the Ul Element drop down menu,

the GPS Trigger Setup page appears. See the Figure below.

GPS Trigger Time drop down menu
The GPS Trigger Time drop down menu is used to select the time duration between GPS

coordinate updates.

The time duration between GPS coordinate updates is determined by the GPS Trigger Time

drop down menu.

| Type I Colors I Options | GFS Trigger Setup

GPS Trgger Time: |2 Minutes -

Figure 31.23: GPS Trigger Setup Page - Ul Element Setup

Available options are:

30 Seconds
1 Minute
2 Minutes
4 Minutes
8 Minutes

To add a GPS Trigger On button, do the following:

1.

From the Insert menu, select Add Ul Button.

A None button appears on the console window.
Right-click the None button.

A shortcut menu appears.

From the shortcut menu, select Properties.
The Ul Element Setup window appears.

From the Ul Element drop down menu, select GPS Trigger On.

Click OK.
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The color of the button changes and GPS Trigger On appears on the button.

31.33 Group Programmed

The Group Programmed function allows the console operator to broadcast to a pre-defined
group.

Line Group page
When the Group Programmed function is selected from the Ul Element drop down menu, the
Line Group page appears. Refer to the Figure below.

e Grovp

Select Lines for Group:

1:5IF Diamondhead -
2:5idney Police T
3:MNewport Police =
4iDen Line

5:16kb Vocoder

&:Supervisor Line

7-Met Enabled-

8:-Not Enabled-

5:-Mot Enabled-

10:-Mot Enabled-

11:-Mot Enabled- -

Figure 31.24: Line Group Page - Ul Element Setup

Select Lines for Group field

The Select Lines for Group field contains a list of all the lines configured on “Per Line
Parameters window, page 61”. Selecting a line from this list assigns it to the group. Pressing
the Group Programmed button in the C-Soft Runtime program places the defined lines into a
select condition.

To add a group programmed button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Group Programmed.
The Line Group tab appears.
5. Click the Line Group tab.
The Line Group page appears.
6. From the Select Lines for Group field, select the line(s) for the group.
7. Click OK.
The color of the button changes and Preset Group appears on the button.
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To remove a line from the Group Programmed, deselect the line.

Group Programmed Enhanced button

The Group Programmed Enhanced button allows the console operator to broadcast to a pre-
defined group of lines and frequencies. The group’s lines and transmit frequencies are
configured in the Group Programmed Enhanced setup dialog.

Up to 25 selected lines can be stored in a pre-defined group.

Notice!
The Allow Programmed Group to be changed in Runtime feature is not accessible with a
mouse used on the IP-30XX devices.

Group Programmed Enhanced Setup page

When Group Programmed Enhanced button is selected from the Ul Element drop down menu,
the Group Programmed Enhanced Setup page appears. This button has the ability to
configure line and frequencies selected when the button is pressed.

To open the Group Programmed Enhanced Setup page, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Group Programmed Enhanced.
The Group Programmed Enhanced Setup tab appears.
5. Click the Group Programmed Enhanced Setup page.
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Ul Elernent Setup >

Type Colors  Group Programmed Enhanced Setup  Options

Awvailiable Lines and Frequencies

Line: | 4:Line 4 ~ Freq: | 4:Freq4 ~

Programmed Group List

Line Frequency Delete
1:Line 1 0:Use Default
Zline 2 2:Freq 2
JLine 3 J:Freq 3
4:line 4 4:Freqg 4
QK

Available Lines and Frequencies group box
The Available Lines and Frequencies group box displays the list of lines and the line’s
corresponding frequencies available in the design configuration file.

Line drop down menu
The Line drop down menu identifies the desired line to be selected.

Freq drop down menu
The Freq drop down menu identifies the desired frequency to use per selected line.

Programmed Group List
The Programmed Group List displays the list of line/frequency combinations which are
selected when the Group Programmed Enhanced button is pressed. To remove a line/

frequency combination from the list, select the desired row in the list and then click the
Delete button.

Group Programmed Enhanced Options page
The Group Programmed Enhanced Options page is used to identify whether or not
Programmed Groups can be changed in Runtime by the dispatcher.
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Ul Element Setup *

Type Colors  Group Programmed Enhanced Setup  Options

Options

[+]iAllow Programmed Group to be changed in Runtime:!

Allow Programmed Group to be changed in Runtime check box
The Allow Programmed Group to be changed in Runtime check box indicates the setup
allows the defined group to be modified by the dispatcher in C-Soft Runtime.

To edit the Group Programmed Enhanced button in Runtime, do the following:

1. Right-click the Group Programmed Enhanced button.

2. Select the Edit option.

The border of the Group Programmed Enhanced button blinks to signify the console is in
Edit mode.

Select or unselect lines.

Set the desired transmit frequency for the selected lines.

Right-click the Group Programmed Enhanced button.

. Select the Save Option.

The new group configuration is now saved to the button.

o0 s w

To exit Edit mode without saving, do the following:
1. Right-click the Group Programmed Enhanced button.
2. Select the Cancel option or any button other than a select or frequency control.

To clear a button’s defined group, do the following:
1. Right-click the Group Programmed Enhanced button.
2. Select the Clear option.

Refer to
—  Per Line Parameters window, page 61
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31.34

Group Select

The Group Select function creates a button used to create a group of users to call.

Notice!

Group Select Limited and Group Select buttons cannot co-exist on the same console.

31.35

To add a Group Select button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4. From the Ul Element drop down menu, select Group Select.

5. Click OK.

The color of the button changes and Group Select appears on the button.

When the button is selected in C-Soft Runtime, a group can be defined manually.

To manually select a group of IDs to call, while in C-Soft Runtime, do the following:

1. In C-Soft Runtime, click the Group Select button.
2. Click the desired lines.

The lines are added to the group.
3. Click the Group Select button a second time.
The group clears.

Group Select Limited

The Group Select Limited function is similar to the Group Select function, except the number

of lines the console operator can select is limited.

Notice!

Group Select Limited and Group Select buttons cannot co-exist on the same console.

Group Select Limited page

When the Group Select Limited function is selected from the Ul element drop down menu, the

Group Select Limited page appears. Refer to the Figure below.
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31.36

Max number of simulttaneous selected lines:

Figure 31.25: Group Select Limited Page - Ul Element Setup

Max Number of Simultaneous Selected Lines field
The Max Number of Simultaneous Selected Lines field identifies the number of lines a
console operator can select for a group.

The range for this field is 0 to 200 lines.

To add a group select limited button, do the following:

1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4. From the Ul Element drop down menu, select Group Select Limited.
The Group Select Limited tab appears.

5. Click the Group Select Limited tab.
The Group Select Limited page appears.

6. From the Select Lines for Group field, enter the maximum number of line(s) for the
group.

7. Click OK.

The color of the button changes and Group Limited appears on the button.

Input Indication

The Input Indication function allows the console operator to monitor an ADHB-4 or NEO-10
input, as well as configure the parameters particular to an input source.

Input Indication Setup page
When the Input Indication function is selected from the Ul element drop down menu, the
Input Indication Setup page appears. Refer to the Figure below.
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Ul Elerment Setup
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Figure 31.26: Input Indication Setup Page - Ul Element Setup

Input Source group box

The Input Source group box identifies the input source to be monitored. When either ADHB-4
or NEO is selected, the fields necessary to enter the setup information for input sources are
enabled.

ADHB-4 radio button
The ADHB-4 radio button indicates an ADHB-4 device is used as the input source.

NEO radio button
The NEO radio button indicates a NEO-10 is used as the input source.

Polarity group box

Active High check box
The Active High check box indicates the input is set to active high. If selected, the status
button changes when the input goes to a positive (high) state.

Annunciation of Input Change group box

Beep for check box

The Beep for check box indicates a beep sound is played when there is a change in input.
When the Beep for check box is selected, the Beep for seconds field becomes active.
Otherwise, there is no beep sound when the input changes.

Beep for seconds field
The Beep for seconds field is used to set the amount of time, in seconds, the indicator beeps
after the input is changed. The Beep for radio button must be selected.

The range for this field is 0 to 20 seconds.
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Blink for check box
The Blink for check box indicates the border of the Input Indication button blinks when an
input change is detected.

Blink for seconds field
The Blink for seconds field is used to enter the number of seconds the border of the Input
Indication button blinks after a change in input is detected.

The range for this field is 0 to 30 seconds.

Play check box
The Play check box indicates the .wav file configured for the selected annunciation button
plays when the input changes.

Notice!

When a system is configured with parallel consoles, only one console should be configured to
play a .wav file on input change. This prevents multiple consoles attempting to transmit

the .wav file simultaneously.

Play drop down menu

The Play drop down menu is used to select an annunciation button from a list that exist in the
design file. The .wav file format is: X:text (where X represents the line number associated with
the Annunciation button and text is the button name of the Annunciation button). When the
input changes, the .wauv file is played on the line the annunciation button is configured on.

The Play check box must be selected to activate the play function.

Input Destination ADHB-4 group box
The Input Destination radio buttons identify the ADHB-4 input destination.

None radio button
The None radio button indicates there is no input indication assigned to the button or there is
no ADHB-4 connected.

Input 1 radio button
The Input 1 radio button is used to configure the Input Indication button to signal the console
operator if the first relay is currently in control of an ADHB-4.

Input 2 radio button
The Input 2 radio button is used to configure the Input Indication button to signal the console
operator if the second relay is in control of an ADHB-4.

NEO Settings group box

IP field
The IP field identifies the IP Address of the NEO-10.
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Input drop down menu
The Input drop down menu identifies the input port for relays.

Available selections for this field are None and Ports 1 through 10.
Relay Setup group box

Active Relay With Input check box
The Active Relay With Input check box indicates a configured relay activates when the input
state changes to active.

Relay Destination group box
The Relay Destination radio buttons identify the relay to be controlled. When a selection is
made, the fields necessary to enter the setup information for the relay are enabled.

ADHB-4 Settings group box
The ADHB-4 Settings radio buttons identify which ADHB-4 relay is activated when an input is
active.

None radio button
The None radio button indicates none of the ADHB-4 relays is activated.

Relay 1 radio button
The Relay1 radio button indicates the first relay in the ADHB-4 is being controlled.

Relay 2 radio button
The Relay 2 radio button indicates the second relay in the ADHB-4 is being controlled.

NEO Settings group box
The NEO Settings field identifies the IP Address and the relay, if any, for the NEO-10.

IP field
The IP field identifies the IP Address of the NEO-10.

Relay drop down menu
The Relay drop down menu is used to select the desired relay.

Available selections for this field are None, Port 1, Port 2, Port 3, Port 4, Port 5, Port 6, Port 7,
Port 8, Port 9 and Port 10.

Active Duration field
The Active Duration field is used to enter the length of time, in ms, the relay remains active
after the input state changes to active.

The range for this field is 300-3000ms.

To configure and add an ADHB-4 Input Indications button, do the following:
1. From the Insert menu, select Add Ul Button.

A None button appears on the console window.
2. Right-click the None button.

A shortcut menu appears.
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10.
11.

From the shortcut menu, select Properties.

The Ul Element Setup window appears.

From the Ul Element drop down menu, select Input Indication.

The Input Indication Setup tab appears.

Click the Input Indication Setup tab.

The Input Indication Setup page appears.

From the Input Source and Polarity group box, select ADHB-4.

The Input Destinations group box is active.

From the Input Destination area, select None, Inputl, or Input2.
Select the Active High check box for active high inputs.

From the Annunciation of Input Change group box, select No Audio.
OR

Select Beep.

In the seconds field, enter number of seconds the beep is heard, if applicable.
From the Input drop down menu, select the desired input.

To configure and add a NEO Input Indication button, do the following:

1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Input Indication.
The Input Indication Setup tab appears.
5. Click the Input Indication Setup tab.
The Input Indication Setup page appears.
6. Select NEO.
The NEO Settings group box is active.
7. Inthe IP field, enter the IP Address of the NEO-10.
8. Select the Active High check box for active high inputs.
9. From the Annunciation of Input Change group box, select No Audio.
OR
Select Beep.
10. In the seconds field, enter number of seconds the beep is heard.
11. From the Input drop down menu, select the desired input.
31.37 Instant Recall

The Instant Recall function allows the console operator to play back a predetermined amount

of receive audio only.

The recall starts with the oldest call first.

Multiple Instant Recall buttons can be placed on the console window with each button set to
playback a certain amount of audio.

The button must be held down for the complete duration of the recording time to hear all
audio in buffer.
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The C-Soft program function constantly maintains a record of the last 600 seconds (or 10
minutes) of both parallel transmit and receive audio. The recorder only records the audio
when the call is active, allowing for a long conversation to be replayed without the loss of
audio.

31.37.1 Duration page
When the Instant Recall function is selected on the Ul Element Setup window, the Duration
page appears. Refer to the Figure below.

Colors

Audio Playback Start: Seconds Old

Audio Source: [Seled

Figure 31.27: Duration Page - Ul Element Setup

Audio Playback Start field

The Audio Playback Start field identifies the amount of time to record from the end of the call
backwards.

The field value can range from 0 to 600 seconds.

Audio Source drop down menu
The Audio Source drop down menu determines the source from which the audio is recorded.
Available selections for this field are:

Select

Unselect

Speaker 3 [ADHB-4]
Speaker 4 [ADHB-4]
Speaker 5 [ADHB-4]
Speaker 6 [ADHB-4]
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Durston

Audio Playback Stat: 10 Seconds Old

Audio Source: | Select
Select

Unselect

Speaker 3 (ADHEB4)
Speaker 4 (ADHEB4)
Speaker 5 (ADHE4)
Speaker 6 (ADHEB4L)

Figure 31.28: Audio Source Drop Down Menu

To configure and add an Instant Recall button, do the following:

1.

7.
8.

From the Insert menu, select Add Ul Button.

A None button appears on the console window.

Right-click the None button.

A shortcut menu appears.

From the shortcut menu, select Properties.

The Ul Element Setup window appears.

From the Ul Element drop down menu, select Instant Recall.

The Duration tab appears.

Click the Duration tab.

The Duration page appears.

In the Audio Playback Start field, enter the number of seconds you want to play back
audio.

From the Audio Source drop down menu, select the audio source to play back.
Click OK.

The duration and audio source are configured. The color of the button changes and IRR Select
10 appears on the button.

31.38 Instant Recall - Last Call button

The Instant Recall - Last Call button allows users to play back audio from the last received
call on the configured line.

Clicking the Last Call button prompts the audio from the last call to start playing. To stop the
audio from playing, click the Last Call button again. The Last Call button is only available for
lines that have Per Line Call Playback enabled.

To add a Last Call button, do the following:

1.

From the Insert menu, select Add Ul Button.

A None button appears on the console window.
Right-click the None button.

A shortcut menu appears.

From the shortcut menu, select Properties.
The Ul Element Setup window appears.
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31.39

31.40

4. From the Ul Element drop down menu, select Instant Recall - Last Call.
The Line to Associate Function With drop down menu becomes active.

5.  From the Line to Associate Function With drop down menu, select the line to associate
the Last Call function.

6. Click OK.

The color of the button changes and Last Call appears on the button.

Intercom

The Intercom function allows communication between consoles without keying remote radios.
The Intercom button works just like the PTT- Main button, except additional information is
included in the transmission that prevents the generation of PTT and radio keying.

To add an Intercom button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Intercom.
5. Click OK.
The color of the button changes and Intercom appears on the button.

Intercom-Per Line

The Intercom-Per Line function allows console operators to communicate with each other
without keying up a radio connected to the line. This button is similar to the Intercom button,
except it works only on the line selected in the Line to Associate Function With field, and it
does not transmit on the selected line.

The Intercom Per Line function is usually activated on a non-priority channel so existing audio
traffic is not interrupted.

To add an Intercom-Per Line button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Intercom-Per Line.
The Line to Associate Function With drop down menu becomes active.
5.  From the Line to Associate Function With drop down menu, select the line to associate
the Intercom-Per Line function.
6. Click OK.
The color of the button changes and Intercom appears on the button.
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3141

31.42

3142.1

Knox Digit

The Knox Digit function is used to assign a Knox tone to the button. These digits must be
assigned to Ul elements individually.

Available selections for this field are: 1, 2, 3,4, 5,6, 7,8, 9, A, B, C, D, *, and #.

To create a Knox digit button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Knox Digit.
The Knox Digit tab appears.
5. Click the Knox Digit tab.
6. From the Know Digit drop down menu, select a digit.
7. Click OK.
The Knox Digit button is created.

Launch Application

The Launch Application function creates a button called Launch Application.

In C-Soft Runtime, if the Launch Application button is clicked, the specified application, such
as a messaging software is started. The maximum number of Launch Application buttons in a
design is 64.

Launch Application Setup page

When the Launch Application function is selected from the Ul Element Setup window, the
Launch Application Setup page and Application Triggers page appear. Refer to the Figure
below.

LI Element Setup

Type Colors Launch Application Setup  Application Triggers

Application Setup

File Path: | | | Browse..

Parameters: |[:D|-.-..-E1—sjgn |

Autostart Application

Figure 31.29: Launch Application Setup Page - Ul Element Setup
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31.42.2

File Path field

The File Path field displays the path to the application you want to launch. For example, F:
\RadioDispatch\CSoftDesigner.exe. You can either find the file with the browse button or
enter the path in the field.

Parameters field
The Parameters field is used to specify command line arguments to the application being
started. The parameters that can be entered are dependent on the application.

EXAMPLES:

— If the application is Internet Explorer and www.Telex.com is entered in the Parameters
field, the Telex webpage opens in Internet Explorer.

— If the application file path is Notepad, and C:\Logs\notebook.txt is entered in the
Parameters field, the notebook.txt file opens.

This field can contain up to 1024 characters.

Browse button
The Browse button opens a Windows folder from which you can navigate to the application
you want to start with the Launch Application button.

Autostart Application check box
The Autostart Application check box indicates the application automatically starts running the
configured application when C-Soft is launched.

To create a launch application button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Launch Application.
The Launch Application Setup tab appears.
5. Click the Launch Application Setup tab.
The Launch Application Setup page appears.
6. Click the browse button.
A Windows folder appears.
7. Navigate to the application you want to start when the Launch Application button is
clicked.
8. Click OK.
The Ul Properties window closes.

Application Triggers page

When the Launch Application function is selected from the Ul Element Setup window, the
Launch Application Setup page and Application Triggers page appear. Refer to the Figure
below.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



284 en | Ul Element Functions configuration C-Soft 7.700

UI Elernent Setup e

Type Colors  Lsunch Application Setup  Application Triggers
Custom Test Message:

Open Application
Text 3

Text Message List:

Text 2
Text 1

<
Status List:

Red Status
Yellow Status
Green Status

oK

Figure 31.30: Application Triggers Page

Custom Text Message field
The Custom Text Message field is used to enter a custom text message that can be added to
the Open Application group box.

Text Message List field
The Text Message List field is used to select text message that were pre-created in Text
Message ID list.

Status List field
The Status List field is used to select statuses that were pre-created in Status Message ID. list

Add button
The Add button is used to add the selected text messages or status messages to the
application launch list.

Remove button
The Remove button is used to remove the selected text messages or status messages from
the application launch list.

Open Application field

The Open Application field displays the text messages and status messages that have been
moved to the open application list. When text messages or status messages are received that
are in the application list, the application specified on the Launch Application Setup page
starts.
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OK button
The OK button saves any changes made and closes the window.

To create text message/status message application launch button, do the following:

1.

8.

From the Insert menu, select Add Ul Button.

A None button appears on the console window.

Right-click the None button.

A shortcut menu appears.

From the shortcut menu, select Properties.

The Ul Element Setup window appears.

From the Ul Element Function drop down menu, select Launch Application.

The Launch Application Setup and Application Triggers tabs appear.

Click the Application Triggers tab.

The Application Triggers page appears.

In the Custom Text Message field, enter a custom text message that is not in the Text
Message List.

OR

From the Text Message List group box, select the text message desired to launch the
designated application.

The list of text messages are pulled from the Text Message ID List.

OR

From the Status List group box, select the status desired to launch the designated
application.

The list of status messages are pulled from the Status Message ID List.

Click the Add button to add the text messages or status messages to the Open
Applications group box.

OR

Click the Remove button to remove the text messages or status messages from the Open
Applications group box.

IMPORTANT: Whenever the designated text/status is received in C-Soft Runtime, the
designated application launches.

Click OK.

The color of the button changes and Text Message Control or Status Message Control appears
on the button.

31.43 Manual Call List

The Manual Call List function creates a button called Manual Call List. The Manual Call List
window is used to place calls by manually entering the user ID number.

In C-Soft Runtime, if the Manual Call List button is clicked, the manual call list for the selected
line appears. From this window, the user can manually send calls or status messages on the
selected line based on programming set up in “Signaling Parameters window, page 72”.

To add a Manual Call List button, do the following:

1.

From the Insert menu, select Add Ul Button.

A None button appears on the console window.
Right-click the None button.

A shortcut menu appears.
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3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Manual Call List.
5. Click OK.
The color of the button changes and Manual Call List appears on the button.

Refer to
- Signaling Parameters window, page 72

31.43.1 Manual Call List window
The Manual Call List window is used to manually send messages, alerts and statuses. The
User ID is entered by the console operator.

Manual Call List: Mo Line Selected

Uszer (D I
1 2 3
4 5 E
7 ] 3
* 1] #
&, | E C | D | E F |

Status I Mo Status Set Status |

Calll [Call2 [Call3 Call4 Call&
CallG [Call¥ [Calls Calld Callfio
Dione

Figure 31.31: Manual Call List Window - C-Soft Runtime Application

User ID field
The User ID field is used to enter an ID number to call or send status to.
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31.44

Graphic DTMF keypad
The Graphic DTMF keypad is used to enter DTMF digits to place calls and send status
messages.

Clear button
The Clear button is used to clear all digits from the User ID field.

Backspace button
The Backspace button is used to backup one space to clear the last digit entered.

Set Status button

The Set Status button is used to select from a list of preprogrammed status IDs. When a
status ID is selected and the window is closed, the selected status appears in the Status field
in the Status List window.

For more information, refer to “Status List window, page 236”.

A-F Buttons
The A-F buttons are valid digits for 5/6 Tone. Each digit corresponds to a different tone
frequency.

Call (1-10) Buttons

The Call (1-10) buttons are used to place user-defined calls configured in the “5/6 Tone DTMF
ANI Setup Page” on “5-6 Tone/DTMF ANI system type, page 75”. The labels configured on the
5/6 Tone/DTMF ANI Setup page appear on these buttons in the call list window.

To place a manual call, do the following:

1. Select a line to call from.

2. Select a Manual Call List button.
The Manual Call List window appears, refer to the Figure above.

3. Using the monitor keypad or your keyboard, enter a user ID number.
The number appears in the User ID field.

4. Press a configured call button to place the call.

The call is placed.

Done button
The Done button is used to close the Manual Call List window.

Refer to
—  Status List window, page 236
- 5-6 Tone/DTMF ANI system type, page 75

Marker Tone

The Marker Tone function controls a periodic automatic keyup of a radio channel, along with
an associated tone burst transmission for a particular line.
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Notice!

If the Marker Tone function is selected, a line must be selected from the Line to Associate

Function With drop down menu on the Type page.

Marker Tone Setup page

When the Marker Tone function is selected from the Ul Element drop down menu, the Marker

Tone Setup page appears. Refer to the Figure below.

| Type | Colore | Marer Tone Setup

Tone Type:
@ Tone! () Pulsed Tone () Hi-Llo

Low Frequency: 1000 Hz  Low/On Durgtion: |1000 | ms
Hi Frequency: |0 Hz Hi/Off Duration: |0 ms
Tone Level: -10 dB

Keyup Duration: 2000 ms

Time Between Tones: 10 g

Figure 31.32: Marker Tone Setup Page - Ul Element Setup

Tone Type group box

The Tone Type group box identifies the type of tone to play. When a selection is made, the
fields necessary to enter the setup information for that tone type are enabled on the page.

Tone radio button

The Tone radio button indicates a single steady tone is used as an alert tone.

To add a marker tone button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3.  From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4. From the Ul Element drop down menu, select Marker Tone.

The Marker Tone Setup tab appears.
5. Click the Marker Tone tab.
The Marker Tone Setup page appears.

In the Tone Level field, enter the tone level (in dB).
In the Key-up Duration field, enter the duration (in ms).

© N

In the Tone Type group box, select the Tone radio button.
In the Low Frequency field, enter the frequency (in Hz).
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10. In the Time Between Tones field, enter a time (in seconds).
11. Click OK.
The Marker Tone button is created.

Pulsed Tone radio button
The Pulsed Tone radio button indicates a pulsed tone is used as an alert tone.

To add a pulsed marker tone button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Marker Tone.
The Marker Tone Setup tab appears.
5. Click the Alert Setup tab.
The Alert Setup page appears.
6. From the Tone Type group box, select the Pulsed Tone radio button.
7. In the Low Frequency field, enter the frequency (in Hz).
8. Inthe Low/On Duration field enter the duration (in ms).
9. In the Hi/Off Duration field, enter the duration (in ms).
10. In the Tone Level field, enter the tone level (in dB).
11. In the Key-up Duration field, enter the duration (in ms).
12. In the Time Between Tones field, enter a time (in seconds).
13. Click OK.
The Marker Tone button is created.

Hi-Lo radio button
The Hi-Lo radio button indicates a Hi-Lo warble is used as an alert tone.

To add a hi-lo marker tone button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Marker Tone.
The Marker Tone Setup tab appears.
5. Click the Marker Tone tab.
The Marker Tone Setup page appears.
6. From the Tone Type group box, select the Hi-Lo radio button.
7. In the Low Frequency field, enter the frequency (in Hz).
8. In the Low/On Duration field, enter a duration (in ms).
9. In the Hi Frequency field, enter a frequency (in Hz).
10. In the Hi/Off Duration field, enter the duration (in ms).
11. In the Tone Level field, enter the tone level (in dB).
12. In the Key-up Duration field, enter the duration (in ms).
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13. In the Time Between Tones field, enter a time (in seconds).
14. Click OK.
The Marker Tone button is created.

Low Frequency field
The Low Frequency field identifies the frequency, in Hz, of the low tone sent when the button
is pressed.

The range for this field is 0 to 3000Hz.

Low/On Duration field
The Low/On Duration field identifies the duration, in ms, the low frequency is played.

The range for this field is 0 to 5000ms.

Notice!

If Tone is selected, this field is ignored because the tone is continuous. If Pulsed Tone is
selected, this field indicates the length of each tone off period. If Hi-Lo is selected, this field
indicates how long the high tone is played.

Hi Frequency field
The Hi Frequency field identifies the frequency of the Hi tone sent when the button is pressed.

The range for this field is 0 to 3000Hz.

Hi/Off Duration field
The Hi/Off Duration field identifies the duration the Hi frequency is turned off.

The range for this field is 0 to 5000ms.

Tone Level field
The Tone Level field identifies the relative change for allowable tone level.

The range for this field is -40 to 10dB.

Notice!

If Tone is selected, this field is ignored because the tone is continuous. If Pulsed Tone is
selected, this field indicates the length of each tone off period. If Hi-Lo is selected, this field
indicates how long the high tone is played.

Key-up Duration field
The Key-up Duration field identifies the duration of the tone.

The range for this field is 0 to 10,000ms.
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Time Between Tones field
The Time Between Tones field identifies the duration between key-ups.

The range for this field is 0 to 32 seconds.
31.45 MDC-1200
The MDC-1200 function, creates a button to open the MDC-1200 Dispatching window.

In C-Soft Runtime, when the window is open the user can view the system list, call and status
history, status IDs, voice and data messages and select groups and individuals to place calls.

MDC-1200 Setup page
When the MDC-1200 window function is selected from the Ul Element drop down menu, the
MDC-1200 Setup page appears.

MDC-1200 Setup

Console Requests Remate Monitor
Timeout: 5 [] Enable Global Muttiplier

Passwond Protection Remote Monitor Type: | Mon-Silent -

[ Emergency Re¢ Muttiplier:
[“|{Radio Enable,/Disable:
[7] Radic Remote Monitar

Tx Multiplier:

Figure 31.33: MDC-1200 Setup Page - Ul Element Setup
Console Requests group box

Timeout sec field

The Timeout sec field is used to configure the amount of time, in seconds, the console waits
when sending status requests, radio checks, radio enable, and radio disable messages. If the
radio is unable to respond, No Response, appears in the status bar of the dispatching window
depending on the current state of the radio.

The range for this field is 1 to 10 seconds.
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Password Protection group box

Emergency check box
The Emergency check box indicates the console operator is prompted for the supervisor
password before they are allowed to send an emergency message.

Radio Enable/Disable check box
The Radio Enable/Disable check box indicates the console operator is prompted for the
supervisor password before they are allowed to enable or disable the radio.

Radio Remote Monitor check box
The Radio Remote Monitor check box indicates the console operator is prompted for the
supervisor password before they are allowed to remotely monitor the radio.

Remote Monitor group box

Enable Global Multiplier check box
The Enable Global Multiplier check box indicates the values entered in the RX Multiplier and
TX Multiplier fields are multiplied by two.

Remote Monitor Type drop down menu
The Remote Monitor Type drop down menu is used to select a mode for radio transmission
indications.

Available selections for this field are:

— Non-Silent - Radio indicates transmission is occurring by flashing TX LED on the radio
display when using radio remote monitor.

—  Silent - No transmit indication appears during transmission.

Remote Monitar
[ Enable Global Muttiplier

Remote Monitor Type: [ MNon-Silent

Man-Silert
Rec Multiplier: Silert

Ta Muttiplier:

Figure 31.34: Remote Monitor Type Drop Down Menu

RX Multiplier drop down menu

The RX Multiplier drop down menu indicates the amount of time the radio receiving the
remote monitor command is unable to receive calls after transmitting. The value is multiplied
by the remote monitor time programmed in the radio to determine the total time.

Available selections for this field are: 0 to 3.
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Remote Manitar

[] Enable Global Multiplier
Remote Monitor Type: | Silent
Foe Muttiplier:

T Multiplier:

[FLR R ] & ]
4 4

Figure 31.35: Rx Multiplier Drop Down Menu

TX Multiplier drop down menu

The TX Multiplier drop down menu is used to indicate how long the radio receiving the
remote monitor command is allowed to transmit. The value is multiplied by the remote
monitor time programmed in the radio to determine total transmit time.

Available selections for this field are: 0 to 3.

Remote Monitor

[T] Enable Global Muktiplier

Remote Monitor Type:

T Multiplier:

Figure 31.36: Tx Multiplier Drop Down Menu

To add an MDC-1200 Window button, do the following:
1. From the Insert menu, select Add Ul Button.

A None button appears on the console window.
2. Right-click the None button.

A shortcut menu appears.
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3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select MDC-1200 Window.
The MDC-1200 Setup tab appears.
5. Click the MDC-1200 Setup tab.
The MDC-1200 Setup page appears
6. From the Console Request group box, enter a time for the timeout.
7. From the Password Protection group box, select the password protection radio button.
NOTE: For more information, refer to “Password Protection Group Box”.
8. From the Remote Monitor group box, configure a multiplier.
NOTE: For more information, refer to “Remote Monitor Group Box”.
9. Click OK.
A button with MDC-1200 on it appears.

31.45.1 MDC-1200 Dispatching window
The MDC-1200 Dispatching window, shown in the Figure below, is used by the console
operator in C-Soft Runtime to send and receive MDC-1200 messages. The status bar provides
feedback about MDC-1200.

| MDC-1200 Dispatching

System [MOC System v| [Seecsditems |Hstory
| = @ MOC Syst r
Type ! o., () r.ch :m System Alias o Type
Drop Down + MO A MDC System MOC 14 —
| + @ MDC Group 1 Indrvidud]
Menu B @MOC Grow 2
D Console Group
@ Consoles
& MDC 14
& Huan
@ Main Console
D Parsllel Console
!
System
List
Manwal Select
User ID: Add to Selected |
Call Alert ’ Radio Check ’ Status Request ‘ Salect Call
Stat Eaccbizbis I Radi Enable ’ Remaote Manitor ’ Emergency
us
Bar\
| | ol atert to MDC 14 sent successfully on Line 8. = -

Figure 31.37: Selected Items Page - MDC-1200 Dispatching Window

System Type drop down menu

The System Type drop down menu is used to change from the currently selected system to
another system in the console position. When a system is selected, the system list populates
with filters and components contained in the system.
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Up to 200 systems can be created.

The default systems included in the drop down menu depend on the currently selected line’s
configuration.

System List

The System List populates with system components that belong to the system currently
selected in the System drop down menu. The system name is the first item to appear in the
list. Filter components are listed next in the hierarchy. When a filter component is expanded
individual units and groups are visible.

Systems can be configured, by the console admin, to display filters only. In that case, only
components affiliated with a filter appear in the System List. Otherwise, all components,
including components with deny icons (permission to place calls denied), appear in the list.
Refer to the Figure below.

Icon Type Description

° Filter The Filter icon indicates the component is used to group, sort, and label
the components contained in the filter.

To view or hide filters, do one of the following:
- Click ¥ to expand the filter list.
—  Click ™ to collapse the filter list.

@ Deny The Deny icon indicates the tagged item does not allow the console
operator to place a call or send messages to this component.

o Allow The Allow icon indicates the component is available for selection. The
console operator can place calls to these components.
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MDC-1200 Dispatching MDC-1200 Dispatching

MOC System v

Only Display Filters = 13 —,-. Only Display Filters

options selected @mocure 11 option unselected
& MDC Unit 12
@ MDC Unit 13
@& MDC Unik 14

= #P AUnits
& MOC Unit |
& MDC Unit 2
& MDC Unit 3
@ MOC Unit 4

& MDC Uik 5 /
Filters

Units/

Filters

Figure 31.38: MDC-1200 System Displays Only Filters Example

System List flyout menu
The System List flyout menu is used as a quick method of accessing the Select Type
commands that are also available with the MDC Message buttons.

Available selections for this field are:
- Call Alert

— Radio Check

- Request Status

- Select Call

— Radio Status

- Remote Monitor

- Emergency

To access the System List flyout menu, do the following:

— In the system list, right-click the system, individual, or group to send the call or message
to.
The System List flyout menu appears.
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MDC-1200 Dispatching
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Selected Items page

The Selected Items page is used to view the currently selected component’s ID information.
The selected item list is used to determine where a call or status message is sent to. The
operator can select one component per system in the list. Up to 200 messages can be sent
simultaneously as long as they are each sent to a different system. When a system component
in the system list is selected it is added to the selected items page.

Grayed out icons with deny tags are not available for selection.

To add a component’s ID to the Selected Items page, do the following:
— In the System List field, select the component.
The component is highlighted, and appears in the Selected Items list.

Refer to “Manual Select Group Box” to learn how to manually enter an ID.

To remove an ID from the Selected Items page, do the following:
1. Right-click the unwanted component.
A flyout menu appears.
2. Click Remove Item.
The item disappears from the list.

Manual Select group box
The Manual Select group box is used to communicate with system users not in the system list.

User ID field
The User ID field is used to enter an MDC ID (in hexadecimal format) for selection to add to
the list.

Add to Selected button
The Add to Selected button is used to add the MDC ID entered in the User ID field to the
selected items list.

To manually place an individual radio ID in the selected items list, do the following:
— In the User ID field, enter an ID from 001-DFFF.
The ID appears in the Selected Items list.

To manually place a group ID in the selected items list, do the following:
— In the User ID field, enter an ID from 000-FFF.
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The ID appears in the Selected Items list.

To manually place a system ID in the selected items list, do the following:
- Inthe User ID field, enter FFFF.
The ID appears in the Selected Items list.

Notice!
The character F behaves like a wildcard.

The MDC Message buttons, located at the bottom of the MDC-1200 Dispatching window, are
used to send calls, alerts, statuses, and messages. When a button is clicked, the status bar
confirms activity.

MDC offers ANI capabilities on PTT. When transmitting on a line, C-Soft sends the console’s ID
to the radio. A PTT call displays in the history pages as a Voice message type. The ID alias or
ID appear on the line’s Select button.

Call Alert button
The Call Alert button is used to send an alert message.

To send a call alert, do the following:

1. From the system list, select the unit ID to send the alert message to.
OR
From the system list, select the group to send the alert message to
The highlighted item is added to the selected items list.

2. Click call Alert.

An alert is sent to the selected user(s) MDC-1200 radio.

Radio Check button
The Radio Check button indicates a message is sent to check for radio activity.

To send a radio check message to an MDC-1200 radio, do the following:

1. Inthe system list, select a unit ID to send the radio check message to.
The highlighted item is added to the selected items list.

2. Click Radio Check.

If the selected radio is able to respond, Acknowledge appears on the line’s select button,
History window, and in the item list on the History page.

If the radio is unable to respond within the configured time allowed, No Response appears on
the select button, the Per Line Call History window, and the list on the History page.

Status Request button
The Status Request button is used to request status from a unit in the system.

To request a status from a unit, do the following:
1. Inthe system list, select a unit ID to send the alert message to.
The highlight item is added to the selected items list.
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2. Click Status Request.

If the selected radio is able to respond, the (status message) appears on the line’s select
button, the Per Line Call History window, and in the item list on the History page.

If the radio is unable to respond within the configured time allowed, No Response appears on
the select button, the Per Line Call History window, and the list on the History page.

Select Call button
The Select Call button is used to place a select call.

To place an MDC-1200 select call, do the following:
1. Inthe system list, select a unit ID to place the select call to.
The highlighted item is added to the selected items list.
OR
In the system list, select a group to place the select call to.
The highlighted item is added to the selected items list.
2. Click Select Call.
The select call message is sent and the receiving radio performs select call actions.

Radio Disable button
The Radio Disable button is used to disable a radio in the field from use by unauthorized
persons.

To disable a radio, do the following:

1. Inthe system list, select a unit you want to disable from use.
The highlighted item is added to the selected items list.

2. Click Radio Disable.

The disable radio message is sent and the radio no longer functions.

If the selected radio is able to respond, Acknowledge appears on the line’s select button,
History window, and in the item list on the History page.

If the radio is unable to respond within the configured time allowed, No Response appears on
the select button, the Per Line Call History window, and the list on the History page.

Radio Enable button
The Radio Enable button is used to enable a radio that has been disabled.

To enable a radio, do the following:

1. Inthe system list, select a unit you want to enable for use.
The highlighted item is added to the selected items list.

2. Click Radio Enable.

The microphone on the selected unit is open for monitoring.

If the selected radio is able to respond, Acknowledge appears on the line’s select button,
History window, and in the item list on the History page.

If the radio is unable to respond within the configured time allowed, No Response appears on
the select button, the Per Line Call History window, and the list on the History page.
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31.45.2

Remote Monitor button
The Remote Monitor button is used to remotely keyup a microphone for monitoring purposes.

To monitor a unit, do the following:

1. Inthe system list, select a unit ID you want to monitor remotely.
The highlighted item is added to the selected items list.

2. Click Remote Monitor.

The microphone on the selected unit is open for monitoring.

Emergency button
The Emergency button is used to send an emergency alert.

To send an emergency call, do the following:

1. In the system list, select the unit ID to which the emergency alert is sent.
The highlighted item is added to the selected items list.
OR
In the system list, select the group to which the emergency alert is sent.
The highlighted item is added to the selected items list.

2. Click Emergency.

The emergency alert is sent and the receiving unit performs emergency actions.

History page

The History page is used to view a log of received messages. Calls received from parallel
consoles are included in the log. The history page is also used to place calls. Status, group and
call color coding is supported. Click and drag column headings to rearrange column order.
Messages can be sent to an ID in the history list. Items in the history list can not be removed.
When C-Soft Runtime is closed all call history is cleared.

For more information, refer to “Per Line Call History Window Lines Window Field” on “Per
Line Call History Window Lines Field”.

Note:

— Received messages also appear on the line’s select button while receiving a call and in
the Per Line Call History window, refer to “Per Line Call History Window” on page 314.

—  MDC-1200 call history can also be found on the Per Line Call History window.
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Figure 31.39: History Page - MDC Dispatching Window

To place a select call from the History page, do the following:

1. From the history log, select a unit ID entry in the history log.
2. Click Select Call.

The call is sent.

For more calling options, refer to “Selected Items Page” on MDC-1200 Dispatching window,
page 294.

Date column
The Date column displays the date the message was received.

Time column
The Time column displays the time the message was received.

Channel column
The Channel column displays the frequency the message was sent on.

Call Type column
The Call Type column displays the type of message received.

There are seven call type possibilities:

- Call Alert Type

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



302 en | Ul Element Functions configuration C-Soft 7.700

Call Alert indicates an alert message was received from an MDC-1200 radio. When a call alert
message is received, all alerts and the caller’s alias or ID appears on the receiving line’s
button. If annunciations are configured, they are played when an alert is received. Refer to
“Annunciation of Call Alert Group Box” on page 341.

- Emergency Type
Emergency indicates an emergency message was received from an MDC-1200 radio.

—  Group Call Type

Group Call indicates a group call was received from an MDC-1200 radio. When a group call is
received, the group call initiator’s ANI or ID appear on the receiving line’s select button. If
annunciations are configured, they are heard when a group call is received. Refer to
“Annunciation of Select Call Group Box” on page 339.

-  Select Call Type

Select Call indicates a select call was received from an MDC-1200 radio. When an individual
call is received, the caller’s ANI or ID appears on the receiving line’s select button. If
annunciations are configured, they are heard when a select call is received. Refer to
“Annunciation of Select Call Group Box” on page 339.

-  Status Type

Status indicates a status message was received from an MDC-1200 radio. When a status
message is selected, the alias or ID appears in the Calling ID field and a status message
appears in the Status message field.

- Txt msg Type

Txt msg (Text Message) indicates a text message was received from an MDC-1200 radio. When
a text message is selected, the alias or ID appear in the Calling ID field and the text message
appears in the Test Message field.

- Voice Type
Voice indicates a voice message was received from an MDC-1200 radio. If available, the ANI
displays on the receiving line’s select button, otherwise the ID appears.

Call Details group box
The Call Details group box gives information about a selected item in the history list.

Calling ID
The Calling ID is the alias or ID number of the MDC-1200 radio that sent the selected
message.

Status Message field
The Status Message field is used to display the status message received by the selected
message.

If a text message appears in the field, the label changes to Text Message.

Text Message field
The Text Message field is used to display the text message received by the selected message.
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If a status message appears in the field, the label changes to Status Message.
Call History View group box
All Lines radio button
The All Lines radio button indicates the history list displays all messages received on all lines.
Selected Line radio button
The Selected Line radio button indicates the history list displays messages received on
selected lines in the system.
Refer to
- MDC-1200 Dispatching window, page 294
31.46 Monitor
The Monitor function allows the console operator to send a packet burst, similar to a
frequency change, to a remote radio, instructing the radio to open squelch or ignore CTCSS
tones.
To add a monitor button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Monitor.
5. Click OK.
The button changes color and MON appears on the button.
31.47 MOTOTRBO Radio Setup page

When the MOTOTRBO function is selected from the Ul Element drop down menu, the
MOTOTRBO Radio Setup window appears.

Notice!
Each line controlling either a MTRBi or MOTOTRBO requires its own window.

The MOTOTRBO Radio Setup page, shown in the Figure below, is used for setting Dispatch
Window features and entering time intervals to check for the Master Console.
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Figure 31.40: MOTOTRBO Radio Setup Page Example
MOTOTRBO Dispatch Window Setup group box

Enable MOTOTRBO Dispatch Window check box

The Enable MOTOTRBO Dispatch Window check box, if selected, allows the user to open the
Dispatch Window in Runtime. If not selected, the user is not able to open the Dispatch
Window in Runtime.

Dispatch Window Config button
The Dispatch Window Config button is used to open the Dispatch Window settings. The
button text and color of the Dispatch Window can be updated in this view.

For more information on Dispatch Window Config button, refer to the Figure below.

MOTOTRBO Radio List Font Size field
The MOTOTRBO Radio List Font Size field is used to enter the font size of the ID List.

Text Message RX Button Blink Color drop down palette

The Text Message TX Button Blink Color drop down palette is used to select the color that
the MOTOTRBO Dispatch Window button blinks when a text message is received. The button
will not blink if the MOTOTRBO Dispatch Window’s Text Message tab is already open.

MOTOTRBO Timing group box

Master Heartbeat Send Time field
The Master Heartbeat Send Time field is used to enter an interval for the master console to
send its heartbeat out to all other consoles on the control line (i.e., 1).

The range for this field is 1 to 999 seconds.
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The default is 1.

MTRBI Check Send Time field
The MTRBi Check Send Time field is used to enter an interval for C-Soft to verify the MTRBI
on a certain line is alive (i.e., 4).

Note:
-  Allow one second for the check function to complete.
—  This function is only available when MTRBi is selected on the MOTOTRBO Setup tab.

EXAMPLE: If this field is set to four seconds, the console sends an MTRBi check command
then waits for four minus one second, or three seconds for a response.

The range for this field is 2 to 999 seconds.
The default is 4.

Slave Check Time field
The Slave Check Time field is used to enter an interval for the console to wait to receive a
heartbeat from the master before it changes into the master. (i.e., 4)

EXAMPLE: At startup, the console waits four seconds for a heartbeat, if nothing is received,
the console changes to the master console. If a heartbeat is detected, the console remains a
slave and resets to four seconds.

The range for this field is 3 to 999 seconds.
The default is 4.

Master Resend Command Time field
The Master Resend Command Time field is used to enter an interval for C-Soft to resend a
MOTOTRBO command (i.e., 1).

EXAMPLE: If C-Soft sends a MOTOTRBO command and does not get a response in one
second, it sends the command again, waits one second, if nothing sends again, waits one
second. If no response is received after three tries the command is cleared and goes to the
next command to send to the buffer. The maximum tries is three.

The range for this field is 1 to 999 seconds.
The default is 1.

PTT Hangtime field

The PTT Hangtime field is used to enter the amount of time C-Soft waits before sending the
end of call command to the MTRBI. This delay allows the IP-224 to finish processing the
outgoing audio before the mobile stops transmitting.

The value entered in this field is multiplied by 20ms to calculate the total delay. This value
should match the Packet Delay Before Playback field in the Ethernet Setup section of the
IP-223 technical manual and the IP-224 technical manual.
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3147.1

The range for this field is 0 to 99 x 20ms.
EXAMPLE: A value of 10 delays sending the end of call command by 200ms.

This feature is only enabled when MTRBI is selected from the MOTOTRBO Setup tab in
Signaling Setup.

Password Protection group box

The Password Protection group box enables the user to set up functions that require a user
password before allowing the user access.

If not selected, no password is required.

Radio Monitor check box
The Radio Monitor check box indicates the user must enter a password to use these
functions.

Radio Inhibit/Uninhibit check box
The Radio Inhibit/Uninhibit check box indicates the user must enter a password to use the
function.

Call Alert check box
The Call Alert check box indicates the user must enter a password to use the function.

MOTOTRBO Misc group box
Talk Permit Tones check box

The Talk Permit Tones check box, if selected, enables the user to hear go ahead Tones when
PTT is pressed in Runtime.

Channel Alias Read check box
The Channel Alias Read check box indicates the channel’s aliases are read automatically from
the mobile radio.

This feature is only enabled when MOTOTRBO is selected from the MOTOTRBO Setup tab in
the Signaling Setup Window.

Dispatch Window
The Dispatch Window, shown in the Figure below, is used to select the color, font and font
size of the Dispatch Window settings.
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Dispatch Window Color: | I— |'| -
Dispatch Window Faont: Set Font

Main Control | Unit Control | Text Message I Historyl

Figure 31.41: Dispatch Window Example

Dispatch Window Color drop down menu

The Dispatch Window Color drop down menu is used to select the color of the Dispatch
Window.

To select the color of the Dispatch Window, do the following:
—  From the Dispatch Window Color drop down menu, select the desired color for the
dispatch window.

Set Font button
The Set Font button opens the Font window.

Dispatch Window Color: | -

Dispatch Window Font: Set Font

Main Control

Font style:
Bold Italic

Arial monospacec| |

Arno Pro : -
Arno Pro Caption ;
Arno Pro Display - | |Black Obligue ™

Sample

AaBbYyZz

Figure 31.42: Dispatch Window Font Drop Down Menu

To set the font of the Dispatch Window, do the following:
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- From the Font window, select the desired font for your text.

Main Control Page

The Main Control page, shown in the Figure “Dispatch Window Example” on Dispatch
Window, page 306, is used to change the color, font type, and font size for the following
buttons:

- InPTT

- Private Call

- Group Call

- Mute

- Select

- Numerical Pad

—  Delete

Select Color and Text

Buttan Colar Up:

Button Color Down:

Button Text Calor:
Enable Button

Button Text: InPFTT

QK ] [ Cancel

Figure 31.43: Select Color and Text

Button Color Up drop down menu
The Button Color Up drop down menu is used to select the color of the button as it is
released.

Button Color Down drop down denu
The Button Color Down drop down menu is used to select the color of the button as it is
pressed.

Button Text Color drop down menu
The Button Text Color drop down menu is used to select a color for the button text.

Enable Button check box
The Enable Button check box is used to enable the button in C-Soft Runtime. If disabled, the
button’s operation is not available.

Button Text field
The Button Text field is used to add text to the button.
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OK button
The OK button is used to accept the changes to the button.

Cancel button
The Cancel button is used to discard any changes to the button.

To select color and text of the desired button, do the following:

1. From the Main Control menu, press the desired button.

Select Color and Text appears.

From the Button Color Up drop down menu, select the desired color.
From the Button Color Down drop down menu, select the desired color.
From the Button Text Color drop down menu, select the desired color.
Select the Enable Button check box to enable the button’s functionality in C-Soft
Runtime.

6. In the Button Text field, enter the desired text for the button.

7. Click OK.

The entries are saved.

orwbd

Unit Control Page
The Unit Control page, shown in Figure below is used to change the color, font type, and font
size for the following buttons:

' M
Dispatch Window ]

Depstch Widow Font

Main Control | Unit Control ]Textnemage History |

Figure 31.44: Unit Control Page Example

Radio Check button
The Radio Check button is used to select the color of the button and text of the Radio Check
button.

Remote Monitor button
The Remote Monitor button is used to select the color of the button and text of the Remote
Monitor button.
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Call Alert button
The Call Alert button is used to select the color of the button and text of the Call Alert button.

Radio Disable button
The Radio Disable button is used to select the color of the button and text of the Radio
Disable button.

Radio Enable button
The Radio Enable button is used to select the color of the button and text of the Radio Enable
button.

GPS Trigger On button
The GPS Trigger On button is used to select the color of the button and text of the GPS
Trigger On button.

GPS Read button
The GPS Read button is used to select the color of the button and text of the GPS Read
button.

GPS Trigger Off button
The GPS Trigger Off button is used to select the color of the button and text of the GPS
Trigger Off button.

Keypad
The Keypad buttons are used to select the color of the buttons and text of the Keypad
buttons.

To select color and text of the desired button, do the following:

1.  From the Unit Control window, select the desired button.

Select Color and Text appears.

From the Button Color Up drop down menu, select the desired color.

From the Button Color Down drop down menu, select the desired color.

From the Button Text Color drop down menu, select the desired color.

Select the Enable Button check box to enable the selected color and text of the button.
In the Button Text field, enter the desired text for the button.

Click OK.

The entries are saved.

No ok on

Text Message page
The Text Message page, shown in the Figure below, is used to select the color of the button
and text of the text message.
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Dispatch Window Color: | — |'| -
Dispatch Window Font: Set Font

| Main Control | Unit Control | Text Message | History |

Figure 31.45: Text Message Page Example

Clear History button
The Clear History button is used to select the color of the button and text of the Clear History
button.

Send Unit Text button
The Send Unit Text button is used to select the color of the button and text of the Send Unit
Text button.

Send Group Text button
The Send Group Text button is used to select color of the button and text of the Send Group
Text button.

To select color and text of the desired button, do the following:

1. From the Text Message menu, press the desired button.

Select Color and Text appears.

From the Button Color Up drop down menu, select the desired color.

From the Button Color Down drop down menu, select the desired color.

From the Button Text Color drop down menu, select the desired color.

Select the Enable Button check box to enable the selected color and text of the button.
In the Button Text field, enter the desired text for the button.

. Click OK.

The entries are saved.

Noor~DN

History page
The History Message page, shown in the Figure below, is used to change the color, font type,
and font size for the following buttons:
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Dispatch Window Color: |*'| -
Dispatch Window Font: Set Font

Main Contral | Unit Control | Text Message| History I

Figure 31.46: History Message Page Example

Private Call button
The Private Call button is used to select the color of the button and text of the Private Call
button.

To select color and text of the desired button, do the following:

1. From the History menu press the desired button.

Select Color and Text appears.

From the Button Color Up drop down menu, select the desired color.
From the Button Color Down drop down menu, select the desired color.
From the Button Text Color drop down menu, select the desired color.

S S

In the Private text field, enter the desired text to be displayed when a call from an

individual is selected.

6. In the Group Text field, enter the desired text to be displayed when a call from a group is
selected.

7. Click OK.

The entries are saved.

Notice!
The Private Call Button uses the Enable Button setting from the DFSI Window’s Main Control
tab’s Private Call and Group Call buttons.

31.47.2

MOTOTRBO Dispatching window

The MOTOTRBO Dispatching window, shown in the Figure below, is used by the console
operator in C-Soft Runtime to manage a MOTOTRBO line’s call history, channel changes, send
text messages and alerts, read GPS coordinates and read remote radio positions. Volume
adjustments, radio checks, and radio enable/disable are also conducted from this window.
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During operation, all parallel consoles on the same network synchronize to each other.
Consoles on the same network display the same channel and zone, received ID, alias, history
and notifications.

Each line controlling a MTRBi (MOTOTRBO) or MOTOTRBO Interface requires its own window.

To add a MOTOTRBO button, do the following:

1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4. From the Ul Element drop down menu, select MOTOTRBO.
The MOTOTRBO Radio Setup page appears.

5. In the Master Heartbeat Sent time field, enter a time interval to send a heartbeat.

6. Inthe MTRBi Check Send Time field, enter a time interval to check MTRBi status.

7. In the Slave Check Time field, enter the amount of time C-Soft waits before changing to
the master console.

8. In the Master Resend Command Time field, enter the amount of time C-Soft waits before
resending a command.

9. From the MOTOTRBO drop down menu, select a background color for the window.

10. Click OK.

The MOTOTRBO button is added to the console.

Main Control page
The MOTOTRBO window displays the most frequently used MOTOTRBO fields.

The drop down menu selections are set up in C-Soft Designer and the MOTOTRBO radio
programming software.
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Trbo [x]
Main Control | Unit Control | Text Message | History

Keypad: [

ID: | 3 ID List: [

PTT Buttons: J atll
QR

Common Buttons:
Status Information:  Establishing Connection... [ ]

Figure 31.47: MOTOTRBO Dispatching Window

Channel drop down menu

The Channel drop down menu is used to change the channel of the selected line. If a parallel
console or the radio changes the channel, this field updates with the current channel
information.

Available selections for this field are configured in the radio.

Zone drop down menu
The Zone drop down menu is used to change the zone of the selected line. If a parallel
console or the radio changes the zone, this field updates with the current zone information.

Available selections for this field are configured in the radio.

Volume Slider

The Volume Slider is used to increase or decrease the volume to the speaker or handset
currently connected. The volume indicator gives a graphical representation of the total
volume.

Notice!
MOTOTRBO is compatible with the ADHB-4 which can also be used to adjust volume.

Trbo Ptt button
The Trbo Ptt button is used the same as a normal key up of a mobile radio.
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Private Call button
The Private Call button is used to select what is entered in the ID field for a private call.

Group Call button
The Group Call button is used to select what is entered in the ID field for a group call.

Mute button
The Mute button is used to mute or amplify the selected line’s volume. If the console speaker
is muted, the universal no symbol appears on the speaker icon.

Select button
The Select button is used to select or deselect the MOTOTRBO Line.

Status Information field
The Status Information field displays all incoming and outgoing MOTOTRBO radio status
information.

MOTOTRBO Connection Indicator

The MOTOTRBO Connection Indicator indicates the status of the connection to the
MOTOTRBO currently displayed in the MOTOTRBO window. If green, the unit is online and
functional. If red, the unit is offline or disconnected.

Unit Control page

When the Unit Control tab is clicked from the MOTOTRBO window, the Control Buttons page
appears. The Unit Control page is used to access MOTOTRBO functions. When a radio is
selected in the ID field, a button can be clicked to perform an action.
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Test Rack MOTO: Freg 1 (x]
Main Control Unit Control | Text Message | History

Status Information: ~ Channel Lipdate (]

Figure 31.48: MOTOTRBO Window - Unit Control

Radio Check button
The Radio Check button is used to verify if the target radio is currently online and functional.

Radio Disable button
The Radio Disable button is used to disable a target radio from use. This feature can be used
in the case of a lost or stolen radio.

Radio Enable button
The Radio Enable button is used to enable the target radio for use. This feature is used to
enable a radio if it has been disabled with the Radio Disable button.

Remote Monitor button
The Remote Monitor button is used to monitor the target remote radio.

Call Alert button
The Call Alert button is used to send an alert to the target remote radio.

GPS Read button
The GPS Read button is used to request a read of the selected radio’s current location and
navigate to the radio’s location on Google Earth.

GPS Trigger On button
The GPS Trigger On button is used to enable the GPS to send status at a regular interval to
the console. The interval is determined by the value entered in the GPS Trigger On field.
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GPS Trigger Off button
The GPS Trigger Off button is used to disable the radio from periodic GPS coordinate updates
status to the console.

GPS Trigger On field
The GPS Trigger On field is used to configure the interval with which the selected radio sends
a GPS location to the console.

Available options for this field are: 30 sec, 1 min, 4 min, 8 min, 10 min, 20 min, and 30 min.

Text Message page
When the Text Message tab is clicked the Text Message page appears. Refer to the Figure on
441.

The Text Message page is used to send text messages to the selected individual or a group of
radios and to view text messages sent and received during the current C-Soft Runtime
session.

Radio Name column
The Radio Name column displays the name assigned to the radio the text message was sent or
received.

Time column
The Time column displays the time the text message was sent or received.

Text Message column
The Text Message column displays the text message sent to or received from the radio.

Quick Text drop down menu

The Quick Text drop down menu is used to select a text ID number assigned to a
preprogrammed text message. When a text ID is selected, its message appears in the Text
field.

Text field

The Text field displays a preview of the text message to be sent when Send Text is clicked. A
text message can be entered using the Quick Text drop down menu or it can be entered
manually.

This field can contain up to 100 characters.

Send Unit Text button
The Send Unit Text button is used to send the message in the Text field to the selected radio.
When clicked, the message is sent to the radio.

To send a text message, do the following:
1. Inthe Text field, enter a text message to send.
OR
From the Quick Text drop down menu, select a Text ID.
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2. From the ID drop down menu, select an individual to send the text message to.
OR
From the ID drop down menu, select a group to send the text message to.
3. Click Send Unit Text.
The text message is sent to the selected user.
OR
Click Send Group Text.
The text message is sent to the selected group.

Clear History button
The Clear History button is used to clear all text messages in the list.

To clear text message history, do the following:

—  Click Clear History.

The text message history list is deleted.

History page

The History page appears when MOTOTRBO window is maximized. The History page is global
for all MOTOTRBO lines. All MOTOTRBO active and previous calls appear in the list. Each call’s
radio name, radio ID, date, time, call type, and the call’s current state appear.

Notice!
When C-Soft Runtime is closed, this list is cleared.

Date column
The Date column displays the date the call was received.

Time column
The Time column displays the time the call was received.

Freq column
The Freq column displays the frequency the call came from.

Status column
The Status column displays the current status of the call.

Available options for this field are Mobile PTT, In Progress, Call RX., GPS Position, On, Off,
Passed and Failed.

User ID column
The User ID column displays the caller’s user ID.

Call Type column
The Call Type column displays the type of call.
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31.48

Available options for this field are Private, Group, Alert, Enable, Disable, Check, Scan, Monitor
and GPS Read.

Private Call button
The Private Call button is used to initiate a private call to the User ID displayed in the
selected entry’s User ID column.

Mute Group

The Mute Group function allows the console operator to mute the audio on a pre-defined
group of lines.

Line Group page
When the Mute Group function is selected from the Ul Element drop down menu, the Line
Group page appears. Refer to the Figure below.

Notice!
The Line Group page is used to select the lines that belong to a specific Mute Group.

Select Lines for Group:

5:16kb Vocoder
&:Supervisor Line
7-Mot Enabled-
S:-Mot Enabled-
10:-Mot Enabled-

11:-Mot Enabled- 7

Figure 31.49: Line Group Page - Ul Element Setup

Select Lines for Group field
The Select Lines for Group field contains a list of all the lines configured on the “Per Line
Parameters window, page 61”. Selecting a line from this list, assigns the line to the group.

Click the Group Programmed button in the C-Soft Runtime program to place the lines defined
on the Line Group page into a select condition.

To add a Mute Group button, do the following:
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1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Mute Group.
The Line Group tab appears.
5. Click the Line Group tab.
The Line Group page appears.
6. From the Select Line for Group field, select the line(s) you want to add to the group.
7. Click OK.
The selected lines are assigned to the group. The button color changes and Mute Group
appears on the button.

Notice!
Deselect the highlighted line, to remove a line from the Mute Group List.

31.49

Refer to
- Per Line Parameters window, page 61

Mute Main

The Mute Main function allows the console operator to mute all lines not currently selected.

Notice!
Selected lines can also be muted when the Allow Muting Selected Lines option is selected on
the Global Parameters page. Refer to “Global Parameter Setup window, page 114”.

To add a Mute Main button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Mute Main.
5. Click OK.
The button changes color and Mute appears on the button.

Refer to
—  Global Parameter Setup window, page 114
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31.50 Mute-Per Line
The Mute-Per Line function allows the console operator to mute a particular line. It is a toggle
button that is active when clicked and inactive when released.
Mute Icon
A Mute Icon, shown in the Figure below, appears on a line’s Select button, a group select
button, a phone onhook/offhook button, a SIP button or a NENA indication anytime the line is
muted, RX blocked, or group muted.
This icon can be customized by selecting an image for the Mute icon in the Button Images
window, page 141.
Figure 31.50: Mute Icon - Select Button
31.50.1 Per Line Mute Button Setup page

When the Mute - Per Line function is selected from the Ul Element drop down menu, as shown
in the Figure below, the Per Line Mute Button Setup page appears.

The Per Line Mute Button setup tab is used to set the Mute Time and Minimum Mute Level.

Mute Time: 0! geC

Min Mute Level: 0 dB

Figure 31.51: Per Line Mute Button Setup Page - Ul Element Setup

Mute Time field
The Mute Time field identifies the duration audio is muted before the audio is automatically
restored. A value of zero disables this feature.

The range for this field is 0 to 180 seconds.

Min Mute Level field

The Min Mute Level field identifies the level the unselected audio level is reduced at the
speaker. Enter a value from -20 to -1dB to reduce the level on the muted line accordingly
without completely muting the line. This ensures the console operator is unable to completely
turn off audio being monitored. A value of zero completely mutes the line.
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The range for this field is -20 to -1dB.

Notice!
Selected lines can also be muted when the Allow Muting Selected Lines option is selected on
the Global Parameters page. Refer to “Global Parameter Setup window, page 114”.

To add a Mute-Per Line button, do the following:

1.

8.
9.

From the Insert menu, select Add Ul Button.

A None button appears on the console window.

Right-click the None button.

A shortcut menu appears.

From the shortcut menu, select Properties.

The Ul Element Setup window appears.

From the Ul Element drop down menu, select Mute - Per Line.

The Line to Associate Function With drop down menu becomes active. The Per Line Mute
Button Setup tab appears.

From the Line to Associate Function With drop down menu, select the line you want to
associate with the Mute - Per Line function.

Click the Per Line Mute Button Setup tab.

The Per Line Mute Button Setup page appears.

In the Mute Time field, enter the amount of time the line is muted before audio is
automatically restored.

In the Min Mute Level field, enter the audio level for the unselected line.

Click OK.

The button changes color and Mute appears on the button.

31.51 P25-DFSI window

The P25-DFSI window allows the console operator to open the P25-DFSI Dispatching window.

P25-DFSI Misc page
When the P25-DFSI function is selected from the Ul Element drop down menu, the P25-DFSI
Misc page appears. Refer to the Figure below.
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| Type | Colors | P25-DF5I1 Misc

Receive Al Talk Groups Dizpatch Window Config

Receive All Private Calls
F25-DF5] Radio List Font Size: 12

Password Protection

[T Radio Manitor

[ Radio Inhibit/Uninhibit
[ Call Alert

[ Vote Select/Disable

Figure 31.52: P25-DFSI Misc - Ul Element Setup
Misc group box

Enable P25-DFSI Dispatch Window check box

The Enable P25-DFSI Dispatch Window check box gives the user to open the Dispatch
Window in Runtime. If not selected, the user is not able to open the Dispatch Window in
Runtime.

Receive All Talk Groups check box

The Receive All Talk Groups check box indicates all incoming Talk Groups can be heard. If not
selected, only incoming calls with Talk Groups matching the current Talk Group will be heard,
all others are muted.

Receive All Private Calls check box

The Receive All Private Calls check box indicates all incoming Private Calls can be heard. If
not selected, only incoming Private Calls sent directly to the console will be heard, all others
are muted.

P25-DFSI Radio List Font Size field
The P25-DFSI Radio List Font Size field is used to select a font size for the P25-DFSI Radio
List.

The range for this field is 0 to 99.
The default is 12.
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31.52

Dispatch Window Config button

The Dispatch Window Config button is used to open the Dispatch Window settings. The
button text and color of the Dispatch Window can be updated in this view. For more
information, refer to “Appendix E - P25-DFS/ (Digital Fixed Station Interface), page 479”.

Password Protection group box
The Password Protection group box enables the user to set up functions that require a user
password before allowing the user access.

If not selected, no password is required.

Radio Monitor check box
The Radio Monitor check box, if enabled, indicates the Radio Monitor function is password
protected.

For more information, refer to “Global Parameter Setup window, page 114”.

Radio Inhibit/Uninhibit check box
The Radio Inhibit/Uninhibit check box, if enabled, indicates the Radio Inhibit/Uninhibit
function is password protected.

For more information, refer to “Global Parameter Setup window, page 114”.

Call Alert check box
The Call Alert check box, if enabled, indicates the Call Alert function is password protected.

For more information, refer to “Global Parameter Setup window, page 114”.

Vote Select/Disable check box
The Vote Select/Disable check box, if enabled, indicates the Vote Select/Disable function is
password protected.

For more information, refer to “Global Parameter Setup window, page 114”.

OK button
The OK button saves the entries and closes the window.

Page

The Page function allows the console operator to send a single page to a specific line on a
specific frequency.

Page Setup page
When the Page function is selected from the Ul Element drop down menu, the Page Setup
page appears. Refer to the Figure below.
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Ul Element Setup >

Type Colors Fage Setup

Page Setup Relay Setup
Format: = 1:PageFormat 1~ [] Activate Relay With Page
Relay Destination
F - 1:Freg1 w
requency =4 ADHB4 () NEO
Talk Time: [0 | ms ADHB4 Setiings
Page String Mone Relay1 Relay?
Page String: | NED Settings
[] Use Manual Cap Code Entry P:] 0.0 .0 .0 Relay:  Mone

) . Tanon
[]5end on Selected {not steered) Active Duration: | LU0 | ms

Figure 31.53: Page Setup Page - Ul Element Setup
Page Setup group box

Format drop down menu
The Format drop down menu is used to select the desired pager. This field contains all the
pagers defined for the line in the “Paging Settings window, page 149”.

Frequency drop down menu
The Frequency drop down menu is used to select the frequency for the page. This field
contains all of the frequencies defined for “Freqs Button”.

Talk Time field
The Talk Time field is used to enter the amount of time, in ms, allowed for the console
operator to add a voice message to a page after the page has been sent.

The range for this field is 0 to 32000ms.

Page String field
The Page String field is used to enter the page string specific to the pager selected in the
format field.

This field can contain up to 35 characters.

Use Manual Cap Code Entry check box
The Use Manual Cap Code Entry check box indicates a page string is manually entered by the
user in Runtime, instead of using the predefined page string entered in the Page String field.
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Notice!
Selecting this option disables the Page String field.

In C-Soft Runtime, when the page button is clicked, the Manual Paging Entry window appears.
The user enters the number to page and clicks Send Page.

Page String: | 1248

Figure 31.54: Manual Page Entry Window

Send on Selected (not steered) check box
The Send on Selected (not steered) check box indicates the page is sent to the selected line
or the unselected line. Otherwise, the page is sent to the line configured for the page button.

Relay Setup group box

Active Relay With Page check box
The Active Relay With Page check box indicates a configured relay activates when a page is
sent.

Relay Destination group box
The Relay Destination radio buttons identify the relay to be controlled. When a selection is
made, the fields necessary to enter the setup information for the relay are enabled.

ADHB-4 Settings group box
The ADHB-4 Settings radio buttons identify which ADHB-4 relay is activated when the page is
sent.

None radio button
The None radio button indicates none of the ADHB-4 relays is activated.
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Relay 1 radio button
The Relay1 radio button indicates the first relay in the ADHB-4 is being controlled.

Relay 2 radio button
The Relay 2 radio button indicates the second relay in the ADHB-4 is being controlled.

NEO Settings group box
The NEO Settings field identifies the IP Address and the relay, if any, for the NEO-10.

IP field

Relay drop down menu
The Relay drop down menu is used to select the desired relay.

Available selections for this field are None, Port 1, Port 2, Port 3, Port 4, Port 5, Port 6, Port 7,
Port 8, Port 9 and Port 10.

Active Duration field
The Active Duration field is used to enter the length of time, in ms, the relay remains active
from the start of the Annunciation.

The range for this field is 300-3000ms.

To add a Page button, do the following:

1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4.  From the Ul Element drop down menu, select Page.
The Line to Associate Function With drop down menu becomes active. The Page Setup
tab appears.

5.  From the Line to Associate Function With drop down menu, select the line you want to
associate with the Page function.

6. Click the Page Setup tab.
The Page Setup page appears.

7. From the Format drop down menu, select the type of pager being used.

8. From the Frequency drop down menu, select the frequency for the pager.

9. Inthe Talk Time field, enter the amount of time allowed for the console operator to add a
voice message to the page.

10. In the Page String field, enter the page string or code specific to the pager.

11. Select the Send on Selected (not steered) check box, if desired.

12. Click OK.

The button changes color and Page appears on the button.
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31.53

31.54

31.54.1

Page Cancel

The Page Cancel function is used to cancel the transmission of one or more pages while the
pages are being sent.

If the Manually Confirm When Pages Are Done Sending check box is selected (“Paging
Settings window, page 149”), the Page Cancel button clears the Paging Done icons from all
paging buttons.

Figure 31.55: Paging Button

Note:

— These icons can be customized by using the Button Images window, page 141.

— If you do not want to use one of the icons, you must make a 1 pixel bmp file and call it
out properly (see above). If you delete the .bmp file, the C-Soft Runtime uses the default
icons.

Refer to
—  Paging Settings window, page 149

Page Manual Entry

The Page Manual Entry function allows the incorporation of up to five single tones in
sequence for a specific line.

Manual Page Setup

When the Page Manual Entry function is selected from the Ul Element drop down menu, the
Manual Page Setup page appears. Refer to the Figure below.
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Ul Elernent Setup #

Type Colors Manual Page Setup
Page Setup Relay Setup

Initial Page Delay: ms [] Activate Relay With Page
Inter-Fage Delay: ms Relay Destination

ADHE-4 NED
Frequency: | 1:Freq 1 W

Tone Level: dB ADHBH-tll:li:ttlngs Relay
Tone 1: |4[|'D |Hz |33'|] |rns

Tone 2: |3‘D'DI |Hz |33'D' |ms
Tone 3: |1DD|]' |Hz |33!'|:II |ms
Tone 4: |'U |Hz |ﬂ' |ms Active Duration: | 2000 ms
Tone 5: |'U' |Hz |ﬂ' |ms

Relay2

MED Settings
P:1 0.0 .0.0 Relay: | Mone

Page Generation Options

Talk Time: ms
Page Tone teration Count:
Send on Selected (not steered)

Figure 31.56: Manual Page Setup Page - Ul Element Setup

Initial Lead-In Delay field
The Initial Lead-in Delay field identifies the amount of time to use for the lead-in delay.

The range for this field is 0 to 20000ms.

Frequency drop down menu
The Frequency drop down menu identifies the frequency to send the page on. This field
contains all of the frequencies defined for the line in “Freqs Button”.

Tone Level field
The Tone Level field identifies the audio level of the tone.

The range for this field is -60 to 10dB.

Tone (1-5) fields
The Tone (1-5) fields identify the frequency for the tone.

The range for this field is 0 to 3000Hz.

Tone (1-5) Level fields
The Tone (1-5) Level fields identify the length for the tone.

The range for this field is 0 to 65000ms.
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Talk Time field
The Talk Time field identifies the maximum amount of time, allowed for talk time.

The range for this field is 0 to 65000ms.

Send on Selected (not steered) check box
The Send on Selected (not steered) check box indicates the page is sent to the selected line.
Otherwise, the page is sent to the line configured for the page button.

Relay Setup group box

Active Relay With Annunciation check box
The Active Relay With Annunciation check box indicates a configured relay activates when an
Page is sent.

Relay Destination group box
The Relay Destination radio buttons identify the relay to be controlled. When a selection is
made, the fields necessary to enter the setup information for the relay are enabled.

ADHB-4 Settings group box
The ADHB-4 Settings radio buttons identify which ADHB-4 relay to activate when the page is
sent.

None radio button
The None radio button indicates none of the ADHB-4 relays is activated when sending a page.

Relay 1 radio button
The Relay1 radio button indicates the first relay in the ADHB-4 is being controlled.

Relay 2 radio button
The Relay 2 radio button indicates the second relay in the ADHB-4 is being controlled.

NEO Settings group box
The NEO Settings field identifies the IP Address and the relay, if any, for the NEO-10.

IP field
The IP field identifies the IP Address of the NEO-10.

Relay drop down menu
The Relay drop down menu is used to select the desired relay.

Available selections for this field are None, Port 1, Port 2, Port 3, Port 4, Port 5, Port 6, Port 7,
Port 8, Port 9 and Port 10.

Active Duration field
The Active Duration field is used to enter the length of time, in ms, the relay remains active
from the start of the Annunciation.

The range for this field is 300-3000ms.
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31.55

Page Generation options

Page Tone Iteration Count field

The Page Tone Iteration Count field is used to determine the number of times the button’s
tone sequence is sent during the page and allows for tone sequences to be repeated a
specified number of times.

The range for this field is 1 - 100.
The default value for this field is 1.

To add a Manual Page button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Page-Manual Entry.
The Line to Associate Function With drop down menu becomes active. The Manual Page
Setup tab appears.
5. From the Line to Associate Function With drop down menu, select the line you want to
associate with the Manual Page function.
6. Click the Manual Page Setup tab.
The Manual Page Setup page appears.
7. In the Initial Lead in Delay field, enter the lead-in delay for the pager.
8. From the Frequency drop down menu, select the type of frequency for the pager.
9. Inthe Tone 1 through Tone 5 fields, enter the level and amount of time for each tone.
10. In the Talk Time field, enter the amount of time allowed for the console operator to add a
voice message to the page.
11. Select the Send on Selected (not steered) check box, if desired.
12. Click OK.
The button changes color and Page appears on the button.

Page Send

The Page Send function allows a console operator to send a group of pages selected using the
Page Stack button. This option also works when the Always Stack Page Buttons check box is
selected, refer to “Always Stack Page Buttons Check Box” on “Always Stack Page Buttons
Check Box”.

In C-Soft Runtime, the console operator is notified when the last stacked page is sent. A voice
message can be sent to page recipients.

To add a Page Send button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
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4. From the Ul Element drop down menu, select Page Send.
5. Click OK.
The button changes color and Page Send appears on the button.

31.56 Page Stack
The Page Stack function allows the console operator to select the number of pages to be sent
in succession.
In C-Soft Runtime, after pressing the Page Stack button, the console operator can select
multiple Page buttons. Normally, a page is sent the moment the Page button is pressed, but
when the Page button is pressed after the Page Stack button, all selected pages are stacked
first and sent when the Page Send button is clicked.
Notice!
When the Page Send button is clicked, pages assigned to the same line number are sent in
the order they were selected, but pages assigned to different line numbers are sent in order
of ascending line number.
For example, when the Page Send button is pressed, pages that were selected in this order:
XYZ (line 5), XYY (line 5), XXY (line 4), ZZY (line 3) are sent in this order: ZZY (line 3), XXY (line
4), XYZ (line 5), XYY (line 5).

31.56.1 Page Stack Setup

When the Page Stack function is selected from the Ul Element drop down menu, a Page Stack
Setup page appears. Refer to the Figure below.

[T[iUnlatch stack button after page:

Figure 31.57: Options Page - Ul Element Setup

Unlatch stack button after page check box
The Unlatch stack button after page check box indicates the Page Stack button automatically
unlatches (toggle off) after pages are sent.

To add a Page Stack button, do the following:
1. From the Insert menu, select Add Ul Button.

A None button appears on the console window.
2. Right-click the None button.

A shortcut menu appears.
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3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Page Stack.
The Option tab appears.
5. Click the Options tab.
The Options page appears.
6. Select the Unlatch stack button after page check box to automatically unlatch after the
pages are sent, if desired.
7. Click OK.
The button changes color and Stack Pages appears on the button.
31.57 Page Stack Programmed
The Page Stack Programmed function creates a button used to select a pre-defined group of
pages. While in C-Soft Runtime, clicking the Page Stacked Programmed button causes the pre-
defined pages to be stacked.
Notice!
When the Page Send button is clicked, pages assigned to the same line number are sent in
the order they were selected, but pages assigned to different line numbers are sent in order
of ascending line number.
For example, when the Page Send button is pressed, pages that were selected in this order:
XYZ (line 5), XYY (line 5), XXY (line 4), ZZY (line 3) are sent in this order: ZZY (line 3), XXY (line
4), XYZ (line 5), XYY (line 5).
To send stacked pages, do the following:
1. From C-Soft Runtime, click the Page Stacked Programmed button.
The pages are stacked in the order defined in the Selected Pages list.
2. Click the Page Send button.
The Pages are sent.
31.57.1 Programmed Stack Setup page

When Pages Stack Programmed is selected from the drop down menu, the Programmed Stack
Setup page appears. Refer to the Figure below.

A maximum of 50 pages can be configured for a single Page Stack Programmed button.
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Type |D:|Iors Programmed Stack Setup ‘

All Pages Selected Pages

6:Engine 1 G:CAPT
&:Engine 1 Knox &:Engine 2 Knox
6:Engine 2 G:lnit &
&:Engine 3 Knox &:Ladder 2 Knox
6:K9

&:Ladder 1 Knox
LT

6:5GT1

6:5GT 2
G:SWAT

&:Unit 1

6:Unit 2

&:Unit 3

&:Unit 4

&:Unit 5

&:Unit 7

Figure 31.58: Programmed Stack Setup - Ul Element Setup

All Pages field

The All Pages field displays all pages in the system. This list is used to select a page to add to
the Selected pages field.

Selected Pages field
The Selected Pages field displays pages selected for the stack. When the console operator
clicks the Page Stack Programmed button, a page is sent to members in this field.

Move Right button

The Arrow Right button [on ] is used to move pages from the All Pages field to the
Selected Pages field.

Move Left button

The Arrow Left button | ] is used to move pages from the Selected Pages field to the
All Pages field.

Move Up Button
The Move Up button is used to move the selected page up in the Selected Pages list.

Move Down Button

+
The Move Down button L is used to move the selected page down in the Selected Pages
list.
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31.58

To add a Page Stack Programmed button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Page Stack Programmed.
The Programmed Stack Setup tab appears.
5. Click the Programmed Stack Setup tab.
The Programmed Stack Setup page appears.
6. Select pages from the All Pages panel.
7. Click >>> to move them to the Selected Pages pane.
8. Click OK.
The button changes color and Page Send appears on the button.

Per Line Call History

The Per Line Call History function creates a button used to open a list of past calls received
on the associated line.

In C-Soft Runtime, the Per Line Call History window is used to view incoming calls, make
outgoing calls, and playback call audio based upon programming setup.

To add a Per Line Call History button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Per Line Call History.
5. From the Line to Associate Function With drop down menu, select the line to display call
history.
6. Click OK.
The color of the button changes and Per Line Call History appears on the button.

Per Line Call History Setup page

The Per Line Call History Setup window allows users to determine which columns are visible
in the Per Line Call History window. The respective columns display in the Per Line Call
History window if selected and hidden if not checked.
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Ul Element Setup et

Type Colors Per Line Call History Setup

Column Setup
Select the columns to be displayed:
Call Duration [] Line Mame
Caller ID Status
Comments Talkagroup
Time
[] Direction Iser 1D

Frequency

Column Setup group box

Call Duration check box
The Call Duration check box is used to add a Call Duration column to the Per Line Call History
window.

Caller ID check box
The Caller ID check box is used to add a Caller ID column to the Per Line Call History window.

Comments check box
The Comments check box is used to add a Comments column to the Per Line Call History
window.

Date check box
The Date check box is used to add a Date column to the Per Line Call History window.

Direction check box
The Direction check box is used to add a Direction column to the Per Line Call History
window.

Frequency check box
The Frequency check box is used to add a Frequency column to the Per Line Call History
window.

Line Name check box
The Line Name check box is used to add a Line Name column to the Per Line Call History
window.
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Status check box
The Status check box is used to add a Status column to the Per Line Call History window.

Talkgroup check box
The Talkgroup check box is used to add a Talkgroup column to the Per Line Call History
window.

Notice!
This field is only available when the associated line is configured for a P25-DFSI line.

31.58.1

Time check box
The Time check box is used to add a Time column to the Per Line Call History window.

User ID check box
The User ID check box is used to add a User ID column to the Per Line Call History window.

Per Line Call History window

The Per Line Call History window is used to view the associated line’s call history. Each entry
in the call history contains details regarding an individual call. Icons in the left column display
the current status of the call entry. The console operator can also send messages, statuses,
and alerts to the ID listed in the window by clicking a Call button at the bottom of the
window.

 Per Line Call Histo

Date Time: Freg Calling IDv User ID Status Dwretion Comments
< 10282014 10:0138  Group101  Group101  AaronEanes  GroupRX 0008 Saveforsupervsor
-’- 1042872014 09:53:55 Group 100 Aaron Eanes Sent Check 00:00 Verify Aaron's radio is receiving
104282014  10:03:05  Group 103 1332 Radio Check Ack 00:00
10/28/2014  10:03:00  Group 103 1332 Sent Check 00:00
) 10/28/2014  10:02:47  Group 103 Group 103 1332 Group RX 0008 Unit arrived on scene
E@ 100282014 10:02:07  Group 101 Aaron Eanes  Remote Monitor Ack oo
1042872014 10:02:06  Group 101 Aaron Eanes Sent Remote Monitor 00:00
Eﬂﬁ 1042872014 10:01:04 Group 103 Aaron Eanes Private RX 00:07
cli 10/282014  10:00:33  Group 103 1332 Private R 00:10
Polozezona 0905939 Group 103 Group 103 1332 Group RX 0008  Needto getunit to ‘I14th and Toledo.
‘ 10/28/2014  09:54:04  Group 100 Aaron Eanes Enable Radio Ack 00:00
1042872014 09:54:03 Group 100 Aaron Eanes Sent Enable 00:00
1042812014 09:54:02 Group 100 Aaron Eanes Disable Radio Ack 00:00
1042802014 09:54:01 Group 100 Aarcn Eanes Sent Disable 0000
1042812014 09:53:56 Group 100 Aaron Eanes Radic Check Ack 00:00
1042802014 09:53:26  Group 100 Aaron Eanes CallAlert 0000
| < tozeznie  0s:s256  Growp 101 Group101  AsronEanes  GrowpRX 0005
R’ﬁ' 10/28/2014  09:52:35  Group 100 Group 100 Aaron Eanes Group RX 0009

Figure 31.59: Per Line Call History Window - C-Soft Runtime
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Icon Status column
The Icon Status column displays an icon representative of the call entry state.

| The call entry is pinned. A pinned call entry is always located at the top of the call list
control and cannot be deleted until the call is unpinned.

<P

- The call entry contains audio that can be played.

The call entry contains audio that can be played and the call entry is pinned.

2 =

The call entry contains audio, but the line was muted when the call was received. The
un-muted audio can still be played.

2,

The call entry contains audio, but the line was muted when the call was received and
the call entry was pinned. The un-muted audio can still be played.

The audio for a call entry is currently being played.

v.v

The audio for a pinned call entry is currently being played.

Date column
The Date column displays the date of the call or operation.

Time column
The Time column displays the time of the call or operation.

Freq column
The Freq column displays the frequency of the call or operation.

Status column

The Status column displays additional call or operation information. For example, if a status
message is received, the Status column contains a Status Alias. If the entry represents an
outgoing Select Call, the Status column contains “Sent Select Call”.

User ID column
The User ID column displays the source User Alias/ID or Group Alias/ID of the call or
operation.

Calling ID Column
The Calling ID column displays the destination User Alias/ID or Group Alias/ID of the call or
operation.

Direction column
The Direction column displays the call or operation’s direction. Incoming calls or operations
display Rx and outgoing calls or operations display Tx.
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Duration column
The Duration column displays the duration of the recorded call audio.

Comments column
The Comments column displays comments from the user.

31.58.2 Per Line Call History window - 5/6 Tone line
The Status List window displays the status of a call. If the configured line is set to 5/6 Tone
DTMF ANI signaling, and one or more call formats have been configured in the Call Setup tab,
the Per Line Call History window displays the user defined call buttons as shown in the Figure

below.
r Line Call Hi
-
Date Time Freq Caling... U=erlD Status  Duration Commens

Status On a Call

Private Call Group Call Status Last Call

Calls Call7

Call10

i
o
7}
f
W
L

Figure 31.60: Per Line Call History Window: 5/6 Tone Line

Set Status button
The Set Status button is used to open the Status List window and select a status to send.
Refer to the Figure on “Status List window, page 236”.

To send a status ID from the Per Line Call History window in C-Soft Runtime, do the
following:
1. While in C-Soft Runtime, select the line you want to place the call from.
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10.

11.

Th

To
1.
2.
Th

Select a Per Line Call History button.

The Per Line Call History window appears.

From the ID Type drop down menu, select an alias or an ID number.

The selected User ID in the User List is highlighted.

Select Set Status.

The Status List window appears.

From the ID type drop down menu, select an alias or ID number to sort the list.

The list is sorted depending on the selected type.

From the Status drop down menu, select a status ID to send.

The selected status ID is highlighted.

OR

From the status ID list, select a status ID to send.

The selected status ID is highlighted.

Click Done.

If a password is required to send the status ID, the Password Entry window appears.
Using the keypad, enter the password.

For each character you enter, asterisks fill the empty field at the top of the window.
Click Enter.

The Password Entry window closes and the selected status’s alias appears in the Status
Message field or, if the password is incorrectly entered, an error message appears.
Click a Call button to place the call.

The message is sent and a confirmation or error message appears in the Dispatching
status bar.

Click Done.

e window closes.

open the Status List window, do the following:
Open a Per Line Call History window associated with a 5/6 Tone line.
Click the Set Status button.

e Status List window appears.

7

Status List
ID Type Status ID -
Status (90 -
Alias Status ID =
Revive 92
Kill 91
Resolved 88
Call Back 80
Send Status 70
Gone Home 6 -
l Cancel l l Done ]
|
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Notice!
The Status field is used only for 5/6 Tone/DTMF ANI Signaling.

31.58.3

Call (1-10) Buttons

The Call (1-10) buttons are used to place user-defined calls configured in the “5-6 Tone/DTMF
ANI system type, page 75”. For the call buttons panel to be enabled, the line must be
configured for 5/6 Tone DTMF Signaling, and at least one Call Format must be set up. The
labels used only for 5/6 Tone/DTMF ANI Setup page appear on these buttons in the Call List
window.

To place a call from the Per Line Call History window, do the following:
1. Selectan ID in the list.

Available call buttons on the bottom of the window become active.
2. Select a call button.
The call is placed.

Refer to
—  Status List window, page 236
- 5-6 Tone/DTMF ANI system type, page 75

IRR Playback Control window

Notice!

For the IRR Playback control to appear, the line must be configured for IRR Recording. If IRR
Recording is enabled on the line, the Per Line Call History Window will display the Audio
Playback Control.

Per Line Call History : Line 1
Date Time  Caling ID User D Status Duration Comments Q)
:’J‘ 0211212016 09:21:20 Group 1 Rob Stark Group Call 00:02
Pinned lcon ————— ® 02122016 091827 Groupi  Asron Eamst Fire 00:00 Fire reported 1207 P Street L Comment
P 02122016 091914  Group1  Asron Eamst Group Call 00:01
qﬁ 0211212016 09:19:07 Group 1 Rob Stark Group Call 00:05
) 021272016  0919:02  Groupt  Aaron Eamst Group Cal 00:05 Save for supervisor
) 021272016 0918:%  Group 1 Rob Stark Group Cal 00:05
Played lcon ———————— > o02/12/2016 09:18:50  Group 1 Asron Earnst Group Call 00:05
) 02122016 091843 Groupt  Aaron Eamst Group Cal 00:05 Unit arrived on scene.
<) 021272016 091837 Group 1 Rob Stark Group Cal 00:08
021212016 091833 Group 1 Rob Stark Lunch Break  00:00 Rob's break started 9:18
021272016 091820 Group1  Aaron Eamst Fire 00:00
02122016 091846 Group 1 Rob Stark Lunch Break  00:00
021212016 091800 Group1  Asron Earnst Fire 00:00
Audio Available lcon —————| <) 02122016 09:17:45  Group1  Asron Earnst Group Call 00:03
P 02122016 09:17:40  Group 1 Rob Stark Group Call 00:04
A ARMAANAE  ARATAE  Femin P — e—— nna b
< >
[ Media Timeline
Play/Stop Button m [ ~— )| [0000m0:05 ¢ Elapsed/Total Time
<<>> | L, Volume Slider
F— 1
Forward/Skip Button I ]

Figure 31.61: Per Line Call History Window

Save to File button
The Save to File button is used to save the currently selected items to a .csv file.

To save a .csv file of the items in the list, do the following:
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1. From the Per Line Call History list, select the items you want to save.
Click Save to File.
The Save window appears.

3. In the File name field, enter a name for your .csv file.

4. Click Save.

Done button
The Done button is used to close the Per Line Call History window.

Note:

When an ADHB-4 is installed in the system:

—  Master Select audio will also affect the IRR playback audio level if Output Speaker 1 is
selected in the Recording Settings.

—  Master Unselect audio will also affect the IRR playback audio level if Output Speaker 2 to
6 is selected in the Recording Settings.

31.58.4 Comments window
The Comments window, shown in the Figure below appears when the user right clicks on a
call entry in either the Per Line window or the Global Call History window and selects the Edit
Comment menu item. The Comments window is used to either create a new comment or
modify an existing comment for a menu item.

Up to 100 characters can be entered in a single comment.

Unit arrived on scene

79 Characters Remaining

Cancel

Figure 31.62: Comments window

Notice!
Phone functions listed below are specific to PSTN lines attached to a C-6200 or IP-223 with
TDI or PIB adapters. These should not be confused with SIP Phone operation.
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31.59

31.60

31.61

Phone-Flashhook

The Phone-Flashhook function allows the console operator to perform a flashhook operation
on the phone line. This button is generally included as part of a DTMF keypad.

To add a Flash button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Phone - Flashhook.
5. Click OK.
The button changes color and Flash appears on the button.

Phone-Hold

The Phone-Hold function allows the console operator to place a particular line on hold. While
a line is in hold status, no TX audio is sent to the line and RX audio is sent to the unselect
speaker.

To add a Hold button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Phone - Hold.
The Line to Associate Function With drop down menu becomes active.
5. From the Line to Associate Function With drop down menu, select the line to associate
the Hold function.
6. Click OK.
The button changes color and Hold appears on the button.

Phone-On/Offhook

The Phone-On/Offhook function is available to add a line set up as a phone line.

A phone, like a radio circuit, can be used as a network device. A C-6200 console with a phone
card offers phone lines for use by anyone on the network. A phone line can be used for direct
phone communications by a console operator, or to add a crosspatch to telephone capability
for radio users.

When the console operator presses the Phone-On/Offhook button, the line goes offhook and a
dial tone is audible. All radio traffic is moved to the unselect speaker. Full-duplex audio is
present from the microphone while the line is offhook and not on hold. Placing the line on
hold mutes the transmit audio and places the receive audio on the unselect speaker.
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When a hard-wired phone card receives an incoming call, a ring signal is sent out. The C-Soft
program generates a ringing sound and places a RING icon on the on/offhook button. When
the line is taken offhook, the first console to answer the call takes control of the line and all
others are denied.

Notice!

A Mute-Per Line button can be associated with a Phone line to mute the phone line’s mic. The
mute icon appears when the Phone line is muted, RX blocked, or when a Mute Main button is
selected. Refer to “Mute-Per Line, page 321”.

To add a Phone On/Offhook button, do the following:

1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4. From the Ul Element drop down menu, select Phone - On/Offhook.
The Line to Associate Function With drop down menu becomes active and the Remote
Phone Select tab appears.

5.  From the Line to Associate Function With drop down menu, select the line to associate
the On/Offhook function.

6. Click the Remote Phone Select tab.
The Remote Phone Select page appears.

7. From the Remote Phone Number drop down menu, select the physical line of the device
the PSTN line is attached to.

- When specifying a specific line using an IP-223, valid options are 1 or 2.

—  When specifying a specific line for a C-6200 choices can be 1-18.

— To use any line on the device, select Pool.

8. Click OK.

The button changes color and Phone Onhook appears on the button.

Refer to
—  Mute-Per Line, page 321

31.61.1 Remote Phone Line Select page
When the Phone On/Offhook function is selected from the Ul Element drop down menu, the
Remote Phone Line Select page appears. Refer to the Figure below.
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Type | Colorz | Remote Phone Line Select

=

Remote Phone Mumber:
ool

0 0D ] N LN e D R —

Y
00 =] PN e L P —

Figure 31.63: Remote Phone Line Select Page - Ul Element Setup

Remote Phone Number drop down menu
The Remote Phone Number drop down menu identifies the line to force the use of a
particular phone line on the console.

To use any line, do the following:
-  From the Remote Phone Number drop down menu, select Pool.
C-Soft creates a ring only if the selected line is ringing.

31.62 PTT-Group Call
The PTT-Group Call button is used to call a specific group/talk group.

Refer to the Table “Radio Operations Supported by System Type,” on page 394 for radio
operations supported by Group PTT.

To send a group call, do the following:

1. If the Keypad is present, select the group from the Contacts tab or manually enter a
group ID.
OR
From the Group-PTT drop down menu, select the group you want to call.

2. Press and hold the Group PTT button and begin speaking.

3. Release the Group PTT button to stop transmitting.

The PTT-Group Call function allows the console operator to transmit audio to a group of
radios.
1. From the Insert menu, select Add Ul Button.

A None button appears on the console window.
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31.63

31.64

31.64.1

2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select PTT-Group Call.
5. Click OK.
The button changes color and PTT appears on the button.

PTT-Main

The PTT-Main function allows the console operator to transmit audio to all selected channels.
This button is generally included on all console designs. In C-Soft Runtime, if the console
operator presses the PTT-Main button, audio is sent to all selected channels.

To add a PTT-Main button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3.  From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select PTT-Main.
5. Click OK.
The button changes color and PTT appears on the button.

PTT-Per Line

The PTT-Per Line function, or instant PTT function, allows the console operator to
immediately key up a specific line on the current frequency.

When the PTT-Per Line function is selected, a line must be selected from the Line to Associate
Function With drop down menu on the Type page.

Per Line PTT Setup page
When the PTT-Per Line function is selected from the Ul Element drop down menu, the Per
Line PTT Setup page appears. Refer to the Figure below.
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Figure 31.64: Per Line PTT Setup Page - Ul Element Setup

Select PTT Frequency drop down menu
The Select PTT Frequency drop down menu identifies the desired frequency to use per
selected line.

To add a PTT-Per Line button, do the following:

1.

4.
5.

From the Ul Element drop down menu, select PTT-Per Line.

The Line to Associate Function With drop down menu becomes active.

From the Line to Associate Function With drop down menu, select the line to associate
with PTT Per Line.

Click the Per Line PTT Setup tab.

The Per Line PTT Setup page appears.

From the Select PTT Frequency drop down menu, select the frequency.

Click OK.

The color of the button changes and Freq X (where X is the frequency) appears on the button.

31.65 PTT-Private Call

The PTT-Private Call button is used to call an individual radio user.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433" to
see radio operations supported by PTT-Private Call.

To add a PTT-Private Call button, do the following:

1.

4.
5.

From the Insert menu, select Add Ul Button.

A None button appears on the console window.

Right-click the None button.

A shortcut menu appears.

From the shortcut menu, select Properties.

The Ul Element Setup window appears.

From the Ul Element drop down menu, select PTT-Private Call.
Click OK.

The button changes color and PTT-Private Call appears on the button.
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31.66

31.67

To send a private call, do the following:

1. If the Keypad is present, select the User from the Contacts tab or manually enter a User
ID.
OR
From the PTT-Private Call drop down menu, select the user you want to call.

2. Press hold the PTT-Private Call button and begin speaking.

3. Release the PTT-Private Call button to stop transmitting.

PTT-Talk Back

The PTT-Talk Back function allows the console operator to transmit back to the last line from
which audio was received.

To add a PTT-Talk Back button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select PTT-Talk Back.
5. Click OK.
The button changes color and PTT-Talk Back appears on the button.

Radio Call Alert

The Radio Call Alert button is used to send an alert message to a target radio.

Refer to the table “Radio Operations Supported by System Type,” on Keypad, page 433 to see
radio operations supported by Radio Call Alert.

To add a Radio Call Alert button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Radio Call Alert.
5. Click OK.
The button changes color and Call Alert appears on the button.

To send a radio call alert message, do the following:

1. If the Keypad is present, select the User from the Contacts tab or manually enter a User
ID.
OR
Select the User ID to send the call alert.

2. Click Radio Call Alert.

The command is sent.
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31.68 Radio Call Type

The Radio Call Type button is used to switch between Conference Call and Broadcast Call.
This feature is only available for the NEXEDGE IP interface.

To add a Radio Call Type button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. Click OK.
The button changes color and Call Type appears on the button.

31.69 Radio Check

The Radio Check function is used to send a message to check for radio activity.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433" to
see radio operations supported by Radio Check.

To add a Radio Check button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Radio Check.
5. Click OK.
The button changes color and Radio Check appears on the button.

To send a radio check message, do the following:

1. If the Keypad is present, select the User from the Contacts tab or manually enter a User
ID.
OR
Select the User ID to send the radio check message to.

2. Click the command button on the Radio Check button.

31.70 Radio Disable

The Radio Disable button is used to disable a radio in the field from use by unauthorized
persons.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433 for
radio operations supported by Radio Disable.
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31.71

31.72

To add a Radio Disable button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Radio Disable.
5. Click OK.
The button changes color and Radio Disable appears on the button.

To disable a radio, do the following:

1. If the Keypad is present, select the User from the Contacts tab or manually enter a User
ID.
OR
Select the Unit ID to disable.

2. Click Radio Disable.

The command is sent.

Radio Enable

The Radio Enable button is used to enable a radio that has been disabled.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433" for
radio operations supported by Radio Enable.

To add a Radio Enable button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Radio Enable.
5. Click OK.
The button changes color and Radio Enable appears on the button.

To enable a radio, do the following:

1. If the Keypad is present, select the User from the Contacts tab or manually enter a User
ID.
OR
Select the Unit ID to enable.

2. Click Radio Enable.

The command is sent.

Radio Regroup

The Radio Regroup button allows the dispatcher to temporarily reassign a radio to a different
talkgroup.
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31.73

To add a Radio Regroup button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Radio Regroup.
5. Click OK.
The button changes color and Radio Regroup appears on the button.

Radio Ungroup

The Radio Ungroup button allows the dispatcher to reset a radio to their original talkgroup
after using the Radio Regroup button.

To add a Radio Ungroup button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Radio Ungroup.
5. Click OK.
The button changes color and Radio Ungroup appears on the button.

Notice!
The Radio Regroup and Radio Ungroup buttons are only available for the NEXEDGE IP
interface.

31.74

Radio Remote Monitor

The Radio Remote Monitor button allows the dispatcher to open the mic of a targeted radio
and hear any audio in the vicinity of that radio.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433" for
radio operations supported by Radio Remote Monitor.

To add a Remote Monitor button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
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31.75

31.76

4. From the Ul Element drop down menu, select Remote Monitor.
5. Click OK.
The button changes color and Remote Monitor appears on the button.

To monitor a unit, do the following:
1. If a Keypad is present, select a User from the Contacts tab.
OR
From the Remote Monitor drop down menu, select the unit to monitor.
2. Click Remote Monitor.
The command is sent.

Radio Status

The Radio Status function is used to send a status message to a unit.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433" for
radio operations supported by radio status. The list of statuses which can be sent from the
button configured in the Radio Status Setup window.

To send a radio status, do the following:
1. From the Contacts tab of the Keypad, select a user.
OR
Manually enter a User ID.
2.  From the Radio Status drop down menu, select the status to be sent.
3. Click the Radio Status button.
The status message is sent to the user selected in the Keypad or manually entered.

Radio Status Request

The Radio Status Request button is used to send message to request status from a unit in the
system.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433 for
radio operations supported by Radio Status Request.

To add a Radio Status Request button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Radio Status Request.
5. Click OK.
The button changes color and Status Request appears on the button.

To request a status from a unit, do the following:
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1. If the Keypad is present, select the User from the Contacts tab or manually enter a User
ID.
OR
From the Radio Status Request drop down menu, select the User to send the radio status
message to.

2. Click Radio Status Request.

The command is sent.

31.77 Radio Select Call

The Radio Select Call function is used to send a Select Call to a unit in the system.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433 for
radio operations supported by Radio Select Call.

To add a Radio Select Call button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Radio Select Call.
5. Click OK.
The button changes color and Radio Select Call appears on the button.

To send a select call, do the following:

1. If the Keypad is present, select the User from the Contacts tab or manually enter a User
ID.
OR
Select the Unit ID to enable.

2. Click Radio Select Call.

The command is sent.

31.78 Radio-On/Offhook

The Radio-On/Offhook function allows the console operator to control a radio using a
standard PSTN (Public Switched Telephone Network) phone line. Radio - On/Offhook is
similar to “Phone-On/Offhook, page 343”, except radio-on/offhook has a Keep-Alive tone
generated to keep the phone line from dropping. A keep-alive tone goes between the radio
and console so the system knows to stay active until after the connection is broken.

Notice!
Requires an IP-223 with TDI’s at both ends.

To add a Radio On/OffHook button, do the following:
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1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4. From the Ul Element drop down menu, select Radio - On/Offhook.
The Line to Associate Function With drop down menu becomes active and the Remote
Phone Select tab appears.

5.  From the Line to Associate Function With drop down menu, select the line to associate
the On/Offhook function.

6. Click the Remote Phone Line Select tab.
The Remote Phone Line Select page appears.

7. From the Remote Phone Number drop down menu, select the line to force the use of a
particular phone line on the console.

8. Click OK.

The button changes color and Radio OnHook appears on the button

Refer to
—  Phone-On/Offhook, page 343

31.79 Relay Control Button

The Relay Control Button function allows the console operator to control the relays on an
attached ADHB-4 or a network-connected NEO-10.

31.79.1 Relay Control Setup page

When Relay Control Button is selected from the Ul Element drop down menu, the Relay
Control Setup page appears.
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Figure 31.65: Relay Control Setup Page - C-Soft

To open the Relay Control Setup page, do the following:
1. Select Insert | Add IU Button.
A None button is added to the console.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element Function drop down menu, select Relay Control.
The Relay Control Setup tab appears.

Relay Destination group box

The Relay Destination radio buttons identify the relay to be controlled. When a selection is
made, the fields necessary to enter the setup information for the relay are enabled.

ADHB-4 radio button
The ADHB-4 radio button indicates an ADHB-4 is controlled by the Relay Control button.

NEO radio button
The NEO radio button indicates a NEO-10 is controlled by the Relay Control button.

ADHB-4 Settings group box
The ADHB-4 Settings radio buttons identify which ADHB-4 relay is activated when the button
is pressed, or when the configured input conditions are met.

None radio button
The None radio button indicates none of the ADHB-4 relays is activated when the button is
pressed.
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Relay 1 radio button

The Relay1 radio button indicates the first relay in the ADHB-4 is being controlled.

Relay 2 radio button
The Relay 2 radio button indicates the second relay in the ADHB-4 is being controlled.

NEO Settings group box
The NEO Settings field identifies the IP Address and the relay, if any, for the NEO-10.

IP field
The IP field identifies the IP Address of the NEO-10.

Relay drop down menu
The Relay drop down menu is used to select the desired relay.

Available selections for this field are None, Port 1, Port 2, Port 3, Port 4, Port 5, Port 6, Port 7,
Port 8, Port 9 and Port 10.

To configure and add an ADHB-4 Relay Control button, do the following:

1.

8.

From the Insert menu, select Add Ul Button.

A None button appears on the console window.

Right-click the None button.

A shortcut menu appears.

From the shortcut menu, select Properties.

The Ul Element Setup window appears.

From the Ul Element drop down menu, select Relay Control Button.
The Relay Control Setup tab appears.

Click the Relay Control Setup tab.

The Relay Control Setup page appears.

From the Relay Destination group box, select the ADHB-4 radio button.

The ADHB-4 Settings group box becomes active.

From the ADHB-4 Settings group box, select the None radio button.
OR

From the ADHB-4 Settings group box, select the Relay1 radio button.
OR

From the ADHB-4 Settings group box, select the Relay2 radio button.
Click OK.

The button changes color and Relay Off appears on the button.

To configure and add a NEO Relay Control button, do the following:

1.

From the Insert menu, select Add Ul Button.

A None button appears on the console window.

Right-click the None button.

A shortcut menu appears.

From the shortcut menu, select Properties.

The Ul Element Setup window appears.

From the Ul Element drop down menu, select Relay Control Button.
The Relay Control Setup tab appears.
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5. Click the Relay Control Setup tab.
The Relay Control Setup page appears.

6. From the Relay Destination group box, select NEO.
The NEO Settings group box becomes active.

7. From the Relay Behavior group box, select the desired mode radio button for the relay
control.

8. In the IP field, enter the IP Address of the NEO-10.

9. From the Relay drop down menu, select the desired relay.

10. Click OK.

The button changes color and Relay Off appears on the button.

Relay Behavior group box
The Relay Behavior radio buttons identify the mode for the relay control.

Latch Relay On/Off radio button

The Latch Relay radio button indicates the relay’s latch is controlled by the operator. When
the Relay Control button is clicked the device is active. When the Relay Control button is
pressed again the device is inactive.

Momentary Relay radio button
The Momentary Relay radio button indicates the relay is active when the button is pressed.
When the button is released, the relay is inactive.

Timed Relay radio button

The Timed Relay radio button indicates that when an Relay Control button is clicked, it
remains active for the amount of time configured in the Timed field. When the radio button is
selected, you must configure a time in the Timed field.

Timed Relay field
The Time Relay field is used to set the time, in ms, when the Timed Relay radio button is
selected.

The range for this field is 0 to 30000ms.

Emergency Relay Trigger group box
The Emergency Relay Trigger group box is used to configure how the relay behaves when an
emergency call is received.

Activate Relay on Emergency Call check box

The Activate Relay on Emergency Call check box indicates an emergency call activates the
configured relay. If the check box is selected, a radio emergency deactivation radio button can
be selected.

Relay Control Button Only radio button
The Relay Control Button Only radio button is used to configure the relay to deactivate when
the relay control button is released.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



358 en | Ul Element Functions configuration C-Soft 7.700

31.79.1.1

31.79.1.2

31.79.1.3

Emergency Clear and Acknowledge radio button
The Emergency Clear and Acknowledge radio button indicates the relay is deactivated when
the emergency is acknowledged, cleared, or when the relay control button is released.

Emergency Acknowledge radio button
The Emergency Acknowledge radio button indicates the relay is deactivated when the
emergency is acknowledged or when the relay control button is released.

Phone Relay Trigger group box
The Phone Relay Trigger group box is used to configure how the relay behaves when a phone
call is received.

Activate Relay in Call check box

The Activate Relay in Call check box indicates the relay is activated while C-Soft is in a phone
call. This setting includes both a phone line going offhook as well as C-Soft participating in a
SIP call.

Activate Relay on Phone Ring check box

The Activate Relay on Phone Ring check box indicates a phone ring activates the configured
relay. When the check box is selected, the phone ring behavior can be configured. This setting
includes both a ringing phone line as well as an incoming SIP call.

Cadence radio button
The Cadence radio button indicates the relay is activated when an individual phone ring starts
and deactivated when the phone ring ends.

EXAMPLE: A phone ringing three times, produces an on/off/on/off /on/off pattern.

Steady radio button
The Steady radio button indicates the relay is activated when the first phone ring is received
and deactivates when the call is answered or the caller terminates the call.

EXAMPLE: A phone ringing three times, produces a on/off pattern.
PTT Relay Trigger group box

Activate Relay on PTT check box

The Activate Relay on PTT check box indicates the configured relay is active when any
console-generated transmit event, with the exception of intercom and intercom per line,
occurs.

Relay Destination group box

ADHB-4 Settings group box

NEO Settings group box
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31.79.1.4 Relay Behavior group box

31.79.1.5 Emergency Relay Trigger group box
31.79.1.6 Phone Relay Trigger group box
31.79.1.7 PTT Relay Trigger group box
31.79.2 Text Message Control page

To open the Text Message Control page, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element Function drop down menu, select Relay Control Button.
The Relay Control Setup, Text Message Control, and Status Control tabs appear.
5. Click the Text Message Control tab.
The Text Message Control page appears.

Ul Element Setup x

Type Colors  Relay Control Setup  Text Message Control — Status Control

Custom Text Message:

Relay On
Evacuation Drill On

5
Text Message List:
Frant Door Close =2
Front Door Open
Fire Alarm On
Fire Alam Off

Relay Off
Evacuation Drill Off

L

0K

Figure 31.66: Text Message Control Page
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Custom Text Message field
The Custom Text Message field is used to enter a text message that is not in the Text
Message ID List.

Text Message List field
The Text Message List field is used select a status that was pre-created in the Text Message
ID List.

Add button
The Add button is used to add the custom or selected text message to the Relay On field.

Remove button
The Remove button is used to add the custom or selected text message to the Relay On field.

Relay On field
The Relay On field is used to list the different text messages that are sent when the relay is
turned on.

Add button
The Add button is used to add the custom or selected text message to the Relay Off field.

Remove button
The Remove button is used to add the custom or selected text message to the Relay Off field.

Relay Off field
The Relay Off field is used to list the different text messages that are sent when the relay is
turned off.

OK button
The OK button saves the modifications and closes the window.

To create a text message relay control button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element Function drop down menu, select Relay Control Button.
The Relay Control Setup, Text Message Control, and Status Control tabs appear.
5. Click the Text Message Control tab.
The Text Message Control page appears.
6. Inthe Custom Text Message field, enter a custom text message that is not listed in the
Text Message ID List.
OR
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8.

From the Text Message List Group Box, select the status desired to trigger relays on and
off.

The list of text messages is pulled from the Text Message ID List.

Click the Add button to add the status to either the Relay On group box or the Relay Off
group box.

The Text Message moves from the Custom Text Message field or the Text Message List.
IMPORTANT: A status cannot be used for both a trigger on and a trigger off. If the relay
control type is timed, the Relay Off group box is disabled since the relay automatically
latches off when the designated time has elapsed.

Click OK.

The modifications are made and the window closes.

To remove status from the relay on or relay off lists, do the following:

1.

5.

From the Ul Element Function drop down menu, select Relay Control Button.
The Relay Control Setup, Text Message Control, and Status Control tabs appear.
Click the Text Message Control tab.

The Text Message Control page appears.

From the Relay On list, select the text message to remove from the list.

OR

From the Relay Off list, select the text message to remove from the list.

Click the Remove button to remove the status from either the Relay On group box or the
Relay Off group box.

The Text Message is removed from the Relay On or the Relay Off list.

Click OK.

The modifications are made and the window closes.

31.79.3 Status Control page
To open the Status Control page, do the following:

1.

5.

From the Insert menu, select Add Ul Button.

A None button appears on the console window.

Right-click the None button.

A shortcut menu appears.

From the shortcut menu, select Properties.

The Ul Element Setup window appears.

From the Ul Element Function drop down menu, select Relay Control Button.
The Relay Control Setup, Text Message Control, and Status Control tabs appear.
Click the Status Control tab.

The Status Control page appears.
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Ul Element Setup

Type Colors Relay Cortrol Setup  Text Message Control  Status Control

Status List: Relay On
Fire: Alamm Cff Emergency Evacuation On
Front Door Close =
Front Doar Open
Fire Alarm On y :
Relay Off
Emergency Evacuation Cff
=
<

Figure 31.67: Status Control Page

Status List field
The Status List field is used to select the status to add to the Relay On field or Relay Off field.

Add button
The Add button is used to add the custom or selected status to the Relay On field.

Remove button
The Remove button is used to add the custom or selected status to the Relay On field.

Relay On field
The Relay On field is used to list the different statuses that are sent when the relay is turned
on.

Add button
The Add button is used to add the custom or selected status to the Relay Off field.

Remove button
The Remove button is used to add the custom or selected status to the Relay Off field.

Relay Off field
The Relay Off field is used to list the different statuses that are sent when the relay is turned
off.

OK button
The OK button saves the modifications and closes the window.

To create a status control button, do the following:
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1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4.  From the Ul Element Function drop down menu, select Relay Control Button.
The Relay Control Setup, Text Message Control, and Status Control tabs appear.

5. Click the Status Control tab.
The Status Control page appears.

6. From the Status List group box, select the status desired to trigger relays on and off.
The list of statuses is pulled from the Status Message ID List.

7. Click the Add button to add the status to either the Relay On group box or the Relay Off
group box.
The Status moves from the Status List to the Relay On or Relay Off group box.
IMPORTANT: A status cannot be used for both a trigger on and a trigger off. If the relay
control type is timed, the Relay Off group box is disabled since the relay automatically
latches off when the designated time has elapsed.

8. Click OK.

The modifications are made and the window closes.

To remove status from the relay on or relay off lists, do the following:
1. From the Ul Element Function drop down menu, select Relay Control Button.
The Relay Control Setup, Text Message Control, and Status Control tabs appear.
2. Click the Status Control tab.
The Status Control page appears.
3. From the Relay On list, select the status to remove from the list.
OR
From the Relay Off list, select the status to remove from the list.
4. Click the Remove button to remove the status from either the Relay On group box or the
Relay Off group box.
The status is removed from the Relay On or the Relay Off list.
5. Click OK.
The modifications are made and the window closes.

31.80 RX All

The RX All function allows the console operator to remove mute on selected lines if Allow
Muting Selected Lines is selected.

In C-Soft Runtime, if the console operator presses the RX All button it does not change the
select status of any line.

To add an RX All button, do the following:
1. From the Insert menu, select Add Ul Button.

A None button appears on the console window.
2. Right-click the None button.

A shortcut menu appears.
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3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select RX All.
5. Click OK.
The button color changes and RX All appears on the button.

31.81 Scan

The Scan function allows the console operator to scan a selected line.

To add a Scan button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Scan.
The Line to Associate Function With drop down menu becomes active.
5.  From the Line to Associate Function With drop down menu, select the line to associate
with Scan.
6. Click OK.
The button color changes and Scan Off appears on the button.

To activate or deactivate a radio’s scan mode in Runtime, do the following:
1. Press the Scan button.
The radio’s scan mode is activated.
2. Press the Scan button again.
The radio’s scan mode is deactivated.

31.82 Select

The Select function allows the console operator to toggle transmission channels when a
master or accessory PTT button is selected. DTMF and Alert tones are also transmitted to all
selected lines. Select buttons also indicate the type of activity on a line, such as: audio
receive, audio transmit, mute, crossmute, intercom, link fail, and supervisor status.

The Supervisor icon cannot be customized.

— A Mute-Per Line button can be associated with the line assigned to the Select button to
mute the RX (incoming) audio. The mute icon appears when the Select line is muted, RX
blocked, or when a Mute-Main button is selected. Refer to “Mute-Per Line, page 321”.

For more information, refer to Button Images window, page 141.

Select Button Setup page
When Select is chosen from the Ul Element drop down menu, the Select Button Setup page
appears.

To open the Select Button Setup page, do the following:
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1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Select.
The Select Button Setup tab appears.
5. Click the Select Button Setup tab.
The Select Button Setup page appears.

Type |Color5 Select Button Setup ‘

Annunciation of Select Call Blink: Border on Receive

Blink Select Button i@ Mo Blinking Blink Color: |:| |"|
@ Mo Beep - () Blink for |5 | seconds.

Beepfor |< | =econds. © Bink Urtil PTT

() Beep Until PTT

Action an Select Call DTMF Digits for Select Call

@ Mo Action 1

(7 Open Mute for |7 | seconds.

[] Trigger Emergency

2 [T Trigger Emergency
Annunciation of Call Alet
Blink Select Button

@ Mo Beep . [] Trigger Emergency

[7] Trigger Emergency

(") Beepfor |© | seconds.
() Beep Urtil PTT : [ Trigger Emergency

Figure 31.68: Select Button Setup - Ul Element Setup
Annunciation of Select Call group box

Blink Select Button check box
The Blink Select Button check box is used to indicate the button blinks light blue when the
console receives a select call.

No Beep radio button
The No Beep radio button indicates no tones are heard when a select call is received.

Beep for radio button
The Beep for radio button is used to indicate a select call alert tone is heard when a select
call is received.

Beep for seconds field
The Beep for seconds field indicates the amount of time the select call alert tone plays.
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The Beep for radio button must be selected for this field to be active.

The range for this field is 1-10 seconds.

Beep Until PTT radio button
The Beep Until PTT radio button indicates the select call alert tone is heard until a PTT
operation is performed on the line that received the select call.

To configure a blinking button indication, do the following:
—  From the Select Button Setup page, select the Blink Select Button check box.

To configure the desired notification, select one of the following:

— No Beep radio button - no beep sound is played when a select call is received.

—  Beep For radio button - a beep sounds for the specified the number of second.

—  Beep Until PTT radio button - a beep sounds until a PTT when a select call is received.

Action On Select Call group box

No Action radio button
The No Action radio button indicates an active mute button is not opened during a select call.

Open Mute for radio button
The Open Mute for radio button indicates a muted line is opened upon receiving a select call.

The Open Mute for seconds field must also be configured.

Open Mute for seconds field
The Open Mute for seconds field indicates the amount of time a muted line is unmuted upon
receiving a select call.

The range for this field is 1 to 20 seconds.

To configure the desired action, select one of the following:

- No Action radio button - no action occurs.

—  Open Mute for radio button - specifies the duration, in seconds, muted line remains open
(unmuted).

To add a Select button, do the following

1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3.  From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4. From the Ul Element drop down menu, select Select.
The Line to Associate Function With drop down menu becomes active and the Select
Button Setup tab appears.

5.  From the Line to Associate Function With drop down menu, select the line to associate
with Select.
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6. Click the Select Button Setup tab.
The Select Button Setup page appears.

7. In the DTMF Digits for Select Call field, enter the digits required to activate the select
call feature.

8. From the Annunciation of Select Call group box, select the type of notification to be
used.

9. From the Action on Select Call group box, select the mute action during a select call.

10. Click OK.

The button changes color and Select appears on the button.

Annunciation of Call Alert group box

Blink Select Button check box
The Blink Select Button check box indicates the button blinks orange when the console
receives a call alert.

No Beep radio button
The No Beep radio button indicates no tones are heard when a call alert is received.

Beep for check box
The Beep for check box indicates a call alert tone is heard when a call alert is received.

The Beep for seconds field indicates the amount of time the alert tone plays.
Blink Border on Receive group box

No Blinking radio button
The No Blinking radio button indicates the Select button does not blink when receiving a call.

Blink for radio button
The Blink for radio button indicates upon receiving a call the Select button’s border blinks for
the amount of time set in the seconds field. When the line is transmitting the blinking stops.

When selected, the Blink for Radio button field is active.

Blink for field
The Blink for field indicates the amount of time, in seconds, the Select button blinks upon
receiving a call.

Blink Until PTT radio button
The Blink Until PTT radio button indicates upon receiving a call, the Select button’s border
blinks until a PTT is generated on the line.

Blink Color drop down palette
The Blink Color drop down palette indicates the color of the button border when it blinks.

DTMF Digits for Select Call fields
The DTMF Digits for Select Call fields identifies the digits required to activate the select call
feature. C-Soft can respond up to five different DTMF strings.

This field can contain up to 10 characters.
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31.83

Beep for seconds field
The Beep for seconds field indicates the amount of time the call alert tone plays.

The Beep for radio button must be selected for this field to be active.

The range for this field is 1 to 10 seconds.

Beep Until PTT radio button
The Beep Until PTT radio button indicates the alert tone is heard until a PTT operation is
performed on the line that received the call alert.

To configure a blinking button indication, do the following:
—  From the Select Button Setup page, select the Blink Select Button check box.

To configure the desired notification, select one of the following:

— No Beep radio button - no beep sound is played when a select call is received.

—  Beep For radio button - a beep sounds for the specified number of second (0-10 seconds)
when a Select Call is received.

—  Beep Until PTT radio button - a beep sounds until a PTT when a select call is received.

DTMF Digits for Select Call group box

The DTMF Digits for Select Call group box contains five fields to specify DTMF digit strings to
trigger a select call in C-Soft. When the console receives any of the DTMF strings configured in
the select call setup, the button notifies the operator by either blinking or beeping depending
on the console configuration.

Trigger Emergency check box
The Trigger Emergency check box indicates an emergency is triggered when the string entered
in the field is received.

Refer to
—  Mute-Per Line, page 321

SIP Call Control

The SIP Call Control function creates a button to open the SIP Calls window shown in S/P
Calls window, page 375.
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31.83.1

Ul Element Setup 4

Type Colors  SIP Window  Speed Dial

Incoming Call Answer Behaviar S|P Window Options

() Automatic Window Size (®) Nomal

@ flanal O Large
] Answer Calls on S|P Call Control Click (] Display Backspace Button

[+] Allow Do Mot Disturb Background |-

S|P Call Options Teut _ |,

Display Missed Call Motfications

[] Display Extension on Incoming Call Fitter + Contact Fort

Figure 31.69: SIP Window - SIP Call Control

Refer to
- SIP Calls window, page 375

SIP Window page

Incoming Call Answer Behavior group box
The Incoming Call Answer Behavior group box is used to determine how C-Soft responds to
incoming calls.

Automatic button
The Automatic button indicates incoming calls are answered automatically by C-Soft.

Manual button
The Manual button indicates incoming calls are answered by clicking the Answer button in the
SIP Call Control window.

Answer Call on SIP Call Control Click check box

The Answer Call on SIP Call Control Click check box indicates incoming calls are answered
using the SIP Call Control button. This option also allows calls to be answered in a single
button press.

Allow Do Not Disturb check box
The Allow Do Not Disturb check box indicates the Do Not Disturb feature is available. If
unchecked, the Do Not Disturb button is disabled.
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SIP Call Options group box

SIP Calls on Trixbox 208 et

Cal History ~ Missed

Figure 31.70: Normal Window Size
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SIP Calls on Trixbox 208 oy

Call History Missed

Enter phone number; (=< New: 3

Call Hang Up @

Hold Mute Mic
]
DND Consultant Xfr
Line Conf IWay Call
Cancel

Cloze Mare: @

Figure 31.71: Large Window Size

Display Missed Call Notifications check box

The Display Missed Call Notifications check box indicates if any missed call notifications
should be displayed to the user. When selected, missed calls generate notifications on the SIP
Call Control button and in the SIP Call Control window.

In configurations where the extension is configured for one or more Ring Groups, it may be
useful to not display missed call notifications.

Display Extension on Incoming Call check box
The Display Extension on Incoming Call check box indicates the incoming extension number
is displayed in addition to any alias information in the SIP Call Display window.

When not selected, the incoming SIP extension number is only displayed if there is no caller ID
information included in the incoming call.

SIP Window options

Window Size radio buttons
The Window Size radio buttons are used to specify the size of the SIP window.
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Available options are Normal and Large.

Notice!
The Large window size is recommended for touch-screen operation.

31.83.2

Display Backspace Button check box

The Display Backspace Button check box is used to display an on-screen backspace button in
the top right corner of the SIP Call Control window. The on-screen backspace button is useful
for touchscreen operations when using C-Soft without a keyboard.

Background drop down palette

The Background drop down palette is used to change the background color of the SIP Call
Display window.

A light color is recommended.

Text drop down palette
The Text drop down palette is used to change the color of the SIP Call Display window.

A dark color is recommended.

Filter + Contact Text button
The Filter + Contact Text button is used to select a font for the SIP Call Control’s Contact and

Filter list.

SIP Speed Dial page

The SIP Speed Dial page allows entry of 12 numbers. These provide an easy and convenient
way to access commonly-called extensions. Additionally, each entry contains a Presence check
box. If an entry’s Presence check box is selected, C-Soft attempts to subscribe to presence
notifications for the extension.
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Ul Element Setup

Type Colors  SIP Window Speed Dial

Speed Dial Mumber Presence Speed Dial Number Presence
1|70 | 7 | | O
2 [7or O g | |
3| o e | O
4| o ] | O
5 | o n| | O
6 | O 12 | O

Figure 31.72: Speed Dial Page

Refer to “Speed Dial Pane” for additional information on the Presence feature.

In C-Soft Runtime, when the window is open, the user can receive, place, and transfer phone
calls, control the call volume, view history or view a list of missed calls. Monitor the Status Bar
at the top of the console window for success or failure messages.

To initiate a connection to the SIP server, do the following:

—  Open C-Soft Runtime.

C-Soft attempts to connect to the server.

— If the SIP server connection is successful, the message appears on the console status bar.

— If the SIP server connection fails, the message appears on the console status bar.

— If the SIP server connection becomes disconnected during use, the failure message
appears in the status bar.

;- /C-Soft Console - 5IP-Theresa.veg

SIP Line: SIPDiamondcard - Reiistered as 5242Dﬁusi,ast.diamondcard‘us

- C-Soft Console - SIP-Theresa.veg
SIP Line: SIPDiamondcard - Unable to Register as 524 20@usgw.ast.diamondcard.us

During SIP calls, some status messages and icons appear directly on the SIP Call control
button during SIP call activity. These same indications as well as status messages, appear in
the SIP Calls window. Refer to the Figure below.

Note:
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A Mute Per Line button can be associated with a SIP Call Control button to mute the SIP
line’s RX (incoming) audio. The mute icon, refer to the Figure below, appears when the
SIP line is muted per line, RX blocked, or when a Mute-Main button is selected.

If the line is muted, and a call is initiated from the SIP Calls window, the line is
automatically unmuted.

Mic mute Mute (per line)

Tab. 31.7: SIP Call Buttons with Status Indications

SIP Incoming Call popup menu

The SIP Incoming Call popup menu, shown in the Figure below, can be used to quickly access
the incoming SIP call. During an incoming call, the status indicator changes to RING. Right-
click the incoming SIP call button to access the popup menu.

Available selections for this menu are:

Open SIP Window - Opens the SIP Calls window. For more information, refer to “S/P Calls
window, page 375”.

Answer - Answers the incoming call. For more information, refer to “Call/Answer Button”
onCall page, page 375.

Ignore - Ignores the incoming call. For more information, refer to “Hang Up/Hang Up >/
Ignore Button” on Call page, page 375.
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Open SIP Window
Answer
Ignore

Figure 31.73: SIP Incoming Call popup Menu

Refer to
- SIP Calls window, page 375
- Call page, page 375

31.83.3 SIP Calls window

The SIP Calls window is used to manage SIP Calls, view call history and view missed calls.

31.83.4 Call page
When a SIP Call Control button is clicked in C-Soft Runtime, the SIP Calls window opens to
the Call page. Refer to the Figure below.

The Call page is used to place incoming and outgoing SIP phone calls, place holds, initiate 3-
way calling, mute the microphone, transfer calls, and activate do not disturb.

SIP Calls on Line 2

Call | History | O - Missed |

SIP Call
Display

W\ Connectec
Icon

Call

Hod | | mMutemic | |

[
[ owp | |consuttant xfr|
[ uineconf | [ 3-waycal |

Cancel

- O

Figure 31.74: SIP Calls Window - Call Page

SIP Call display
The SIP Call display is used to enter a phone number to call. It also provides status messages
and icons to indicate the state of the associated SIP line.
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To enter a phone number to call, do the following:

1. Ensure the SIP Calls window is open.

2. Using the Keypad pane or the keyboard keypad, enter the phone number to call.
The digits appear in the SIP display.

3. Click call.
OR
While the SIP display has focus, press Enter.

When the call is connected, the Connected icon appears in the display.

Call/Answer button
The Call/Answer button is used to place or answer a call.

This button is disabled until a number is entered or an incoming call is received.

— If a contact is selected from the Contacts pane, or a phone number is entered in the SIP
Call display, the Call button is enabled.

— If acall is being received on a line while the SIP Calls window is open, a ring icon appears
on the SIP Call display, the Call/Answer button changes to Answer, and the Call/Answer
and Ignore buttons are enabled.

SIP Calls on Line 2

Call  |History | 0- Missed

\

Ring Icon

[ Answer ] [ Ignore ]@

Hold Mute Mic ‘

Consultant Xfr

Line Conf

Cancel

- Q

Figure 31.75: SIP Calls - Incoming Call

To answer a call, do the following:
—  Click Answer.
The incoming call is connected.

If the line is already engaged in a call, the existing call is placed on hold and the Cancel button
label changes to Switch.

To return to a caller on hold while on another call, do the following:
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—  Click Switch.
The current caller is placed on hold and the other call is taken off hold.

To answer and merge a waiting call with the current call, do the following.
1. While already engaged in a call, click Answer.

The current call is placed on hold and the incoming call is answered.
2. Click 3-way Call.
The on-hold call is taken off hold, and joined with the other call. The two callers and console
operator are connected in one conversation. The 3-Way Call button label changes to Leave
Call.

SIP Calls on Line 2

Call | History | 1 - Missed |

Hold Mute Mic

Consultant XFfr

Line Conf 3-Way Call

Cancel

- Q

Figure 31.76: SIP Calls - Outgoing Call

To place an outgoing call, do the following:

1. Using the Keypad pane or keyboard, enter the phone number.
The number appears in the SIP Calls display.

2. Click cCall.
OR
Press Enter.

The call is placed to the phone number entered in step 1.

To disconnect from the call, click Hang Up.

Hang Up/Hang Up >/Ignore Button

The Hang Up/Hang Up >/Ignore button is used to disconnect the current SIP call or ignore an

incoming call.

—  During a call, the Hang Up button is enabled.

— If multiple parties are connected via consultant transfer, 3-way calling, or call waiting the
Hang Up > button appears. Click the Hang Up > button to open a popup menu containing
all currently connected calls.

- While an incoming call is ringing, the Hang Up button’s text changes to Ignore.
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SIP Calls on Line 2

Call | History | 1 - Missed |

Popup Menu

202@172.19.50.60
203@172.19.50.60
Both

(v Comteme

[ Line Conf ] [ Leave Call ]

Cancel

- ©

Figure 31.77: Hang Up > Button with popup Menu

To disengage a 2-way call, do the following:
—  Click the Hang Up button.
The call is disconnected and the connected icon disappears.

To disengage a call with multiple participants, do the following:
1. Click Hang Up >.

A popup menu appears. Refer to the Figure above.
2. Select an individual call to disconnect from.

OR

Select Both to disconnect both calls.

To ignore an incoming call, do the following:
—  Click Ignore.
The call is ignored and the caller information is added to the list on the Missed page.

Hold button

The Hold button places the current call on hold. During hold, C-Soft does not send or receive

audio.

— If multiple parties are connected at one time, the hold button places all calls on hold or
takes all calls off hold.

— If the console operator is talking to the consulting party during a consultant transfer or
speaking to one party during a call waiting event, clicking the Hold button places the
active participant on hold.

Note:

—  Hold options can be configured on the SIP server.

—  The SIP hold button stops both incoming and outgoing audio, whereas the console hold
button only stops the outgoing audio.
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SIP Calls on Line 2
Call  [History | 0 - Missed |

On Hold Icon

Call Hang Up @

[ Hod | [ mutemic |

[ DND I [Consu1tant Xfr]

[ Line Conf ] [3-Way Call ]

Cancel

- ©

Figure 31.78: Call Page - On Hold

To place a call on hold, do the following:
—  While in a SIP call, click Hold.
The call is placed on hold and the On Hold icon appears in the SIP Call display.

To take a call off hold, do the following:
—  Click the Hold button.
The call is taken off hold.

Mute Mic/Unmute Mic button
The Mute Mic button is used to stop microphone audio from reaching any connected party.
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SIP Calls on Line 2
Call | History | O - Missed |

Mute Mic lcon

@

Hold ] [ Unmute Mic | ‘

[
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[

Line Conf | | 3-way call |

Cancel
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Figure 31.79: Call Page - Mute Mic

To mute the microphone, do the following:

—  While engaged in a SIP call, click Mute Mic.

The button changes to Unmute Mic, the Mute Mic icon appears in the SIP Call display, and
microphone audio is not sent.

To unmute the microphone, do the following:

-  Click Unmute Mic.

The button label changes to Mute Mic, the icon disappears from the display, and the
microphone is open.

DND/Disable DND button

The DND (Do Not Disturb) / Disable DND button is used to activate do not disturb mode.
While active, callers automatically receive a message stating the number is unavailable. While
DND is active, DND icons appear on the Call page and the associated SIP button.
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SIP Calls on Line 2
Call | History | O - Missed |

Do Not
\ Disturb Icon

Call Hang Up @

Hold Mute Mic
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Line Conf 3-Way Call

Cancel
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Figure 31.80: Call Page - DND

To activate DND, do the following:
—  Click DND.
The button label changes to Disable DND and the DND icon appears in the SIP Call display.

Calls received while in do not disturb mode are logged on the Missed page.

To disable DND, do the following:
—  Click Disable DND.

The specific do not disturb message is configured on the SIP server.

Consultant Xfr/Blind Xfr button

The Consultant Xfr/Blind Xfr button is used to blind transfer a call or transfer with

consultation.

— A blind transfer is a call transferred to a second party without announcing the call to the
receiver.

— A consultant transfer allows the console operator to announce the transferred call to the
receiver.

—  The button label is changed by right-clicking the button and selecting the function from
the popup menu.
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SIP Calls on Line 3

cal History | Missed

Popup Menu

Figure 31.81: Consultant Xfr popup Menu

To abort the transfer function at any time, click Cancel. The incoming call remains
connected.

To make a consultant transfer, do the following:

1.

From the Call page for the line, if the button label is Consultant Xfr, go to step 3.

OR

Right-click Blind Xfr.

A popup menu appears.

Select Consultant Xfr.

The button label and function changes to Consultant Xfr.

Click Consultant Xfr.

Enter transfer destination appears and the SIP Call display is ready to accept a transfer
destination.

Using the Keypad pane, keyboard, or the Contacts list, enter the new destination number
in the SIP Calls window.

Click Consultant Xfr.

The current call is placed on hold and a call is placed to the destination number. When
the call is answered, the Hang Up button changes to Hang Up >.

Announce the caller to the second party.

Click Consultant Xfr.

The first and second call are now connected, and disconnected from C-Soft.

Click Hang Up to disconnect from the call.

Both callers are disconnected from the console.

To make a blind transfer, do the following:

1.

From the Call page for the line, if the button label is Blind Xfr, go to step 3.
OR

Right-click Consultant Xfr.

A popup menu appears.
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2. Select Blind Xfr.
The button changes to Blind Xfr.
3. Click Blind Xfr.
Enter Transfer destination appears in the display and the SIP Call display is ready to
accept a number.
4. Using the Keypad pane, keyboard, or Contacts list enter the destination number.
The phone number appears at the bottom of the display.
5. Click Blind Xfr.
The original call is transferred to the destination number and immediately disconnected from
the console.

Line Conf button

The Line Conf button is used to join two SIP phone calls already in progress into a line
conference. A line already involved in a 3-way call can be included in the line conference.
During a line conference, the SIP Calls window border changes to black. An example is shown
in the Figure below.

Due to processing demands, a maximum of six remote parties (plus the console) can be mixed
together at one time.

SIP Calls on Line 2

| [ mutemic | |

|
[ DND ] [Consu[tant Xfr]
E

Line Conf | [S-Way Call ]

Cancel

More: 6

Figure 31.82: SIP Calls Page - Line Conference

To place two lines into a line conference, do the following:
1. Engage two SIP calls on two separate lines.
2. From the first line’s call window, click Line Conf.
The window’s border turns black.
3. From the second line’s call window, click Line Conf.
The second line’s SIP Call window turns black. Both lines are now in communication with each
other.
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3-Way Call button
The 3-Way Call button is used to establish a call in which three participants are engaged.

To abort the 3-way call function at any time, click Cancel.
The original call remains connected to the console.

To establish a 3-way call, do the following:

1.

4.

While already engaged in a call, click 3-Way Call.

Enter New Destination appears in the display.

Using the Keypad pane, keyboard, or Contacts list enter the new destination number.
The number appears at the bottom of the display.

Click 3-Way Call.

The current call is placed on hold and a call is placed to the new destination number. The
Hang Up button changes to Hang Up >.

Click 3-Way Call.

The first call is taken off hold and joined in the current call. Both parties and the console
operator are connected. The 3-Way Call button’s label changes to Leave Call.

Cancel/Switch button
The Cancel/Switch button is used to cancel an operation or switch to another call.

If the button is active and Cancel appears on it, it can be used to cancel a blind transfer,
consultant transfer, 3-way call or restore a call to its previous state.

If the button is active and Switch appears on it, it can be used to switch from the current
call to a call-waiting call.

To cancel a transfer or 3-way call operation before it is completed, do the following:

Click Cancel.

The operation is canceled, the current caller remains on the line, and the Cancel button is
disabled.

To switch to a waiting call while already in a call, do the following:

Click Switch.

The current call is placed on hold, the waiting call becomes active.

Click Switch to switch back to the other call.

Mute icon

The Mute icon is used to instantly mute audio on the SIP line.
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SIP Calls on Line 2
Call | History | O - Missed |

@

Hold | | mutemic |

[
[ DND ] [Consu!tant Kfr]
[

Line Conf | | 3-way cal |

Cancel

- Q

Figure 31.83: Call Page - Mute Icon

Muted Icon

To mute audio on the SIP line, do the following:

—  Click Mute.

The Volume slider moves to the bottom of the volume bar. The speaker icon changes to a red
mute icon and audio is turned off.

Clicking Mute restores the Volume slider to its previous value.

Volume Slider
The Volume slider is used to adjust the speaker volume for the associated line.

To decrease the volume, do the following:
—  Slide the volume slider down.

To increase the volume, do the following:
—  Slide the volume slider up.

Expand Button

The Expand button is used to expand the SIP Calls window, refer to the Figure in 480. When
the Expand button is clicked, a Misc tab, Forward tab, and additional features appear on the
Call, History, and Missed pages.

- Expand button. @

Collapse button
The Collapse button is used to collapse the SIP Calls window, refer to the Figure above.

—  Collapse button. @
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Contacts pane

The Contact pane is used to view, edit, or delete the list of contacts within the SIP system.
This list is managed using a popup menu. The contact list can be divided into subdirectories
making it easier to group and maintain contacts. Additionally, the Contact Search bar can be
used to filter the contact list to contain only contacts that match the entered text.

The Contact List supports 5000 SIP contacts.

The Contacts pane appears on the Call page when the expand button is clicked.

SIP Calls on G5 2003 >
Call History Missed Forward Misc
E MNew: 1 Contacts Keypad
Contact Number Global Directory — S bdirectory Selector
5551212
John Contact Search Bar
John Adams o)
John Smith Contact
m Call
. - ‘
Rl Q| T i Pop-up Menu
May
Hold Mute Mic . Edit...
Williz :
DND Consultant *fr Jam Delete
Line Conf 3IWay Cal John Import...
Export...
Cancel < po
Closze @

Figure 31.84: Call Page - Contacts Pane

Notice!

The Pop-up Menu is not accessible with a mouse on the IP-30xx devices.

Notice!

Subdirectory Group names can be modified from their default names (Subdirectory 1,
Subdirectory 2, etc.) by editing the Contact Directory CSV file. The CSV file is located at C:
\ProgamData\Telex Communications\design_folder\ and is named sip_directory_<veg>.cvs
(where <veg> is the name of the C-Soft Design file. You can edit this file directly using a text
editor or import the file into any common spreadsheet application, such as Excel). The
Directory file is only created after adding the first contact to an operational position.

To place a call to a contact in the list, do the following:
1. From the Contacts pane, select a contact.
The contact’s number appears in the SIP call display.
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Click call.
A call is placed to the selected contact.
OR

Double-click the contact.

The default action (the bold item in the popup menu i.e Call) is performed and the call is
placed.

OR

Right-click the contact and select Call.

A call is placed to the selected contact.

To add a new contact to the list, do the following:

1.

© o N oA

Right-click the contact list.

A popup menu appears.

Click Add New.

The Edit Contact window appears.

Edit Contact

Subdirectory: | Subdirectory 1 e Motes;

First Mame Last Mame

Display Name
| Johin Smith |

Mumber
| 6666 |

Cancel

From the Subdirectory drop down menu, select a subdirectory to associate to a Contact,
if desired.

In the First Name field, enter the first name of the contact.

In the Last Name field, enter the last name of the contact.

In the Display Name field, enter a user-recognizable name for the contact.

In the Number field, enter the phone number for the contact.

In the Notes field, enter appropriate comments for the contact.

Click OK.

The contact is added to the contacts list.

To edit a contact in the list, do the following:

1.

3.
4.

Right-click the contact list.

A popup menu appears.

Click Edit.

The Edit Contact window appears.
Make changes to the appropriate fields.
Click OK.

The changes to the contact information are saved.

To delete an entry from the contacts list, do the following:
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1. Right-click a contact to delete.

The contact list popup menu appears.
2. Click Delete.
The contact is removed from the list.

To import a contact list from a .csv file, do the following:
1. Right-click the contact list.
A popup menu appears.
2. Click Import.
The Import window appears.
3. Select a.csv file to import.
4. Click OK.
All contacts contained in the .csv file are added to the list.

To export a contact to a .csv file, do the following:
1. Right-click the contact list.
A popup menu appears.
2. Click Export.
The Export window appears.
3.  From the Name drop down menu, select a name.
OR
In the Name field, enter a name for the .csv file.
4. Click OK.
All contacts are exported to the selected .csv file.

Keypad pane
The Keypad pane is used to enter DTMF digits and access voice mail messages.

The Keypad appears when the Keypad tab is clicked while in the maximized Call page. The Call
page is maximized using the Expand button.

Note:

—  These digits can also be entered using the keyboard.

—  While in a call, the keypad generates DTMF tones. When not in a call, the keypad inserts
the digits in the SIP call display.
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SIP Calls on trixbox-207

Call IHisl:ury | 4 - Missed  Misc | Forward

5. New: 4 Contacts | Keypad
//\( ter phone number: . 3 =
) ) 5555555
Voicemail
Aot 4 5 6
Notification
Icon =
=l B E

Hold Mute Mic [ CLR -
Line Conf 3-Way Call
Cancel

€

Figure 31.85: Call Page - Keypad Pane

To access the keypad pane, do the following:

1. From the Calls page, click the expand button.
The contacts page appears.

2. Click the Keypad tab.

The Keypad pane appears.

CLR button
The CLR (Clear) button is used to clear the information from the SIP Call display.

The SIP Call display entry field must be enabled.

<-- button
The <-- button is used to delete the last entered character from the SIP Call display.

The SIP Call display entry field must be enabled.

Flash button
The Flash button is used to send a hook flash signal.

This feature is only available during a SIP call.

Voice mail button
The Voice mail button is used to access a specific voice mail number. The SIP server must
support this feature.

To configure a specific voice mail number for the button, do the following:
1. Right-click Voice mail and select Configure from the popup menu.

The Edit Contact window appears.
2. In the Number field, enter the phone number for the button.
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3. Click OK.
The voice mail number is stored.

To call the stored voice mail number, do the following:
—  Click the Voice mail button.
A call is placed to the specified phone number.

Voice mail notification icon

When the Voice mail notification icon, shown in the Figure above, appears in the SIP Calls
display, voice mails are waiting. The number indicated to the right of the New text, (e.g. 4), is
the quantity of voice mail messages in queue.

Speed Dial pane
If at least one speed dial extension is configured, the SIP window in C-Soft Runtime displays
an additional Speed Dial pane.

SIP Calls on 5IP-3CX 608 *
Call Histary Missed Forward Misc
Enter phone number: Contacts Keypad Speed Dial

Call Hang Up @

Hold Mute Mic
DND Consuttant *fr
Line Conf FWay Call
Cancel

Close e

Figure 31.86: Call Page - Speed Dial Pane

In C-Soft Runtime, the current call state of the speed dial number is color coded (for example,
green means the number is available to call):

— If not currently in a call, pressing the button calls the specified number.

— If already in a call with the specified number, pressing the button hangs up the call.
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— If already in a call, but not with the specified number, pressing the button forwards the
current call to the specified extension.
If the Presence setting is enabled, C-Soft attempts to monitor the Presence State of each of
the configured button extensions. Each Speed Dial button color changes based on the
corresponding extension’s presence. Additionally, any Autodial buttons in the main console
window configured to the same extension also change color with the extension’s presence
information.
The Presence states and colors are:
Presence state Color
Available (not in a call) Green
Unavailable (in a call) Red
Incoming Ring Yellow
Outgoing Ring Blue
No Presence Information Grey
31.83.5 History page

When the History tab is clicked from the SIP Calls window, the History page appears. Refer to
the Figure below. The History page is used to view past SIP Calls received on the selected

line.
SIP Calls on Line 3
cal | History |U - Missed | Misc || Forward
Previous SIP calls on Line 3
Description Date and Time Phone Mumber
8/27/2010 19:49:46
Linksys 201 8/27{2010 19:49:54 201
Linksys 201 8/27/2010 19:50:08 201
Linksys 201 8/27/2010 19:50:15 201
Linksys 202 8/27/2010 19:50:23 202
History
Legend N
= Incoming calls
B Outgoing calls
e

Figure 31.87: History Page - Maximized

Description column

The Description column displays the call’s number and url or the alias.
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Date and Time column
The Date and Time column displays the date and time the call occurred

Phone Number column
The Phone Number column displays the phone number that called.

History legend
The History legend displays the color format used for incoming and outgoing calls.

Call button
The Call button is used to place a call to the selected phone number. If no call is selected
from the list, the Call button is disabled.

The Call button appears on the History page when the Expand button is clicked.

To call a contact in the History list, do the following:
1. Select the phone number to call.
2. Click the Call button.
OR
Select Call from the entry’s popup menu.
OR
Double-click the entry.
The call is placed and the SIP Calls window switches to the Call page.

31.83.6 Missed page
When the Missed tab is clicked from the SIP Calls window, the Missed page appears. Refer to
the Figure below. The Missed page is used to view calls received, but not answered on the
selected SIP line.

SIP Calls on Line 3

Call | History | 9-Missed |Misc | Forward

Missed calls on Line 3
Missed Legend Description Date and Time Phone Number

Linksys 202 8/ 3/2010 20:05:42 202
Linksys 202 8/ 3/2010 20:05:52 202
Linksys 203 8/ 3/2010 20:06:02 203
Linksys 203 8/ 3/2010 20:06:06 203
Linksys 203 8/ 3/2010 20:06:13 203
Linksys 202 8/ 3/2010 20:06:37 202
Linksys 202 8/ 3/2010 20:06:49 202
Linksys 202 8/ 3/2010 20:07:11 202

| Linksys 202 8/ 3/2010 20:07:23 202

I Unanswered calls cal
B Ignored calls =
I Do Mot Disturb (DND) calls

B Forwarded Clear List
o

Figure 31.88: Missed Page
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Description column
The Description column displays the call’s number and url or the alias.

Date and Time column
The Date and Time column displays the date and time the call occurred

Phone Number column
The Phone Number column displays the phone number that called.

This column is visible when the Expand button is clicked to maximize the window.

Missed Calls legend
The Missed Calls legend display the color format used for unanswered, ignored, do not
disturb, and forwarded calls.

Call button
The Call button is used to place a call to the selected phone number. If no call is selected
from the list, the Call button is disabled.

The Call button appears when the Missed page is maximized. Click the Expand button to
maximize the window.

Call button
The Call button is used to place a call to a phone number selected from the list. This button is
visible when the Expand button is clicked to maximize the window.

To place a call from the missed call list, do the following:
1. Select a call from the list.
2. Click Return Call.
OR
Double-click an entry.
OR
Right-click an entry and select Call from the popup menu.
The call is placed to the selected phone number.

Clear List button
The Clear List button is used to clear all calls from the list. This button is visible when the
window is maximized.

To clear all calls from the list, do the following:
—  Click Clear List.
The list is cleared.

31.83.7 Misc page
The Misc page is used to view the following system information:
— Domain - Displays the registered domain of the SIP line.
—  Protocol - Displays the SIP protocol for the line.
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31.83.8

—  SIP Registration - Displays the registration information for the SIP line.

The Misc page, refer to the Figure below, becomes available in the SIP Calls window when the

expand button is clicked.

SIP Calls on Line 2

(call | History | 0-Missed || Misc | Forward

Domain:  172,19.50.60
Protocal: sip:

SIP line Line 2 is registered as
205@172.19.50.60

Close

€)

Figure 31.89: Misc Page

Forward page

The Forward page is used to configure forwarding options.

The Forward page, shown in the Figure below, becomes available in the SIP Calls window

when the expand button is clicked.

SIP Calls on Line 2

| call | History | 0-Missed | Misc | Forward |

[CJForward all calls

Destination: ‘ 201

|

Forward calls while busy

Destination: } 202

| @

Forward unanswered calls after seconds

Destination: ‘ 203

Close

&)

Figure 31.90: Forward Page
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Forward All Calls check box
The Forward All Calls check box indicates all calls received on the line are forwarded to the
phone number entered in the Destination field for this check box.

Notice!
This selection cannot be combined with any other forwarding option.

Destination field
The Destination field is used to enter the phone number to forward all incoming calls to.

Address Book
The Address Book button is used to locate a phone number to enter in the Destination field.

Forward calls while busy check box
The Forward call while busy check box indicates calls received while the line is busy are
forwarded to the phone number in the Destination field for this check box

Notice!

This check box can be used in combination with the Forward unanswered calls option.

Some SIP servers (i.e. 3CX) have their own settings for forwarding a call when an extension is
busy. When using these servers the call forwarding logic in the server takes precedence over
the call forwarding settings in C-Soft.

Destination field
The Destination field is used to enter the phone number to forward incoming calls to when
the line is busy.

Address Book
The Address Book button is used to locate a phone number to enter in the Destination field.

Forward unanswered calls after check box

The Forward unanswered calls after check box indicates calls left unanswered are forwarded
to the phone number entered in the Destination after the amount of time configured in the
Forward unanswered all after seconds field.

Notice!
This check box can be used in combination with the Forward calls while busy option.
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31.84

Forward unanswered calls after seconds field

The Forward unanswered calls after seconds field is used to enter the amount of time, in
seconds, the call is left unanswered before it is forwarded to the phone number in the
Destination field.

Destination field
The Destination field is used to enter the phone number to forward unanswered calls after [X]
seconds.

Address Book
The Address Book button is used to locate a phone number to enter in the Destination field.

Apply button
The Apply button is used to save changes made to the Forward page.

To set up call forwarding, do the following:
1. From the Forward page, select the Forward all calls check box.
OR
Select the Forward calls while busy check box.
OR
Select the Forward unanswered calls check box.
2. Inthe Forward unanswered calls after seconds field, enter the amount of time in
seconds.
3. Inthe Destination field for the selected check box, enter the phone number the call is to
be forwarded to.
OR
Click the Address Book button.
The address book appears.
4. Select a phone number to forward calls to.
The phone number appears in the Destination field.
5. Click Select.
The window closes and the phone number appears in the selected field.
OR
Click Cancel
The changes are not accepted and the window closes.
6. Click Apply to accept changes.
The changes are applied.

Close button
The Close button is used to close the SIP Calls window.

Status Stack Programmed

The Status Stack Programmed window, shown in the Figure below, is used to pre-configure a
stack status which defines the user or group a particular status is sent. Programmed stack
statuses are used to execute an existing stack status in C-Soft Runtime.
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Stack Setup page
When Status Stack Programmed is chosen from the Ul Element drop down menu, the Stack
Setup page appears.

Notice!
This feature is only supported in FleetSync and NEXEDGE Direct IP.

To open the Stack Setup page, do the following:

1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4. From the Ul Element drop down menu, select Status Stack Programmed.
The Stack Setup tab appears.

5. Click the Stack Setup tab.

The Stack Setup window appears.

LI Element Setup @
Stack et
Add status Status Destination
Status Unit 1D Test 3 EMS 1
Test 3 ~| [Ems 1 v | Test2 ER 2
Group 1D Test 2 ER 12

I

Remove

Figure 31.91: Status Stack Programmed - Stack Setup Page
Add Status group box

Status drop down menu
The Status drop down menu is used to select an existing status you want to configure for the
stack setup.
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31.85

To create statuses, refer to “Status Message ID List window, page 187.

Unit ID drop down menu
The Unit ID drop down menu is used to select an existing Unit ID to send the status.

Group ID drop down menu
The Group ID drop down menu is used to select an existing Group ID to send the status.

Add button
The Add button is used to add the selected status and either the selected Unit ID or Group ID
to the Status/Destination display pane.

Status/Destination display pane
The Status/Destination display pane displays the preprogrammed status messages and the
destination each is sent to when the configured button is clicked.

Remove button
The Remove button is used to remove the selected preprogrammed status from the Status/
Destination display pane.

To remove a status from the Status/Destination display pane, do the following:

1. From the Status/Destination display pane, select the Status you want to remove.
2. Click the Remove button.

The Status is removed from the Status/Destination display pane.

Status Stack window

The Status Stack window, shown in the Figure below, is used to configure the window
appearance and functionality of the status stack, including the number of visible entries and
the actions to take when a failed attempt occurs. The Status stack window allow users to
select multiple statuses and send them.

Stack Setup page
When Status Stack Window is chosen from the Ul Element drop down menu, the Stack Setup
page appears.

To open the Stack Setup page, do the following:

1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4. From the Ul Element drop down menu, select Status Stack Window.
The Stack Setup tab appears.

5. Click the Stack Setup tab.

The Stack Setup window appears.
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LI Elernent Setup @
Stk Setup
Window Appearance
Maximum Mumber of Visible Entries: ]
Failed Attempts
Number of retries: 0
Retry wait: Ome
@ Resend immediately
(") Resend after stack completion
Figure 31.92: Stack Status Window - Stack Setup Page
31.85.1 Window Appearance group box
Maximum Number of Visible Entries field
The Maximum Number of Visible Entries field is used to set the maximum number of visible
entries inside a Stack window at one time.
The range for this field is 0-9.
Set Font button
The Set Font button is used to open the Font window. From this window you can set the font
you want to display in the Stack Status window.
31.85.2 Failed Attempts group box

Number of Retries field
The Number of Retries field is used to set the number of times the system retries the status.

The range for this field is 0-9999.

Retry Wait field
The Retry Wait field is used to set the amount of time to wait between status tries.

The range for this field is 0-9.
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Resend Immediately radio button
The Resend Immediately radio button is used to set the system to resend the failed status
immediately, regardless of the status of the status stack.

Resend After Stack Completion radio button
The Resend After Stack Completion radio button is used to set the system to resend the
failed status after the status stack has completely finished.

31.85.3 Status Stack window
The Status Stack window is used to display the status of stacks being sent such as the date,
time, channel, etc. This window is also used to administer status stacks - sent and failed
sends.

Notice!
This feature is only supported in FleetSync and NEXEDGE Direct IP.

Status Stack Window
. . Status:

Date Time Channel Statugs A UnitlD Status P~ o
01/07/20.. 083815 ConvT.  Fre 1 Failed .. .
01/07/20.. 083815 ConvT.  Fire 2 Failed

Users:
Radio 43C
Radio 41C
Add
Resend Clear Done Send
Add status and repeat if needed else send.

Figure 31.93: Stacked Status Window

Status Stack display pane

The Status Stack display pane displays columns of different information:
— Date Column - The date the status stack was sent.

—  Time Column - The time the status stack was sent.

—  Channel Column - The channel the status is sent from.

—  Status Alias Column - The name of the status sent.

— Unit ID Column - The User ID of the recipient of the status.
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—  Group ID Column - The Group ID of the group receiving the status.
—  Status Column - The Status of the stack sent. Available Statuses are:
Status drop down menu
The Status drop down menu is used to select the status alias. Doing this, refines the list of
statuses shown in the display pane, making it easier to find the particular status you are
searching. The selections listed in this menu are directly related to the statuses you created in
the Status Message ID List window. For more information, refer to “Status Message ID List
window, page 187”.
Groups display pane
The Groups display pane displays the groups, if any, associated with the selected status.
Users display pane
The Users display pane displays the users, if any, associated with the selected status.
Resend button
The Resend button resends a failed status. You can select more than one status to resend by
pressing the Ctrl key and selecting with the mouse which statuses you want to resend.
Clear button
The Clear button clears the Stacked Status window of all statuses.
Done button
The Done button closes the Stacked Status window.
Add button
The Add button adds more statuses to send
Send button
The Send button sends the selected statuses to the appropriate users or groups.
Refer to
—  Status Message ID List window, page 187

31.86 Supervisor

The Supervisor function allows a single dispatch location to seize control of a line or group of
lines.

In C-Soft Runtime, after clicking the Supervisor button, the console operator enters the 4-digit
PIN number. When the PIN is entered, a supervisor packet burst is sent to all selected lines.
When a console receives a packet burst, those lines are removed from local control. The
console operator of those lines is no longer able to hear receive traffic or create transmit
traffic.

Supervisor password and timeout are configured on the “Control Settings page, page 124”.
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31.87

31.88

To add a Supervisor button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Supervisor.
5. Click OK.
The button changes color and Supervisor appears on the button.

Refer to
—  Control Settings page, page 124

Talk Around button

The Talk Around button is used, on a per line basis, to toggle the radio talk around feature.
Talk around bypasses a radio repeater system, permitting direct radio-to-radio communication.

In C-Soft Runtime, after clicking the talk around button, the button changes colors and talk
around is enabled (the button position is down). After clicking the button again, talk around is
disabled (the button position is up).

To add a Talk Around button, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select Talk Around.
5. Click OK.
The button changes color and Talk Around appears on the button.

Text button

The Text button displays text or can serve as a colored space filler.

Notice!
There is no action associated with this Ul Button.

To add a text button, do the following:
1. From the Insert menu, select Add Ul Button.

A None button appears on the console window.
2. Right-click the None button.

A shortcut menu appears.
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4.
5.

From the shortcut menu, select Properties.

The Ul Element Setup window appears.

From the Ul Element drop down menu, select Text Button.
Click the Colors tab.

The Colors page appears.

From the Colors page you can enter the text and change the color you want on the button.
Also, you can leave the text field blank and change the color of the button to serve as a

colored space filler. For more information, refer to “Colors page, page 407”.

Refer to

Colors page, page 407

31.89 TX All

The TX All function allows the console operator to place all lines into a selected mode. A

subsequent PTT is then transmitted on all lines.

To add a TX All button, do the following:

1.

4.
5.

From the Insert menu, select Add Ul Button.

A None button appears on the console window.
Right-click the None button.

A shortcut menu appears.

From the shortcut menu, select Properties.

The Ul Element Setup window appears.

From the Ul Element drop down menu, select TX All.
Click OK.

The button color changes and TX All appears on the button.
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32

Ul Element Setup window - Add button

The Ul Element Setup window is used to configure the button to perform the assigned
command when clicked in C-Soft Runtime.

To open the Ul Element Setup window for a Ul Button, do the following:
1. Right-click the Ul Element button.
The properties menu appears.
2. Click Properties.
The Ul Element window appears.
—  Double-click the Ul Element button.
The Ul Element window appears.

Notice!

The first field on the Ul Element Setup window identifies the type of button you are
configuring and cannot be changed. In this case, it is Ul Element: Button. The type is
determined by the button you right-click.

32.1

Type page
The Type page, shown in the Figure below, is used to configure the type of function for the Ul

Element button. Some Ul Elements require further configuration and when selected from the
function drop down menu, additional configuration pages appear.

|l Blement: Button

Fitter: [AII - ]

Ul Blement Function:
[ ]

Line to Associate Function With:

SIP Diamondhead

Figure 32.1: Type Page - Ul Element Setup

Filter drop down menu
The Filter drop down menu is used to select a filter that shows only elements associated with
the type of filter chosen.

Available selections for this field are:
— All - All Ul Elements are available
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FleetSync - Ul Elements which can be used with FleetSync are available
MDC-1200 - Ul Elements which can be used with MDC-1200 are available
MOTOTRBO - Ul Elements which can be used with MOTOTRBO are available
P25-DFSI - Ul Elements which can be used with P25-DFSI are available
Phone - Ul Elements which can be used with Phone are available

SIP - Ul Elements which can be used with SIP are available

ADHB-4 Only - Only Ul Elements associated with the ADHB-4 are available
Crosspatch Only - Only Ul Elements associated with Crosspatch are available
FleetSync Only - Only Ul Elements associated with FleetSync are available
MDC-1200 Only - Only Ul Elements associated with MDC-1200 are available
P25-DFSI Only - Only Ul Elements associated with P25-DFSI are available
Paging Only - Only Ul Elements associated with Paging are available

Phone Only - Only Ul Elements associated with Phone are available

PTT Only - Only Ul Elements associated with PTT are available

SIP Only - Only Ul Elements associated with SIP are available

Ul Element Function drop down menu

The Ul Element Function drop down menu is used to select an operation for the button. For
more information on individual function configurations, refer to “U/ Element Functions

configuration, page 213”.

UI Element Setu

Type | Colors

IJI Blement: Button

Filter: [AII - ]

Ul Blement Function:

Active Emengency Window o~
Line to Ast ADHE-4 Mic Control E

ADHB-4 MEMA Hold =

ADHE-4 MENA Hook Control

ADHBE-4 NEMA-Indication

ADHE-4 NEMA-Mute

ADHE-4 Select Speaker Control

Mert

Ammnimmistine

Figure 32.2: Ul Element Function Drop Down Menu

Line to Associate Function With drop down menu

The Line to Associate Function With drop down menu is used to select a line to associate the
function with. Not all functions are associated per line. This field is grayed out if the Ul

element function is a global function.

OK button
The OK button saves the entries and closes the window.
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Ul Element Setup

Type  Colors Alert Setup

Ul Blement: Button

Filter: | All

Ul Blement Function:

Alert

Line 1

Line to Associate Function With:

The Alert Setup tab is
displayed when Alert is
selected in the

Ul Element Function field

e

Figure 32.3: Alert Setup Page - Ul Element Setup

Ul Element Setup
Type Colors Aert Setup
Tone Type:
(Ol (O Pulsed Tone () Hi-lo

Low Frequency: HZ Low/On Duration: | 1000  ms
Hi Frequency: 0 Hz

Taone Level: dB

Hi/Off Duration: 0 ms

Notice!

If the console contains a Ul Element button with no assigned function, ERROR! Button with

no a/ssigned Ul element function appears in the Design Errors window when the C-Soft
Designer is saved. Refer to the Figure below.
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ERROR! Button *ith Mo Azzigned Ul Element Function
Searching for Backup Line Button Errors
Searching for Per-Line Configuration Errorg---
Searching far Call “Windows Button Erars
Searching far Crogzpatch Buttan Errars
Searching for Dial Button Ermors
Searching far Emergency Button Emrors
Searching for Encryption Button Erors
Searching for Freq Button Ermors
Searching far Group Select Buttan Ermrars
Searching for GPS Button Ermors
Searching far Input Button Errors
Searching for Intercom Button Errors
Searching for Marker Tone Button Erars
Searching far Monitar Buttan Errars
Searching far Mute Button Errors
Searching far ADHB-4 Buttan Errors
Searching for Page Button Errors
Searching far Phone Buttan Ermors
Searching for PTT Button Emorg------- -
Searching for Fadio Button Errars-
Searching far Belay Butkan Errars--
Searching for Bx &l Button Errors
Searching for Scan Button Ermars
Searching for Select Button Ermors
Searching far SIP Call Contral Buttan Erars
Searching far Supervizar Button Errors
Searching for Talk Around Button Erors
Searching for Tw Al Button Emrors
Searching for Popup Emors
Searching for Yalume Control Errars
End aof Ermor List

Figure 32.4: Design Errors Window

32.2

Colors page

When Add Ul Button or Add popup Button is selected from the Insert Menu the Colors page
appears. This page also provides a visual display of the button in the up position with the

selected attributes, and can be pressed to display the button in its down state. Refer to the
Figure below.
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Ul Element Setup 4

Type  Colors

Button Lp Button Down Button Images

Lip Position Image: |:|
Button: gl Down Position Image: |:|

Text: [~ Ted: - Mote: To use the same image in both up and down
positions, set Down Position Image only

Border Color
Button |None Set Font
Up =
S C I
Button | Mone
Down
Text:

Figure 32.5: Colors Page - Ul Element Setup
Button Up and Button Down group box

Button drop down menu

The Button drop down menu displays the color of the button when it is available for selection
(Button Up) or when it is selected (Button Down). Default button colors are defined for each
Ul element function. The button colors can be changed by selecting the drop down menu to
open a color palette.

Text drop down menu

The Text drop down menu displays the color of the text on the button when it is available for
selection (Button Up) or when it is selected (Button Down). Default text colors are defined for
each Ul element function. The text colors can be changed by selecting the drop down menu to
open a color palette.

Button Images group box
The Button Images group box is used to add a graphic to a button. The Button Images group
box supports image types of .bmp, .png, .jpg, and .gif.

Note:

- For a transparent button when using a 24-bit color bitmap, use RGB color 192, 192, 192.
—  Suggested maximum image size is 1680 x 1050 pixels.

—  Suggested maximum resolution is 72dpi.

Only 24-bit and 32-bit .png files are supported.

Up Position and Down Position Image fields
The Up Position and Down Position image fields identify the image to use on the button. Use

the browse button E located next to the field to select the image.

To use the same image on the Up and Down button position, do the following:
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— Using the browse button located next to the Down Position Image field, select the image.
To use a different image for the Up and Down button position, do the following:
— Using the browse button located next to the image field, select the image for each field.
To clear an entry from the Up and Down button position Image fields, do the following:
—  Click the X button located next to the image field.
Button Up Text field
The Button Up Text field identifies the text displayed on the button when the button is
available for selection.
This field can contain up to 49 characters.
Button Down Text field
The Button Down Text field identifies the text displayed on the button when the button is
selected.
This field can contain up to 49 characters.
Border Color drop down menu
The Border Color drop down menu displays the color of the border around the button. The
border color can be changed by opening the palette with the drop down menu to select the
desired color. The button border is half of the grid size on the console window. This allows Ul
Elements with the same color border to be grouped together, or to help create a visual
separation between groups of buttons.
Set Font button
The Set Font button displays a Font window used to select the text attributes for the button
text.
OK button
The OK button saves the entries and closes the window.

32.3 Radio Command buttons

The Radio Command buttons, shown in the Figure below, allow the user to send a radio
command to specific user or group. If a keypad is present in the design file, Radio Command
buttons contain a single button and use the keypad’s destination as the command’s target.
However, if no keypad is present the button comprised of two individual buttons; the
command button and a drop down button.

COMMAND BUTTON

\ DROP DOWN BUTTON

Figure 32.6: Radio Command Button
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Radio Command drop down button
The Radio Command drop down button is used to display all the users or groups associated
with the radio command.

If no keypad is present, the following button function types display users in the drop down
list:

-  GPS Read

- GPS Trigger On

- GPS Trigger Off

-  Private Call

— Radio Call Alert

— Radio Call Type

— Radio Check

— Radio Disable

— Radio Enable

- Radio Select Call

— Radio Status Request
— Radio Regroup

— Radio Ungroup

- Remote Monitor

The following statuses display statuses in the drop down list:
—  Radio Status

The following button function types display groups in the drop down list:
—  Group Call

The following button function types display call priorities in the drop down list:
—  Call Priority

To select a user from the drop down list, do the following:
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1. Click the Radio Command button.
The drop down list opens displaying users/groups configured in the line’s signaling
system.

GPS Read

Fadio 20072
Fadio 2003
Radio 2004

Fadio 2005
Fadio 2006
Fadio 2007
Fadio 2008
Fadio 2004 j

2.  From the Radio Command drop down list, select an entry.
The Command Button displays the selected user name. When the command button is pressed,

the button’s configured command is sent to the selected.

Fadio 2000
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33 Ul Element Setup window - Add Clock

The Add Clock option inserts a clock on the console. C-Soft can support multiple clocks on a
design file for radio resources covering different time zones. The time and button format are
controlled with the Clock Control page.

While in C-Soft Runtime, the clock displays as configured. An example is shown in the Figure

below.

4:46:24 PM

Figure 33.1: Console Clock Example

To insert a clock button, do the following:
- From the menu bar, select Insert | Add Clock.
A clock button appears on the console.

33.1 Clock Control page

The Clock Control page, shown in the Figure below, appears when the clock is right-clicked.
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Clock Control

Time Format Time Source

(12 Hour @ 24 Hour lUse Local Computer Time

Time Cffset

Appearance

Backaround Color: GG - GMT

Border Calor: Date Format

Text Color: March 17, 2010

Baorder Thickness:

Figure 33.2: Clock Control Page
Time Format group box

12 Hour radio button
The 12 Hour radio button indicates the time displays in civilian time format.

24 Hour Radio Button
The 24 hour radio button indicates the time displays in military time format.

Appearance group box

Background Color drop down palette
The Background Color drop down palette is used to set the clock background color.

Border Color drop down palette
The Border Color drop down palette is used to set the clock border color.

Test Color drop down palette
The Text Color drop down palette is used to set the clock text color.

Border Thickness field
The Border Thickness field is used to set the clock border thickness.

The range for this field is 0 to 20.

Set Font button
The Set Font button is used to open the font window.
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Font window

The Font window, shown in the Figure below, indicates the font used to display the time on
the clock display. The font window includes standard options for Font, Font Style, and Size.
When you change the format, a preview of the text appears in the Sample field.

| Element St

Clock Contral

Font style:
Regular

. __| |Marrow Bold
Arial monospacec || |yarrow Bold It

Arno Pro Bold _ L
Arno Pro Caption Elnaliltallc | i

Arno Pro Display Black Obligue ™

Sample

AaBbYyiz

Figure 33.3: Font Window - Clock Control
Time Source group box

Use Local Computer Time check box

The Use Local Computer Time check box indicates the time that displays on the clock is
derived from the PC running C-Soft. Otherwise, an offset time must be selected from the Time
Offset drop down menu.

Time Offset drop down menu
The Time Offset drop down menu is used to select an offset time for the clock. The Use Local
Computer Time check box must be cleared for this field to be active.

Available selections for this field are:

GMT-12:00 GMT-11:00 GMT-10:00 GMT-09:00 GMT-08:00 GMT-07:00
GMT-06:00 GMT-05:00 GMT-04:00 GMT-03:30 GMT-03:00 GMT-02:00
GMT-01:00 GMT GMT+01:00 GMT+02:00 GMT+03:00 GMT+03:30
GMT+04:00 GMT+04:30 GMT+05:00 GMT+05:30 GMT+05:45 GMT+06:00
GMT+06:30 GMT+07:00 GMT+08:00 GMT+09:00 GMT+09:30 GMT+10:00
GMT+11:00 GMT+12:00 GMT+13:00
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Date Format drop down menu
The Date Format drop down menu is used to select the display format for the clock. The clock
control displays in the selected format.

Available selections for this field are:

Selection Console clock display format

None Date is not displayed. The clock only displays
the time.

Wednesday, March 17, 2010 Day of the Week, Month Day, Year (4-digit)

Wednesday March 17 Day of the Week Month Day

Wed March 17 Day of the Week Abbreviated Month Day

Wednesday Mar 17 Day of the Week Month Abbreviated Day

March 17, 2010 Month Day, Year (4-digit)

Mar 17, 2010 Month Abbreviated Day, Year (4-digit)

17-Mar-2010 Day-Month Abbreviated-Year (4-digit)

17-Mar-10 Day-Month Abbreviated-Year (2-digit)

March 17 Month Day

03/17/10 dd/mm/yy

03/17/2010 mm/dd/yyyy

17/03/2010 dd/mm/yyyy

17.03.2010 dd.mm.yyyy

2010-03-17 yyyy-mm-dd

17 March 2010 Day Month Year (4-digit)

17 Mar 2010 Day, Month Abbreviated, Year (4-digit)

2010 March 17 Year (4-digit) Month Day

2010 Mar 17 Year (4-digit), Month Abbreviated Day
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34 Ul Element Setup window - Add Frame

The Add Frame option inserts a Frame on the console. The button format and color are
controlled with the Frame Setup page.

To insert a Frame, do the following:
- From the menu bar, select Insert | Add Frame.
A Frame appears on the console.

File Edit View Run Help

= i Add Button .,.I
Add Clock

Add Frame

Add Frequency Control
Add Popup Button
Add Keypad

Add Text
Add Volume Control
Add VU Meter

Figure 34.1: Insert/Add Frame from Insert Drop Down Menu

Frame Setup page
The Frame Setup page, shown in the Figure below, appears when the Frame button is right-
clicked on the edge of the frame.

Frame Setup >

Border Width: EI
Border Calor: [ |*I

|:| Use Image: Browse ...

Figure 34.2: Frame Setup Page

Border Width field
The Border Width field is used to enter the border width of the frame.

The range for this field is 0 to 999.
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Border Color field

The Border Color field is used to select the border color of the frame.

Use Image check box

The Use Image check box indicates the frame displays the selected image file.

To select an image file, do the
—  Click the Browse button.

The Frame supports image types of .bmp, .png, .jpg, and .gif.

following:

Frarme Setup

| Browse ...

Pt

Figure 34.3: Use Image Check Box

Bosch Security Systems, LLC
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35

Ul Element Setup window - Add Frequency Control

The Frequency Control

The Frequency Control is used to change the frequency on a line. When a frequency is
changed, a burst of packets is sent onto the Ethernet network requesting the remote radio to
change to the new frequency of the selected line. Additionally, all other consoles on the
network must change to display the new frequency of the radio on that particular line.

A Frequency Control is composed of two buttons, (frequency up and frequency down) and the
current frequency display area.

FREQUENCY FREQUENCY
DOWN BUTTON UP BUTTON

e
f

CURRENT FREQUENCY DISPLAY

Figure 35.1: Frequency Control

The Frequency Control automatically contains all frequencies configured for the line, except
for frequencies configured for Pair Mode and are non-transmittable.

For more information, refer to “Fregs Button”.

Frequency Down button
The Frequency Down button is used to select the previous configured frequency.

Frequency Up button
The Frequency Up button is used to advance to the next configured frequency.

Current Frequency display

The Current Frequency display displays the active frequency on the line associated to the
frequency control. The selected frequency can be changed by either; clicking the Frequency
Down or Frequency Up buttons, or by clicking on the Current Frequency Display area and
selecting a frequency from a drop down list.

To scroll through the available frequencies, do the following:
—  Press and hold the Frequency Down or Up buttons.
The Frequency Control begins cycling through the available frequencies on the configured line.

To select a frequency while scrolling, do the following:
— Release the Frequency Up or Down button when the desired frequency is visible.

To select a frequency from the drop down list, do the following:

1. Click the Current Frequency Display area.
A drop down menu containing all available frequencies are displayed. Frequencies are
displayed in ascending numeric order starting at Frequency 1.
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35.1

2.  From the drop down menu, select the desired frequency.

1: Channel 1
2: Channel 2

3: Channel 3
4: Channel 4
5: Channel 5
6: Channel 6

Figure 35.2: Frequency Control Drop Down

When Scannable is selected for the line, right-click the frequency control to display a shortcut
menu that provides the console operator the ability to add or remove the currently selected
frequency from the scan list.

When a frequency is in the scan list, the B icon appears next to the frequency in the
Frequency Display area and in the Frequency drop down list. Parallel consoles are also alerted
to update their display if a frequency is added or removed from the scan list.

For more information refer to “Scannable Check Box” on “Scannable Check Box”.

Add Frequency Control
The Add Frequency Control function inserts a Frequency Control on the console. The button
format and color are controlled with the Frequency Control page.

To insert a frequency control button, do the following:
—  From the menu bar, select Insert | Add Frequency Control.
A Frequency Control appears on the console.

Colors page

The Colors page, shown in the Figure below, is used to select the settings for the Orientation,
Arrow Button Settings, and Text settings.
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I EEoent cent

Colors | Frequency Contral

Orientation Amow Button Settings Text Settings

Button Size: 30 Piels

-

() Vertical IUp Color: - |"

Border Color Down Calar; |:||v|
— e

Group 100

Figure 35.3: Colors Page - Ul Element Setup

Orientation group box
The Orientation group box specifies whether the Frequency Up and Down buttons are placed
to the left and right of the control or the top and bottom of the control.

Horizontal radio button
The Horizontal radio button indicates the Frequency Up and Down buttons are drawn to the
right and left of the frequency display area.

Figure 35.4: Frequency Control in the Horizontal Orientation

Vertical radio button
The Vertical radio button indicates the Frequency Up and Down buttons are drawn to the top
and bottom of the frequency display area.

Figure 35.5: Frequency Control in the Vertical Orientation
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Border Color group box

Border Color drop down menu

The Border Color drop down menu displays the color of the border around the frequency
control. The border color can be changed by opening the palette with the drop down menu to
select the desired color. The frequency control border is half of the grid size on the console
window. The frequency control border being half the size of the grid size allows Ul Elements
with the same color border to be grouped together, or to help create a visual separation
between groups of Ul Elements.

Arrow Button Settings group box
The Arrow Button Settings group box contains settings which control the appearance of the
Frequency Up and Down buttons.

Button Size field

The Button Size field sets the height (if the orientation is set to vertical) or width (if the
orientation is set to horizontal) of the Frequency Up and Down buttons The button size field
allows for a larger drop down button to accommodate users of touch screen monitors.

The range for this field is 0 to 200.
The default value for this field is 17.

Up Color drop down menu

The Up Color drop down menu displays the color of the button when it is available for
selection (Button Up). The button colors can be changed by selecting the drop down menu to
open a color palette.

Down Color drop down menu

The Down Color drop down menu displays the color of the button when it is selected (Button
Down). The button colors can be changed by selecting the drop down menu to open a color
palette.

Arrow Color drop down menu

The Arrow Color drop down menu displays the color of the arrow in the drop down button.
The arrow color can be changed by opening the palette with the drop down menu to select
the desired color.

Text Settings group box
The Text Settings group box properties control the appearance of the Frequency Display area
and the Frequency drop down list.

Background Color drop down menu

The Background Color drop down menu displays the background color of the Frequency
Display area and Frequency drop down list. The background color can be changed by selecting
the drop down menu to open a color palette.

Text Color drop down menu

The Text Color drop down menu displays the color of the text in the Frequency Display area
and Frequency drop down list. The text colors can be changed by selecting the drop down
menu to open a color palette.
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Set Font button
The Set Font button displays a Font window used to select the text attributes for the
Frequency Display area and Frequency drop down list.

OK button
The OK button saves the entries and closes the window.

35.2 Frequency Control page

The Frequency Control page, shown in the Figure below, is used to select the Frequency List
Settings and the Scrolling Settings.

Type |Cn|or5| Frequency Contral |

Frequency List Settings Scrolling Settings
Scrollbar Width: 17 Pixels

Minimum Slider Size: 17 Pixels
Initial Delay: 500

Repeat Delay: 100
Ertry Spacing: &  Pixels

Visible Entries: 10

Figure 35.6: Frequency Control Page - Ul Element Setup

Frequency List Settings group box

The Frequency List group box properties control the appearance and the display location of
the Frequency drop down list. The Frequency List appears when the user clicks the Frequency
Display area and disappears when either a frequency has been selected or the user has
clicked on another control.

Drop Down Direction radio buttons
The Drop Down Direction group box is used to select the direction the drop down list
containing the list of available frequencies is displayed relative to the frequency control.

Above radio button
The Above radio button indicates the drop down list is displayed above the frequency control.
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Below radio button
The Below radio button indicates the drop down list is displayed below the frequency control.

Left radio button
The Left radio button indicates the drop down list is displayed to the left of the frequency
control.

Right radio button
The Right radio button indicates the drop down list is displayed to the right of the frequency
control.

Entry Spacing field

The Entry Spacing field is used to enter the amount of space in pixels between individual
entries in the drop down list. The valued entered for Entry Spacing and the font type
determine the height of the individual entries in the drop down list. When using a touch
screen monitor the entry spacing value can be increased to allow individual entries to be
selected from a touch screen.

The range for this field is 0 to 99.
The default value for this field is 8.

Visible Entries field
The Visible Entries field is used to enter the number of frequencies visible in the drop down
list without scrolling.

The default value for this field is 10.
Scrolling Settings group box

Scrollbar Width field
The Scrollbar Width field is used to set the width in pixels of the scrollbar in the drop down
list.

The default value for this field is 17.

Minimum Slider Size field

The Minimum Slider Size field is used to set the minimum height of the scrollbar’s thumbtack
slider in the drop down list. The thumbtack slider is sized proportionally to the total number
of entries in the list and the number of entries which are displayed. The minimum slider size
ensures the scrollbar will always be as large as the entered value.

The default value for this field is 17.

Initial Delay field

The Initial Delay field is used to set the number of milliseconds a Frequency Up or Down
button must be held down before the frequency control begins scrolling through the available
frequencies. The larger the value, the longer the Frequency Up or Down buttons must held
before scrolling begins.
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The range for this field is 10 to 9999.
The default value for this field is 500.

Repeat Delay field

The Repeat Delay field is used to set the number of milliseconds between frequency changes
once the Frequency Control begins scrolling. The larger the value, the slower the Frequency
Control will cycle though the available Frequency List.

The range for this field is 10 to 9999.
The default value for this field is 100.
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36 Ul Element Setup window - Add Keypad

Use the Keypad Ul Element Properties to configure the colors associated with each Mode;
Common, Contact, Manual, and History. The Keypad GUI Element Settings window contains
five pages: Type, Common, Contact Tab, Manual Tab, and History Tab.

To customize the Keypad Graphical User Interface, do the following:
1. From the Insert menu, select Add Keypad.
The keypad module is created on the Designer desktop.
2. Right-click on the keypad.
A popup menu appears.
3. From the popup menu, select Properties.
The Ul Element Setup window appears.

Type |Cummnr1 I Conrtact Tab I Manual Tab | History Tab

Il Element : Keypad

|l Element Function:

Keypad P w

Line to Associate Function With:

Line 1

4. Click each tab to configure colors for the associated buttons and fields.

36.1 Common page

The Common page is used to set the appearance settings for common keypad window
elements shared between multiple pages.
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Ul Element Setup )4

Type Common  Cortact Tab  Manual Tab  History Tab

Line/Contact Display Settings Separator/Background Border Settings

Line Background Color: [N |1r| Background Color [ IvI Border Width: D

Line Text Color: 1 |v| Border Color: =
line Fori Mode Button Settings

Calar Up: | |v|
Uger/Alias = ]
Background Color: QI Color Down: QI
User/Alias Text Color: |v| Text Color Up: - |v|

AN/ Mias Fort Text Color Down: I |'| Status Settings

Background Color: [ |-|
Search/UserlD -
Background Color: —I Status Text Color: I IvI

Contacts: Contacts
e — s
History |

Mode Font

Manual: Manual

Search/UserlD Fort History: History Default Apphy

Figure 36.1: Keypad GUI Element - Common Page
Line Contact display settings

Line Background Color drop down palette
The Line Background Color drop down palette is used to set the background color of the
selected contact area.

Line Text Color drop down palette
The Line Text Color drop down palette is used to set the text color of the selected contact
area.

Line Font button
The Line Font button opens the Font window. From this window, you can set the font of the
selected contact area.

User/Alias Background Color drop down palette
The User/Alias Background Color drop down palette is used to set the background color of
the User/Alias display area.

User/Alias Text Color drop down palette
The User/Alias Text Color drop down palette is used to set the text color of the User/Alias
display area.

ANI/Alias Font button
The ANI/Alias Font button opens the font window. From this window, you can set the font of
the User/Alias display area.
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Search/UserID Background Color drop down palette
The Search/UserID Background Color drop down palette is used to set the background color
of the Search/UserlD area.

Search/UserID Text Color drop down palette
The Search/UserlID Color drop down palette is used to set the text color of the Search/UserID
entry area.

Search/UserlD Font button
The Search/User ID Font button opens the Font window. From this window, you can set the
font of the Search/UserlID Entry area.

Separator/Background group box

Separator/Background Color drop down palette

The Separator/Background Color drop down palette is used to set the color of other non-
defined background areas.

Mode Button Settings group box

Color Up Color drop down palette
The Color Up Color drop down palette is used to set the color of the mode buttons in the
unpressed state.

Color Down Color drop down palette
The Color Down Color drop down palette is used to set the color of the mode buttons in the
depressed state.

Text Color Up Color drop down palette
The Text Color Up Color drop down palette is used to set the text color of the mode buttons
in the unpressed state.

Text Color Down Color drop down palette
The Text Color Down Color drop down palette is used to set the text color of the mode
buttons in the depressed state.

Mode Font button
The Mode Font button opens the Font window. From this window, you can set the of the
Mode buttons.

Contact Button Label field
The Contact Button Label field is used to enter the text shown on the Contacts button.

Manual Button Label field
The Manual Button Label field is used to enter the text shown on the Manual button.

History Button Label field
The History Button Label field is used to enter the text shown on the History button.
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36.2

Border Settings group box

Border Width field
The Border Width field is used to set the border width for the entire keypad control.

Border Color drop down palette
The Border Color drop down palette is used to set the border color for the entire keypad
control.

Status Settings group box

Background Color drop down palette
The Background Color drop down palette is used to set the background color of the status
display area.

Status Text Color drop down palette
The Status Text Color drop down palette is used to set the text color of the status display
area.

Status Font button
The Status Font button opens the Font window. From this window, you can set the font of the
status display area.

Default button
The Default button is used to return all the Common Tab settings back to the factory default
settings.

Apply button
The Apply button is used to apply the modifications made to the Common Tab settings.

Contact Tab page

The Contact Tab page is used to set the appearance settings for the Contact window.
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g A
UT Element Setup lﬂ
Type | Common | Contact Tab | Manual Tab | History Tab |

Contact Fitter Settings Contact List Settings Shared Settings
Background Color: Background Calor: —1 |v| [ Filter + Contact Fort
Text Color: [ ] |v| Attemate Color: —1 |v|
Button Color: —1 |*I Text Color: ] |'|

Button Text Color: NN |'I

Entry Spacing: 12

Row Height: 16

Scrollbar Width: 25
Button/Scrollbar 0

Width: Minimum Slider Height: 20

Scroll Slider Height: 20

Visible Entries: 10

Apply

b

Figure 36.2: Keypad GUI Element - Contact Tab Page

Contact Filter Settings group box

Background Color drop down palette
The Background Color drop down palette is used to set the background color of the filter
area.

Text Color drop down palette
The Text Color drop down palette is used to set the text color of the filter area.

Button Color drop down palette
The Button Color drop down palette is used to set the color of the button in the filter area.

Button Text Color drop down palette
The Button Text color drop down palette is used to set the color of the arrow on the button in
the filter area.

Entry Spacing field
The Entry Spacing field is used to enter the spacing between entries in the filter entry list.

Button/Scrollbar Width field
The Button/Scrollbar Width field is used to enter the width of the filter selection button and
filter entry list scrollbar.

Scroll Slider Height field
The Scroll Slider Height field is used to enter the height of the filter entry list scrollbar’s
slider.
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36.3

Visible Entries field

The Visible Entries field is used to enter the number of entries displayed at once in the filter
entry list.

Contact List Settings group box

Background Color drop down palette
The Background Color drop down palette is used to set the background color of every odd
row of the Contact List area.

Alternate Color drop down palette
The Alternate Color drop down palette is used to set the background color of every even row
of the Contact List area.

Text Color drop down palette
The Text Color drop down palette is used to set the text color of the Contact List area.

Row Height field
The Row Height field is used to enter the height of each row in the Contact List.

Scrollbar Width field
The Scrollbar Width field is used to enter the width of the Contact List scrollbar.

Minimum Slider Height field
The Minimum Slider Height field is used to set the minimum slider height of the Contact List
area.

Display drop down menu
The Display drop down menu is used to set how the Contacts information is displayed in the
Contact List.

Available options are:

- Alias +ID

- Alias

Shared Settings group box

Filter + Contact Font button
The Filter + Contact Font button opens the Font window. From this winder you can set the
font of both the filter entry list and the contact list.

Apply button
The Apply button is used to apply the modifications made to the Contact Tab settings.

Manual Tab page

The Manual Tab page is used to set the appearance settings for the Manual window.
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LI Element Setup @

| Type | Common | Contact Tab | Manual Tab | History Tabl

Delete Button Settings Keypad Button Settings
Button Up: | |"’| Button Up:

Button Down: [ Ivl Button Down: [ |v|
Brow Color: 1 |"I Button Text Up: [ |"|

Apply

Figure 36.3: Keypad GUI Element - Manual Tab Page
Delete Button Settings group box

Button Up drop down palette
The Button Up drop down palette is used to set the color of the Delete button in the
unpressed state.

Button Down drop down palette
The Button Down drop down palette is used to set the color of the Delete button in the
depressed state.

Arrow Color drop down palette
The Arrow Color drop down palette is used to set the color of the arrow on the Delete button.

Keypad Button Settings group box

Button Up drop down palette
The Bottom Up drop down palette is used to set the color of the manual entry button in the
unpressed state.

Button Down drop down palette
The Button Down drop down palette is used to set the color of the manual entry button in the
depressed state.

Button Text Up drop down palette
The Button Text Up drop down palette is used to set the text color of the manual entry button
in the unpressed state.
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36.4

Button Text Down drop down palette
The Button Text Down drop down palette is used to set the text color of the manual entry

button in the depressed state.

Button Font button
The Button Font button opens the Font window. From this window, you can set the font for

the manual entry buttons.

Apply button
The Apply button is used to apply the modifications made to the Manual Tab settings.

History Tab page

The History Tab page is used to set the appearance settings for the History window.

UI Element Setup |ﬁ

| Type | Comman | Contact Tab | Manual Tab | History Tab

History List Settings
Backaground Color: [ Ivl

Altemate Color: —1 |.|

Text Colar:
Row Height: 32
History List Font ]

Apply

Figure 36.4: Keypad GUI Element - History Tab Page
History List Settings group box

Background Color drop down palette
The Background Color drop down palette is used to set the background color of every odd

row of the History List area.

Alternate Color drop down palette
The Alternate Color drop down palette is used to set the background color of every even row

of the History List area.
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Text Color drop down palette
The Text Color drop down palette is used to set the text color of the History List area.
Row Height field
The Row Height field is used to enter the height of each row in the History List.
History List Font button
The History List Font button opens the Font window. From this window you can set the font
for the History List window.
36.5 Keypad
The Add Keypad option is used to add the keypad module, shown in the Figure below, to your
C-Soft Console. The keypad module is used to specify a destination address for radio
operations. Use the following Table to see the different radio operations for the different
system types.
FleetSyn |Telex- |MDC- [MOTOTRBO |P25- Sprint AlS |NEXEDGE |NEXEDG | Telex-
c Serial 1200 DFSI Direct Control EIP Enhanced-
Connect Station Interface | ANI
Radio X X X X
Check
Radio X X X X X X X X X
Enable/
Disable
Call Alert X X X X X X X
Select Call X X X X X
Remote X X X X X X X X
Monitor
Status X X X X X X X
Request
Status X X X X X X
Message
GPS X X X X
Operation
s
Private X X X X X X X X
PTT
Group PTT X X X X X X X
Radio X X
Regroup
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Radio
Ungroup

Table 36.8: Radio Operations Supported by System Type

NAVIGATION: Select Insert | Add Keypad from the menu bar.

Search...

Selected Line

All Contacts

John Smith
5551234
Contact A Alias
Contact A ID
Contact B Alias
Contact B 1D
Contact C Alias
Contact C ID
Contact D Alias
Contact D ID
Contact E Alias
Contact E ID
Contact F Alias
Contact F ID
Contact G Alias
Contact G ID
Contact H Alias
Contact H 1D
Contact | Alias

;ullﬂ

=

Ready

Figure 36.5: Keypad Module - C-Soft

The keypad module has three modes of operation:
Contacts Mode - Used to search for contact/user IDs.

Manual Mode - Displays a numeric keypad on the screen while allowing for keyboard

input.

History Mode - Displays a list of recently used contact/user IDs and can be used to
specify destination for new operations.
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Selected Contact

Selected Line

Displ o) -
isp aY Selected Line Display
User Entry~_ i o St ]
Field \‘aeamn 74— Backspace
| Button
Contacts=—— k“H
Mode I'\.:130t§g
Manual
Mode

Figure 36.6: Keypad Module - Common Controls

Selected Line Display
The Selected Line display shows the currently selected line. For example, Line 1.

Selected Contact display

The Selected Contact display shows the currently selected contact. The selected contact is
the destination of any radio command messages sent from the corresponding radio command
buttons.

User Entry field
The User Entry field is used to enter information necessary for keypad operation. Depending
on the current mode selected, this field behaves differently.

— In Contact mode, the user entry field is used to search contacts. When text is entered,
the contact list updates to only show contacts whose User IDs or Aliases match (or
partially match) the entered text. This search is not case sensitive. If no users match the
entered text, the entered text becomes the selected contact (for example, manually
entering an ID).

— In Manual mode, the user entry field is used to display the entered digits.

— In History mode, the user entry field is used to display the entered digits.

Contacts Mode button
The Contacts Mode, shown in the Figure below, is used to search for contacts. The use of
filters further narrows the search parameters when looking for contacts.
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All Contacts

[Conce | Mo | ey

[v]

John Smith
5551234
Contact A Alias

Contact A ID
Contact B Alias
Contact B ID
Contact C Alias
Contact C ID
Contact D Alias
Contact D ID
Contact E Alias
Contact E ID
Contact F Alias
Contact F ID
Contact G Alias
Contact G 1D

Meamtnand U AlRAaA

Figure 36.7: Keypad Module - Contacts Pane

Filter drop down menu

=

The Filter drop down menu is used to select a filter to use when looking for contacts. When a
filter is selected from the list, only contacts contained within the specified filter are shown.

Filters are created using the Filter List Setup window, refer to “Filter List Setup window, page
177”. Once filters are created, user |IDs are associated with filters in the User ID List Setup
window, refer to “User ID List window, page 179”. Group IDs are associated with filters in the

Group ID List Setup window, refer to “Group ID List window, page 183".

Contact List pane

The Contact List pane displays all contacts associated with the selected line. When a contact

entry is selected, the selected Contact Display is updated with the selected contact
information. Any radio operations use the selected contact’s as the destination.

If the contact uses a System List, only contacts within the system list are shown.

Signaling/System Types Requiring a System

List

Signaling/System Types Not Requiring a
System List

-  FleetSync
- Telex-Serial
- MDC-1200
-  MOTOTRBO
- P25-DFSI

- NEXEDGE

Generic

5/6 Tone

iDen

Sprint Direct Connect
AIS
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Manual Mode

The Manual Mode, shown in the Figure below, is used to manually enter the desired ID. The
numeric keypad can be used with a mouse, but is used largely for touch-screen users or users
without a keyboard.

If the manually entered ID matches a known User ID or Group ID, the selected contact display
area display the matching contact information.

Notice!
The ABC button displays the DTMF buttons A - F.

Figure 36.8: Keypad Module - Manual Panel

History Mode

The History Mode, shown in the Figure below, is used to view any operations initiated that
use the keypad’s destination as a target. When a history event is selected, the contact
associated with the selected history event appears in the Selected Contact area. Each entry
includes:

—  Operation Destination (the Contact ID or Alias, if known)

—  Operation Type

— Line name on which the operation was sent

—  Timestamp of when the operation occurred.
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Figure 36.9: Keypad Module - History Pane

Status Bar

John Smith \
Radio Check Line X

LItiznin Line A
Dial

Contact B Line B
Page

Contact C .
Radio Check — s

12:00 PM

12:01 PM

12:02 PM

12:03 PM

The Status Bar displays relevant operation information. This includes notifications of
specifying an invalid User ID, operation sent notifications, and operation results notification.

Ready

Figure 36.10: Keypad Module - Status Bar
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37

Ul Element Setup window - Add Popup Button

Select Add Ul Popup Button from the Insert menu to place a popup button in the upper left
hand corner of the console window. Popup buttons can also be added to a popup window.
The popup button displays an activity icon when a line inside the popup window has incoming
audio traffic. The activity icon can be customized by creating a graphic file named
activity.bmp. This file must be located in the same directory as the csoftruntime.exe file.

To add a popup button to the C-Soft Console window, do the following:
—  From the Insert menu, select Add popup Button.
A popup button appears on the C-Soft console window.

To open a popup window in C-Soft Designer, do the following:
1. Right-click a Ul element popup button.

A shortcut menu appears.
2.  From the shortcut menu, select Open popup.

A popup window appears.

To close a popup window, do the following
—  Click the X in the upper-right corner of the popup window.

The popup window closes.

To resize the popup window in C-Soft Designer, do the following:
1. Right-click the popup button.
2.  From the Shortcut menu, select Open popup.

+ =
3. Click resize buttons * Al ] to increase/reduce width/height.
OR
Press the Ctrl key while pressing the arrow keys on your keyboard.

Note:

- If, as a result of resizing, the window extends past the window view, move the popup
button to a new position.

—  The popup window cannot be resized in C-Soft Runtime.

To insert items into the popup window, do the following:
1. Right-click the Popup button.
A flyout menu appears.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



440 en | Ul Element Setup window - Add Popup Button C-Soft 7.700

2.  From the flyout menu, select Open Popup.
The Popup window opens.

3. Right-click anywhere inside the Popup window.
A flyout menu appears.

4. From the flyout, select the desired element.

5. Repeat as necessary.

Notice!
The popup button must be selected in order to insert items into a popup window.

To edit items in the popup window, do the following:
1. Open a popup window as described above.
2. Select the item(s) in the popup window.
Red targets appear on the items.
3. Perform the desired action on the selected item(s).

Notice!
The parameters for the item(s) can be changed, and the item(s) can be cut, copied, or moved
in the same way as an item(s) is when it is placed directly on the console window.

37.1

Popup Window Setup page

The Popup Window Control function creates a popup window to which additional controls and
button can be added. The popup window is one of the most versatile user interface options.
Popup windows can be used to group together similar line functions, pages, alerts, or any
combination of button and slider controls. Popup buttons can even be included within a
popup window allowing for nested controls. When popup Window Control is selected from
the Ul Element Function drop down menu, the Popup Window Setup page appears.
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Ul Element Setup

Type  Colorz  Popup Window Setup
Window Options
[ ] Allow window to be moved

Automatically close children popup windows
[]Open window on activity

Background Cor. NN

Button Options

] Highlight button on focus

Logo

Image Filename:

Position: Upper Left

ot

Figure 37.1: Popup Window Setup Page

37.1.1 Window Options group box

Allow window to be moved check box

37.1.2

The Allow window to be moved check box indicates the popup window can be moved in C-
Soft Runtime.

Automatically close children popup windows check box

The Automatically close children popup windows check box indicates when a popup window
is closed, any associated children popup windows automatically close. When cleared, the
children popup windows remain open after the parent window has closed.

Open Window on Activity check box
The Open Window on Activity check box indicates the popup window automatically opens
when activity is occurring within the popup window.

Background Color drop down palette
The Window Background Color drop down palette is used to set a background color for the
popup window.

Button Options group box

Highlight button on focus check box
The Highlight button on focus check box is used to indicate to the user when the button’s
child window is in focus.
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37.1.3

37.2

37.2.1

Focus Color drop down palette
The Focus Color drop down palette is used to select the color the button changes to when
the button window it opens is under focus.

Logo group box

Image Filename field

The Image Filename field identifies the file path of a image to be displayed in the background
of the Console window.

This field can contain up to 255 characters.

C-Soft supports 1-bit, 4-bit, 8-bit and 24-bit bitmaps, .png, .jpg, and .gif file formats.

Browse button
The Browse button opens the Open window, which is used to navigate to the logo image file.

To change the image file, do the following:
1. Click Browse.
The Open window appears.
2. Select the file you want to use for the image.
3. Click Open.
The path to the image file appears in the field.

Position drop down menu
The Position drop down menu is used to select the location of the image logo on the console
window.

Available selections for this field are: Upper-Left, Upper-Right, Lower-Left, Lower-Right, Center
and Stretch.

Popup Webpage

The Popup Webpage function provides the ability to embed a webpage in the popup window.
When the popup Webpage button is pressed, the specified webpage is displayed in the popup
window.

A maximum of three webpages are allowed on any console design.

Popup Webpage Setup page
When the popup Webpage function is selected, the Popup Webpage Setup page appears.
Refer to the Figure below.
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37.3

Type | Colors | Popup Webpage Setup

Webpage URL: |

Refresh Interval: 0 seconds (0=0nly at Startup)

[7] Refresh when popup button is pressed

Figure 37.2: Popup Webpage Setup Page - Ul Element Setup

Webpage URL field
The Webpage URL field identifies the URL of the webpage to display in the popup window.

This field can contain up to 98 characters.

Refresh Interval field

The Refresh Interval field identifies the amount of time that passes before the webpage
displayed in the popup window is automatically refreshed. For example, if a radar weather
map is displayed on the console operator’s window, an entry of 300 in this field automatically
refreshes the radar image every five minutes. A value of zero indicates the webpage refreshes
on C-Soft application startup.

The range for this field is 0 to 999.

Refresh when a popup button is pressed check box
The Refresh when popup button is pressed check box indicates the webpage display is
refreshed when the popup Webpage button is pressed.

Type page
The Type page is used to configure the type of function for the Ul Element Popup (Control)

button. Some Ul Elements require further configuration and when selected from the function
drop down menu additional configuration pages appear. Refer to the Figure below.
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374

Type | Colors | Call List Options |

Ul Element: Popup Button

|l Blement Function:
| Popup Call History -]

_ Popup Call Histo
Line to As
Paopup Window Control

ST OTarmmararEgd Sl

Figure 37.3: Type Page - Ul Element Setup Popup Control

Ul Element Function drop down menu
The Ul Element Function drop down menu is used to select an operation for the popup
button. Each function configuration is described in the following section.

Available selections for this field are:
- Popup Call History

- Popup Webpage

- Popup Window Control

Refer to
—  Instant Recall, page 278

Popup Global Call History

The Popup Global Call History function creates a button used to open the Global Call History
window.

In C-Soft Runtime, the Global Call History is used to view per line calls received and stored in
the history log. The Global Call History window also logs the state changes of input indication
and relays from an ADHB-4 or NEO-10. In addition to displaying the global call history, the log
can be used to play back received audio. Transmitted audio is only recorded on Phone or SIP
Phone lines.

Global Call History stores up to 10 minutes of audio across all lines not enabled for Per Line
Recording. For lines enabled for Per Line Recording, Global Call History window displays an
additional 60 minutes of audio for each enabled line. Silence between calls is not stored.

Note:

—  C-Soft supports one Global Call History window per console. If a Global Call History
window button already exists, the Popup Call History function is not available for
selection.
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—  Recording calls is also accomplished by adding an Instant Recall Recording button to the
console, refer to “Instant Recall, page 278’ for details.
—  While the call history audio is playing, the recorder continues to record incoming calls.

374.1 Call List Options page
When the popup Call History function is selected, the Call List Options page appears. Refer to
the Figure below.

Ul Element Setup -
Type Colors Call List Options
Logging Options

Inchude Muted Calls in List
Include NEQ Changes in List

Column Setup
Select the columns to be displayed:

Call Duration Line Mame
List Appearance Caller ID Status
Call Window Lines Comments [ Talkgroup
Call Window Font Size Date Time

[] Direction IUser ID

Frequency

Figure 37.4: Call List Options Page - Ul Element Setup

Logging Options group box
Include Muted Calls in List check box

The Include Muted Calls in List check box indicates muted calls are included in the call
history log.

Include NEO Changes in List check box
The Include NEO Changes in List check box indicates the NEO-10 event changes are included
in the call history log.

List appearance

Call Window Lines field
The Call Window Lines field identifies the number of lines of text saved in the call history log.

The range for this field is 1 to 500 lines.
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Call Window Font Size field
The Call Window Font Size field identifies the font size of the text in the call history log.

The range for this field is 0 to 72.
The default is 8 point.

Column Setup group box

The Column Setup group box allows the user to determine which columns are visible in the
Global Call History window. The respective columns display in the Global Call History window
if selected and hidden if not selected.

Call Duration check box
The Call Duration check box is used to add a Call Duration column to the Global Call History
window.

Caller ID check box
The Caller ID check box is used to add a Caller ID column to the Global Call History window.

Comments check box
The Comments check box is used to add a Comments column to the Global Call History
window.

Date check box
The Date check box is used to add a Date column to the Global Call History window.

Direction check box
The Direction check box is used to add a Direction column to the Global Call History window.

Frequency check box
The Frequency check box is used to add a Frequency column to the Global Call History
window.

Line Name check box
The Line Name check box is used to add a Line Name column to the Global Call History
window.

Status check box
The Status check box is used to add a Status column to the Global Call History window.

Talkgroup check box
The Talkgroup check box is used to add a Talkgroup column to the Global Call History
window.
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Notice!
Only lines configured for P25-DFSI use the Talkgroup column.

37.5

Time check box
The Time check box is used to add a Time column to the Global Call History window.

User ID check box
The User ID check box is used to add a User ID column to the Global Call History window.

Global Call History window

The Global Call History window provides a log of past calls received by the console. The
operator uses the log to view previously received calls. In addition, the calls can be selected
for playback.

This log can contain up to 500 calls.

Per Line Call History : Line 1

Date Time Calling ID User D Status Duration Comments ~
lﬂ' 021212018 09:21:20 Group 1 Rob Stark Group Call 00:02
-F 021212018 09:18:27 Group 1 Aaron Earnst Fire 00:00 Fire reported 1207 P Street
i 02122016 0911914 Groupd Aaron Earnst Group Call 00:01
o) 021122018 09:19:07  Groupd Rob Stark Group Call 00:05
e 02122016 09:19:02  Group 1 Aaron Earnst Group Call 00:05 Save for supervisor
) 021122016 091856 Group 1 Rob Stark Group Call 00:05
.' 021212018 09:18:50 Group 1 Aaron Earnst Group Call 00:05
43 0212/2018 09:18:43  Group1 Aaron Earnst Group Call 00:05 Unit arrived on scene.
Qﬁ 021212018 09:18:37 Group 1 Rob Stark Group Call 00:08

021212018 09:18:33 Group 1 Rob Stark Lunch Break 00:00 Rob's break started 9:18

021212016 09:18:20 Group 1 Aaron Earnst Fire 00:00

0211212018 09:18:16 Group 1 Rob Stark Lunch Break 00:00

021212016 09:18:00 Group 1 Aaron Earnst Fire 00:00
cfi 02122016 091745 Group Aaron Earnst Group Call 00:03
ef) 02122016 091740 Group 1 Rob Stark Group Call 00.04
B nmmoones  anaTac ;emied P — i nn.na M
< >

m e =) ) | [00:00/00:05
E E [ ———————— |

Save to File

Figure 37.5: Global Call History Window

Save to File button
The Save to File button is used to save the currently selected items to a .csv file.

Notice!
IP-30XX devices do not have the Save to File button.
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To save a .csv file of the items in the list, do the following:

1. From the Per Line Call History list, select the items you want to save.
2. Click Save to File.

The Save window appears.

In the File name field, enter a name for your .csv file.

4. Click Save.

w

Done button
The Done button is used to close the window.

2021-06 | 14 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC



C-Soft 7.700 Ul Element Setup window - Add Text | en 449

38 Ul Element Setup window - Add Text

The Add Text option opens the Font window, shown in the Figure below.

NAVIGATION: Select Insert | Add Text from the menu bar.

Font window

The Font window is used to add descriptive text to the console window or to a popup
window. The Font window includes standard options for Font, Font Style, Size, and Color
formatting. When you change the format, a preview of the text appears in the sample field.

For more information, refer to “User interface element configuration, page 53”.

Font style:
Regular

Regular [N

. __ | |Marrow Bold
Arial monospacec || |Narrow Bold It

Arno Pro

In
E..

B

m |

Arno Pro Caption

hﬁ"&d‘&iﬁkﬂ'&ﬁ

1

Arno Pro Display Black Cbligue ™

Color: Sample

[ Ivelow
Horizontal

EnterText:

Figure 38.1: Font Window

Horizontal check box
The Horizontal check box indicates the text is displayed on the console window in a horizontal

orientation. If not selected, the text is displayed vertically.

Enter Text field
The Enter Text field identifies the text to place on the console window.

This field can contain up to 50 characters.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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39 Ul Element Setup window - Add Text Message Control

The Add Text Message Control window is used to send and receive text messages.

-
UT Element Setup @
Text Message
Common Settings Histony Text Entry
Border Width: 4 Incoming Text Color: Text Color- . |'|
Border Color- - Incoming Bk Color: [ |-|
L_IL . , | TextEntyFort |
Background Color: (- Outoing Text Color: NN -]
Outgoing Bk Calor: [~
Title gong _I Status
Backgound Color: <~ SoolbarWidh: 2 Text Color: NN ||
Text Color i+  Minimum Siider Height: 20 Bic Color: ]l
Title Font ] [ Higtary Font ] [ Status Font ]
| Defaut || Apply |

Figure 39.1: Ul Element Setup window - Text Message

Text Message page
When the Text Message Control function is selected from the Ul Element drop down menu,
Text Message page appears. Refer to the Figure above.

Common Settings group box

Border Width field
The Border Width field is used to set the outside border width of the control.

The range for this field is 0 to 20.

Border Color drop down menu
The Border Color drop down menu is used to set the outside border color.

Background Color drop down menu
The Background Color drop down menu is used to set the color of non-control areas.

Title group box

Background Color drop down menu
The Background Color drop down menu is used to set the background color of the title area.

Text Color drop down menu
The Text Color drop down menu is used to set the text color of the title area text.
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Title Font button
The Title Font button is used to sets the font of the title area text.

History group box

Incoming Text Color drop down menu
The Incoming Text Color drop down menu is used to set the text color of incoming text
messages.

Incoming Bk Color drop down menu
The Incoming Bk Color drop down menu is used to sets the background color of incoming text
messages.

Outgoing Text Color drop down menu
The Outgoing Text Color drop down menu is used to set the text color of outgoing text
messages.

Outgoing Bk Color drop down menu
The Outgoing Bk Color drop down menu is used to set the background color of outgoing text
messages.

Scrollbar Width field
The Scrollbar Width field is used to set the scrollbar width.

The range of this field is 10 to 100.

Minimum Slider Height field
The Minimum Slider Height field is used to set the slider height.

The range of this field is 10 to 100.

History Font button
The History Font button is used to set the font for all incoming and outgoing text messages.

Text Entry group box

Text Color drop down menu
The Text Color drop down menu is used to set the text color for the text entry area.

Text Entry Font button
The Text Entry Font button is used to set the text font for the text entry area.

Status group box

Text Color drop down menu
The Text Color drop down menu is used to set the color for the status area text.

Bk Color drop down menu
The Bk Color drop down menu is used to set the background color of the status area.

Status Font button
The Status Font button is used to set the font of the status area text.
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C-Soft 7.700

Default button
The Default button is used to reset all parameter settings to their default values.

Apply button
The Apply button is used to save changes made to the Text Message page.

To use the Text Message Control, do the following:

1.
2.

4.

Select the line on which to send the text message.
Using the keypad, select the destination for the text message.

The selected destination appears in the Destination Display of the Text Message Control.

Text Message

09:47:56: Anna: =
Short Message Line 1
09:54:50: To Bob:
Medium Message Line 1
Medium Message Line 2
10:01:01: Charlie: —
Long Message Line 1
Longhessage Line 2
Long Message Line 3
10:03:09: To Dan:
Short Message Line 1
10:07-21: Erica:
Medium Message Line 1

Send

Status

Enter text into the entry field.
OR

Click the QuickText button to select a pre-defined text message.

When finished, press the Send button.

The text message is sent, and displays as an outgoing message in the Text Message History
List. In addition, the Status Notification Area displays a notification that the text was sent.
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40

40.1

Ul Element Setup window - Add Volume Control

The Add Volume Control option is used to place a volume control slider, shown in the Figure
below, in the upper left-hand corner of the console window. This section provides information
on the functionality of the different volume controls selected from the Ul Element Function
drop down menu.

I

Figure 40.1: Volume Control Slider

Ul Elernent Setup

Type  Vol. Control

LIl Blement: Vaolume Control

LIl Blement Function:

Volume-Per Line w

Yolume-ADHE-4 NENA

Line to As3Volume-Audliary Track Left
Volume-Auxiliary Track Right
Volume-Master Select
Volume-Master Unselect
Vaolume-Per Line

Figure 40.2: Type Page - Ul Element Setup Volume Control

To access the Ul Element Setup window for Volume Control, do the following:
1. From the Insert menu, select Add Volume Control.
A Volume Control slider appears on the C-Soft console window.
2. Right-click the Volume Control slider.
A shortcut menu appears.
3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

Type page
When Add Volume Control is selected from the menu bar, the Ul Element window opens to the
Type page. Refer to the Figure above.

Ul Element Function drop down menu
The Ul Element Function drop down menu is used to select the desired functionality for the
volume control.

Available selections for this field are:
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Volume-Master Select - Allows a single volume control that manipulates the volume of all
selected audio.

Volume-Master Unselect - Allows the console operator to change the unselect volume for
all lines.

Volume-ADHB-4 NENA - Allows the console operator to change the volume of NENA audio
when operating with ADHB-4.

Volume-Auxiliary Track Left - Allows the console operator to change the left channel
volume of the Auxiliary audio when operating with an ADHGB-4 Gen 2.

Volume-Auxiliary Track Right - Allows the console operator to change the right channel
volume of the Auxiliary audio when operating with an ADHGB-4 Gen 2.

Volume-Per Line - Allows the console operator to control the relative level of the selected
line with respect to other lines.

Line to Associate Function With drop down menu

The Line to Associate Function With drop down menu is used to select the line to associate
the button or volume control with. This field is only enabled when the selected entry in the Ul
Element Function field requires a line association.

OK button
The OK button saves the entries and closes the window.

Notice!

If the associated line is muted, the volume control for the line is disabled.

40.2 Vol. Control page

When the Vol Control tab is selected from the Ul Element Setup window, the Vol. Control
page appears. Refer to the Figure below.
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Vol Control

Orientation
() Horizontal

Minimum Volume: 0

Maxdimum Gain:

Slider Background Calar:

Figure 40.3: Vol. Control Page - Ul Element Setup Volume Control

Orientation group box
The Orientation group box contains buttons to orient the volume control.

Horizontal radio button
The Horizontal radio button is used to position the volume control horizontally.

Vertical radio button
The Vertical radio button is used to position the volume control vertically.

Minimum Volume field
The Minimum Volume field identifies the minimum volume level for the control.

The range for this field is -20 to -1dB.
Zero (0) mutes the audio.

Maximum Gain drop down menu
The Maximum Gain drop down menu identifies the maximum volume level for the control.

Available selections for this field are: 0, 3, 6, 9, and 12.
The default for this field is 0. It is advisable to add some gain to every volume control.

Slider Background Color drop down menu
The Slider Background Color drop down menu displays the color of the volume control slider.
Use the drop down color palette to select the desired color.

To add a volume control, do the following:
1. From the Insert menu, select Add Volume Control.

A Volume Control slider appears on the C-Soft console window.
2. Right-click the Volume Control slider.

A shortcut menu appears.
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3. From the shortcut menu, select Properties.
The Ul Element Setup window appears.

4. From the Ul Element Function drop down menu, select a volume function.
The Vol. Control tab appears.

5. Click the Vol. Control tab.
The Vol. Control page appears.

6. In the Orientation field, select the desired orientation radio button of the volume control
slider.

7. In the Minimum Volume field, enter a minimum volume.

8. From the Maximum Gain drop down menu, select the maximum gain.

9. From the Slider Background Color drop down menu, select the background color for the
slider control.

10. Click OK.

A volume control appears on the console.
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41

41.1

Ul Element Setup window - Add VU Meter

The Add VU Meter option inserts a VU Meter on the console. The control format and color are
controlled with the VU Meter Control page.

To insert a VU Meter control, do the following:
- From the menu bar, select Insert | Add VU Meter.
A VU Meter control appears on the console.

VU Meter Control page

The VU Meter Control page, shown in the Figure below, is where the control format and color

are configured.

Type | VU Meter Control |

Crientation
@ Horzontal

(7 Vertical

WU Meter Background Color:

-

Figure 41.1: VU Meter Control Page

To access the VU Meter Control page, do the following:
1. Right-click the VU Meter control.

A shortcut menu appears.
2. From the shortcut menu, select Properties.

The Ul Element Setup window appears.

Orientation group box

Horizontal radio button
The Horizontal radio button indicates the VU Meter Control is in the horizontal position on the
console.

Vertical radio button
The Vertical radio button indicates the VU Meter Control is in the vertical position on the
console.

VU Meter Background Color drop down menu
The VU Meter Background Color drop down menu is used to select the VU Meter Control
background color.
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42 View menu

The View menu contains commands used to change the window view.

Toolbar toggle

The Toolbar toggle indicates whether the toolbar is visible or not.

— If the toolbar is toggled on (selected), the toolbar is visible on the console window.

- If the toolbar is toggled off (not selected), the toolbar is not visible on the console
window.

Status Bar toggle

The Status Bar toggle indicates whether the Status bar is visible or not.

- If the Status Bar is toggled on (selected), the status bar is visible on the console window.

— If the Status Bar is toggled off (not selected), the status bar is not visible on the console
window.
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43 Configure menu

The Configure Menu contains configuration settings for target devices and external key
mapping.
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44 Device Setup

The Device Setup window contains settings to configure the design file for operation on a
specific hardware platform along with other peripheral settings.

Device Setup >

Hardware Setup
Design Target: |Desktop e

Keypad Module

Hide Mouse Cursor

Figure 44.1: Device Setup

Design Target

Sets the target hardware platform for the design. Options are: Desktop, IP-300X, and IP-3018.
Setting the Design Target to IP-300X sets the Design’s window size to dimensions matching
the IP-300X device, making it easier to create a Design compatible with the IP-300X’s screen
dimensions.

Keypad Module check box

Specifies that the Design is intended to use Side Car Button Module. If checked, additional
hardware key mapping options are available in the Key Mappings Setup window (see Global
Key Mapping, page 461). Global Key Mapping is only enabled when IP-300x or IP-3018 is the
design target.

Hide Mouse Cursor check box
Specifies that C-Soft hides the mouse cursor, which is desirable when running C-Soft on a
touchscreen.
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45 Global Key Mapping

The Global Key Mapping window is used to map physical hardware buttons of the IP-30XX to
buttons in the C-Soft Design.

When opened, the Global Key Mapping window displays a tab representing the Main Console
window, as well as dynamically creating tabs for each Popup button that exists in the Design.
While a specific Popup is opened, pressing the specified hardware key entry activates the
configured button for that specific popup button / tab. If a button mapping is not configured
for a specific popup, the button’s behavior is defined by the configured button in the Main
Console tab.

Each tab contains a list of all available Keys, as defined by settings in the Device Setup, page
460 page.

Each KeyMap_ButtonX entry represents the physical hardware buttons on the front of the
IP-30XX device, numbered from left to right. For example, the IP-300X’s leftmost button is
button 1, and the rightmost is button 6.

Each Sidecar_ButtonX represents physical hardware buttons if using a Sidecar Button Module,
numbered top to bottom, left to right. For example, the topmost row are buttons 1-4, the
second row are buttons 5-8, and so on.

Global Key Mapping >

Main Console  Keypad

Key Line Button Mame : Type
KeyMap_Button1 Line 1 Select : Select

KeyMap_Button2 Line 1 InFTT : PTT-Per Line
KeyMap_Button3 Line 1 Mute : Mute-Per Line
KeyMap_Button4 Line 2 Select : Select

KeyMap_Buttons Line 2 InPTT : FTT-Per Line
KeyMap_Buttong Line 2 Mute : Mute-Per Line

Cance

Figure 45.1: Global Key Mapping window
To configure an IP-30XX hardware key to a button, do the following:
1. Configure the Design Target to the correct hardware (see Device Setup, page 460).
2. Select Configure | Global Key Mapping.
The Global Key Mapping window appears
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3. In the Main Console tab, on the row corresponding to the desired button, click the empty
Line column
Upon selecting the column entry, the dropdown displays a list of available lines, as well
as a Global option.

4. Select the desired line or Global if the button is to operate globally.

5. In the same row, click the empty column Button Name : Type column.
Upon selecting the column entry, the dropdown displays a list of buttons on the main
console window, filtered by the selected line.

6. When finished, press the OK button to close the window.
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46 Run menu

The Run menu, shown in the Figure below, is used to either launch the current C-Soft Design
or open a .veg file you desire.

2 cson oo S

File Edit Insert Wiew |Run| Help

= n c"% Run C-5oft Ctrl+R
Select C-5oft Location
TTTTTTTTTTHesErved tor Console |

Figure 46.1: Run Menu - C-Soft

To open the current C-Soft design in C-Soft Runtime, do the following:
- From the Run menu, select Run C-Soft.
The currently open C-Soft Design file is launched in C-Soft Runtime.

To select a C-Soft Runtime executable to run, do the following:
1. From the Run menu, select Select C-Soft Location.
A file navigation window appears.

EE - C-Soft Designer -
File Edit Inset View Run Help

Organize « New folder =« 0 @

¢ Favorites Name Date modified Type Size

) Desktop | Program Files 4/2/2014 9:32 AM File folder
i Downloads . Program Files (x86) 4/30/2014 7:55 AM  File folder
5| Recent Places ProgramData 8 012 3:44 PM  File folder

| Projects /2972012 9:43 AM File folder

- Libraries . SafeHouse 2 1210:03 AM  Filefolder
E‘] Documents | system.sav 8/6/2012 1:30 PM File folder
&' Music . Telex 11/15/201312:36 ...  File folder

[&] Pictures | temp 4/30/2014 6:27 AM  File folder
B Videos . Thinapp 014 7:27 AM  File folder
TrueDelete 8/20/201210:13 AM  File folder

1%/ Computer - <

File name: softruntime.exe - IC—SoﬂRuntlme (*.exe)

[ Open ] [ Cancel

2. Navigate to and select the C-Soft Runtime executable you want to run.

3. Click the Open button.

4.  From the Run menu, select Run C-Soft.

The current C-Soft design file is launched in the specified C-Soft Runtime executable.
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47 About C-Soft Designer

The About C-Soft Designer window is used to view C-Soft version information, Bosch’s
mailing address and website URL.

NAVIGATION: Select Help | About C-Soft Designer.
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48

C-Soft Runtime program

Once the design is created and saved, the C-Soft Designer program generates a file read by
the C-Soft Runtime program. The C-Soft Runtime software does the actual IP communications
with the other radio elements available on the network. The C-Soft Console appears when the
C-Soft Runtime program is opened.

Upon starting C-Soft Runtime, C-Soft will automatically attempt to acquire all necessary Telex
software-based licenses based on the line types and enabled features configured in the Design
file. C-Soft checks for licenses on the local computer, as well as any Telex License Servers
specified in the License Server settings set in the Design file. Refer to “Peripherals page, page
131” for instructions on how to specify a License Server.

Dealer Mode

Dealer Mode is a feature license specifically designed for Telex Radio Dispatch certified
dealers to demonstrate C-Soft's capabilities for a limited amount of time. It allows C-Soft to
operate as if the following licenses are available:

- 50 lines

- 12 SIP lines

— 24 P25-DFSl lines

- 24 NEXEDGE lines

— 100 lines of per-line call playback

- 24 AIS lines

- 24 P25 CSSl Lines

- P25 Encryption

- APl license

Upon startup, if C-Soft Runtime detects a Dealer Mode license, it will display the Dealer Mode
License window to indicate that C-Soft is operating in Dealer Mode, and that the license is not
for resale. Every 15 minutes, the Dealer Mode License window reappears. After 60 minutes,
the license expires, and C-Soft will cease to function and need to be restarted.

C-Soft Dealer Mode License *

TELEX

C-Soft is operating using a Dealer License,
and is not for resale.

This message will reappear every 15
minutes, and C-Soft will close in 59 minutes.

Figure 48.1: Dealer Mode License Window

Finally, the Status bar will display Dealer License: Not for Resale whenever it would otherwise
be clear.

5 C-Soft Console - MySampleDesign 7.132.veg _ o X
Dealer License: Not for Resale  Client Console " REC @D IR: VU: 15:22
- - ________________— _— ___________________________ |

Figure 48.2: Dealer License Status Bar
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Demo Mode

If no software licenses are detected, C-Soft will display the License Error dialog, blocking
access to its user interface. It is still possible to open and test the user interface by entering
Demo Mode. While in Demo Mode, C-Soft is unable to transmit or receive audio.

To run C-Soft Runtime in Demo mode, do the following:
1. Double-click the C-Soft Runtime desktop shortcut.
The C-Soft License Error window appears.

rC-Soﬁ: License Error @1
TELEX

Error: No TRD-CSOFT-LINES license available. Please specify a license
server containing a valid license or activate a license locally using Telex
License Activation Tool.

License Server: 1.2.3.4

Rety | [ Eat |

2. Click the Demo button to enter Demo Mode.

Refer to
—  Peripherals page, page 131

48.1 C-Soft Console

The C-Soft Console opens to the configuration stored in the default file. If no default file is
specified by the user, the Set Default.Veg File window appears.

Alternatively, any .veg file can be double-clicked to open the C-Soft Console. In this case, the
Set Default Veg File window does not appear.

Set Default Veg File window

The Set Default Veg File window is used to locate and set the default .veg file that opens
when C-Soft Runtime is opened. This window appears the first time C-Soft Runtime is opened
or when the default .veg file is reset to none. For more information, refer to “Reset

Default .Veg File” below.

To set the default .veg file, do the following:

1. Double-click the C-Soft Runtime shortcut installed on your desktop during C-Soft
installation.
The Set Default .Veg File window appears.

2. Browse to the .veg file created in C-Soft Designer.

3. Select the .veg file.
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4. Click Open.
The default file is set to the selected configuration and C-Soft Runtime opens.

Set Default Veg File X
Lok in: | (3 desion_folder v O & e E-
“
My Recent
Documents
Desklop
(es/
My Documents
=
Iy Computer
Q) e vl
My N&mk Files of tppe: Ve File(". veq) v | Cancel |

Example Console

When the C-Soft Runtime program is started, the C-Soft Console displays the console design.
A six line console design, along with several other user interface elements, is shown in the
Figure below.

The Title Bar contains the C-Soft Console label and is used to access a shortcut menu. For
more information, refer to “C-Soft Console Title Bar Shortcut Menu” below.

The status bar, located directly below the title bar, is divided into seven panes providing
different status information. From left to right, these panes display: text messages, the IR
playback position, the NENA on an ADHB-4, the connected ADHB-4, the PTT status, the VU
meter, and the current time, as set on the computer clock.

The recording icon m is used to indicate if the console is configured and able to record
per line audio to the hard drive. The icon appears in the menu bar if a line is enabled for IRR
Line Recording and the audio recording directory is valid. For more information, refer to “/RR
Recording page, page 127”.
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C-Soft 7.700

[ C-Soft Consle - Basch truck

(2

[T TS| - |[cr—

* Press to Select ~ Press to Select
MTRBO

MOTOTRBO
Window

Press to - o 7
Press to Select < EXT 210

Select Firacati s
NXDN ! Controls

i

- " EXT 211

SELECTED Volume
4

@IRR Select 10 D IRR Select 30

V@ Praven

0]

: (2]
sertt [l Alert2 12-Dec-2014
w 09:38:36

Figure 48.3: C-Soft Console Window

C-Soft Console Title Bar shortcut menu
The C-Soft Console Title Bar shortcut menu is used to set the window size, find the current C-

Soft version, view license information, and set the default .veg file.

To open the title bar shortcut menu, do the following:
— Right-click the Title Bar to open the shortcut menu.

The menu shown in the Figure below appears.

Size
- Minimize
Maximize

x Close

About C-Soft Runtime

License Information

Reset Default Veg File
Set Default Veg File

Alt+F4

Figure 48.4: C-Soft Console Title Bar Shortcut menu - Minimize
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Restore
Restore is used to restore the window to the last-set window size.

To shrink the window to the size last set by the console operator, do the following:
1. Right-click the title bar.
The Title Bar shortcut menu appears.
2. Click Restore.
The window is restored.

Move
Move is used to the move window. This option is not available (grayed out) if the window is
maximized.

Notice!
The window can also be sized when the move cursor is active.

To move the window, do the following:
1. Right-click the title bar.
The Title Bar shortcut menu appears.
2. Click Move.
The Move cursor appears.
3. Click and hold the title bar.
4. Drag the window into place.

Size
Size is used to change the height and/or width of the window. This option is not available
(grayed out) if the window is maximized.

Notice!
The window can also be moved when the size cursor is active.

To size the window, do the following:

1. Right-click the title bar.
The Title Bar shortcut menu appears.

2. Click Size.
The Size cursor appears.

3. Click and hold the cursor on the edge of the window.
The cursor changes.

4. Drag the window to the desired size.
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Minimize
Minimize is used to shrink the window to a minimized icon on the task bar.

Notice!
If the current view is already minimized, this selection is grayed out.

Maximize
Maximize is used to change the window to full screen view.

Notice!
If the current view is already maximized, this selection is grayed out.

Close
Close is used to close the C-Soft Runtime program.

About C-Soft Runtime
About C-Soft Runtime is used to open the about C- Soft Runtime window.

This window contains the following information:
- Version

—  Telex’s address

—  Sales Support Phone Number

- Website Address

License Information
The License Information window displays all Telex License Keys detected by C-Soft.

Each row in the License List represents a detected software license. The Source column
displays the license’s source, and Option column contains the detected license. Licenses that
have been successfully checked out and are currently in use by the instance of C-Soft are
displayed in blue.

Reset Default .Veg File
Reset Default .Veg File is used to change the default file to none. When reset, and C-Soft
Runtime is opened, the Set Default Veg File window appears.

To reset the default file to none, do the following:
1. Right-click the title bar.

The Title Bar shortcut menu appears.
2. Select Reset Default Veg File.

The default file is set to none.
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Default Reset

Restart C-Soft To Select New Default Yeg File!

Set Default .Veg File

Set Default .Veg File is used to set the current configuration as the default file. When a .veg
file is double-clicked C-Soft Runtime opens to the selected configuration. This configuration
can be set as the default file.

To set the current C-Soft Console configuration as the default .veg file, do the following:
1. Right-click the title bar.

The Title Bar shortcut menu appears.
2. Select Set Default Veg File.

Default Change

Location OF The Default Yeq File:
C:\TestVegFilesi TelexDefault.veg

Window Sizing

By default, the C-Soft Runtime program window fills the entire monitor window. However, this
may not be acceptable for a single monitor system, when only a small monitor is available, or
if the console operator views the software on a multi-monitor computer. In these cases, the
size of the console window can be changed to match the size of the console operator’s
monitor window.

When the C-Soft Runtime program starts it looks for the file cposi[.veg file name].txt. This file
is created each time the C-Soft Runtime program is closed. The cposi[.veg file name].txt (for
example, cposi_Default.txt) file records the size and position of the C-Soft Runtime program
window. In addition to storing the position information, the cposi[.veg file name].txt file also
stores the console state at shutdown. This includes information such as the selected channels,
mute states, volumes, channel frequencies, and the entries in the call log (without the IRR
audio). Since the cposi.txt file does not exist the first time the C-Soft Runtime program is
started, the C-Soft Runtime window fills the entire screen.

Notice!

If one console design is closed and a different console design is started, the states do not
match.

To change the size of the program window, do the following:
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1. Ensure the following fields are selected, refer to “Window Controls Check Boxes” on
page 121 for details.
- Allow Minimize
- Allow Maximize
- Allow Resize
- Allow Close
For more information, refer to “Save Runtime Status on Close Check Box” on page
120.
TIP: If this is an existing design, verify these controls are enabled for the design. If
they are not, select the Windows controls listed above, and then proceed to the next
step.
2. Save the designer file (.veg).
3. Open the .veg file you just saved.
4. Resize and position the console window, as desired.
The elements on the window do not rescale to fit the window size and some may be
hidden from view when the window is resized. This step is only to create the size and
position of the window. The next time the console window is opened, all of the elements
on the console window are automatically scaled to fit the console window by the C-Soft
Runtime program.
5. Close the C-Soft Runtime program when the console window is set to the desired size
and position.
The cposi.[veg file name].txt file is created by the program is when it is closed
6. Open the .veg file.
The window opens using the last location and size with the buttons, sliders, VU Meter,
and clock in the correct locations.
7. If the console display needs further adjustment, repeat the above steps until the console
window is the desired size.
Refer to

IRR Recording page, page 127
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49 Appendix A - Telex Tone Group Numbers and Paging
Plans

49.1 Telex Tone Group Numbers
Telex 1 2 3 4 5 6 7
Group
No.
Tone Mot 1 Mot 2 Mot 3 Mot 4 Mot 5 Mot 6 Mot A
Group
0 330.5 569.31  [1092.4  [321.7 553.9 11225 |358.9
1 349.0 600.9 288.5 339.6 584.8 1153.4  |398.1
2 368.5 634.5 296.5 358.6 617.4 1185.2  |441.6
3 389.0 669.9 304.7 378.6 651.9 1217.8  |489.8
4 410.8 707.3 313.0 399.8 688.3 12514  |543.3
5 433.7 746.8 953.7 422.1 726.8 1285.8  |602.6
6 457.9 788.5 979.9 445.7 767.4 13212  |668.3
7 483.5 832.5 1006.9  |470.5 810.2 1357.6  |741.3
8 510.5 879.0 1034.7  |496.8 855.5 1395.0  |822.2
9 539.0 928.1 1063.2  |524.6 903.2 14334  |912.0
Diagonal |569.1 979.9 569.1 569.1 979.9 979.9 979.9

Tab. 49.9: Telex Tone Group Numbers (1-7)

Telex 8 9 10 11 12 13 14 15
Group

No.

Tone Mot B Mot 2 GE A’ GE B’ GEC’ Mot 10 Mot 11 |Custom
Group

0 371.5 346.7 682.5 652.5 667.5 1472.9 [1930.2 |1034.9
1 412.1 384.6 592.5 607.5 7125 1513.5 [1989.0 |953.9
2 457.1 426.6 757.5 787.5 772.5 1555.2 |2043.8 |0

3 507.0 473.2 802.5 832.5 817.5 1598.0 [2094.5 |0

4 562.3 524.8 847.5 877.5 862.5 1642.0 |[2155.6 |0

5 623.7 582.1 892.5 922.5 907.5 1687.2 [2212.2 |0

6 691.8 645.7 937.5 967.5 952.5 1733.7 [2271.7 |0

7 767.4 716.1 547.5 517.5 532.5 1781.5 |2334.6 |0

8 851.1 794.3 727.5 562.5 577.5 1830.5 |[2401.0 |O

9 944.1 881.0 637.5 697.5 622.5 1881.0 [2468.2 |0
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Diagonal [979.9 979.9 742.5 742.5 742.5 None None None

Tab. 49.10: Telex Tone Group Numbers (8-15)

49.2 Tone and Gap Durations for Standard Paging Plans

Tone #1 (ms) Gap (ms) Tone #2 (ms) Group Call (ms) |Type

1000 - 3000 8000 GE std, Mot std
Tone and Voice

400 0 800 8000 Mot Tone Only

1000 0 3000 6000 NEC-B

1000 300 3000 6000 NEC-A

1000 0 1000 4000 NEC-C

400 0] 800 4000 NEC-M

500 0 500 3000 NEC-L

400 0 400 3000 NEC-D

Tab. 49.11: Tone and Gap Durations for Standard Paging Plans
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50 Appendix B - 2 Tone 1000 Plan Numbers
Telex 1 2 3 4 5 6 7 8 9
Code Plan
#
Pager Mot A ([MotC |MotD [MotE [MotF |[MotG |[MotH |[MotJ |MotK
Capcodes
Oxx 2+4 N/A N/A N/A N/A N/A N/A N/A N/A
1xx 1+1 1+1 1+1 1+1 1+1 1+1 1+1 1+1 1+1
2xx 2+2 2+2 2+2 2+2 1+3 1+3 1+3 1+4 1+4
3xx 3+3 1+2 1+2 1+2 3+3 3+3 3+3 4+1 4+1
4xx 1+2 4+4 1+5 2+1 4+4 3+1 3+1 4+4 4+4
5xx 1+3 1+4 5+5 1+6 3+1 5+5 1+6 5+5 1+6
6xX 2+1 2+1 2+1 6+6 1+4 1+5 6+6 1+5 6+6
7XX 3+1 4+1 5+1 6+1 4+1 5+1 6+1 4+5 6+1
8xx 2+3 2+4 2+5 2+6 3+4 3+5 3+6 5+4 4+6
9xx 3+2 4+2 5+2 6+2 4+3 5+3 6+3 5+1 6+4

Tab. 50.12: 2 Tone 1000 Plan Numbers (1-9)

Telex 10 11 12 13 14 15 16 17
Code

Plan #

Pager MotL |MotM Mot N Mot P Mot Q Mot R Mot S Mot T
Capcodes

Oxx N/A 4+2 4+2 4+2 4+2 4+2 4+2 4+2
Ixx 1+1 2+3 2+3 2+3 2+4 2+4 2+5 3+4
2xx 145 2+2 2+2 2+2 2+2 2+2 2+2 4+3
3xx 5+1 3+3 3+3 3+3 4+2 4+2 5+2 3+3
4xx 1+6 4+4 3+2 3+2 4+4 4+4 2+6 4+4
5xx 5+5 3+2 5+5 2+6 5+5 2+6 5+5 5+5
6xx 6+6 2+4 2+5 6+6 2+5 6+6 6+6 3+5
7xx 6+1 4+2 5+2 6+2 4+5 6+2 6+2 4+5
8xx 5+6 3+4 3+5 3+6 5+4 4+6 5+6 5+4
9xx 6+5 4+3 5+3 6+3 5+2 6+4 6+5 5+3

Tab. 50.13: 2 Tone 1000 Plan Numbers (10-17)
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Telex 18 19 20 21 22 23 24 25
Code
Plan #

Pager MotU |MotV Mot W Mot Y Mot MT |GE X GEY GE z
Capcodes

0xx 4+2 4+2 4+2 N/A 4+2 10+10 11+11 10+10
1xx 3+4 3+5 4+6 7+7 1+1 11+10 12+11 12+10
2XxX 4+3 5+3 6+4 8+8 2+2 11+11 12+12 12+12
3xx 3+3 3+3 5+6 9+9 1+2 10+11 11+12 10+12
Axx 4+4 3+6 4+4 7+8 4+4 12+12 N/A N/A
5xx 3+6 5+5 5+5 7+9 5+5 12+10 N/A N/A
BXX 6+6 6+6 6+6 8+7 2+1 12+11 N/A N/A
7XX 6+3 6+3 4+5 9+7 4+5 10+12 N/A N/A
8xx 4+6 5+6 5+4 8+9 5+4 11+12 N/A N/A
9xx 6+4 6+5 6+5 9+8 2+4 N/A N/A N/A

Tab. 50.14: 2 Tone 1000 Plan Numbers (18-25)
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51 Appendix C - Supported Tone Frequencies
Tone | Co European Tone Frequencies in Hz Motorola
Numb | de

ZVEI1 | ZVEI | KEN | PZV | DZV | PDZV |CCIR|CCIR [PCCI | EEA | EURO | NATE | EIA | MOD

er |Dig 2 El | EI | EI 1 2 | R SIGNAL| L AT

TONE | O | 2400 |2400| 815 | 2400|2200 | 2200 |1981 1981|1981 |1981| 979.8 | 1633 | 600 | 637.5

TONE| 1 | 1060 |1060| 882 [1060| 970 | 970 [1124|1124|1124|1124| 903.1 631 | 741 | 787.5

TONE | 2 | 1160 |1160| 954 1160|1060 | 1060 |1197 |1197 (1197|1197 | 832.5 697 | 882 | 937.5

TONE| 3 | 1270 [1270|1032|1270|1160| 1160 |[1275|1275|1275|1275| 767.4 770 |1023]| 1087.

3 5
TONE | 4 | 1400 |1400|1117|1400|1270| 1270 |1358|1358|1358|1358| 707.4 852 | 1164 | 1237.
4 5
TONE | 5 | 1530 |[1530|1209|1530|1400| 1400 |1446 |1446|1446|1446| 652.0 941 | 1305 | 1387.
5 5
TONE| 6 | 1670 [1670|1308|1670|1530| 1530 | 1540 (1540|1540 |1540| 601.0 | 1040 |1446| 1537.
6 5
TONE| 7 | 1830 [1830|1415|1830|1670| 1670 |1640|1640|1640|1640| 554.0 | 1209 | 1587 | 1687.
7 5
TONE | 8 | 2000 |2000|1531 (2000|1830 | 1830 |1747 1747|1747 |1747| 510.7 | 1336 | 1728 | 1837.
8 5
TONE | 9 | 2200 |2200|1657 |2200|2000| 2000 |1860 |1860|1860 |1860| 470.8 | 1477 | 1869 | 1987.
9 5
GROU| A | 2800 | 885 |1939| 970 | 825/ | 825 |2400 1050 | 1055 2151

P 885
TONE
B 810 | 810 |2270| 810 | 740 | 886 | 930 930 | 930 2292
RESE | C 970 | 970 | 2098|2800 | 2600 | 2600 |2247 2400 | 2247 2010
T
TONE
D 885 | 680 | 2457 | 885 | 885 | 856 | 991 |2110| 991 | 991 2292

REPE | E | 2600 | 970 | 1792|2600 | 2400 | 2400 |2110|2400|2110|2110| 1062.9 | 1805 | 459 | 487.5
AT
TONE

F 680 | 2600 680 | 680 1055 | 2400 | 1995|1091 1995 | 1091
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C-Soft 7.700

52

Appendix D - Echo Packets Diagram
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[E]
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C-Soft (E)
10.7.100.201
Chan1: RX 225.8.11.83:1054
TX 2258.11.8%1072
Echo1: Disabled

X C-Soft (F)
Radio tower 2 10.7.100.200
10.7.100.101 Chani: RX 10.8.100.201:1054
22581183 TX 10.8.100.201:1072
RX:1055 Echo1: RX 225.8.11.83:1054
TH1073 TX 225.8.11.83:1072
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%_ roier [ A
Radio tower 1 _—+M Private WAN
10.6.100.100 \
2258.11.83 |
rx:1054 (0 : )
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Radio tower 3

) 10.8.100.102
225.8.11.83
RX: 1056
TX: 1074

— S

C-Soft (A)
10.6.100.200
Chan1: RX 225.8.11.83:1054
TX 225.8.11.83:1072
Echo1: RX 10.8.100.200:1054
TX 10.8.100.200:1072

C-Soft (C)
10.8.100.200
Chan1: RX 10.6.100.200:1054
TX 10.6.100.200:1072
Echo1: RX225.8.11.83:1054

TX 225.8.11.831072

C-Soft (B)
10.6.100.201
Chani: RX 2258.11.83:1054
TX 225.8.11.83:1072
Echo1: Disabled

C-Soft (D)
10.8.100.201
Chanl: RX 225.8.11.83:1054
TX 225.8.11.83:1072
Echo1: RX 10.7.100.200:1054
TX 10.7.100.200:1072
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53 Appendix E - P25-DFSI (Digital Fixed Station Interface)
53.1 P25-DFSI C-Soft Architecture
A C-Soft console can be configured for two different types of system architectures; a Stand

Alone console, or a Client/Server console.

A Stand Alone console is defined as a single console connection to n (where n is the number
of repeaters or Fixed Stations).

A Client/Server console is defined as multiple consoles connected to a server console which
is connected to n (where n is the number of repeaters or Fixed Stations).

Notice!
The maximum total number of consoles connected to one P25 DFSI is 25.

A Stand Alone Console is a simple configuration, requiring the least amount of setup time.
Refer to the Figure below.

n Fixed Stations

Stand Alone Console (Voice and Control Data between

Server Console and Fixed Station)

— Control Unicast Address and Port of Fixed Station
— Voice |P Address and Port of Fixed Station

Figure 53.1: Stand Alone Console Configuration

If more than one console operator is controlling the fixed stations, a Client/Server
configuration should be used. Refer to the Figure below. One console is set up as a server,
two consoles are set up as clients and one console is set up as a client console providing back
up to the main server console.
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0 Fixed Slalions {vaice and Canlrel Data batween
D Server Cansole and Fixed Statian)
= Cantral Unicast Address and Part of Fixed Stasan
= Vaice IP Addrezs and Port of Fixad Station

I:] {Conirel Data belween Sarver Consale and
Clhiend Cansobes)

= Server Canlrol Part

I::_-u\ /—-) = Canlrol Unicas! Address of Server
L R
Sarver Consale {Waiee Dala batwean Sarver Congale and
EI Client Consoles and Backup Server Communicalions)
= TXRX Mullicast Address and Peets
r_l.__lj II__'__I — Backup Server Ping Address and Port

¢

Client Cansale and |— = Client Consale 2 '_',] Client Consale 3
Serder Backup =i

=]
L=

Figure 53.2: Server/Client Console Configuration

Notice!
There is no special software needed between consoles. Any C-Soft console can be configured
as a Stand Alone, Server, Client or Backup console via user setting in C-Soft designer.

53.2

P25 DFSI Global Setup window

The P25 DFSI Global Setup window, shown in the Figure below, is used to determine what
type of console is required for the system.

For example, if you require a stand alone system, then you have only one console, and an
equal number of lines to base stations in your system. Only one .veg file needs to be created
with the global console type set to stand alone.

If you require a client/server system, you must create one. veg file with a global console type
set to server and a second .veg file with the console type set to client or client and backup
server console.

Notice!
Each Client console has a unique Console ID, therefore, it is required to have a different veg
file for each console position in the system.

Notice!
The parameters on this page affect all line types set to P25-DFSI.
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A Console ID must first be added. Refer to the Figure below. This ID is used by the individual
radios to make Private Calls with the console. This ID shows up as the radio ID when
implementing a PTT from the console.

P25 DFSI Global Set X .;.|

Settings Apply To All DFSI Line Types

Console Type

Console ID: 00

(@ Stand Alone Console

This consaole is a:

(71 Server Console
(71 Client Consale

(71 Client & Backup Server Consale

Backup Server Fing Address

Pz || 225 . . 11 . 110 Port: | 6739

Heartheats
Fixed Station Heartbeat Time:

Host Heartbeat Time:

Mumber of Missed Heartbeat Allowed:

Radio/fepeater Control Signals
Mumber of Control Retries:

Control Retry Time:
Packet Controls

Control Packet Delay: 0 {3 20ms)

Figure 53.3: P25 DFSI Global Setup Window

To set up P25 DFSI Global Values, do the following:
—  From the Edit menu, select Setup P25-DFSI.
P25 DFSI Global Setup window appears.

53.2.1 Console Type group box
The Console Type group box is used to make a selection between Stand Alone Console,
Server Console, Client Console and Client and Backup Server Console.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



482 en | Appendix E - P25-DFSI (Digital Fixed Station Interface) C-Soft 7.700

Stand Alone radio button
The Stand Alone radio button indicates one console is used.

Server Console radio button
The Server Console radio button indicates multiple consoles are used.

Notice!
Only one server per system.

Client Console radio button
The Client Console radio button indicates the C-Soft Console is connected with a Server
Console.

Client & Backup Server Console radio button
The Client & Backup Server Console radio button indicates a Server is already setup and a
backup Server is needed, in case the server computer goes down.

Notice!
Only one Backup Server per system.

53.2.2

Console ID field

The Console ID field is used to enter the ID of the console. This ID is used by the individual
radios to make Private Calls with the console, and appears as the radio ID when implementing
a PTT from the console.

Backup Server Ping Address group box
The Backup Server Ping Address group box is used for communication between all C-Soft
Consoles to determine if the Server is operational or if the Server is down.

IP field

The IP field is a multicast address. It is used for communication between all the C-Soft
Consoles to determine if the primary server is operational or is down. IP field number is the
same among all of the consoles in the system.

Port Field

The Port field is a multicast port. It used for communication between all the C-Soft Consoles
to determine if the primary server is operational or is down. The Port field number is the same
among all of the consoles in the system.
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53.2.3 Heartbeats group box
The Heartbeats group box is used to configure a Fixed Station Heartbeat Time, a Host
Heartbeat Time, and the Number of Missed Heartbeats Allowed.
Fixed Station Heartbeat Time field
The Fixed Station Heartbeat Time field indicates the time, in seconds, the fixed station sends
heartbeats to the C-Soft Console. This field is only enabled if the console type is set to Server
Console or Client & Backup Server Console mode.
The range for this field is 5 to 255.
The default is 30.
Host Heartbeat Time field
The Host Heartbeat Time field indicates the time, in seconds, the C-Soft Console sends
heartbeats to the fixed station. This field is only enabled if the console type is set to Server
Console or Client & Backup Server Console mode.
The range for this field is 5 to 255.
The default is 30.
Number of Missed Heartbeats Allowed field
The Number of Missed Heartbeats Allowed field indicates the number of missed heartbeats
from the Fixed Station before C-Soft terminates communication with the fixed station and
tries to connect again.
The range for this field is O to 5.
The default is 2.
53.2.4 Radio/Repeater Control Signals group box

The Radio/Repeater Control Signals group box is used to configure the number of control
retries and the wait time between retries from the server to establish contact with the radio.

Number of Control Retries field
The Number of Control Retries field indicates the number of times a control command is sent
if no acknowledgment is received.

The range for this field is 0 to 5.
The default is 3.

Control Retry Time
The Control Retry Time field indicates the time, in ms, C-Soft waits before sending the same
control command.

The range for this field is 500 to 1000.
The default is 600.
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53.2.5 Packet Controls group box
The Packet Controls group box is used to set the packet delay for the C-Soft Console.
Control Packet Delay field
The Control Packet Delay field is used to enter a value that is multiplied by 20ms to set the
delay between P25 DFSI Control Packets sent from C-Soft. This field is only enabled if the
console type is set to Server Console or Client & Backup Server Console mode.
The range for this field is 0 to 99.
The default is 0.
Setting up a P25-DFSI Line
To set up a P25-DFSI Line, do the following:
1. From the Edit Window, select Setup Per Line Parameters.
The Per Line Parameters window appears.
2.  From the Line Type drop down menu, select P25-DFSI.
3. Click the Signal Setup button.
The P25-DFSI Setup window appears.
Per Line Parsmeters
NLI;Ii':EBI Line Type Line Mame Rz Multicast Address RxPort  Tx Multicast Address T Port Base Radio [P: TTL PDa;l;:t E“-
1 P25-DFSl = | Line1 225.8 .11 .81 1054 2258 . 11.81 1254 o.0.0.0 & 10 PR Signal
opacketsgname; 0.0.0.0 [1054 0.0.0.0 [1254 peters Seg“"’
Figure 53.4: P25-DFSI Line Type
Notice!
Below are four examples of how a console can be configured, depending the Console Type
selected in P25 DFSI Global Setup window (i.e. Stand Alone, Server or Client). Refer to the
Figure on P25 DFSI Global Setup window, page 480.
Refer to
- P25 DFSI Global Setup window, page 480
53.3 Console Type Setup
The Console Type Setup is used to configure the console depending on the Console Type
selected in P25 DFSI Global Setup window.
53.3.1 Stand Alone Console

Stand Alone Console type
The Stand Alone Console is the easiest console type to set up and should be the starting
point for building a Client/Server system.

The three parameters to be set up are:
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—  The Per Line IP connections which consist of the control Unicast Address of FS and the
Voice Address of the FS

—  The channel numbers to a single base station

- P25 Manufacturer

Notice!
The Control Port of FS must match the DFSI control port of the Base Station. The Voice Port
of FS can be the same as, or different than the DFSI Voice Port of the base station.

The Signaling Parameters window, shown in the Figure below, is used to set up the per line IP
connections and channel numbers to a single base station.

Signaling Parameters: P25 DFSI x
General Signal Setup  P25-DFS| Setup

Console configuration: "Stand Alone Console™

Fied Station (F5) Connections
Control Address of Fted Station

Conttrol Uniicast Address of F5: { 172 .13 . 50 . 70 ‘ Control Port of FS:
Voice Address of Ficed Station
VoioeleFmost;( 172.19 .5 . 7 ‘ Voice Port of FS: 2000
[ Backup Enabled Backup FS Setup
NA
MA
72 15 100 . 148 27100
NA
25 .8 .11 . M 8054 [ 25 . 8 . 1 14 8055
P25 Manufacturer: | Codan v Channel Setup Edt Global DFSI Parameters

Figure 53.5: P25-DFSI| Setup-Stand Alone Console

Fixed Station (FS) Connections group box
The Fixed Station (FS) Connections group box contains the Control Address of Fixed Station
group box and the Voice Address of Fixed Station group box.

Control Address of Fixed Station group box

Control Unicast Address of FS field
The Control Unicast Address of FS field is used to enter an IP Address of the P25 base
station.
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Control Port of FS field
The Control Port of FS field is used to enter the port number of the P25 base station.

The range for this field is 1054 to 65536.

Notice!
The Control Port of FS field must match the DFSI Control Port of the P25 base station.

53.4

Voice Address of Fixed Station group box

Voice IP Address of FS field
The Voice IP Address of FS field is used to enter the voice IP address of the P25 base station.

Voice Port of FS field
The Voice Port of FS field is used to enter the unique port number of the P25 base station.

The range for this field is 1054 to 65536.

Backup Enabled check box

The Backup Enabled check box enables the backup FS setup button. It is used when the
system needs to have a secondary P25 base station for backup in the event the primary base
station is down.

Backup FS Setup window

The Backup FS Setup button opens the Backup Fixed Station Setup window.

To open the Backup Fixed Station Setup window, do the following:
1. Select the Backup Enabled check box.
2. Click Backup FS Setup.

The Backup Fixed Station Setup window appears.

Control Address of Fixed Station

Control Unicast Address of F5: 172 . 19 . 50 . 70 Control Port of FS: 7000

Voice Address of Fixed Station

Voice IP Addressof F5: 172 . 18 . 50 . 70 Voice Port of F5; 2000

3. Configure your backup station.
NOTE: If connection is lost to a Fixed Station, C-Soft automatically switches to the
Backup Fixed Station if Backup Enabled is selected.

4. Restart C-Soft to return to the original Fixed Station.
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Control Address of Fixed Station group box

Control Unicast Address of FS field
The Control Unicast Address of FS field is used to enter an IP Address of the P25 base
station.

Control Port of FS field
The Control Port of FS field is used to enter the port number of the P25 base station.

The range for this field is 1054 to 65536.

Notice!
The Control Port of FS field must match the DFSI Control Port of the P25 base station.

Voice Address of Fixed Station group box

Voice IP Address of FS field
The Voice IP Address of FS field is used to enter the IP Address of the P25 base station.

Voice Port of FS field
The Voice Port of FS field is used to enter the unique port number of the P25 base station.

The range for this field is 1054 to 65536.

P25 Manufacture drop down menu
The P25 Manufacture drop down menu is used to select the manufacturer of the repeater.

Available selections for this field are:
- Daniels
- Tait

Notice!
Since there may be small differences between radio designs, this field is important to insure
C-Soft works correctly with the repeater.

Channel Setup button
The Channel Setup button is used to open the DFSI Channel Table window. For more
information, refer to “Channel Table window, page 497”.

Edit Global DFSI Parameters button
The Edit Global DFSI Parameters button is used to open the P25 DFSI Global Setup window,
shown in Figure on P25 DFS/ Global Setup window, page 480.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



488 en | Appendix E - P25-DFSI (Digital Fixed Station Interface) C-Soft 7.700

53.5

Server Console

The Signaling Parameters window, shown in the Figure below, is used to set up the Server
Console Configuration. The FS (Fixed Station) Connection portion of the window is the same
as that for a Stand Alone Console. As in the case of the “Stand Alone Console”, one line of the
Server Console connects to one base station. The difference between the Stand Alone and
Server is the client(s) now connects and talks to the server on a per line basis in order to
control and communicate with the base station connected to this line.

Signaling Parameters: P25 DFSI X
General Signal Setup  P25-DFSI Setup
Conscle configuration: "Server Console™

Foed Station (FS) Connections
Control Address of Fied Station

Control Unicast Address of FS: [ EE. 19 .5 .70 | Control Port of FS:
Voice Address of Fixed Station
vgaioelpmdmssuws;{ 172. 13 . 50 . 70 ‘ Voice Port of FS: |2000
[ Backup Enabled Backup FS Setup

Sarver Connections (Clients connect to this server port & talk on these Multicast Addresses (MCA))
Server's Cortrol Address

IPaddrﬁsofﬂisconpuer:[ 172 . 15 . 100 . 148 \ Server Control Pet: |27100
Server's Voice Address
RcMCA| 225 - 8 . 11 . 34 | pog. (8054 | TxMca] 225 . 8 . 11 . 34 | poq:[8055 ]
P25 Manufacturer. | Tait w Channel Setup Edit Global DFS| Parameters

o[ oo

Figure 53.6: P25-DFSI- Server Console

To change settings to a Server Console, do the following:
1. From the menu bar, select Edit | Setup P25 | DFSI.
The P25 DFSI Global Setup window appears.
2. In the Console Type group box, click the Server Console radio button.
Server Console is the console for the system.
3.  From the menu bar, select Edit | Setup Per Line Parameters.
The Per Line Parameters window appears.
4. With P25-DFSI selected in the Line Type drop down menu, click Signal Setup.
The P25-DFSI Setup - Console configuration: Server Console window appears.

Fixed Station (FS) Connections group box
The Fixed Station (FS) Connections group box contains the Control Address of Fixed Station
group box and the Voice Address of Fixed Station group box.
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Control Address of Fixed Station group box

Control Unicast Address of FS field
The Control Unicast Address of FS field is used to enter an IP Address of the P25 base
station.

Control Port of FS field
The Control Port of FS field is used to enter the port number of the P25 base station.

The range for this field is 1054 to 65536.

Notice!
The Control Port of FS field must match the DFSI Control Port of the P25 base station.

Voice Address of Fixed Station group box

Voice IP Address of FS field
The Voice IP Address of FS field is used to enter the IP Address of the P25 base station.

Voice Port of FS field

The Voice Port of FS field is used to enter the voice port number of the P25 base station. The
Voice Port of FS field must match the voice port number configured in Daniels P25 base
station and unique for Tait P25 base station.

The range for this field is 1054 to 65536.

Backup Enabled check box

The Backup Enabled check box enables the backup FS setup button. It is used when the
system needs to have a secondary P25 base station for backup in the event the primary base
station is down.

53.6 Backup FS Setup window
The Backup FS Setup button opens the Backup Fixed Station Setup window.

To open the Backup Fixed Station Setup window, do the following:
1. Select the Backup Enabled check box.
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2. Click Backup FS Setup.
The Backup Fixed Station Setup window appears.

Control Address of Fixed Station

Control Unicast Address of F5: . . . Control Port of F5: 7000

Voice Address of Fixed Station

Voice IP Address of F5: 172 - ' : Voice Port of F5: 2000

3. Configure your backup station.
NOTE: If connection is lost to a Fixed Station, C-Soft automatically switches to the
Backup Fixed Station if Backup Enabled is selected.

4. Restart C-Soft to return to the original Fixed Station.

Control Address of Fixed Station group box

Control Unicast Address of FS field
The Control Unicast Address of FS field is used to enter an IP Address of the P25 base
station.

Control Port of FS field
The Control Port of FS field is used to enter the port number of the P25 base station.

The range for this field is 1054 to 65536.

Notice!
The Control Port of FS field must match the DFSI Control Port of the P25 base station.

Voice Address of Fixed Station group box

Voice IP Address of FS field
The Voice IP Address of FS field is used to enter the IP Address of the P25 base station.

Voice Port of FS field
The Voice Port of FS field is used to enter the voice port number of the P25 base station.

The range for this field is 1054 to 65536.

Notice!
The Voice Port of FS field must match the voice port number configured in Daniels P25 base
station and unique for Tait P25 base station.
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Server Connections group box

IP Address of this Computer field
The IP Address of this Computer field cannot be modified. When a client is configured, it
must connect to the IP Address of the PC the server console resides on.

Server Control Port field
The Server Control Port field is used to enter the port number the client connects to the
server and to control the base station/radio functionality.

The range for this field is 1054 to 65536.

Server's Voice Address group box
The Server’s Voice Address group box is used to configure the (MCA) Multicast Address and
ports the server uses to communicate with the client and client consoles.

Rx MCA field
The Rx MCA field is used to enter the receive Multicast Address used to receive P25 audio.

Port field
The Port field is used to enter the port number used to receive P25 audio.

The range for this field is 1054 to 65536.

Tx MCA field
The Tx MCA field is used to enter the transmit Multicast Address used to transmit P25 audio.

Port field
The Port field is used to enter the port number used to transmit P25 audio.

The range for this field is 1054 to 65536.

P25 Manufacture drop down menu
The P25 Manufacture drop down menu is used to select the manufacturer of the repeater.

Available selections for this field are:
- Codan
- Tait

Notice!
Since there may be small differences between radio designs, this field is important to insure
C-Soft works correctly with the repeater.

Channel Setup button
The Channel Setup button is used to open the DFSI Channel Table window. For more
information, refer to “Channel Table window, page 497”.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



492 en | Appendix E - P25-DFSI (Digital Fixed Station Interface) C-Soft 7.700

53.7

The Channel Table window displays all of the channels open for a selected line.

Edit Global DFSI Parameters button
The Edit Global DFSI Parameters button is used to open the P25 DFSI Global Setup window.
For more information, refer to “P25 DFS/ Global Setup window, page 480”.

The P25 DFSI Global Setup window is used to select the type of console required for the
system.

Client Console

The Signaling Parameters window, shown in the Figure below, is used to set up the Client
Console Configuration. Each client requires a different .veg file because of the console ID.

Notice!
The server console must have the number of lines equal to the number of base stations;
clients cannot directly access the base station without going through the server.

Signaling Parameters: P25 DFSI X
General Signal Setup  P25-DFSI Setup
Console configuration: “Client Console™
NA
MNA
{:.?2 19 . 50 . 70 | nitel Port of 7000
NA
{ 172 .19 . 50 . 70 |
Backup Enabled Backup FS Setup
Client Connactions
Control Address of Server
c:mmlmcaammasew:[ W2 . 19 . 100 . 148 | cmrdpc.m_c,mg;
Voice Address of Server
ReMca:| 25 - 8 11 . M | pog:[e054 | Txmca] 225 8 . 11 . 34 | poq:[s055 |
P25 Marufacturer:  Codan ~ Channel Setup Edit Global DFS| Parameters
Cance

Figure 53.7: P25-DFSI Client Console

To change settings to a Server Console, do the following:
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1. From the menu bar, select Edit | Setup P25 | DFSI.
The P25 DFSI Global Setup window appears.
2. Select the Client Console radio button to make the console type a Client Console.
3. From the menu bar, select Edit | Setup Per Line Parameters.
The Per Line Parameters window appears.
4. From the Line Type drop down menu, select P25-DFSI.
5.  With P25-DFSI selected in the Line Type drop down menu, click Signal Setup.
The P25-DFSI Setup - Console configuration Client Console window appears.

Client Connections
The Client Connections group box is used to configure per-line signaling setup address fields.

Control Address of Server group box

Control Unicast Address of Server field
The Control Unicast Address of Server field is used to enter the IP Address of the server PC.

Control Port of Server field
The Control Port of Server field is used to enter the port address of the server control port
for this line.

Notice!
The Port Address must match the value setting of the Server Control Port on the Server
Console setup.

Voice Address of Server group box

Rx MCA field
The Rx MCA field is used to enter the receive Multicast Address used to receive P25 audio.

Tx MCA field
The Tx MCA field is used to enter the transmit Multicast Address used to transmit P25 audio.

P25 Manufacture drop down menu
The P25 Manufacture drop down menu is used to select the manufacturer of the repeater.

Available selections for this field are:
—  Daniels
- Tait

Notice!
Since there may be small differences between radio designs, this field is important to insure
C-Soft works correctly with the repeater.

Channel Setup button
The Channel Setup button is used to open the DFSI Channel Table window. For more
information, refer to “Channel Table window, page 497”.

The Channel Table window displays all of the channels open for a selected line.
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Edit Global DFSI Parameters button

The Edit Global DFSI Parameters button is used to open the P25 DFSI Global Setup window.
For more information, refer to “P25 DFS/ Global Setup window, page 480.

The P25 DFSI Global Setup window is used to select the type of console required for the
system.

53.8 Client Console with Server Backup

The Signaling Parameters window, shown in the Figure below, is used to set up the Server
Console Configuration. The backup client console or .veg file must have the same number of
lines the server console or .veg file does.

The top half of the page, shown in the Figure below, is exactly the same as the setting for a
Stand Alone Console or for a Server Console. The bottom half of the page is exactly the same
as the setting for a client console.

Signaling Parameters: P23 DFSI K

Console configuration: "Client Console with Server Backup™

Foced Station (FS) Connections (For Backup Senver)
Address of Foced Station (For Backup Server)

Corttrol Unicast Address of FS: l EE .19 .5 .70 | Contrel Port of FS:
Voice Address of Fieed Station (For Backup Server)
vgs.;ew.ﬁressafps;[ 172 .19 . 50 . 70 | Voice Port of FS: 2000
[] Backup Enabled Backup FS Setup
Chiarit Connachions
Control Address of Server
r:omuamcasmddmafsﬁrm:[ 172 . 19 . 100 . 148 | comdpmdsgva;

Voice Address of Server
ReMCA| 25 - 8 . 11 . M | pon.[s058 | Txmca] 25 8 . 11 . M | pog[a055 |

P25 Manufacturer: | Codan ~ Channel Setup Edi Global DFS| Parameters

[ 0k_] | Canca

Figure 53.8: P25-DFSI Client Console with Server Backup

To change settings to a Server Console, do the following:
1. From the menu bar, select Edit | Setup P25 | DFSI.
The P25 DFSI Global Setup window appears.
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2. Click the Client & Backup Server Console radio button to make the console type Client
and Backup Server.
Client & Backup Server Console is now the console for the system.
3. From the menu bar, select Edit | Setup Per Line Parameters.
The Per Line Parameters window appears.
4. From the Line Type drop down menu, select P25-DFSI.
Fixed Station (FS) Connections (For Backup Server) group box
The Fixed Station (FS) Connections (For Backup Server) group box is used to connect with
the backup FSI if the Server Console fails to receive heartbeats from the Primary FSI.
Address of Fixed Station (For Backup Server) group box
Control Unicast Address of FS field
The Control Unicast Address of FS field is used to enter an IP Address of the P25 base
station.
Control Port of FS field
The Control Port of FS field is used to enter the port number of the P25 base station.
The range for this field is 1054 to 65536.
Notice!
The Control Port of FS field must match the DFSI Control Port of the P25 base station.
Voice Address of Fixed Station (For Backup Server) group box
Voice IP Address of FS field
The Voice IP Address of FS field is used to enter the voice IP address of the P25 base station.
Voice Port of FS field
The Voice Port of FS field is used to enter the voice port number of the P25 base station. The
Voice Port of FS field must match the voice port number configured in Daniels P25 base
station and unique for Tait P25 base station.
The range for this field is 1054 to 65536.
Backup Enabled check box
The Backup Enabled check box enables the backup FS setup button.
53.9 Backup FS Setup window

The Backup FS Setup button opens the Backup Fixed Station Setup window.

To open the Backup Fixed Station Setup window, do the following:
1. Select the Backup Enabled check box.
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53.9.1

53.9.2

2. Click Backup FS Setup.
The Backup Fixed Station Setup window appears.

Control Address of Fixed Station

Control Unicast Address of F5: . . . Control Port of F5: 7000

Voice Address of Fixed Station

Voice IP Address of F5: 172 - ' : Voice Port of F5: 2000

3. Configure your backup station.
NOTE: If connection is lost to a Fixed Station, C-Soft automatically switches to the
Backup Fixed Station if Backup Enabled is selected.

4. Restart C-Soft to return to the original Fixed Station.

Client Connections group box
The Client Connections group box is used to configure per-line signaling setup address fields.

Control Address of Server group box

Control Unicast Address of Server field
The Control Unicast Address of Server field is used to enter the IP Address of the server PC.

Control Port of Server field
The Control Port of Server field is used to enter the port address of the server control port
for this line.

Notice!
The Port Address must match the value setting of the Server Control Port on the Server
Console setup.

53.9.3

Voice Address of Server group box

Rx MCA field

The Rx MCA field displays the RX Multicast Address and Port that the server and clients use
to receive P25 voice (a different value for each line). The MCA and ports must match the MCA
and ports you entered in the server console.

Tx MCA field

The Tx MCA field displays the TX Multicast Address and Port that the server and clients use to
transmit P25 voice (a different value for each line). The MCA and ports must match the MCA
and ports you entered in the server console.
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P25 Manufacture drop down menu
The P25 Manufacture drop down menu is used to select the manufacturer of the repeater.

Available selections for this field are:
- Daniels
- Tait

Notice!
Since there may be small differences between radio designs, this field is important to insure
C-Soft works correctly with the repeater.

Channel Setup button
The Channel Setup button is used to open the DFSI Channel Table window. For more
information, refer to “Channel Table window, page 497”.

The Channel Table window displays all of the channels open for a selected line.

Refer to
- Server Console, page 488

53.10 Channel Table window

The Channel Table window, shown in the Figure below, is used to view channel information.

To open the Channel Table window, do the following:

— In the Per Line Parameters window with P25 DFSI line type selected, click the Freqs
button.

The Channel Table appears.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



498 en | Appendix E - P25-DFSI (Digital Fixed Station Interface) C-Soft 7.700

’ Channeﬁ'aﬁle

Channel Number ~ Channel Label R¥_MNAC (Hex) T¥_MAC (Hex) TGID (Hex) Analog/Digital
1 Channel 1 293 293 1 P25 Digital

Load File

Save File

< | Delete Channel

Add Channel

RX Block Lines:
1iline 1

2:lot Enabled-
3:-Not Enabled-
4: Mot Enabled-
5:-Not Enabled-
&:-Not Enabled-

Figure 53.9: DFSI Channel Table

Channel Number column
The Channel Number column displays the physical channel number assigned to the radio.

Notice!
The Channel Number must match the Channel Number set up in the Fixed Station.

Channel Label column
The Channel Label column displays the name of the channel.

RX-NAC (Hex) column
The RX-NAC (Hex) column displays the receive NAC (Network Access Code). This code must
match the incoming NAC from a radio so the audio can be heard on C-Soft.

Notice!
The RX-NAC must match the RX-NAC set up in the Fixed Station.

TX-NAC (Hex) column
The TX-NAC (Hex) column displays the TX-NAC (Transmit Network Access Code).
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Notice!
The TX-NAC must match the TX-NAC, set up in the Fixed Station.

TGID NAC (Hex) column
The TGID (Talk Group ID) (Hex) column displays the Talk Group ID for the channel and is an
additional filter, used in both TX and RX directions.

Analog/Digital column

The Analog/Digital column displays the type of voice encoding/decoding by the console for
the selected channel. (A setting of P25 Digital causes the channel to transmit and receive in
P25 digital audio).

Analog uses G711 encoding/decoding for both transmit and receive. Mixed mode receives in
either analog or digital and transmit audio is selectable (analog or digital) via a user defined
button.

Available options are:

— P25 Digital - The channel transmits and receives in P25 digital audio

— Analog - The channel transmits and receives using G711 encoding/decoding.

—  Mixed Mode - Receives audio in either analog or digital. Transmit audio is selectable
(analog or digital) through the use of a user-defined button.

RX Block Lines panel

The RX Block Lines panel is used to select lines that have their receive audio blocked when
having their configurations modified. This allows the console operator to transmit on a radio
that has overlapping coverage with other radios, without getting feedback from the radios
receiving the transmitted signal. This function also operates when a parallel console is
transmitting on the line.

To mute a line during transmission, do the following:

1. From the RX Block Lines panel, select the lines you want to block.
The line is highlighted.

2. Click the line(s) a second time to clear the selection.

The line is no longer highlighted.

Load File button
The Load File button is used to load a saved Channel Table from a saved .csv (comma
separated values) file.

Save File button
The Save File button is used to save the Channel Table to a .csv file.

Add Channel button
The Add Channel button is used to manually configure another line.
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Delete Channel button
The Delete Channel button is used to delete a channel from the channel table.

To delete a channel, do the following:

1. From the Channel Table, highlight the channel row to be deleted.
2. Click the Delete Channel button.

The channel is deleted.

Edit Global DFSI Parameters button
The Edit Global DFSI Parameters button is used to open the P25 DFSI Global Setup window.
For more information, refer to “P25 DFSI Global Setup window, page 480”.

The P25 DFSI Global Setup window is where the type of console required for the system is
selected.

Refer to
- P25 DFSI Global Setup window, page 480

53.11 Setting Up Additional P25-DFSI lines

When adding multiple lines, the procedure is repeated from above.

Notice!

When setting up multiple lines, each line must have unique Unicast Addresses, Ports, and
Multicast Addresses. The only address that is constant among the lines is the IP Address of
the Server P.C.

Adding Buttons to the Design

Once you have created the lines to be used for the P25 system, buttons need to be created on
the console. You can assign buttons to either individual lines or you can use the preconfigured
P25-DFSI Window button.

The P25-DFSI Window button contains all P25 radio/base station functionality in a single
popup window.

Notice!
Each DFSI line requires one P25 _DFSI button; however, only one window is shown,
depending on the line/button selected.
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Figure 53.10: DFSI Design Options

For a P25 DFSI button without a Select Button, an “S” appears on the button for selected. A
“U” appears on the button if unselected.

(@D B8 |@ (1]
P25 DFSI P25 DFSI
Channel 2 Channel 2
Talk Group 1 Talk Group 1

Figure 53.11: P25 DFSI - Select and Unselect

P25-DFSI Misc Page setup
The P25-DFSI Misc window is used to change the colors of the buttons.
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P25-DFS| Misc

Misc

[¥]:Enable P25-DFS| Dispatch Window:

Receive All Talk Groups Dispatch Window Corfig
Feceive All Private Calls

P25-DF5| Radio List Fort Size: 12

Password Protection

[] Radio Monitor

[7] Radio Inhibit/Uninhibit
[ Call Alert

[ Vete Select/Disable

Figure 53.12: P25-DFSI Misc

To add a P25-DFSI button to the console, do the following:
1. From the Insert menu, select Add Ul Button.
A None button appears on the console window.
2. Right-click the None button.
A shortcut menu appears.
3.  From the shortcut menu, select Properties.
The Ul Element Setup window appears.
4. From the Ul Element drop down menu, select P25-DFSI Window.
5. Click the P25-DFSI Misc tab.
The P25-DFSI Misc Page appears.

Misc group box

Enable P25-DFSI Dispatch Window check box
The Enable P25-DFSI Dispatch Window check box is used to enable the P25-DFSI Dispatch
Window. If unselected, the user cannot open the DFSI Window in Runtime.

The default is selected.

Receive All Talk Groups check box

The Receive All Talk Groups check box, if enabled, allows the console operator to be able to
hear all incoming Talk Groups on that line. When the check box is not enabled, the line mutes
all audio not matching the current Talk Group of that line.

The default is selected.

Receive All Private Calls check box

The Receive All Private Calls check box, if enabled, allows the console operator be able to
hear all Private Calls on that line. When the check box is not enabled, the line mutes private
calls not directed to the console.
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The default is selected.

P25-DFSI Radio List Font Size field
The P25-DFSI Radio List Font Size field indicates the size of the P25-DFSI Radio List Font
Size.

The default is 12.
Password Protection group box

Radio Monitor check box
The Radio Monitor check box, if enabled, indicates the Radio Monitor function is password
protected.

For more information, refer to “Global Parameter Setup window, page 114”.

Radio Inhibit/Uninhibit check box
The Radio Inhibit/Uninhibit check box, if enabled, indicates the Radio Inhibit/Uninhibit
function is password protected.

For more information, refer to “Global Parameter Setup window, page 114”.

Call Alert check box
The Call Alert check box, if enabled, indicates the Call Alert function is password protected.

For more information, refer to “Global Parameter Setup window, page 114”.

Vote Select/Disable check box
The Vote Select/Disable check box, if enabled, indicates the Vote Select/Disable function is
password protected.

For more information, refer to “Global Parameter Setup window, page 114”.

Dispatch Window Config button
The Dispatch Window Config button is used to change the color of the buttons and
background of the Dispatch Window. Refer to the Figure below.
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Dispatch Windaw Color: 1 |'| -
Dispatch Window Font: Set Font

Main Control | Unit Control | Voting | History |

Figure 53.13: Dispatch Window

53.12 P25-DFSI window and C-Soft Runtime

The P25-DFSI window is the general control of a DFSI line. Clicking on the P25-DFSI button in
the Figure “DFSI Design Options” in “Setting Up Additional P25-DFSI lines, page 500", during
runtime, opens the window shown in the Figure below.

Refer to

Setting Up Additional P25-DFSI lines, page 500

53.12.1 Main Control page

The Main Control page is used to change the settings of the main control.

DFSI 1: Channel 1 [x]
Main Control | Unit Control | Voting | Repeater | History
Keypad: [
Channek: Channel 1 -
Volume:
D .nlll“l““"""
PTT Buttons: Talk Group 1 Tait 1
el [
Common Buttons: Control Buttons:

Status Information: Parameters Read

Figure 53.14: DFSI 1: Channel 1 - Main Control
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Channel drop down menu
The Channel drop down menu is used to select the channel.

Volume Slider
The Volume slider is used to increase or decrease the volume of the P25 audio.

Group Call button
The Group Call button is used to make a group call to the group ID in the ID box.

Talk Group field and drop down menu
The Talk Group drop down menu is used to place group calls to the group selected from the
list. The text above the drop down menu displays the selected value.

Private Call button
The Private Call button is used to initiate a Private Call to the radio ID in the ID box.

Private Call drop down menu
The Private Call drop down menu is used to place private calls to the radio selected form the
list.

Mute button
The Mute button is a latching button (press it, it stays muted, press again, it unmutes).

Selected button
The Selected button changes the current line from Selected Audio to Unselected audio.

Digital button
The Digital button is used to toggle the channel between Analog and Digital.

Notice!
The channel must be configured for mixed mode. For more information, refer to “Analog/
Digital Column” on Channel Table window, page 497.

Repeat On/Off button
The Repeat On/Off button is used to turn the base stations Repeater functionality On or Off.

Monitor On/Off button
The Monitor On/Off button is used to enable or disable monitor mode directly over the DFSI
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Keypad
/

DFSI 1: Channel 1
Main Control Unit Control | Voting | Repeater | History|

Keypad: 4
Channel:  Channel 1 -
Volume: -
PTT Buttons: Talk Group 1 Tait 1

Status Information: Parameters Read

Figure 53.15: DFSI 1: Channel 1- Main Control Keypad

Keypad flyout

The Keypad flyout is used to manually select unit IDs for a private call.

Refer to
—  Channel Table window, page 497

53.12.2 Unit Control page
The Unit Control page us used to send unit specific commands.
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DFSI 1: Channel 1 Talk Group 1 [x] D List

Main Control |. Unit Control 'Voting Repeater | History
Tait 1 Keypad: [
ID: | 2~ Dust

Date Time Freq Status TG-MAC SourceID TargetID

¥

[ TedoChesk | [ St Roquen | [ Redioihibi |
[ Coiien | [ RadioWonior | | Radio Uninhib |
— e

Status Information: Parameters Read

Figure 53.16: DFSI| 1: Channel 1 - Unit Control

ID List flyout
The ID List flyout contains all the Unit IDs and Group IDs setup for P25-DFSI. The ID List flyout
is used to access the preprogrammed Unit ID and Group ID list.

Date column
The Date column is used to show the historical date commands were sent.

Time column
The Time column is used to show the historical time commands were sent.

Freq column
The Freq column is used to show the frequency that was sent.

Status column
The Status column is used to show any status information about the sent command.

TG-NAC column
The TG-NAC column is used to show the talk group and identifier number for the radio call.

Source ID column
The Source ID column is used to identify the number of the calling subscriber unit.

Target ID column
The Target ID column is used to identify the number the source ID is calling.
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Radio Check button
The Radio Check button is used to verify if the target radio is currently online and functional.

Status Request button
The Status Request button is used to read the Status of a Radio.

Radio Inhibit button
The Radio Inhibit button is used to disable a radio from use. This feature can be used in the
case of a lost or stolen radio.

Call Alert button
The Call Alert button is used to send an alert to the target remote radio.

Radio Monitor button
The Radio Monitor button is used to monitor the selected remote radio.

Radio Uninhibit button
The Radio Uninhibit button is used to enable the radio for use. This feature is used to enable
a radio if it has been disabled with the Radio Inhibit button.

Text Message button
The Text Message button is used to send the selected Text Message from the drop down
menu to the selected radio.

DFSI 1: Channel 1 Talk Group 1 [x]
Main Control  Unit Control | Voting I Repeaterl History| ;
 Kenwoo
Tait 1 Keypad: [ || - Midiand 1
. - ) -Midland 2
ID: | 21 ] ID List: 4 - Tat1
Date Time Freg Status  TG-MNAC SourceID TargetID - Tait 2

Status Information: Parameters Read

Figure 53.17: DFSI 1: Channel 1 - Unit Control - ID List

53.12.3 Voting page

The Voting page is used to provide a visual representation of voter status.
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DFSI 1: Channel 1

|Main ControllUnit Control | Voting RepeaterlHist0w|

Receiver Vote State

Receiver 2
Receiver 3
Receiver 4
Receiver 5
Receiver &
Receiver 7
Receiver 8

Rereiver 9

m

e ] e

Keypad: [

Status Information: Parameters Read

Figure 53.18: DFSI 1: Channel 1 - Voting

Receiver column
The Receiver column is used to display the various voting receivers that are being used.

Vote State column

The Vote State column display the status of the various voting receivers.

Report button
The Report button is used to view the current Vote State of the receiver selected in the ID

box.

Normal button
The Normal button is used to set the receiver into normal state.

Select button

The Select button is used to select the receiver to use.

Disable button
The Disable button is used to disable the receiver input at voter.

53.124 Repeater page
The Repeater page shows the current state of all P25-DFSI lines setup in C-Soft.

Bosch Security Systems, LLC
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DFSI 1: Channel 1 ]

' Main Control | Unit Control | Voting | Repeater |History

Repeater Current State
DFSI 1 Channel 1

DFSI 2 Digital

DFSI 3 Connection Failed

Status Information: Parameters Read

Figure 53.19: DFSI| 1: Channel 1 - Repeater

When a line is selected, if the call is a Group Call, the PTT Button turns into a Group Call
button. If the call selected is a Private Call, the PTT Button becomes a Private Call button.

53.12.5 History page
The History page is used to show the historical information for traffic on the line.

DFSI 1: Channel 4 Talk Group 3

| Main Control | Unit Control |Voting | Repeater History

Date Time Freq Status TG -MAC  Source ID  Target ID

1752012 094500 Channel4 Group RX  Tak Group 1 Tait 1 7000
;I - 253

1752012 094842 Channel 4 Growp BX  Tak Group 1 Tait 1 7000

=i 293
] -293

Control Buttons: PTT Button:

Status Information: Tait 1 Group RX

Figure 53.20: DFSI: Channel 1 - History

Alert Cancel button
The Alert Cancel button is used to ignore a Call Alert on the P25-DFSI line.
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53.13 System features and requirement for DFSI Interface

Supported DFSI Repeaters

For the most up to date information on repeater support, go to www.telex.com.
- BK/Relm M/8150 with DFSI

- Codan

- EF Johnson Atlas

- ICOM

- RIC-M

- Tait

Supported DFSI repeater functions

For the most up to date information on supported DFSI repeater functions, go to
www.telex.com.

—  Channel Change

-  Repeat mode

- Monitor

- Voting

Supported DFSI radio functions
For the most up to date information on supported DFSI radio functions, go to
www.telexradiodispatch.com.

- Digital\Analog\Mixed Mode
— Radio Check

— Radio Inhibit

— Radio Uninhibit

—  Status request

- Call Alert

- Radio Monitor

- Private Call

- Group Call

Required for C-Soft Setup

- C-Soft 6.5000 or higher

—  Software-based license key for P25-DFSI lines

—  Supported Repeater (refer to Supported DFSI Repeaters, above)
— IP Addresses and Ports of Repeater

53.14 Frequently Asked Questions

—  P25-DFSI Line of Server Console won’t connect to Fixed Station:
Check the Control Unicast Address of FS and Control Port of FS in the P25-DFSI Setup.

—  P25-DFSI Line of Client Console won’t connect to Fixed Station:
Check the Control Unicast Address of Server and Control Port of Server in the P25-DFSI
Setup.

—  The wrong channel selected is shown:
Check the P25 Manufacture in the P25-DFSI Setup.
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54

Appendix F - P25 Encryption

Due to C-Soft’s Designer/Runtime separation, C-Soft first requires keys are registered and
organized in the design file. C-Soft uses a specialized architecture to allow for clarity and
flexibility in the task of key management. C-Soft utilizes several constructs and definitions to
simplify the management of encryption keys:

— Registered Key: A registered key’s information consists of a key name and a CKR
(Common Key Reference).

—  Encryption Option: Specifies the cryptographic method used to transmit. Available
encryption options are a Registered Key or Clear.

—  Encryption Profile: An ordered group of encryption options which represent a list of all
encryption options available on a given P25-DFSI talkgroup.

Each C-Soft design maintains a list of registered encryption keys, which are organized into
encryption profiles. Each P25-DFSI line contains a list of channels that are each linked to an
encryption profile, allowing the dispatcher to select and use any of the encryption options
available in the encryption profile.

Once these organization steps are completed, encryption keys must be loaded into C-Soft
Runtime. Once loaded, C-Soft Runtime uses the key organization as defined in the design file,
but uses key data directly loaded into Runtime. This allows for C-Soft to easily manage key
updates, changeovers, and other cryptographic maintenance tasks.

Notice!
The P25-DFSI Encryption functionality is a value added option to your C-Soft license; please
contact your regional Bosch Sales person for details on how to purchase.

P25-DFSI Lines
Encryption Profiles
: - P25 DFSI Line
Encryption Options
Channel
Clear
Channel
Key Channel
Encryption Option .
Key
P25 DFSI Line
| _Name | CKR | .
Encryption Option ( Channel
Encryption Option
Key : : Channel
[ Name | CKR | Encryption Option
. Channel

Figure 54.1: Encryption Configuration Constructs

In the example shown in the Figure below, there are three channels on both Line 1 and Line 2.
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— P25 DFSIl Line 1’s Channel 1 is linked to the encryption profile Clear that contains only
one encryption option, Clear. While using P25 DFSI Line 1’s Channel 1, the dispatcher
can only transmit unencrypted.

— P25 DFSI Line 1’s Channel 2 is linked to Encryption Profile A that contains three
encryption options. While using P25 DFSI Line 1’s Channel 2, the dispatcher can choose
whether to transmit unencrypted, with Key 1 or with Key 2.

— P25 DFSI Line 1’s Channel 3 is linked to the encryption profile B that contains only one
encryption option. While on Channel 3, the dispatcher can only transmit using Key 3.

—  P25-DFSI Line 2 contains three channels that are linked to encryption profile B. While on

all of these channels, the dispatcher can only transmit using Key 3.

Figure 54.2: Organization Configuration Example

54.1 Encryption configuration

In order to utilize the P25-DFSI Encryption features, the following configuration steps need to

be completed:

P25 DFSI Line 1 Profile “Clear”

: »

| channel 1 IE )‘ Clear

‘ Channel 2 Pruﬁle uAn Kev

| Channel 3 Clear I | P ey’ | 1

Key

P25 DFSI Line 2 ” Z

: Key2' o r——

| channel 1

i > Profile “B" Key
Channel 2 “ "

| ey 3" ; o

‘ Channel 3

Register Keys

C-Soft Designer

Group Keys into » | Link Channels to

Encryption Profile

Encryption Profile

Set Key Fill Device
Serial Port

Create Encryption
Select Button

C-Soft Runtime

Load Keys » Operate

1. “Registering keys, page 519”.
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“Group encryption options into encryption profiles, page 522”.
“Link P25-DFSI Channels to an encryption profile, page 523”.
“Activate Key Fill Device serial port, page 524”.

“Add an Encryption Option Select button, page 524”.

ok wbd

The majority of encryption configuration is contained in the Encryption Setup window, shown
in “Encryption Setup window, page 516”.

NAVIGATION: From the Edit menu, select Setup P25 | Encryption.

Refer to

—  Registering keys, page 519

—  Group encryption options into encryption profiles, page 522
- Link P25-DFSI Channels to an encryption profile, page 523
- Activate Key Fill Device serial port, page 524

- Add an Encryption Option Select button, page 524

- Encryption Setup window, page 516
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54.2 Encryption Setup window
Encryption Setup %
Encryption Keys

MName CER.

Key A 123

Key B 456 Key Fill Device

Key C 739

Click to create key Serial Port | COM1 w Start

Delete
Encryption Profiles

Mame Summary
Clear Clear
Selectable Clear +3 keys
Always Encrypted 1key
Click to create profile Clear

Edit Delete

Cancel

Encryption Keys group box

Name column field
The Name column field is used to enter the name of the key being registered. A maximum of
100 keys can be registered.

Up to 24 alphanumeric characters can be entered into this field.

CKR column field

The CKR column field is used to enter the common key reference number. A common key
reference number is used to link a key name to an encryption key in a key fill device,
commonly used for key name display purposes. This additional reference value allows
changing a key’s name without having to know its key ID.

The range for this field is 0 through 65535.
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Key Fill Device group box
The Key Fill Device group box is used to import encryption key data (Name and CKR) from a
key fill device to C-Soft.

Serial Port drop down menu
The Serial Port drop down menu is used to specify the serial port that C-Soft Designer opens
in order to communicate with an attached key fill device for key registration purposes.

Notice!
This value is also used in C-Soft Runtime to specify the serial port used to communicate with
an attached key fill device for key loading.

Start button
The Start button is used to immediately open the serial port listed in the Serial Port drop
down menu, allowing communication with the key fill device in C-Soft Designer.

The button toggles between a start and stop function.

Notice!
It is not recommended to use the DES demo key in any capacity where robust encryption is
required. It is used mainly for demonstration and debugging.

Encryption Profiles group box

The Encryption Profiles group box is used to create encryption profiles with different
encryption keys. For more information, refer to “Group encryption options into encryption
profiles, page 522”. Up to 50 encryption profiles can be created. Each profile can have up to
25 encryption options associated with it.

Notice!

The Encryption Profile list always contains an encryption profile labeled Clear, which contains
the Clear encryption option only. By default, any P25-DFSI Line’s channels are linked to the
clear encryption profile.

Name column field
The Name column is used to enter a profile name, such as All Keys or Clear Only.

Summary column field
The Summary column field summarizes the key options included in the Key Profile (i.e., Clear
+2keys). This column is automatically generated.

Edit button

The Edit button is used to open the Encryption Profile window of the currently selected
encryption profile. Use this window to add and remove different encryption options to the
profile as well as set the default encryption option.
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Delete button
The Delete button is used to delete an encryption profile.

1. Select the profile intended for deletion.

Click the Delete button.

A warning message appears verifying the intention to delete the profile.
3. Click OK.
The profile is deleted from the Encryption Profiles list.

Encryption Profile Edit window

The Encryption Profile Edit window is used to create encryption profiles using the user
created encryption options and Clear.

For more information, refer to “Group encryption options into encryption profiles, page 522”.

Encryption Profile -

Profile Mame: Profile 1

All Options Selected Options
Clear Key101(101)
Key 103 (103) Key102 (102)

Key 104 (104)

Frx *

SRt *

Cancel

Figure 54.3: Encryption Profile Edit Window

Profile Name field
The Profile Name field is used to enter a name for the encryption profile.

All Options list
The All Options list displays a list of all available encryption options for use in the profile.

Add button
The Add button is used to move options from the All Options list to the Selected Options list.
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Remove button
The Remove button is used to move options from the Selected Options list to the All Options
list.

Selected Options list
The Select Options list displays a list of the encryption options selected for the profile being
created. The Selected Options list is an ordered list.

Notice!

The first option listed is always the default option. For example, in Figure 228, Clear is the
default encryption option. The default option is the first option listed on the Encryption
Button Popup List in C-Soft Runtime.

Use the up and down buttons to move the selected encryption options up or down in the list.

OK button
The OK button is used to accept the modifications made and closes the Encryption Profile
window.

Cancel button
The Cancel button is used to close the Encryption Profile window. No modifications made are
saved.

Refer to
—  Group encryption options into encryption profiles, page 522

54.4 Registering keys

Registering keys requires two pieces of information:
—  The Key’s Name
—  The Keys CKR (Common Key Reference) value

To transmit encrypted audio using a specific encryption key, the key must be registered into
the system design.

There are two methods to register keys; manually or automatically.

Register manually
To register manually, do the following:
1. From the Edit menu, select P25 | Encryption.
The Encryption Setup screen appears.
2. In the Name column, enter a unique name for the key.
3. Inthe CKR column field, enter the CKR number for the key.

Register automatically
When using a key fill device to import keys to C-Soft, some radios do not use key names, refer
to “Key Fill Device Group Box”.
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To register automatically, do the following:

1. From the Edit menu, select P25 | Encryption.
The Encryption Setup screen appears.

2.  From the Serial Port drop down menu, select the COM port to be used to communicate
with a key fill device.

3. Click the Start button.
The specified serial port for communication with an attached key fill device opens.
NOTE: C-Soft Designer may be unable to acquire the serial port if C-Soft Runtime has
reserved the port.

4. Using the Key Fill Device, load the keys into C-Soft.

The updated Key Names and CKRs appear in the Encryption Keys table.

Notice!

When using the automatic register feature, only Key Names and CKRs are loaded.

Encryption Setup
Encryption Keys
Mame CkR
My First Key 1249
My Second Key 569 Ke
My Third Key [ 741]
Click to create key E
DE
Delete
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54.5 Connecting a key fill device

Motorola
KVL-4000

Tait 9000 Series to
KVL adaptor Model
TPA-SV-020

Null Serial
cable
connection
points

Depending on the radio you are using, a few differences must be noted.

—  If using a Tait Recon KVL, connect the bottom DB-9 serial port to the C-Soft Console PC
using a null serial cable.

- If using either the Motorola KVL-3000+ or KVL-4000, the Tait 9000 Series to KVL adapter
is also necessary. On the Motorola KVL, connect the 10-pin connector to the Tait 9000
Series to KVL Adapter. And then connect the DB-9 serial port to the C-Soft Console PC
using a null serial cable.

Key Fill Device Features and Limitations
While all tested key fill devices follow the same base P25-defined Key Fill Device Interface
Protocol, there may exist several operational differences and behavior.

Key Names

The Motorola KVL-3000+ and Motorola KVL-4000 do not include Key Names when importing

encryption key data. This results in the following behavior:

— In C-Soft Designer, when using Automatic key registration, only keys’ CKR values are
added to the Key List. Their names must be manually set.

— In C-Soft Runtime, when receiving an audio call encrypted with a key with a non-
registered but loaded key, C-Soft will display “Unregistered Key (#)”, where # is the CKR
of the key. This can be amended by manually registering the key in the Design, which
makes the key name appear properly.

—  The Tait Recon KVL key load process includes key names, and in each of these cases, the
Key Name is properly displayed.
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54.6 Group encryption options into encryption profiles

Encryption Profiles are ordered groups of encryption options such as registered keys and
Clear.

To group encryption options into encryption profiles, do the following:
1. From the Edit menu, select P25 | Encryption.
The Encryption Setup screen appears.

Encryption Setup X
Encryption Keys
Mame CKR
Key 1 123
Key 2 455 Key Fill Device
Key 3 739
Serial Port | Dis v Start

Click to create key

Delete
Encryption Profiles

MName Summary
Clear Clear
My Profile Clear
Profile 2 Clear+3 keys
Click to create profile Clear

Edit Delete

Cancel

2. In the Encryption Profile group box, click in the Click to create profile field.
The name column field becomes active.

3. Enter a profile name in the active field.
The profile name appears in the field.
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4. Click the Edit button.
The Encryption Profile window appears.

Encrypticn Profile >

Profile Name: Profile 2

All Options Selected Options
Key 1(123) Clear

Key 2 (456)

Key 3 (789)

e *

L *

Cancel

5. From the All Options list, select the options to add to the profile.

Multiple options can be selected at one time.

6. Click the Add button to move the encryption options to the Selected Options list.

7. Use the up and down buttons to reorder the Selected Options list, if applicable.
NOTE: Reordering the Selected Options list is useful when wanting to the default
encryption option in which the topmost entry becomes the default.

8. Click OK.

The Edit Encryption Profile window closes.

54.7 Link P25-DFSI Channels to an encryption profile

Each P25-DFSI Channel needs to be configured to select which Encryption Profile to use.
When the specific P25-DFSI Channel is selected, only encryption options in the associated
encryption profile are available to use for transmit.

To link the P25-DFSI channels to the encryption profile, do the following:
1. From the Edit Window, select Setup Per Line Parameters.

The Per Line Parameters window appears.
2. Press the Freqgs button of the desired P25-DFSI line.

The Channel Table appears.
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54.7.1

3. From the Encryption Profile column drop down menu, select an encryption profile for
each channel.

Channel Table: Line 2 *
ChannelNu... ChannelLabel RX_NAC (H... TX_NAC (Hex) TGID (Hex) Anzlog/Digital ~ Encryption ... | oK |
1 Channel 1 293 293 1 P25 Digital Clear Cancel
- 2 Channel 2 293 293 1 P25 Digital Profle 1 ~
- 3 Channel 3 293 293 1 P25 Digital Clear Load File
4 Channel 4 293 293 1 P25 Digital
> 5 Channel 5 293 293 1 P25 Digital Profile Everythi save File
> B Channel 6 293 293 1 P25 Digital DEMO ONLY
> 7 1 P25 Digital Clear

Channel 7 293 293

4. Click OK.
The Channel Table modifications are saved, and the Channel Table window closes.

Activate Key Fill Device serial port
To permit communication between C-Soft and a key fill device, the desired serial port must be
configured.

To configure C-Soft Runtime’s serial port, do the following:

1. From the Edit menu, select P25 | Encryption.
The Encryption Setup screen appears.

2. From the Serial Port drop down menu, select the COM port to be used to communicate
with a key fill device.

3. Click the OK button.
The Encryption Setup window closes.

4. Save the design.

Notice!
When C-Soft Runtime is launched with the Design, C-Soft opens the selected serial port for
communication with an attached key fill device.

54.8

Add an Encryption Option Select button

Encryption Profiles containing more than one encryption option need a Ul element to control
the encryption option to be used while transmitting. Secondarily, the Encryption Option Select
button also displays encryption key information when receiving encrypted audio.

To add an Encryption Option Select button, do the following
1. From the Insert menu, select Add Button.
OR
Right-click in an empty spot in the Design workplace.
A popup menu appears.
2. Select the Add button.
A button appears in the design workspace.
3. Right-click on the button.
A popup menu appears.
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54.9

4. From the popup menu, select Properties.
The Ul Properties window appears.

UI Elernent Setup

Type  Colors  Options

|l Bement: Button

Fitter: | All L

1JI Bement Function:

Encryption Key Select w

Line to Associate Function With:
Line 1 []i5lcbal Radio Button:

5.  From the Ul Element Function drop down menu, select Encryption Key Select.

6. From the Line to Associate Function With, select the P25-DFSI Line configured for P25
Encryption.
OR
Select the Global checkbox to have the Encryption key Select button display information
based on the currently selected line.

7. Click OK.

The window closes and the button displays Key Select.

Loading keys to C-Soft Runtime

At this point, C-Soft Runtime does not have any actual key data. This key data must be loaded
from a key fill device. C-Soft Runtime communicates to a key fill device through the PC’s serial
port.

To load keys into C-Soft Runtime, do the following:

1. Launch C-Soft Runtime.

2. Attach a Key Fill Device to the C-Soft Dispatch Console PC via the serial port.
Upon successful connection, C-Soft’s Status Bar displays a “Key Fill Device Attached”
message.
NOTE: C-Soft Runtime may be unable to acquire the serial port if C-Soft Designer is using
it to register keys.

3. Using the key fill device, load one or more keys into C-Soft in the same fashion as a
radio.

Once finished, C-Soft’s Status Bar displays a “# Key(s) Updated” message, where “#” specifies

the number of keys that were loaded or updated. The keys are now successfully loaded into C-

Soft.

Refer to “Connecting a key fill device, page 521” for more information on using a key fill
device.
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54.10

54.11

Refer to
—  Connecting a key fill device, page 521

Receiving encrypted calls

When receiving a call with encrypted audio, C-Soft attempts to find a loaded key in which the
incoming Key ID matches the received Key ID. If a matching key is found, the call is decoded
and played. If C-Soft does not possess a key with a matching Key ID, the incoming call’s audio
is muted.

While receiving a call encrypted with an AES key, the line’s Select button displays FIPS to
indicate the call is being decrypted using a FIPS-validated cryptographic library.

In addition, the Encryption Key Select button momentarily displays the incoming call’s key
name, or the Key’s CKR if the name is not known. Since there are potentially two locations in
which a key name is specified, C-Soft uses the following priority list for displaying Key
Information:

1. Registered Key Name from Design’s Encryption Key List

2. Key Name obtained from the key fill device.

3. “Unregistered Key <CKR>”

The incoming call flow is summarized as follows:

| ing P25 Does C-5oft Isthere a Registered Encryption Select Button:
ng IsCall Encrypted? p—Yes-j» possess Key with b—Yez—p» Decrypt and play call Keywith matching p—Yes-J» Display Registered Key's
matching Key ID? CKR? Name

| 1 |
No No No

¥ h 4 ¥
Does Key [ loaded Encryption Select Button:
Play Call Mute Call from KFDj have +—Ye=—p Display Key Name from
name? KFD
|
No
4
Encryption Select Button: En;:pﬂn:js:;utr:n
Display "Unknown Key* Key [<CKR=]"

Figure 54.4: Receiving Call Flow

Transmitting encrypted calls

The Encryption Key Select button is the essential Ul element for encryption operation. The
button is either configured as global meaning the content is changed based on the currently
selected line, or statically configured to a specific line.

The Encryption Key Select button is also linked to the currently selected channel/talkgroups,
and changes its content when the active channel/talkgroups is changed. The Encryption Key
Select button’s selected option is preserved between switching selected lines and switching
channel/talkgroups.
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# Sample Key 1 (555)
 Sample Key 2 (87)
 TestKey 1 (88)

- Test Key 2 (500)

- Test Key 3 (501)

Figure 54.5: Encryption Key Select Button (with Option List)
The Encryption Key Select button’s drop down menu contains a list of all encryption options
contained in the encryption profile linked by the currently selected frequency of the

associated line. In addition, it contains information relevant to encryption key validity.

The icon/states include:

Icon Meaning Description
Blank Used for “Clear”, indicates
transmissions are not
encrypted.
Key Key data is loaded and
available.
4 No Data Key name/CKR are registered

in the Design file, but C-Soft
Runtime does not possess
data for the key. Any attempt
to transmit using a registered
but not loaded key is blocked.
After using a key fill device to
load the key’s data into C-
Soft Runtime, the no data
icon changes to key.

Once an encryption option is selected, pressing a PTT button (e.g. Main PTT, Per-Line PTT,
Private PTT, or Group PTT) button will transmit using the selected key. While receiving a call
encrypted with an AES key, the line’s Select button displays FIPS to indicate the call is being
decrypted using a FIPS-validated cryptographic library. The transmit call flow is as follows:
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Encrypt and transmit
Does C-Soft FYe udio
—Encryption Key® possess Key with
What isselected matching CKR? Ly
Encryption
Option? e
Demao ) Is Demno Key
Key FElEEE Block Transmit
I [ Display Error Message
“Clear”
Transmit Clear

Figure 54.6: Transmit Call Flow
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55 Appendix G - CSSI Interface

The P25 CSSl interface is designed to connect directly to P25 Trunking System via an IP
Interface without using a radio gateway or additional hardware. The C-Soft CSSI interface
provides flexibility in deployment and offers advanced radio control features. CSSl interface is
an option feature on C-Soft and available in 2, 6, 12, and 24 talk paths.

Notice!

Included with this option is the ability to define a line as either P25 CSSI or P25 DFSI. The
total number of lines available is constrained by the number of lines in the P25 CSSI option
license. In other words, a six line P25 CSSI license could have all six lines set up for P25
CSSI, or all six lines set up for P25 DFSI, or a combination of 4 lines set up for P25 CSSI and
two lines set up for P25 DFSI.

55.1 Supported features

Notice!
While C-Soft supports these features, each radio manufacturers supported CSSI feature set
varies, consult technical support for a list of known features per manufacturer.

The CSSI Trunking Interface supports the following features:
—  Console Registration

- Group Call

- Private Call

- Call Alert

—  Announcement Call

- System Call

—  Short Message Decode

-  Status Query/Update

- Radio Unit Monitor

— Radio Check

— Radio Enable

— Radio Disable

—  Emergency Alarm

- Emergency Acknowledgement

—  Audio Encryption and Keys Loading

- P25 Phase 1

- P25 Phase 2

— P25 DFSI (refer to “Appendix E - P25-DFSI (Digital Fixed Station Interface), page 479”)

Refer to
- Appendix E - P25-DFSI (Digital Fixed Station Interface), page 479
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55.2 Theory of operation

Console

In a P25 CSSI interface, the C-Soft console acts as an RFSS System. When the console starts,
it needs to register its talk groups with the P25 trunking infrastructure via IP connection to
gain access to the system.

Notice!
The registration process fails on certain talk groups if those talk groups are not pre-
programmed in the CSSI system.

Call Line

Each CSSI line within a console design can be set up as either Talk Group or Unit Call lines.
Talk Group lines use either a Group PTT or InPTT button for call activation. Using a GroupPTT
button allows the talk group ID to be varied on the line. Using an InPTT button creates a
dedicated line with only one talk group ID. All talk groups needing to receive and transmit on
must be registered with the CSSI system. The console registers all talk groups contained in
the consoles System List when the console first starts. Talk group validation can be viewed in
the console’s Global Call History window (refer to “Global Call History window, page 447”).

A Unit Call line is used to send private calls to an individual radio subscriber. Unit lines use
either a Private PTT button or an InPTT button for call activation. Using a Private PTT button
allows the unit ID to be varied on the line. Using an InPTT button creates a dedicated line to
call only one unit ID. Radio buttons such as Call Alert, Remote Monitor, etc. are typical buttons
assigned to this type of line. Console designers can add a Keypad module to the console
design to provide easy access to the Talk Group or Private Call user list during call operations
when using the Private PTT button.

Notice!

It is strongly recommended to assign Radio Control Buttons such as Radio Call Alert, Radio
Check, Radio Disable, Radio Enable, and Radio Remote Monitor to a unit call line. This ensures
seamless operation on the console.

Assigning the Radio Control Buttons on group lines that may be restricted can produce
unpredictable results.

The console registers all talk groups contained in the consoles System List when the console
first starts up. The System List can be edited using the System List Window (refer to “Status
List window, page 236”). Talk group validation can be viewed in the console’s Global Call
History window (refer to “Global Call History window, page 447").

Refer to
—  Global Call History window, page 447
—  Status List window, page 236
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55.2.1

Distribution of receive audio to the lines

Talk Groups

The CSSI protocol is based on SIP (Session Initiation Protocol); therefore the console
implementation also uses this protocol to structure the operation of the console. The console
first scans all lines for a Group PTT button that is set to the incoming talk group ID. If the
receive ID matches the line’s talk group ID, the line receives the audio.

If no Group PTT button is set to the incoming ID, the console then scans all lines with an
Instant PTT button (a dedicated line) for a group ID assigned to the line (the talk group ID
assigned in C-Soft Designer). If the receive ID matches the lines talk group ID, that line
receives the audio.

If no line matches the ID, the receive audio goes to the first available (non-busy) line with a
Group PTT. If all lines are busy, the call is missed.

Notice!

If a console system cannot tolerate any missed talk group calls, the console administrator
must have as many Talk Group lines as voice channels available on the CSSI system and all
lines must have Group PTT buttons.

If a dispatcher needs to monitor and talk to a specific talk group, an InPTT button is used to
create a dedicated line.

Unit lines operate exactly the same as group lines, with one exception, if all unit call lines are
busy the console sends back a busy signal to the calling unit.

Operational Notes

—  The talk group or unit ID shown on the Group PTT, InPTT, and Private PTT is the line’s
current transmit and receive ID.

— If the keypad module is used on the C-Soft console to change talk group and unit IDs,
console operators must select the desired line by clicking on the Select button first and
changing the ID in the keypad. The ID changes on the selected line’s PTT button and any
radio buttons assigned to it. If a console operator selects another, the previous selected
line retains its ID. This operation holds true for all non-dedicated lines. Dedicated lines
are preset to the default designer value; the keypad has not effect on these lines.

— Upto 24 CSSl lines can be created with any combination of Talk Group or Unit lines.

Group Call line
A Group Call is used to talk to multiple radios within a talk group.

Group lines use Group PTT or an InPTT button for call activation. Using a Group PTT button
allows the Group ID to be varied on the line. Using an InPTT button creates a dedicated line
with only one Group ID. In addition, a Radio Status button can be assigned to a group line to
send status messages to a group.
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Notice!

All talk groups must be registered with the CSSI system. Upon initial start up, the console
registers all CSSI groups listed in the Group ID List. Talk group validation can be viewed in
the console’s Global Call History window. The registration process fails on groups not pre-
programmed on the CSSI system. To configure the console’s system list, refer to “File menu -
Edit System List, page 193".

55.2.2

55.3

55.3.1

Refer to
- File menu - Edit System List, page 193

Individual Call line

An Individual Call line is used to send private calls to individual units. Individual Call lines use
a Private PTT or an InPTT button for call activation. Using a Private PTT button allows the unit
ID to be varied on the line. Using an InPTT button creates a dedicated line with only one unit
ID.

Radio buttons (Call Alert, Remote Monitor, Regroup, Ungroup, etc.) are typically assigned to
this type of line. Console operators can add a Keypad to the console design, providing easy
access to the user list during call operation. All Unit Calls are received by the console when
the Individual Call line is in Scanning Mode. In Dedicated Mode, the Individual Call line
becomes a point-to-point call with one preprogrammed unit.

CSSI Call types

Each CSSI line within a console design can be set up as either Group or Individual Call lines.

Group Call

Talk Group lines use either a Group PTT or InPTT button for call activation. Using a GroupPTT
button allows the talk group ID to be varied on the line. Using an InPTT button creates a
dedicated line with only one talk group ID.

To create a Group Call, do the following:

1. From the Edit Window, select Setup Per Line Parameters.
The Per Line Parameters window appears.

2. Click the Signal Setup button of the P25 CSSI line to create a group call.
The Signaling Parameters screen appears.

3. Click the CSSI tab.
The CSSI page appears.

4. From the Call Type drop down menu, select Group Call.

5.  From the Encryption Profile drop down menu, select the encryption profile to use, if
applicable.

6. In the Call Number field, enter the Talk Group Number of the line if using an InPTT
button on the line.
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Notice!

If the console designer assigns an InPTT button to the line, this line would only transmit to
and receive from the default ID. This is called a Static Group Line. If the console designer
assigns a Group PTT button to the line, the default ID is overridden at run time by the current
Group ID assigned by the selectable Group PTT button. This is called Manual Group line.

Select

InPTT
Group 01
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Select

Group PTT
Group 004

Figure 55.1: Static Group Line and Manual Line Set Up

55.3.2 Individual Call
An Individual Call line is used to send private calls to individual users. Individual lines use
either a Private PTT button or an InPTT button for call activation. Using a Private PTT button
allows the unit ID to be varied on the line. Using an InPTT button creates a dedicated line with
only one unit ID. Radio buttons such as Call Alert, Remote Monitor, etc. are typical buttons
assigned to this type of line. Console operators can add a Keypad to the console design to
provide easy access to the user list during call operation.

To create an Individual Call, do the following:

1. From the Edit Window, select Setup Per Line Parameters.
The Per Line Parameters window appears.

2. Click the Signal Setup button of the P25 CSSI line to create an individual call.
The Signaling Parameters screen appears.

3. Click the CSSI tab.
The CSSI page appears.

4. From the Call Type drop down menu, select Individual Call.

5. From the Encryption Profile drop down menu, select the encryption profile to use, if
applicable.

6. In the Call Number field, enter the Individual Call Number of the line if using an InPTT
button on the line.
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Notice!

If the console designer assigns an InPTT button to the line, this line would only transmit to
and receive from the default unit ID.

If the console designer assigns a Private PTT button to the line, the Private PTT overrides the
default number and allows different units to be selected.

g %]
[ Fianal

Selected

Private
Call
Radio 41

Figure 55.2: Private Call Configuration

55.4 C-Soft Setup parameters

To program a P25 unit radio or parallel console ID for CSSI operation, do the following:
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1. From the edit menu, select Edit User ID List.
The User ID List window appears.
User ID List X
Mame: Sot By Mame UserID: | SotByID Type: T Inhibit: lcon:

[ ] (e | [ee527 | |Pescasi ~ O Fiters | lcon 1 ~

[2 |[consde2 | 131072 | |Pascssl « O Fiters | ' lcon 1

[3 ||consde3 | [1a8608 | |Pescssl ~ O Fiters | |lcon 1

[+ |[consale s | [262124 | |Pescssl v O Fiters | |con 1

|5 |[Consoles | [327880 REES ~ 4 Fiters | |lcon 1

[ |[console® | [3m3218 | |Pscssl ~ O Fiters | [lcan 1

[ |[consde? | [45a7sz | |Pescssl ~ O Fiters | lcon 1

(8 |[console s | (524288 | |Pascssl ~ O Fiters | |lean |

[3 |[HiewsConsole | [1005 | |P25casi ~ O Fiters | [on 1

(10 |[Radio1 | [1 | |Poscssi v O Fiters | lcon 1

[11 |[Radio2 | [2 | [Pescssi v~ O Fiers | | Icon 1

[12 |[Radio3 | [2 | [Pescssi v O Fiters | | Icon 1 v

LoadFile | | Save File Cancel

2. In the Name column, enter the alias for each line.
3. Inthe User ID column, enter the User ID for each line (the User ID is in decimal format).
4. From the Type drop down menu, select P25-CSSI.
5. Click OK.
Notice!

To program an All Call ID that can transmit to all CSSI subscribers on the system, enter 65535
in the User ID column, and select CSSI from the Type drop down menu. All numbers are in
decimal format.

To program a P25 Trunking talkgroup for CSSI operation, do the following:
From the Edit menu, select Edit Group ID List.

1.

The Group ID List window appears.

Group ID List

Group: Soit By Name|  Group ID: Sort By ID
] | [0 | [Pascssi
[2 ][Group1 | [1 | |Pescssl
[3 |[arouwp2 | [2 | |PasCssl
[4 |[Grou3 |[3 | [Pascssi
[5  |[Group4 | [4 | |Pescasl
e |[Gous | [5 | |P2scssi
DT | [6 | |Pascssl
[ |[Group? RE | [Pascssi
(3 |[Grous NE | [Pescssl
[0 |[Group3 | [s | [Pscssi
(11 |[System Cal | [pamas | [Pescssi
[z ] | | |Geneiic
Load File Save File
Uncheck All| | SetColor | |Reset Colors

Type:

T Inhibit: - Set Color:

Filters ~
Filters
Filters
Filters
Filters
Filters
Filters
Filters
Filters
Filters

Filters

OoOooooooooooaond
ODoOOoooooooooad

Filters v

Cancel
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2. Inthe Group column, enter the Group alias for each line.
3. Inthe Group ID column, enter the Group ID for each line (the Group ID is in decimal

format).
4. From the Type drop down menu, select CSSI for each line.
5. Click OK.
Notice!

During start up, C-Soft registers all of the pre-programmed CSSI Talk Groups. C-Soft can only
communicate to Talk Groups registered to the system.

55.5 Signaling Parameters

Signaling Parameters: Line 1

General Signal Setup | CSSI

Console Call Parameters RFSS Location Parameters
RFSS ID:
Call Type [Group Call v] f] Dec 3 Hox
Encryption Profile: [Clear v] System ID: -
CallNumber. ! Dec : Dec : Hex
WACN ID:
1 Dec 1 Hex

RFSS IP Address
172 0019 0 2 . 6

RFSS Location ID:
03.002.00001.p25dr

Gobal CSSI Setup

| OK I [ Cancel

Figure 55.3: Signaling Parameters - CSSI| Page

Console Call Parameters group box
The Console Call Parameters group box is used to configure a line’s voice call. Configuration
options include the type of call, the encryption profile to use, and the call number.

The Call Type drop down menu is used to select the type of call designated to the line.

Available options are Group Call or Individual Call.

Encryption Profile drop down menu
The Encryption Profile drop down menu is used to select the encryption profile to use for the
line, if any. For more on Encryption profiles, refer to “Appendix F - P25 Encryption, page 513”.
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55.6

Call Number field

The Call Number field is used to enter the Talk Group ID or the Individual ID, depending on
what is selected in the Call Type drop down menu. This field is uniquely identified by a
number.

The range for this field is 1 to 65535 in decimal.

RFSS Location Parameters group box

The RFSS Location Parameters group box is used to configure the P25 repeater RFSS (Radio
Frequency Sub-System) that connects to the line. The following field values are obtained from
the systems RFSS.

RFSS ID Dec/Hex fields
The RFSS ID Dec/Hex fields are used to enter the ID of the Home RFSS in the connected P25
Trunking system. The unique identifier can be entered in either decimal or hex format.

The range for this field is 1 to 65535 in decimal.

System ID Dec/Hex fields

The System ID Dec/Hex fields is used to enter the ID for the LMR system within a WACN
(Wide Area Communication Network). The unique identifier can be entered in either decimal
or hex format.

The range for this field is 1 to 4095 in decimal format.

WACN ID Dec/Hex fields

The WACN ID Dec/Hex fields are used to enter the WACN ID, which is a collection of one or
more LMR systems. The unique identifier for each LMR system can be entered in either
decimal or hex format.

The range for this field is 1 to 1048575.

RFSS IP Address field
The RFSS IP Address field is used to enter the IP Address of the RFSS system. Individual RF
sites use this address to connect with.

RFSS Location ID field

The RFSS Location ID field displays the an ID that is made up of the RFSS ID, System ID, and
the WACN ID. This field cannot be modified. This field is most commonly used for comparison
purposes when setting up a CSSI system.

Global CSSI Setup button
The Global CSSI Setup button opens the Global P25 CSSI Parameters setup window. For
more information, refer to “Global P25 CSS| Parameters, page 540”.

CSSI System setup
To set up a CSSI Line, do the following:
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1. From the Edit menu, select Setup Per Line Parameters.
The Per Line Parameters window appears.

Per Line Parameters X
(L Packet ‘ oK.

MNumber  Line Type Line Mame Rx Multicast Address Rz Poit T Multicast Address  Tx Port Base Radio IP: TTL Delay

P25C551 v |[Broup 1 | [225. 8 .11 .81 |[1054 | [225. 8 .11.81][1z54 |[0.0.0.0]6 10 @ N £ I
Echo Packets Enable: [o0.0.0.0]ms [o0.0. 0. 0]z & JSetup

P25-C55I vHGmupz | [225. 8 .11 @1 |[1055 | [225.8 1.8 |[12855 |[[0. 0.0 06 10 ‘D e P | Sval] [
Echa Packets Enable: [0 0. 0.0 [o.0.0.0]125% i | sep

F250551 v |[Broup3 | [225. 8 .11 .81 |[105 | [225. 8 .11 .81 |[1z56 |[0.0.0.0]6 |10 Options | [readl | 5ol e
Echo Packets Enable: [0 0. 0. 0]se [o.0.0. 0] & Setup

F25C55| v |[Group 4 | [225.8 11 & |[1057 | [225.8 118|157 [[0. 0.0 06 10 o E Sgral| |
Echo Packets Enable: [o.o.o0.0]hws |[[0.0.0.0]0z plane| T | setup

(5 |[Pscssi v |[Group5 | [225. 8 .11 . |[1058 | [225. 8 .11 .81 |[12% |[0.0.0. 06| 1 Options| Freas | 5908l | oo
Echo Packets Enable: [0. 0.0 . o]ms [o0.0. 0. 0] F + Selup

[5|[pescssi |[Grouns | [225 8 11 o] [1089 | [225 8 w1 er[12s8 [0 0 0 0]e| 0 [ dE ﬁ o
Echo Packets Enable: [0 0. 0. 0]ss | [o.0.0. 0129 4| Setup

P25-CSS| VHGrnupT | [225. 8 .11 &1 |[1080 | [225. 8 .11 .80 |[1260 |[[ 0.0 0 0]s 10 opiors| [N Si%”a' "
Echo Packets Enable: [0 0. 0. ofen [o.0.0.0]120 etup

P25C351 v |[Private | [225. 8 .11 .81 |[1061 | [225. 8 .11.81][1261 |[[0.0.0.0]6 10 omons| el |5t [
Echo Packets Enable: [o.0o. 0.o0fhe [ [o0.0.0. 0]H121 Setup

[3 ][Disabled | Lines [225. 8 .11.a1] 1062 | [225.8 1181|1262 [[0.0.0.0][6| 10 ooiene] B Sinal | | oo
Echo Packets Enable: [0 0. 0. o]foez | [o.0.0. 0]z 1898 | Setup

Disabled | Line 10 [225. 8 .11.81] 1063 | [225.8 .11 .81 |1263 [[0.0.0.0][6| |10 aptions| [Freas | 53| | 5P
Echo Packets Enable: [o.o.0.0]mea  [o0.0.0.0]"123 i v

| dutoFil

2. From the Line Type drop down menu, select CSSI.
NOTE: The Multicast address and port number information is used for cross console
communications supporting the following features: Call Queue, Emergency and Cross-
patch updates. These fields should match on each console in a shared system.

3. Click the Signal Setup button.
The Signaling Parameters window appears.

Signaling Parameters: Group 1 b4

General Signal Setup  CSS|

System Settings
System Type: P25-CSSI w
System Name: None ~ Edit System

Signaling AutoFill Setup
Enable Signaling AutoFill

Starting Line Mumber: 1

Ending Line Number: 1

Call Logging

Lisplay All Calls

Cancel

4. From the System Type drop down menu, select P25 CSSI.
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5. Click the CSSI tab.
The CSSI window appears.

| General Signal Setup | €SS
Console Call Parameters RFSS Location Parameters
RFSSID:
Call Type: | Group Call = - .
Dec Hex
| :
Encryption Profile: [Giaar = | System ID
|
2 2
| Call Mumber | Dec Dec Hex
WACN ID-

i7Zz. @ . 2 6

| RFSS Location 1D:
03.002.00007 p25dr

Gobal CS51 Setup

I 0K ] I Cancel

\
| ‘
l ' Dec ' Hex
I
RFSSIP Address

6. From the Call Type drop down menu, select the Call Type.
7. Inthe Talk Group Number field, enter the Talk Group Number.

55.7 Global P25 CSSI Parameters

The Global CSSI Parameters apply to all CSSI console lines and only need to be set once per
console. The Global CSSI Parameters window is assessable from any line, but the values are
constant between lines, and can be found at Edit | Setup CSSI.
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Global P25 CSSI

Console Location
Console ID:

1000 3E8
Dec

Console RFSS ID:

Dec 1111

Console System ID:

2
Dec

Console WACHN ID:

1
Dec

Console Location ID: Console SUID:

1111.002.00001.p25dr 00001.002.0003E8.p25dr

|| Enable Heartbeats

Heartheat Rate Missed heartbeats

o0 Ser . # of allowed

Receive FNE supplementary data by SUs registered with group

Console Tx Priority:

16 Dec

Local Consoles OK

Cancel

Figure 55.4: Global CSSI Trunking Parameters Window
Console Location group box

The Console Location group box is used to define the console location identifiers.

Console ID Dec/Hex fields

The Console ID Dec/Hex fields are used to enter the ID that is assigned to the console.
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The range for this field is 1 to 16777215 in decimal format.

Console RFSS ID Dec/Hex fields
The Console RFSS ID Dec/Hex fields are used to enter the ID of the RFSS. This ID must match
the external CSSI RFSS ID which was set up on the LMR system.

The range for this field is 1 to 65535 in decimal format.

Console System ID Dec/Hex fields
The Console System ID Dec/Hex fields are used to enter Control System ID. This ID must
match the CSSI System ID which is set up on the LMR system.

The range for this field is 1 to 4095 in decimal format.

Console WACN ID Dec/Hex fields
The Console WACN ID Dec/Hex fields are used to enter the WACN ID. The WACN is a
collection of one or more uniquely identified LMR Systems.

The range for this field is 1 to 101048575 in decimal format.

Console Location ID field

The Console Location ID field displays the location ID of the console. This ID is made up of
the Console RFSS ID, Console System ID and the Console WACN ID. This field is used for
comparison purposes when setting up a CSSI system. This field cannot be edited.

Console SUID field

The Console SUID field displays the SUID (subscriber unit ID). This ID is made up of the
Console WACN ID, Console System ID, and Console ID. This field is used for comparison
purposes when setting up a CSSI system. This field cannot be edited.

Enable Heartbeats check box
The Enable Heartbeats check box determines whether or not heartbeats are sent from the
console to the LMR RFSS.

Heartbeat Rate field
The Heartbeat Rate field is used to enter rate at which heartbeats are sent from the console
to the LMR RFSS.

The range for this field is 10 to 120 seconds.

Missed Heartbeats field
The Missed Heartbeats field is used to enter the number of missed heartbeats allowed before
an error is generated.

The range for this field is 1 to 10.
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Receive FNE Supplementary data by SUs registered with group check box

The Receive FNE Supplementary data by SUs registered with group check box determines
whether or not a group registration with both the LMR RFSS and LMR FNE (Fixed Network
Equipment) is allowed. This allows supplementary operations such as Status, Call Alert, Radio
Check, etc. to be handled by FNE. For example, an SU sends a Status update to the FNE. All
the consoles registered to the FNE for that group receives the status update. The SU does not
need to send status updates to each individual console.

Console Tx Priority field
The Console Tx Priority field is used to enter the transmit priority level. Consoles with a
higher priority level transmits over a console that has a lower priority level.

The range for this field is 1 to 255.

Notice!
A console always transmits over an SU.

Local Console button
The Local Console button opens the “Local Consoles page, page 129”.
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56 Appendix H - Kenwood NEXEDGE Direct IP interface

The NEXEDGE Direct IP interface is designed to connect directly to NEXEDGE Trunking and
NEXEDGE Conventional Systems via an IP Interface without using a radio gateway or
additional hardware. The C-Soft NEXEDGE IP interface provides flexibility in deployment and
offers advanced radio control features. NEXEDGE IP interface is an option feature on C-Soft
and available in 2, 6, 12, and 24 talk paths.

56.1 Supported features

The NEXEDGE Trunking and Conventional IP Interfaces support the following features:

Direct IP Interface (no extra hardware or radio gateway needed)
Supports both Narrow band (12.5Khz) and Very Narrow band (6.25Khz) Channel Spacing
Group Call/Conference Call

Unit/Private Call

Alert Call

Selectable Talk Group

Emergency Call Decode with Acknowledgement Capabilities
Radio Status Request

Radio Status Decode

Radio Status Encode

Radio Remote Grouping

Over-The-Air-Aliasing

Supports up to 24 Talk Paths per Console

Call Queuing Using Incoming Status

Radio Remote Monitor with Supervisor Password

Radio Stun

Radio Revive

Support the following Conventional interface types:

- No Signaling with RAN

—  Signaling without RAN

— Signaling and RAN

Radio Remote Grouping (Trunking Only)

GPS Decode with IP Interface

Text Messaging (Trunking Only)

Broadcast Call (Trunking Only)

56.2 Theory of operation

Console

In a NEXEDGE system, the console acts as a radio SU (Subscriber). When the console starts, it
needs to register its unit ID with the NEXEDGE infrastructure via IP connection to gain access
to the system. Once it is registered, it then registers all the NEXEDGE talk groups programmed
in the Group ID List.
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Private Call

Individual units, or SUs, are calls the console wants to talk to that are not registered by the
console. All unit calls are received by the console if the consoles Unit line is in SCAN mode.
Scanning mode allows a line to overflow to another line, if busy. If the Unit line is in dedicated
mode, the line becomes a point to point call with only one unit. Dedicated mode does not
allow an overflow. If a line is busy, the call is missed.

Notice!
The consoles registered Unit ID is set from the Global Parameter Setup window, Console Unit
ID Number (refer to “Global Parameter Setup window, page 114”).

Group Call

All talk groups the console is required to listen and talk on must be registered with the
NEXEDGE system. The console registers all talk groups contained in the consoles System List
when the console first starts up. Talk group validation can be viewed in the console’s Global
Call History window (refer to “Global Call History window, page 447”).

Notice!
The registration process fails on certain talk groups if those talk groups are not pre-
programmed in the NEXEDGE system.

Call Line

Each NEXEDGE line within a console design can be set up as either Talk Group or Unit Call
lines. Talk Group lines use either a Group PTT or InPTT button for call activation. Using a
GroupPTT button allows the talk group ID to be varied on the line. Using an InPTT button
creates a dedicated line with only one talk group ID.

A Unit Call line is used to send private calls to individual units or SUs. Unit lines use either a
Private PTT button or an InPTT button for call activation. Using a Private PTT button allows the
unit ID to be varied on the line. Using an INPTT button creates a dedicated line to call only one
unit ID. Radio buttons such as Call Alert, Remote Monitor, etc. are typical buttons assigned to
this type of line. Console designers can add a Keypad to the console design to provide easy
access to the Talk Group or Private Call user list during call operations when using the Private
PTT button.

Notice!

It is strongly recommended to assign Radio Control Buttons such as Radio Call Alert, Radio
Check, Radio Disable, Radio Enable, and Radio Remote Monitor to a unit call line. This
ensures seamless operation on the console.

Assigning the Radio Control Buttons on group lines that may be restricted can produce
unpredictable results.
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Notice!
In the Conventional interface, when not using talk groups, the RAN (Radio Access Node)
configured is used for the Call Line.

56.2.1

Refer to
—  Global Parameter Setup window, page 114
—  Global Call History window, page 447

Distribution of receive audio to the lines

Talk Groups

The NEXEDGE protocol is based on SIP (Session Initiation Protocol); therefore the console
implementation also uses this protocol to structure the operation of the console. The console
first scans all lines for a Group PTT button that is set to the incoming talk group ID. If the
receive ID matches the line’s talk group ID, the line receives the audio.

If no Group PTT button are set to the incoming ID, the console then scans all lines with an
Instant PTT button (a dedicated line) for a group ID assigned to the line (the talk group ID
assigned in C-Soft Designer). If the receive ID matches the lines talk group ID, that line
receives the audio.

If no line matches the ID, the receive audio goes to the first available (non-busy) line with a
Group PTT. If all lines are busy, the call is missed.

RANSs (Conventional Only)

When using talk groups, the console scans all the lines to match the talk group, once it has
found a match it then attempts to match the RAN, as well. If you are not using a talk group the
console scans to find a line matching the RAN. If a match is not found the call is missed.

Notice!

If a console system cannot tolerate any missed talk group calls, the console administrator
must have as many Talk Group lines as voice channels available on the CSSI system and all
lines must have Group PTT buttons.

If a dispatcher needs to monitor and talk to a specific talk group, an InPTT button is used to
create a dedicated line.

Unit lines operate exactly the same as group lines, with one exception, if all unit call lines are
busy the console sends back a busy signal to the calling unit.

Operational Notes

—  The talk group or unit ID shown on the Group PTT, InPTT, and Private PTT is the line’s
current transmit and receive ID.

— If the keypad module is used on the C-Soft console to change talk group and unit IDs,
console operators must select the desired line by clicking on the Select button first and
changing the ID in the keypad. The ID changes on the selected line’s PTT button and any
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56.2.2

radio buttons assigned to it. If a console operator selects another, the previous selected
line retains its ID. This operation holds true for all non-dedicated lines. Dedicated lines
are preset to the default designer value; the keypad has not effect on these lines.

- Upto 24 CSSl lines can be created with any combination of Talk Group or Unit lines.

Group Call line
A Group Call line can be set as a Conference Call:

—  Conference Call: A Conference Call is used to talk to multiple radios within a talk group.

Group lines use Group PTT or an InPTT button for call activation. Using a Group PTT button
allows the Group ID to be varied on the line. Using an InPTT button creates a dedicated line
with only one Group ID. In addition, a Radio Status button can be assigned to a group line to
send status messages to a group.

Notice!

All talk groups must be registered with the CSSI system. Upon initial start up, the console
registers all CSSI groups listed in the Group ID List. Talk group validation can be viewed in
the console’s Global Call History window. The registration process fails on groups not pre-
programmed on the CSSI system. To configure the console’s system list, refer to “File menu -
Edit System List, page 193".

56.3

56.3.1

-  UNIT CALL LINE

A Unit Call line is used to send private calls to individual units. Unit Call lines use a Private
PTT or an InPTT button for call activation. Using a Private PTT button allows the unit ID to be
varied on the line. Using an InPTT button creates a dedicated line with only one unit ID.

Radio buttons (Call Alert, Remote Monitor, Regroup, Ungroup, etc.) are typically assigned to
this type of line. Console operators can add a Keypad to the console design, providing easy
access to the user list during call operation. All Unit Calls are received by the console when
the Unit Call line is in Scanning Mode. In Dedicated Mode, the Unit Call line becomes a point-
to-point call with one pre-programmed unit.

NEXEDGE Call types

Each NEXEDGE line within a console design can be set up as either Conference (Talk Group)
or Unit Call lines.

Conference call

Talk Group lines use either a Group PTT or InPTT button for call activation. Using a GroupPTT
button allows the talk group ID to be varied on the line. Using an InPTT button creates a
dedicated line with only one talk group ID.

To create a conference call or talk group, do the following:
1. From the Call Type drop down menu, select Conference Call.
2. Inthe Talk Group Number field, enter the Talk Group Number of the line.
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Notice!

If the console designer assigns an InPTT button to the line, this line would only transmit to
and receive from the default ID. This is called a Static Group Line. If the console designer
assigns a Group PTT button to the line, the default ID is overridden at run time by the current
Group ID assigned by the selectable Group PTT button. This is called Manual Group line.

InPTT
Group 01
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Select

Group PTT
Group 004

Figure 56.1: Group and Manual Line Set Up

56.3.2 Unit call
A Unit Call line is used to send private calls to individual users. Unit line use either a Private
PTT button or an InPTT button for call activation. Using a Private PTT button allows the unit ID
to be varied on the line. Using an InPTT button creates a dedicated line with only one unit ID.
Radio buttons such as Call Alert, Remote Monitor, etc. are typical buttons assigned to this
type of line. Console operators can add a Keypad to the console design to provide easy access
to the user list during call operation.

To create a unit call, do the following:
1. From the Call Type drop down menu, select Unit Call.
2. In the Unit ID Number field, enter the Unit Call Number of the line.

Notice!

If the console designer assigns an InPTT button to the line, this line would only transmit to
and receive from the default unit ID.

If the console designer assigns a Private PTT button to the line, the Private PTT overrides the
default number and allows different units to be selected.
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C-Soft 7.700

g %]
[ Fianal

Selected

Private
Call
Radio 41

Figure 56.2: Private Call Configuration

56.4 C-Soft Setup parameters

To program a NEXEDGE radio in C-Soft, do the following:
1. From the edit menu, select Edit User ID List.
The User ID List window appears.

User ID List
M ame: |Sort By Name| Usger [D: | Sort By 1D | Type:

[1 " |[Radot | [ | |NEXEDGE-TRUNK ~
[2 |[Radi4z | [+ | |NEXEDGE-TRUNK |
2 |[Rados3 | [+3 | |NEXEDGE-TRUNK |
4 |[RadosD | [50 | |NEXEDGE-TRUNK
[5  |[Radicat | [ | |NEXEDGECONV
[ |[Radiocaz | [42 | |NEXEDGECONY ~
[ |[Radioca | [42 | |NEXEDGECONY  ~
la|[Radiocs0 | [s0 | |NEXEDGE-CONV |
| | | oo~
o] | | [oome ]
] | | [ome ]
fe_]| | | g

T Inhibit:

|

Oooooooooon

x
lcon:
-
lcan 1 ~
lcon 1 ~
lzan 1 ~
lcon 1 ~
leon 1 =
I Ok I | Cancel

2. In the Name column, enter the alias for each line.
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3. Inthe User ID column, enter the User ID for each line (the User ID is in decimal format).
4. From the Type drop down menu, select NEXEDGE-CONV or NEXEDGE-TRUNK.

5. Click OK.

Notice!

To program an All Call ID that can transmit to all NEXEDGE subscribers on the system, enter
65535 in the User ID column, and select NEXEDGE from the Type drop down menu.

To program a Group ID for NEXEDGE in C-Soft, do the following:

1.

From the Edit menu, select Edit Group ID List.
The Group ID List window appears.

Group ID List

Group: |Sort By Mame

Group [0 Sort By 1D

[t [[Grouw | [ |
2 |[owe2 IE |
5 e IE |
|4 ||GroupCt | [1 |
5 |[Groupc2 | [2 |
F|[owe IE |
|| | |
| | |
| || |
o || || |
| | |
[z || | |
Load File Save File

Uncheck &ll| | Set Color | |Reset Colors

Type:
NEXEDGE-TRUME
NEXEDGE-TRUME
MEXEDGE-TRUME.
MEXEDGE-COMY
MNEXEDGE-CONW
MEXEDGE-CONW
Generic
Generic
Generic
Generic
Generic

Generic

<

£

<

T Inhibit:  Set Color:

Oooooooooooao

Filkers ~
Filkers
Filkers
Filkers
Filkers
Filters
Filkers
Filters
Filters
Filkers

Filers

OoOo0ooooooood

Filkers v

Cancel

In the Group column, enter the Group alias for each line.
In the Group ID column, enter the Group ID for each line (the Group ID is in decimal

format).

From the Type drop down menu, select NEXEDGE for each line.
In the Group ID column, enter the Group ID for each line (the Group ID is in decimal

format).
Click OK.

During start up, C-Soft will register all of the pre-programmed NEXEDGE Talk Groups. C-Soft

can only communicate to Talk Groups registered to the system.

56.5 NEXEDGE Trunking System setup

To set up a NEXEDGE Line, do the following:
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1. From the Edit menu, select Setup Per Line Parameters.

The Per Line Parameters window appears.
D " _-”

Line Packet
Humber  Line Type Line Hame RiMullicast dddress RxPod  TxMulicastdddiess TxPok  BaseRadiolP:  TTL Delay
T (s o) ot oo e e wm w00 00 6] [0 [
EchoPscketsEnsble: [1 0. 0. 0.0 (105 | 0.0.0.0 [125 | J
e L8118 .0.0.0 [6] (10 [
2 [NEXEDGE | Group2 225, 8 8 W ws.s.m.w ot 0,000 [6] fig] [
EchoPacketsEnsbles (] 0. 0. 0.0 1055 | 0.0.0.0 [12 |
3 [NEXEDGE v Manual Gioup 2.8 A8 0 268 1.6 w4 0.0 0.0 [5] [ [0
EchoPacketsEnable: [] 0. 0. 0.0 [108 | 0.0.0.0 [125 |
4 ~ | Private Li 25 8. 11.91 1057 25 8% . 11.81 s 0.0.0. 0 (8] [0 ]
HEXEDGE 2 Line 5 o ) [
EchoPacketzEnshle: [] 0. 0.0.0 (1057 | 0.0.0.0 [1257 | ) L
i i 5.8 .11.8 [105 ; 1.8 1238 | 0.
5 [Disabled +|Line5 5. 8 & (1058 | 25.8.11.81 [1z8 | 0.0.0.0 [5] [10 o
EchoPackesEnsbles (] 0.0 . 0.0 (1058 | 0.0 0.0 1288 |
6 [Dissbled v|[Lines | 25 e ww (1o ) 25801 128 ) 0.0 0.0 [6] (o] [
EchoPacketsEnable: [] 0. 0.0.0 [1039 | o.0.0.0 [128 | L J
? i = 7 L8 .1, 225, 11 1 ]
(Disabled v Line |z e e [0 | s vie [0 ] a0 [o] [io) [0
EchoPacketsEnsble: [1 0. 0. 0.0 [1080 | ©0.0.0.0 [1280 | | J
8 [Disabled v][Line8 | 2258 . n.s [1081 | 25,8 .8 [1261 | 0.0.0_0 [5] [i0] 1
(Disbles_~] e \ g |
EchoPacketsEnsble: [] 0. 0. 0.0 (1081 | 0.0.0.0 [1261 Dl |
3 [Disatled v][Lined ] 2.8 i .er (w062 | (25,8 1181 (122 | 0.0.0.0 [6] 0] [,
EchoPacketsEnable: (1 0. 0. 0.0 [1082 | 0.0.0.0 |12 | L )
i [Ling 1 25 1.8 (1083 | 1.8 1283 | 1 — ]
10 [Disabled v |[Line 10 u5. 8. 1.8 (1063 ] 2. 8 S0 0.0 0] [0 (o] frad [0 [
EchoPacketsEnable: [1 0. 0.0.0 (1083 | 0.0.0.0 [182 | [E | ] | Jil=

2.  From the Line Type drop down menu, select NEXEDGE.
NOTE: The Multicast address and port number information is used for cross console
communications supporting the following features: Call Queue, Emergency and Cross-
patch updates. These fields should match on each console in a shared system.

3. Click the Signal Setup button.
The Signaling Parameters window appears.

Signaling Parameters: Line 2

General Signal Setup | NEXEDGE Trunking Parameters |

System Settings

System Type: NEXEDGE Trunking -

System Name: lNEXE[Z‘GE Conventional J Edit System

Signaling AutoFill Setup
Enable Signaling AutaFill

Starting Line Number: |1

Ending Line Number: |1

Call Logging

Display Al Calls

4. From the System Type drop down menu, select NEXEDGE Trunking.
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5. Click the NEXEDGE Trunking Parameters tab.
The NEXEDGE Trunking Parameters window appears.
Signaling Parameters: NXDMN Private
General Signal Setup  NEXEDGE Trunking Parameters
Parameters that apply to this line
Console call parameters System site parameters
Site Number:
Call Type: | Unit Call hd 1
Broadcast Call
Encryption Key: Conference Call
Urit Call Mumber: |43 :
Site Ip Address:
172 .19 . 1 .20
* A "Private” PTT button is assigned to this line.
Unit Call numbers are set below.
Parameters that apply to all lines
User ID List Global NEXEDGE Trunking Setup G"’b}?;yEB‘;‘r;P““”
Cancel
6. From the Call Type drop down menu, select the call type (refer to “NEXEDGE Trunking
Parameters page, page 553”).
7. In the Talk Group Number field, enter the Talk Group Number for the Trunking
Refer to
-  NEXEDGE Trunking Parameters page, page 553
56.5.1 NEXEDGE Trunking Parameters page

Console Call Parameters group box
The Console Call Parameters group box is used to configure Call Type and Default ID.

The Call Type drop down menu is used to select the type of call designated to the line.

Available selections for this field are:

—  Broadcast Call: A Broadcast Call is a group call. It temporarily disables a remote radio's
ability to respond to the dispatcher in a set amount of time pre-configured in the
NEXEDGE system. Broadcast calls can be used in a special event or in an emergency
situation for announcement.

—  Conference Call: A Conference Call allows a Talk Group.

— Unit Call Lines: A Unit Call allows the dispatcher to talk to a specific radio unit.
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Talk Group Number field

The Talk Group Number field is used to enter the default talk group ID for the line. The Talk
Group Number is a unique Talk Group ID defined by the system administrator and
programmed in the NEXEDGE system.

Notice!

If an InPTT button is assigned to the line, the line only transmits to, and receives from, the
default Talk Group ID. This is known as a Static Group line. However, if a Group PTT button is
assigned to the line, the default talk group ID is overridden by the current Group ID. This is
known as a Manual Group line.

Unit Call Number field

The Unit Call Number field is used to enter the default Unit Call number. The Unit Call
Number is a unigue NEXEDGE subscriber ID defined by the system administrator and
programmed in the NEXEDGE system.

Notice!
An InPTT button on this line allows calls to and from the Default Unit ID. A Private PTT button
overrides the default unit number and allows different units to be selected.

56.6 Console Global Setup

The Global NEXEDGE Trunking parameters apply to all NEXEDGE console lines and only need
to be set once for any line. The Global NEXEDGE Trunking Parameters window is assessable
from any line, but the values are constant between lines, and can be found at Edit | Setup
NEXEDGE.
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Global MEXEDGE Trunking Pararmeters

Parameters apply to &ll lines

Console Unit ID number: System Code:
100 100
Console SIF Ry Port: Metwork Cateqory:

5060 Local -

Console SIP Tx Port: Channel Spadng:

S0e00 Marrow w

[ ] Enable Over The Air Aliasing

Local Console

[ ] Enable Heartbeat Settings
Heartbeat Rate: Missed Heartbeats allowed;
15 seconds 4

[ ] ralkbadk With Last Received Encryption Key ID

Time Period: (msec)
2000
Transmit Delay

Initial Transmit Delay Time: {msec)
0

RAM Values

Transmit Delay Time: (msec)
1000

Cancel

Figure 56.3: Global NEXEDGE Trunking Parameters Window

Console Unit ID Number field
The Console Unit ID field is used to enter the console’s unique ID registered to the NEXEDGE
system. This number must be programmed in the NEXEDGE system as a console ID.

o

Notice!

The console’s registered Unit ID is set in the global parameters window (Console Unit ID
Number).
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Console SIP Rx Port field
The Console SIP Rx Port field displays the console’s receive port number for the SIP
connection. This field cannot be edited.

Console SIP Tx Port field
The Console SIP Tx Port field displays the console’s transmit port number for the SIP
connection. This field cannot be edited.

System Code field
The System Code field is used to enter the number assigned to the NEXEDGE system. The
console System Code must match the NEXEDGE site system code.

The range for this field is 1-131070.

Network Category drop down menu
The Network Category drop down menu is used to select the coverage size. The console
Network Category must match the NEXEDGE site network category.

Available options are:
- Local
- Regional

Channel Spacing drop down menu

The Channel Spacing drop down menu is used to set the frequency separation between two
adjacent channels. The console Channel Spacing must match the NEXEDGE site channel
spacing.

Available options are:
—  Narrow Band (12.5kHz)
—  Very Narrow Band (6.25kHz)

Enable Over the Air Aliasing check box

The Enable Over the Air Aliasing check box is used to enable over the air aliasing. Over the
Air Alias allows the console to display the unique name of the calling transceiver without using
User ID list in C-Soft for aliasing.

Notice!
The Over-the-Air Alias option must be enabled and Unit ID Name must be programmed in the
transceiver for the console to receive the name.

56.6.1

Local Consoles button
The Local Consoles button allows users to setup a parallel console for the dispatch system.
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Enable Heartbeat check box

The Enable Heartbeat check box indicates the system is monitoring the site verifying it is still
online. When enabled, the Heartbeat Rate field and Missed Heartbeats Allowed fields become
active.

Heartbeat Rate field
The Heartbeat Rate field is used to enter how often the heartbeat occurs, in seconds.

Missed Heartbeats Allowed field

The Missed Heartbeats Allowed field is used to enter the number of missed heartbeats
allowed before disabling the corresponding site. Disabling the site grays out all lines
associated with the site.

Transmit Delay check box
The Transmit Delay check box enables transmit delay when delay is necessary for Radio
Command functions.

Initial Transmit Delay Time field

The Initial Transmit Delay Time field is used to ensure receipt of a radio command request
when the called subscriber unit uses scan or battery saver. The Repeater sends an idle
signaling command to the called subscriber at the designated time before sending the Radio
Command (Radio Status, Radio Monitor, etc.). This insures the subscriber is available to
receive the request from the repeater.

Initial Transmit Delay Time can range from 0 to 25000msec.

Transmit Delay Time field

The Transmit Delay Time field is used to send a delay time along with the Radio Command
request. Initial Transmit Delay Time and Transmit Delay Time are summed in value to
determine for the overall delay time.

Transmit Delay Time ranges from 0 to 6000msec.

RAN Encode button
The RAN Encode button opens the NEXEDGE Conventional RANs window. For more
information, refer to “NEXEDGE Conventional RANs window, page 563”.

Refer to
- NEXEDGE Conventional RANs window, page 563

56.7 NEXEDGE Conventional IP system configuration

Notice!
Samples of a NEXEDGE .veg file and NEXEDGE System List.xml are available for reference
design at www.telex.com/us/dispatch/line.
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C-Soft 7.700

ro

Signaling Pararneters: Line 2

General Signal Setup | NEXEDGE Conventional Parameters

System Settings

System Type: | NEXEDGE Convertional |

M EKE E Trunking
System Name: l— EXEDGE Conventional Edit System

Signaling AutoFill Setup
Enable Signaling AutoFill

Starting Line Number: |1

Ending Line Mumber: |1

Call Logging

Display All Calls

Figure 56.4: Signaling Parameters Window - Conventional System Type

When NEXEDGE is selected as the Line Type and the Signal Setup button is clicked, the
NEXEDGE Conventional Parameters Tab appears, refer to the Figure in “NEXEDGE

Conventional Parameters window, page 558”.

Refer to

- NEXEDGE Conventional Parameters window, page 558
56.8 NEXEDGE Conventional Parameters window

The NEXEDGE Conventional Parameters window is used to configure the IP Address of the

NEXEDGE conventional system.
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Signaling Parameters: NXDM TG Fly *

General Signal Setup  NEXEDGE Conventional Parameters

Parameters that apply to this line

Console call parameters System site parameters
Site Mumber:
Call Type: |Conference Call  ~ 101

Encryption Key:
Talk Group Number:
Site Ip Address:
RANE”W“EE 172.13 .1 . 20
Parameters that apply to all lines
Global NEXEDGE Convertional Setup Global Encryption

Key Data

Cacel

Figure 56.5: NEXEDGE Conventional Parameters Window

Notice!

When using a Group PTT or Private PTT button, the talk group number and Unit Call number
are pulled from the system list. In addition, Talk Group Number, Unit Talk Group Number and
RAN Encode fields cannot be modified. To edit the RAN, see the Global NEXEDGE
Conventional Setup window.

Parameters That Apply to This Line group box

The Parameters That Apply to This Line group box is used to set up the Console Call
Parameters, such as Call Type, RAN number, etc., and the System Site Parameters, such as the
Site Number and Site IP Address.

Console Call Parameters group box
The Console Call Parameters group box is used to select the call type and the default ID for
the selected call type.

The Call Type drop down menu is used to select the type of call to assign the configured
parameters. Select Conference Call to set up a group talk line or select Unit Call to set up a
Private Call Line.

Available selections for this field are:
—  Conference Call: A Conference Call allows a Talk Group.
— Unit Call Lines: A Unit Call allows the dispatcher to talk to a specific radio unit.
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Encryption Key Field
The Encryption Key field is used to enter the default encryption key for the Line.

Talk Group Number field
The Talk Group Number field is used to enter the Group ID assigned to the group.

RAN Encode Display field
The RAN Encode field displays the RAN (Remote Access Node) for the call type. This field
cannot be modified. Modifications to the RAN are done on the Global NEXEDGE Conv.

System Site Parameters group box
The System Site Parameters group box is used to match the IP Address of the NEXEDGE
Conventional system.

Site Number field
The Site Number field is used to enter the site number of the NEXEDGE conventional system.

Site IP Address field
The Site IP Address field is use to enter the site IP Address the NEXEDGE conventional
system is located.

Parameters That Apply to All Lines group box

Global NEXEDGE Convn. Setup button
The Global NEXEDGE Convn. Setup button, when clicked, opens the Global NEXEDGE
Conventional Setup Window.

Global Encryption Key Data button
The Global Encryption Key Data button opens the NEXEDGE Encryption window.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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56.9 Global NEXEDGE Conventional Parameters window

Global MEXEDGE Conventional Parameters o

Parameters apply to all lines

Console Unit ID number: System Code:
100 1
Console SIP Rx Port: Metwork Category:

5060 Local

Console SIP Tx Port: Channel Spadng;:

50600 Marrow w

[]Enable Over The Air Aliasing

Local Console

[ ]Enable Heartbeat Settings
Heartheat Rate; Missed Heartbeats Allowed:

15 ceconds 4

[ Talkback With Last Received Encryption Key ID

Time Period: {msec)
2000
[ Transmit Delay

Iritial Transmit Delay Time: (msec)
W]

RAMN Values

Transmit Delay Time: (msec)
1000

Cancel

Figure 56.6: Global NEXEDGE Conventional Parameters Window

Parameters Apply to All Lines group box

Console Unit ID Number field
The Console Unit ID field is used to enter the console’s unique ID registered to the NEXEDGE
system. This number must be programmed in the NEXEDGE system as a console ID.

Console SIP Rx Port field

The Console SIP Rx Port field displays the console’s receive port number for the SIP
connection. This field cannot be edited.
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The number must match the NEXEDGE site’s Tx SIP port number.
The default port number is 5060.

Console SIP Tx Port field
The Console SIP Tx Port field displays the console’s transmit port number for the SIP
connection. This field cannot be edited.

The number must match the NEXEDGE site’s Rx SIP port number
The default port number is 5060.

Enable Over the Air Aliasing check box
The Enable Over the Air Aliasing check box allows the console to display the unique name of
the calling transceiver without using the User ID list in C-Soft for aliasing.

Notice!
The Over-the-Air Alias option must be enabled and Unit ID Name must be programmed in the
transceiver for the console to receive the name.

System Code field
This field is not used for the Conventional Interface.

Network Category field
This field is not used for the Conventional Interface.

Channel Spacing drop down menu

The Channel Spacing drop down menu is used to set the frequency separation between two
adjacent channels. The console Channel Spacing must match the NEXEDGE site channel
spacing.

Available options are:
—  Narrow Band (12.5kHz)
- Very Narrow Band (6.25kHz)

Local Console button
The Local Console button opens the “Local Consoles page, page 129”.

Enable Heartbeat check box

The Enable Heartbeat check box indicates the system is monitoring the site verifying it is still
online. When enabled, the Heartbeat Rate field and Missed Heartbeats Allowed fields become
active.

Heartbeat Rate field
The Heartbeat Rate field is used to enter how often the heartbeat occurs, in seconds.
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56.10

Missed Heartbeats Allowed field

The Missed Heartbeats Allowed field is used to enter the number of missed heartbeats
allowed before disabling the corresponding site. Disabling the site grays out all lines
associated with the site.

Transmit Delay check box
The Transmit Delay check box enables transmit delay when delay is necessary for Radio
Command functions.

Initial Transmit Delay Time field

The Initial Transmit Delay Time field is used to ensure receipt of a radio command request
when the called subscriber unit uses scan or battery saver. The Repeater sends an idle
signaling command to the called subscriber at the designated time before sending the Radio
Command (Radio Status, Radio Monitor, etc.). This insures the subscriber is available to
receive the request from the repeater.

Initial Transmit Delay Time can range from 0 to 25000msec.

Transmit Delay Time field

The Transmit Delay Time field is used to send a delay time along with the Radio Command
request. Initial Transmit Delay Time and Transmit Delay Time are summed in value to
determine for the overall delay time.

Transmit Delay Time ranges from 0 to 6000msec.

RAN Encode button
The RAN Encode button opens the NEXEDGE Conventional RANs window. For more
information, refer to “NEXEDGE Conventional RANs window, page 563”.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.

NEXEDGE Conventional RANs window

The NEXEDGE Conventional RANs window allows you to configure all talk groups and units to
their respective RAN (Remote Access Node). The repeater must have the matching talk group/
unit programmed for this to work. By populating the RANSs list, the user has the ability to
change the RAN number for each talk/unit. This can also be changed on the Signaling
Parameters Setup and are reflected in this list.

Notice!
The name and ID fields cannot be modified from this window. These changes must be made
in the System List window (refer to “Edit System List window, page 192”).
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MEXEDGE Conventional FAMNs o
FAM Value
# Group Mame Group ID (Encode’, Decode)
5 E |2
z E |
T 1 [0 |
4 TC1 1 o |
- | |
[s ] | |
| |
| |
Ell | |
El | |
| |
| | v
Type: |Groups e
Encode and Decode. Cance

Figure 56.7: NEXEDGE Conventional RANs Window

Group/Unit Name field
The Group/Unit Name field displays the name of the group or unit you want to assign the RAN
to.

Group/Unit ID field
The Group/Unit ID field displays the ID of the selected group or unit you want to assign the
RAN to.

RAN Encode field
The RAN Encode field is used to assign a RAN code used by the associated group or unit.

Type drop down menu
The Type drop down menu is used to select the type of RAN you want to assign, either Groups
or Units.
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Notice!
When Group is selected from the drop down menu, Group Name and Group ID are displayed
as the columns; when Unit is selected from the drop down menu, Unit Name and Unit ID are
displayed.
OK button
The OK button saves any changes made and closes the window.
Cancel button
The Cancel button discards any changes made and closes the window.
Refer to
- Edit System List window, page 192
56.11 NEXEDGE Conventional IP set up

To set up a NEXEDGE Line, do the following:
1. From the Edit menu, select Setup Per Line Parameters.
The Per Line Parameters window appears.

Lw Packet [ ok
Number  Line Type Line Name Fix Multicast Adcress RxPost T Mulicast Address TxPort  BaseRadolP:  TTL Delay
1 NEXEDGE = Grown 1 ] .81 3027 5. 8 . 1181 C f 1 Signal -
‘ p” Setup |
Echo Packets Enable 0.0.0.0 1054 0.0.0.0 125
2 NEXEDGE v | Giowp 2 5. 8.11.8 55 %. 8 .11 .81 ] )« [ 1 Signal
‘ E cho Packets Ensbls 0.0.0 0 10% 0.0.0 0 12 Setup |
3 NEXEDGE = Manud Gioup 25 11 .81 |105€ 25 8 .11 &1 & 0. f B 1 Signal |
Echo Packets Enable 0.0.0. 0 105 0.0.0. 0 12 Setup
4 NEXEDGE w Privale Line 2 g .1 1 ) 225.8.11.81 1257 0. [ 1 Signal
| Echo Packets Ensble 0.0.0.0 1057 0.0.0.0 1257 | Seup

2. From the Line Type drop down menu, select NEXEDGE.
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3. Click the Signal Setup button.
The Signaling Parameters window appears.

Signaling Pararneters: Line 2

General Signal Setup | NEXEDGE Conventional Parameters

System Settings
System Type: NEXEDGE Convertional -
MEXEDGE Trunking
System Mame: MEXEDGE Conventional Edit System
L

Signaling AutoFill Setup
Enable Signaling AutoFill

Starting Line Number: |1

Ending Line Mumber: |1

Call Logging

Display All Calls

4. From the System Type drop down menu, select NEXEDGE Conventional.
The NEXEDGE Conventional Parameters tab appears.
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5. Click the NEXEDGE Conventional Parameters tab.
The NEXEDGE Conventional Parameters window appears.
Signaling Parameters: NXDN TG Fly x
General Signal Setup  NEXEDGE Conventional Parameters
Parameters that apply to this line
Console call parameters System site parameters
Site Murnber:
Call Type: |Conference Call  ~ 101
CoerenoeCalI
Encryption Key: Unit Call )
Talk Group Mumber:
Site |p Address:
RANE”““E 172019 01 .
Parameters that apply to all lines
. Global Encryption
Global NEXEDGE Conventional Setup Mey Deta
Cancel
6. From the Call Type drop down menu, select either Conference Call or Unit Call.
56.12 C-Soft NEXEDGE Conventional IP interface

IP Console ID List
The KPG-109DN application and system key file are required before gaining access to
configuration settings for the system. The values set in the Console Unit ID, RANs and Channel
Spacing must match the programming parameters in Kenwood Conventional System. The
Figure below displays a Kenwood KPG-109DN conventional repeater programmer.

The Console ID in C-Soft must match one of the IDs on the following list.

Bosch Security Systems, LLC
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_=] Conventienal IP Network
—IP Con=ole I List

M. Unit 1D Prigrity
1 104 High
2 102 High
3 103 High
4 105 High
5

6

T

a

9

10

Figure 56.8: Conventional IP Network Window

Channel Edit window
The Channel Edit window is used to enter the channel spacing and RAN settings. Channels
can have a single RAN or use multiple encode/decode tables.

2 Channel Edit [mE3m]

Channel |1 |

Receive Freguency [MHz] |4ﬁu_1uuuuu [~ Beat Shift hift

|
.
L

Transmit Frequency [MHz] | 455.100000

Channel Type |{ix{sll]

Transmit Mode INXDN

¥ T Reverse Burst

|

I~ Scan&dd

[T compander

I cwo i D |
[ =

QT/DQAT Decode | Mone

QT/DAT Encode | None

RAN Decode | 1
RAN Encode |1

Lefleflelledle

—Scrambler Setting

| oo

Channel Name | 1

armbler

Tranzsmit Power Ian

Scrambler Code | 1
Channel Spacing (&nalog) I Marrow

Channel Spacing (MXDN) IVery Narrow

— Network Setting

Eucade T Bk || Primany [ Conventional IP Network

Operation Mode |Repeat
Multiple Encode/Decode Table | 1

Site List |

Close | Help |

K| K KN | K [ K | KR | KX

User List |None

Figure 56.9: Channel Edit Window
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56.13 NEXEDGE System configuration

56.13.1 NEXEDGE System configuration type 1 - No signaling with RAN
Kenwood offers a system configuration that does not use signaling. This means there is no
group talk and the distinguishing element between sites is the RAN (refer to the Figure
below).

. Roamin

Site 1 m Site 3
RX Freq: 462.1 7
TX Freq: 4121 ';R'Xx FFreq :?::

req. -

Talk Group: 0 Talk Ger?yup' o
RANs: 1 RANs: 3 .

Site 2 Site 4
RX Freq: 462.2 RX Freq: 462.4

TX Freq: 412.2 TX Freq: 412.4
Talk Group: 0 Talk Group: 0
RANs: 2 RANs: 4

Figure 56.10: Set Up without Signaling

System configuration features (supported)
—  Static Line PTT

—  Conference Calls

- Radio Status Request

—  Radio Status Decode

— Radio Enable

— Radio Disable

-  Emergency Decode

- Emergency Acknowledgement

Notice!

In the NEXEDGE Conventional system, Emergency call can be sent out either on a Talk Group
or a Unit ID. However, when the talk group isn’t used in the NEXEDGE system, in order to
receive an emergency call, the radio has to be configured to send out the emergency call to a
Unit ID which is a Console ID.

System configuration

As seen in the Figure above, there are four sites with four different frequencies and four
different RANs. C-Soft must be configured properly in order to interact correctly with the
system. The number of lines must match the number of RANs. Radios should be configured as
shown in the Figure below and lines should be configured as shown in the afterwards Figure.

Radio configuration
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"] Channel Edit =
Zone(Site Roaming (NXDN}} | & _I;
Channel | 1 _I;
Page 1 IPageZl
Receive Freguency [MHz] |455.1GDDDD Channel Spacing (Analog) | Marrow
Transmit Frequency [MHz] | 460.100000 Busy Channel Lockout (Analog) | Mo
Channel Type NXDN Optional Signaling (Analog) | MNone
Transmit Mode | MADH PTT ID (Analog) | Off
QT/DQT Decode | None j I List Number (Analog) j
QT/DAT Encode | None Channel Spacing (NXDN) | Very Narrow
RAN Decode |1 Busy Channel Lockout (NXDN) | Mo
RAN Encode | 1 Optional Signaling (NXDN) | Mone
ChannelName | Ho TG RAN 1 Selcall on PTT (NXDN) | Off
rnee i Bowoedl Low ID List Number (NXDN) =
V¥ Scan add
5 (MDY
unc
Close Help
Figure 56.11: No Signaling Radio Configuration
Notice!
When setting the NXDN Signal ID to none, the Talk Group Number must be set to zero within
C-Soft.

C-Soft configuration
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Signaling Parameters: NXDM TG Fly

General Signal Setup  NEXEDGE Conventional Parameters

Parameters that apply to this line

Console call parameters System site parameters

Site Mumber:

Call Type: |Conference Call  ~ 101

Encryption Key: | None ~

Talk Group Number: _

Site Ip Address:
RAN Encode—Decade: 17 19 . 1 m

Parameters that apply to all lines

Global NEXEDGE Convertional Setup GIObEéyEB??m

Cancel

Figure 56.12: No Signaling C-Soft Configuration

RAN configuration

Notice!

Since there are multiple RANs for the Talk Group 0, these do not show up on the Global RANs
page.

The No Signal System Type does not support Unit Calls. Send Status and Request Status are
the only radio commands supported in this configuration option.
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C-Soft 7.700

=] Channel Edit
Channel |1 =
Receive Freguency [MHz] I 450100000 [~ Beat Shift
Transmit Frequency [MHz] I 455100000 [ aT Reverse Burst
L WEVED S =
Channel Type | NXDN j
3 [T Scanddd
Transmit Mode | NXDN j
QT/DQT Decode | Mone j r Compander
QT/DQT Encode | None ;| ™ cwiD i D |
RAN Decode I 1 j
RAN Encode | 1
I j — Scrambler Setting
Chiarnme e I ) [T ‘oice Scrambler
Transmit Power ILDW j
Scrambler Code I 1 _Ij
Channel Spacing (Analog) I Narrow Ll
Channel Spacing (MXDN}) I\.Fery Narrow j ~ Network Setting
Exmaade fone (Mulip), | Primary ;I ¥ Conventional IP Network
Operation Mode |Repeat j
| Muttiple Encode/Decode Table Site List |
User List |Mone %
Close | Help |
Figure 56.13: Repeater Configuration Multiple Encode/Decode Tables
_=] Multiple Encode/Decode Table 3]
Multiple Encode/Decode Table I ﬂ _l;
No. QT/DAT Decode QT/DAT Encode No. RAN Decode RAN Encode
1 1
2 MNone None 2 1 1
3 Mone None 3 2 2
4 Mone None 4 3 3
3 Mone Mone 5 4 4
6 Mone None ] 5 5
7 Mone None 7 6 [
8 Mone None (] 7 7
9 Mone None 9 8 8
10 Mone None 10 9 g9
11 Mone None " 10 10
12 Mone None 12 None None
13 MNone None 13 None None
14 Mone Mone 14 None Mone
15 Mone None 15 None None
16 Hone None 18 None None
Close Help

Figure 56.14: Multiple Encode/Decode Table
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56.13.2 NEXEDGE System configuration type 2 - Signaling without RAN
The second system configuration uses only talk groups and no RANs. This configuration uses
talk groups as the distinguishing factor between the different lines (refer to the Figure below).

. Roaming

Site 1 /,_\ p—
RX Freq: 452.1 = i
TX Freq: 412.1 RX Freq: 462.3
Talk Group: 1 _I'l?(lkFéeqi 4’%3

. alk Group:

RANS: lone RANs: None

Site 2 Site 4
RX Freq: 462.2 RX Freq: 462.4
TX Freq: 412.2 TX Freq: 412.4
Talk Group: 3 Talk Group: 4
RAMNs: None RANs: None

Figure 56.15: Signaling Set Up

System configuration features (supported)

- Static Line PTT, Group PTT, Private Call PTT

—  Conference Calls

-  Private Call

- Alert Call

—  Selectable Talk Group

—  Emergency Call Decode with Acknowledgement Capabilities
— Radio Status Request

— Radio Status Decode

- Radio Status Encode

— Radio Remote Monitor with Supervisor Password
— Radio Stun

—  Radio Revive

Radio configuration
Radios in this system configuration are configured similar to the Figure below.
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C-Soft 7.700

E Channel Edit b= e g
Zone(Conventional Group) 5 j
Channell 1 =
Page 1 |Page2|
Receive Frequency [MHz] | 455100000 Channel Spacing (Analog) | Marrow
Transmit Fregquency [MHz] | 460.100000 Busy Channel Lockout (&nalog) | Mo
Channel Type | NXDN Optional Signaling (Analog) | None
Transmit Mode | MXDON PTT ID (Analog) | Off
QT/DQT Decode | None j D' List Number (4nalog) =
QT/DOT Encode | None j Channel Spacing (NXDN) | Very Narrow
RAN Decode | Mone j Bugy Channel Lockout (WXDN} | No
= Optional Signaling (NXDM) | NXDN ID
RANEncode | Nene |
ChannelName | TG 1 RAN 0O Selcall on PTT (NXDN) | Group Call
Transmit Power | Low D List Number (NXDN) | 1 ﬁ
[ ScanaAdd
[~ GID Scan (NXDN}
[ Talk &round
Close Help:
Figure 56.16: Radio Signaling Configuration
C-Soft configuration
C-Soft in this configuration is configured similar to the Figure below.
Signaling Parameters: NXDN TG Fly *

General Signal Setup  NEXEDGE Conventional Parameters

Parameters that apply to this line

Console call parameters

Call Type: |Conference Call
S——
Talk Group Mumber:
RAN Encode: E

Parameters that apply to all lines

System site parameters

Site Mumber:
m

Site |p Address:
w2 .15 .1 .20

Global NEXEDGE Conventional Setup Global Encryption

Key Data

0K | Cancel

Figure 56.17: C-Soft Signaling Configuration
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Notice!

The RAN is set to zero, which is the same as None on the repeater.

56.13.3 NEXEDGE System configuration type 3 - Signaling and RAN
This system configuration type allows use of talk groups and RANs. This configuration allows
for both the talk group and the RAN to be distinguishing factors. The lines have to match from
the Radio Configuration and C-Soft to receive the call (refer to the Figure below).

Site 3

Site 2

. Roamin
Site 1 m
RX Freq: 462.1
RX Freq: 462.2

TX Freq: 412.1
TX Freq: 412.2

RX Freq: 462.3
TXFreq: 4123
Talk Group: 2
RANs: 2

Site 4
RX Freq: 462.4
TX Freq: 412.4

Talk Group: 1
Talk Group: 3
RANs: 3

RANs: 1
Figure 56.18: Signaling and RANs Setup

System configuration features (supported)

—  Static Line PTT, Group PTT, Private Call PTT

—  Conference Calls

- Private Call

- Alert Call

—  Selectable Talk Group

—  Selectable Users

-  Emergency Call Decode with Acknowledgement Capabilities
— Radio Status Request

— Radio Status Encode

— Radio Remote Monitor with Supervisor Password
— Radio Stun

—  Radio Revive

—  Enhanced interference mitigation

Radio configuration
Using the Figure below, configure the Radios.

Talk Group: 4
RANs: 4

Bosch Security Systems, LLC Technical Manual
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C-Soft 7.700

_=] Channel Edit

(=)= =

Figure 56.19: Signaling with RANs Radio Configuration

Zone{Conventional Group) G—ZI'
Channel ﬁ
Page 1 | Page?l
Receive Frequency [MHz] | 455.100000 Channel Spacing (Analeg) | Marrow
Transmit Frequency [MHz] | 460.100000 Busy Channel Lockout (Analog) | No
Channel Type | NXDN Optional Signaling (Analeg) | None
Transmit Mode | MON PTT ID (Analog) | Off
QT/DAT Decode | Mone j ID List Number (Analog) ﬂ
QT/DAT Encode | Mone - Channel Spacing (NXDN) | Very Narrow
RAN Decode |1 - Busy Channel Lockout (NXDN) | No
RAN Encode 1| i IOptiDnaI Signaling (NXDM) | NXDN ID I
Channel Name Tz 1 RAH O Selcall on PTT (NXDN) | Group Call
Transmit Power | Low ID List Number (NXDN) | 1 :}
[~ ScanAdd
[~ GID Scan (NXDN)
[T Talk Around
Close Help

In this configuration, the global RANs list populates the talk groups. Talk groups can only have
one RAN associated with them. This configuration requires the repeater to be configured
correctly with each repeater having the corrected decode and encode tables.
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Signaling Parameters: NXDN TG Fly *

General Signal Setup  NEXEDGE Conventional Parameters

Parameters that apply to this line

Console call parameters System site parameters

Site Murmber:

Call Type: |Conference Call 101

Encryption Key: | None -
Talk Group Number:
Site Ip Address:
RAN Encode: 2| 72 .19 . 1 . 20
Parameters that apply to all lines
Global NEXEDGE Convertional Setup Global Encryption

Key Data

Cacs

Figure 56.20: Signaling with RANs Configuration

56.14 NEXEDGE System manager parameters

For C-Soft to function properly the values set in the console must match the programming
parameters in the Kenwood Trunking System.

Notice!

The KPG-110SM application and system key file are required to access the configuration
settings for the system. The values set in the console, such as Site Number, Unit ID Number,
Network Category, System Code, Network Category, and Channel Spacing, must match the
programming parameters in the Kenwood trunking system.

To configure the Kenwood KPG-110SM radio for use with C-Soft, do the following:
1. Open the KPG-110SM System Manager.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



578 en | Appendix H - Kenwood NEXEDGE Direct IP interface C-Soft 7.700

2.  From the Edit menu, select System Configuration.
The System Configuration window appears.

-] kPG-1105N FERIE )

File Edit Program Tools Monitor Setup View Window Help

DEH 4 2% & QW

»

{ General | Queue | Timers | Optional | Network [ IP Console | Speed Dial | Cal R
System Information

Control Number  001-00383

Network Category Local

System Code 204

License Information

Number of Stes

Mumber of Channels

Key Class

Trunking Activation
Activation File

Customer Information

Revision Number

Single [ Site 1]

8

000204_01_0001 atv

Bosch-Telex

1

53| coms 1152001

NOTE: For additional support, see KPG-110SM user manual.
Under System Information
3. In the Control Number field, enter Control Number.
In Network Category field, enter Network Category.
5. In the System Code field, enter System Code.
IMPORTANT: The values set in the console must match the programming parameters in
the Kenwood System Manager.

>
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6.

7.

From the Edit Menu, select Console Information.
The Console Information window appears.

File Edit Program Tools Monitor Setup View Window Help

DEH S 22 X Q6

@ System Configuration

General | Queue | Timers | Optional | Network | IP Console | Speed Dial | Call R

Total Number of Consoles 4

UID Class of Service

UID-102

{Common)

0ID-103

{Common)

UID-104

{Common)

UID-105

{Common)

< [

COMA [115200]

From the Site drop down menu, select a Site to be modified.

Bosch Security Systems, LLC

Technical Manual
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8. Click the Edit button.
The Console Edit window appears.
g T . s
File Edit Program Tools Monitor Setup View Window Help
DEH4E %D & S

3 System Configuration

Date Created SEP/04/2012

Last Update  JUL/16/2013
Total Number of Consoles 4
uiD

Valid {Common)
(Common)
({Common)
UID Class of Service | {Ce ) (Comman)
Talkpath
Talkpath

UID Class of Service

UID Name UID-103

< [

|51 coma [115200]

9. Inthe UID field, enter Unit ID.

10. Select the Valid check box.

11. Under Talkpath, select the Talkpath check box.
12. Click Close.

56.15 Kenwood radio programming software

To configure Kenwood KPG-109DN software, do the following:
1. Open the Kenwood KPG-109DN radio programming software.
2.  From the Edit menu, select Channel Information.

The Channel Information window appears.
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3. Select desired channel and click Edit.
The Channel Edit window appears.

File Model Edit Program Tools Setup View Window Help

DEed & s 7
3 Channel Information [ Crannel -1 ] E'@

RX Freguency | TX Freguency QT/DAT Dec | QT/DAT Enc | Ch Name
455.100000 451.100000 — —| 01

Channel I [1] _|:

Neccive Freguency [MHz] I 458.100007 [~ Bcat Shift Bicat Shift

Transmit Frequency [MHz] | 451.100003 [ QT Reverse Burst

Chennel Type INXDN
QT/DCT Decode | Mone

|- Compander

QT/DAT Encode | Mone

Channel Name IEIl

Transmit Power ILuw

Channel Spacing (Analog) I Narrow

Channel Spacing (NXDN}) IVery Marrow

4. From the Channel Spacing (NXDN) drop down menu, select Spacing.

Notice!
Channel spacing values must match C-Soft console settings.

The NEXEDGE system allows maximum of 10 console connections per site and 100 console
connections per system.

For additional support, refer to the Kenwood KPG-109DN user manual.

56.16 NEXEDGE Encryption window

The NEXEDGE Encryption window is used to store up to 16 individual encryption keys, as
shown in the second Figure. Each Key Number contains Key Data, Key ID, and Key Name, all of
which need to contain unique data.

To open the NEXEDGE Encryption window from the Edit menu, do the following:
—  From the Edit Menu, select Setup NEXEDGE | Global Encryption Key Data.
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EE - C-Soft Designer

File | Edit Inset View Run Help

B

Setup Per Line Parameters % —I ‘ O ‘ —p t J, m

Setup Global Parameters

Setup Language Custornization
Setup Pagers
Setup Tone Levels

Setup SIP Phone

Setup P25 ¥

Setup GPS Mapping

Setup NEXEDGE > Global IP Trunking

Edit Filters Global IP Conventional

Edit User ID List Global Encryption Key Data

Edit Group ID List
Edit Status Message ID List

To open the NEXEDGE Encryption window from the Per Line Parameters window, do the

following:
1. From the menu bar, select Edit | Setup Per Line Parameters.
The Per Line Parameters window appears.
2. Onaline with a NEXEDGE line type, click the Signal Setup button.
The Signalling Parameters Window appears.
3. Click the NEXEDGE Trunking Parameters tab.
The NEXEDGE Trunking Parameters page appears.
4. Click the Global Encryption Key Data button in the bottom right of the page.

The NEXEDGE Encryption window appears.
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Mexedge Encryption x

Key Mumnber Key Data Key ID Key Mame ™

4 | & | 0o [ keyi |

| 2 51 1 Key 2

| 3 37 2 Key 3

8 4

* 3

. & 23 45 Key &

» 7

* 3

- g v

£ >

: T T Type 1: Does not Mute Rx encrypted audio
Encryption Mute Type: | 1YPE when per line Encryption Key is set to "Mone”,

Type 2: Mutes Rx encrypted audio when
per line Encryption Key is set to "Mone”,

Figure 56.21: NEXEDGE Encryption Window

Key Number column
The Key Number column is a numerical assignment of the Key Data, Key ID, and Key Name
Columns.

Key Data column

The Key Data column is used to enter a unique encryption number used in the encryption
algorithm routine. This field must be entered first when filling out the NEXEDGE Encryption
window.

The range for this field is 1 to 32767.

Key ID column
The Key ID column is used to enter an unique numerical alias for the Key Data. the Key ID is
the actual data passed between the console and subscriber units, not the Key Data

The range for this field is 0 to 63.

Key Name column
The Key Name column is used to enter a local alias associated for the console operator to
recognize in the C-Soft Runtime application.
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This field can be any combination of letters, numbers, or special characters up to 14
characters.

Encryption Mute Type drop down menu
The Encryption Mute Type drop down menu is used to select the way encrypted audio is
received by C-Soft when the Scrambler/Encrypt Key Select is set to None.

Available options are:
— Type 1: The console tries to match the encrypted audio received by scanning and

matching the Key ID with the Key IDs created in C-Soft. If no match is found, the
scrambled audio is heard.

— Type 2: The console does not scan the list and mutes all encrypted receive audio.

56.17 Scrambler/Encrypt Key Select button

The Scrambler/Encrypt Key Select button, shown in the Figure below, is set up to work with
a specific line or as a global button to work with the selected line. This button includes a drop
down menu that the user to change the current encryption key being used on the line.

The drop down menu includes the Key Names assigned in the NEXEDGE Encryption window.

Notice!

The Scrambler/Encrypt Key Select button only works for NEXEDGE type lines, otherwise, it is
grayed out.

Figure 56.22: Scrambler/Encrypt Key Select Button
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57

57.1

Appendix | - Telex License Activation tool

C-Soft Runtime requires one or more software-based licenses to operate. The software-based
licenses reside on a Telex License Server. The Telex License Server hosts and manages Telex
feature licenses. C-Soft connects to the Telex Licensing Server to validate licensing
requirements. Upon successful connection, C-Soft checks out the necessary licenses. Once C-
Soft closes, the licenses are released and available for use by other C-Soft instances.

Telex Licensing Server

The Telex Licensing Server is software package running on a PC or dedicated server. The
primary function of the software is to maintain licenses and respond to licensing requests
from C-Soft. When a license is added, the Telex Licensing Server detects the newly added
license and makes it available for C-Soft license checkout/check-in request.

Telex License Server is comprised of two software components:

— Telex License Manager: The Telex License Manager is a background service running on
the hosting computer. The License Manager maintains and responds to licensing requests
from C-Soft. The service automatically starts on boot, and requires no user interaction.
The service uses TCP port 27000 to respond to licensing requests from C-Soft.

— Telex License Activation Tool: The Telex Activation Tool is used to manage hosted Telex
licenses. The Activation Tool has five primary features:
—  Viewing current licensing information
- Adding a fulfillment
—  Returning a fulfillment
—  Repair fulfillments
—  Processing a fulfillment response message

Telex Licensing Server setup

The Telex Licensing Server can be installed in one of two locations:
— On the same PC as each C-Soft position
— On adedicated server PC, hosting licenses for multiple C-Soft positions

Installed on the same PC as each C-Soft position

Advantages - No single point of failure.

— No configuration necessary in C-Soft. C-
Soft Runtime automatically detects and
check out locally hosted licenses.

Disadvantages —  License activation process must be
completed for each PC running C-Soft

Installed on a dedicated server PC

Advantages — If asingle C-Soft position fails, a
replacement C-Soft position can be
configured without an additional license
installation.
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57.2

— License activation process only needs to
completed once.

Disadvantages —  If server PC fails, all C-Soft positions

lose licensing.

Installation activation

TN

2
(1Y ; - ) Process
\_/ Entitlement | - Return L Feature(s)
Certificate Activation ID AT Fulfillment 'ﬁ:sp‘g;see Available
A

Telex Licensing Activation Tool

Feature(s)
Purchased

Fulfillment/Feature Lists (Trusted Storage)

3 S

Fulfillment
Request
Message

System Activation Site

Order Database

3 )# Add Fulfillment
anage License ! Response —

Message

Figure 57.1: Installation Activation Flow Diagram

To activate purchased licenses, do the following:

1.

Upon purchase of a feature, an e-mail is sent containing an Entitlement Certificate. The
Entitlement Certificate contains a list of purchased features and an Activation ID.

On the target PC, install Telex License Server. Refer to “Telex License Server setup, page
31”.

Once installed, launch the Telex License Activation Tool. Refer to the figure on “View
current licensing information, page 587.

From the Telex Activation Tool, click the Add Fulfillment button.

In the Add License window, input contact information, as well as one or more Activation
IDs received from the Entitlement Certificate. Refer to “Appendix I - Telex License
Activation tool, page 585”.

A Fulfillment Request Message (Request.xml) is created.

If an Internet connection is available:

1.

Select the Online tab.

The Online Page appears.

Enter your System Activation Website Username and Password.
Press the Activate Licenses button.

The features granted by the license are now available.

If an Internet connection is not available:
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57.2.1

1. Select the Offline tab.
The Offline page appears.
2. Press the Create request button.
A prompt appears to save the Fulfillment Request Message (with default name
Request.xml).
Visit the System Activation Website and use the Manage License feature.
Click the Browse button.
Select the newly created Fulfillment Request Message.
Click Activate.
A prompt appears to save the Add Fulfillment Response Message (RequestResponse.xml).
7. From the Telex License Activation Tool, select the Process Response Message feature.
Refer to “Process Response Message, page 591”.
8. Select the Add Fulfillment Response Message file.
The features granted by the license are now available.

© ok ow

Refer to

— Telex License Server setup, page 31

- View current licensing information, page 587

- Appendix | - Telex License Activation tool, page 585
—  Process Response Message, page 591

View current licensing information

The Telex License Activation Tool displays the computer’s current license information. The left
panel contains a list of Fulfillment IDs added. The right panel contains a table listing all
licensed features, including quantity, order number, activation date, and expiration date of
each feature.
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57.2.2

EE Telex License Activation Toal - m] x
Telex License Activation Tool TELEX
Radio Dispatch
il

Fulfillments List of licenses and quantity

E. Qey ] Order number | Description ] Activated I Expires ]
FID_33b85882 14a691c8548_TdS 1 TRD-CSOFT-LINES-12 C-Soft 12-Line License 11-Sep-2014 -
FID_33b85882_14a691c8548_THfb 1 TRD-CSOFT-P250DFSI1-2  C-Soft P25-DFSI 2-Line License 11-Sep-2014 -
FID_4f3003e4_14c2314a715_Tffa 1 TRD-CSOFT-PLCP-2 C-Soft Per-Line Call Playback 2-Line License  11-Sep-2014 -
FID_413093e4_14c2314a715_TFF9 2 TRD-CSOFT-NEXEDGE-2 C-Soft NEXEDGE 2-Line License 22-Dec-2014 -
FID_ad656f_156293034c2_ 714 1 TRD-CSOFT-LINES-200  C-Soft 200-Line License 22-Dec-2014 -
FID_3ccTbdDc_157c98eeTel__Tifa 2 TRD-CSOFT-LINES-2 C-Soft 2-Line License 22-Dec-2014 -
FID_69125adc_15a76f39bd2_7ffb 1 TRD-CSOFT-SIP-12 C-Soft SIP 12-Line License 22-Dec-2014 -
FID_1712117¢_15c27189632_Tfe2 2 TRD-CSOFT-SIP-4 C-Soft SIP 4-Line License 22.Dec-2014 -
FID_16dcb7a6_29ca_4038_badb_16757207c686 1 TRD-CSOFT-SIP-6 C-Soft SIP 6-Line License 22-Dec-2014 -
FID_594efdac_eda0_4111 875 931aB0deBeaf 1 TRD-CSOFT-PLCP-50  C-Soft Per-Line Call Playback 50-Line License 22-Dec-2014 -
FID_232¢5387_3f01_4bBe_b19a_b077835b7423 1 TRD-CSOFT-LINES-150  C-Soft 150-Line License 22-Dec-2014 -
FID_d6b17290_436d_47¢3_891e_8644cc68518e 1 TRD-CSOFT-LINES-24  C-Soft 24-Line License 22-Dec-2014 -
FID_4d<0030f d735_4676_a281 02212193886 |, op ccoer pasprsl6  C-Soft P25-DESI G-Line License 23-Dec-2014 -
FID_3a0d2d73_970b_4232_S3ef. 30bb817ed{54 1 TRD-CSOFT-P25DFSI-12 C-Soft P25-DFSI 12-Line License 22-Dec-2014 -

1 TRD-CSOFT-PLCP-12  C-Soft Per-Line Call Playback 12-Line License 22-Dec-2014 -
& YRR ACACT MIMERAL N4 R MCNEOT N e a5 O nBea

Figure 57.2: Telex Activation Tool

Add Fulfillment
Add Fulfillment is used by the customer or dealer to add a Fulfillment from an Activation 1D,
which is contained within an Entitlement Certificate.

The window displays customer information fields (Location name, Customer name, Address,
City and Email) for the user to fill in when adding a Fulfillment. The window also displays a
field to enter an Activation ID, and a list of entered Activation IDs, if the user wishes to enter
multiple Activation IDs in the same transaction.
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BB Add license - O x

Customer information
Location name: :Globoflorp Headguarters

Customer name: .GlaboCurp

Address: 111 Main 5t
City: GloboCity
Country: | United States v

Activation information

Activation 1D: 12345-67890-abede-fghij-kimno-pgrst-uvwagy _

Activation ID list:

Online . Offline '

Use this method if the server has access to the internet. Enter your user name and password for the
Dealer site and press activate button to activate the activation IDs.

Use this link to configure your proxy settings

User name: | globoTech

Password: |iillﬂlll‘iii.ltl0ll

Progress

Figure 57.3: Telex Activation Tool - Add License Window.

Notice!
The Location Name field must be different for each position install at any single location.

To add a fulfillment, do the following:
1. From the Telex License Activation window, select Add Fulfillment.
The Add license window appears.
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Under Customer information

Notice!
The Location Name field must be different for each position install at any single location.

In the Location name field, enter the location of C-Soft deployment.
In the Customer name field, enter the name of the customer.

In the Address field, enter the customer’s address.

In the City field, enter the customer’s city.

In the Country field, select the customer’s country.

ok wbdE

Under Activation information

If an Internet connection is available:
1. Select the Online tab.
The Online Page appears.
2. Enter a User Name and Password for the dealer site.
3. Click the Activate Licenses button.
The Telex License Activation Tool attempts to connect to the System Activation Website and
execute the entire License Activation process. When finished, the license is activated and
ready for use.

If an Internet connection is not available:
1. Select the Offline tab.

The Offline page appears.
2. Click the Create Request button.
An Activation Request file is generated. The Activation Request file must be processed using
the Dealer Activation website. Refer to the Process Response section for instructions on how
to complete the manual licensing operation.

57.2.3 Return Fulfillment
Return Fulfillment is used by the customer or dealer to remove a Fulfillment currently
licensed to the PC and returns the license to the dealer’s available license pool. A list of
available licenses can be found at the Bosch Dealers Activation website.

To return a fulfillment, do the following:
1. From the Telex License Activation window, select the fulfillment you want to return.
The Return Fulfillment button is enabled.

If an Internet connection is available:
1. Select the Online tab.
The Online Page appears.
2. Enter a User Name and Password for the dealer site.
3. Click the Return Fulfillments button.
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The Telex License Activation Tool attempts to connect to the System Activation Website and
execute the License Return process.

Notice!
Once the Return Fulfillment process has been initiated, all licenses associated with the
selected fulfillment are no longer available for license checkout.

57.2.4

57.2.5

If an Internet connection is not available:
1. Select the Offline tab.

The Offline page appears.
2. Click the Create Request button.
A Return Request file is generated. The Return Request file must be processed using the
Dealer Activation website. Refer to the Process Response section for instructions on how to
complete the manual licensing operation.

Repair

Repair is used by the customer or dealer to re-establish the validity of fulfillments licensed to
the server. The Repair License button only appears if the license has been corrupted or
tampered with.

To return a fulfillment, do the following:
1. From the Telex License Activation window, select the fulfillment you want to return.
The Return Fulfillment button is enabled.

If an Internet connection is available:
1. Select the Online tab.
The Online Page appears.
2. Enter your Credentials.
3. Click the Return Fulfillments button.
The Telex License Activation Tool attempts to connect to the System Activation Website and
execute the License Repair process.

If an Internet connection is not available:
1. Select the Offline tab.

The Offline page appears.
2. Click the Create Request button.
A Repair Request file is generated. The Repair Request file must be processed using the
Dealer Activation website. Refer to the Process Response section for instructions on how to
complete the manual licensing operation.

Process Response Message

The Process Response Message is used to complete an offline Add Fulfillment, Return
Fulfillment, or Repair Fulfillment operation. Pressing the Process Response Message button
opens the Process Response Message Window.
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g

(- Offline response =&

Response file:  Responsexml

Figure 57.4: Offline Response Window

The Process Response Window contains a field used to select an Add Fulfillment Response
Message (RequestResponse.xml), Return Fulfillment Response Message
(ReturnResponse.xml), or Repair Response Message (RepairResponse.xml). After selecting
one of these files, pressing the Process Response Message button completes the transaction.

— Add Fulfillment Response Message: If processing an Add Fulfillment Response Message, a
fulfillment is added to the Fulfillment list, and the newly licensed features appear in the
list of licenses. The newly added features are available for C-Soft license checkout
requests.

—  Return Fulfillment Response Message: If processing a Return Fulfillment Response
Message, the specified fulfillment is removed from the Fulfillment list and all licenses
associated with it are removed from the list. The removed features are no longer available
for C-Soft license checkout requests.

—  Repair Response Message: If processing a Repair Response Message, all fulfillments are
validated and made available for C-Soft license checkout requests.
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58

58.1

Appendix J - DMR-AIS

The AIS (Application Specification Interface) protocol was developed by DMR (Digital Mobile
Radio) association to standardize the interface between a third party application such as
dispatch console and DMR radio system. As a DMR member, Bosch implemented the AIS
standard in C-Soft dispatch console application to fully comply with the DMR Tier I
Conventional and DMR Tier Il Trunking systems via wireline connection. This implementation
provides the flexibility for users to install and operate DMR radio communication systems.
Unlike other console manufactures, the C-Soft AlS implementation requires no dedicated
server nor gateway. Each console on a DMR network will act like a digital radio subscriber.
This advanced architecture provides system reliable and transparency, enhances operation,
and reduces the system cost.

Supported features

The C-Soft DMR-AIS interface currently supports the following feature set:
— Displays ANI and/or Alias of incoming calls

—  Send and Receive Group Calls
—  Group Call is sent by selecting corresponding Frequency button and then pressing
either InPTT or Main PTT button.
—  The Group Call type (Broadcast Call or Conference Call) can be controlled by using
the Radio Call Type button.

Notice!
For Hytera DMR AIS interface, system All Call can be sent by configuring a group with a group
ID of 16777215 for Conventional systems.

—  Send and Receive Individual Calls
- Individual Call is sent by selecting the corresponding Frequency button and then
pressing either INPTT or Main PTT button.
— Individual calls can be made by selecting or entering a user in the Keypad and then
pressing the Private PTT button.

—  Receive Emergency Notifications
—  Supports receiving both Emergency Calls and Emergency Alerts.

—  Send and Receive Call Alerts
—  Call Alert is sent by selecting a user from the Keypad control and then clicking the
Radio Call Alert button.
—  Call Alerts can only be sent on lines configured for Individual operation.

—  Send and Receive Text Messages
—  Text Message is sent by selecting a user from the Keypad control and then entering
the desired text into the Text Message Control. The message is sent when the Send
button in the Text Message Control is clicked.
—  Text Message can be sent to a group by selecting the line and group and then
entering the desired text into the Text Message Control. The message is sent when
the Send button in the Text Message Control is clicked.
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- Send Radio Enable /Disable Commands
— Radio Enable/Disable commands is sent by selecting a user from the Keypad control
and then clicking either the Radio Enable or the Radio Disable button.
— Radio Enable/Disable commands can only be sent on lines configured for individual
operation.

- Send Radio Check Command
— Radio Check command is sent by selecting a user from the Keypad control and then
clicking either the Radio Check button.
— Radio Check Command can only be sent on lines configured for Individual operation.

- Send Remote Monitor Command
- Remote Monitor command is sent by selecting a user from the Keypad control and
then clicking either the Radio Check button.
- Remote Monitor command can only be sent on lines configured for Individual
operation.

—  Console Priority
—  The Call Priority button can be created to set transmit priority level for each
outbound call.

-  Vocoder Support
-  C-Soft supports DMR standard AMBE+2 vocoder.

- GPS Support

—  GPS currently is not a part of DMR AIS standard. However, Telex has worked with
other repeater manufactures to support their specific GPS data format.

—  The following GPS features are available in C-Soft:
GPS Read (Standard Location Immediate Request)
GPS Trigger (Toggle On/Off for Location Reporting)
Incoming GPS Data triggered from Emergency Alarm
Incoming GPS Data triggered from Emergency Call
GPS data during voice calls

Notice!
Specific GPS supported functions vary depending on DMR repeater.

—  Supports connection to up to 20 AIS compatible repeaters
—  Each repeater connection is configured with a name, IP Address, System Type (e.g.
Conventional or Trunking), Vendor, Connection Port, Authentication Password, and
Registration interval.

—  Supports up to 24 AIS Interface lines
—  Each AIS Interface line connects to a specific repeater. The line configured with a
Connection, Type (Group or Individual), and a list of affiliated Group or Individuals.
Lines connected to a conventional repeater also use a time slot configuration.
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—  Each line can be configured to accept audio from one to 100 talkgroups.

— Indication of parallel console transmissions
—  Parallel Consoles are configured in C-Soft Designer by going to Edit | Setup Global
Parameters | Local Consoles and entering the Subscriber IDs of the parallel consoles
in the Direct IP Console Subscriber IDs field.
—  Calls initiated from parallel dispatch consoles display the ‘T’ icon on the receiving
line’s Select button.

—  Crossmuting of parallel consoles
—  Calls from parallel consoles can be automatically muted by enabling the Crossmute
direct IP console subscriber IDs field in Edit | Setup Global Parameters | Local
Consoles
—  When this option is enabled calls initiated from parallel dispatch consoles display the
‘XT’ icon on the receiving line’s Select button.

- Send Annunciations
- Send audio from the .wav file on an AIS line using the Annunciation button.

—  Crosspatching
—  Crosspatch audio from an AIS line to another line type supported by C-Soft.

Notice!

The supported features for DMR AIS interface might vary depending operation modes and
DMR manufacturer’s specifications. Please check the manufacturer’s manual and additional
application notes for more information.
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58.2 AIS Global Setup window
AlS Global Setup 4
Global Settings
Console ID:
Call Inactivty Timeout: E sEC
Connection List
Mame P System Vendor Connection Port  Password Heartbeat (sec)
Site 1 192,163, 1.3 Conventional Generic 5060 3600
Site 2 192.168.1.4 Trunking Generic 5060 3600
Click to create 0.0.0.0 Trunking Generic 5060 3600
Delete
Cancel

Global Settings group box

Console ID field
The Console ID field is used to enter the identification number assigned to the console.

The range for this field is 1 to 16777215 in decimal format.

Call Inactivity Timeout field

The Call Inactivity Timeout field is used to enter the amount of time in seconds allowed to
elapse with no voice traffic before the console terminates the call. before the console
terminates the call. This value should be set to approximates two seconds greater then the
AIS repeater’s call inactivity timeouts.

The range for this field is 1 to 100 seconds.
Connection List group box

Name column field
The Name column field is used to enter a unique name for the connection.

This field can contain up to 32 characters.

IP column Field
The IP column field is used to enter the IP Address of the connection being used to
communicate.
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58.3

System column drop down menu

The System column drop down menu is used to select the type of system the connection is
running. There are three service tiers - Tiers |, I, and Ill. Tiers | and Il are considered
Conventional systems, where Tier Il is only applicable for commercial radio markets.

Tier lll is classified as a trunking system. A trunking system uses a control channel to direct
radio traffic automatically whereas the radio user manually directs a conventional system.
Available options are:

—  Conventional

—  Trunking

Vendor column drop down menu

The Vendor column drop down menu is used to select the vendor of the system the
connection is running. This setting allows the console to perform any logic or functionality that
is unique to a specific radio system vendor.

The options available for this list are dependent on the currently selected System type.
Available option for a system type of Conventional:

- Generic

Available options for a system type of Trunking:

- Generic

- Leonardo

Connection Port field

The Connection Port field displays the port number used by C-Soft to connect to the AIS
repeater. The connection port need to match the port number used by the DMR-AIS system.
The default value for this field is 5060.

Password column field
The Password column field is used to enter the password configured as the Authentication
Password. When the field is left empty, the system does not require a password to register.

This field can contain up to 32 alpha numeric characters.

Heartbeat (sec) column field

The Heartbeat (sec) column field is used to enter the length of time, in seconds, a console
can be registered to the server without reregistering. This field can be used to monitor the
network connection between C-Soft and the repeater.

The range for this field is 10 to 65535 seconds.

C-Soft Designer setup

To configure C-Soft Designer, do the following:
1. Open C-Soft Designer v7.300 or later.
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2. From the Edit menu, select Setup AlS.
The AIS Global Setup window appears.

AlS Global Setup >
Global Settings
Console ID:
Call Imactivty Timeout: E sec
Connection List
Name i System Vendor Connection Port  Password Heartbeat (sec)
Site 1 192.168.1.3 Conventional Generic 5060 3000
Site 2 192.168.1.4 Trunking Generic 5060 3600
Click to create 0.0.0.0 Trunking Generic 5060 3600
Delete
e

3. In the Console ID field, enter the console ID.
IMPORTANT: Each console must have a unique ID.

4. In the Call Inactivity Timeout field, enter amount of time, in seconds, allowed to elapse
with no voice traffic before the console terminates the call.
NOTE: This value should be set to approximately two seconds greater than the AIS
repeater’s call inactivity timeouts.

5. In the Connection List:
In the Name field, enter a unique name that is easily identifiable.
In the IP field, enter the IP Address of repeater configured earlier.
From the System drop down menu, select Conventional or Trunking.
From the Vendor drop down menu, select Generic unless connecting to a Leonardo
Trunking system.
From the Connection Port drop down menu, select the connection port to use. 5060 is
the default setting; however individual systems may require different orts depending on
their configuration.
In Password field, enter the password configured as the Authentication Password, if
applicable.
In the Heartbeat field, enter the length of time a console can be registered to the server
without re-registering.

6. Click OK.

7. From the Edit Window, select Setup Per Line Parameters.
The Per Line Parameters window appears.
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8.

From the Line Type drop down menu, select AIS for the desired line.

Per Line
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9.

10.

11.

12.

13.

14.

Click the Signal Setup button for that line.
The Per Line AIS Setup window appears.

Per Line AlS Setup: Line 1

Line Settings
Connection: | Site 1 E
Slot:  |Slet1 w
Type: | Group e
Talkgroup List
Freq Mumber Alias
1 100 Group 100
2

Delete

Cancel

From the Connection drop down menu, select the desired repeater.

If the connection is configured as a conventional system, select Slot 1 or Slot 2 from the
Slot drop down menu.
NOTE: A DMR conventional repeater supports two independent time slots, which function
as channels. This field is disabled if the connection is configured as a Trunking system.

From the Type drop down menu, select Group or Individual.

IMPORTANT: Group lines can be used to transmit to and receive calls from DMR
Talkgroups as well as receive and send group text messages. Individual lines can be used
to transmit and receive individual calls, and send individual radio command operations.
Individual radio command operations cannot be sent on Group lines.

In the Talkgroup List group box, enter one or more group contacts.

OR

Enter one or more individual contacts.

The contacts in the list are mapped to frequency numbers which are selected by the
Frequency controls in C-Soft.

Click OK.

The Per Line AIS Setup window closes.
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15. From the Edit menu, select Setup Global Parameters.
The Global Parameter Setup window appears.

|Appeamnce | Audio ICnrrtroI Settings | IRR Recording | Local Consoles | Perpherals F&ecording|

Local Conscle IP Addresses
.0.0.0
.0.0.0
.0.0.0
.0.0.0
.0.0.0

Direct IP Console Subscriber [Ds

10M 0
102 0
1013
1014

0

[ Crossmute direct IP console subscriber 1Ds (Only for NEXEDGE and AlS lines)

J [ Cancel

16. Click the Local Consoles tab.
The Local Consoles page appears.

17. In the Local Console IP Addresses group box, enter the subscriber IDs of the parallel
consoles in the Direct IP Console Subscriber IDs field.

18. Select the Crossmute direct IP console subscriber IDs check box if parallel console
transmit audio should not be heard on the other parallel consoles.
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19. From the Edit menu, select Edit User ID List.
The User ID List window appears.

[ User ID List
Mame: IJger D Type:
1 Fortable 10071 100 &15
2 Portable 1002 1002 &5
3 Portable 1003 1003 415
4 Portable 1004 1004 &5

| .
Gﬁr‘lﬁrlﬁ

20. In the Name field, enter the name of the individual radio in the DMR system.
21. In the User ID field, enter the user ID of the individual radio in the DMR system.
22. From the Type drop down menu, select AIS.
The User ID List is used to alias IDs for incoming calls and to populate the Keypad
control.
23. Repeat step 20 through step 22, as necessary.
24. Click OK.
The User ID List window closes.
25. From the Edit menu, select Edit Group ID List.
The Group ID List window appears.
-

Group ID List
G roup: Group ID: Type:
1 Group 100 100 |45
2 Group 101 101 e
3 Giroup 102 102 |l
4 Group 103 103 |l
] Group 104 104 AlS
E Generc

26. In the Group field, enter the name of the talkgroup in the DMR system.

27. In the Group ID field, enter the group ID of the talkgroup in the DMR system.

28. From the Type drop down menu, select AIS.
The Group ID List is used to alias IDs for incoming calls and to populate the Keypad
control.

29. Click OK.
The Group ID List window closes.

30. Save the .veg file.
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Notice!
Verify the Console ID and Group IDs are entered correctly because C-Soft registers its
Console ID and all Talk Groups when it starts up.
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59 Appendix K - C-Soft API Installation notes

API functionality allows third party applications to connect securely to C-Soft. This API allows
external applications to exchange data and provide limited control of C-Soft.

Notice!

The API functionality is a value added option to you C-Soft license, please contact your

regional Bosch Sales person for details on how to purchase.

59.1 Supported features

Secured connection with user authentication
256-bit AES data encryption

Main PTT

Line PTT

Private Call

Group Call

Line Selection

Multiple Line Selection
Channel/Talkgroup Selection (Frequency Control Only)
Paging Functions (Single, Stack Pages)
Remote Monitor (Covert Call)
Crosspatch

GPS Integration

Event Notifications

Private Call Acknowledgement
Incoming Private Call Notification
Emergency

Connection Monitor (Heartbeat)
Select Call

Radio Call Status

Relay/Input support

SIP support
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59.2 Setup External Systems window
59.2.1 API Setup
Setup External Systems -
API Setup
Enable API
IP Address: | 172 . 1% . 1 . 108 TCP Port: |985D |
Username: |telex Password: |uu- |

Encryption Key: | V@0selzxp =CkWHCK TNvpwR 5Vi] =XM~Er |

QK Cancel

Figure 59.1: AP| Setup Window

Enable API checkbox
The Enable API checkbox is used to enable the API functionality in C-Soft. If this checkbox is
not selected, the functionality of the API is completely disabled.

IP Address field

The IP Address field is used to enter the IP Address of the 3™ party system. This is the IP
Address that communicates with C-Soft. When a 3 party system connects to C-Soft, C-Soft
confirms the address before connecting to the address.

Notice!
This address must match exactly between C-Soft and the 3™ party system.

TCP Port field

The TCP Port field is used to enter the port number that C-Soft attempts to connect and
communicate to the 3™ party system. If this does not match the 3™ party system’s settings,
communication cannot occur.

Username field
The Username field is used to enter the username used by the 3™ party system to log into C-
Soft. If the 3™ party system does not have the correct username, communication fails.
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59.2.1.1

Password field
The Password field is used to enter the password used by the 3™ party to log into C-Soft. If
the 3™ party system password does not match, communication fails.

Encryption Key Field

The Encryption Key field is used to enter or generate a 256-bit encryption key that is used to
encrypt communications between C-Soft and the 3™ party system. This key must match
exactly in both C-Soft and the 3™ party system or decryption fails and encryption cannot be
used.

Generate Key button
The Generate Key button is used to generate a random encryption key. This key must match
exactly in both C-Soft and the 3™ party system or decryption fails.

OK button
The OK button is used to accept the modifications and close the API Setup window.

Cancel button
The Cancel button closes the API Setup window without saving the modifications.

API Setup window

To set up an API connection, do the following

1. From the Edit menu, select Setup External System.
The Setup External Systems window appears.

2. Navigate to the API Setup page.

Select the Enable API check box.

4. Inthe IP Address field, enter the IP Address of the 3rd party system communicating with
C-Soft.

5. Inthe TCP Port field, enter the port number C-Soft attempts to connect and

w

communicate with the 3™ party system.
NOTE: If the port number entered in this field does not match the 3™ party system’s
settings, communication cannot occur.

6. Inthe User Name field, enter the username the 3™ party system uses to log on to C-Soft.
If the 3rd party user name does not have the correct username, communication cannot
occur.

7. In the Password field, enter the password the 3™ party system uses to log into C-Soft.
NOTE: The password can be anything, but the 3rd party system must use the same exact
password for logging in. If the password does not match communication will fail.

8. In the Encryption Key field, enter the encryption key to be used.

OR
Click the Generate Key button.
An encryption code appears in the Encryption Key field.
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Notice!

The encryption key is an AES 256-bit key. C-Soft can generate the key or a key can be
manually entered. This key must match on the 3™ party system and must be a valid AES 256-
bit key. If the encryption key is not valid, decryption fails and the functionality cannot be
used.
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60 Appendix L - End user license agreement

Bosch Security Systems, LCC.

Telex Radio Dispatch Products

End User Software License Agreement
8601 E. Cornhusker Highway

P.O. Box 5579

Lincoln, Nebraska 68507, USA

Tel. +1 402 467 5321

Fax +1 402 467 3279

www.telex.com

Important information

PLEASE READ THIS END USER LICENSE AGREEMENT (THE “LICENSE”) CAREFULLY BEFORE
OPENING THE PACKAGE AND/OR USING THE CONTENTS THEREOF AND/OR BEFORE
DOWNLOADING OR INSTALLING THE SOFTWARE PROGRAM. IF YOU DO NOT AGREE TO THIS
LICENSE DO NOT OPEN THE PACKAGE AND/OR DOWNLOAD AND/OR INSTALL THE
SOFTWARE AND PROMPTLY (AND IN ANY EVENT, WITHIN 7 DAYS FROM THE DATE YOU
RECEIVED THIS PACKAGE) RETURN THE SOFTWARE WITH THE ORIGINAL PACKAGE TO
BOSCH, ERASE THE SOFTWARE, AND ANY PART THEREOF, FROM YOUR COMPUTER AND DO
NOT USE IT IN ANY MANNER WHATSOEVER.

Bosch Security Systems, LCC. (“Bosch”) licenses the software comprised in the Telex Radio
Dispatch Products (each, together with associated documentation, the “Software”) for the
nonexclusive use by the end user (the “Licensee”). Licensee has read this License, and
Licensee understands, accepts and expressly agrees to abide by all the terms, provisions and
conditions of this License.

License of software

Under the terms of this nonexclusive and nontransferable License:

1.

Licensee may use a machine-readable form of the Software on a single computer or a single
server at a time and only for the operation of Bosch products. Licensee may not and shall not
(A) use the Software except as expressly authorized in this License and in the User
Documentation; (B) sell, sub-license, lease, rent, assign, pledge, or otherwise transfer, make
available or share Licensee’s rights under this License with any party or entity; (C) modify,
translate disassemble, decompile, reverse engineer, revise or enhance the Software or
attempt to discover the Software’s source code or create derivative works thereof; or (D)
install the Software onto a server so that it is accessible via a public network.
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2.

This License does not convey to Licensee an ownership interest in or title to the Software, in
whole or in part, but only the right to use the Software in accordance with the terms of this
License. Nothing in this License constitutes a waiver of Bosch’s intellectual property rights
under any law.

3. Open Source Software

The Software contains certain software components that are licensed by Bosch from various
open source distributors (individually and collectively, the “Open Source Software”), and
redistributed by Bosch to Licensee in accordance with the provisions of the open source
licenses governing the Open Source Software (each, the “Open Source License”). The Open
Source Software and applicable Open Source Licenses are listed in Schedule A to this
License. The source code is available for a period of 12 months after our last shipment of this
product and can be requested by sending an email to: open source-
request@telexradiodispatch.com. Please add “C-Soft Open Source Code” in the memo line of
your message. Only Mozilla Public License open source inquiries/requests will be responded
to via this email address.

A. No Support of Open Source Software

Licensee acknowledges and agrees that the Open Source Software is sublicensed by Bosch to
Licensee without support from Bosch. Licensee additionally understands and acknowledges
that the open source licenses governing the Open Source Software offer few, if any,
warranties.

B. Open Source Rights; Restrictions on Use of Software

Licensee may use, modify, link, distribute the Open Source Software to the full extent
permitted under the applicable Open Source License; provided that Licensee will not
incorporate, link, distribute or use any third party software or code in conjunction with the
Software in any way that (i) creates any obligation with respect to the Software, including the
obligation to disclose or distribute its source code; or (ii) grants to any third party any rights
to the Software. Without limiting the generality of the foregoing, Licensee will not incorporate,
link, distribute or use the Software with any code or software licensed under the GNU General
Public License (“GPL”), Lesser General Public License (“LGPL”), Mozilla, or any other Open
Source License, in any manner that could cause the Software (or any modifications thereto) to
become subject to the terms of the GPL, LGPL, Mozilla or such other Open Source License.
Licensee, and any other third party receiving the Software or any copies thereof, do not and
will not receive any right to use the Software or copies thereof in a manner that will cause any
patents, copyrights or other intellectual property rights that are owned or controlled by Bosch
or any of its Affiliates to become subject to any encumbrance or terms and conditions of any
third party or Open Source License. These restrictions, limitations, exclusions and conditions
will apply even if Bosch becomes aware of or fails to act in a manner to address any violation
or failure to comply therewith. Also, no act by Bosch will be construed as inconsistent with
the intent not to cause any intellectual property rights that are owned or controlled by Bosch
or any of its affiliate to become subject to any Open Source License. For clarity and the
avoidance of doubt, the restrictions set forth in this Section 1.3(B) are not intended and shall
not be construed to apply to the Open Source Software.

4.

This License will terminate automatically if Licensee fails at any time to comply with any of its

terms or conditions.

5.

Licensee may terminate this License at any time by returning the Software to Bosch and
complying with the terms of Section 1.6 below.
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6.

Except as expressly stated in this License, Bosch has no obligation to provide support,
maintenance, upgrades, modifications, or new releases of the Software.

7.

Upon any termination of this License, Licensee shall immediately return the Software to
Bosch, or destroy all items of the Software and delete same from Licensee's hardware. After
termination of this License, Bosch will not provide any further support for the Software.

8.

The Software, including the AMBE® voice coding technology (the “Technology”) embedded
therein, is protected by intellectual property rights including patent rights, copyrights, and
trade secrets of Digital Voice Systems, LCC. The Technology is licensed solely for use within
the Software without further modification. The user of the Software is expressly prohibited
from attempting to decompile, reverse engineer, or disassemble the Object Code, or in any
other ways convert the Object Code into human-readable form. U.S. Pat. Nos. #5,870,405,
#5,826,222, #5,754,974, #5,701,390, #5,715,365, #5,649,050, #5,630,011, #5,581,656,
#5,517,511, #5,491,772, #5,247,579, #5,226,084 and #5,195,166.]

Ownership and propriety rights; No implied rights

The Software is owned and copyrighted by Bosch and/or its suppliers. Except for the rights
expressly granted herein, no rights whatsoever are granted to or implied in favor of Licensee.
Bosch and its suppliers retain all rights to the Software, including, without limitation, all right,
title and interest in or to all copyright, patent, trade secret, and other intellectual and
proprietary rights therein, and any copies thereof, in whole or in part, all of which are the
valuable property of Bosch and/or its suppliers. Licensee may not remove, change, or delete
the copyright notice from the Software. Licensee will instruct its employees and others having
access to the Software in, and ensure their compliance with the terms of, this License.
Licensee shall use its best efforts to prevent any unauthorized copying of the Software.
Licensee shall be responsible for any breach of any provision of this License by Licensee's
employees. Licensee shall not sell, transfer, publish, disclose, commercially exploit or
otherwise make available, the whole or any part of the Software, or any copies thereof, to any
third party or persons not permitted by the terms of, and pursuant to the terms contained in
this License and each applicable Open Source License. Licensee shall not be not in violation
of this License, including this section, when a third party views the functional output resulting
from Licensee's use of the Software.

Software key

Licensee understands, acknowledges and agrees that, in order to use the Software and
receive the benefit of the Software’s functionality, Licensee must utilize the applicable
Software key made available by Bosch to purchasers of the Telex Radio Dispatch-IP Console
(each, the “Software Key”). Licensee understands that a specific Software Key must be used
for each of C-Soft and the Network Recorder Application.

1.

Licensee may not and shall not (A) use the Software Key except as expressly authorized in this
License and User Documentation (B) sell, sub-license, lease, rent, assign, pledge, or otherwise
transfer the Software Key; (C) modify, disassemble, decompile, reverse engineer, revise or
enhance the Software Key or create derivative works thereof.
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2.

Licensee acknowledges and agrees that its rights to the Software Key are subject to the
intellectual property rights of Bosch and/or third parties. This License does not convey to
Licensee an ownership interest in or title to intellectual property rights associated with the
Software Key Nothing in this License constitutes a waiver of intellectual property rights of
Bosch or any third party with respect to the Software Key.

Taxes

The License Fees for the Software is exclusive of all applicable federal, state, provincial and
local taxes including, without limitation, sales, use, property, value added, goods and services,
excise, and similar taxes, and all such taxes shall be assumed and paid by Licensee, excluding
taxes on Bosch’s net income. In the event that Bosch determines that any such taxes are
subject to withholding requirements, Bosch may bill Licensee for such taxes, and Licensee
shall promptly pay the amount billed. If any such tax for which Licensee is responsible
hereunder is paid by Bosch, Licensee agrees to promptly reimburse Bosch therefor.

Warranty, limitation of liability, remedies

1.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND INCLUDING A
WARRANTY THAT THE SOFTWARE IS ERROR FREE OR WILL RUN UNINTERRUPTED, OR THAT
IT IS FREE FROM INFRINGEMENT CLAIMS. ANY WARRANTY IMPLIED BY LAW, INCLUDING
WARRANTY OF MERCHANTABILITY OR WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE,
IS EXPRESSLY DISCLAIMED HEREBY NEITHER BOSCH NOR ITS SUPPLIERS SHALL BE LIABLE
FOR ANY LOSS OF PROFITS, LOSS OF USE, LOSS OF BUSINESS, GOODWILL OR ECONOMIC
OPPORTUNITY, INTERRUPTION OF BUSINESS, LOSS OF DATA, LOSS OF PROGRAMMING
AND/OR PRODUCTION MATERIALS, DAMAGE TO BUSINESS REPUTATION, OR FOR INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY KIND, WHETHER UNDER THIS
AGREEMENT OR OTHERWISE, OR FOR ANY CLAIM BY ANY OTHER PARTY. Bosch does not
warrant the functions provided by the Software. However, Bosch warrants the diskette or
other media on which the Software is furnished to be free from material defects in materials
and workmanship, under normal use, for a period of 90 days from the date of original
purchase. Bosch's entire liability to Licensee, and Licensee's exclusive remedy, shall be the
replacement of the diskette or other media not meeting Bosch's warranty, provided that
Licensee returns the defective diskette or other media to Bosch. The replacement will be
warranted for the remainder of the term of the original warranty, or 30 days, whichever is
longer. Licensee acknowledges that it is solely responsible for the selection of the Software to
achieve Licensee's intended results, and for the installation, use, and results obtained from
the Software.

2. Limited Warranty of Software Key; Remedies

Bosch warrants, for Licensee's benefit alone, that (i) the Software Key, when and as delivered
to Licensee, and for a period of three years after the date of delivery (ii) will perform in all
material respects in accordance with the User Documentation, provided that it is used on the
computer hardware and with the operating system specified in the User Documentation; and
(iii) will be in all material respects free from significant defects in materials and workmanship
under normal use thereof. Use of the Software Key other than normal, which shall render this
warranty void, includes misuse, tampering, modification, neglect or failure to follow Bosch
instructions. This warranty additionally does not cover defects not caused by Bosch (including
accidents or malfeasance while the Software Key is in transit or in Licensee’s possession,
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custody or control, or any defects or errors arising from any modification of the Software,
including any Open Source Software, that is not made or approved by Bosch). Repairs not
covered by this warranty shall be available on a time and material basis. Licensee
understands, acknowledges and expressly agrees that all repair(s) and replacement(s) of a
Software Key shall require the return of the original Software Key, and that lost Software Keys
will not be replaced. If, at any time during the applicable warranty period, Bosch, or Licensee
discovers one or more defects or errors in the Software Key or if the Software Key fails to
operate in accordance with applicable specifications or is otherwise defective, Bosch's sole
obligation shall be to repair or replace the defective item. EXCEPT AS EXPRESSLY STATED IN
THIS AGREEMENT, BOSCH DOES NOT WARRANT THAT THE SOFTWARE KEY WILL MEET
LICENSEE’S REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE KEY WILL BE
UNINTERRUPTED OR ERROR-FREE. BOSCH EXPRESSLY DISCLAIMS ALL EXPRESS
WARRANTIES NOT STATED HEREIN AND ALL IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. FURTHER, NOTHING IN THIS LICENSE IS INTENDED OR SHALL BE
CONSTRUED AS A WARRANTY BY BOSCH OF ANY OPEN SOURCE SOFTWARE, OR AN
AGREEMENT BY BOSCH TO PROVIDE ANY SUPPORT OR MAINTENANCE WITH RESPECT TO
THE OPEN SOURCE SOFTWARE; ANY SUCH WARRANTY OR AGREEMENT BEING
EXPRESSLY DISCLAIMED HEREBY.

U.S. Government restricted rights

Licensee will not use the Software or Software Key in any manner prohibited by applicable
law, including any restrictions imposed by the United States Government. The Software is
provided with restricted rights. Use, duplication, or disclosure is subject to legal restrictions
of the U.S. Government as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data
and Computer Software clause at DFAR 252.227-7013, Federal Acquisition Regulation clause
52.227-19 (c) (2) Commercial Computer Software Restricted Rights, NASA clause 52.227.86
(d) Commercial Computer Software Licensing, or their successor.

Export control laws

1.

Bosch's responsibility for delivery is limited to the delivery of the Software to Licensee. Bosch
will not be responsible for obtaining any export licenses or reexport licenses which may be
required for any subsequent shipping of the Software to destinations determined by Licensee.

2.
In the event that Licensee, or any subsequent party handling the Software after delivery by
Bosch to Licensee, does export the Software then, as between Bosch and Licensee:

3.

Licensee shall be solely responsible for compliance with all applicable laws and regulations
relating to such export including, but not limited to (a) export licenses or license exceptions,
(b) determining correct classification at the time of export; and (c) any other regulatory
agency approval requirements; and

4.

any diversion of the Software contrary to applicable law (including but not limited to U.S. law
and the law of the jurisdiction in which Licensee is located) by Licensee or any such
subsequent party is prohibited, and Licensee shall be solely responsible for any diversion
which is contrary to applicable law.
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DISCLAIMER OF CONSEQUENTIAL DAMAGES

NEITHER PARTY SHALL BE LIABLE (WHETHER UNDER CONTRACT, TORT (INCLUDING
NEGLIGENCE) OR OTHERWISE) TO THE OTHER PARTY FOR ANY LOSS OR DAMAGE
(INCLUDING INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES), INCLUDING, WITHOUT
LIMITATION, ANY LOSS OR DAMAGE TO BUSINESS EARNINGS, LOST PROFITS OR
GOODWILL AND LOST OR DAMAGED DATA OR DOCUMENTATION, SUFFERED BY ANY
PERSON, ARISING FROM AND/OR RELATED WITH AND/OR CONNECTED TO DELIVERY,
INSTALLATION, USE OR PERFORMANCE OF THE PRODUCT AND/OR ANY COMPONENT OF
THE PRODUCT, EVEN IF SUCH PARTY IS ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

Governing law

This License shall be construed according to the laws of the State of New York and the U.S.
The provisions of the United Nations Convention on Contracts for the International Sale of
Goods shall not apply. Any dispute will be subject to arbitration under the rules of the
American Arbitration Association and shall take place in Lincoln, Nebraska, Metropolitan area
of Rochester, New York, U.S.A.

Entire agreement

This License any Bosch Standard Terms and Conditions as applicable from time to time, as
well as all exhibits, schedules or appendices hereto, constitutes the complete and exclusive
statement of the terms hereof and supersedes all prior oral and written statements of any kind
made by the parties or their representatives with respect to the subject matter hereof. Any
customer purchase order or similar document issued by Licensee or subsequent shall not be
part of this License and shall not add to or modify any of the terms hereof. This License may
not be changed or supplemented except by a written amendment signed by authorized
representatives of the parties.

Schedule A

Bosch Security Systems, LCC.

Telex Radio Dispatch Products

End User Software License Agreement
Open Source Software

and Open Source Software Licenses

Component Description License

ADPCM Vocoder Telex ADPCM 32k Encode/ BSD-3-Clause “New” or
Decode format “Revised” License

alsa-lib Advanced Linux Sound GNU Lesser General Public
Architecture (ALSA) is a License

software framework and part
of the Linux kernel that
provides an application
programming interface (API)
for sound card device drivers

alsa-utils Advanced Linux Sound GNU Lesser General Public
Architecture (ALSA) is a License
software framework and part
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of the Linux kernel that
provides an application
programming interface (API)
for sound card device drivers

busybox

BusyBox combines tiny
versions of many common
UNIX utilities into a single
small executable

GNU General Public License

CBitmapSlider

Code Project -
“CBitmapSlider”

Code Project Open License
1.02

CButtonST

Code Project - “CButtonST
(MFC Flat Buttons)”

CButtonST

CColorEdit/CColorStatic

Code Project - “Using colors
in CEdit and CStatic”

Code Project Open License
1.02

CComboBox in a Grid Control

Code Project - “Using combo
boxes in the MFC Grid

Code Project Open License
1.02

Control”
cgic cgic is an ANSI C-language CGIC License Note: This
library for the creation of library contains modifications
CGlbased World Wide Web authored by Bosch Security
applications Systems, LCC. Refer to the
5.0 CGIC License for a
description of these changes.
cherokee Cherokee is an innovative, GNU General Public License
feature rich, lightning fast and
easy to configure open source
web server designed for the
next generation of highly
concurrent secured web
applications
CMemDC Code Project - “Flicker Free Code Project Open License

Drawing in MFC”

1.02

CommonServicelLocator

loC containers and service
locators library

Microsoft Public License (MS-
PL)

CppEvent Cod Project - "Generic Code Project Open License
Observer Pattern and Events |1.02
in C++

CppSAQLite3 Code Project - "CppSQLite3 - | Code Project Open License
C++ Wrapper for SQLite" 1.02

CProgressBar Code Project - “Showing Code Project Open License

progress bar in a status bar
pane”

1.02
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dbus

D-Bus is a message bus
system, a simple way for
applications to talk to one
another

GNU General Public License

DirectFB

DirectFB is a thin library that
provides hardware graphics
acceleration, input device
handling and abstraction,
integrated windowing system
with support for translucent
windows and multiple display
layers, not only on top of the
Linux Framebuffer Device

GNU Lesser General Public
License

expat

Expat is an XML parser library
written in C

The MIT License (MIT)

Font Awesome

Icon library and toolkit

The MIT License (MIT)

freetype

It is written in C, designed to
be small, efficient, highly
customizable, and portable
while capable of producing
high-quality output (glyph
images) of most vector and
bitmap font formats

GNU General Public License

Jpeg

Free library for JPEG image
compression

Independent JPEG Group
License

jQuery

jQuery is a fast, small, and
feature rich JavaScript
library. https://
blog.jquery.com

The MIT License (MIT)

jQuery File Upload Plugin

File Upload widget with
multiple file selection, drag &
drop support, progress bars,
validation and preview
images, audio and video for
jQuery. https://github.com/
blueimp/jQuery-File-Upload

The MIT License (MIT)

jQuery Ul

jQuery Ul is a curated set of
user interface interactions,
effects, widgets, and themes
built on top of the jQuery

JavaScript Library. https://
blog.jgueryui.com

The MIT License (MIT)

libpng

libpng is the official PNG
reference library

The zlib/libpng License

Bosch Security Systems, LLC

Technical Manual
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Linux Kernel

TI DaVinci Linux development
(Kernel)

GNU General Public License

Microsoft.PowerShell.5.Refer
enceAssemblies

SDK reference assemblies for
PowerShell version 5

The MIT License (MIT)

mtdutils MTD subsystem (stands for GNU General Public License
Memory Technology Devices)
provides an abstraction layer
for raw flash devices

MvvmLight MVVM Framework for The MIT License (MIT)

applications in WPF

MvvmLightLibs

MVVM Framework for
applications in WPF

The MIT License (MIT)

ncurses The Ncurses (new curses) The X11 License (MIT/X
library is a free software, and | Consortium)
emulation of curses in System
V Release 4.0, and more

net-snmp Simple Network Management |BSD-3-Clause

Protocol (SNMP) is widely
used protocol for monitoring
the health and welfare of
network equipment

Network and Socket files

Networking library

Microsoft Public License (MS-
PL)

NLog

Logging platform for
various .NET platforms.

BSD 3-Clause "New" or
"Revised" License

Open Phone Abstraction
Library (OPAL)

SIP/VOIP

Mozilla Public License v1.1

OpenSSL

Full-featured toolkit for the
Transport Layer Security
(TLS) and Secure Sockets
Layer (SSL) protocols. It is
also a general-purpose
cryptography library

OpenSSL License and SSLeay
license

popt

The popt library exists
essentially for parsing
command line options

The X11 License (MIT/X
Consortium)

Portable Windows Library
(PTLib)

SIP/VOIP library

Mozilla Public License v1.1

Qwave.lib

Quality of Service (QOS)
library

Microsoft Public License (MS-
PL)
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scew

The aim of SCEW is to
provide an easy interface
around the XML Expat parser,
for creating new XML
documents

GNU Lesser General Public
License

SharpZipLib

Zip library for .NET platform

The MIT License (MIT)

sysvinit

Init is the parent of all
processes. Its primary role is
to create processes from a
script stored in the file /etc/
inittab. This package also
contains well known and used
utilities like reboot,
shutdown, killall, poweroff,
tellinit, sulogin, wall, etc.

GNU General Public License

TI UBL

Texas Instruments Davinci
Serial Boot and Flashing
(Bootloader)

GNU General Public License,
version 2

TinyXML

XML Library

The zib/libpng License

U-Boot

"Das U-Boot" Source Tree
(Bootloader)

GNU General Public License

XML CTreeCtrl

Code Project - “How to
serialize a CTreeCtrl in XML”

Code Project Open License
1.02

zlib

zlib is a software library used
for data compression

The zlib/libpng License

Bosch Security Systems, LLC

Technical Manual
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0SS License applications

License Embedded C-Soft
BSD-3-Clause X X
CButtonST License X
CGIC License X

Code Project Open License X

1.02

GNU General Public License |X

GNU Lesser General Public X
License

Independent JPEG Group X

License

The MIT License (MIT) X X
Microsoft Public License X
(Ms-PL)

Mozilla Public License v1.1 X
OpenSSL License X X
SSlLeay License X X
The X11 License (MIT/X X

Consortium)

The zlib/libpng License X X
BSD-3-Clause

The Telex Radio Dispatch software contains open source software licensed under the BSD-3-
Clause, and the license terms below in this schedule apply to that open source software.

net-snmp
http://www.net-snmp.org/about/license.html

License
Various copyrights apply to this package, listed in various separate parts below.
Please make sure you read all parts.

Cambridge Broadband Ltd, copyright notice (BSD)
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

1. Redistribution of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.
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2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/ or other materials
provided with the distribution.

3. The name of Cambridge Broadband Ltd. may not be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

CMU/UCD copyright notice (BSD like)

Copyright 1989,1991,1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California
All rights reserved.

Permission to use, copy, modify and distribute this software and its documentation for any
purpose and without fee is hereby granted, provided that the above copyright notice appears
in all copies and that both that copyright notice and this permission notice appear in
supporting documentation, and that the name of CMU and The Regents of the University of
California not be used in advertising or publicity pertaining or distribution of the software
without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF
CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY
DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR PROFITS, WHETHER
IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF
OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Networks Associates Technology, LCC copyright notice (BSD)
Copyright (c) 2001-2003, Networks Associates Technology, LCC
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

1. Redistribution of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/ or other materials
provided with the distribution.
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3. Neither the name of the Networks Associates Technology, LCC nor the names of its
contributors may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 1S”
AND ANY EXPRESS OR IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

NLog copyright notice (BSD)

https://github.com/NLog/NLog/blob/master/LICENSE.txt

Copyright (c) 2004-2021 Jaroslaw Kowalski <jaak@jkowalski.net>, Kim Christensen, Julian
Verdurmen

All rights reserved.

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions

are met:

* Redistributions of source code must retain the above copyright notice,

this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice,

this list of conditions and the following disclaimer in the documentation

and/or other materials provided with the distribution.

* Neither the name of Jaroslaw Kowalski nor the names of its

contributors may be used to endorse or promote products derived from this

software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

Stichting Mathematisch Centrum copyright notice (BSD)

Copyright 1992 by Stichting Mathematisch Centrum, Amsterdam, The Netherlands.

All Rights Reserved

Permission to use, copy, modify, and distribute this software and its documentation for any
purpose and without fee is hereby granted, provided that the above copyright notice appear in
all copies and that both that copyright notice and this permission notice appear in supporting
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documentation, and that the names of Stichting Mathematisch Centrum or CWI not be used in
advertising or publicity pertaining to distribution of the software without specific, written
prior permission.

STICHTING MATHEMATISCH CENTRUM DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS
SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN
NO EVENT SHALL STICHTING MATHEMATISCH CENTRUM BE LIABLE FOR ANY SPECIAL,
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING
FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT,
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE
USE OR PERFORMANCE OF THIS SOFTWARE.

Sun Microsystems, LCC. copyright notice (BSD)

Copyright © 2003 Sun Microsystems, LCC., 4150 Network Circle, Santa Clara, California
95054, U.S.A.

All rights reserved.

User is subject to license terms below.

This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of
Sun Microsystems, LCC. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

1. Redistribution of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/ or other materials
provided with the distribution.

3. Neither the name of the Sun Microsystems, LCC. nor the names of its contributors may
be used to endorse or promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.
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Sparta, LCC copyright notice (BSD)
Copyright © 2003-2009 Sparta, LCC.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

1. Redistribution of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/ or other materials
provided with the distribution.

3. Neither the name Sparta, LCC nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 1S”
AND ANY EXPRESS OR IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

Cisco/BUPTNIC copyright notice (BSD)

Copyright © 2004, Cisco, LCC and Information Network Center of Beijing University of Posts
and Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

1. Redistribution of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/ or other materials
provided with the distribution.

3. Neither the name of Cisco, LCC, Beijing University of Posts and Telecommunications, nor
the names of their contributors may be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS I1S”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
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CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

Fabasoft R&D Software GmbH & Co KG copyright notice (BSD)
Copyright © Fabasoft R&D Software GmbH & Co KG, 2003 oss.fabasoft.com
Author: Bernhard Penz

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

1. Redistribution of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/ or other materials
provided with the distribution.

3. The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or
product names may not be used to endorse or promote products derived from this
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

Apple LCC. copyright notice (BSD)
Copyright © 2007 Apple LCC.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

1. Redistribution of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/ or other materials
provided with the distribution.

3. Neither the name of Apple, LCC. (“Apple”) nor the names of its contributors may be used
to endorse or promote products derived from this software without specific prior written
permissions.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS “AS IS” AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
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INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USER, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Sciencelogic, LLC copyright notice (BSD)
Copyright © 2009, Sciencelogic, LLC
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

1. Redistribution of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/ or other materials
provided with the distribution.

3. Neither the name of Sciencelogic, LLC nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

CButtonST License
The Telex Radio Dispatch software contains open source software developed by Davide
Calabro and the license terms below in this Schedule 1 apply to that open source software.

Disclaimer

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE DISTRIBUTED “AS IS” AND WITHOUT
ANY WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO RESPONSIBILITIES FOR THE
POSSIBLE DAMAGES OR EVEN FUNCTIONALITY CAN BE TAKEN. THE USER MUST ASSUME
THE ENTIRE RISK OF USING THIS SOFTWARE.

CGIC License

The Telex Radio Dispatch software contains open source software licensed under the CGIC
License, and the license terms below in this schedule (copied from the following website:
http://www.boutell.com/cgic/license.txt ) apply to that open source software.
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Notice!
This library contains modifications authored by Bosch Security Systems, LCC.

Modification Date: Feb 15, 2017
Reason: The multi-part form data parsing code performed slowly on Bosch hardware. This
code was replaced with a buffered parser for better performance.

Basic License

CGIC, copyright 1996-2011 by Thomas Boutell and Boutell.Com, LCC.

Permission is granted to use CGIC in any application, commercial or noncommercial, at no
cost. HOWEVER, this copyright paragraph must appear on a “credits” page accessible in the
public online and offline documentation of the program.

Modified versions of the CGIC library should not be distributed without the attachment of a
clear statement regarding the author of the modifications, and this notice may in no case be
removed. Modifications may also be submitted to the author for inclusion in the main CGIC
distribution.

IF YOU WOULD PREFER NOT TO ATTACH THE ABOVE NOTICE to the public documentation of
your application, consult the information which follows regarding the availability of a
nonexclusive commercial license for CGIC.

Signed originals are available on request after purchase.

Commercial licensees are entitled to ongoing email support and update notifications.

Commercial License
The price of a nonexclusive commercial license is $200 U.S. To purchase the license, visit our
online store here: https://www.boutell.com/

CGIC Nonexclusive Commercial License

The party purchasing this license is granted the right to utilize CGIC, major version 1 or 2, any
minor version thereof, in CGI applications without the need for a credit notice of any kind. CGl
applications developed by the holder of this license may be distributed freely in source code
or binary form without additional fees or royalties. This license does not grant the right to use
CGIC to create a development tool which passes on substantially all of the capabilities of the
CGIC library to the user of the tool, unless that tool is to be used internally by the license
holder only in order to develop CGI applications. This license may not be resold, but
applications developed in accordance with the terms of the license may be distributed freely
subject to the limitations described above.

Future minor (2.x) versions of CGIC will be covered by this license free of charge. If significant
defects of workmanship are discovered in version 2.x, minor releases to correct them will be
made available before or at the same time that those defects are addressed in any future
major version.

Future "major" (3.x) versions will be available to licensees at an upgrade price of $50. If, for
any reason, any portion of this license is found to be invalid, that portion of the license only is
invalidated and the remainder of the agreement remains in effect.
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If this license has not been signed by Thomas Boutell or M. L. Grant on behalf of Boutell. Com,
LCC., it is invalid.

Licensee's name:

Signed for Licensee:
Complete mailing address:
Phone number:

Email address:

Signed for Boutell.Com, LCC.:
Date:

Code Project Open License (CPOL) 1.02

The Telex Radio Dispatch software contains open source software licensed under the Code
Project Open License (CPOL) 1.02, and the license terms below in this Schedule 2 (copied
from the website: http://www.codeproject.com/info/cpol10.aspx) apply to that open source
software.

Preamble

This License governs Your use of the Work. This License is intended to allow developers to use
the Source Code and Executable Files provided as part of the Work in any application in any
form. The main points subject to the terms of the License are:

—  Source Code and Executable Files can be used in commercial applications;

—  Source Code and Executable Files can be redistributed; and

—  Source Code can be modified to create derivative works.

— No claim of suitability, guarantee, or any warranty whatsoever is provided. The software is
provided “as- is”.

—  The Article accompanying the Work may not be distributed or republished without the
Author's consent.

This License is entered between You, the individual or other entity reading or otherwise
making use of the Work licensed pursuant to this License and the individual or other entity
which offers the Work under the terms of this License (“Author”).

License

THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS CODE PROJECT
OPEN LICENSE (“LICENSE”). THE WORK IS PROTECTED BY COPYRIGHT AND/OR OTHER
APPLICABLE LAW. ANY USE OF THE WORK OTHER THAN AS AUTHORIZED UNDER THIS
LICENSE OR COPYRIGHT LAW IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HEREIN, YOU ACCEPT AND AGREE TO
BE BOUND BY THE TERMS OF THIS LICENSE. THE AUTHOR GRANTS YOU THE RIGHTS
CONTAINED HEREIN IN CONSIDERATION OF YOUR ACCEPTANCE OF SUCH TERMS AND
CONDITIONS. IF YOU DO NOT AGREE TO ACCEPT AND BE BOUND BY THE TERMS OF THIS
LICENSE, YOU CANNOT MAKE ANY USE OF THE WORK.
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Definitions

1. “Articles” means, collectively, all articles written by Author which describes how the
Source Code and Executable Files for the Work may be used by a user.

2.  “Author” means the individual or entity that offers the Work under the terms of this
License.

3. “Derivative Work” means a work based upon the Work or upon the Work and other pre-
existing works.

4. “Executable Files” refer to the executables, binary files, configuration and any required
data files included in the Work.

5. “Publisher” means the provider of the website, magazine, CD-ROM, DVD or other medium
from or by which the Work is obtained by You.

6. “Source Code” refers to the collection of source code and configuration files used to
create the Executable Files.

7. “Standard Version” refers to such a Work if it has not been modified, or has been
modified in accordance with the consent of the Author, such consent being in the full
discretion of the Author.

8. “Work” refers to the collection of files distributed by the Publisher, including the Source
Code, Executable Files, binaries, data files, documentation, white papers and the Articles.

9. “You” is you, an individual or entity wishing to use the Work and exercise your rights
under this License.

Fair Use/Fair Use Rights

Nothing in this License is intended to reduce, limit, or restrict any rights arising from fair use,
fair dealing, first sale or other limitations on the exclusive rights of the copyright owner under
copyright law or other applicable laws.

License Grant

Subject to the terms and conditions of this License, the Author hereby grants You a

worldwide, royalty-free, non-exclusive, perpetual (for the duration of the applicable copyright)

license to exercise the rights in the Work as stated below:

1. You may use the standard version of the Source Code or Executable Files in Your own
applications.

2. You may apply bug fixes, portability fixes and other modifications obtained from the
Public Domain or from the Author. A Work modified in such a way shall still be considered
the standard version and will be subject to this License.

3. You may otherwise modify Your copy of this Work (excluding the Articles) in any way to
create a Derivative Work, provided that You insert a prominent notice in each changed file
stating how, when and where You changed that file.

4. You may distribute the standard version of the Executable Files and Source Code or
Derivative Work in aggregate with other (possibly commercial) programs as part of a
larger (possibly commercial) software distribution.

5. The Articles discussing the Work published in any form by the author may not be
distributed or republished without the Author's consent. The author retains copyright to
any such Articles. You may use the Executable Files and Source Code pursuant to this
License but you may not repost or republish or otherwise distribute or make available the
Articles, without the prior written consent of the Author.
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Any subroutines or modules supplied by You and linked into the Source Code or Executable
Files of this Work shall not be considered part of this Work and will not be subject to the
terms of this License.

Patent License

Subject to the terms and conditions of this License, each Author hereby grants to You a
perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in
this section) patent license to make, have made, use, import, and otherwise transfer the Work.

Restrictions

The license granted in Section 3 above is expressly made subject to and limited by the

following restrictions:

1. You agree not to remove any of the original copyright, patent, trademark, and attribution
notices and associated disclaimers that may appear in the Source Code or Executable
Files.

2.  You agree not to advertise or in any way imply that this Work is a product of Your own.

3. The name of the Author may not be used to endorse or promote products derived from
the Work without the prior written consent of the Author.

4. You agree not to sell, lease, or rent any part of the Work. This does not restrict you from
including the Work or any part of the Work inside a larger software distribution that itself
is being sold. The Work by itself, though, cannot be sold, leased or rented.

5.  You may distribute the Executable Files and Source Code only under the terms of this
License, and You must include a copy of, or the Uniform Resource Identifier for, this
License with every copy of the Executable Files or Source Code You distribute and ensure
that anyone receiving such Executable Files and Source Code agrees that the terms of
this License apply to such Executable Files and/or Source Code. You may not offer or
impose any terms on the Work that alter or restrict the terms of this License or the
recipients' exercise of the rights granted hereunder. You may not sublicense the Work.
You must keep intact all notices that refer to this License and to the disclaimer of
warranties. You may not distribute the Executable Files or Source Code with any
technological measures that control access or use of the Work in a manner inconsistent
with the terms of this License.

6. You agree not to use the Work for illegal, immoral or improper purposes, or on pages
containing illegal, immoral or improper material. The Work is subject to applicable export
laws. You agree to comply with all such laws and regulations that may apply to the Work
after Your receipt of the Work.

Representations, Warranties and Disclaimer

THIS WORK IS PROVIDED “AS 1S,” “WHERE IS” AND “AS AVAILABLE”, WITHOUT ANY EXPRESS
OR IMPLIED WARRANTIES OR CONDITIONS OR GUARANTEES. YOU, THE USER, ASSUME ALL
RISK IN ITS USE, INCLUDING COPYRIGHT INFRINGEMENT, PATENT INFRINGEMENT,
SUITABILITY, ETC. AUTHOR EXPRESSLY DISCLAIMS ALL EXPRESS, IMPLIED OR STATUTORY
WARRANTIES OR CONDITIONS, INCLUDING WITHOUT LIMITATION, WARRANTIES OR
CONDITIONS OF MERCHANTABILITY, MERCHANTABLE QUALITY OR FITNESS FOR A
PARTICULAR PURPOSE, OR ANY WARRANTY OF TITLE OR NON-INFRINGEMENT, OR THAT THE
WORK (OR ANY PORTION THEREOF) IS CORRECT, USEFUL, BUG-FREE OR FREE OF VIRUSES.
YOU MUST PASS THIS DISCLAIMER ON WHENEVER YOU DISTRIBUTE THE WORK OR
DERIVATIVE WORKS.
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Indemnity

You agree to defend, indemnify and hold harmless the Author and the Publisher from and
against any claims, suits, losses, damages, liabilities, costs, and expenses (including
reasonable legal or attorneys’ fees) resulting from or relating to any use of the Work by You.

Limitation on Liability

EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE LAW, IN NO EVENT WILL THE AUTHOR
OR THE PUBLISHER BE LIABLE TO YOU ON ANY LEGAL THEORY FOR ANY SPECIAL,
INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY DAMAGES ARISING OUT OF THIS
LICENSE OR THE USE OF THE WORK OR OTHERWISE, EVEN IF THE AUTHOR OR THE
PUBLISHER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Termination

1. This License and the rights granted hereunder will terminate automatically upon any
breach by You of any term of this License. Individuals or entities who have received
Derivative Works from You under this License, however, will not have their licenses
terminated provided such individuals or entities remain in full compliance with those
licenses. Sections 1, 2, 6, 7, 8, 9, 10 and 11 will survive any termination of this License.

2. If You bring a copyright, trademark, patent or any other infringement claim against any
contributor over infringements You claim are made by the Work, your License from such
contributor to the Work ends automatically.

3. Subject to the above terms and conditions, this License is perpetual (for the duration of
the applicable copyright in the Work). Notwithstanding the above, the Author reserves the
right to release the Work under different license terms or to stop distributing the Work at
any time; provided, however that any such election will not serve to withdraw this
License (or any other license that has been, or is required to be, granted under the terms
of this License), and this License will continue in full force and effect unless terminated
as stated above.

Publisher

The parties hereby confirm that the Publisher shall not, under any circumstances, be
responsible for and shall not have any liability in respect of the subject matter of this License.
The Publisher makes no warranty whatsoever in connection with the Work and shall not be
liable to You or any party on any legal theory for any damages whatsoever, including without
limitation any general, special, incidental or consequential damages arising in connection to
this license. The Publisher reserves the right to cease making the Work available to You at any
time without notice

Miscellaneous

1. This License shall be governed by the laws of the location of the head office of the Author
or if the Author is an individual, the laws of location of the principal place of residence of
the Author.

2. If any provision of this License is invalid or unenforceable under applicable law, it shall
not affect the validity or enforceability of the remainder of the terms of this License, and
without further action by the parties to this License, such provision shall be reformed to
the minimum extent necessary to make such provision valid and enforceable.

3. No term or provision of this License shall be deemed waived and no breach consented to
unless such waiver or consent shall be in writing and signed by the party to be charged
with such waiver or consent.

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



630 en | Appendix L - End user license agreement C-Soft 7.700

4. This License constitutes the entire agreement between the parties with respect to the
Work licensed herein. There are no understandings, agreements or representations with
respect to the Work not specified herein. The Author shall not be bound by any additional
provisions that may appear in any communication from You. This License may not be
modified without the mutual written agreement of the Author and You.

GNU General Public License

The Telex Radio Dispatch software contains open source software licensed under the GNU
General Public License, and the license terms below in this schedule (copied from the
following website: http://www.gnu.org/licenses/oldlicenses/gpl-2.0.html ) apply to that open
source software.

Linux Kernel

NOTE! This copyright does *not* cover user programs that use kernel services by normal
system calls - this is merely considered normal use of the kernel, and does *not* fall under the
heading of “derived work”. Also note that the GPL below is copyrighted by the Free Software
Foundation, but the instance of code that it refers to (the Linux kernel) is copyrighted by me
and others who actually wrote it.

Also note that the only valid version of the GPL as far as the kernel is concerned is _this_
particular version of the license (ie v2, not v2.2 or v3.x or whatever), unless explicitly
otherwise stated.

Linus Torvalds

Refer to the GNU General Public License for the rest of the license information.

U-Boot

U-Boot is Free Software. It is copyrighted by Wolfgang Denk and many others who contributed
code (refer to the actual source code for details). You can redistribute U-Boot and/or modify it
under the terms of the GNU General Public License as published by the Free Software
Foundation. Most of it can also be distributed at your option, under any later version of the
GNU General Public License - refer to individual files for exceptions.

NOTE! This license does *not* cover the so-called “standalone” applications that use U-Boot
services by means of the jump table provided by U-Boot exactly for this purpose - this is
merely considered normal use of U-Boot, and does *not* fall under the heading of “derived
work”.

The header files “include/image.h” and “include/asm-*/u-boot.h” define interfaces to U-Boot.
LCCluding these (unmodified) header files in another file is considered normal use of U-Boot,
and does *not* fall under the heading of “derived work”.

Also note that the GPL below is copyrighted by the Free Software Foundation, but the
instance of code that it refers to (the U-Boot source code) is copyrighted by me and others
who actually wrote it.

Wolfgang Denk

Refer to the GNU General Public License for the rest of the license information.
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busybox

A note on GPL versions:

BusyBox is distributed under the General Public License (included in its entirety, below).
Version 2 is the only version of this license which this version of BusyBox (or modified
versions derived from this one) may be distributed under.

Refer to the GNU General Public License for the rest of the license information.

dbus

Bus is licensed to you under your choice of the Academic Free License, or the GNU General
Public License. Both licenses are included here. Some of the standalone binaries are under
the GPL only; in particular, but not limited to, tools/dbus-cleanup-sockets.c and test/decode-
gcov.c. Each source code file is marked with the proper copyright information - if you find a
file that isn't marked please bring it to our attention.

Refer to the GNU General Public License for the rest of the license information.

freetype

The FreeType 2 font engine is copyrighted work and cannot be used legally without a software
license. In order to make this project usable to a vast majority of developers, we distribute it
under two mutually exclusive open-source licenses. This means that *you* must choose *one*
of the two licenses described below, then obey all its terms and conditions when using
FreeType 2 in any of your projects or products.

The FreeType License, found in the file "FTL.TXT', which is similar to the original BSD license
*with* an advertising clause that forces you to explicitly cite the FreeType project in your
product's documentation. All details are in the license file. This license is suited to products
which don't use the GNU General Public License.

The GNU General Public License, found in ‘GPL.TXT’ (any later version can be used also), for
programs which already use the GPL Note that the FTL is incompatible with the GPL due to its
advertisement clause.

The contributed PCF driver comes with a license similar to that of the X Window System. It is
compatible to the above two licenses (refer to file src/pcf/readme).

Refer to the GNU General Public License for the rest of the license information.

GNU General Public License

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, LCC.

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change
it. By contrast, the GNU General Public License is intended to guarantee your freedom to
share and change free software--to make sure the software is free for all its users. This
General Public License applies to most of the Free Software Foundation's software and to any
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other program whose authors commit to using it. (Some other Free Software Foundation
software is covered by the GNU Lesser General Public License instead.) You can apply it to
your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public
Licenses are designed to make sure that you have the freedom to distribute copies of free
software (and charge for this service if you wish), that you receive source code or can get it if
you want it, that you can change the software or use pieces of it in new free programs; and
that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these
rights or to ask you to surrender the rights. These restrictions translate to certain
responsibilities for you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must
give the recipients all the rights that you have. You must make sure that they, too, receive or
can get the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this
license which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone
understands that there is no warranty for this free software. If the software is modified by
someone else and passed on, we want its recipients to know that what they have is not the
original, so that any problems introduced by others will not reflect on the original authors'
reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the
danger that redistributors of a free program will individually obtain patent licenses, in effect
making the program proprietary. To prevent this, we have made it clear that any patent must
be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

Terms and Conditions for copying, distribution and modification

1.

This License applies to any program or other work which contains a notice placed by the
copyright holder saying it may be distributed under the terms of this General Public License.
The “Program”, below, refers to any such program or work, and a “work based on the
Program” means either the Program or any derivative work under copyright law: that is to say,
a work containing the Program or a portion of it, either verbatim or with modifications and/or
translated into another language. (Hereinafter, translation is included without limitation in the
term “modification”.) Each licensee is addressed as “you”. Activities other than copying,
distribution and modification are not covered by this License; they are outside its scope. The
act of running the Program is not restricted, and the output from the Program is covered only
if its contents constitute a work based on the Program (independent of having been made by
running the Program). Whether that is true depends on what the Program does.
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2.

You may copy and distribute verbatim copies of the Program's source code as you receive it, in
any medium, provided that you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer
to this License and to the absence of any warranty; and give any other recipients of the
Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option
offer warranty protection in exchange for a fee.

You may modify your copy or copies of the Program or any portion of it, thus forming a work
based on the Program, and copy and distribute such modifications or work under the terms of
Section 1 above, provided that you also meet all of these conditions:

—  You must cause the modified files to carry prominent notices stating that you
changed the files and the date of any change.

—  You must cause any work that you distribute or publish, that in whole or in part
contains or is derived from the Program or any part thereof, to be licensed as a
whole at no charge to all third parties under the terms of this License.

—  If the modified program normally reads commands interactively when run, you must
cause it, when started running for such interactive use in the most ordinary way, to
print or display an announcement including an appropriate copyright notice and a
notice that there is no warranty (or else, saying that you provide a warranty) and that
users may redistribute the program under these conditions, and telling the user how
to view a copy of this License. (Exception: if the Program itself is interactive but
does not normally print such an announcement, your work based on the Program is
not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that
work are not derived from the Program, and can be reasonably considered independent and
separate works in themselves, then this License, and its terms, do not apply to those sections
when you distribute them as separate works. But when you distribute the same sections as
part of a whole which is a work based on the Program, the distribution of the whole must be
on the terms of this License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written
entirely by you; rather, the intent is to exercise the right to control the distribution of
derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or
with a work based on the Program) on a volume of a storage or distribution medium does not
bring the other work under the scope of this License.

3.

You may copy and distribute the Program (or a work based on it, under Section 2) in object
code or executable form under the terms of Sections 1 and 2 above provided that you also do
one of the following:
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— Accompany it with the complete corresponding machine-readable source code,
which must be distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange; or,

- Accompany it with a written offer, valid for at least three years, to give any third
party, for a charge no more than your cost of physically performing source
distribution, a complete machine-readable copy of the corresponding source code,
to be distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange; or,

— Accompany it with the information you received as to the offer to distribute
corresponding source code. (This alternative is allowed only for noncommercial
distribution and only if you received the program in object code or executable form
with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to
it. For an executable work, complete source code means all the source code for all modules it
contains, plus any associated interface definition files, plus the scripts used to control
compilation and installation of the executable. However, as a special exception, the source
code distributed need not include anything that is normally distributed (in either source or
binary form) with the major components (compiler, kernel, and so on) of the operating system
on which the executable runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source code from the same
place counts as distribution of the source code, even though third parties are not compelled
to copy the source along with the object code.

4.

You may not copy, modify, sublicense, or distribute the Program except as expressly provided
under this License. Any attempt otherwise to copy, modify, sublicense or distribute the
Program is void, and will automatically terminate your rights under this License. However,
parties who have received copies, or rights, from you under this License will not have their
licenses terminated so long as such parties remain in full compliance.

5.

You are not required to accept this License, since you have not signed it. However, nothing
else grants you permission to modify or distribute the Program or its derivative works. These
actions are prohibited by law if you do not accept this License. Therefore, by modifying or
distributing the Program (or any work based on the Program), you indicate your acceptance of
this License to do so, and all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

6.

Each time you redistribute the Program (or any work based on the Program), the recipient
automatically receives a license from the original licensor to copy, distribute or modify the
Program subject to these terms and conditions. You may not impose any further restrictions
on the recipients' exercise of the rights granted herein. You are not responsible for enforcing
compliance by third parties to this License.

7.

If, as a consequence of a court judgment or allegation of patent infringement or for any other
reason (not limited to patent issues), conditions are imposed on you (whether by court order,
agreement or otherwise) that contradict the conditions of this License, they do not excuse you
from the conditions of this License. If you cannot distribute so as to satisfy simultaneously
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your obligations under this License and any other pertinent obligations, then as a
consequence you may not distribute the Program at all. For example, if a patent license would
not permit royalty-free redistribution of the Program by all those who receive copies directly
or indirectly through you, then the only way you could satisfy both it and this License would
be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular
circumstance, the balance of the section is intended to apply and the section as a whole is
intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property
right claims or to contest validity of any such claims; this section has the sole purpose of
protecting the integrity of the free software distribution system, which is implemented by
public license practices. Many people have made generous contributions to the wide range of
software distributed through that system in reliance on consistent application of that system;
it is up to the author/donor to decide if he or she is willing to distribute software through any
other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the
rest of this License.

8.

If the distribution and/or use of the Program is restricted in certain countries either by patents
or by copyrighted interfaces, the original copyright holder who places the Program under this
License may add an explicit geographical distribution limitation excluding those countries, so
that distribution is permitted only in or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the body of this License.

9.

The Free Software Foundation may publish revised and/or new versions of the General Public
License from time to time. Such new versions will be similar in spirit to the present version,
but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version
number of this License which applies to it and "any later version", you have the option of
following the terms and conditions either of that version or of any later version published by
the Free Software Foundation. If the Program does not specify a version number of this
License, you may choose any version ever published by the Free Software Foundation.

10.

If you wish to incorporate parts of the Program into other free programs whose distribution
conditions are different, write to the author to ask for permission. For software which is
copyrighted by the Free Software Foundation, write to the Free Software Foundation; we
sometimes make exceptions for this. Our decision will be guided by the two goals of
preserving the free status of all derivatives of our free software and of promoting the sharing
and reuse of software generally.

NO WARRANTY

11.

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
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PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE
OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR
DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR
A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH
HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use to the public,
the best way to achieve this is to make it free software which everyone can redistribute and
change under these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of
each source file to most effectively convey the exclusion of warranty; and each file should have
at least the “copyright” line and a pointer to where the full notice is found.

One line to give the program's name and an idea of what it does.
Copyright (C) year, name of author

This program is free software; you can redistribute it and/or modify it under the terms of the
GNU General Public License as published by the Free Software Foundation; either version 2 of
the License, or (at your option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY;
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE. Refer to the GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if
not, write to the Free Software Foundation, LCC., 51 Franklin Street, Fifth Floor, Boston, MA
02110-1301, USA.

Also add information on how to contact you by electronic and paper mail. If the program is
interactive, make it output a short notice like this when it starts in an interactive mode:
Gnomovision, Copyright (C) year name of author

Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type ‘show w’. This is free
software, and you are welcome to redistribute it under certain conditions; type ‘show c’ for
details.
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The hypothetical commands ‘show w’ and ‘show ¢’ should show the appropriate parts of the
General Public License. Of course, the commands you use may be called something other than
‘show w and ‘show c’; they could even be mouseclicks or menu items - whatever suits your
program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign
a “copyright disclaimer” for the program, if necessary.

Here is a sample; alter the names:

Yoyodyne, LCC., hereby disclaims all copyright interest in the program ‘Gnomovision’ (which
makes passes at compilers) written by James Hacker.

Signature of Ty Coon, 1 April 1989

Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary
programs. If your program is a subroutine library, you may consider it more useful to permit
linking proprietary applications with the library. If this is what you want to do, use the GNU
Lesser General Public License instead of this License.

GNU Lesser General Public License

The Telex Radio Dispatch software contains open source software licensed under the GNU
Lesser General Public License, and the license terms below in this schedule (copied from the
following website: http://www.gnu.org/licenses/ old-licenses/Igpl-2.1.html) apply to that open
source software.

Copyright (C) 1991, 1999 Free Software Foundation, LCC.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the
GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change
it. By contrast, the GNU General Public Licenses are intended to guarantee your freedom to
share and change free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software
packages - typically libraries - of the Free Software Foundation and other authors who decide
to use it. You can use it too, but we suggest you first think carefully about whether this license
or the ordinary General Public License is the better strategy to use in any particular case,
based on the explanations below.
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When we speak of free software, we are referring to freedom, not price. Our General Public
Licenses are designed to make sure that you have the freedom to distribute copies of free
software (and charge for this service if you wish), that you receive source code or can get it if
you want it, that you can change the software or use pieces of it in new free programs; and
that you know you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these
rights or to ask you to surrender these rights. These restrictions translate to certain
responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give
the recipients all the rights that we gave you. You must make sure that they, too, receive or
can get the source code. If you link other code with the library, you must provide complete
object files to the recipients, so that they can relink them with the library after making
changes to the library and recompiling it. And you must show them these terms so they know
their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer
you this license, which gives you legal permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free
library. Also, if the library is modified by someone else and passed on, the recipients should
know that what they have is not the original version, so that the original author's reputation
will not be affected by problems that might be introduced by others.

Finally, software patents pose a constant threat to the existence of any free program. We wish
to make sure that a company cannot effectively restrict the users of a free program by
obtaining a restrictive license from a patent holder. Therefore, we insist that any patent
license obtained for a version of the library must be consistent with the full freedom of use
specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public
License. This license, the GNU Lesser General Public License, applies to certain designated
libraries, and is quite different from the ordinary General Public License. We use this license
for certain libraries in order to permit linking those libraries into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the
combination of the two is legally speaking a combined work, a derivative of the original library.
The ordinary General Public License therefore permits such linking only if the entire
combination fits its criteria of freedom. The Lesser General Public License permits more lax
criteria for linking other code with the library.

We call this license the “Lesser” General Public License because it does Less to protect the
user's freedom than the ordinary General Public License. It also provides other free software
developers Less of an advantage over competing non-free programs. These disadvantages are
the reason we use the ordinary General Public License for many libraries. However, the Lesser
license provides advantages in certain special circumstances.
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For example, on rare occasions, there may be a special need to encourage the widest possible
use of a certain library, so that it becomes a de-facto standard. To achieve this, non-free
programs must be allowed to use the library. A more frequent case is that a free library does
the same job as widely used non-free libraries. In this case, there is little to gain by limiting the
free library to free software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater
number of people to use a large body of free software. For example, permission to use the
GNU C Library in non-free programs enables many more people to use the whole GNU
operating system, as well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it does
ensure that the user of a program that is linked with the Library has the freedom and the
wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay close
attention to the difference between a “work based on the library” and a “work that uses the
library”. The former contains code derived from the library, whereas the latter must be
combined with the library in order to run.

Terms and Conditions for copying, distribution and modification

1.

This License Agreement applies to any software library or other program which contains a
notice placed by the copyright holder or other authorized party saying it may be distributed
under the terms of this Lesser General Public License (also called “this License”). Each
licensee is addressed as “you”.

A “library” means a collection of software functions and/or data prepared so as to be
conveniently linked with application programs (which use some of those functions and data)
to form executables.

The “Library”, below, refers to any such software library or work which has been distributed
under these terms. A “work based on the Library” means either the Library or any derivative
work under copyright law: that is to say, a work containing the Library or a portion of it, either
verbatim or with modifications and/or translated straightforwardly into another language.
(Hereinafter, translation is included without limitation in the term “modification”.)

“Source code” for a work means the preferred form of the work for making modifications to it.
For a library, complete source code means all the source code for all modules it contains, plus
any associated interface definition files, plus the scripts used to control compilation and
installation of the library.

Activities other than copying, distribution and modification are not covered by this License;
they are outside its scope. The act of running a program using the Library is not restricted,
and output from such a program is covered only if its contents constitute a work based on the
Library (independent of the use of the Library in a tool for writing it). Whether that is true
depends on what the Library does and what the program that uses the Library does.
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2.

You may copy and distribute verbatim copies of the Library's complete source code as you
receive it, in any medium, provided that you conspicuously and appropriately publish on each
copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices
that refer to this License and to the absence of any warranty; and distribute a copy of this
License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option
offer warranty protection in exchange for a fee.

3.

You may modify your copy or copies of the Library or any portion of it, thus forming a work
based on the Library, and copy and distribute such modifications or work under the terms of
Section 1 above, provided that you also meet all of these conditions:

—  The modified work must itself be a software library.

—  You must cause the files modified to carry prominent notices stating that you
changed the files and the date of any change.

-  You must cause the whole of the work to be licensed at no charge to all third parties
under the terms of this License.

— If afacility in the modified Library refers to a function or a table of data to be
supplied by an application program that uses the facility, other than as an argument
passed when the facility is invoked, then you must make a good faith effort to ensure
that, in the event an application does not supply such function or table, the facility
still operates, and performs whatever part of its purpose remains meaningful. (For
example, a function in a library to compute square roots has a purpose that is
entirely well-defined independent of the application. Therefore, Subsection 2d
requires that any application-supplied function or table used by this function must
be optional: if the application does not supply it, the square root function must still
compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that
work are not derived from the Library, and can be reasonably considered independent and
separate works in themselves, then this License, and its terms, do not apply to those sections
when you distribute them as separate works. But when you distribute the same sections as
part of a whole which is a work based on the Library, the distribution of the whole must be on
the terms of this License, whose permissions for other licensees extend to the entire whole,
and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written
entirely by you; rather, the intent is to exercise the right to control the distribution of
derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or
with a work based on the Library) on a volume of a storage or distribution medium does not
bring the other work under the scope of this License.

4.

You may opt to apply the terms of the ordinary GNU General Public License instead of this
License to a given copy of the Library. To do this, you must alter all the notices that refer to
this License, so that they refer to the ordinary GNU General Public License, version 2, instead
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of to this License. (If a newer version than version 2 of the ordinary GNU General Public
License has appeared, then you can specify that version instead if you wish.) Do not make any
other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU
General Public License applies to all subsequent copies and derivative works made from that
copy. This option is useful when you wish to copy part of the code of the Library into a
program that is not a library.

5.

You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in
object code or executable form under the terms of Sections 1 and 2 above provided that you
accompany it with the complete corresponding machine-readable source code, which must be
distributed under the terms of Sections 1 and 2 above on a medium customarily used for
software interchange.

If distribution of object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place satisfies the
requirement to distribute the source code, even though third parties are not compelled to
copy the source along with the object code.

6.

A program that contains no derivative of any portion of the Library, but is designed to work
with the Library by being compiled or linked with it, is called a “work that uses the Library”.
Such a work, in isolation, is not a derivative work of the Library, and therefore falls outside the
scope of this License.

However, linking a “work that uses the Library” with the Library creates an executable that is a
derivative of the Library (because it contains portions of the Library), rather than a “work that
uses the library”. The executable is therefore covered by this License. Section 6 states terms
for distribution of such executables.

When a “work that uses the Library” uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the Library even though the
source code is not. Whether this is true is especially significant if the work can be linked
without the Library, or if the work is itself a library. The threshold for this to be true is not
precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors,
and small macros and small inline functions (ten lines or less in length), then the use of the
object file is unrestricted, regardless of whether it is legally a derivative work. (Executables
containing this object code plus portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the
work under the terms of Section 6. Any executables containing that work also fall under
Section 6, whether or not they are linked directly with the Library itself.

7.

As an exception to the Sections above, you may also combine or link a “work that uses the
Library” with the Library to produce a work containing portions of the Library, and distribute
that work under terms of your choice, provided that the terms permit modification of the work
for the customer's own use and reverse engineering for debugging such modifications.
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You must give prominent notice with each copy of the work that the Library is used in it and
that the Library and its use are covered by this License. You must supply a copy of this
License. If the work during execution displays copyright notices, you must include the
copyright notice for the Library among them, as well as a reference directing the user to the
copy of this License. Also, you must do one of these things:

—  Accompany the work with the complete corresponding machine-readable source
code for the Library including whatever changes were used in the work (which must
be distributed under Sections 1 and 2 above); and, if the work is an executable
linked with the Library, with the complete machine-readable "work that uses the
Library", as object code and/or source code, so that the user can modify the Library
and then relink to produce a modified executable containing the modified Library. (It
is understood that the user who changes the contents of definitions files in the
Library will not necessarily be able to recompile the application to use the modified
definitions.)

— Use a suitable shared library mechanism for linking with the Library. A suitable
mechanism is one that (1) uses at run time a copy of the library already present on
the user's computer system, rather than copying library functions into the
executable, and (2) will operate properly with a modified version of the library, if the
user installs one, as long as the modified version is interface-compatible with the
version that the work was made with.

— Accompany the work with a written offer, valid for at least three years, to give the
same user the materials specified in Subsection 6a, above, for a charge no more than
the cost of performing this distribution.

- If distribution of the work is made by offering access to copy from a designated
place, offer equivalent access to copy the above specified materials from the same
place.

—  Verify that the user has already received a copy of these materials or that you have
already sent this user a copy.

For an executable, the required form of the "work that uses the Library" must include any data
and utility programs needed for reproducing the executable from it. However, as a special
exception, the materials to be distributed need not include anything that is normally
distributed (in either source or binary form) with the major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself
accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary

libraries that do not normally accompany the operating system. Such a contradiction means

you cannot use both them and the Library together in an executable that you distribute.

8.

You may place library facilities that are a work based on the Library side-by-side in a single

library together with other library facilities not covered by this License, and distribute such a

combined library, provided that the separate distribution of the work based on the Library and

of the other library facilities is otherwise permitted, and provided that you do these two

things:

—  Accompany the combined library with a copy of the same work based on the Library,

uncombined with any other library facilities. This must be distributed under the
terms of the Sections above.
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—  Give prominent notice with the combined library of the fact that part of it is a work
based on the Library, and explaining where to find the accompanying uncombined
form of the same work.

9.

You may not copy, modify, sublicense, link with, or distribute the Library except as expressly
provided under this License. Any attempt otherwise to copy, modify, sublicense, link with, or
distribute the Library is void, and will automatically terminate your rights under this License.
However, parties who have received copies, or rights, from you under this License will not
have their licenses terminated so long as such parties remain in full compliance.

10.

You are not required to accept this License, since you have not signed it. However, nothing
else grants you permission to modify or distribute the Library or its derivative works. These
actions are prohibited by law if you do not accept this License. Therefore, by modifying or
distributing the Library (or any work based on the Library), you indicate your acceptance of
this License to do so, and all its terms and conditions for copying, distributing or modifying
the Library or works based on it.

11.

Each time you redistribute the Library (or any work based on the Library), the recipient
automatically receives a license from the original licensor to copy, distribute, link with or
modify the Library subject to these terms and conditions. You may not impose any further
restrictions on the recipients' exercise of the rights granted herein. You are not responsible for
enforcing compliance by third parties with this License.

12.

If, as a consequence of a court judgment or allegation of patent infringement or for any other
reason (not limited to patent issues), conditions are imposed on you (whether by court order,
agreement or otherwise) that contradict the conditions of this License, they do not excuse you
from the conditions of this License. If you cannot distribute so as to satisfy simultaneously
your obligations under this License and any other pertinent obligations, then as a
consequence you may not distribute the Library at all. For example, if a patent license would
not permit royalty-free redistribution of the Library by all those who receive copies directly or
indirectly through you, then the only way you could satisfy both it and this License would be
to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular
circumstance, the balance of the section is intended to apply and the section as a whole is
intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property
right claims or to contest validity of any such claims; this section has the sole purpose of
protecting the integrity of the free software distribution system which is implemented by
public license practices. Many people have made generous contributions to the wide range of
software distributed through that system in reliance on consistent application of that system;
it is up to the author/donor to decide if he or she is willing to distribute software through any
other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the
rest of this License.
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13.

If the distribution and/or use of the Library is restricted in certain countries either by patents
or by copyrighted interfaces, the original copyright holder who places the Library under this
License may add an explicit geographical distribution limitation excluding those countries, so
that distribution is permitted only in or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the body of this License.

14.

The Free Software Foundation may publish revised and/or new versions of the Lesser General
Public License from time to time. Such new versions will be similar in spirit to the present
version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library specifies a version number
of this License which applies to it and "any later version", you have the option of following the
terms and conditions either of that version or of any later version published by the Free
Software Foundation. If the Library does not specify a license version number, you may
choose any version ever published by the Free Software Foundation.

15.

If you wish to incorporate parts of the Library into other free programs whose distribution
conditions are incompatible with these, write to the author to ask for permission. For software
which is copyrighted by the Free Software Foundation, write to the Free Software Foundation;
we sometimes make exceptions for this.

Our decision will be guided by the two goals of preserving the free status of all derivatives of
our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

16.

BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
LIBRARY "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

17.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE
OR INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR
DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR
A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH
HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS
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How to apply these terms to your new libraries

If you develop a new library, and you want it to be of the greatest possible use to the public,
we recommend making it free software that everyone can redistribute and change. You can do
so by permitting redistribution under these terms (or, alternatively, under the terms of the
ordinary General Public License).

To apply these terms, attach the following notices to the library. It is safest to attach them to
the start of each source file to most effectively convey the exclusion of warranty; and each file
should have at least the "copyright" line and a pointer to where the full notice is found.

One line to give the library's name and an idea of what it does.
Copyright (C) year, name of author

This library is free software; you can redistribute it and/or modify it under the terms of the
GNU Lesser General Public License as published by the Free Software Foundation; either
version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY;
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE. Refer to the GNU Lesser General Public License for more details. You should have
received a copy of the GNU Lesser General Public License along with this library; if not, write
to the Free Software Foundation, LCC., 51 Franklin Street, Fifth Floor, Boston, MA
02110-1301 USA

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, to sign
a "copyright disclaimer" for the library, if necessary. Here is a sample; alter the names:

Yoyodyne, LCC., hereby disclaims all copyright interest in the library ‘Frob’ (a library for
tweaking knobs) written by James Random Hacker.

Signature of Ty Coon, 1 April 1989

Ty Coon, President of Vice

That's all there is to it!

Independent JPEG Group License

The Telex Radio Dispatch software contains open source software licensed under the
Independent JPEG Group License, and the license terms below in this schedule (copied from
the following website: https://spdx.org/licenses/IJG ) apply to that open source software.

Legal issues

In plain English:

1. We don't promise that this software works. (But if you find any bugs, please let us know!)
You can use this software for whatever you want. You don't have to pay us.

3.  You may not pretend that you wrote this software. If you use it in a program, you must
acknowledge somewhere in your documentation that you've used the IJG code.
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In legalese:

The authors make NO WARRANTY or representation, either express or implied, with respect to
this software, its quality, accuracy, merchantability, or fitness for a particular purpose. This
software is provided “AS IS”, and you, its user, assume the entire risk as to its quality and
accuracy.

This software is copyright (C) 1991-1998, Thomas G. Lane.
All rights reserved except as specified below.

Permission is hereby granted to use, copy, modify, and distribute this software (or portions
thereof) for any purpose, without fee, subject to these conditions:

1. If any part of the source code for this software is distributed, then this README file must
be included, with this copyright and no-warranty notice unaltered; and any additions,
deletions, or changes to the original files must be clearly indicated in accompanying
documentation.

2. If only executable code is distributed, then the accompanying documentation must state
that “this software is based in part on the work of the Independent JPEG Group”.

3. Permission for use of this software is granted only if the user accepts full responsibility
for any undesirable consequences; the authors accept NO LIABILITY for damages of any
kind.

These conditions apply to any software derived from or based on the IJG code, not just to the
unmodified library. If you use our work, you ought to acknowledge us.

Permission is NOT granted for the use of any IJG author's name or company name in
advertising or publicity relating to this software or products derived from it. This software may
be referred to only as “the Independent JPEG Group's software”.

We specifically permit and encourage the use of this software as the basis of commercial
products, provided that all warranty or liability claims are assumed by the product vendor.

ansi2knr.c is included in this distribution by permission of L. Peter Deutsch, sole proprietor of
its copyright holder, Aladdin Enterprises of Menlo Park, CA.

ansi2knr.c is NOT covered by the above copyright and conditions, but instead by the usual
distribution terms of the Free Software Foundation; principally, that you must include source
code if you redistribute it. (Refer to the file ansi2knr.c for full details.) However, since
ansi2knr.c is not needed as part of any program generated from the IJG code, this does not
limit you more than the foregoing paragraphs do.

The Unix configuration script “configure” was produced with GNU Autoconf. It is copyright by
the Free Software Foundation but is freely distributable. The same holds for its supporting
scripts (config.guess, config.sub, Itconfig, Itmain.sh). Another support script, install-sh, is
copyright by M.L.T. but is also freely distributable.
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It appears that the arithmetic coding option of the JPEG spec is covered by patents owned by
IBM, AT&T, and Mitsubishi. Hence arithmetic coding cannot legally be used without obtaining
one or more licenses. For this reason, support for arithmetic coding has been removed from
the free JPEG software. (Since arithmetic coding provides only a marginal gain over the
unpatented Huffman mode, it is unlikely that very many implementations will support it.) So
far as we are aware, there are no patent restrictions on the remaining code.

The IJG distribution formerly included code to read and write GIF files. To avoid entanglement
with the Unisys LZW patent, GIF reading support has been removed altogether, and the GIF
writer has been simplified to produce “uncompressed GIFs”. This technique does not use the
LZW algorithm; the resulting GIF files are larger than usual, but are readable by all standard
GIF decoders.

We are required to state that “The Graphics Interchange Format(c) is the Copyright property
of CompuServe LCCorporated. GIF(sm) is a Service Mark property of CompuServe
LCCorporated.”

MICROSOFT PUBLIC LICENSE (Ms-PL)

The Telex Radio Dispatch C-Soft application contains open source software licensed under the
Microsoft Public License (Ms-PL), and the license terms below in this schedule (copied from
the following websites: http://www.microsoft.com/en-us/openness/licenses.aspx and https://
github.com/unitycontainer/commonservicelocator/blob/master/LICENSE) apply to that open
source software.

This license governs use of the accompanying software. If you use the software, you accept
this license. If you do not accept the license, do not use the software.
1. Definitions
The terms "reproduce," "reproduction," "derivative works," and "distribution" have the
same meaning here as under U.S. copyright law.
A "contribution" is the original software, or any additions or changes to the software.
A "contributor" is any person that distributes its contribution under this license.
"Licensed patents" are a contributor's patent claims that read directly on its contribution.
2. Grant of Rights
(A) Copyright Grant- Subject to the terms of this license, including the license conditions
and limitations in section 3, each contributor grants you a non-exclusive, worldwide,
royalty-free copyright license to reproduce its contribution, prepare derivative works of
its contribution, and distribute its contribution or any derivative works that you create.
(B) Patent Grant- Subject to the terms of this license, including the license conditions
and limitations in section 3, each contributor grants you a non-exclusive, worldwide,
royalty-free license under its licensed patents to make, have made, use, sell, offer for
sale, import, and/or otherwise dispose of its contribution in the software or derivative
works of the contribution in the software.
3. Conditions and Limitations
(A) No Trademark License- This license does not grant you rights to use any contributors'
name, logo, or trademarks.
(B) If you bring a patent claim against any contributor over patents that you claim are
infringed by the software, your patent license from such contributor to the software ends
automatically.
(C) If you distribute any portion of the software, you must retain all copyright, patent,
trademark, and attribution notices that are present in the software.
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(D) If you distribute any portion of the software in source code form, you may do so only
under this license by including a complete copy of this license with your distribution. If
you distribute any portion of the software in compiled or object code form, you may only
do so under a license that complies with this license.

(E) The software is licensed "as-is." You bear the risk of using it. The contributors give no
express warranties, guarantees, or conditions. You may have additional consumer rights
under your local laws which this license cannot change. To the extent permitted under
your local laws, the contributors exclude the implied warranties of merchantability,
fitness for a particular purpose and non-infringement.

The MIT License (MIT)

The Telex Radio Dispatch software contains open source software licensed under The MIT
License (MIT), and the license terms below in this schedule (copied from the following
website: http://opensource.org/licenses/MIT ) apply to that open source software.

expat
Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper
Copyright (c) 2001, 2002, 2003, 2004, 2005, 2006 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.
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Font Awesome
https://github.com/FortAwesome/Font-Awesome/blob/master/LICENSE.txt
Copyright <YEAR> <COPYRIGHT HOLDER>

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"),

to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or
sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

jQuery

Copyright JS Foundation and other contributors, https://js.foundation/.

This software consists of voluntary contributions made by many individuals. For exact
contribution history, refer to the revision history available at https://github.com/jquery/jquery.

The following license applies to all parts of this software except as documented below:

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

All files located in the node modules and external directories are externally maintained
libraries used by this software which have their own licenses; we recommend you read them,
as their terms may differ from the terms above.
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jQuery Ul

Copyright jQuery Foundation and other contributors, https://jquery.org/

This software consists of voluntary contributions made by many individuals. For exact
contribution history, refer to the revision history available at https://github.com/jquery/jquery-

ui.
The following license applies to all parts of this software except as documented below:

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS 1S", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Copyright and related rights for sample code are waived via CC0O. Sample code is defined as
all source code contained within the demos directory.
CCO: http://creativecommons.org/publicdomain/zero/1.0/

All files located in the node modules and external directories are externally maintained
libraries used by this software which have their own licenses; we recommend you read them,
as their terms may differ from the terms above.

jQuery File Upload Plugin
Copyright (c) 2017 jQuery-File-Upload Authors

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
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AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Microsoft.PowerShell.5.ReferenceAssembies
https://github.com/PowerShell/PowerShell-Tests/blob/master/LICENSE
Copyright (c) 2015 Microsoft Corporation.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

The MIT License (MIT)
Copyright (c) <year> <copyright holders>

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS 1S", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

MvvmLight and MvvmLightLibs
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https://github.com/lbugnion/mvvmlight/blob/master/GalaSoft.MvvmLight/GalaSoft.MvvmLight
%20(PCL)/License.txt

Copyright (c) 2009-2018 Laurent Bugnion (GalaSoft), laurent@galasoft.ch

Permission is hereby granted, free of charge, to any person obtaining a copy

of this software and associated documentation files (the "Software"),

to deal in the Software without restriction, including without limitation the

rights to use, copy, modify, merge, publish, distribute, sublicense, and/or

sell copies of the Software, and to permit persons to whom the Software is

furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

SharpZipLib
https://github.com/icsharpcode/SharpZipLib/blob/master/LICENSE.txt

Copyright © 2000-2018 SharpZipLib Contributors

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"),

to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or
sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Mozilla Public License vi.1

The Telex Radio Dispatch software contains open source software licensed under the Mozilla
Public License v1.1, and the license terms below in this Schedule 3 (copied from the following
website: http://www.mozilla.org/MPL/1.1/index.txt) apply to that open source software.
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Definitions

"Commercial Use" means distribution or otherwise making the Covered Code available to

a third party.

"Contributor" means each entity that creates or contributes to the creation of

Modifications.

"Contributor Version" means the combination of the Original Code, prior Modifications

used by a Contributor, and the Modifications made by that particular Contributor.

"Covered Code" means the Original Code or Modifications or the combination of the

Original Code and Modifications, in each case including portions thereof.

"Electronic Distribution Mechanism" means a mechanism generally accepted in the

software development community for the electronic transfer of data.

"Executable" means Covered Code in any form other than Source Code.

"Initial Developer" means the individual or entity identified as the Initial Developer in the

Source Code notice required by Exhibit A.

"Larger Work" means a work which combines Covered Code or portions thereof with

code not governed by the terms of this License.

"License" means this document.

— "Licensable" means having the right to grant, to the maximum extent possible,
whether at the time of the initial grant or subsequently acquired, any and all of the
rights conveyed herein.

Modifications" means any addition to or deletion from the substance or structure of

either the Original Code or any previous Modifications. When Covered Code is released as

a series of files, a Modification is:

Any addition to or deletion from the contents of a file containing Original Code or

previous Modifications.

Any new file that contains any part of the Original Code or previous Modifications.

"Original Code" means Source Code of computer software code which is described in the

Source Code notice required by Exhibit A as Original Code, and which, at the time of its

release under this License is not already Covered Code governed by this License.

-  “Patent Claims” means any patent claim(s), now owned or hereafter acquired,
including without limitation, method, process, and apparatus claims, in any patent
Licensable by grantor.

“Source Code” means the preferred form of the Covered Code for making modifications

to it, including all modules it contains, plus any associated interface definition files,

scripts used to control compilation and installation of an Executable, or source code
differential comparisons against either the Original Code or another well known, available

Covered Code of the Contributor's choice. The Source Code can be in a compressed or

archival form, provided the appropriate decompression or de-archiving software is widely

available for no charge.

“You” (or “Your”) means an individual or a legal entity exercising rights under, and

complying with all of the terms of, this License or a future version of this License issued

under Section 6.1. For legal entities, “You” includes any entity which controls. is
controlled by, or is common control with you. For purposes of this definition, “control”
means (a) the power, direct or indirect, to cause the direction or management of such
entity, whether by contract or otherwise, or (b) ownership of more than fifty percent

(50%) of the outstanding shares or beneficial ownership of such entity.

Source Code License
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The Initial Developer Grant

The Initial Developer hereby grants You a world-wide, royalty-free, nonexclusive license,

subject to third party intellectual property claims:

1. under intellectual property rights (other than patent or trademark) Licensable by Initial
Developer to use, reproduce, modify, display, perform, sublicense and distribute the
Original Code (or portions thereof) with or without Modifications, and/or as part of a
Larger Work; and

2. under Patents Claims infringed by the making, using or selling of Original Code, to make,
have made, use, practice, sell, and offer for sale, and/or otherwise dispose of the Original
Code (or portions thereof).

3. the licenses granted in this Section (1) and (2) are effective on the date Initial Developer
first distributes Original Code under the terms of this License.

4. Notwithstanding Section (2) above, no patent license is granted: 1) for code that You
delete from the Original Code; 2) separate from the Original Code; or 3) for infringements
caused by: i) the modification of the Original Code or ii) the combination of the Original
Code with other software or devices.

Contributor Grant

Subject to third party intellectual property claims, each Contributor hereby grants You a

world-wide, royalty-free, non-exclusive license

1. under intellectual property rights (other than patent or trademark) Licensable by
Contributor, to use, reproduce, modify, display, perform, sublicense and distribute the
Modifications created by such Contributor (or portions thereof) either on an unmodified
basis, with other Modifications, as Covered Code and/or as part of a Larger Work; and

2. under Patent Claims infringed by the making, using, or selling of Modifications made by
that Contributor either alone and/or in combination with its Contributor Version (or
portions of such combination), to make, use, sell, offer for sale, have made, and/or
otherwise dispose of: 1) Modifications made by that Contributor (or portions thereof);
and 2) the combination of Modifications made by that Contributor with its Contributor
Version (or portions of such combination).

3. the licenses granted in Sections (1) and (2) are effective on the date Contributor first
makes Commercial Use of the Covered Code.

4. Notwithstanding Section (2) above, no patent license is granted: 1) for any code that
Contributor has deleted from the Contributor Version; 2) separate from the Contributor
Version; 3) for infringements caused by: i) third party modifications of Contributor
Version or ii) the combination of Modifications made by that Contributor with other
software (except as part of the Contributor Version) or other devices; or 4) under Patent
Claims infringed by Covered Code in the absence of Modifications made by that
Contributor.

Distributions Obligations

Application of License

The Modifications which You create or to which You contribute are governed by the terms of
this License, including without limitation Section Contributor Grant. The Source Code version
of Covered Code may be distributed only under the terms of this License or a future version of
this License released under Section New Versions, and You must include a copy of this
License with every copy of the Source Code You distribute. You may not offer or impose any
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terms on any Source Code version that alters or restricts the applicable version of this License
or the recipients' rights hereunder. However, You may include an additional document offering
the additional rights described in Section Required Notices.

Availability of Source Code

Any Modification which You create or to which You contribute must be made available in
Source Code form under the terms of this License either on the same media as an Executable
version or via an accepted Electronic Distribution Mechanism to anyone to whom you made an
Executable version available; and if made available via Electronic Distribution Mechanism,
must remain available for at least twelve months after the date it initially became available, or
at least six months after a subsequent version of that particular Modification has been made
available to such recipients. You are responsible for ensuring that the Source Code version
remains available even if the Electronic Distribution Mechanism is maintained by a third party.

Description of Modifications

You must cause all Covered Code to which You contribute to contain a file documenting the
changes You made to create that Covered Code and the date of any change. You must include
a prominent statement that the Modification is derived, directly or indirectly, from Original
Code provided by the Initial Developer and including the name of the Initial Developer in (a)
the Source Code, and (b) in any notice in an Executable version or related documentation in
which You describe the origin or ownership of the Covered Code.

Intellectual Property Matters

—  Third Party Claims
If Contributor has knowledge that a license under a third party's intellectual property rights is
required to exercise the rights granted by such Contributor under Sections The Initial
Developer Grant or Contributor Grant, Contributor must include a text file with the Source
Code distribution titled "LEGAL" which describes the claim and the party making the claim in
sufficient detail that a recipient will know whom to contact. If Contributor obtains such
knowledge after the Modification is made available as described in Section Availability of
Source Code, Contributor shall promptly modify the LEGAL file in all copies Contributor
makes available thereafter and shall take other steps (such as notifying appropriate mailing
lists or news groups) reasonably calculated to inform those who received the Covered Code
that new knowledge has been obtained.

—  Contributor APIs
If Contributor's Modifications include an application programming interface and Contributor
has knowledge of patent licenses which are reasonably necessary to implement that API,
Contributor must also include this information in the LEGAL file.

-  Representation
Contributor represents that, except as disclosed pursuant to Section (1) above, Contributor
believes that Contributor's Modifications are Contributor's original creation(s) and/or
Contributor has sufficient rights to grant the rights conveyed by this License.

Required Notices

You must duplicate the notice in Exhibit A in each file of the Source Code. If it is not possible
to put such notice in a particular Source Code file due to its structure, then You must include
such notice in a location (such as a relevant directory) where a user would be likely to look for
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such a notice. If you created one or more Modification(s) You may add your name as a
Contributor to the notice described in Exhibit A. You must also duplicate this License in any
documentation for the Source Code where You describe recipients' rights or ownership rights
relating to Covered Code. You may choose to offer, and to charge a fee for, warranty, support,
indemnity or liability obligations to one or more recipients of Covered Code. However, You
may do so only on Your own behalf, and not on behalf of the Initial Developer or any
Contributor. You must make it absolutely clear than any such warranty, support, indemnity or
liability obligation is offered by You alone, and You hereby agree to indemnify the Initial
Developer and every Contributor for any liability incurred by the Initial Developer or such
Contributor as a result of warranty, support, indemnity or liability terms You offer.

Distribution of Executable Versions

You may distribute Covered Code in Executable form only if the requirements of Section
3.1-3.5 have been met for that Covered Code, and if You include a notice stating that the
Source Code version of the Covered Code is available under the terms of this License,
including a description of how and where You have fulfilled the obligations of Section 3.2. The
notice must be conspicuously included in any notice in an Executable version, related
documentation or collateral in which You describe recipients' rights relating to the Covered
Code.

You may distribute the Executable version of Covered Code or ownership rights under a
license of Your choice, which may contain terms different from this License, provided that You
are in compliance with the terms of this License and that the license for the Executable
version does not attempt to limit or alter the recipient's rights in the Source Code version
from the rights set forth in this License. If You distribute the Executable version under a
different license You must make it absolutely clear that any terms which differ from this
License are offered by You alone, not by the Initial Developer or any Contributor. You hereby
agree to indemnify the Initial Developer and every Contributor for any liability incurred by the
Initial Developer or such Contributor as a result of any such terms You offer.

Larger Works

You may create a Larger Work by combining Covered Code with other code not governed by
the terms of this License and distribute the Larger Work as a single product. In such a case,
You must make sure the requirements of this License are fulfilled for the Covered Code.

Inability to Comply Due to Statute or Regulation

If it is impossible for You to comply with any of the terms of this License with respect to some
or all of the Covered Code due to statute, judicial order, or regulation then You must: (a)
comply with the terms of this License to the maximum extent possible; and (b) describe the
limitations and the code they affect. Such description must be included in the LEGAL file
described in Section Intellectual Property Matters and must be included with all distributions
of the Source Code. Except to the extent prohibited by statute or regulation, such description
must be sufficiently detailed for a recipient of ordinary skill to be able to understand it.

Application of this License
This License applies to code to which the Initial Developer has attached the notice in Exhibit A

and to related Covered Code.

Versions of the License

2021-06 | 14 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC



C-Soft 7.700

Appendix L - End user license agreement | en 657

New Versions
Netscape Communications Corporation ("Netscape") may publish revised and/or new versions
of the License from time to time. Each version will be given a distinguishing version number.

Effect of New Versions

Once Covered Code has been published under a particular version of the License, You may
always continue to use it under the terms of that version. You may also choose to use such
Covered Code under the terms of any subsequent version of the License published by
Netscape. No one other than Netscape has the right to modify the terms applicable to Covered
Code created under this License.

Derivative Works

If You create or use a modified version of this License (which you may only do in order to
apply it to code which is not already Covered Code governed by this License), You must (a)
rename Your license so that the phrases "Mozilla", "MOZILLAPL", "MOZPL", "Netscape", "MPL",
"NPL" or any confusingly similar phrase do not appear in your license (except to note that your
license differs from this License) and (b) otherwise make it clear that Your version of the
license contains terms which differ from the Mozilla Public License and Netscape Public
License. (Filling in the name of the Initial Developer, Original Code or Contributor in the notice
described in Exhibit A shall not of themselves be deemed to be modifications of this License.)

Disclaimer of Warranty

COVERED CODE IS PROVIDED UNDER THIS LICENSE ON AN "AS IS" BASIS, WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, WITHOUT
LIMITATION, WARRANTIES THAT THE COVERED CODE IS FREE OF DEFECTS,
MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGING. THE ENTIRE RISK
AS TO THE QUALITY AND PERFORMANCE OF THE COVERED CODE IS WITH YOU. SHOULD
ANY COVERED CODE PROVE DEFECTIVE IN ANY RESPECT, YOU (NOT THE INITIAL DEVELOPER
OR ANY OTHER CONTRIBUTOR) ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR
OR CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF
THIS LICENSE. NO USE OF ANY COVERED CODE IS AUTHORIZED HEREUNDER EXCEPT
UNDER THIS DISCLAIMER.
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Termination

1.

This License and the rights granted hereunder will terminate automatically if you fail to comply

with terms herein and fail to cure such breach within 30 days of becoming aware of the

breach. All sublicenses to the Covered Code which are properly granted shall survive any
termination of this License. Provisions which, by their nature, must remain in effect beyond
the termination of this License shall survive.

2.

If You initiate litigation by asserting a patent infringement claim (excluding declatory judgment

actions) against Initial Developer or a Contributor (the Initial Developer or Contributor against

whom You file such action is referred to as "Participant") alleging that:

1. such Participant's Contributor Version directly or indirectly infringes any patent, then any
and all rights granted by such Participant to You under Sections The Initial Developer
Grant and/or Contributors Grant of this License shall, upon 60 days notice from
Participant terminate prospectively, unless if within 60 days after receipt of notice You
either: (i) agree in writing to pay Participant a mutually agreeable reasonable royalty for
Your past and future use of Modifications made by such Participant, or (ii) withdraw Your
litigation claim with respect to the Contributor Version against such Participant. If within
60 days of notice, a reasonable royalty and payment arrangement are not mutually agreed
upon in writing by the parties or the litigation claim is not withdrawn, the rights granted
by Participant to You under Sections The Initial Developer Grant and/or Contributors
Grant automatically terminate at the expiration of the 60 day notice period specified
above.

2. any software, hardware, or device, other than such Participant's Contributor Version,
directly or indirectly infringes any patent, then any rights granted to You by such
Participant under Sections The Initial Developer Grant (2) and Contributors Grant (2) are
revoked effective as of the date You first made, used, sold, distributed, or had made,
Modifications made by that Participant.

3.

If You assert a patent infringement claim against Participant alleging that such Participant's

Contributor Version directly or indirectly infringes any patent where such claim is resolved

(such as by license or settlement) prior to the initiation of patent infringement litigation, then

the reasonable value of the licenses granted by such Participant under Sections The Initial

Developer Grant or Contributors Grant shall be taken into account in determining the amount

or value of any payment or license.

4.

In the event of termination under Sections 2. (1) or 2. (2) above, all end user license

agreements (excluding distributors and resellers) which have been validly granted by You or

any distributor hereunder prior to termination shall survive termination.

Limitation of Liability

UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER TORT (INCLUDING
NEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL YOU, THE INITIAL DEVELOPER, ANY
OTHER CONTRIBUTOR, OR ANY DISTRIBUTOR OF COVERED CODE, OR ANY SUPPLIER OF ANY
OF SUCH PARTIES, BE LIABLE TO ANY PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION,
DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR
MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES, EVEN IF
SUCH PARTY SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES.
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THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL
INJURY RESULTING FROM SUCH PARTY'S NEGLIGENCE TO THE EXTENT APPLICABLE LAW
PROHIBITS SUCH LIMITATION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS EXCLUSION AND
LIMITATION MAY NOT APPLY TO YOU.

U.S. Government end users

The Covered Code is a “commercial item,” as that term is defined in 48 C.F.R. 2.101 (Oct.
1995), consisting of “commercial computer software” and “commercial computer software
documentation,” as such terms are used in 48 C.F.R.12.212 (Sept. 1995). Consistent with 48
C.F.R. 12.212 and 48 C.F.R.227.7202-1 through 227.7202-4 (June 1995), all U.S. Government
End Users acquire Covered Code with only those rights set forth herein.

Miscellaneous

This License represents the complete agreement concerning subject matter hereof. If any
provision of this License is held to be unenforceable, such provision shall be reformed only to
the extent necessary to make it enforceable.

This License shall be governed by California law provisions (except to the extent applicable
law, if any, provides otherwise), excluding its conflict-of-law provisions. With respect to
disputes in which at least one party is a citizen of, or an entity chartered or registered to do
business in the United States of America, any litigation relating to this License shall be subject
to the jurisdiction of the Federal Courts of the Northern District of California, with venue lying
in Santa Clara County, California, with the losing party responsible for costs, including without
limitation, court costs and reasonable attorneys' fees and expenses. The application of the
United Nations Convention on Contracts for the International Sale of Goods is expressly
excluded. Any law or regulation which provides that the language of a contract shall be
construed against the drafter shall not apply to this License.

Responsibility for Claims

As between Initial Developer and the Contributors, each party is responsible for claims and
damages arising, directly or indirectly, out of its utilization of rights under this License and You
agree to work with Initial Developer and Contributors to distribute such responsibility on an
equitable basis. Nothing herein is intended or shall be deemed to constitute any admission of
liability.

Multiple-Licensed Code

Initial Developer may designate portions of the Covered Code as “Multiple-Licensed”.
“Multiple-Licensed” means that the Initial Developer permits you to utilize portions of the
Covered Code under Your choice of the MPL or the alternative licenses, if any, specified by the
Initial Developer in the file described in Exhibit A.

EXHIBIT A - Mozilla Public License

The contents of this file are subject to the Mozilla Public License; you may not use this file
except in compliance with the License. You may obtain a copy of the License at http://
www.mozilla.org/MPL/Software distributed under the License is distributed on an "AS IS"
basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. Refer to the License for
the specific language governing rights and limitations under the License.
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The Original Code is Open Phone Abstraction Library 3.10.5- Release May 3, 2012 The Initial
Developer of the Original Code is Equivalence Pty.Ltd.

OpenSSL License

The Telex Radio Dispatch software contains open source software licensed under the
OpenSSL License, and the license terms below in this schedule (copied from the following
website: https://www.openssl.org/source/license.html) apply to that open source software.

License Issues

The OpenSSL toolkit stays under a double license, i.e. both the conditions of the OpenSSL
License and the original SSLeay license apply to the toolkit. See below for the actual license
texts.

Copyright (c) 1998-2017 The OpenSSL Project.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

1. Redistribution of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/ or other materials
provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the
following acknowledgment: "This product includes software developed by the OpenSSL
Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or
promote products derived from this software without prior written permission. For
written permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL"
appear in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS"” AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).
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SSLeay License

The Telex Radio Dispatch software contains open source software licensed under the SSLeay
License, and the license terms below in this schedule (copied from the following website:
https://www.openssl.org/source/license.html) apply to that open source software.

License Issues

The OpenSSL toolkit stays under a double license, i.e. both the conditions of the OpenSSL
License and the original SSLeay license apply to the toolkit. See below for the actual license
texts.

Original SSLeay License
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The
implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions
are adhered to. The following conditions apply to all code found in this distribution, be it the
RC4, RSA, Ihash, DES, etc., code; not just the SSL code. The SSL documentation included
with this distribution is covered by the same copyright terms except that the holder is Tim
Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be
removed.

If this package is used in a product, Eric Young should be given attribution as the author of the
parts of the library used. This can be in the form of a textual message at program startup or in
documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

1. Redistribution of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/ or other materials
provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the
following acknowledgement: "This product includes cryptographic software written by
Eric Young (eay@cryptsoft.com)". (The word 'cryptographic' can be left out if the rouines
from the library being used are not cryptographic related.)

4. If you include any Windows specific code (or a derivative thereof) from the apps directory
(application code) you must include an acknowledgement:

"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
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EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESSINTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The license and distribution terms for any publically available version or derivative of this code
cannot be changed. i.e. this code cannot simply be copied and put under another distribution
license [including the GNU Public License.]

The X11 License (MIT/X Consortium)

The Telex Radio Dispatch software contains open source software licensed under The X11
License (MIT/X Consortium), and the license terms below in this schedule (copied from the
following website: http://opensource.org/licenses/MIT) apply to that open source software.
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ncurses
Copyright (c) 1998-2004,2006 Free Software Foundation, LCC.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Except as contained in this notice, the name(s) of the above copyright holders shall not be
used in advertising or otherwise to promote the sale, use or other dealings in this Software
without prior written authorization.

$I/d: README,v 1.23 2006/04/22 22:19:37 tom Exp $

popt
Copyright (c) 1998 Red Hat Software

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Except as contained in this notice, the name of the X Consortium shall not be used in
advertising or otherwise to promote the sale, use or other dealings in this Software without
prior written authorization from the X Consortium.
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The X11 License (MIT/X Consortium)
Copyright (c) <year> <copyright holders>

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Except as contained in this notice, the name(s) of the above copyright holders shall not be
used in advertising or otherwise to promote the sale, use or other dealings in this Software
without prior written authorization.

The zlib/libpng License

The Telex Radio Dispatch software contains open source software licensed under the zlib/
libpng License (Zlib)), and the license terms below in this schedule (copied from the following
website: http://opensource.org/licenses/Zlib ) apply to that open source software.

libpng

This copy of the libpng notices is provided for your convenience. In case of any discrepancy
between this copy and the notices in the file png.h that is included in the libpng distribution,
the latter shall prevail.

Copyright notice, Disclaimer, and License

If you modify libpng you may insert additional notices immediately following this sentence.
libpng, December 3, 2004, is Copyright (c) 2004 Glenn Randers-Pehrson, and is distributed
according to the same disclaimer and license as libpng with the following individual added to
the list of Contributing Authors Cosmin Truta libpng, July 1, 2000, - October 3, 2002, are
Copyright (c) 2000- 2002 Glenn Randers-Pehrson, and are distributed according to the same
disclaimer and license as libpng with the following individuals added to the list of Contributing
Authors:

Simon-Pierre Cadieux

Eric S. Raymond

Gilles Vollant

and with the following additions to the disclaimer:
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There is no warranty against interference with your enjoyment of the library or against
infringement. There is no warranty that our efforts or the library will fulfill any of your
particular purposes or needs. This library is provided with all faults, and the entire risk of
satisfactory quality, performance, accuracy, and effort is with the user.

libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are Copyright (c) 1998,
1999 Glenn Randers-Pehrson, and are distributed according to the same disclaimer and
license as libpng-0.96, with the following individuals added to the list of Contributing Authors:
Tom Lane

Glenn Randers-Pehrson

Willem van Schaik

libpng versions 0.89, June 1996, through 0.96, May 1997, are Copyright (c) 1996, 1997
Andreas Dilger Distributed according to the same disclaimer and license as libpng-0.88, with
the following individuals added to the list of Contributing Authors:

John Bowler

Kevin Bracey

Sam Bushell

Magnus Holmgren

Greg Roelofs

Tom Tanner

libpng versions 0.5, May 1995, through 0.88, January 1996, are Copyright (c) 1995, 1996 Guy
Eric Schalnat, Group 42, LCC. For the purposes of this copyright and license, "Contributing
Authors" is defined as the following set of individuals:

Andreas Dilger

Dave Martindale

Guy Eric Schalnat

Paul Schmidt

Tim Wegner

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, LCC.
disclaim all warranties, expressed or implied, including, without limitation, the warranties of
merchantability and of fitness for any purpose. The Contributing Authors and Group 42, LCC.
assume no liability for direct, indirect, incidental, special, exemplary, or consequential
damages, which may result from the use of the PNG Reference Library, even if advised of the
possibility of such damage.

Permission is granted to anyone to use this software for any purpose, including commercial

applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you
wrote the original software. If you use this software in a product, an acknowledgment in
the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented
as being the original software.

3. This Copyright notice may not be removed or altered from any source or altered source
distribution.
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The Contributing Authors and Group 42, LCC. specifically permit, without fee, and encourage
the use of this source code as a component to supporting the PNG file format in commercial
products. If you use this source code in a product, acknowledgment is not required but would
be appreciated.

A "png_get copyright" function is available, for convenient use in "about" boxes and the like:
printf("%s",png_get_copyright(NULL));

Also, the PNG logo (in PNG format, of course) is supplied in the files "pngbar.png" and
"pngbar.jpg (88x31) and "pngnow.png" (98x31).

Libpng is OSI Certified Open Source Software. OSI Certified Open Source is a certification
mark of the Open Source Initiative.

Glenn Randers-Pehrson
glennrp at users.sourceforge.net
December 3, 2004

Tiny XML

http://www.grinninglizard.com/tinyxmldocs/index.html

Copyright (c) 2000-2006 Lee Thomason (www.grinninglizard.com)

This software is provided 'as-is', without any express or implied warranty. In no event will the
authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial
applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote
the original software. If you use this software in a product, an acknowledgment in the product
documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as
being the original software.

3. This notice may not be removed or altered from any source distribution.

zlib
(C) 1995-2004 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the
authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial

applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you
wrote the original software. If you use this software in a product, an acknowledgment in
the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented
as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly - jloup@gzip.org
Mark Adler - madler@alumni.caltech.edu
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If you use the zlib library in a product, we would appreciate *not* receiving lengthy legal
documents to sign. The sources are provided for free but without warranty of any kind. The
library has been entirely written by Jean-loup Gailly and Mark Adler; it does not include third-
party code.

If you redistribute modified sources, we would appreciate that you include in the file
Changelog history information documenting your changes. Please read the FAQ for more
information on the distribution of modified source versions.
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The zlib/libpng License
Copyright (c) <year> <copyright holders>

This software is provided 'as-is', without any express or implied warranty. In no event will the
authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial

applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you
wrote the original software. If you use this software in a product, an acknowledgment in
the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented
as being the original software.

3. This notice may not be removed or altered from any source distribution.

2021-06 | 14 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC



C-Soft 7.700 Appendix L - End user license agreement | 669

Bosch Security Systems, LLC Technical Manual 2021-06 | 14 | F.01U.218.561



670 | Appendix L - End user license agreement C-Soft 7.700

2021-06 | 14 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC






TELEX

12000 Portland Avenue South
Burnsville MN 55337

USA

www.telex.com

© Bosch Security Systems, LLC, 2021

202107212039



	 Table of contents
	1 Notices
	1.1 Proprietary notice
	1.2 Copyright notice
	1.3 Warranty notice (limited)
	1.4 Factory service center
	1.5 Contact information
	1.6 Claims
	1.7 Warning
	1.8 OpenSSL project

	2 Overview
	3 License and optional features
	4 C-Soft Application Software
	5 Installation and setup
	5.1 Install the C-Soft Runtime software
	5.2 Install the C-Soft Designer software
	5.3 ADHB-4 driver installation
	5.4 Telex License Server setup
	5.5 Initial volume control settings
	5.5.1 Playback volumes
	5.5.2 Recording volumes

	5.6 Position settings

	6 Communications system design
	6.1 Communication control
	6.1.1 Tone remote control
	6.1.2 VoIP radio control

	6.2 PC & Network Security Considerations
	6.3 Network requirements
	6.3.1 IP operation overview
	6.3.2 Ethernet as physical layer
	6.3.3 Bandwidth
	6.3.4 Multicast
	6.3.5 IP PIM query-interval
	6.3.6 Internet group management protocol
	6.3.7 Network performance
	6.3.8 TCP/IP and UDP/IP
	6.3.9 Multicast UDP/IP
	6.3.10 Telex Radio Dispatch port-centric method


	7 C-Soft Designer program
	7.1 Starting the C-Soft Designer program

	8 C-Soft Designer window
	9 User interface element configuration
	10 File menu
	10.1 Design Errors window
	10.2 File Information window
	10.3 Telex Design Archive (TDA) files

	11 Edit menu
	12 Per Line Parameters window
	12.1 Line Options Setup window
	12.2 Frequency Parameters window
	12.3 Frequency Parameters windows - MOTOTRBO
	12.4 Signaling Parameters window
	12.5 Signal system types
	12.5.1 Generic system type
	12.5.2 5-6 Tone/DTMF ANI system type
	12.5.3 FleetSync system type
	12.5.4 Telex-Serial system type
	12.5.5 MDC-1200 system type
	12.5.6 MOTOTRBO system type
	12.5.7 Sprint Direct Connect system type
	12.5.8 Telex-Enhanced-ANI system type
	12.5.9 Phone system type

	12.6 AutoFill Line Parameters window
	12.7 Configure SIP Settings window
	12.8 SIP Phone line configuration
	12.8.1 SIP features
	12.8.2 Configure SIP for recording or monitoring


	13 Global Parameter Setup window
	13.1 Appearance page
	13.2 Audio page
	13.3 Control Settings page
	13.4 IRR Recording page
	13.5 Local Consoles page
	13.6 Peripherals page
	13.7 Recording page

	14 Language Customization
	14.1 General page
	14.2 Button Labels window
	14.3 Button Images window
	14.4 Column Headings page
	14.5 Text Labels window
	14.6 Window Titles window

	15 Paging Settings window
	15.1 2 Tone 100 Page Setup window
	15.2 2 Tone 1000 Setup window
	15.3 DTMF Paging Setup window
	15.4 Knox Paging Setup window

	16 Tone Levels window
	17 Global SIP Configuration window
	17.1 SIP Network page
	17.2 Audio page
	17.3 Behavior page

	18 Setup P25
	19 GPS Mapping Setup window
	20 NEXEDGE
	21 Setup External Systems
	21.1 API Setup

	22 AIS
	23 Filter List Setup window
	24 User ID List window
	25 Group ID List window
	26 Status Message ID List window
	27 Text Message ID List window
	28 Edit System List window
	28.1 File menu - Edit System List
	28.2 Edit System List window - System Menu
	28.2.1 New System window
	28.2.2 Copy System window
	28.2.3 System configuration
	28.2.4 Auto Build System command
	28.2.4.1 System List group box
	28.2.4.2 System Components group box



	29 Insert menu
	30 UI Element Setup window
	30.1 Type page
	30.2 Colors page
	30.3 Options page

	31 UI Element Functions configuration
	31.1 Active Emergency Window
	31.2 ADHB-4 Auxiliary Audio Control button
	31.3 ADHB-4 Mic Control
	31.4 ADHB-4 NENA-Hold
	31.5 ADHB-4 NENA-Hook Control function
	31.6 ADHB-4 NENA-Indication
	31.7 ADHB-4 NENA-Mute
	31.8 ADHB-4 Select Speaker Control
	31.9 Alert
	31.10 Annunciation
	31.11 Auto-Dial
	31.12 Backup Line
	31.13 Call List Window
	31.13.1 Call List window
	31.13.2 Status List window

	31.14 Call Priority button
	31.15 Call Queue window
	31.15.1 Call Queue Setup page
	31.15.1.1 Event Selection group box
	31.15.1.2 Behavior group box
	31.15.1.3 Event Priority group box
	31.15.1.4 Window Appearance group box

	31.15.2 Call Queue Columns page
	31.15.3 Group Statuses page
	31.15.4 Call Queue window

	31.16 Crosspatch
	31.17 Crosspatch Block
	31.18 Crosspatch Clear
	31.19 Crosspatch Programmed
	31.20 Crosspatch PTT
	31.21 Dial
	31.22 DTMF Digit
	31.23 Emergency ACK
	31.24 Emergency Clear
	31.25 Emergency History Window
	31.26 Encryption
	31.27 Event Logger
	31.28 FleetSync
	31.28.1 FleetSync Dispatching window

	31.29 Frequency Change
	31.30 GPS Read button
	31.31 GPS Trigger Off button
	31.32 GPS Trigger On button
	31.33 Group Programmed
	31.34 Group Select
	31.35 Group Select Limited
	31.36 Input Indication
	31.37 Instant Recall
	31.37.1 Duration page

	31.38 Instant Recall - Last Call button
	31.39 Intercom
	31.40 Intercom-Per Line
	31.41 Knox Digit
	31.42 Launch Application
	31.42.1 Launch Application Setup page
	31.42.2 Application Triggers page

	31.43 Manual Call List
	31.43.1 Manual Call List window

	31.44 Marker Tone
	31.45 MDC-1200
	31.45.1 MDC-1200 Dispatching window
	31.45.2 History page

	31.46 Monitor
	31.47 MOTOTRBO Radio Setup page
	31.47.1 Dispatch Window
	31.47.2 MOTOTRBO Dispatching window

	31.48 Mute Group
	31.49 Mute Main
	31.50 Mute-Per Line
	31.50.1 Per Line Mute Button Setup page

	31.51 P25-DFSI window
	31.52 Page
	31.53 Page Cancel
	31.54 Page Manual Entry
	31.54.1 Manual Page Setup

	31.55 Page Send
	31.56 Page Stack
	31.56.1 Page Stack Setup

	31.57 Page Stack Programmed
	31.57.1 Programmed Stack Setup page

	31.58 Per Line Call History
	31.58.1 Per Line Call History window
	31.58.2 Per Line Call History window - 5/6 Tone line
	31.58.3 IRR Playback Control window
	31.58.4 Comments window

	31.59 Phone-Flashhook
	31.60 Phone-Hold
	31.61 Phone-On/Offhook
	31.61.1 Remote Phone Line Select page

	31.62 PTT-Group Call
	31.63 PTT-Main
	31.64 PTT-Per Line
	31.64.1 Per Line PTT Setup page

	31.65 PTT-Private Call
	31.66 PTT-Talk Back
	31.67 Radio Call Alert
	31.68 Radio Call Type
	31.69 Radio Check
	31.70 Radio Disable
	31.71 Radio Enable
	31.72 Radio Regroup
	31.73 Radio Ungroup
	31.74 Radio Remote Monitor
	31.75 Radio Status
	31.76 Radio Status Request
	31.77 Radio Select Call
	31.78 Radio-On/Offhook
	31.79 Relay Control Button
	31.79.1 Relay Control Setup page
	31.79.1.1 Relay Destination group box
	31.79.1.2 ADHB-4 Settings group box
	31.79.1.3 NEO Settings group box
	31.79.1.4 Relay Behavior group box
	31.79.1.5 Emergency Relay Trigger group box
	31.79.1.6 Phone Relay Trigger group box
	31.79.1.7 PTT Relay Trigger group box

	31.79.2 Text Message Control page
	31.79.3 Status Control page

	31.80 RX All
	31.81 Scan
	31.82 Select
	31.83 SIP Call Control
	31.83.1 SIP Window page
	31.83.2 SIP Speed Dial page
	31.83.3 SIP Calls window
	31.83.4 Call page
	31.83.5 History page
	31.83.6 Missed page
	31.83.7 Misc page
	31.83.8 Forward page

	31.84 Status Stack Programmed
	31.85 Status Stack window
	31.85.1 Window Appearance group box
	31.85.2 Failed Attempts group box
	31.85.3 Status Stack window

	31.86 Supervisor
	31.87 Talk Around button
	31.88 Text button
	31.89 TX All

	32 UI Element Setup window - Add button
	32.1 Type page
	32.2 Colors page
	32.3 Radio Command buttons

	33 UI Element Setup window - Add Clock
	33.1 Clock Control page

	34 UI Element Setup window - Add Frame
	35 UI Element Setup window - Add Frequency Control
	35.1 Colors page
	35.2 Frequency Control page

	36 UI Element Setup window - Add Keypad
	36.1 Common page
	36.2 Contact Tab page
	36.3 Manual Tab page
	36.4 History Tab page
	36.5 Keypad

	37 UI Element Setup window - Add Popup Button
	37.1 Popup Window Setup page
	37.1.1 Window Options group box
	37.1.2 Button Options group box
	37.1.3 Logo group box

	37.2 Popup Webpage
	37.2.1 Popup Webpage Setup page

	37.3 Type page
	37.4 Popup Global Call History
	37.4.1 Call List Options page

	37.5 Global Call History window

	38 UI Element Setup window - Add Text
	39 UI Element Setup window - Add Text Message Control
	40 UI Element Setup window - Add Volume Control
	40.1 Type page
	40.2 Vol. Control page

	41 UI Element Setup window - Add VU Meter
	41.1 VU Meter Control page

	42 View menu
	43 Configure menu
	44 Device Setup
	45 Global Key Mapping
	46 Run menu
	47 About C-Soft Designer
	48 C-Soft Runtime program
	48.1 C-Soft Console

	49 Appendix A - Telex Tone Group Numbers and Paging Plans
	49.1 Telex Tone Group Numbers
	49.2 Tone and Gap Durations for Standard Paging Plans

	50 Appendix B - 2 Tone 1000 Plan Numbers
	51 Appendix C - Supported Tone Frequencies
	52 Appendix D - Echo Packets Diagram
	53 Appendix E - P25-DFSI (Digital Fixed Station Interface)
	53.1 P25-DFSI C-Soft Architecture
	53.2 P25 DFSI Global Setup window
	53.2.1 Console Type group box
	53.2.2 Backup Server Ping Address group box
	53.2.3 Heartbeats group box
	53.2.4 Radio/Repeater Control Signals group box
	53.2.5 Packet Controls group box

	53.3 Console Type Setup
	53.3.1 Stand Alone Console

	53.4 Backup FS Setup window
	53.5 Server Console
	53.6 Backup FS Setup window
	53.7 Client Console
	53.8 Client Console with Server Backup
	53.9 Backup FS Setup window
	53.9.1 Client Connections group box
	53.9.2 Control Address of Server group box
	53.9.3 Voice Address of Server group box

	53.10 Channel Table window
	53.11 Setting Up Additional P25-DFSI lines
	53.12 P25-DFSI window and C-Soft Runtime
	53.12.1 Main Control page
	53.12.2 Unit Control page
	53.12.3 Voting page
	53.12.4 Repeater page
	53.12.5 History page

	53.13 System features and requirement for DFSI Interface
	53.14 Frequently Asked Questions

	54 Appendix F - P25 Encryption
	54.1 Encryption configuration
	54.2 Encryption Setup window
	54.3 Encryption Profile Edit window
	54.4 Registering keys
	54.5 Connecting a key fill device
	54.6 Group encryption options into encryption profiles
	54.7 Link P25-DFSI Channels to an encryption profile
	54.7.1 Activate Key Fill Device serial port

	54.8 Add an Encryption Option Select button
	54.9 Loading keys to C-Soft Runtime
	54.10 Receiving encrypted calls
	54.11 Transmitting encrypted calls

	55 Appendix G - CSSI Interface
	55.1 Supported features
	55.2 Theory of operation
	55.2.1 Distribution of receive audio to the lines
	55.2.2 Individual Call line

	55.3 CSSI Call types
	55.3.1 Group Call
	55.3.2 Individual Call

	55.4 C-Soft Setup parameters
	55.5 Signaling Parameters
	55.6 CSSI System setup
	55.7 Global P25 CSSI Parameters

	56 Appendix H - Kenwood NEXEDGE Direct IP interface
	56.1 Supported features
	56.2 Theory of operation
	56.2.1 Distribution of receive audio to the lines
	56.2.2 Group Call line

	56.3 NEXEDGE Call types
	56.3.1 Conference call
	56.3.2 Unit call

	56.4 C-Soft Setup parameters
	56.5 NEXEDGE Trunking System setup
	56.5.1 NEXEDGE Trunking Parameters page

	56.6 Console Global Setup
	56.6.1 Local Consoles button

	56.7 NEXEDGE Conventional IP system configuration
	56.8 NEXEDGE Conventional Parameters window
	56.9 Global NEXEDGE Conventional Parameters window
	56.10 NEXEDGE Conventional RANs window
	56.11 NEXEDGE Conventional IP set up
	56.12 C-Soft NEXEDGE Conventional IP interface
	56.13 NEXEDGE System configuration
	56.13.1 NEXEDGE System configuration type 1 - No signaling with RAN
	56.13.2 NEXEDGE System configuration type 2 - Signaling without RAN
	56.13.3 NEXEDGE System configuration type 3 - Signaling and RAN

	56.14 NEXEDGE System manager parameters
	56.15 Kenwood radio programming software
	56.16 NEXEDGE Encryption window
	56.17 Scrambler/Encrypt Key Select button

	57 Appendix I - Telex License Activation tool
	57.1 Telex Licensing Server setup
	57.2 Installation activation
	57.2.1 View current licensing information
	57.2.2 Add Fulfillment
	57.2.3 Return Fulfillment
	57.2.4 Repair
	57.2.5 Process Response Message


	58 Appendix J - DMR–AIS
	58.1 Supported features
	58.2 AIS Global Setup window
	58.3 C-Soft Designer setup

	59 Appendix K - C-Soft API Installation notes
	59.1 Supported features
	59.2 Setup External Systems window
	59.2.1 API Setup
	59.2.1.1 API Setup window



	60 Appendix L - End user license agreement

